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NOTICE TO USERS
© 2011 Sony Corporation. All rights reserved. This 
manual or the software described herein, in whole or 
in part, may not be reproduced, translated or reduced 
to any machine readable form without prior written 
approval from Sony Corporation.

SONY CORPORATION PROVIDES NO 
WARRANTY WITH REGARD TO THIS MANUAL, 
THE SOFTWARE OR OTHER INFORMATION 
CONTAINED HEREIN AND HEREBY EXPRESSLY 
DISCLAIMS ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR ANY 
PARTICULAR PURPOSE WITH REGARD TO THIS 
MANUAL, THE SOFTWARE OR SUCH OTHER 
INFORMATION. IN NO EVENT SHALL SONY 
CORPORATION BE LIABLE FOR ANY 
INCIDENTAL, CONSEQUENTIAL OR SPECIAL 
DAMAGES, WHETHER BASED ON TORT, 
CONTRACT, OR OTHERWISE, ARISING OUT OF 
OR IN CONNECTION WITH THIS MANUAL, THE 
SOFTWARE OR OTHER INFORMATION 
CONTAINED HEREIN OR THE USE THEREOF.

Sony Corporation reserves the right to make any 
modification to this manual or the information 
contained herein at any time without notice.
The software described herein may also be governed 
by the terms of a separate user license agreement.
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Functions Newly Supported in 
Version 11.10

The functions newly supported in the MVS-8000X/7000X 
system version 11.10 are as follows.

Functions relating to the switcher

a) In MVS-7000X only

Functions relating to the setup

Functions relating to the DME

Functions Not Supported in Version 
11.10

The following functions are not supported in the MVS- 
7000X system version 11.10.

Classification Functions 
supported

Menu No. See page

Vol. 1 Vol. 2

Signal inputs 
and outputs

Combination 
setting of 
format 
converter signal 
formats in units 
of 4 inputs

7313.4 - 143

Frame delay 
mode in the 
format 
converter

7332 - 144, 
204

Key Key rotation by 
the resizer

1115 147 -

Frame 
memory

Ancillary data 7316.8 208 153

System 3D support 7331.13
7331.9
7331.10
7331.12

248 -

3M/E mode and 
4M/E mode in 
the M/E 
configuration a)

7316.11 254 -

Signal outputs Multi Viewer 7333.9 - 209

Classification Functions 
supported

Menu No. See page

Vol. 1 Vol. 2

User setup Source patch 7211
7212
7212.1

- 248

Classification Functions 
supported

Menu No. See page

Vol. 1 Vol. 2

Switcher 
connection

Connection by 
SDI interface

7337.7 - 222

Applying 
special effects 
(edge effects)

Flex shadow 4115 283 -

Applying 
special effects 
(effects on the 
overall video 
signal)

Masking the 
glow effect

4174 297 -

System Support for SD 
format by MKS-
7470X/7471X

- 257 -

Classification Functions 
supported

Menu No. See page

Vol. 1 Vol. 2

System Support for 
1080P format 
by MKS-7470X/
7471X

- - -

Key assignment 
for 3M/E mode 
or 4M/E mode

7331.13 - -

Classification Functions 
supported

Menu No. See page

Vol. 1 Vol. 2
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Introduction

This manual is the User’s Guide for the MVS-8000X/
7000X Multi Format Switcher system.
This manual describes principally the operation of the 
system using the CCP-8000 of center control panels.
The User’s Guide for this system comprises two volumes.
For the contents of each volume, see the section 
“Organization of This User’s Guide” at the front of this 
volume.

Devices and system nomenclature
In this manual, when discussing the principal components 
of the MVS-8000X/7000X system, in place of the formal 
product names, abbreviated names characterizing the 
functions and features are sometimes used. When 
distinctions between system configurations must be 
drawn, the terms in the following table are used.

Principal components and naming
The formal product names of the principal components of 
the MVS-8000X/7000X system, and the terms used in this 
manual are as follows.

System nomenclature
The following terms are used for systems, depending on 
the combination of installed options, and the signal format.

Related manuals

MVS-8000X-C/7000X-C Switcher Processor Pack
• MVS-8000X-C/7000X-C Operation Manual
• MVS-8000X-C/7000X-C Installation Manual

MVE-8000A DME Processor Pack
• MVE-8000A Operation Manual
• MVE-8000A Installation Manual

MVE-9000-C DME Processor Pack
• MVE-9000-C Operation Manual
• MVE-9000-C Installation Manual

CCP-6000/8000 Center Control Panel Pack
• CCP-6000/8000 Operation Manual
• CCP-6000/8000 Installation Manual

DCU-8000 Device Control Unit Pack
• DCU-8000 Operation Manual
• DCU-8000 Installation Manual

DCU-2000 Device Control Unit Pack
• DCU-2000-C Operation Manual
• DCU-2000-C Installation Manual

Formal product name Term used in this manual

MVS-8000X/7000X Multi 
Format Switcher Processor

Switcher or switcher 
processor

DME Board Set MKS-7470X DME or DME Board set or 
MKS-7470X/7471XAdditional DME Board 

MKS-7471X

MVE-8000A Multi Format 
DME Processor

DME or DME processor or 
MVE-8000A

MVE-9000 Multi Format 
DME Processor

DME or DME processor or 
MVE-9000

CCP-8000, CCP-6224, CCP-
6324 Center Control Panel

Control panel or center 
control panel

DCU-8000 (MKS-8700) 
Device Control Unit

DCU or MKS-8700

DCU-2000 (MKS-2700) 
Device Control Unit

DCU or MKS-2700

System configuration and features Term for system

System with installed option boards 
and settings to support HDTV format

HD system

System with installed option boards 
and settings to support SDTV format

SD system

A system in which the center control 
panel has five M/E banks

5M/E system

A system in which the center control 
panel has four M/E banks

4M/E system

A system in which the center control 
panel has three M/E banks

3M/E system

A system in which the center control 
panel has two M/E banks

2M/E system
11Introduction
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Features of the 
MVS-8000X/7000X Multi 
Format Switcher System

The MVS-8000X/7000X Multi Format Switcher system 
boasts extensible high performance and 
multifunctionality. The following are some of the principal 
features of this system.

System configuration flexibility

Multiformat support
This system supports both HDTV and SDTV signal 
formats. The format selection can be switched by a simple 
control panel operation. 

Extensible system configuration
By suitable combination of options, the switcher can be 
configured with various inputs and outputs, and different 
numbers of M/E banks. The system offers the flexibility to 
change and expand as required.
You can connect up to two MVE-8000A or MVE-9000 
extensible DME processor, which provides any number 
from one to eight channels, for a maximum of eight 
channels of DME functionality.
When the signal format is 1080P, you can also connect up 
to four MVE-8000A units, which provides a maximum of 
eight channels of DME functionality.
For the MVS-7000X, by installing the optional MKS-
7470X/7471X DME board set, you can use a maximum of 
four channels of DME functionality. 
You can use a maximum of eight channels of DME 
functionality in the whole switcher system.

Powerful external device interfaces
By connecting to a Sony routing switcher or similar, a 
large system can be built. From the control panel, it is also 
possible to operate other equipment, including VTRs and 
disk recorders.

Powerful tally system
The complete system including routing switcher provides 
an all-inclusive tally system. The system can be adapted to 
different applications and settings, using multiple tally 
outputs, including both on-air and recording tallies.

Comprehensive video manipulation

M/E banks
Each mix/effects bank (M/E bank) is equipped with eight 
keyers, and each keyer is capable not only of chroma 
keying, but also independent key transitions separate from 
the background transitions. The eight keys can be freely 
combined, to carry out four different program outputs.

Powerful frame memory functions
The frame memory can hold approximately 1000 frames in 
an HDTV system (approximately 2000 frames in 720P/
59.94 format), or approximately 5000 frames in an SDTV 
system in 480i/59.94 format, or approximately 4000 
frames in 576i/50 format, and allows eight frames (four 
frames in 1080P format) to be recalled simultaneously.

Link operation with DME
You can use a wide range of DME functions, including 
DME wipes and processed key functions as though they 
were part of the standard switcher functions. 

Designed for use in a live broadcasting 
environment

Flexible control panel layout
Because of its modular design, the various sections of the 
control panel can be laid out as required. This allows a 
flexible layout appropriate to the system operation.

High-performance user interface
The menu control block provides a large color LCD panel, 
with rapid touch-panel menu selection.
The source name displays and buttons in the Flexi PadTM 
and shotbox control blocks have color backlit LCD 
displays. The signal names, and graphical representations 
of the patterns associated with buttons provide intuitive 
feedback, and allow the immediate decisions that are 
required in a live operating environment.
Features of the MVS-8000X/7000X Multi Format Switcher System
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Basic Video Processing

This section introduces basic functions used for video 
processing on the switcher.

Transitions

In the M/E banks and PGM/PST bank, the switch from the 
current video stream (appearing on the corresponding 
program monitor) to a new video stream is referred to as a 
transition.
In the M/E banks and PGM/PST bank, you can change one 
of the images, the background, and keys 1 to 8 
(downstream keys 1 to 8 in the PGM/PST bank), and also 
vary combinations of these simultaneously.

When the signal format is 1080P, four keyers can be used 
(keys 1 to 4).

The following are examples of transition.

Changing the background
A background transition switches from the video currently 
selected on the background A bus (the current video) to the 
video selected on the background B bus (the new video).

In the default selection of flip-flop mode (see page 100), 
the background always switches in the direction from the 
A bus to the B bus. When the transition completes, the 

cross-point selections on the A and B buses are 
interchanged.

Inserting and deleting a key
You can insert one or more of the eight keys (downstream 
keys on the PGM/PST bank).
If you select a key which is already inserted, the transition 
will delete the key.
A simultaneous combination of deleting and inserting keys 
is also possible.

Inserting or deleting key 1 and key 2

Deleting key 1 and inserting key 2

Notes

Background B

Background A

Transition

DeleteInsert

Key 1

Key 2

Key 1

Key 2

Transition
13Basic Video Processing
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Simultaneously changing the background 
and keys
You can change any of the eight keys (downstream keys on 
the PGM/PST bank) and the background at the same time.

Changing the background and key 2 simultaneously

Changing the background and keys 1 to 4 simultaneously

Selecting the transition type determines the way in which 
the transition occurs. The following are the transition type.
• Mix
• NAM (non-additive mix)
• Super mix 
• Preset color mix (color matte)
• Wipe
• DME wipe

• Clip transition
• Cut
There are two modes for carrying out a transition: auto 
transitions are carried out by a button operation, and 
manual transitions are carried out using the fader lever. It 
is also possible to combine these two modes.

Independent Key Transitions
In addition to common transitions, it is possible to carry 
out independent transitions on the keyers of the M/E banks 
and PGM/PST bank. These are called “independent key 
transitions.”
By carrying out an independent key transition in 
combination with a common transition, different transition 
types can be used for the background and keys. 
The following description compares the independent key 
transition with a common transition, taking a simultaneous 
change of the background and key as an example.

Video used in the transition

Effect of a common transition
In the case shown in the previous illustration, carrying out 
a common transition produces the following change in the 
image.

Key 1

Key 2

Transition

Key 1

Key 2

Key 4

Transition

Key 3

Background A

Background B

Key to insert
Basic Video Processing
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Effect of a common transition

Effect of use with an independent key transition
The key is inserted with an independent key transition as 
the background changes with a common transition, 
providing the following result.

Effect of a background transition and independent key transition

For details, see Chapter 3 “Signal Selection and 
Transitions” (page 78).

Keys

A key is an effect in which a part of the background image 
is replaced by an image or superimposed text. The signal 
determining how the background is cut out is termed “key 
source,” and the signal that replaces the cut-out part is 

termed “key fill.” The system component responsible for 
processing a key is referred to as a keyer.
Each switcher bank has eight keyers, each providing the 
same functionality.

On each switcher bank, you can use the following key 
types (methods of processing the key source).
• Luminance key
• Linear key
• Color vector key
• Chroma key
• Wipe pattern key
• Key wipe pattern key

Key modifiers
You can apply borders and other modifiers to the edge of 
the key image.

Masks
A mask allows a part of the image to be replaced by the 
background or a key. To prevent unwanted holes in the 
background, or if a key is not the desired shape, you can 
correct this with a mask.

Resizer
This function allows you to apply effects, similar to a 
DME, such as zoom, movement, or aspect ratio change to 
a part of a created key. You can use the following 
operations.
• Two-dimensional transform of a key
• Rotation of keys
• Resizer interpolation settings
• Resizer crop/border settings
• Resizer effect settings (wide key border, drop shadow, 

edge enhancement, mosaic, defocus, mask)

For details, see “Keys” (page 112).

Wipes

A wipe is a transition from the current video stream to a 
new video stream, using a wipe pattern.
Changing the background by means of a wipe is referred to 
as a “background wipe,” and inserting or deleting a key 
with a wipe is termed a “key wipe.”
There are two types of wipe: those that can be selected in 
a common transition, and those that can be selected in an 
independent key transition.

The patterns that can be used for a wipe are as follows. 
• Standard wipe patterns
• Enhanced wipes
• Rotary wipes
• Mosaic wipe pattern

Same wipe is applied to background 
and key.

Transition type: wipe

Different wipe patterns are applied to 
the background and key transitions.

Transition type: wipe Independent key transition 
type: wipe
15Basic Video Processing
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• Random and diamond dust wipe patterns

You can combine two selected patterns (referred to as 
“main” and “sub”) to create a new pattern (pattern mix).
You can also specify the wipe direction, or set the pattern 
position, applying various changes and modifiers to the 
selected wipe pattern.

For details, see “Wipes” (page 152).

DME Wipes

A DME wipe is a wipe transition that uses a DME effect to 
change from one video image to the next. 
There are two types of DME wipe: those which can be 
selected for a normal transition, and those which can be 
selected for an independent key transition.
The patterns that can be used for a DME wipe are as 
follows. 

Slide, Squeeze, Split, Door, Flip tumble, Mirror, 
Sphere, Character trail, Wave, Ripple, Page turn, Page 
roll, Frame in-out, Picture-in-picture, 2D trans, 3D 
trans, Sparkle, Split slide, Mosaic, Defocus, Brick, and 
User programmable DME

You can also specify the wipe direction, or set the pattern 
position, applying various changes and modifiers to the 
selected DME wipe pattern.

Resizer DME wipes
Using the resizer, you can carry out key DME wipes.

For details, see “DME Wipes” (page 172).

Frame Memory

Frame memory is a function for using a still image or video 
(frame memory clip) as material for editing.
You can create a still image by capturing a frame of input 
video or a clip by specifying a range of input video. The 
created images and clips can be written to memory for 
playback, editing, and output.

For details, see “Frame Memory” (page 191).

Color Backgrounds

This function can be used to obtain color background 
video.
Two color signals generated from the dedicated generators 
can be switched or mixed, and then output.

For details, see “Color Background” (page 217).

Copy and Swap

This function can be used to copy and swap the settings 
among the M/E-1 to M/E-3, and PGM/PST banks or 
between keyers.
The following settings can be copied or swapped.
• Overall settings for the M/E and PGM/PST banks
• Keyer settings
• Wipe settings in a transition control block
• Wipe settings in an independent key transition control 

block
• DME wipe settings in a transition control block
• DME wipe settings in an independent key transition 

control block
• Matte color settings (color 1, color 2, and how to 

compose them)
• Color settings
• DME channel settings
• Format converter input settings (copy only)
• Format converter output settings (copy only)

For details, see “Copy and Swap” (page 219).

Video Process

The term “video process” is applied to adjustments to the 
gain, hue, black level of the input video signal. There are 
two types of adjustment; adjustment of an individual input 
signal and adjustment as image effects on a particular bus.

For details, see “Video Process” (page 226).

Color Corrector

The color corrector enables video signal color correction 
(black balance/white balance adjustment, gamma 
correction, knee correction, etc.).
The color corrector includes the following adjustments.
• Input video processing
• Primary color correction
• Secondary color correction
• Luminance processing
• Spot color adjustment
• Output video processing
• YUV/RGB clip

For details, see “Color Corrector” (page 228).

Side Flags

The term “side flags” refers to the areas to left and right of 
an image with aspect ratio 4:3 embedded within a 16:9 
Basic Video Processing
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frame, when these areas are filled with a separate image 
selected from the utility 1 bus. 

For details, see “Side Flags” (page 238).

Multi Program 2

By operating the switcher in Multi Program 2 mode, a 
single switcher mix/effects bank can be used to create two 
separate video outputs, referred to as “main” and “sub.” 
You can set backgrounds, keys, and transitions for each of 
main and sub. For example, during broadcast of sports 
events, two versions of the scene can be provided as shown 
below, and switched simultaneously.

Program output for “Main”

Program output for “Sub”

For details, see “Multi Program 2” (page 241).

Input source with aspect 
ratio

Image to fill the side flag 
areas (selected from utility 
1 bus)

Turn the side flag 
function on

Side flag area Side flag area

Background A

Key (Key 1 to Key 8 are 
available on the main side.)

Background B

Background A (signal from utility 2 bus)

Key (Key 2 to Key 8 are 
available on the sub side.)

Background B (signal from utility 3 bus)
17Basic Video Processing
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3D Support

Installing the BZS-8560 switcher upgrade software in an 
MVS-8000X/ 7000X, and the BZDM-8560 DME upgrade 
software in an MVE-8000A/MVE-9000, enables the 
processing of video in 3D mode.

For details, see “3D Support” (page 248).

Creation of Special 
Effects and Management 
of Data and Operations

This section introduces functions used for creation of 
special effects, control of external devices or switcher 
operations, and data management.

Digital Multi Effects (DME)

When used with the switcher, DME allows you to add 
three-dimensional effects such as image movement, 
rotation, magnification and shrinking, as well as a wide 
variety of special effects. 
Each channel can be used on its own or in combination 
with other channels, which allows you to create advanced 
effects with more complexity.

The following types of DME special effects are available.
• Edge effects: Border, Crop, Beveled Edge, Key Border, 

Art Edge, Flex Shadow
• Effects for entire image: Defocus, Blur, Multi Move
• Effects for video image: Sepia, Mono, Posterization, 

Solarization, Nega, Contrast, Mosaic, Mask, Sketch, 
Metal, Dim and Fade, Glow

• Freeze effects
• Nonlinear effects: Wave, Mosaic Glass, Flag, Twist, 

Ripple, Rings, Broken Glass, Flying Bar, Blind, Split, 
Split Slide, Mirror, Multi Mirror, Kaleidoscope, Lens, 
Circle, Panorama, Page Turn, Roll, Cylinder, Sphere, 
Explosion, Swirl, Melt, Character Trail

• Lighting effects: Lighting, Spotlighting
• Recursive effects: Trail, Motion Decay, Keyframe 

Strobe
• Background color
• Separate Sides (effects for front and back sides)
• Signal inversion (Invert effect)
• Key density adjustment
• Key source selection

Global effects
Global effects are special effects created by combining the 
images of successive channels. The following types of 
global effects are available.
• Combiner
• Brick
• Shadow

For details, see “DME Operations” (page 256).
Creation of Special Effects and Management of Data and Operations
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External Devices

In this system, you can operate while controlling the 
following types of external device:
• Devices supporting P-Bus (Peripheral II protocol) 
• Devices supporting GPI
• VTRs
• Disk recorder (Sony disk 9-pin protocol and video disk 

communications protocol)
• Extended VTR (Abekas A53 protocol)

For details on the devices that can be connected, consult 
your Sony representative.

You can control an external device by previously 
registering timeline keyframes.

For details, see Chapter 12 “External Devices” (Volume 
2).

Keyframes

A keyframe represents an instantaneous state of an image; 
it can be saved in a register and recalled for reuse.
By arranging a number of keyframes on the time axis, and 
interpolating between successive keyframes, you can 
create a “keyframe effect” in which there is a continuous 
change from each keyframe to the next.
The following figure shows three keyframes created with 
a wipe pattern (the circle) in different positions. This is 
interpolated to create the effect shown.

Example of keyframes and effect execution

You can save the sequence of keyframes representing a 
single effect in a register. Then by recalling this register, 
you can replay the same effect.

For details, see Chapter 13 “Keyframe Effects” (Volume 
2).

Snapshots

The term “snapshot” refers to a function whereby the 
various settings required to apply a particular effect to an 
image are saved in a register as a set of data, for recall as 
required, to recover the original state.

Snapshots are divided as follows.
• Snapshots applying to a particular region (functional 

block of the switcher or DME)
• Master snapshot
• Key snapshot
• Wipe snapshot
• DME wipe snapshot

An individual snapshot may also have attached special 
conditions relating to switcher or DME operation when the 
snapshot is recalled.
These conditions are called “attributes” of the snapshot, 
and can be added when the snapshot is saved or recalled.

For details, see Chapter 14 “Snapshots” (Volume 2).

Utility

The utility function refers to a function whereby you can 
assign an arbitrary action or a shortcut for frequently used 
menu to a particular button, then instantly recall the action 
or menu by pressing the button.

For details, see “Utility Execution” in Chapter 15 
(Volume 2).

Shotbox

The term “shotbox” refers to a function whereby for each 
specified region (see “Regions” in Chapter 13 (Volume 2)) 
any snapshot or keyframe effect can be recalled 
simultaneously.

For details, see “Shotbox” in Chapter 15 (Volume 2).

Macros

The term “macro” refers to the function whereby a 
sequence of signal selections and other operations on the 
control panel is saved as data in memory (macro register), 
so that it can be recalled as required to automatically 
execute the same sequence of operations.
The individual control panel operations constituting a 
macro are termed “events.”
Macros also provide the following functions.

Background A

Background B

Interpolated images

Keyframe 1 Keyframe 2 Keyframe 3

Effect execution
19Creation of Special Effects and Management of Data and Operations
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Menu macros
The term “menu macro” refers to the function whereby a 
sequence of menu operations is saved as data in memory, 
so that it can be recalled as required to automatically 
execute the same sequence of operations.

Macro timeline
By recording macro recall and execute action on a 
timeline, in the same way as for keyframes in an effect, 
you can automatically execute them in a sequence.

Macro attachment
Macro attachment is a function whereby a macro register 
is assigned to a control panel button or a particular position 
of a fader lever, linking the execution of the button 
function or a fader lever operation with a macro execution.

For details, see Chapter 16 “Macros” (Volume 2).

Files

You can save register data, including setup information 
and snapshot information, as a file on a hard disk or 
memory card, and recall it as required.
You can operate on individual files or registers, or together 
in a batch.
Regarding frame memory, it is possible to capture image 
data stored in an external device into frame memory. 

The following files can be saved and recalled.
• Operation mode setup data for system as a whole and 

individual devices
• Device status data for system startup
• Key memory setting data
• Video process memory setting data
• Keyframe effect setting data
• Snapshot setting data
• Wipe snapshot setting data
• DME wipe snapshot setting data
• Key snapshot setting data
• Shotbox setting data
• Macro setting data
• Macro attachment data
• Menu macro setting data
• Frame memory image data

For details, see Chapter 17 “Files” (Volume 2).

Setup

Various settings are required, in order to operate the 
switcher, control panel, DME, external devices, and so on, 
connected together in a single system.
This is referred to as “setup,” and you can carry out the 
setup operations from the Engineering Setup menu.

The settings in the Engineering Setup menu are grouped 
under the following headings.

System setup (System)

For details, see Chapter 18 “System Setup” (Volume 2).

Panel setup (Panel)

For details, see Chapter 19 “Control Panel Setup 
(Panel)” (Volume 2).

Switcher setup (Switcher)

For details, see Chapter 20 “Switcher Setup (Switcher)” 
(Volume 2).

DME setup (DME)

For details, see Chapter 21 “DME Setup (DME)” (Volume 
2).

DCU setup (DCU)

For details, see Chapter 22 “DCU Setup (DCU)” (Volume 
2).

Router/tally setup (Router/Tally)

For details, see Chapter 23 “Setup Relating to Router 
Interface and Tally (Router/Tally)” (Volume 2).

User setup (User Setup)

For details, see Chapter 24 “User Setup (User Setup)” 
(Volume 2).
Setup
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Names and Functions of Parts of the Control Panel

Control Panel: Example Configuration 1 (With Standard Transition Modules)

The MVS-8000X/7000X system control panel comprises a 
number of modules.

The following illustration shows a typical 32-button, 4-M/
E configuration, with standard transition modules used in 
the transition control block.

Control panel configuration 1 (with standard transition modules)

Control Panel: Example Configuration 2 (With Simple Transition Modules)

The following illustration shows a typical configuration, 
with simple transition modules used in the transition 

control block. 

Auxiliary bus control block (page 46)

M/E-1 bank

M/E-2 bank

M/E-3 bank

Cross-point control block (page 22)

Memory card/USB adaptor 
block (page 50)
“Memory Stick”/USB 
connections block (page 50)

Key control block (page 32)

Keyframe control block (page 41)

Device control block (page 35/
page 38)

Menu control block (page 49)

Transition control 
block (standard 
type) (page 27)

Fade to black control block (page 46)

Flexi Pad control block (standard type) (page 30)

Downstream key control block 
(page 56)

Utility/
Shotbox 
control block 
(page 51)

Numeric keypad control block (page 44)

PGM/PST 
(program/
preset) bank
21Names and Functions of Parts of the Control Panel
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Except for the simple modules, this is the same 
configuration as in example configuration 1.

Control panel configuration 2 (with simple transition modules)

Control Panel: Example Configuration 3 (With Compact Transition Modules)

The following illustration shows a typical configuration, 
with compact transition modules used in the transition 
control block. 

Control panel configuration 3 (with compact transition modules)

Cross-Point Control Block

In the cross-point control block, you can select the signals 
to be used in this M/E bank or PGM/PST bank.

There are also modules without the source name displays 
shown in the following figure.

Transition control block and Flexi Pad control 
block (simple type) (page 52)

Independent key transition control block 
(simple type) (page 54)

Transition control block (compact type) (page 58)
Names and Functions of Parts of the Control Panel
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All operations except those of the [SHIFT] button are the 
same as for a module with source name displays.

In the case of the MVS-8000X, only the premium inputs 
(inputs to the switcher PREMIUM INPUTS connectors 1 
to 20) can be selected as key signals on the M/E-4 bank. 

a Cross-point buttons
These buttons select the signals used for video creation on 
this M/E bank or PGM/PST bank. Each row of buttons 
corresponds to one or more signal buses within the 
switcher.

For details of assignment and selection of keys 5 to 8, see 
the following sections in Appendix: “Assigning Buttons for 
Selection of Keys 5 to 8 in the Setup Menu” (page 381) and 
“Selecting Input Signals for Keys 5 to 8 in the Cross-Point 
Control Block” (page 382).

Notes

1Cross-point buttons

5Source name displays

7M/E bank display

3Key bus selection buttons

4UTIL button

8Macro buttons

2XPT HOLD buttons

6Dedicated SHIFT button

Key 1 row

Key 2 row Reentry buttons

Background A row

Background B row Reentry buttons

Background A row

Key 1 row Reentry buttons

Key 2 row

Background B row Reentry buttons

Name Description

Key 1 row • The buttons in this row select the key 1 or 
key 3 signals to be inserted into the video 
on this M/E bank or PGM/PST bank.

• To select the key 1 fill signal, check that the 
right-hand [KEY3] button in the M/E bank 
(or the [DSK3] button in the PGM/PST 
bank) is off, then press the button assigned 
to the desired signal.

• To select the key 3 fill signal, press the 
[KEY3] button, turning it on.

• While the [UTIL] button on the right hand 
side is held down, these buttons are 
assigned to the DME external video bus 
allowing you to select the signal on that 
bus.
23Names and Functions of Parts of the Control Panel
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Cross-point button numbers
Cross-point button and reentry buttons are respectively 
numbered (see page 82).

Assigning signals to button
You can assign a signal to each button using the Setup 
menu.

For details, see “Cross-Point Settings (Xpt Assign Menu)” 
in Chapter 19 (Volume 2).

Visual indications on cross-point buttons

For details, see “Colors of lit cross-point buttons” (page 
84).

Assigning a Delegation Function to the 
Key 1 Row 
You can assign the key/AUX bus delegation function to 
the key 1 row so that signals can be selected in the key 2 
row.

For details, see “Assigning a Key or AUX Bus to a Button 
in the Key 1 or Key 2 Row” in Chapter 19 (Volume 2). 

b XPT (cross-point) HOLD buttons
Turning one of these buttons on enables you to recall a 
keyframe or snapshot while keeping the current cross-
point selection unchanged.
Function of this button varies depending on the operation 
mode selected in the Setup menu.

For details, see “Selecting the Bank to Make the Settings” 
in Chapter 20 (Volume 2).

c Key bus selection buttons
With the following buttons you can assign the key 1 or key 
2 cross-point buttons to the key 3 or key 4 fill bus.

Pressing one of the key delegation buttons [KEY1] to 
[KEY4] in the transition control block (standard type) 
twice in rapid succession changes the state of the 
corresponding one of these buttons, so that you can make 
cross-point selections on the key bus (see page 30).
Using these buttons and the dedicated SHIFT button, you 
can assign keys 5 to 8 to cross-point buttons (see page 
382).

d UTIL (utility) button 
While this button is held down, the cross-point buttons are 
assigned to the following buses, respectively.
Background A row: utility 1 bus
Background B row: utility 2 bus
Key 1 row: DME external video bus
Key 2 row: DME utility 1 bus when the [KEY4] button is 

off, or DME utility 2 bus when the [KEY4] button is 
lit.

In a Setup menu, you can select either of the following two 
modes for these buttons.
• The button takes effect while being held down.

Key 2 row • The buttons in this row select the key 2 or 
key 4 signals to be inserted into the video 
on this M/E bank or PGM/PST bank.

• To select the key 2 fill signal, check that the 
right-hand [KEY4] button in the M/E bank 
(or the [DSK4] button in the PGM/PST 
bank) is off, then press the button assigned 
to the desired signal. 

• To select the key 4 fill signal, press the 
[KEY4] button, turning it on.

• While the [UTIL] button on the right hand 
side is held down, these buttons are 
assigned to the DME utility 1 or 2 bus as 
follows.
When the [KEY 4] button is off: DME 

utility 1 bus
When the [KEY 4] button is on: DME 

utility 2 bus

Background 
A row

• To select the signal as the current 
background video on this M/E bank or 
PGM/PST bank.

• While the [UTIL] button on the right hand 
side is held down in Hold mode, these 
buttons are assigned to the utility 1 bus, 
and can be used to select the signal on that 
bus.

Background 
B row

• To select the signal as the background 
video after the transition on this M/E bank 
or PGM/PST bank.

• While the [UTIL] button on the right hand 
side is held down in Hold mode, these 
buttons are assigned to the utility 2 bus, 
and can be used to select the signal on that 
bus.

Reentry 
buttons

• These allow you to select the video created 
on another bank as background A or B or 
one of the keys 1 to 8.

• For example, to use the video created on 
the M/E-1 bank as background B on the M/
E-2 bank, press the reentry button [M/E 1] 
in the background B row of buttons on the 
M/E-2 bank.

Name Description

Name Description

KEY3 button Press this button, turning it on, to assign the 
key 1 cross-point buttons to the key 3 fill bus.

KEY4 button Press this button, turning it on, to assign the 
key 2 cross-point buttons to the key 4 fill bus.
Names and Functions of Parts of the Control Panel
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• Every time the button is pressed, it toggles between the 
on and off states for key 1 and key 2 rows. For 
background A and background B rows, utility buses 
remain disabled.

e Source name displays
These show the names of the signals which can be selected 
on the cross-point buttons, in two or four characters, or in 
auto mode.
While the [SHIFT] button on the right hand side or the 
[SHIFT] button assigned to the column of cross-point 
buttons is enabled, the source name of the signal assigned 
to the column of cross-point buttons in shift mode appears. 
You can select green, orange, or yellow for the background 
color of the source name display, for each source 
separately. You can set the source name display mode and 
background color in a Setup menu.

f Dedicated SHIFT button
This button has the following three functions.
Selection buttons for key 5 to 8 signals: When this button 

is enabled, you can select key 5 and 7 signals in the key 
1 row, and key 6 and 8 signals in the key 2 row. Each 
time you press the button toggles between enabled and 
disabled.

Source name display shift button: When this button is 
enabled, the source name display shows the shifted 
signal name. Each time you press the button toggles 
between enabled and disabled. In a module with no 
source name display, this button is disabled.

Bus shift button: When this button is enabled, it acts as a 
shift button for all buses on this M/E (PGM/PST) 
bank. Each time you press the button toggles between 
enabled and disabled.

You can select the mode in a Setup menu.

g M/E bank display
This indicates the notional mix/effect bank name to which 
the particular M/E bank is assigned, as a four-character 
identifier.

h Macro buttons
With the following buttons you can enable macro 
attachments, and select the mode for using macro 
attachments.

Name Description

PRE MCRO 
(pre macro)

• Use this button to set a macro attachment 
in pre macro mode. 

• For setting in macro only mode, use this in 
combination with a macro only set button 
assigned to the utility/shotbox control block 
or a user preference button. Alternatively, 
without using the button, you can make the 
selection simply, by pressing 
simultaneously with the [POST MCRO] 
button.

• Function of this button varies as follows 
depending on the operation mode selected 
in the Setup menu. 
- Switching dual background bus mode
- Switching utility/shotbox mode
- Disabling cross-point button operations

For details, see “Setting the Assignment of 
Macro Operation Buttons” in Chapter 19 
(Volume 2).

Notes
For the CCP-6224/6324, [AUX CTRL] is 
assigned to this button (see page 63).

POST 
MCRO (post 
macro)

• Use this button to set a macro attachment 
in post macro mode. 

• For setting in macro only mode, use this in 
combination with a macro only set button 
assigned to the utility/shotbox control block 
or a user preference button. Alternatively, 
without using the button, you can make the 
selection simply, by pressing 
simultaneously with the [PRE MCRO] 
button.

For details, see “Setting the Assignment of 
Macro Operation Buttons” in Chapter 19 
(Volume 2).

Notes
For the CCP-6224/6324, [AUX DSPLY] is 
assigned to this button (see page 63).

MCRO 
ATTCH 
ENBL 
(macro 
attachment 
enable)

When this button is on, the macro 
attachments set for the buttons of the M/E 
bank are enabled. You can make a setup 
setting such that enabled buttons light.
25Names and Functions of Parts of the Control Panel
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Cross-Point Control Block in Key/AUX Bus Delegation Mode

You can assign key and AUX buses to the key 1 row 
buttons in the cross-point control block for use as 
delegation buttons so that signal selection can be made in 
the key 2 row.
In this case, the buttons in the cross-point control block 
operate as follows. 

For details of assignment, see “Assigning a Key or AUX 
Bus to a Button in the Key 1 or Key 2 Row” in Chapter 19 
(Volume 2).

a Key/AUX delegation button row
These buttons select a key bus or AUX bus. 
In setup you can assign the following buses. 
KEY1 to KEY8, DSK1 to DSK8, UTILITY 1, UTILITY 
2, EXT DME, DME UTIL 1, DME UTIL 2, EDIT PVW 
AUX 1 to 48, FMS 1, FMS 2, DME 1 V/K to DME 8 V/K, 
CCR 1, CCR2 

b Cross-point button row
These buttons select a cross-point on the bus selected with 
the key/AUX delegation buttons.

• When you press a button in the cross-point button row 
while holding down the button to which any of KEY1 to 
KEY8 and DSK1 to DSK8 buses is assigned in the Key/
AUX delegation button row, you can select the cross-
point of the key source bus.

• When you select a cross-point while holding down the 
button to which any of  DME 1 V.K to DME 4 V.K buses 
is assigned in the Key/AUX delegation button  row, you 
can select the image on the reverse side of the currently 
viewed DME image.

c Source name / bus name display (for key/AUX 
buses) 

When the DSPLY button is on, these show the names of 
the signals corresponding to the current bus delegation.

The following displays may also appear, depending on the 
state of other buttons.

a) When you are holding down the button to which any of KE1 to KEY8 and 
DSK1 to DSK8 buses is assigned in the key/AUX delegation button row, 
the video signal name is displayed. To display the key signal names when 
other bus is selected, keep the KEY button held down.

b) When you are holding down the button to which any of KEY1 to KEY8 
and DSK1 to DSK8 buses is assigned in the key/AUX delegation button 
row, the key signal names are displayed. To display the key signal names 
when other bus is selected, keep the KEY button held down.

d DSPLY [display] button 
Press to light this button, in order that the source name / 
bus name displays show the signal names or bus names 
corresponding to the current bus delegation.

e DEST button
When both the DSPLY button and this button are on, the 
key bus names or AUX bus names are displayed. 

4DSPLY [display] button 

1Key/AUX delegation button row 

2Cross-point button row 

A/B bus control block 

3Source name/bus name 
display (for key/AUX buses) 

5DEST button

6KEY button

Notes

Button name Display

[DSPLY] [DEST] [KEY]

Off Off - A/B bus signal names

On Off Off Key/AUX bus video 
signal name or key signal 
names a)

On On - Key/AUX bus names

On Off On Key/AUX bus video 
signal name or key signal 
names b)
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f KEY button
When you press a cross-point button while holding down 
this button, the key signal is selected.

Transition Control Block (Standard Type)

In the transition control block, you can modify the output 
of the M/E bank or PGM/PST bank, and perform 

transitions. Both common transition and independent key 
transition operations are possible.

a Next transition selection buttons
Press these buttons, turning them on, to determine what the 
next transition will apply to.

9PRIOR SET button

1Next transition selection buttons

8Key status display

2 Transition type selection buttons

7KF button

6Pattern limit buttons

5 TRANS PVW button

3 Transition execution section

q;Key delegation buttons

qdKey source name display/key 
snapshot buttons

qfKey 
snapshot 
setting 
buttons

qa Independent key transition type selection buttons

qs Independent key transition execution section

4Wipe direction selection buttons
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b Transition type selection buttons
Press one of these buttons, turning it on, to determine the 
type of the next transition (see page 85).

For the method of assigning transition types, see 
“Transition Control Block Button Assignments” in 
Chapter 19 (Volume 2).

When multi-program mode is selected in the Setup menu, 
two or more of the following buttons may light.

For details of multi-program mode, see “Setting 
Transition Control Block Button Assignments” in Chapter 
19 (Volume 2).

You can also assign a function to these buttons to select 
whether or not the fader levers are used as keyframe 
faders.

c Transition execution section
This section is used to carry out a transition and check the 
progress of the transition.

Name Description

BKGD Next transition changes the background.

KEY1 to 
KEY8 
(DSK1 to 
DSK8 in the 
PGM/PST 
bank)

• Press this button, turning it on, to make the 
next transition insert or remove the 
corresponding key (keys 1 to 8). 

• If a key is currently inserted it will be 
removed, and vice versa. 

• In the PGM/PST bank, this inserts or 
removes downstream keys 1 to 8.

For details of assignment and selection of 
keys 5 to 8, see the following sections in 
Appendix: “Assigning Buttons for Selection of 
Keys 5 to 8 in the Setup Menu” (page 381) 
and “Selecting Keys 5 to 8 for Next Transition” 
(page 382).

KEY PRIOR 
(priority)

When this button is lit, the setting of the key 
priority after the next transition is enabled. 
The key priority after the next transition 
appears in the key status display.

ALL Pressing this button turns on a preselected 
set of the [BKGD], [KEY1] to [KEY8], and 
[KEY PRIOR] buttons. Make this setting in a 
Setup menu.

Name Description

MIX In a background transition, the new video 
fades in as the current video fades out.

NAM (non-
additive mix)

The current and new video signals are 
compared, and the signal with the higher 
luminance level is given priority in the output.

SUPER MIX The current video is maintained at 100% 
output for the first half of the transition as the 
new video is mixed while increasing 
progressively to 100%.

PST 
(preset) 
COLOR 
MIX

The color matte (unpatterned display) is 
inserted during transition, replacing the 
current video by the color matte, and then 
replacing the color matte by the new video.

WIPE The current video is replaced by the new 
video, using the wipe pattern selected in the 
Wipe menu.

DME (DME 
wipe)

A wipe type of transition is carried out, using 
the DME effect selected in the DME Wipe 
menu.

FM1&2CLIP, 
FM3&4CLIP, 
FM5&6CLIP, 
FM7&8CLIP

A recorded clip is played back together with 
the transition. At this point, you can also carry 
out a transition (wipe or mix (dissolve)) 
simultaneously together with the clip.

KF 
(keyframe)

Press this button, turning it on, to enable 
using the fader lever as a keyframe fader.

Name Description

Transition 
indicator

This comprises multiple LEDs, which show 
the progress of the transition.

Fader lever • Move up or down to carry out the transition.
• When the [KF] button or a transition type 

selection button to which the KF button 
function has been assigned is lit, you can 
use this as a keyframe fader.

Transition indicator

Transition rate display

Fader lever
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d Wipe direction selection buttons
When a wipe or DME wipe is selected as the transition 
type, you can press to light these buttons to select the wipe 
direction.

e TRANS PVW (transition preview) button
When this button is lit, you can check in advance the video 
changes during the transition, on the preview output from 
the M/E or PGM/PST bank.
During the preview, you can use the fader lever, [AUTO 
TRANS] button, and [CUT] button. One of the following 
functions of this button can be selected in a Setup mode.
• When the transition completes, the system returns to the 

normal mode.
• The transition preview mode is maintained while this 

button is pressed.
• Switching is made between the transition preview mode 

and normal mode every time this button is pressed.

f Pattern limit buttons
The following buttons are used to set a pattern limit.

g KF (keyframe) button
Pressing this button to turn it on allows you to use the fader 
lever as a keyframe fader.

h Key status display
For each of the next transition selection buttons, [KEY1] 
to [KEY4], the corresponding ON indicator lights when 
the key is inserted. It also shows the priority (1 to 4) of 
each key.

i PRIOR (priority) SET button
While this button is held down, you can set the key 
priority.
The setting mode when this button is pressed depends on 
whether or not the [KEY PRIOR] button is lit, as follows.
• When the [KEY PRIOR] button is off, the current key 

priority is set.
• When the [KEY PRIOR] button is lit, the key priority 

after the next transition is set.
Press the [KEY PRIOR] button as required, to switch 
between these two modes.
In either mode, hold down the [PRIOR SET] button, and 
press the button ([KEY1] to [KEY8]) corresponding to the 
key you want to bring to the front.

The key priority establishes a separate priority order within 
each of the groups of keys 1 to 4 and keys 5 to 8. You can 
make any setting within the groups of keys 1 to 4 or keys 
5 to 8, but not for combinations of keys from different 
groups. For example, it is not possible to set a priority 
sequence of keys 1, 5, and 2.

For details, see “Setting the Key Priority in the Transition 
Control Block” (page 88).

The following controls are used as the independent key 
transition control block.

Transition 
rate display

• This shows the “transition rate” (the time 
from the beginning of a transition to its 
completion) set for an auto transition, in 
frames.

• You can set the transition rate using the 
numeric keypad control block, Flexi Pad 
control block, or menu.

AUTO 
TRANS 
(transition) 
button

• Pressing this button carries out an auto 
transition of the set transition rate 
(duration). The transition starts 
immediately, and the button lights amber.

• When the transition completes, the button 
goes off.

CUT button Pressing this button carries out the transition 
as a cut (i.e. instantaneously).

Name Description

NORM 
(normal)

The wipe proceeds in the direction from black 
to white as shown on the pattern in the lists of 
patterns see“Wipe Pattern List” (page 344) 
and “DME Wipe Pattern List” (page 348), or in 
the direction of the arrow.

REV 
(reverse)

The wipe proceeds in the opposite direction to 
that when the [NORM] button is pressed.

NORM/REV 
(normal/
reverse)

The wipe direction alternates between normal 
and reverse every time a transition is 
executed.

Name Description

Name Description

PTN 
(pattern) 
LIMIT

Pressing this button, turning it on, enables the 
pattern limit function.

LIMIT SET • Use this button to set a pattern limit when 
the [PTN LIMIT] button is off.

• Move the fader lever to the position of a 
particular pattern size, and stop it there, 
then press this button to set the pattern limit 
range.

Notes
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j Key delegation buttons
These buttons delegate this independent key transition 
control block to a desired keyer. Press one of the [KEY1] 
to [KEY8] buttons ([DSK1] to [DSK8] in the PGM/PST 
bank), turning it on.
You can press more than one button to select two or more 
keyers.
While these buttons are held down, you can select a key 
source with the cross-point buttons for the key bus.
Pressing one of these buttons twice in rapid succession 
changes its state so that you can make cross-point 
selections on the corresponding key bus.

For details of assignment of keys 5 to 8, see “Assigning 
Buttons for Selection of Keys 5 to 8 in the Setup Menu” 
(page 381) in Appendix.

k Independent key transition type selection buttons
Press one of the following buttons, turning it on, to select 
the independent key transition type.
You can assign any transition types to these buttons in 
setup 

For details, see “Setting Transition Control Block Button 
Assignments” in Chapter 19 (Volume2).

l Independent key transition execution section
The following buttons are used to insert or delete a key, 
and carry out an auto transition.

For details of assignment of keys 5 to 8, see “Assigning 
Buttons for Selection of Keys 5 to 8 in the Setup Menu” 
(page 381) in Appendix.

m Key source name display/key snapshot buttons
These display the source name selected on the 
corresponding keyer. In key snapshot mode, press these 
buttons, corresponding to registers 1 to 8 for the selected 
keyer, to save or recall a key snapshot.

n Key snapshot setting buttons
The following buttons are used to operate a key snapshot.

Flexi Pad Control Block (Standard 
Type)

The Flexi Pad control block is used for saving and 
recalling wipe snapshots, DME wipe snapshots, and 
snapshots, for recalling effects, and shotbox content, and 
for entering the transition rate.

Name Description

MIX Faded in or out.

WIPE Inserted or deleted with a wipe.

DME (DME 
wipe)

Inserted or deleted with a DME wipe.

CUT Instantaneously insert or remove the key 
selected with the delegation buttons.

Name Description

KEY1 ON to 
KEY8 ON 
(DSK1 ON 
to DSK8 ON 
in the PGM/
PST bank)

• Press the corresponding one of these 
buttons to cut key 1 to key 4 in or out 
instantaneously.

• When the key corresponding to the button 
appears in the final program output, the 
button lights red, and otherwise lights 
amber.

AUTO 
TRANS 
(transition)

• These correspond to keys 1 to 4 from left to 
right; press one to carry out an auto 
transition.

• The transition rate for an independent key 
transition can be set in the numeric keypad 
control block, in the Flexi Pad control block, 
or in a menu.

Name Description

K-SS (key 
snapshot)

This enables key snapshot mode.

K-SS 
STORE (key 
snapshot 
store)

To save a key snapshot, hold down this 
button, and press the key source name 
display/key snapshot button corresponding to 
the register you want to save.

K-MOD 
ENBL (key 
modifier 
enable)

To recall key adjustment values and key 
modifier settings when recalling a key 
snapshot, press this button, turning it on.

K-TR ENBL 
(key 
transition 
enable)

To recall independent key transition settings 
when recalling a key snapshot, press this 
button, turning it on.
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a Mode selection buttons
Pressing the following buttons selects the operation mode.

b Bank selection buttons
The following buttons are used to select a bank, and assign 
the memory recall section to the registers of the selected 
bank.

c Memory recall section
This consists of 12 buttons with LCDs. These display 
changes, according to various operation modes.

d UNDO button
The following buttons are used to return a register to its 
state before the register recall operation.

Name Description

WIPE To save or recall a wipe snapshot, or recall 
the pattern number of a wipe pattern, use this 
in combination with the buttons of the 
memory recall section.

DME To save or recall a DME wipe snapshot, or 
recall the pattern number of a DME wipe 
pattern, use this in combination with the 
buttons of the memory recall section.

SNAPSHOT To save or recall a snapshot, use this in 
combination with the buttons of the memory 
recall section.

1Mode selection buttons

5XPT HOLD status display

3Memory recall 
section

2Bank 
selection 
buttons

4UNDO 
button

6Numeric display

EFF (effect) To recall the master timeline or run an effect, 
use this in combination with the buttons in the 
memory recall section.

SHOTBOX To recall or execute a shotbox, use this in 
combination with the buttons of the memory 
recall section.

MCRO 
(macro)

To save, recall or edit a macro, use this in 
combination with the buttons of the memory 
recall section.

TRANS 
RATE 
(transition 
rate)

• To enter the transition rate, press this 
button, turning it on.

• To enter the independent key transition 
rate, hold down this button, and press the 
key delegation button in the independent 
key transition control block.

• To select whether the value is entered in 
frames or as a timecode value, switch the 
[TC] button in the memory recall section on 
or off.

Name Description

BANK0 
(bank 0)

Assigns the memory recall section to bank 0, 
of registers 1 to 10.

BANK1 
(bank 1)

Assigns the memory recall section to bank 1, 
of registers 11 to 20.

BANK SEL 
(bank 
selection)

After pressing this button, press a button in 
the memory recall section to select banks 0 to 
9.

Name Description
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e XPT HOLD (cross-point hold) status display
A bus for which cross-point hold is set appears as a green 
light.

f Numeric display
Depending on the operation mode, this shows the pattern 
number of a wipe or DME wipe, a bank number, a register 
number, a transition rate, and so on in up to four digits.

Key Control Block

Each of the M/E banks and the PGM/PST bank includes 
eight keyers (for keys 1 to 8), and you can delegate this 

control block to any desired keyer. In this control block, 
you can adjust and modify keys.

a Delegation buttons
Pressing the following buttons selects a keyer and an M/E 
or PGM/PST bank to which the key control block is 
delegated.

Name Description

UNDO • After recalling a register, press this button to 
return to the state before recalling the 
register.

• When contents have been saved to a 
register, hold down the [STORE STATS] 
button and press this button to return the 
register to its state before the save 
operation.

STORE 
STATS 
(store 
status)

• When a save or delete operation has been 
carried out on a register, this button lights 
amber.

• After saving to a register, hold down this 
button and press the relevant register button 
to delete the data in the register.

• Again, after a save operation on a register, 
hold down this button and press the [UNDO] 
button to restore the register to its state 
before the save operation.

3Key fill/key source 
selection buttons

2Key type selection 
buttons

1Delegation buttons

4Key modifier buttons

9DME channel 
selection buttons

7Knobs

8Displays

qfAUTO DELEG button

qaOutput destination specification buttons

qd TRACE button

qsOVERRIDE button

6SHOW KEY button

q;ON AIR indicatorsqgRESIZER button

5MORE button
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b Key type selection buttons
Press one of these buttons, turning it on, to select the 
desired key type.
Depending on the selected key type, various parameters 
are displayed, and you can set the values with the knobs.
The following key types can be selected.
LUM: luminance key
LIN: linear key
CRK: chroma key
CVK: color vector key
PTN: key wipe pattern key

For details, see “Key Types” (page 112).

c Key fill/key source selection buttons
Pressing the following buttons selects key fill and key 
source.

d Key modifier buttons
To add an edge modifier to the key, press one of these 
buttons, turning it on.
Depending on the button pressed, parameters appear in the 
displays, and you can set the values with the knobs.
To select a normal edge as the edge type, turn the BDR 
(border), DRP BDR (drop border), SHDW (shadow), 
EMBOS [emboss] and OUTLINE buttons off.

Name Description

M/E 
delegation

Press one of the [M/E 1] to [M/E 4], and [P/P] 
buttons to select the bank (an M/E bank or the 
PGM/PST bank) to which the key control 
block is delegated.

For details of [M/E 4] button assignment, see 
“Assigning a Button for M/E-4 Selection in the 
Setup Menu” (page 380) in Appendix.

Key 
delegation

Press one of the [KEY1] to [KEY8] buttons to 
delegate the key control block to the 
corresponding keyer.

For details of assignment of keys 5 to 8, see 
“Assigning Buttons for Selection of Keys 5 to 8 
in the Setup Menu” (page 381) in Appendix.

TRANS • By pressing this button, you can check the 
DME channel used for DME wipes on the 
M/E or PGM/PST bank. 

• By pressing this button, then pressing one 
of the DME channel selection buttons, you 
can preset the DME channel to be used 
when a DME wipe is selected as the 
transition type for the transition.

• When presetting the DME channel for an 
independent key transition, hold down this 
button, then press one of the [KEY1] to 
[KEY8] buttons, turning the two buttons on, 
beforehand.

Name Description

AUTO SEL 
(selection)

• Use the signal selected on the key fill bus, 
and the paired key source signal. The 
setting of key fill and key source pairs is 
carried out in a Setup menu.

• To use the signal selected on the key fill bus 
as key source (self keying), press the 
[AUTO SEL] button and [SPLIT] button at 
the same time, so that both are off.

SPLIT • To use the signal selected on the key fill bus 
as key fill, and a signal separate from the 
signal assigned in a pair with key fill for key 
source, press this button, turning it on. 

• To select the signal on the key source bus, 
hold down this button, and press a button in 
the key 1 or key 2 row in the cross-point 
control block.

• To use the signal selected on the key fill bus 
as key source (self keying), press the 
[AUTO SEL] button and [SPLIT] button at 
the same time, so that both are off.

MATTE 
FILL

• To use a color matte from the internal 
generator as key fill, press this button, 
turning it on. You can adjust the color matte 
using the knobs.

• When this button is off, the signal selected 
on the key fill bus is used as key fill.

Name Description

KEY DROP • When the selected edge type is “normal” 
and soft edge is off or when drop border or 
shadow is selected, turning this button on 
lowers the key fill and key source position 
by four or eight scan lines as set in the key 
menu. To select 4H or 8H, use the Key 
menu.

• When the selected edge type is “normal” 
and soft edge is selected or when border, 
outline, or emboss is selected, this button 
lights automatically.
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a) When one of these buttons is selected, you can use a special color matte or 
a signal selected on the utility 1 bus for the edge.

e MORE button
When there are more than four parameters, this button 
lights amber. When it is pressed, it changes from amber to 
green and the fifth and subsequent parameters are assigned 
to the knobs, allowing them to be adjusted.

f SHOW KEY button
While this button is held down, a key processed key source 
signal is output from the specified output port. You can 
make the output specification independently for each of 
edit preview and the preview of each M/E or PGM/PST 
bank in a Setup menu.

g Knobs
Turn the knobs to adjust the parameter values.

h Displays
Each display shows the initial letters of the parameter 
name and the parameter value (maximum three digits 
including a minus sign for a negative value).

i DME channel selection buttons
Press one of these buttons, turning it on, to delegate a DME 
channel to the keyer. 
The number of valid DME channel selection buttons 
depends on the number of channels installed in the DME 
processor.

A maximum of four consecutively numbered DME 
channels from the two sets, DME 1 to 4 and DME 5 to 8, 
can be assigned to one keyer. 
On the MVS-8000X, when the signal format is 1080P 
only, the consecutive channel combinations that can be 
selected are any of DME1 and DME2, DME3 and DME4, 
DME5 and DME6, or DME7 and DME8.
On the MVS-7000X, when the signal format is 1080P, the 
above restriction also applies if using the MVE-8000A. 
There is no such restriction for the MKS-7470X/7471X.
DME channel assigned to a keyer cannot be selected on 
another keyer. 
However, using the override function it is possible to 
allocate a channel already allocated to another keyer to the 
currently selected keyer. If DME channel allocations have 
been made in a Setup menu, these buttons cannot be used 
to make DME channel allocations. Using the trace 
function, it is possible to check which keyer a DME 
channel is allocated to.

j ON AIR indicators
These light red when the corresponding DME channels are 
included in the final program output.

k Output destination specification buttons
Pressing the following buttons selects and checks the 
output signal.

BDR 
(border) a)

Apply a border of a uniform thickness to the 
whole key.

DROP BDR 
(drop 
border) a)

Apply a border to two sides of the key (for 
example, below and to the right, or below and 
to the left).

SHDW 
(shadow) a)

Apply a shadow to two sides of the key (for 
example, below and to the right, or below and 
to the left).

OUTLINE • Use the outline of the key.
• Use the key fill signal selected for the key in 

the edge portions.

EMBOS 
(emboss)

• Apply an embossing effect to the periphery 
of the key.

• When emboss is selected, you can use the 
dedicated color matte signal for the emboss 
function.

MAIN 
MASK

Press this button, turning it on, to enable the 
key mask using the main pattern.

SUB MASK Press this button, turning it on, to enable the 
key mask using the sub pattern. 

ZABTN 
(zabton)

Press this button, turning it on, a translucent 
pattern is inserted behind the key.

SOFT 
EDGE

Press this button, turning it on, to soften the 
key edge portions.

Name Description

Name Description

MON (DME 
monitor)

• Hold down this button and press the 
selection button for the DME channel you 
want to assign to the monitor output; you 
can then monitor the output signal on the 
DME monitor output.

• While this button is held down, the DME 
channel selection buttons light as follows, 
allowing you to check the monitor 
assignment.
Lit amber: DME channel that can currently 

be monitored
Lit green: DME channel currently assigned 

to the monitor output
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l OVERRIDE button
To select a DME channel already allocated to another 
keyer or transition to the currently selected keyer (or 

transition), hold down this button, and press the DME 
channel selection button.

m TRACE button
When a DME channel is already allocated to another keyer 
or transition, hold down this button, and press the 
corresponding DME channel selection button, to switch to 
the state in which the keyer (or transition) to which the 
DME channel is allocated is currently selected.

n AUTO DELEG (auto delegation) button
When this button is on, the key delegation selection state 
of the key control block is linked to the key delegation 
selection state of the independent key transition control 
block.

o RESIZER button
Enables or disables resizer.
When this is set to On, you can turn the knob to shrink, 
magnify, or move a key.
You can also rotate the key by pressing the following 
buttons assigned in the Setup menu in advance.
ROT X button: Rotate the key in the horizontal direction.
ROT Y button: Rotate the key in the vertical direction.

For details on resizer, see page 141.

Device Control Block (Trackball)

The device control block is used for three-dimensional 
transform operations using a DME, for wipe pattern 

position setting, and for VTR/disk recorder/frame memory 
clip operation.

a Region selection buttons
The operation mode allocated to the device control block 
depends on the selection state of the region selection 
buttons.

FM FEED 
(frame 
memory 
feed)

• When you press this button, it lights 
momentarily amber, then for the currently 
selected keyer, the key processed signals 
are selected for frame memory sources 1 
and 2.

• If a DME is selected on the currently 
selected keyer, the key fill and key source 
signals to which a DME effect is applied are 
assigned; otherwise the key fill and key 
source are assigned.

• Carrying out a frame memory feed causes 
the [PROC KEY] button to light amber.

PROC KEY 
(processed 
key)

• When this button is on, the key fill/source 
signal subjected to key processing or signal 
subjected to a DME effect on the currently 
selected keyer can be selected as a reentry 
signal (PROC V or PROC K) for the M/E or 
PGM/PST bank, on the auxiliary bus or the 
like.

• If a DME is selected on the currently 
selected keyer, the key fill and key source 
signals to which a DME effect is applied are 
assigned; otherwise the key fill and key 
source are assigned.

Name Description

1Region selection buttons

3 Trackball

4 Z-ring2Operating buttons

5MENU button
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b Operation buttons
The following buttons are used to carry out the 
corresponding operations. Function of each button varies 
with the operation mode.

When the positioner operation mode is enabled

For details of assignment of keys 5 to 8, see “Assigning 
Buttons for Selection of Keys 5 to 8 in the Setup Menu” 
(page 381) in Appendix.

Selected 
buttons

Overview of assigned operation

[M/E 1] to 
[M/E 4], 
[P/P]

• This enables the wipe pattern position 
setting (positioner) operation mode in the 
device control block.

• You can select multiple buttons 
simultaneously.

For details of [M/E 4] button assignment, see 
“Assigning a Button for M/E-4 Selection in the 
Setup Menu” (page 380) in Appendix.

[USER] This enables pattern position setting used for 
color backgrounds.

[DME1] to 
[DME8]

• This enables the three-dimensional 
transform operation mode in the device 
control block.

• Press a button, turning it on, to select a 
DME channel. 

• You can select multiple buttons 
simultaneously.

• The number of valid buttons depends on the 
number of DME processor channels 
installed.

[DEV] • This enables the VTR/disk recorder/frame 
memory operation mode in the device 
control block. 

• Each button functions as follows. 
(From upper left to right in the above figure)
- [M/E1] to [M/E3]: DEV1 (device 1) to 

DEV3 (device 3)
- [P/P]: DEV4 (device 4)
- [USER]: FM1CLIP (frame memory clip 1)
- [Unused]: FM2CLIP (frame memory clip 

2)
- [DME1] to [DME4]: DEV5 (device 5) to 

DEV8 (device 8)
- [FX CTRL]: FM LOOP (frame memory 

loop)
- [DME5] to [DME8]: DEV9 (device 9) to 

DEV12 (device 12)
• To exit from this mode, press the [DEV] 

button again, turning it off.

[RUN 
CTRL]

This enables the effect run control mode in 
the device control block.

[RSZR 
CTRL]

• This enables the resizer control mode in the 
device control block.

• In resizer control mode, select the key with 
the region selection button [K1RSZ] to 
[K8RSZ].

[FX CTRL] Leave this button off for operation.

Alternatively, for details of operation of this 
button, refer to the help information for the 
MPES-FX01 Programmable Effector software.

Name Description

K1 CB1 a) b) • Press this button to enable wipe pattern 
position setting for key 1 (DSK1).

• When the [USER] button is selected, 
pattern position setting for color background 
1 is enabled.

K2 CB2 a) b) • Press this button to enable wipe pattern 
position setting for key 2 (DSK2).

• When the [USER] button is selected, 
pattern position setting is enabled for color 
background 2.

K3 a) b) Press this button to enable wipe pattern 
position setting for key 3 (DSK3).

K4 a) b) Press this button to enable wipe pattern 
position setting for key 4 (DSK4).

MAIN a) Press this button to enable main wipe pattern 
position setting for normal transitions.

SB a) Press this button to enable sub wipe pattern 
position setting for normal transitions.

POS • Press this button to enable pattern 
movement in the x-axis and y-axis 
directions with the trackball.

• When the [USER] button is selected, this 
enables the trackball to move the pattern in 
the x-axis and y-axis directions, and the 
Z-ring to adjust the size of the pattern.

X, Y, Z These restrict the axes affected by the 
trackball and Z-ring to the x-, y- or z-axis.

Selected 
buttons

Overview of assigned operation
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a) Among these buttons, you can select multiple buttons.
b) By setting the operation mode in setup, you can select keys 5 to 8 with 

these buttons. In this case, it is not possible to select more than one of keys 
1 to 8.

When the three-dimensional transform operation 
mode is enabled
The buttons are used for three-dimensional DME 
transformations.

For details, see “Three-Dimensional Transformation 
Operations” (page 270).

When the VTR/disk recorder/frame memory operation 
mode is enabled
The buttons are used for VTR control or playback of frame 
memory clips.

For details, see “Controlling the Tape/Disk Transport” in 
Chapter 12 (Volume 2).

When the resizer control mode is enabled

c Trackball
The effect of operation depends on the operating mode as 
follows.

When the positioner operation mode is enabled
By moving this, you can move the pattern in the x-axis and 
y-axis directions.

When the three-dimensional transform operation 
mode is enabled
Move the trackball to control the x- and y-axes in a three-
dimensional transform.
When the [SRC] or [TRGT] button is held down, the 
trackball operation is switched to a finer control. (fine 
mode)

When the resizer control mode is enabled 
By turning the trackball, you can move in the x and y 
directions of the key to which the resize is applied, change 
the aspect ratio, and rotate around the x-axis and y-axis.
When the [LOC SIZE], [LOC XYZ], or [ASP PS] button 
is held down, the trackball operation is switched to a finer 
control. (fine mode)

d Z-ring 
The effect of operation depends on the operating mode as 
follows.

When the positioner operation mode is enabled
When the [USER] button is selected, by turning the ring 
you can adjust the size of the pattern.

When the three-dimensional transform operation 
mode is enabled
Turn this ring to control the z-axis in a three-dimensional 
transform.
When the [SRC] or [TRGT] button is held down, the Z-
ring operation is switched to a finer control. (fine mode)

CTR 
(center)

• When this button is pressed, the pattern 
position returns to the center.

• When the [USER] button is selected, the 
pattern size also returns to 50.00.

CLR WORK 
BUFR

Press this button twice in rapid succession to 
reset all parameters on the target M/E or 
PGM/PST to their initial values.

Name Description

LOC SIZE 
(ASP: 
aspect)

• Pressing this button and operating the 
trackball or Z-ring changes the aspect ratio 
of a key to which the resizer function is 
applied to. 

• When this button is held down, the trackball 
or Z-ring operation is switched to a finer 
control. (fine mode)

LOC XYZ 
(LOC: 
location)

• Pressing this button and operating the 
trackball or Z-ring moves, shrinks, or 
magnifies a key to which the resizer 
function is applied.

• When this button is held down, the trackball 
or Z-ring operation is switched to a finer 
control. (fine mode)

ROT 
(RSZR: 
resizer)

Press this button, turning it on, to enable the 
resizer.

ASP PS 
(ROT: 
Rotation)

• Pressing this button and operating the 
trackball or Z-ring rotates the key to which 
the resizer function is applied or adjusts 
perspective.

• When this button is held down, the trackball 
or Z-ring operation is switched to a finer 
control. (fine mode)

Name Description

SHIFT/CLR 
WORK 
BUFR (clear 
work buffer)

• Pressing this button once returns the two-
dimensional transformation settings to the 
defaults.

• Pressing the [CLR WORK BUFR] button 
twice, or holding down [SHIFT] and 
pressing the [CLR WORK BUFR] button 
returns all resizer parameter values to the 
defaults.

X, Y, Z These restrict the axes affected by the 
trackball and Z-ring to the x-, y- or z-axis.

SHIFT/CTR 
(center)

• Pressing this button once changes the two-
dimensional transformation settings to the 
closest detent values.

• Pressing the [CTR] button twice, or holding 
down [SHIFT] and pressing the [CTR] 
button returns the two-dimensional 
transformation values to the defaults.

Name Description
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When the effect run control mode is enabled
By turning the Z-ring, you can run the keyframe effect, 
independent of the STOP NEXT KF, EFF LOOP, and 
similar settings in the keyframe control block. Turn 
clockwise to run the effect in the normal direction, and 
counterclockwise for the reverse direction.

When the VTR/disk recorder/frame memory operation 
mode is enabled
Turning the Z-ring controls the tape transport/disk drive/
frame memory clip operations, at a speed determined by 
the operating buttons. Turn clockwise for the normal 
direction, and counterclockwise for the reverse direction.
When the [LOC SIZE] or [LOC XYZ] button is held 
down, the Z-ring operation is switched to a finer control. 
(fine mode)

When the resizer control mode is enabled 
By turning the ring, you can zoom the key to which the 
resizer is applied, and change the aspect ratio and 
perspective.
When the [LOC SIZE], [LOC XYZ], or [ASP PS] button 
is held down, the trackball operation is switched to a finer 
control. (fine mode)

e  MENU button
Press this button, turning it on, to enable adjusting the 
parameters allocated to the knobs in the menu using the 
trackball and Z-ring.
In the case of the DME menu, the operation applies to the 
selected DME channel.
In VTR/disk recorder/frame memory operation mode, 
press this button, setting it to On. This makes it possible to 
carry out timeline start/stop point setting operation for the 
device selected with the device selection buttons (timeline 
setting mode).

Device Control Block (Joystick)

All functions of the joystick type device control block are 
equivalent to the functions of the trackball type, except that 

the trackball and Z-ring operations are carried out with the 
joystick.

a Joystick

When the positioner operation mode is enabled
By moving this, you can move the pattern in the x-axis and 
y-axis directions.
When the [USER] button is selected, by turning the end of 
the joystick you can adjust the size of pattern.

When the three-dimensional transform operation 
mode is enabled
By moving this, you can carry out operations in the x-, y-, 
and z-axes.
When the following buttons are held down, the joystick 
operation is switched to a finer control. (fine mode)

• The button on the end of the joystick
• [SRC] button
• [TRGT] button

When the effect run control mode is enabled
By moving the joystick sideways, you can run the 
keyframe effect, independent of the STOP NEXT KF, EFF 
LOOP and similar settings in the keyframe control block. 
Move to the right to run the effect in the normal direction, 
and to the left for the reverse direction.

Operating buttons

1 JoystickMENU button

Region selection buttons
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When the VTR/disk recorder/frame memory operation 
mode is enabled
Moving the joystick sideways controls the tape transport/
disk drive/frame memory clip operation, at a speed 
determined by the operating buttons. 

When the resizer control mode is enabled 
Move for operations in the x-, y-, and z-axes.

When the following buttons are held down, the joystick 
operation is switched to a finer control. (fine mode)
• The button on the end of the joystick
• [LOC SIZE] button
• [LOC XYZ] button
• [ASP PS] button

Device Control Block (Search Dial)

Using the device control block (search dial), you can 
directly operate an XDCAM, disk recorder, VTR, other 
external device, frame memory clip, or shotbox. The 

device control block (trackball) and device control block 
(joystick) can be used together.

a Timecode display
This shows the current time (CURRENT) and the start and 
stop point timecode values for the current reference device 
(START TC, STOP TC). When you press a device 
selection button, the button lights, selecting the assigned 
device as the reference device, and displaying its setting 
value.
In the case of the [SBOX] buttons, the display does not 
change. When the operation applies to a VTR/disk 
recorder, the displayed setting value depends on whether 
the [TIMELINE] button is on or off, as follows.
When the [TIMELINE] button is on: Displays the start 

and stop points of the last set keyframe on the timeline. 
When the keyframe number is changed and the last 
register and keyframe change, the display also 
changes. (timeline setting mode)

When the [TIMELINE] button is off: Displays the 
Cueup & Play (rewind action) start and stop points.

b Device selection buttons
These buttons are used for selecting assigned external 
devices or frame memory clips. 
Each button can only be assigned to a single device. Carry 
out the assignment in the Setup menu.

For details, see “Assigning Functions to the Device 
Control Block” in Chapter 19 (Volume 2).

To select an assigned device, press the corresponding 
button, which lights green. To select more than one device 
simultaneously, hold down the button for the first 
selection, while pressing the buttons for the other 
selections in turn. The second and subsequent selected 
buttons light amber. If you press another button without 
holding down the first selected button, the second button 
will be the reference device and light green.

1 Timecode display

2Device selection 
buttons

4DELAY button

5Editing buttons

6External device 
operation buttons

7 TIMELINE button

8STOP button

9Search dial

3SBOX buttons
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c SBOX (shotbox) buttons
Assign a shotbox saved in registers 1 to 99. When you 
press a button, the assigned shotbox is selected, and 
executed. Carry out the assignment in the Setup menu.

For details, see “Assigning Functions to the Device 
Control Block” in Chapter 19 (Volume 2).

You can freely assign the portions for device selection, 
SBOX, and DELAY buttons in setup.

d DELAY button
When pressed, this button lights green, the numeric keypad 
control block display changes to DELAY__  :  , and you 
can set the start delay time for the selected device. The 
setting range is from 00:00 to 59:29 (depends on the video 
format). This button goes off when another timecode 
setting button ([START TC], [STOP TC], [SET START 
TC], [SET STOP TC], or [SET DUR]) is pressed.
The DELAY button can be set as a device selection button 
or an SBOX button in the Setup menu. Carry out the 
assignment in the Setup menu.

For details, see “Assigning Functions to the Device 
Control Block” in Chapter 19 (Volume 2).

e Editing buttons
These buttons set start and stop points. These operations 
are only valid while a device is selected with the device 
selection buttons.

Name Description

DEV1 to DEV6 Assign external devices DEV1 to DEV12.

FM1 CLIP, FM2 
CLIP

• Assign frame memory clips FM1 to 
FM8.

• Device selection buttons can be set as 
SBOX buttons or DELAY button in the 
Setup menu.

Name Description

START TC Press this button to set the timecode of the 
start point at that time. The timecode of the 
start point is updated to the current time each 
time this button is pressed. When the device 
the operation applies to is a VTR/disk 
recorder, the start point updated by the setting 
of the [TIMELINE] button is as follows.
When the [TIMELINE] button is On: start 

point of the timeline
When the [TIMELINE] button is Off: start 

point of Cueup & Play

STOP TC Press this button to set the timecode of the 
stop point at that time. The timecode of the 
stop point is updated to the current time each 
time this button is pressed. When the device 
the operation applies to is a VTR/disk 
recorder, the stop point updated by the setting 
of the [TIMELINE] button is as follows.
When the [TIMELINE] button is On: stop 

point of the timeline
When the [TIMELINE] button is Off: stop 

point of Cueup & Play

SET START 
TC, SET 
STOP TC, 
SET DUR

• When pressed, these buttons light green, 
“START TC”, “STOP TC” or “DUR” appears 
in the numeric keypad control block display, 
and you can enter a timecode from the 
numeric keypad. If you enter a numeric 
value and press the [ENTER] button, the 
button goes off, whereas if you press the 
[ENTER] button without entering a numeric 
value the numeric keypad control block 
display shows “--:--:--:--”. If the timecode 
has been set correctly, the entered numeric 
value appears in the timecode display.

• To exit the numeric value entry mode, either 
repeat pressing the same button, or press a 
different numeric keypad control block 
linked button, or a mode selection button 
such as the [EFF] and [SNAPSHOT] 
buttons in the numeric keypad control block.

STB 
(standby) 
OFF

• When pressed, this button flashes amber, 
and the device selected with the device 
selection buttons exits from the standby 
mode.

• This button cannot be used for frame 
memory clip operations.

CUE • When pressed, this button flashes amber 
together with the [ALL STOP] button, and 
the device selected with the device 
selection button is cued up to the start point 
of the material.

• When more than one device is selected, the 
amber flashing continues until the reference 
device is cued up, and when the cueing up 
is finished, this button lights green.

REW When pressed, this button lights amber, and 
material of the device selected with the device 
selection buttons is rewound.
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f External device operation buttons
Pressing the following buttons selects the search dial 
mode.

g TIMELINE button
Press to switch the device selected with the device 
selection buttons to timeline setting mode.

h STOP button
When pressed, this lights amber, and operation of the 
device selected with the device selection buttons stops.

i Search dial
Use this for search and other operations on the material of 
an external device. 

For details, see “Controlling Tape/Disk Transport” in 
Chapter 12 (Volume 2).

Keyframe Control Block

In the keyframe control block, you can carry out effect 
editing and execution.

PLAY • When pressed, this button lights amber, and 
the device selected with the device 
selection buttons plays. The playback stops 
not only if the [STOP] button is pressed, but 
also if any of the [STB OFF], [SHTL], [JOG], 
[CUE], [REW], [PLAY], [FF], and [ALL 
STOP] buttons is pressed.

• When the [VAR] button is pressed while the 
device is playing back, the device plays at 
one times normal speed in variable mode.

FF When pressed, this button lights amber, and 
the material of the device selected with the 
device selection buttons is fast forwarded.

ALL STOP • When pressed, all device material playback 
stops.

• During cueing up of any of the devices, this 
button flashes amber, and when all cueing 
up operations are completed, it lights green.

REC • When pressed simultaneously with the 
[PLAY] button, this button lights red (the 
[PLAY] button lights amber), and the image 
from the selected device is recorded.

• This button cannot be used for frame 
memory clip operations.

Name Description

Name Description

ENBL 
(enable)

When this is pressed, turning it on, the search 
dial [VAR], [JOG], and [SHTL] button 
operations are enabled.

VAR 
(variable)

Sets the search dial to variable mode.

JOG Sets the search dial to jog mode.

SHTL 
(shuttle)

Sets the search dial to shuttle mode.

0EFF LOOP button 1EDIT ENBL button

3Editing buttons

4Duration setting buttons

5KF LOOP button

6PAUSE button

9STOP NEXT KF button

qaAUTO INS button

2Edit point 
specification buttons

7Effect execution 
section

8Effect execution 
direction selection 
buttons
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a EDIT ENBL (edit enable) button
Press this button, turning it on, to enable effect editing 
operations with the keyframe control block.
When macro editing is carried out, this button lights red.

b Edit point specification buttons
The following buttons are used to set an edit point.

c Editing buttons
The following buttons are used to edit keyframes.

Name Description

GO TO TC 
(Go to 
timecode)

Press this button, turning it on, to enter a 
numeric value from the numeric keypad 
control block, and move the edit point to the 
specified timecode position.

GO TO KF 
(Go to 
keyframe)

• Press this button, turning it on, to enter a 
numeric value from the numeric keypad 
control block, and move the edit point to the 
specified keyframe.

• During macro editing, pressing this button 
moves the edit point to the event number 
specified by numeric entry with the numeric 
keypad control block.

PREV KF 
(previous 
keyframe)

• When this button is pressed, the edit point 
moves to the keyframe immediately before 
the current time (the position where the 
effect is currently stopped).

• During macro editing, pressing this button 
moves the edit point to the event 
immediately before the current event.

NEXT KF 
(next 
keyframe)

• When this button is pressed, the edit point 
moves to the keyframe immediately after 
the current time.

• During macro editing, pressing this button 
moves the edit point to the event 
immediately after the current event.

Name Description

ALL Press this button, turning it on, to select all 
keyframes (during macro editing, all events) in 
the effect.

FROM TO Press this button, turning it on, to enter 
numeric values from the numeric keypad 
control block, and select a specified range of 
keyframes (during macro editing, the specified 
range of events).

INS (insert) • When this button is pressed, a new 
keyframe is inserted after the current 
keyframe. 

• Pressing this button while holding down the 
[SHIFT] button inserts a new keyframe 
before the current keyframe.

• During macro editing, pressing this button 
registers an event after the current event.

• During macro editing, holding down the 
[SHIFT] button and pressing this button 
inserts a new event before the current 
event.

MOD 
(modify)

• When this button is pressed, the selected 
keyframe is modified with the values of the 
current keyframe.

• When the edit point is between two 
keyframes, the immediately preceding 
keyframe is modified.

• You can also select multiple keyframes, and 
modify them in a single operation. At this 
time, pressing this button while holding 
down the [SHIFT] button modifies all 
selected keyframes with the changed 
values taken as relative values.

• During macro editing, pressing this button 
amends the selected event.

• You can also select multiple events, and edit 
them in a single operation.

DEL 
(delete)

• When this button is pressed, the selected 
keyframe is deleted.

• When the edit point is between two 
keyframes, the immediately preceding 
keyframe is deleted.

• During macro editing, pressing this button 
deletes the selected event.

• You can also select multiple keyframes or 
macro events, and delete them in a single 
operation.

COPY • When this button is pressed, the selected 
keyframe (during macro editing, macro 
event) is copied.

• You can also select multiple keyframes or 
macro events, and copy them in a single 
operation.
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d Duration setting buttons
The following buttons are used to set the duration of a 
keyframe.

e KF LOOP (keyframe loop) button
Press this button, turning it on, to execute the effect the 
specified number of times through the keyframes in the 
specified range.

f PAUSE button
When this button is pressed, a pause is applied to the 
selected keyframe.
When editing a macro, press this button, turning it on, to 
include a pause event in the macro. The pause length can 
be set in the numeric keypad control block.

g Effect execution section
This section is used to execute an effect, and check the 
progress of the effect execution.

h Effect execution direction selection buttons
The following buttons are used to set the direction of effect 
execution.

PASTE • When this button is pressed, the deleted or 
copied keyframe (during macro editing, 
macro event) is inserted after the current 
keyframe (during macro editing, macro 
event).

• Pressing this button while holding down the 
[SHIFT] button inserts the deleted or copied 
keyframe (during macro editing, macro 
event) before the current keyframe (during 
macro editing, macro event).

SHIFT Hold down this button, and press the [INS] 
button, [MOD] button, or [PASTE] button, to 
obtain the shifted function for the button.

UNDO When this button is pressed, the last executed 
keyframe (during macro editing, macro event) 
insertion, modification, or deletion, or paste 
operation is canceled.

Name Description

KF DUR 
(keyframe 
duration)

Press this button, turning it on, to set the 
keyframe duration of the selected keyframe, 
by numeric value entry from the numeric 
keypad control block.

EFF DUR 
(effect 
duration)

Press this button, turning it on, to set the 
effect duration from the numeric keypad 
control block.

DELAY Press this button, turning it on, to enter a 
delay value from the numeric keypad control 
block.

CONST 
DUR 
(constant 
duration)

• Select the duration mode. 
• When this is lit, the mode is constant 

duration mode, and when off, variable 
duration mode.

Name Description

Name Description

RUN button • When this button is pressed, the effect is 
run from the first keyframe to the last 
keyframe. However, if a pause is set on a 
keyframe, the effect stops at that point.

• Press this button again to resume 
execution, and continue to the next pause 
point or the end of the effect.

Effect 
indicator

This comprises multiple LEDs, which show 
the progress of the effect.

Fader lever Moving this up or down manually runs the 
effect.

REWIND 
button

When this button is pressed, the currently 
recalled effect is rewound to the first 
keyframe.

FF (fast 
forward) 
button

When this button is pressed, the currently 
recalled effect is advanced to the last 
keyframe.

Name Description

NORM 
(normal)

• When this button is lit, effect execution runs 
from the first keyframe to the last keyframe.

• This button automatically goes off when the 
[REV] button is pressed, turning it on.

REV 
(reverse)

• When this button is lit, effect execution runs 
from the last keyframe to the first keyframe.

• This button automatically goes off when the 
[NORM] button is pressed, turning it on.

Effect indicator

Fader lever
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i STOP NEXT KF (stop next keyframe) button
When this button is pressed, turning it on, the effect 
execution range is from the current time to the next 
keyframe.

j EFF LOOP (effect loop) button
When the effect reaches the last keyframe with this button 
on, it returns to the first keyframe and repeats.

k AUTO INS (auto insert) button
When editing a macro, press this button, turning it on, to 
enable the auto insert function, so that every control panel 
operation you carry out is added to the macro as an event.

Numeric Keypad Control Block

The numeric keypad control block is used for region 
selection, for saving and recalling snapshots, effects and 
shotboxes, for entering numeric values for trackball 

operation and keyframe operation, and for transition rate 
entry.

a Mode selection buttons
Pressing the following buttons changes the mode.

b Region selection buttons
These select the functional block (“region”) of the control 
panel to which operations apply.
You can select more than one region at the same time.

The first button you press is taken as the reference region, 
and lights green, while the next pressed button lights 
amber.
With the exception of the [MASTR] and [ALL] buttons, 
you can change the region assignment to the buttons as 
desired in the Setup menu.

NORM/REV 
(normal/
reverse)

Press this button, turning it on, to reverse the 
direction of the effect when it reaches the last 
keyframe or first keyframe.

Name Description

1Mode selection buttons
5Display

2Region selection buttons

3 Function selection 
buttons

4Numeric keypad

Name Description

EFF (effect) Press to save or recall an effect.

SNAPSHOT Press to save or recall a snapshot.

SHOTBOX Press to save or recall a shotbox.

MCRO 
(macro)

Press to save, recall or edit a macro.

TRANS 
RATE 
(transition 
rate)

• Press to set the transition rate. 
• Hold down this button, and press one of the 

key delegation buttons [KEY1] to [KEY8] in 
the transition control block to set an 
independent key transition rate.
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c Function selection buttons
The following buttons are used to switch the function.

a) [STORE] button or [RCALL] button flashes amber when one or more of 
the regions assigned to the Region selection buttons are not selected by the 
Region Select menu.

d Numeric keypad
In addition to the buttons for numeric input, this includes 
buttons for adding attributes to snapshots.

e Display
This shows the selected region name, register number and 
entered numeric values.

Name Description

MASTR 
(master)

Press this, turning it on, to save region 
information in a master snapshot register or 
master timeline register, or to recall such 
region information.

ALL • Select all regions. 
• When any region is already selected, 

pressing this button makes all regions 
unselected.

M/E 1 to 
M/E 4, P/P

Select the corresponding regions, M/E-1, 
M/E-2, M/E-3, M/E-4, and PGM/PST.

For details of [M/E 4] button assignment, see 
“Assigning a Button for M/E-4 Selection in the 
Setup Menu” (page 380) in Appendix.

USER 1 to 
USER 8

Select a User region.

DME1 to 
DME8

Select a DME channel.

P-Bus Select the P-Bus region.

GPI Select the GPI region.

RTR Select the router region.

DEV1 to 
DEV12

Select the Device 1 to Device 12 regions 
respectively.

MCRO Select the macro region.

Name Description

UNDO After recalling a register, press this button to 
return to the state before recalling the register.

STORE 
STATS 
(store 
status)

• This lights amber when data is stored in a 
register.

• After saving data to a register, hold down 
this button and press the [UNDO] button to 
return the register to the state before the 
data was saved.

TC 
(timecode)

Press this button, turning it on, to switch 
transition rate entry to the timecode entry 
mode.

STORE a) Press this button to switch to the mode for 
saving a snapshot, effect, shotbox or macro in 
a register.

RCALL 
(recall) a)

Press this button to switch to the mode for 
recalling a snapshot, effect, shotbox or macro  
from a register.

Name Description

0 to 9 Used to input numeric digits.

. (period) • Enters the decimal point.
• When the [TC] button is lit, enters “00.”
• When the [EFF] button, [SNAPSHOT] 

button or [SHOTBOX] button is lit, this is 
used to find an empty register.

+/–/EFF 
DISS (effect 
dissolve)

• Invert the sign, negative or positive.
• When the [SNAPSHOT] button is lit, applies 

the effect dissolve attribute to a snapshot.

CLR/AUTO 
TRANS 
(clear/auto 
transition)

• Clear an input value, returning to the 
previous state.

• When the [SNAPSHOT] button is lit, applies 
the auto transition attribute to a snapshot.

TRIM/GPI 
ENBL 
(enable)

• After entering a difference value to be 
added to an existing setting, press this 
button to confirm the change.

• When the [SNAPSHOT] button is lit, adds a 
GPI output attribute to the snapshot.

ENTER Confirm an entered value.

Name Description
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Fade to Black Control Block

a FTB (fade to black) button
Press this button to fade to black the program output of the 
PGM/PST bank, at the set transition rate. You can set the 
fade to black transition rate in the menu.

b Preview selection buttons
Each of these buttons can be assigned to any preview 
output in setup.
Each button can be assigned to any preview output in 
setup.

For details, see “Assigning Preview Output to Preview 
Selection Buttons” in Chapter 19 (Volume 2).

c AUTO button
When this button is pressed, the M/E or PGM/PST bank 
preview signal selected on the edit preview bus is 
automatically switched to the program signal depending 
on the on-air status.

Auxiliary Bus Control Block (for AUX Buses)

There are also models without the selected source name 
displays and source name displays shown in the following 
figure.
All operations except those of the [DEST] button and 
[SHIFT] button are the same as for a model with selected 
source name displays and source name displays.

3AUTO button

2Preview selection buttons

1FTB button

Name Description

PST 
(preset)

When this button is pressed, the signal 
selected on the background B row of the 
PGM/PST bank is selected on the edit 
preview bus.

M/E 1 to 
M/E 4, P/P 
(M/E1 to 
M/E 4, P/P 
preview)

The preview signal (M/E-1 PVW, M/E-2 PVW, 
M/E-3 PVW, M/E-4 PVW, P/P PVW) of the 
M/E or PGM/PST bank corresponding to the 
pressed button is selected on the edit preview 
bus.

For details of [M/E 4] button assignment, see 
“Assigning a Button for M/E-4 Selection in the 
Setup Menu” (page 380) in Appendix.

M/E1 K to 
M/E4 K, P/P 
K (M/E1 to 
M/E 4, P/P 
key 
preview)

The key preview signal (M/E-1 K-PVW, M/E-2 
K-PVW, M/E-3 K-PVW, M/E-4 K-PVW, P/P 
K-PVW) of the M/E or PGM/PST bank 
corresponding to the pressed button is 
selected on the edit preview bus.

For details of [M/E 4] button assignment, see 
“Assigning a Button for M/E-4 Selection in the 
Setup Menu” (page 380) in Appendix.

DME V 
(DME 
monitor 
video)

When this button is pressed, the DME monitor 
output video signal (DME MON V) is selected 
on the edit preview bus.

DME K 
(DME 
monitor key)

When this button is pressed, the DME monitor 
output key signal (DME MON K) is selected 
on the edit preview bus.
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a AUX delegation buttons
Press one of these buttons, turning it on, to select the bus 
to which to assign the cross-point buttons in the auxiliary 
bus control block. 

For buses that can be selected, see “Bus Selection” (page 
79).

b Selected source name displays
These show the name of the currently selected signal 
(source) on the bus corresponding to the delegation button.

c DEST (destination) button
Press this button, turning it on, to display the names of 
buses allocated to the delegation buttons in the selection 
source name displays.
In the case of a module without selected source name 
displays, this button is invalid.

d Selected bus display
This shows the name of the bus selected by the auxiliary 
bus delegation buttons.

e Cross-point buttons
The cross-points in the auxiliary bus control block are 
arranged in two rows: an upper row (1st row) and a lower 
row (2nd row), and are allocated to the buses selected with 
the AUX delegation buttons. The 1st row contains the 
cross-point buttons for unshifted buses, and the 2nd row 
contains the cross-point buttons for shifted buses.
When the DME 1V/K to 8V/K buses are selected with the 
AUX delegation buttons, the 1st row cross-point buttons 
are for the currently showing side of DME, and the 2nd 
row are for the reverse side.

By holding down the [2ND] button and making an AUX 
delegation selection, you can allocate the 2nd row to a 
different bus from the 1st row.
In this case, if the 32nd button is set to be a [SHIFT] button 
(in a 32-button system), you can select the shifted cross-
point buttons in the 1st and 2nd rows.

f XPT HOLD (cross-point hold) buttons
Press one of these buttons, turning it on, to enable cross-
point hold.

g KEY button
While this button is held down, you can use the cross-point 
row of buttons to select key signals.

h 2ND button
After selecting a bus with an AUX delegation button, hold 
down this button, and select another AUX delegation, thus 
allocating a different bus in the 2nd row from the 1st row.

i Source name displays
These show the names of the source signals which can be 
selected by the cross-point buttons. While the [SHIFT] 
button is enabled, the shifted signal name is displayed. If a 
different bus is allocated to the 2nd row, while the [2ND] 
button is held down, the 2nd row signal name is displayed.
While the [KEY] button is held down, the source name of 
the key signal assigned to the cross-point buttons appears.

j SHIFT button
While this button is enabled, the shifted signal names 
appear in the source name display. Pressing this buttons 
toggles the source name display between the shifted signal 
names and unshifted signal names.

In the case of a module without source name displays, this button is invalid.

3DEST button

qs Level selection buttons

0SHIFT button5Cross-point buttons

2nd

1st

7KEY button

8 2ND button

qaRTR button

6XPT HOLD buttons

4Selected bus display

1AUX delegation 
buttons

2Selected source 
name displays

9Source name 
displays
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k RTR (router) button
Press this button, turning it on, to assign the auxiliary bus 
control block to router control.

For details of the names and functions of parts for router 
control, see the next section.

l Level selection buttons
Used when the auxiliary bus control block is carrying out 
router control.

Auxiliary Bus Control Block (for Router Control)

Press the [RTR] button, turning it on, to assign the 
auxiliary bus control block to router control.

a Destination selection buttons
Press a button, turning it on, to select the destination to 
which the router source is assigned.
The button pressed to assign a destination to a source 
selection button in the 1st row lights amber. When another 
button is pressed to assign a different destination to a 
source selection button in the 2nd row, it lights green.

b Selected source name displays
These show the source name selected for the destination.
If the source names and destination names are set in the 
Setup menu to “SW’er Local” mode, then the description 
names appear here.

c DEST (destination) button
Press this button, turning it on, to display the names of the 
destinations assigned to the destination selection buttons in 
the selected source name displays.

d Selected destination display
This shows the name of the destination selected by the 
destination selection buttons. If a protected destination is 
selected, the indication “PROTECT” appears.

e Source selection button rows
The destination selected with a destination selection button 
is assigned to a source selection button. Press a source 
selection button to select a source. The 1st row of buttons 
are source selection buttons for the unshifted destinations, 
and the 2nd row are shifted source selection buttons. By 
holding down the [2ND] button, and selecting a 
destination, you can assign a different destination from the 
1st row to the 2nd row. In the 1st row, the button to which 
a destination is assigned lights amber. If a different 
destination is assigned to a button in the 2nd row, the 
button lights green.
When the 32nd button is set as a [SHIFT] button (in a 32-
button system), you can select the shifted sources in the 1st 
and 2nd rows. Also, by using the [KEY] button, you can 
expand the source selection as follows.

2Selected source name 
displays

3DEST button

4Selected destination 
display

5Source selection 
button rows

6XPT HOLD buttons

7KEY button

qsLevel selection buttons

qaRTR button

0SHIFT button

8 2ND button

2nd

1st

1Destination selection 
buttons

9Source name displays

Source 
selection

[SHIFT] [KEY] Selection operation

1 to 31 Off Off Press the source 
selection button.
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f XPT HOLD (cross-point hold) buttons
Not used in router control mode.

g KEY button
When this button is enabled by a setting in the Setup menu, 
by holding it down during a source selection you can 
expand the function of the [SHIFT] button. 

See “Using the Auxiliary Bus Control Block for Router 
Control Setting Button” in Chapter 19 (Volume 2).

h 2ND button
After selecting a destination with the destination selection 
buttons, hold down this button and make another 
destination selection to assign a different destination from 
the 1st row to the 2nd row.

i Source name displays
These display the names of signals (sources) that can be 
selected with the cross-point buttons. While the [SHIFT] 
button is active, the shifted signal names appear. While the 
[KEY] button is held down, the expanded signal names 
appear.
When a different destination is assigned to the 2nd row, the 
2nd row signal names appear only while the [2ND] button 
is held down.

j SHIFT button
While this button is active, the source name displays show 
the shifted signal names. Press this button to toggle 
between the shifted and unshifted states.

k RTR (router) button
Press this button, turning it on, to assign the auxiliary bus 
control block to router control.

l Level selection buttons
To each of the four buttons, plural S-Bus levels are 
assigned in the Setup menu. Press a button, turning it on, 
to make operations apply to those S-Bus levels.

Menu Control Block

a Top menu selection buttons
These select the menu appearing in the menu display.
It is also possible to change the assignment of these buttons 
in setup.

For details, see “Assigning Functions to the Menu Control 
Block Top Menu and User Preference Buttons” in Chapter 
19 (Volume 2).

b Menu display
This shows the menu currently in use.

c Knobs
These adjust the parameter values appearing in the menu.

d User preference buttons
These recall the functions or menus assigned to them in the 
Setup menu.

32 to 62 On Off Press the [SHIFT] 
button, then press the 
source selection 
button.

63 to 93 Off On Hold down the [KEY] 
button, and press the 
source selection 
button.

94 to 124 On On Hold down the [KEY] 
button, and press the 
[SHIFT] button, 
turning it on (the 
[SHIFT] button locks 
here, even when in 
Hold mode), then 
press the source 
selection button.

Source 
selection

[SHIFT] [KEY] Selection operation

2Menu display1 Top menu selection buttons

3Knobs
4User preference buttons
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In the default setup, nothing is assigned to the [PREFS 1] 
to [PREFS 7] buttons.
It is also possible to change the assignment of these buttons 
in setup.

For details, see “Assigning Functions to User Preference 
Buttons” in Chapter 19 (Volume 2).

PREFS 8 button: When this button is on, control of an 
editor from the Remote1 port on the rear panel of the 
switcher is possible. However, even when it is off, 
control of the Edit PVW bus is always possible.

Memory Card/USB Adaptor Block

a Memory card slot
This slot accepts a PCMCIA Type II compliant memory 
card. You can use it in software installation, and for saving 
and reading in data, such as snapshot, keyframe, effect, 
and setup data.

b DEVICE connectors
There are three USB connectors. 
You can connect a device such as a mouse, keyboard, USB 
storage, and so on, that is equipped with a USB interface 
to any of these connectors.

For details on the devices that can be connected, consult 
your Sony representative.

“Memory Stick”/USB Connections 
Block

a “Memory Stick” status indicator
Lights in red during access to a “Memory Stick.”

Do not power the unit off or remove a “Memory Stick” 
when the “Memory Stick” status indicator is lit.

b “Memory Stick” slot
Insert “Memory Sticks.” You can use it in software 
installation, and for saving and reading data, such as 
snapshot, keyframe, effect, and setup data.

See the next item, “About “Memory Sticks”” for more 
information about the usable “Memory Sticks” and their 
handling.

c DEVICE connectors
There are three USB connectors.
You can connect a device such as a mouse, keyboard, USB 
storage, and so on, that is equipped with a USB interface 
to any of these connectors.

For details on the devices that can be connected, consult 
your Sony representative.

About “Memory Sticks”

Usable “Memory Sticks”
This unit has been confirmed to operate with those of the 
following “Memory Sticks” that have a capacity of 8 GB 
(gigabytes) or less. However, operation with all “Memory 
Sticks” is not guaranteed.
• “Memory Stick”
• “Memory Stick PRO”
• “Memory Stick Duo”

1Memory card slot

2DEVICE connectors

Notes

1 “Memory Stick” status indicator

2 “Memory Stick” slot

3DEVICE connectors
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• “Memory Stick PRO Duo”

• When using a “Memory Stick PRO,” high-rate data 
transfer using parallel interface is not supported.

• A “MagicGate Memory Stick” can also be used, but this 
system does not support the MagicGate function.

• When using a “Memory Stick Duo,” be sure to use it 
with a “Memory Stick Duo Adaptor” (MSAC-M2 or 
equivalent). If you insert a “Memory Stick Duo” without 
using the adaptor, there is the possibility that the stick 
cannot be removed, resulting in a serious accident.

Handling “Memory Sticks”
When using “Memory Sticks,” pay attention to the 
following points.

• Do not touch the connector of the “Memory Stick” with 
anything, including your finger or metallic objects.

• Do not attach anything other than the supplied label to 
the “Memory Stick” labeling position.

• Attach the label so that it does not stick out beyond the 
labeling position.

• Carry and store the “Memory Stick” in its case.
• Do not strike, bend, or drop the “Memory Stick.”
• Do not disassemble or modify the “Memory Stick.”
• Do not allow the “Memory Stick” to get wet.
• Do not use or store the “Memory Stick” in a location that 

is:
- Extremely hot, such as in a car parked in the sun
- Under direct sunlight
- Very humid or subject to corrosive substances

Utility/Shotbox Control Block

a Bank selection buttons
Press any of the [BANK1] to [BANK4] buttons to select a 
bank of 24 memory recall buttons. The selected button 
lights amber.

b Memory recall buttons
You can use these buttons to recall frequently used menus, 
utility functions, shotbox registers, or macro registers that 
you have assigned.
When a utility function is allocated to a button, the button 
lights orange (or green depending on the status), and the 
allocated function name appears. 
Pressing the button executes the allocated function. When 
the function constitutes a switching on/off operation, the 
button lights green; otherwise, it only momentarily lights 
green.
When a shotbox register or macro register recall is 
assigned to a button, the button lights orange, and the 

assigned register name appears. (If the register is empty, 
the button goes off.) In the case of a shotbox function, 
pressing the button executes the assigned shotbox 
function, and the button lights yellow. In the case of a 
macro register, pressing the button executes the assigned 
macro, and the button flashes yellow.
You can also assign enabling and disabling of macro 
attachment to use as the MCRO ATTCH ENBL button. 
You can make a setup setting such that when MCRO 
ATTCH ENBL is On, the buttons for which a macro 
attachment is set light.

For details, see “Assigning a Function to a Memory Recall 
Button in the Utility/Shotbox Control Block” in Chapter 
19 (Volume 2).

Notes

1Bank selection 
buttons

2Memory recall 
buttons
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Transition Control Block and Flexi Pad Control Block (Simple Type)

The simple versions of the transition control block and 
Flexi Pad control block shown in the following figure is 
designed to allow simplified operations than with the 

standard type. The transitions carried out using these 
simple-type control blocks are also referred to as “simple 
transitions” in this User’s guide.

Transition Control Block and Flexi Pad 
Control Block (with INH button)

a Transition type selection buttons
You can assign these buttons in setup to any transition 
type.

For details, see “Overall Control Panel Settings (Config 
Menu)” in Chapter 19 (Volume 2).

Press any of the following buttons, turning it on, to select 
the transition type.
Press one of these buttons, turning it on, to determine the 
type of the next transition for a background.
To select the key transition type (see page 85), hold down 
the [KEY1] or [KEY2] button, and press one of the 
following buttons, turning it on.
When multi-program mode is selected in the Setup menu, 
two or more of the following buttons may light.

For details, see “Setting the Operation Mode” in Chapter 
20 (Volume 2).

You can also assign a function to these buttons to select 
whether or not the fader levers are used as key frame 
faders.

2Key transition selection buttons

6Key status display

1 Transition type selection buttons

3 Transition execution section

5Pattern limit buttons

4Wipe direction selection buttons

qaNumeric display

0XPT HOLD status display 

7Mode selection buttons

9UNDO button

8Memory recall section 

Shown above is the right-hand type transition control block (with the right-hand fader lever).

qs INH button

Memory recall section

UNDO button
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b Key transition selection buttons
To insert or delete key 1 on the next transition, hold down 
the [KEY1] button, and select the type of transition using 
the transition type selection buttons. If the key is currently 
not inserted, the transition will insert it, and if the key is 
currently inserted, the transition will delete it. You can use 
the [KEY2] button in a similar way.
While these buttons are held down, you can select a key 
source with the cross-point buttons on the key bus.
Pressing one of these buttons twice in rapid succession 
changes the state of the corresponding key bus so that a 
cross-point can be selected.

c Transition execution section
This section is used to execute a transition, and check the 
progress of the transition.

d Wipe direction selection buttons

For details, see “Wipe direction selection buttons” (page 
29).

e Pattern limit buttons
The following buttons are used to set a pattern limit.

Name Description

MIX In a background transition, the new video 
fades in as the current video fades out.

NAM (non-
additive mix)

The current and new video signals are 
compared, and the signal with the higher 
luminance level is given priority in the output.

WIPE (DME 
wipe)

The current video is replaced by the new 
video, using the wipe pattern selected in the 
Wipe menu.

DME A wipe type of transition is carried out, using 
the DME effect selected in the DME Wipe 
menu.

FM1&2CLIP, 
FM3&4CLIP, 
FM5&6CLIP, 
FM7&8CLIP

A recorded clip is played back together with 
the transition. At this point, you can also carry 
out a transition (wipe or mix (dissolve)) 
simultaneously together with the clip.

KF 
(keyframe)

Press this button, turning it on, to enable 
using the fader lever as a keyframe fader.

Name Description

Fader lever • Move this vertically to carry out a transition.
• When the [KF] button or a transition type 

selection button to which the KF button 
function has been assigned is lit, you can 
use this as a key frame fader.

• When the split fader function is enabled, by 
pressing the projection on the left side of 
the grip you can release the lock and 
separate the two halves of the fader lever. 
With the split fader lever, in a background 
mix transition, you can control the 
background A and B buses independently.

Transition 
indicator

This comprises multiple LEDs, which show 
the progress of the transition.

Transition 
rate display

• This displays the transition rate (the time 
from the beginning of the transition to its 
completion) set for an auto transition, in 
frames.

• You can set the transition rate using the 
numeric keypad control block or menu.

TAKE 
button

• Pressing this button carries out an auto 
transition of the set transition rate. The 
transition starts immediately, and the button 
lights amber.

• When the transition completes, the button 
goes off.

Transition indicator

Fader lever
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f Key status display
For each of keys 1 and 2, when the key is inserted, the 
corresponding ON indicator lights. The OVER indicators 
show the priority between keys 1 and 2, by lighting when 
the corresponding key is on top. For example, when key 1 
appears over key 2 on the program monitor, the OVER 
indicator for key 1 lights.
The following is the Flexi Pad control block.

g Mode selection buttons
The following buttons are used to save and recall a 
snapshot, wipe snapshot, and DME wipe snapshot.

h Memory recall section
This consists of eight buttons with LCDs, whose display 
changes according to the operation mode. Use these in 
combination with the mode selection buttons to save or 
recall wipe snapshots, DME wipe snapshots, or snapshots.

i UNDO button
After recalling a register, press this button to return to the 
state before recalling the register.
With a setup setting, this can be switched to a mode 
selection button for macro setting, and used in 
combination with the buttons in the memory recall section 
for recalling and executing a macro.

j XPT HOLD (cross-point hold) status display
A bus for which cross-point hold is set appears as a green 
light.

k Numeric display
Depending on the operation mode, this shows a wipe or 
DME wipe pattern number, or a register number in up to 
four digits.
In macro mode, this provides indications for macro 
editing.

l INH (inhibit) button
Pressing this button, turning it on, disables the buttons in 
the memory recall section and the [UNDO] button. 

Independent Key Transition Control 
Block (Simple Type)

The left side of this control block controls key 3, and the 
right side controls key 4.
The control block for key 3 only is described as an 
example, but the operations on the key 4 control block are 
the same.
In setup you can assign any key to either side of this 
control block. 
You can also assign the key selection function (key 
delegation) for keys 1 to 8 to any buttons in this control 
block. 

For details, see “Assigning Keys to the Independent Key 
Transition Control Block (Simple Type)” in Chapter 19 
(Volume 2).

Name Description

LIMIT SET • Move the fader lever to the position of a 
particular pattern size, and stop it there, 
then press this button to set the pattern limit 
range. 

• This button is enabled when the [PTN 
LIMIT] button is off.

PTN 
(pattern) 
LIMIT

When a wipe or DME wipe is selected, 
pressing this button, turning it on, enables the 
pattern limit function.

Name Description

WIPE When saving or recalling a wipe snapshot, 
use this in combination with the buttons of the 
memory recall section.

DME When saving or recalling a DME wipe 
snapshot, use this in combination with the 
buttons of the memory recall section.

SNAPSHOT When saving or recalling a snapshot, use this 
in combination with the buttons of the memory 
recall section.
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a Independent key transition type selection buttons
Press one of the following buttons, turning it on, to select 
the independent key transition type.

b Independent key transition execution section
The following buttons are used to carry out independent 
key transition operations.

c K-SS (key snapshot) button
This enables key snapshot mode. In key snapshot mode, it 
is possible to save and recall key snapshots.

d Key source name display/key snapshot buttons
These show the signal name of the key fill selected for key 
3 and the transition rate on two buttons. In key snapshot 
mode, these correspond to registers 1 and 2 for key 3; press 
to save or recall a key snapshot.
To save a key snapshot, with the [K-SS] button lit amber, 
hold down [SHIFT] button and press one of the key 
snapshot buttons.
This saves a key snapshot in the button you pressed, which 
lights yellow.
By assigning [K-SS 3/4] to a key in the Setup menu, you 
can press the button to switch between key snapshot 
registers 1/2 and 3/4. 

For details, see the section “Assigning a Function to the 
Independent Key Transition Control Block (Simple Type)” 
in Chapter 19 (Volume 2).

Name Description

MIX Faded in or out.

WIPE Inserted or deleted with a wipe.

DME Switches the key with a DME wipe.

CUT Inserted or deleted instantaneously.

SHIFT • When setting is made in the Setup menu to 
allow a different transition type for inserting 
or deleting a key, it is possible to display and 
set the transition type after the next 
transition while this button is held down.

• While this button is held down, you can 
select a key source with the cross-point 
buttons for the key bus.

• If you press this button twice in rapid 
succession, the key bus selection button 
[KEY3] in the cross-point control block 
lights, and a key 3 key bus cross-point can 
be selected.

• If you press this button, while holding down 
[TRANS RATE] button in the numeric 
keypad control block, you can set the 
independent key transition rate on the 
control block.

3K-SS button

4Key source name display/key 
snapshot buttons

1 Independent key transition type 
selection buttons

2 Independent key transition 
execution section

Name Description

KEY3 ON • This inserts or deletes key 3 
instantaneously. 

• When key 3 is present in the final program 
output from the switcher, this lights red, and 
otherwise lights amber.

TAKE This carries out an auto transition on key 3.
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Downstream Key Control Block

a Key delegation buttons
Press one of the [DSK1] to [DSK4] buttons to delegate this 
control block to the corresponding keyer.
Using the Setup menu, it is possible to assign these to 
DSK5 to DSK8 or M/E keys 1 to 8.
While these buttons are held down, you can select a key 
source with the cross-point buttons for the key bus.
Pressing one of these buttons twice in rapid succession 
changes its state so that you can make cross-point 
selections on the corresponding key bus.

b Independent key transition type selection buttons
Press one of these buttons, turning it on, to select the 
downstream key transition type.

c Independent key transition execution section
This section is used to carry out an independent key 
transition, and check the progress of the transition.

1Key delegation buttons

5Key source name display/key snapshot buttons

4Key snapshot setting
buttons

3 Independent key 
transition execution 
section

2 Independent key 
transition type selection 
buttons

Name Description

MIX Carry out a dissolve with the key selected with 
the key delegation buttons.

WIPE Carry out a wipe with the key selected with the 
key delegation buttons.

DME This switches the key selected with the key 
delegation buttons, using a DME wipe.

CUT Instantaneously insert or delete the key 
selected with the key delegation buttons.

SHIFT When setting is made in the Setup menu to 
allow a different transition type for inserting or 
deleting a key, it is possible to display and set 
the transition after the next transition while 
this button is held down.

Name Description

Transition indicator

Fader lever
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d Key snapshot setting buttons
Pressing the following buttons carries out key snapshot 
operations.

e Key source name display/key snapshot buttons
These display the selected source name for each 
corresponding keyer. In snapshot mode, they correspond 
to registers 1 to 4 of the selected keyer, and pressing the 
button saves or recalls a key snapshot.

Downstream Key/Fade-to-Black 
Control Block

a Key delegation buttons
Press DSK1 or DSK2, to select the keyer. Each button can 
be assigned to any key in setup.

For details, see “Assigning Keys to the DSK1 and DSK2 
Buttons in the Downstream Key/Fade-to-Black Control 
Block” in Chapter 19 (Volume 2).

While these buttons are held down, you can select a key 
source with the cross-point buttons on the key bus.
Pressing one of these buttons twice in rapid succession 
changes its state so that you can make cross-point 
selections on the corresponding key bus in the PGM/PST 
bank.

b Independent key transition execution section
Pressing the following buttons carries out transition 
operations of the corresponding downstream key.

Name Description

DSK1 
(downstrea
m key 1) 
ON to DSK4 
ON buttons

• Press these to instantaneously cut the 
downstream keys 1, 2, 3, and 4 in or, when 
the downstream keys are already inserted, 
cut them out.

• When the key corresponding to the button 
appears in the final program output, the 
button lights red, and otherwise lights 
amber.

TAKE 
buttons

• These correspond to downstream keys 1, 2, 
3, and 4 from left to right; press to execute 
an auto transition. The transition starts 
immediately, and the button lights amber.

• When the transition completes, the button 
goes off.

Fader lever Move this vertically to carry out a manual 
downstream key transition.

Transition 
indicator

This comprises multiple LEDs, which show 
the progress of the downstream key transition.

Name Description

K-SS (key 
snapshot)

This enables key snapshot mode.

K-SS 
STORE 
(key 
snapshot 
store)

To save a key snapshot, hold down this 
button, and press the key source name 
display/key snapshot button for the register 
you want to save.

UNDO (key 
snapshot 
recall undo)

This undoes the last key snapshot recall.

1Key delegation 
buttons

2 Independent key transition 
execution section

3K-SS button

4Key source name display/key snapshot buttons

5 FTB button

6AUTO button

7Preview selection 
buttons
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c K-SS (key snapshot) button
Pressing this button, turning it on, enables the key snapshot 
mode. In this mode, you can save and recall key snapshots.

d Key source name display/key snapshot buttons
Each column of two buttons relates to the corresponding 
downstream key 1 or 2. The upper button displays the 
name of the key fill signal selected for the key, and the 
lower button shows the transition rate.
In key snapshot mode, these buttons correspond to 
registers 1 to 4 of the keyer selected with the key 
delegation buttons, and pressing a button recalls the key 
snapshot. To save a key snapshot, hold down the [STORE] 
button in the numeric keypad control block, and press the 
button for the desired register.

e FTB (fade to black) button
Press this button to fade to black the program output of the 
PGM/PST bank, at the set transition rate. You can set the 
fade to black transition rate in the menu.

f AUTO button
When this button is pressed, the M/E or PGM/PST bank 
preview signal selected on the edit preview bus is 
automatically switched to the program signal depending 
on the on-air status.

g Preview selection buttons
Press one of these buttons to select a signal on the edit 
preview bus. Each of these buttons can be assigned to any 
key in setup.

For details, see “Assigning Preview Output to Preview 
Selection Buttons” in Chapter 19 (Volume 2).

Transition Control Block (Compact Type)

The compact version of the transition control block shown 
in the following figure has fewer buttons than the standard 
type. Independent key transition operations can also be 
controlled with the compact transition control block.

Name Description

DSK1 ON, 
DSK2 ON

• Press these to cut in the corresponding 
downstream key 1 or 2. 

• When the key is already inserted, pressing 
the button cuts it out.

• Each button lights red when the 
corresponding key is inserted in the 
program output (final output from the 
switcher), and lights amber at other times.

AUTO 
TRANS

• The left button applies to DSK1 and the 
right button to DSK2; press these buttons to 
carry out an auto transition. 

• The transition immediately starts, and the 
button lights amber. 

• When the transition completes, the button 
goes off.

Name Description

PST 
(preset)

When this button is pressed, the signal 
selected on the background B row of the 
PGM/PST bank is selected on the edit 
preview bus.

M/E 1 to 
M/E 4, P/P 
(M/E1 to 
M/E 4, P/P 
preview)

The preview signal (M/E-1 PVW, M/E-2 PVW, 
M/E-3 PVW, M/E-4 PVW, P/P PVW) of the M/
E or PGM/PST bank corresponding to the 
pressed button is selected on the edit preview 
bus.

For details of [M/E 4] button assignment, see 
“Assigning a Button for M/E-4 Selection in the 
Setup Menu” (page 380) in Appendix.

M/E1 K to 
M/E4 K, P/P 
K (M/E1 to 
M/E 4, P/P 
key 
preview)

The key preview signal (M/E-1 K-PVW, 
M/E-2 K-PVW, M/E-3 K-PVW, M/E-4 K-PVW, 
P/P K-PVW) of the M/E or PGM/PST bank 
corresponding to the pressed button is 
selected on the edit preview bus.

For details of [M/E 4] button assignment, see 
““Assigning a Button for M/E-4 Selection in the 
Setup Menu” (page 380) in Appendix.

DME V 
(DME 
monitor 
video)

When this button is pressed, the DME monitor 
output video signal (DME MON V) is selected 
on the edit preview bus.

DME K 
(DME 
monitor key)

When this button is pressed, the DME monitor 
output key signal (DME MON K) is selected 
on the edit preview bus.
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a Next transition selection buttons
Press these buttons, turning them on, to determine what the 
next transition will apply to.

b Transition type selection buttons
You can assign these buttons in setup to any transition 
type.

For details, see “Setting Transition Control Block Button 
Assignments” in Chapter 19 (Volume 2).

Press one of these buttons, turning it on, to determine the 
type of the next transition (see page 85).
When multi-program mode is selected in the Setup menu, 
two or more of the following buttons may light.

For details, see “Settings for Switcher Configuration 
(Config Menu)” in Chapter 20 (Volume 2).

You can also assign a function to these buttons to select 
whether or not the fader levers are used as keyframe 
faders.

2 Transition type selection buttons

5 TRANS PVW button

8 Independent key 
transition execution 
section7PRIOR SET button

1Next transition selection 
buttons

6Key status display

3 Transition execution 
section

4Wipe direction selection 
buttons

Name Description

BKGD Next transition changes the background.

KEY1 to 
KEY8 
(DSK1 to 
DSK8 in the 
PGM/PST 
bank)

• Press this button, turning it on, to make the 
next transition insert or remove the 
corresponding key (keys 1 to 8).

• If a key is currently inserted it will be 
removed, and if it is not currently inserted, it 
will be inserted.

• In the PGM/PST bank, this inserts or 
removes downstream keys 1 to 8.

For details of assignment and selection of 
keys 5 to 8, see the “Assigning Buttons for 
Selection of Keys 5 to 8 in the Setup Menu” 
(page 381) and ““Selecting Keys 5 to 8 for 
Next Transition” (page 382).

KEY PRIOR 
(priority)

• When this button is lit, the setting of the key 
priority after the next transition is enabled.

• The key priority after the next transition 
appears in the key status display.

ALL • Pressing this button turns on a preselected 
set of the [BKGD], [KEY1] to [KEY8], and 
[KEY PRIOR] buttons.

• Make this setting in a Setup menu.

Name Description

MIX In a background transition, the new video 
fades in as the current video fades out.

NAM (non-
additive mix)

The current and new video signals are 
compared, and the signal with the higher 
luminance level is given priority in the output.

SUPER MIX The current video is maintained at 100% 
output for the first half of the transition as the 
new video is mixed while increasing 
progressively to 100%.
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c Transition execution section
This section is used to carry out a transition, and check the 
signal status during the transition.

d Wipe direction selection buttons

For details, see “Wipe direction selection buttons” (page 
29).

e TRANS PVW (transition preview) button
When this button is lit, you can check in advance the video 
changes during the transition, on the preview output from 
the M/E or PGM/PST bank.
During the preview, you can use the fader lever, [AUTO 
TRANS] button, and [CUT] button. One of the following 
functions of this button can be selected in a Setup menu.
• When the transition completes, the system returns to the 

normal mode.
• The transition preview mode is maintained while this 

button is pressed.
• Switching is made between the transition preview mode 

and normal mode every time this button is pressed.

f Key status display
For each of keys 1 to 4, the corresponding ON indicator 
lights when the key is inserted. It also shows the priority (1 
to 4) of each key.

g PRIOR (priority) SET button
While this button is held down, you can set the key 
priority.
The setting mode when this button is pressed depends on 
whether or not the [KEY PRIOR] button is lit, as follows.
• When the [KEY PRIOR] button is off, the current key 

priority is set.
• When the [KEY PRIOR] button is lit, the key priority 

after the next transition is set.
Press the [KEY PRIOR] button as required, to switch 
between these two modes.
In either mode, hold down the [PRIOR SET] button, and 
press the button ([KEY1] to [KEY8]) corresponding to the 
key you want to bring to the front.

The key priority establishes a separate priority order within 
each of the groups of keys 1 to 4 and keys 5 to 8. You can 
make any setting within the groups of keys 1 to 4 or keys 
5 to 8, but not for combinations of keys from different 
groups. For example, it is not possible to set a priority 
sequence of keys 1, 5, and 2.

PST (preset) 
COLOR MIX

The color matte (unpatterned display) is 
inserted during transition, replacing the 
current video by the color matte, and then 
replacing the color matte by the new video.

WIPE (DME 
wipe)

The current video is replaced by the new 
video, using the wipe pattern selected in the 
Wipe menu.

DME A wipe type of transition is carried out, using 
the DME effect selected in the DME Wipe 
menu.

FM1&2CLIP, 
FM3&4CLIP, 
FM5&6CLIP, 
FM7&8CLIP

A recorded clip is played back together with 
the transition. At this point, you can also carry 
out a transition (wipe or mix (dissolve)) 
simultaneously together with the clip.

KF 
(keyframe)

Press this button, turning it on, to enable 
using the fader lever as a keyframe fader.

Name Description

Transition 
indicator

This comprises multiple LEDs, which show 
the progress of the transition.

Fader lever • Move this vertically to carry out a manual 
transition.

• When the [KF] button or a transition type 
selection button to which the KF button 
function has been assigned is lit, you can 
use this as a keyframe fader.

Transition 
rate display

• This shows the “transition rate” (the time 
from the beginning of a transition to its 
completion) set for an auto transition, in 
frames.

• You can set the transition rate using the 
numeric keypad control block, Flexi Pad 
control block, or menu.

Name Description

Transition indicator

Fader lever

AUTO 
TRANS 
(transition) 
button

• Pressing this button carries out an auto 
transition of the set transition rate 
(duration). The transition starts immediately, 
and the button lights amber.

• When the transition completes, the button 
goes off.

CUT button Pressing this button carries out the transition 
as a cut (i.e. instantaneously).

Notes

Name Description
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For details, see “Setting the Key Priority in the Transition 
Control Block” (page 88).

h Independent key transition execution section
KEY1 TRANS (transition) to KEY8 TRANS (DSK1 

TRANS to DSK8 TRANS in the PGM/PST block) 

buttons: Press the corresponding one of these buttons 
to cut key 1 to key 8 in or out automatically at the set 
transition rate. When the key corresponding to the 
button appears in the final program output, the button 
lights red, and otherwise lights amber. During a 
transition, the button lights green.

CCP-6224 2M/E Control Panel

In this system, you can use the built-in CCP-6224 2M/E 
Control Panel. This panel has two cross-point control 
blocks, two transition control blocks (compact type), one 

device control block (track ball), and one Multifunction 
Flexi Pad control block.

a Cross-point control block

For details of cross-point control block operation, see 
“Cross-Point Control Block” (page 22).

For operations in AUX control mode, see “Auxiliary Bus 
Control Block (for AUX Buses)” (page 46) and “Cross-
Point Control Block (CCP-6224/6324) in the AUX 
Operating Mode” (page 62).

b Transition control block (compact type)

For details of operations, see “Transition Control Block 
(Compact Type)” (page 58).

c Device control block (track ball)

For details of operations, see “Device Control Block 
(Trackball)” (page 35).

d Multifunction Flexi Pad control block

For details of operations, see “Multifunction Flexi Pad 
Control Block” (page 63).

CCP-6324 3M/E Control Panel 

In this system, you can use the built-in CCP-6324 3M/E 
Control Panel. This panel has three cross-point control 
blocks, three transition control blocks (compact type), one 
device control block (trackball), and one Multifunction 
Flexi Pad control block.

1Cross-point control block

4Multifunction Flexi 
Pad control block

2Transition control block (compact type)

3Device control block 
(track ball)
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a Cross-point control block

For details of operations, see “Cross-Point Control 
Block” (page 22) and “CCP-6224 2M/E Control Panel” 
(page 61).

b Transition control block (compact type)

For details of operations, see “Transition Control Block 
(Compact Type)” (page 58).

c Device control block (track ball)

For details of operations, see “Device Control Block 
(Trackball)” (page 35).

d Multifunction Flexi Pad control block

For details of operations, see “Multifunction Flexi Pad 
Control Block” (page 63).

Cross-Point Control Block (CCP-6224/6324) in the AUX Operating Mode

On the CCP-6224/6324, when using a [24-column] cross-
point control block, if the [PRE MCRO] button is assigned 
to switch to AUX operating mode, by pressing this button 

you can switch the control block button functions as 
follows, and select the AUX bus and its source signals 
(AUX panel-less function).

a AUX control block
This selects the AUX bus and the assigned source signals.
This cross-point control block can be switched to AUX 
control mode with the [AUX CTRL] button, and the key 1 

row used as AUX delegation buttons, and the key 2 row 
used as AUX bus cross-point selection buttons, with the 
source name display showing the source names or the bus 
names (AUX panel-less function). To use this function, the 

1Cross-point control block

4Multifunction Flexi 
Pad control block

2 Transition control block 
(compact type)

3Device control block 
(track ball)

2AUX CTRL (AUX control) button

3DEST (destination) 
button

1AUX control block

5AUX DSPLY (AUX 
display) button

4KEY button

7Source/bus name 
displays

6A/B bus control block

AUX cross-point buttons

AUX delegation buttons
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function for switching to AUX control mode must first be 
assigned to the [PRE MCRO] and [POST MCRO] buttons. 

For the method of making this assignment, see Chapter 19 
“Assigning the AUX Bus Control Mode Switching 
Function” (Volume 2).

b AUX CTRL (AUX control) button
This switches the cross-point control block to the AUX 
operating mode. However, using this function requires an 
assignment to have been made in the Setup menu.

For details of assigning the function for switching to AUX 
operating mode, see “Assigning the AUX Bus Control 
Mode Switching Function” in Chapter 19 (Volume 2).

c DEST (destination) button
When you press this button, turning it on, the source name 
displays show the names of the buses assigned to the AUX 
delegation buttons.

d KEY button
When you press this button, turning it on, the source name 
displays show the names of the key source signals assigned 
to the AUX cross-point buttons, and they are now 
selectable.

e AUX DSPLY (AUX display) button
This switches the source name displays to the AUX 
operating mode (by default showing the video source 
signal names).

f A/B bus control block
Select the source signals for the background A/B buses.

g Source/bus name displays
In the AUX operating mode, these show the information in 
the following table, according to the states of the [AUX 
DSPLY], [DEST], and [KEY] buttons.

Multifunction Flexi Pad Control Block

You can use the Multifunction Flexi Pad control block for 
creating, saving, and recalling snapshots, wipe snapshots, 
and DME wipe snapshot key snapshots, effects, shotbox 
recall, macro execution, transition rate settings, and key 
adjustments.

Name Description

AUX 
delegation 
buttons

• These select the AUX bus.
• When you press a button, turning it on, this 

selects the assigned bus as the AUX bus.
• You can make the rightmost button a 

[SHIFT] button, in which case each button 
can be used to select two buses.

For details of the buses that can be selected, 
see “Bus Selection” (page 79).

AUX cross-
point 
buttons

• These select the source signal to be 
assigned to the AUX bus.

• When you press a button, turning it on, this 
selects the assigned video/key source 
signal and assigns it to the bus selected 
with the AUX delegation buttons. 

• To select a key, hold down the [KEY] button 
and press the AUX cross-point button to 
which the desired key signal is assigned. 

• You can make the rightmost button a 
[SHIFT] button, in which case each button 
can be used to select two video/key source 
signals.

• When one of the DME 1V/K to 4V/K buses 
is selected with the AUX delegation buttons, 
this selects the video side currently visible 
on the DME, and if you hold down the AUX 
delegation button, you can also select the 
reverse side of the video.

AUX cross-point buttons

AUX delegation buttons

[AUX 
DSPLY]

[DEST] [KEY] Indication

Off Off Off Background A/B bus source 
signal names

On Off Off Video source signal names for 
AUX bus

On On Off Bus names for AUX bus

On Off On Key source signal names for 
AUX bus
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 a Mode selection buttons
Pressing the following buttons selects the mode.

b EDIT ENBL (edit enable) button
By pressing this, turning it on, you can carry out the 
following operations.
• Effect creation/editing
• Snapshot attribute setting
• Shotbox creation/editing
• Macro creation/editing
• Wipe adjustments
• DME wipe adjustments

c Region selection buttons
These select the function block to which operations apply.
When the mode selection button selection is EFF/
SNAPSHOT/SHOT BOX/MCRO, you can select multiple 
region selection buttons simultaneously. In this case, the 
first button pressed lights green as the reference region, 
and the other buttons pressed light amber (the buttons for 
the regions shown in the memory recall section are 
yellow).

1Mode selection buttons

2EDIT ENBL button

3Region selection buttons

4Alphanumeric display

5Memory recall section 6Adjustment knob 
displays

7Adjustment knobs

Name Description

EFF (effect) Press this to carry out effect creation/recall/
editing/execution/deletion.

SNAPSHOT Press this to carry out snapshot creation/
recall/editing/deletion.

SHOTBOX Press this to carry out shotbox creation/recall/
editing/execution/deletion.

MCRO 
(macro)

Press this to carry out macro creation/editing/
execution/deletion.

WIPE (wipe 
snapshot)

Press this to carry out wipe snapshot creation/
recall/deletion and wipe adjustments.

DME WIPE 
(DME wipe 
snapshot)

Press this to carry out DME wipe snapshot 
creation/recall/deletion and DME wipe 
adjustments.

TRANS 
RATE 
(transition 
rate)

Press this to set the transition rate.

KEY ADJ 
(key adjust)

Press this to carry out key adjustments and 
set modifiers.

KEY SS 
(key 
snapshot)

• Press this to carry out key snapshot 
creation/recall/deletion.

• By default, this is not assigned to a mode 
selection button, so before use it is 
necessary to assign to a mode selection 
button in the Setup menu.

Name Description

ALL/KEY 
SHIFT

• Selects all regions.
• When any region is selected, press this 

button to unset the selection of all regions.
• When KEY ADJ (key adjust) or KEY SS 

(key snapshot) is selected as the function 
mode, these buttons are for KEY5 to KEY8 
selection.

DME1 to 
DME2

Select DME channels.
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d Alphanumeric display
This shows the selected region name or register number, 
and entered numeric values.

e Memory recall section
This comprises 16 LCD buttons, each with a display that 
changes according to the operating mode.

f Adjustment knob displays
Each of these shows the initial letter of the parameter that 
can be adjusted with the knob to the right, and the setting 
value (three digit places, including the minus sign).

g Adjustment knobs
Use these to adjust the parameters selected with the 
memory recall section buttons.

Basic Menu Operations

Overview

In the MVS system, all detailed settings for basic 
operations such as transitions, keys, wipes, and DME are 
made in menus.
You can also display menus on an external monitor, and 
use a mouse. The menu operations using a mouse are 
basically the same as the menu control block operations 
described here, with mouse clicks in place of button 
presses. However, since the monitor has no knobs for 
adjusting the parameters in the menu control block.

For details of operations corresponding to these knob 
operations, see “Operation With a Mouse” (page 75).

About the Top Menu List

When the control panel is powered on, the top menu list 
appears as shown below.

You can also display this by selecting VF1 ‘Top Menu 
List’ after pressing the [HOME] button at the upper left in 
the top menu selection button area of the menu control 
block.

To display the top menu from the top menu 
list
In the same way as for the top menu selection buttons in 
the menu control block, press each button to display the 
particular top menu in the menu display.

• The arrangement of buttons in the top menu list and the 
default arrangement of the top menu selection buttons 
may be different.

M/E1, M/E2, 
P/P

Select the M/E-1, M/E-2, and PGM/PST 
regions respectively.

USER4 Selects the USER4 region.

DEV1 Selects the device 1 region.

MORE • Displays buttons in the memory recall 
section for regions not assigned to a region 
selection button, so that they can be 
selected. 

• By default the following regions are shown 
on the memory recall section buttons.

MSTR (master snapshot, master timeline 
registers), USER1 to 3, USER5 to 8, 
MCRO (macro), DEV2 (device 2), PBUS, 
GPI, RTR (router)

• If there is a region selected in the memory 
recall section, this is indicated by the MORE 
button lighting green.

• To revert the button displays in the memory 
recall section, press the [MORE] button 
once more, or press the [EXIT] button that 
appears in the memory recall section.

• Note that except for the [ALL], [EXIT], and 
[MORE] buttons, you can freely change the 
assignment to regions in the Setup menu.

Name Description

Notes
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• Changing the top menu selection button assignment in 
setup has no effect on the top menu list.

To shut down the menus
Press the [Shutdown] button at the lower right.
This operation is the same as the shut down operation in 
the top menu window (see page 70).

Accessing Menus

You can use any of the following methods to access a 
menu, and the initially displayed menu page depends on 
the method used.

Pressing a top menu selection button in the menu 
control block
This displays the page you last accessed in the particular 
menu. After initially powering on the system, however, the 
page of VF1 - HF1 of the particular menu is always 
selected.

For details of the menus which can be recalled, see 
“Menus accessed from a top menu selection button” (page 
66).

For details of the VF buttons and HF buttons, see 
“Interpreting the Menu Screen” (page 67).

Pressing a button other than a top menu button 
twice in rapid succession
Depending on the button, this may display a fixed page or 
the page selected last time you accessed the menu.

For details of the menus which can be recalled, see 
“Menus accessed by pressing a button twice” (page 383).

Press the menu page selection button at the top 
left of the menu display
The top menu window appears; press the top menu 
selection button for the particular menu, or enter the menu 
number with the numeric keypad, and press the Enter 
button.

Menus accessed from a top menu selection button

Buttons Menus Function See

HOME Home Recalling menus using the top menu list 
or shortcut menu

Top menu list: page 65 Shortcut menu: 
page 76

M/E 1 M/E-1 Transition, keys, and wipe settings for the 
M/E-1 bank

page 91 (transitions), page 113 (keys), 
page 152 (wipes)

M/E 2 M/E-2 Transition, keys, and wipe settings for the 
M/E-2 bank

M/E 3 M/E-3 Transition, keys, and wipe settings for the 
M/E-3 bank

M/E 4 M/E 4 Transition, keys, and wipe settings for the 
M/E-4 bank

P/P PGM/PST Transition, downstream key, and wipe 
settings for the PGM/PST bank

FRAME MEM Frame Memory Frame memory settings page 193

COLOR BKGD Color Bkgd Color background settings page 217

AUX Aux AUX bus settings page 224

CCR CCR Color corrector settings page 228

COPY SWAP Copy/Swap Copy and swap settings page 219

MISC Misc Settings for side flag, safe title, transition 
settings, and connection to external 
devices

page 223

STATS Status Status display page 225

DME DME DME special effect settings page 275

GLB EFF Global Effect Global effect settings page 336

RTR Router Router settings page 225

DEV Device Settings for external device operation Chapter 12 (Volume 2)
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Example of Displaying a Menu

To display, for example, the M/E-1 >Key1 >Type menu, 
use either of the following operations.
• Press the top menu selection button [M/E 1], then press 

the VF1 ‘Key1’ button and the HF1 ‘Type’ button in that 
order.

• Press the menu page number button in the upper left 
corner of the menu screen to display the top menu 
window, then enter the page number of the M/E-1 
>Key1 >Type menu, which is 1111, and press the 
[Enter] button. 
For details of the menu page numbers, see  “Menu Tree” 
(page 359).

The M/E-1 >Key1 >Type menu appears in the menu 
display as follows.

Interpreting the Menu Screen

The menu screen consists of the following principal parts.
When buttons on the screen are lit or represented in a 
depressed state, this indicates that the corresponding item 
or function is selected (set on).
The following describes the M/E-1 >Key1 >Type menu 
screen as an example.

MCRO Macro Macro register and macro timeline 
settings

Chapter 16 (Volume 2)

KEY FRAME Key Frame Keyframe settings Chapter 13 (Volume 2)

EFF Effect Keyframe effect register settings Chapter 13 (Volume 2)

SNAP SHOT Snapshot Snapshot register settings Chapter 14 (Volume 2)

SHOTBOX Shotbox Shotbox register settings Chapter 15 (Volume 2)

FILE File File settings Chapter 17 (Volume 2)

USER SETUP User setup User setup settings Chapter 24 (Volume 2)

ENG SETUP Engineering Setup Setup functions Chapter 18 to Chapter 23 (Volume 2)

DIAG Diagnosis Status information display Chapter 25 (Volume 2)

Buttons Menus Function See
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M/E-1 >Key1 >Type menu

a Menu title button
This shows the title of the menu screen.
You can set different colors for the main menu site and 
subsidiary menu site (see page 74).

Switching the VF buttons between the Key1 to Key4 
and Key5 to Key8 button displays
Switch the displays with the [KEY1-4] and [KEY5-8] 
menu title buttons.

When [KEY1-4] is lit, Key1 to Key4 buttons appear in 
VF1 to VF4.
When [KEY5-8] is lit, Key5 to Key8 buttons appear in 
VF1 to VF4.

b Menu page number button
This shows the menu screen page number. 

When you press this button, the top menu window (see 
page 70) appears. You can enter the page number for the 
desired menu, or press one of the top menu selection 
buttons in the window, to display that menu.
While the system is accessing the hard disk, the indicator 
lights red.

When the indicator is lit, do not power off the switcher, or 
disconnect the USB cable 1).

2Menu page number button

1Menu title button

6Function button area

7Parameter group button

8 Knob parameter buttons
3 VF buttons

4 HF buttons

9 Previous page button

5Status area

0 Keyframe status

qa Default recall button

qsb (previous) button and B (next) button

Notes

Indicator for internal hard disk

Indicator for frame memory external 
hard disk
Basic Menu Operations



  C
hapter 2  M

enus and C
ontrol P

anel
1) When an external hard disk drive is connected

c VF buttons
These indicate the larger subdivisions of this menu.
Depending on the selected item, the menu screen contents 
including the HF button indications change.

d HF buttons
These indicate the items within the menu.
Depending on the selected item, the menu indications 
change.
Depending on the function, if any one is on, the status is 
shown by an orange bar, as in the following figure.

e Status area
This shows the status of the settings items controlled by the 
selected menu.
An orange frame appears around the parameter area 
relating to the displayed menu. For each of the twelve 
areas, pressing the display jumps to the related menu.

f Function button area
This shows the functions which can be operated in the 
currently selected menu by means of buttons.
Each function button corresponds to a function which can 
be set in the currently selected menu. Press it to enable the 
function, to display a parameter group and adjust the 
parameters with the knobs, or to execute the function.
These buttons are in groups by function. In the screen 
example shown on the previous page, the [Key Bus] and 
[Matte] function buttons constitute the <Key Fill> group.

g Parameter group button
This displays parameter group names for which the knobs 
can make adjustments, the current parameter setting page 
number, and the total number of the parameter setting 
pages. (Example: Color Vector 1/2)
When there are more than five parameters within the same 
parameter group, press this button to display the sixth and 
subsequent parameters, which can then be controlled by 
the knobs.

h Knob parameter buttons
These show the parameters currently controlled by the 
knobs and their values. Pressing one of these buttons 
displays the numeric keypad window (see page 71), and 
you can then enter a new value for the corresponding 
parameter with the numeric keypad.

i Previous page button
This shows the page number of the previously displayed 
menu screen. Press it to go back to that page. When the 

indication [Parent] appears, this displays the parent 
directory.

j Keyframe status
This shows the keyframe status of the reference region. 
Pressing this button switches the menu screen as follows.
When a menu other than the Key Frame menu is 

currently shown: The menu screen switches to the 
Key Frame menu.

When the Key Frame menu is currently shown: The 
menu screen switches to the menu that was on the 
screen immediately before the Key Frame menu.

In some parts of menus such as the File menu, this 
functions as a “Region selection area,” for selecting the 
region to which operations apply.

k Default recall button
This only appears in those menus for which the default 
recall function is available.

For details of the menus which can be initialized, see 
“Menus allowing a return to default settings” (page 389) 
in Appendix.

Press this button, turning it on, then press a VF button or 
knob parameter button to return the settings to their default 
values, in the following groupings.
• Function grouping: the functions within an HF menu 

under the VF button
• Knob parameters (parameters currently controlled by the 

knobs)

l b (previous) button and B (next) button
The b button returns to the previous menu. Press the B 
button to continue to the next menu.
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Names and Functions of Parts of the Top Menu Window

a Top menu selection buttons
These are the same as the top menu selection buttons in the 
menu control block. Pressing one of these buttons closes 
the top menu window and displays the selected menu in the 
menu display.

b Input display
This shows the page number entered with the numeric 
entry section.

c Numeric entry section
Enter a page number.

d Clear button
Press this to clear the input display.

e Enter button
Pressing this button without entering a page number closes 
the top menu window with the current menu remaining in 
the menu display.
If you enter a page number then press this button, this 
confirms the value in the input display. If it is a correct 
page number, the top menu window closes, and the menu 
display shows the new menu. If it is not correctly set, the 
input display changes color.

f Close button
Press this to close the top menu window.

g Shut down button
Shuts down the menus.

Be sure to shut down the menus before powering off the 
control panel.

Shutting down the menus

1 In the menu screen, press the menu page number 
button to open the top menu window.

2 Press [Shut down].

A confirmation message appears.

3 Press [Yes].

This shuts down the menu system after a while, and the 
menu display changes to black. Now power off the 
system.

To restart menu operations
Power on the control panel once more.

d Add Favorite button
Pressing this button allows the currently displayed menu to 
be registered to the Shortcut menu (see page 76).

1 Top menu selection buttons

2 Input display

3 Numeric entry section

6 Close button

4 Clear button

5 Enter button

7 Shut down button

8 Add Favorite button

Notes
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Names and Functions of Parts of the 
Numeric Keypad Window

a Item display
This is the name of the parameter being set in the numeric 
keypad window.

b Max./min. (maximum/minimum) value indication
This shows the maximum and minimum settings of the 
parameter.

c Input value
This is the value being input into the numeric keypad 
window.

d Close button
This closes the numeric keypad window.

e TC (timecode) button
When the numeric keypad window is opened for a setting 
requiring a timecode value to be entered, this button 
appears in a depressed state.
You can enter a timecode value in the range that depends 
on the signal format.

00:00:00:00 to 23:59:59:nn,
where nn = (number of frames per second) – 1.

f  – (minus) button
This toggles the sign of the entered value. When it is 
pressed, the value is negative.

g Clear button
This clears the input. It does not change the parameter 
setting.

h Trim button
After entering the difference from the current value, press 
this button to confirm the numeric input.

i Enter button
This confirms the entered value.
If correctly set, the numeric keypad window closes.
If not correctly set, the input display changes color.

Names and Functions of Parts of the Keyboard Window

Except when changing source names, the following 
characters cannot be used.

space, \, /, :, ;, , (comma), . (dot), <, >, *, ?, ", |

1 Item display

2 Max./min. value indication

3 Input value

4 Close button

5 TC (timecode) button

6 – (minus) button

7 Clear button

8 Trim button

9 Enter button

Notes
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a Item display
This is the name of the parameter being set in the keyboard 
window.

b Input string
This is the character string being input in the keyboard 
window.

c Close button
This closes the keyboard window.

d BS button
This clears the character immediately before the cursor in 
the input string.

e Caps Lock button
This enables input of capital letters only.

You can enter items to be displayed on the control panel 
LCD using lowercase letters, but these will be converted to 
capitals for display.
MS-DOS does not distinguish case in filenames, and 
therefore you are recommended to enter filenames in 
capital letters.

f Shift button
This selects the characters on the shift side of the keys. The 
shift is released when you enter a character.

g Space button
This enters a space character.

h Clear button
This clears all of the characters in the input string.

i Del button
This clears the character immediately after the cursor in 
the input string.

j Left button
This moves the cursor one character to the left in the input 
string.

k Right button
This moves the cursor one character to the right in the 
input string.

l Enter button
This sets the input string as a parameter value, and closes 
the keyboard window if the value has been entered 
correctly. If the value has not been entered correctly, the 
display color changes.

m Line feed button
After pressing the Shift button, press this button to feed a 
line. The input string shows “|”.

Names and Functions of Parts of the Color Pallet Window

When a parameter is assigned to the knobs as a 
combination of luminance, saturation, and hue, pressing a 

knob parameter button displays a color palette window.

1 Item display 2 Input string

4BS button

3Close button

0 Left button

6Shift button

5Caps Lock button

7Space button

8Clear button

9Del button

qaRight button

qsEnter button

qd Line feed button

Notes
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a Color palette buttons
Press one of these to enter the corresponding color in the 
display.
By default the following settings are available.
First row: white, yellow, cyan, green
Second row: magenta, red, blue, black
Third row: all black

b Operation buttons
Set: If you press any color palette button with this button 

held down, the color shown in the color display is 
assigned to the color palette button.

Copy: If you press a color palette button with this button 
held down, the color is used as the source for copying. 
Next press a different color palette button to copy to 
that button.

Swap: If you press two color palette buttons in sequence 
with this button held down, the two colors are 
swapped.

Default: If you press any color palette button with this 
button held down, the color palette button is set to the 
default color.

c Color display
This shows the setting color, and the parameters (LUM, 
SAT, and HUE).
By adjusting the parameters with the knobs, you can create 
any color.
If a parameter value is outside the permitted range for RGB 
(0 to 255), the indication “Illegal Color” appears, and this 
is adjusted to a value in range.
Cancel: Pressing this button returns to the state when the 

color palette window was opened.

d Numeric keypad
Use this to enter numeric values for parameters.

For details of use, see page 71.

1Color palette buttons

3Color display

4Numeric keypad

2Operation buttons
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Menu Operations

The method of menu operation is basically the same when 
using a mouse with an external monitor, but with mouse 
clicks in place of button presses. There is no difference in 
the menu control block operation described here.
However, the monitor has no knobs for adjusting the 
parameters in the menu control block. 

For details of operations corresponding to these knob 
operations, see the section below, “Operation With a 
Mouse” (page 75).

Selecting an Item

1 Press the VF button (1 to 7) for the desired group of 
items.

The HF button (1 to 7) indications change to show the 
items within the selected group.

2 Press the HF button for the desired item.

The indications in the status area and function button 
area change, and you can now make various changes 
to the selected item.

Selecting a Function

Press the appropriate function button within the function 
button area.

Shape and color of the button
Pressing the button turns it on, and it lights, showing the 
state.

Lit pale blue: The function is enabled, and the parameters 
can currently be adjusted with the knobs.

Lit orange: The function is enabled.
Lit purple: Execution button. Pressing the button 

immediately executes the function. (Example: [Auto 
Start] button in the Chroma Adjust menu)

Pressing a button of this type displays a further menu, 
allowing more detailed settings. (Example: [Chroma 
Adjust] button in the Type menu)

Setting Parameters

This marking on a function button indicates that there are 
parameters which can be adjusted with the knobs.
Pressing this function button assigns parameters to the 
knobs.
You can set the parameter values by either of the following 
methods.
• Turn the knob (1 to 5) corresponding to the parameter, to 

adjust the value.
• Press the knob parameter buttons (1 to 5) corresponding 

to the parameter. This displays the numeric keypad 
window allowing you to enter the desired value.

In the description of specific setting procedures, the knob 
adjustment is described, as follows.
Example: When wipe pattern key is selected

When the [MENU] button in the device control block is lit, 
you can use the trackball and Z-ring to control the 
parameters.
• Move the trackball on the x-axis to control the parameter 

for knob 1 or on the y-axis to control the parameter for 
knob 2. Moving up or to the right increases the parameter 
value, and moving down or to the left decreases the 
parameter value.

• Use the Z-ring to adjust the parameter for knob 3. 
Turning clockwise increases the parameter value, and 
turning counterclockwise decreases the parameter value.

Switching Between the Main Menu 
Site and Subsidiary Menu Site

For menu transitions, you can store two separate versions 
in the main and subsidiary menu sites.
By switching sites, and pressing the b button and the B 
button you can trace the history in each menu.

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

3 Density Key density 0.00 to 100.00

mark
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To switch the subsidiary menu site on and 
off
Assign [SUB MENU SITE] to a menu control block top 
menu selection button or user preference button. 
To switch to the subsidiary menu site, press this button, 
turning it on.

For details, see “Assigning Functions to the Menu Control 
Block Top Menu and User Preference buttons” in Chapter 
19 (Volume 2).

Going Back to the Previous Menu

To return to the last displayed menu, press the previous 
page button.

Returning to Default State in 
Function Groupings

1 Press the [Default Recall] button, turning it on.

This enters the menu default recall mode.

2 Press the VF button you want to return to the default 
state.

This returns the settings within the function grouping 
to the default state, and the [Default Recall] button 
goes off.

The default state of the settings depends on the setting of 
the initial status mode, set in the Setup menu of system 
setup, as follows.
User: The state when [Initial Status Define] is executed.
Factory: Factory default settings

Returning Knob Parameters to 
Default State

1 Press the [Default Recall] button, turning it on.

This enters the menu default recall mode.

2 Press the knob parameter button you want to return to 
the default state.

This returns the knob parameter value to the default 
state, and the [Default Recall] button goes off.

For details, see the table, “Knob parameters subject to 
restriction on default recall” on page 391.

The default recall function does not return the horizontal 
(H) and vertical (V) position settings to their default state 
individually. Returning the horizontal (H) position to its 
default state also returns the vertical (V) position to its 
default state automatically, and vice versa. 

Operation With a Mouse

If you display the menus in an external monitor, operated 
with a mouse, then you click the mouse instead of pressing 
a button as described in the previous section, “Menu 
Operations.”
However, in the following cases there are special 
operations with a mouse.

To set a parameter with the mouse
To adjust the value of a knob setting parameter button with 
the mouse, you can use either of the following three 
methods.
• Position the cursor over the knob setting parameter 

button for which you want to adjust the value, and turn 
the mouse wheel.

• Position the cursor over the knob setting parameter 
button for which you want to adjust the value, then hold 
down the right mouse button, and drag the bar showing 
the setting to the desired value.

• Position the cursor over the knob setting parameter 
button for which you want to adjust the value, then click 
the left mouse button to open the numeric keypad 
window by which you can input the desired value.

To scroll a list with the mouse
Position the cursor over the list you want to scroll, and turn 
the mouse wheel.
In the setup menus you can select the direction of mouse 
wheel rotation that increases the setting value. And you 
can also switch the functions of the right and left mouse 
buttons.

For details, see Chapter 19 “Setting the Mouse Wheel 
Scrolling Direction for Parameter Setting” (Volume 2).

Notes

Notes
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Shortcut Menu

Registering a Menu To the Shortcut 
Menu

1 In the Home >Favorites >Shortcut menu, select the 
desired group.

2 Display the menu you want to register, and then press 
the [Add Favorite] button.

The currently displayed menu is automatically 
registered to a blank button.

Recalling a Menu Using the Shortcut 
Menu

1 In the Home menu, select VF2 ‘Favorites’ and HF1 
‘Shortcut.’

The following menu appears.

2 In the [Group Select] box, select the group.

The group buttons appear.

3 Press the button for the desired menu.

Customizing the Shortcut Menu

Assign frequently used menus to buttons, to create a 
“Favorites” menu.

To create a menu group

1 In the Home menu, select VF2 ‘Favorites’ and HF1 
‘Shortcut.’

The following menu appears.

2 Press [Group Edit].

The following menu appears.

3 With the cursor, select the group name (in this case a 
blank button) for the operation.

4 Press [Rename].

A keyboard window appears.

5 Enter a group name (maximum 24 characters), and 
press Enter.

This confirms the group name.

To copy a menu group

1 In the Home >Favorites >Group Edit menu, press the 
button for the copy source group.

2 Press [Copy].

3 Press the button for the copy destination group.

4 Press [Paste].

This copies the menu group settings.

To delete menu group settings

1 In the Home >Favorites >Group Edit menu, select the 
group to be deleted.
Shortcut Menu
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2 Press [Clear].

A confirmation message appears.

3 Press [Yes].

This deletes the settings.

To register a menu on a button
You can register 15 buttons in one group.

1 In the Home >Favorites >Shortcut menu, press 
[Button Edit].

2 Move the cursor to the position where you want to 
display the button. To change the content of an already 
displayed button, press the button to select it.

3 Press [Page Set].

A page number input window appears.

4 Enter the page number for the menu you want to 
register.

5 Press [Rename].

A keyboard window appears.

6 Enter the button name (maximum 24 characters).

7 To change the button color, press [Color Set].

Button color samples appear.

8 Press the desired color.

This completes the assignment of the menu to the 
button.

9 Repeat steps 2 to 8 to complete the “Favorites” menu.

To copy button settings

1 In the Home >Favorites >Button Edit menu, press the 
copy source button to select it.

2 Press [Copy].

3 Press the copy destination button to select it.

4 Press [Paste].

This copies the button settings.

To delete button settings
In the Home >Favorites >Button Edit menu, press [Clear].
This deletes the button settings.

The shortcut menu settings are handled as part of the 
control panel setup. You can recall and save them in the 
same way as setup data.

To register a menu macro on a button

See “Recalling a Menu Macro Register and Executing a 
Menu Macro” in Chapter 16 (Volume 2).

To execute a menu macro with a button

See “Recalling a Menu Macro Register and Executing a 
Menu Macro” in Chapter 16 (Volume 2).

Menu No.

Button name

Notes 
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Video Processing Flow

The switch from the current video stream (appearing on 
the corresponding program monitor) to a new video stream 
is referred to as a transition.

The following illustration shows the flow of operations for 
carrying out a transition on an M/E bank or the PGM/PST 
bank.

Select next transition (page 85)

Make key settings (page 112)

Keys 1 to 8

Select new background video (page 79)

Select transition type (page 85)

Select current background video (page 79)

Background

Cut Mix Super mix Preset color mix Wipe DME wipe

Make wipe settings 
(page 152)

Make DME wipe settings
(page 176)

Preview the effect of transition (page 101)

Execute the transition (page 94)

NAM
Video Processing Flow
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Signal Selection

You carry out signal selection with the cross-point buttons 
in the cross-point control block of each M/E bank or the 
PGM/PST bank, and the buttons in the auxiliary bus 
control block.

The number of buttons in each cross-point row may be 16, 
24, or 32, but here the description is of the 32-button case 
as an example.

Cross-point control block

Basics of Signal Selection

Each of the M/E banks, PGM/PST bank and auxiliary bus 
control block has 32 cross-point buttons and three reentry 
buttons (four in the case of the auxiliary bus control block).
These buttons are identified by numbers common to all of 
the banks and block, and a signal is assigned to each 
number.
The basis of signal selection is to select, in a cross-point 
button row, the cross-point button to which is assigned the 
desired signal.

Reentry buttons
To use the output of one M/E bank as background input to 
another bank, use the reentry buttons [M/E1], [M/E2], and 

[M/E3] (on the auxiliary bus control block, [M/E1], [M/
E2], [M/E3], and [PGM]) in the cross-point control block 
of the destination bank.
For example, to feed the output from the M/E-1 bank as the 
background B input to M/E-2, in the M/E-2 cross-point 
control block, press the [M/E1] button in the background 
B row.

• To select M/E 4, it is necessary to assign M/E 4 to a 
button (see page 380).

• For a 5M/E system, a maximum of four re-entry stages 
are possible. For other restrictions on re-entry, see page 
228.

Bus Selection

Each row of 32 cross-point buttons is shared by multiple 
buses.
To assign a bus to the cross-point buttons in the auxiliary 
bus control block, press one of the AUX delegation buttons 
to select the bus. 

• When using the CCP-6224/6324, buses may be assigned 
with the cross-point button rows for keys 1 and 2 as the 
auxiliary bus control block.

Source name displays

Key 2 row

Key 1 row

Reentry buttons

KEY4 button

KEY3 button

Cross-point buttons

Background A row

Background B row

Dedicated SHIFT 
button

Reentry buttons

UTIL button

Notes 

Notes 
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• You can enable assigning a key and AUX bus to the key 
1 row of cross-point buttons, and selecting the signal in 
the key 2 row.

For details, see “Assigning a Key or AUX Bus to a Button 
in the Key 1 or Key 2 Row” in Chapter 19 (Volume 2).

The following table illustrates the correspondence 
between buses and cross-point button rows, and the 
delegation operations.

Bank Bus name Cross-point button row Delegation operation

M/E-1, M/E-2, 
M/E-3, M/E-4 a)

Background A bus b) Background A row –

Background B bus b) Background B row –

Key 1 bus Key 1 row Turn off the dedicated [SHIFT] button, 
then turn off the [KEY3] button. c)

Key 2 bus Key 2 row Turn off the dedicated [SHIFT] button, 
then turn off the [KEY4] button. c)

Key 3 bus Key 1 row Turn off the dedicated [SHIFT] button, 
then turn on the [KEY3] button. c)

Key 4 bus Key 2 row Turn off the dedicated [SHIFT] button, 
then turn on the [KEY4] button. c)

Key 5 bus d) Key 1 row Turn on the dedicated [SHIFT] button, 
then turn off the [KEY3] button.

Key 6 bus d) Key 2 row Turn on the dedicated [SHIFT] button, 
then turn off the [KEY4] button.

Key 7 bus d) Key 1 row Turn on the dedicated [SHIFT] button, 
then turn on the [KEY3] button.

Key 8 bus d) Key 2 row Turn on the dedicated [SHIFT] button, 
then turn on the [KEY4] button.

PGM/PST Program bus b) Program row –

Preset bus b) Preset row –

DSK 1 bus DSK 1 row Turn off the dedicated [SHIFT] button, 
then turn off the [DSK3] button. c)

DSK 2 bus DSK 2 row Turn off the dedicated [SHIFT] button, 
then turn off the [DSK 4] button. c)

DSK 3 bus DSK 1 row Turn off the dedicated [SHIFT] button, 
then turn on the [DSK 3] button. c)

DSK 4 bus DSK 2 row Turn off the dedicated [SHIFT] button, 
then turn on the [DSK 4] button. c)

DSK 5 bus d) DSK 1 row Turn on the dedicated [SHIFT] button, 
then turn off the [DSK 3] button.

DSK 6 bus d) DSK 2 row Turn on the dedicated [SHIFT] button, 
then turn off the [DSK 4] button.

DSK 7 bus d) DSK 1 row Turn on the dedicated [SHIFT] button, 
then turn on the [DSK 3] button.

DSK 8 bus d) DSK 2 row Turn on the dedicated [SHIFT] button, 
then turn on the [DSK 4] button.

M/E-1,  M/E-2,  
M/E-3, M/E-4 a), 
PGM/PST

Utility 1 bus Background A row When [UTIL] button mode is Hold, hold 
down the [UTIL] button.Utility 2 bus Background B row

DME external video bus Key 1 row Hold down the [UTIL] button.

DME utility 1 bus Key 2 row Hold down the [UTIL] button, and press 
the [KEY4] button, turning it off.

DME utility 2 bus Hold down the [UTIL] button, and press 
the [KEY4] button, turning it on.
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a) M/E-4 requires assignment.
b) Dual background bus mode (see below) can be selected.
c) A dedicated [SHIFT] button operation is required when the dedicated 

[SHIFT] button operation mode is set in setup to “Key5-8 Select.” For 
other settings, a dedicated [SHIFT] button operation is not required.

d) Only valid when the dedicated [SHIFT] button operation mode is set in 
setup to “Key5-8 Select.” For other settings, assignment is not possible.

e) An assignment to the delegation buttons is required in setup, to assign the 
bus for operations.

Dual background bus mode
In this mode, the shifted signal on the background A row 
can be selected on the key 1 row, and the shifted signal on 
the background B row can be selected on the key 2 row.
To switch this mode on and off, it is necessary to assign 
this function to the [PRE MCRO] button in the cross-point 
control block.

Auxiliary bus 
control block e)

AUX1 to AUX48 buses 1st row, 2nd row Turn on the appropriate buttons in 
accordance with the signal assignment 
made in the Setup menu.Frame memory source 1 and 

frame memory source 2 buses

DME 1 to DME 8 video buses

DME 1 to DME 8 key buses

Edit preview bus

M/E-1 UTILITY 1 and M/E-1 
UTILITY 2 buses

M/E-2 UTILITY 1 and M/E-2 
UTILITY 2 buses

M/E-3 UTILITY 1 and M/E-3 
UTILITY 2 buses

M/E-4 UTILITY 1 and M/E-4 
UTILITY 2 buses

P/P UTILITY 1 and P/P UTILITY 
2 buses

M/E-1 Key 1 fill to M/E-1 Key 8 fill 
buses

M/E-1 Key 1 source to M/E-1 Key 
8 source buses

M/E-2 Key 1 fill to M/E-2 Key 8 fill 
buses

M/E-2 Key 1 source to M/E-2 Key 
8 source buses

M/E-3 Key 1 fill to M/E-3 Key 8 fill 
buses

M/E-3 Key 1 source to M/E-3 Key 
8 source buses

M/E-4 Key 1 fill to M/E-4 Key 8 fill 
buses

M/E-4 Key 1 source to M/E-4 Key 
8 source buses

DSK 1 source to DSK 8 source 
buses

DSK 1 fill to DSK 8 fill buses

M/E-1 external DME bus

M/E-2 external DME bus

M/E-3 external DME bus

M/E-4 external DME bus

P/P external DME bus

DME UTILITY 1 and DME 
UTILITY 2 buses

Bank Bus name Cross-point button row Delegation operation
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For details of the assignment operation, see “Assigning 
the Dual Background Bus Mode Switching Function” in 
Chapter 19 (Volume 2).

For the following switcher banks, dual background bus 
mode is not available.
• When set to “Dual M/E Assign”
• When M/E Config is set to “DSK”

AUX Panel-less Function

When using 24-column cross-point control blocks for the 
CCP-6224/CCP-6324 Control Panel, you can use the key 
1 and key 2 rows as the auxiliary bus control block. This is 
called the panel-less function.

Preparations
Assign the function for switching to the AUX control 
mode to the [PRE MCRO] and [POST MCRO] buttons. 
Hereafter this button is called the [AUX CTRL] button.
In the source name display you can display either the 
source name or the bus name.

For details of how to make the assignment, see “Assigning 
the AUX Bus Control Mode Switching Function” in 
Chapter 19 (Volume 2).

Selecting the AUX bus

1 Switch the operation mode with the [AUX CTRL] 
button.

2 In the key 1 row, select the AUX bus for the operation.

3 In the key 2 row, select the desired signal.

Signal Assignment and Selection

Assigning signals to buttons
Each of the 32 cross-point buttons and reentry buttons has 
a corresponding button number, to which you assign a 
signal.
In addition to the signals input to the following connectors, 
you can also select signals generated within the switcher.
• The PRIMARY INPUTS connectors on the rear panel of 

the switcher (1 to 144 in MVS-8000X, 1 to 80 in MVS-
7000X)

• The PREMIUM INPUTS 1 to 20 connectors (only in 
MVS-8000X)

• The FC INPUTS 1 to 16 connectors (only in MVS-
8000X)

Each button has assigned to it a video signal and a key 
signal, forming a pair. You can set these video and key 
combinations in a Setup menu. 

For details of Setup menu operations, see “Creating 
Cross-Point Assign Tables” in Chapter 19 (Volume 2).

Cross-point button control block button numbers

On each M/E bank and the PGM/PST bank, each cross-
point button and reentry button has two button numbers, 
and you use the shift button to switch between these 
numbers.

In the case of a 32-button layout, the button numbers are as 
follows.

Notes

(second button numbers)

Shift button

Shift button

(first button numbers)
Signal Selection
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You can use the rightmost button (number 32) as a [SIDE 
FLAG] button. In this case, the shift button moves one to 
the left, to number 31, and the button numbers are offset by 
one.

For details of the [SIDE FLAG] button, see “Assigning a 
Cross-Point Button to Enable/Disable Side Flags” in 
Chapter 19 (Volume 2).

Switching button numbers
The rightmost (32nd) button functions as a shift button.
(The shift button function can be disabled in a Setup 
menu.)
When selecting the signals of button numbers 1 to 31, 
press the cross-point button for the desired signal.
To select button numbers 32 to 62, hold down the shift 
button, and press the cross-point button for the desired 
signal.

Button numbers in the auxiliary bus control block

When the [2ND] button is unlit
The cross-point buttons and reentry buttons in the auxiliary 
bus control block have separate upper (1st row) and lower 
(2nd row) numbers.
In the case of a 32-button layout, the button numbers are as 
follows.

When the [2ND] button is lit
Different buses can be assigned to the 1st-row buttons and 
2nd-row buttons. When the 32nd button is set as a shift 
button, the 1st-row buttons and 2nd-row buttons both have 
the following button numbers.

Inhibiting cross-point button operations
For each cross-point button, you can temporarily inhibit 
operations. 

This setting is cleared when you reset the control panel. 

Assigning a button to the function of disabling 
cross-point button operation
You can assign the button to be used for the operation to 
the [PRE MCRO] button, in setup. 

For details, see “Overall Control Panel Settings (Config 
Menu)” in Chapter 19 (Volume 2).

Cross-point control block button numbers

Button Number when the 
shift button is not 
pressed

Number when the 
shift button is 
pressed

From the left end 
to the 31st button

1 to 31 32 to 62

Reentry buttons 121 to 123 125 to 127

Notes

(1st row)

(2nd row)

[2ND] button

Auxiliary bus control block button numbers ([2ND] button unlit)

Button Button Button numbers

1st row From the left end to the 31st 
button

1 to 31

Reentry buttons 121 to 124

2nd row From the left end to the 31st 
button

32 to 62

Reentry buttons 125 to 128

Auxiliary bus control block button numbers ([2ND] button lit)

Button Number when the 
shift button is not 
pressed

Number when the 
shift button is 
pressed

From the left end 
to the 31st button

1 to 31 32 to 62

Reentry buttons 121 to 124 125 to 128

Notes 
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You can also use the [Inhibit Set] and [Inhibit All Clear] 
functions, assigned to user preference buttons. 

For details, see “Assigning Functions to User Preference 
Buttons” in Chapter 19 (Volume 2).

Buses for which operations can be inhibited
This setting applies to the auxiliary bus control block 
(when using the CCP-8000) and the cross-point buttons in 
each switcher bank. However, when using the CCP-6224/
6324, buses may be assigned with the cross-point button 
rows for keys 1 and 2 as the auxiliary bus control block.
For example, if you make the setting for one cross-point 
button in a switcher bank, this inhibits operation of all 
cross-point buttons with the same number in the following 
buses. 
The corresponding name also disappears from the source 
name display. 
• Background A, background B
• Keys 1 to 8
• Utility 1, Utility 2
• DME utility 1, DME utility 2
• External DME

To inhibit operation of a cross-point button
Hold down the button which “Inhibit Set” is assigned, and 
press the cross-point button whose operation you want to 
inhibit. 
The button you pressed flashes amber, and this makes the 
operation inhibited. 

Even when you inhibit operation of a cross-point button, 
macro attachment settings are still possible.

For details, see “Setting and Canceling a Macro 
Attachment” in Chapter 16 (Volume 2). 

To clear a cross-point button operation inhibit 
setting
Hold down the button to which “Inhibit Set” is assigned, 
and press the button whose operation is inhibited (flashing 
amber). 
This clears the operation inhibit setting for the button you 
pressed. 

To clear all operation inhibit settings
Press the button to which “Inhibit Set” is assigned and the 
button to which “Inhibit All Clear” is assigned 
simultaneously. 

Selection of signals linked with the audio 
mixer
When you select a signal in a switcher bank background A, 
key 1 or key 2 row (of the CCP-6224/6324 control panel in 
AUX control mode) or AUX bus control block (of the 

CCP-8000), and the bank and signal are set to be linked to 
the audio mixer, then the program output of the audio 
mixer follows the signal selection.

For details of the setting, see “Making Settings for Audio 
Mixer” in Chapter 19 (Volume 2). 

• For details of audio mixers that can be connected, 
contact your Sony service or sales representative. 

• When the signal is switched with a snapshot, keyframe, 
and so on, the audio mixer is not linked. 

• When bus fixed mode is selected in setup (see page 100), 
the audio mixer program output is linked to the bus 
output as the background. 

Signal Name Display

You can attach a name (source name) to each signal 
assigned to a cross-point button, with a maximum of 16 
characters.
• The source name displays in the cross-point control 

block and auxiliary bus control block show the source 
names of the video signals assigned to numbers 1 to 31.

• To display the source names for numbers 32 to 62, press 
the [SHIFT] button to the right of the source name 
displays.

• To display the source names of the key signals assigned 
to buttons, hold down the [SPLIT] button in the key 
control block or the [KEY] button in the auxiliary bus 
control block.

When using the AUX panel-less function (see page 82) 
with the CCP-6224/6324 Control Panel, you can use the 
cross-point control block as an AUX bus control block 
with the [AUX CTRL] button.
In this case, use the key 1 row as AUX delegation buttons, 
and the key 2 row as AUX bus cross-point selection 
buttons; the source name displays show the bus names and 
source names.

Colors of lit cross-point buttons
In a particular row of cross-point buttons, only the last 
pressed button is effective, and lights amber or red. The 
amber indicates the “low tally” state, and the red indicates 
the “high tally” state, to indicate whether or not the 
selected signal appears in the final output video.

Notes 

Notes 

Significance of colors of lit cross-point buttons

Color State Significance

Amber Low tally Does not appear in final 
output video

Red High tally Appears in final output 
video
Signal Selection
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Transitions

Selecting the Next Transition

To execute a transition, it is first necessary to decide how 
the image will be changed as a result of the transition. This 
selection is carried out using the next transition selection 
buttons (see page 27) in the transition control block of each 
M/E or PGM/PST bank.

For details of operations, see “Procedure for Basic 
Transition Operation” (page 86).

Transition Types

Selecting the transition type determines the way in which 
the transition occurs.
Carry out the type selection with the transition type 
selection buttons in the transition control block of each M/
E or PGM/PST bank.

For details of this operation, see “Procedure for Basic 
Transition Operation” (page 86).

The following are the transition types.

Mix
This is a dissolve, in which the new video progressively 
fades in over the current video, with the sum of the two 
video outputs maintained constant. At the mid-point of the 
transition (when the fader lever is in the center position), 
the output of each is 50%.
This transition type can also be selected for an independent 
key transition. In this case, the key either dissolves in or 
dissolves out similarly, with the progress of the transition.

NAM (non-additive mix)
In this dissolve, the current video and new video signals 
are compared, and the signal with the higher luminance 
level is given priority in the output. The current video is 
maintained at 100% output for the first half of the 
transition as the new video increases progressively to 
100%, then the current video is progressively reduced 
from 100% to zero in the second half with the new video 
maintained at 100% output.

This transition type is not available for an independent key 
transition.

Super mix
In this dissolve, the current video is maintained at 100% 
output for the first half of the transition as the new video is 
mixed while increasing progressively to 100%, then the 
current video is progressively reduced from 100% to zero 
in the second half with the new video maintained at 100% 
output.

This transition type is not available for an independent key 
transition.

For details on super mix settings, see page 92.

Preset color mix
This is a two-stage dissolve, comprising two transitions, 
the first a dissolve to a color matte, and the second from the 
color matte to the new video.
In the first transition, the current video is replaced by the 
color matte in a mix (dissolve), then in the second 
transition the color matte is replaced by the new video also 
in a mix (dissolve). 

This transition type is not available for an independent key 
transition.

For details on color matte settings, see page 92.

Wipe
A wipe replaces the current video by the new video 
according to a predetermined pattern. This transition type 
can also be selected for an independent key transition.

For details, see Chapter 5 “Wipes” (page 152).

DME wipe
Using a DME effect, it is possible to obtain a transition to 
a new image from the current image, as in a wipe. You can 
also use this transition type as an independent key 
transition.

For details, see Chapter 6 “DME Wipes” (page 172).

Clip transitions
Linked to a mix (dissolve) or wipe transition, a frame 
memory clip (movie) is played back. 

Notes 

Notes 

Notes 
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Cut
A cut switches instantaneously from the current video to 
the new video. When the next transition is a key transition, 
the key cuts in or out instantaneously.

Procedure for Basic 
Transition Operation

The positions of the principal buttons used for basic 
transition operation are as follows.

Transition control block (for standard transitions)

1 In the cross-point control block, select the background 
video with the background A row of cross-point 
buttons.

2 Select the way in which the transition will affect the 
image, using the next transition selection buttons in the 
transition control block.

For an overview, see “Selecting the Next Transition” 
(page 85).

To change the background: Press the [BKGD] 
button, turning it on.

To insert or delete a key: Press one of the [KEY1] to 
[KEY4] buttons (or [DSK1] to [DSK4] buttons in 
the PGM/PST bank), turning it on.

For details of the operation to select [Key5] to [Key8], 
see “Assigning Buttons for Selection of Keys 5 to 8 in 
the Setup Menu” (page 381) in Appendix.

To enable the key priority setting, which 
determines the key overlay order after the 
transition: Press the [KEY PRIOR] button, 
turning it on.
You can press more than one button at the same 
time.

Next transition 
selection buttons

Transition type 
selection buttons

Transition execution 
section
Procedure for Basic Transition Operation
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To change the keys and background presets in 
Setup menus simultaneously: Press the [ALL] 
button.

To allocate a particular next transition button to the 
[ALL] button function, see “Setting the Operation 
Mode of the [ALL] Button in the Transition Control 
Block” in Chapter 19 (Volume 2).

3 For the transition to change the key priority, set the 
priority for after the transition. 

When using keys 1 to 8, see “Priority Setting for Keys 
1 to 8” (page 90). For details of the key priority setting 
operation, see “Key Priority Setting” (page 88).

4 Select the new video used for the transition.

• In the background B row of cross-point buttons, 
select the new background video.

• When inserting a key, select the key signal, and 
make any required settings.

For details of key settings, see Chapter 4 “Keys” 
(page 112).

To carry out a cut transition, skip to step 7; otherwise 
continue to step 5.

5 Select one of the transition type selection buttons in 
the transition control block.

To carry out a dissolve to the new video: Press one 
of the [MIX], [NAM], [SUPER MIX], and [PST 
COLOR MIX] buttons, turning it on.

To carry out a wipe: Press the [WIPE] or [DME] 
button, turning it on.

To carry out a transition while playing back a 
frame memory clip: Press one of the buttons 
corresponding to the clip to be used 
(FM1&2CLIP, FM3&4CLIP, FM5&6CLIP, and 
FM7&8CLIP).

You can also use the Misc  >Transition menu to select 
a desired transition type for the M/E or PGM/PST 
bank. (See “Selecting the Transition Type by a Menu 
Operation” (page 91).)

For an overview, see “Transition Types” (page 85).

The transition type selection buttons in the transition 
control block can be interchanged in the setup menu.

For details, see “Overall Control Panel Settings 
(Config Menu)” in Chapter 19 (Volume 2).

6 Make the required settings, according to the selected 
transition type.

For details of the settings, see the relevant section.

Super mix: “Super Mix Settings” (page 92)
Preset color mix: “Color Matte Settings” (page 92)
Wipe: “Basic Procedure for Wipe Settings” (page 

152)
DME wipe: “Basic Procedure for DME Wipe 

Settings” (page 176)
Clip transition: “Clip Transition Operations” (page 

208)

Using the transition preview function (see page 101), 
you can check the transition on the preview monitor.

7 Carry out the transition in the transition execution 
section.

For a gradual transition such as a mix (dissolve) or 
wipe: Press the [AUTO TRANS] button, or 
operate the fader lever.
To execute a transition by pressing the [AUTO 
TRANS] button, first set the transition rate 
(specified as the duration of the transition).
 (See “Setting the Transition Rate” (page 94).)
When you have selected a wipe or DME wipe as 
the transition type, you can also set the transition 
range. (See “Pattern Limit” (page 97).)

For an instantaneous transition: Press the [CUT] 
button.

For details, see “Executing a Transition” (page 94).

Transition linked to the audio mixer
If the video signal selected in the background B row is 
linked to the audio mixer in setup, then the audio mixer 
sound changes with the transition. That is, pressing the 
[AUTO TRANS] button gives a cross fade, and pressing 
the [CUT] button gives an instantaneous sound switch.

For details of setup, see “Making Settings for Audio 
Mixer” in Chapter 19 (Volume 2).

• The audio mixer is not linked to a snapshot or key frame 
transition.

• The audio mixer is not linked to a transition using the 
fader lever.

• If the bus-fixed mode (see page 100) is selected in the 
setup menu, and the fader lever is in the lowest position, 
there is a cross fade from the audio selected on the B row 
to the audio selected on the A row.

• The audio mixer is not linked to a key transition.
• In the following cases, the audio and video may be out of 

sync.
- When carrying out a cross fade in some DME wipes 

(for example, “picture in picture”)
- When executing a preset color mix in two-stroke mode

• For details of audio mixers that can be used, contact your 
Sony service or sales representative.

Notes 

Notes 
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Key Priority Setting

If a number of keys are already inserted in the current 
video, you can check or change the key priority, that is to 
say, the order in which the keys are overlaid.
When a key priority ([KEY PRIOR]) is selected as the next 
transition, you can also change the key priority in the new 
video.

The key priority values go from 1 to 4, with a higher 
priority key being “in front” as seen on the screen.

Priority sequence on the screen

There are two ways of setting the priority: either using the 
[PRIOR SET] button in the transition control block, or 
using the Misc menu to access the Key Priority menu for 
the M/E or PGM/PST bank.

When the operating mode is set to multi program, the key 
priority setting cannot be made.

Setting the Key Priority in the 
Transition Control Block

The positions of the buttons used for the operation are as 
follows.

Transition control block (standard type)

Changing the currently inserted key 
priority

1 If the next transition selection button [KEY PRIOR] is 
on, press another next transition selection button to 
turn the [KEY PRIOR] button off.

(When the [KEY PRIOR] button is on, the transition 
control block switches to the mode for changing the 
key priority for after the transition.)

2 Holding down the [PRIOR SET] button, press the one 
of the next transition selection buttons [KEY1] to 
[KEY4] ([DSK1] to [DSK4] buttons in the PGM/PST 
bank) for the key to appear on top.

• To select [Key5] to [Key8], or [DSK5] to [DSK8] 
requires an assignment (see page 381). 

• The key priority establishes a separate priority order 
within each of the groups of keys 1 to 4 and keys 5 
to 8. You can make any setting within the groups of 
keys 1 to 4 or keys 5 to 8, but not for combinations 
of keys from different groups.
For example, it is not possible to set a priority 
sequence of keys 1, 5, and 2. 

The selected key now appears on top, on the program 
monitor.
The priority of keys other than the selected one does 
not change.

Notes 

Notes 

Next transition selection buttons
KEY PRIOR button

PRIOR SET button
Key Priority Setting
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To change the priority of more than one key, repeat 
this operation as required.

Changing the key priority for after the 
transition
When executing a transition, turning on the next transition 
selection button [KEY PRIOR] causes the keys to be 
rearranged based on the set priority.
To set the key priority for after the transition, use the 
following procedure.

1 In the transition control block, hold down the [PRIOR 
SET] button and press the [KEY PRIOR] button to 
turn it on. Do not release the [PRIOR SET] button 
before advancing to step 2.

The [KEY PRIOR] button lights green, and it becomes 
possible to change the key priority setting for after the 
transition.

2 Hold down the [PRIOR SET] button, and press the one 
of the next transition selection buttons [KEY1] to 
[KEY4] ([DSK1] to [DSK4] buttons in the PGM/PST 
bank) for the key you want to bring to the front after 
the transition.

To set the priority to be the same as before the 
transition, press the [BKGD] button.

• The [BKGD] button is only effective when in the 
mode for changing the key priority for after the 
transition. 

• To select [Key5] to [Key8], or [DSK5] to [DSK8] 
requires an assignment (see page 381). 

• The key priority establishes a separate priority order 
within each of the groups of keys 1 to 4 and keys 5 
to 8. You can make any setting within the groups of 
keys 1 to 4 or keys 5 to 8, but not for combinations 
of keys from different groups. For example, it is not 
possible to set a priority sequence of keys 1, 5, and 2. 

When the next transition selection button [KEY 
PRIOR] is on, the selected key appears on top on the 
preview monitor. The priority of keys other than the 
selected one does not change.

3 To change the priority of more than one key, repeat the 
previous operation as required.

4 Execute the transition.

The keys are rearranged based on the set priority.

Setting the Key Priority by a Menu 
Operation

When using keys 1 to 8, set the priority separately for the 
two groups (see page 90). 

Changing the priority of the currently 
inserted keys

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ 
then HF3 ‘Key Priority.’

The Key Priority menu appears.

2 For each of <Priority1>, <Priority2>, <Priority3>, and 
<Priority4>, select a key, to determine the key priority 
sequence.

The keys are inserted in the key priority sequence with 
priority 1 at the front.

Notes 

Key 1 selected.

Key priority: 1, 3, 4, 2

Key priority: 3, 1, 4, 2
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It is not possible to select the same key for two or more 
priority numbers.

The keys appear in the set order on the program 
monitor.

Changing the key priority for after the 
transition

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ 
then HF4 ‘Next Key Priority.’

The Next Key Priority menu appears.

2 For each of <Priority1>, <Priority2>, <Priority3>, and 
<Priority4>, select a key, to determine the key priority 
sequence.

For details of the key priority sequence, see the figure 
shown for step 2 in the previous item (see page 89).

The keys appear in the set order on the preview 
monitor.

3 Execute the transition.

The keys are rearranged in the set order on the program 
monitor.

Display of the Key Output Status and 
Key Priority

You can check whether keys are currently output, and the 
key priority setting, using the key status display in the 
transition control block of the M/E or PGM/PST bank.
The display is above the next transition selection buttons 
[KEY1] to [KEY4] ([DSK1] to [DSK4] buttons in the 
PGM/PST bank).

You can change the assignment of the next transition 
selection buttons [KEY1] to [KEY4]. If this is changed, 
the output status and priority is shown for the assigned key.

Display of the key output status
When a key is included in the output from the M/E or 
PGM/PST bank, the corresponding ON indicator lights.

Key priority display
The key priority is indicated by numerals 1 to 4 lighting.
The topmost key as seen on the program monitor is priority 
1, and the keys underneath are numbered 2, 3, 4 away from 
the viewer (see page 89).
To display the key priority for after the transition, press the 
[KEY PRIOR] button in the transition control block, 
turning it on. For keys for which the priority after the 
transition is different from the current priority, the 
corresponding numerals 1 to 4 flash. For a key with the 
same priority, the indication remains on.
Example key status display given when the [KEY PRIOR] 
button is pressed:
Current key priority: 1, 2, 3, 4
Key priority after the transition: 3, 2, 1, 4
Indicators: 1, 3 (flashing), 2, 1 (flashing), 3, 4

Example key status display 
(showing the key priority after the transition)

Priority Setting for Keys 1 to 8

Notes 

Priority 1

Priority 2

Priority 4

Priority 3

Notes 

Lit

Flashing Flashing

LitLit

Lit
Key Priority Setting
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Set the priority for each of the groups consisting of keys 1 
to 4 and keys 5 to 8.

1 In the VF7 ‘Misc’ menu, select HF3 ‘Key Priority,’ to 
display the Key Priority menu.

2 In <Higher Group>, press the button for the group you 
want to be higher.

The button you pressed lights green, and this becomes 
the reference group.

3 Set the reference group priority.

4 In <Higher Group>, select the other group.

5 Set the priority for the other group.

Selecting the Transition 
Type by a Menu 
Operation

You can also select the required transition type by a menu 
operation.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ 
then HF1 ‘Transition.’

The Transition menu appears.

2 Select the required transition type in the <Transition 
Type> group.

The parameter settings can now be adjusted with the 
knobs according to the selected transition type.

For details, see the following.
• “Super Mix Settings” (page 92)
• “Color Matte Settings” (page 92)
• “Setting the Transition Rate” (page 94)

When multi-program mode is selected in the Setup 
menu, there may be cases in which two or more 
transition types have been selected.

For details, see “Setting the Operation Mode” in 
Chapter 20 (Volume 2).

Notes 
91Selecting the Transition Type by a Menu Operation
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Super Mix Settings

You can set the output levels of the current and new video 
signals at the mid-point of the transition, in the range 0 to 
100%. 

This transition type is not available for an independent key 
transition.

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ 
then HF1 ‘Transition.’

The Transition menu appears.

2 Select [Super Mix] in the <Transition Type> group.

3 Turn the knobs to adjust the output levels.

Color Matte Settings

You can specify the color matte by luminance, saturation, 
and hue values.
Also, in place of a color matte you can use an image 
selected on the utility 2 bus. 

• This transition type is not available for an independent 
key transition.

• In the multi-program mode, you can use a preset color 
mix only when selecting the background for the next 
transition.

One-stroke mode and one-time mode
• You can make a setting such that a preset color mix is 

carried out in a single transition. This is called “one-
stroke mode.”
When the bus fixed mode is selected with a Setup menu 
setting, a preset color mix is always carried out in the one-
stroke mode.

• You can also make a setting such that when a preset 
color mix is completed, the next transition switches to 
the previous transition type automatically. This is called 
“one-time mode.”

Notes 

Knob Parameter Adjustment Setting values

2 A Gain Background A 
output level

0.00 to 100.00%

3 B Gain Background B 
output level

0.00 to 100.00%

Notes 
Super Mix Settings / Color Matte Settings
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When only the background is changed

Preset color mix (changing background only)

When a key is inserted

Preset color mix (transition including key)

By means of a Setup menu setting, it is possible to preserve 
the key state while carrying out the color matte mix.

Current video

Color matte

New video

Key fades out

Key

When a key is selected 
as the next transition

When no key is selected

Key fades in
93Color Matte Settings
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When, with a key inserted, a key is selected in the 
next transition

Preset color mix (when set to preserve key state)

Setting the color matte

1 In the M/E or PGM/PST menu, select first VF7 ‘Misc,’ 
then HF1 ‘Transition.’

The Transition menu appears.

2 Select [Preset Color Mix] in the <Transition Type> 
group.

3 In the <Preset Color Mix Fill> group, select one of the 
following.

Flat Color: monochrome color matte
Utility 2 Bus: signal selected on the utility 2 bus

4 When “Flat Color” is selected, turn the knobs to adjust 
the color matte.

Executing a Transition

There are two modes of executing a transition: an auto 
transition by button operation or a manual transition using 
the fader lever.
It is also possible to combine both methods, taking control 
with the fader lever of an auto transition which has partly 
completed, or complete a transition started with the fader 
lever as an auto transition.
By combining common transitions with independent key 
transitions, different transition types can be applied to the 
background and keys, for example allowing a key wipe 
combined with a background dissolve. 
When the audio mixer is linked in setup, you can carry out 
an auto transition, and also switch the sound with the audio 
mixer (see page 87). 

Transition Indicator Function

In each of the M/E banks and PGM/PST bank, to the left 
of the fader lever is a transition indicator composed of 
multiple LEDs. This indicator shows the state of the 
transition, whether auto or manual, by which LEDs are lit.

Transition indicator

For example, in the previous illustration, it can be seen that 
the transition is more than half completed.
When the transition is completed, all of the LEDs go off.

Setting the Transition Rate

There are two ways of setting the transition rate: using the 
Flexi Pad control block, Multifunction Flexi Pad control 
block or numeric keypad control block to enter a numeric 
value, or using the Misc menu to access the Transition 
menu for the M/E or PGM/PST bank.

Knob Parameter Adjustment Setting values

2 Luminance Luminance 0.00 to 100.00

3 Saturation Saturation 0.00 to 100.00

4 Hue Hue 359.99 to 0.00

Key

Key state preserved

Key gradually removed

Lit
Executing a Transition
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You can also display the transition rate, independent key 
transition rate, and fade-to-black transition rate for each of 
the M/E and PGM/PST banks, and change the settings (see 
page 223). 

When a clip transition is selected as the transition type, it 
is not possible to set the transition rate.

Frame input mode and timecode input 
mode
For numeric input of the transition rate value, there are two 
modes: frame input mode and timecode input mode. You 
select one of these modes using either the Flexi Pad control 
block (page 95), Multifunction Flexi Pad control block or 
the numeric keypad control block (page 96).
Frame input mode: The entered value is a number of 

frames.
Example: Entering 123 constitutes an entry of 123 
frames

Timecode input mode: The entered value is a timecode 
value.
Example: Entering 123 constitutes an entry of 1 
second 23 frames.

Whereas you can enter a value of up to 999 in frame input 
mode, a value not smaller than 10 seconds cannot be 
entered in timecode input mode.

Frame display mode and timecode display 
mode
For the transition rate display in the transition control 
block, there are two modes: frame display mode and 
timecode display mode. You can select one of these modes 
in setup. 

For details, see “Setting the Transition Rate Display 
Mode” in Chapter 19 (Volume 2).

The setting is common to all banks of the switcher.

Frame display mode: Values are shown as from 0 to 999 
frames. In this display mode, a value entered in 
timecode input mode is converted for display as a 
number of frames.

Timecode display mode: Values are shown as timecode 
values, consisting of seconds and frames. In this 
display mode, a value entered in frame input mode is 
converted for display as a timecode value. If the value 
consists of four or more digits, the last digit is not 
shown.

Example: A value of 9 seconds 23 frames appears as 
“9.23” and a value of 10 seconds 1 frame appears as 
“10.0.”

Setting the transition rate in the Flexi Pad 
control block

When using a simple-type transition control block, you 
cannot use the Flexi Pad control block to set the transition 
rate.

1 In the M/E bank Flexi Pad control block, press the 
[TRANS RATE] button.

The memory recall section display is now ready to 
accept the entered transition rate.

Flexi Pad control block (standard type)

2 Enter the desired transition rate with the numeric 
keypad. 
If required, press the [TC] button to toggle the input 
mode (frame input or timecode input).

• Enter a value of up to three digits.
• To cancel the entry, press any of the six buttons in 

the leftmost column ([WIPE], [DME], ...) or the 
[TRANS RATE] button.

3 Press the [ENTR] button.

This confirms the entry, and the new setting appears in 
the transition control block display.

Notes 

Notes 

Notes 

Notes 

ENTR button

Memory recall section

TC button

TRANS RATE button
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Setting the transition rate in the numeric 
keypad control block

Numeric keypad control block

1 In the numeric keypad control block, press the 
[TRANS RATE] button.

2 Press the region selection button for the M/E or PGM/
PST bank for which you want to set the transition rate, 
turning it on.

The numeric keypad control block display now shows 
the selected region name and the current transition rate 
setting for the region.

3 With the numeric keypad, enter the transition rate.

If required, press the [TC] button to toggle the input 
mode (frame input or timecode input).
• Enter a value of up to three digits.
• To clear the entry, press the [CLR] button.

4 Press the [ENTER] button.

This confirms the entry, and the selected region name 
and the set transition rate appear in the numeric keypad 
control block display.
The transition control block display of the same bank 
(M/E or PGM/PST) also shows the setting.

To enter a difference from the current value
After pressing the [+/–] button, enter the difference and 
press the [TRIM] button.
To change the sign (+ or –), press the [+/–] button.

Setting the transition rate in the 
Multifunction Flexi Pad control block

1 In the Multifunction Flexi Pad control block, press the 
[TRANS RATE] button.

The button displays in the memory recall section 
change as shown in the following illustration, and the 
Multifunction Flexi Pad control block switches to the 
transition rate setting mode.

2 In the region selection buttons, select the switcher 
bank.

3 Press the [TRANS SEL] button in the memory recall 
section.

The button displays in the memory recall section 
change as shown in the following illustration, and you 
can select the type of transition for which to set the 
rate.

4 Press the [TRANS] button.

You can now set the M/E-1 block background 
transition rate.

5 Watching the alphanumeric display, enter the 
transition rate you want to set with the memory recall 
section button.

If required, press the [TC] button to switch the input 
mode (frame count input or timecode input).

TRANS RATE button

Region selection buttons

Display

Numeric keypad

ENTER buttonTC button
Executing a Transition
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• Enter a value of up to three digits.
• To cancel the input, press any of the mode selection 

buttons.

6 Press the [ENTR] button.

Setting the transition rate by a menu 
operation

1 In the switcher bank, select first VF7 ‘Misc,’ then HF1 
‘Transition.’

The Transition menu appears.

2 Select any transition type in the <Transition Type> 
group.

3 Turn the knob to set the transition rate.

Displaying the transition rates in a menu 
and changing the settings
For each of the M/E and PGM/PST banks, you can display 
the transition rate, independent key transition rate and 
fade-to-black transition rate, and change the settings (see 
page 223).

Pattern Limit

When a wipe or DME wipe pattern is selected for the 
transition, you can specify the range of movement of the 
wipe pattern through the course of the transition, for each 
bank independently.
When the pattern limit function is enabled, carrying out a 
transition results in the following effect for example 
settings.
• When the limit value is set to 50%, the effect at the end 

of the transition is the same as when the fader lever is at 
the center position in the normal case (with the pattern 
limit function disabled); the wipe pattern does not 
complete.

• When the limit value is set to 0%, the wipe effect is 
completely disabled, and carrying out the transition 
produces no change in the image.

• When the limit value is set to the maximum 100%, the 
image changes in exactly the same way as when the 
pattern limit function is off, but when the transition is 
completed, the cross-point selections on the background 
A and B buses do not interchange.

There are two ways of setting a pattern limit: either by 
operating the fader lever to save the fader position, or by 

using the Wipe menu or DME Wipe menu to access the 
Edge/Direction menu for the M/E or PGM/PST bank.

• A pattern limit only applies when a wipe or DME wipe 
is selected as the transition type.

• A pattern limit cannot be applied to an independent key 
transition (see page 102).

Transition control block (standard type)

Setting the pattern limit with the fader 
lever

1 Move the fader lever to the position corresponding to 
a particular pattern size.

• First make sure that the [PTN LIMIT] button is off.
• To check the pattern size on the preview monitor, 

first press the [TRANS PVW] button, to select the 
transition preview mode (see page 101).

2 Press the [LIMIT SET] button.

This sets the current fader lever position as the pattern 
limit.

Setting the pattern limit by a menu 
operation

1 When a wipe is selected as the transition type, in the 
M/E or PGM/PST menu, select first VF5 ‘Wipe,’ then 
HF4 ‘Edge/Direction.’

When a DME wipe is selected as the transition type, in 
the M/E or PGM/PST menu, select first VF6 ‘DME 
Wipe,’ then HF4 ‘Edge/Direction.’

Knob Parameter Adjustment Setting values

1 Transition 
Rate

Transition Rate 0 to 999 (frame 
count)

Notes 

TRANS PVW button

PTN LIMIT button

LIMIT SET button
97Executing a Transition
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The Edge/Direction menu appears.

2 Press the [Pattern Limit] button, turning it on.

3 Turn the knobs to adjust the following parameters.

a) 0.00%: Executing the transition does not change the video output at 
all.

b) 100.00%: The transition is the same as when no pattern limit is set, 
but the cross-point button selections of the background A and B 
buses do not interchange when the transition completes.

Executing a pattern limit transition

1 Press the [PTN LIMIT] button, turning it on.

The button you pressed lights amber.

2 Carry out the transition.

The transition progresses as far as the set pattern limit. 
Even if the transition completes, the cross-point button 
assignments of the background A and B buses do not 
interchange.

3 Carry out the transition once again.

The status before the previous transition is restored.

To cancel the pattern limit
To cancel the pattern limit after completion of step 3 in the 
previous procedure, press the [PTN LIMIT] button, 
turning it off.
If after carrying out step 2 in the previous procedure, the 
pattern limit has been reached, carry out the following 
procedure.

1 Press the [PTN LIMIT] button.

The button you pressed lights green.

2 Carry out the transition.

The [PTN LIMIT] button goes off, and the pattern 
limit state is released.
Depending on the way in which the transition was 
executed, the action will be as follows.
• When you press the [CUT] button, the pattern limit 

is immediately released, and the image switches 
instantaneously.

• When you press the [AUTO TRANS] button, until 
the state of the next transition, the transition is 
carried out over the duration given by the transition 
rate.

• When you move the fader lever, the transition is 
carried out from the pattern limit state to the state 

before the pattern limit transition was carried out.
Moving the fader lever even a little synchronizes the 
fader lever position with the transition state, and you 
can move the fader lever either in the forward 
direction or in the reverse direction.

Depending on the Setup settings, the transition may be 
executed at the instant you press the [PTN LIMIT] 
button, and the button goes off. In this case, execution 
continues for the time specified by the dedicated 
transition rate in the menu setting, as far as the state of 
the next transition.

For details of the setting, see “Selecting the Bank to 
Make the Settings” in Chapter 20 (Volume 2).

To set the transition rate when the pattern limit is 
released

1 In the <Pattern Limit Release> group of the Edge/
Direction menu, select one of the following.

Auto Trans Rate: Use the transition rate set in the 
transition rate control block

Independ Trans Rate: Independent transition rate

2 If you selected “Independ Trans Rate” in step 1, adjust 
the following parameter.

Executing an Auto Transition

The following two modes can be used for auto transition.

Cut
A cut switches instantaneously from the current video to 
the new video. When the next transition is a key transition, 
the key cuts in or out instantaneously.

Auto transition
The transition from the current video to the new video is 
carried out automatically at a constant rate, using the 
transition effect selected as the transition type.
You can set the transition rate in advance (see page 94). 

Knob Parameter Adjustment Setting values

1 Pattern 
Limit

Pattern limit 0.00 a) to 
100.00 b) %

Knob Parameter Adjustment Setting values

1 Transition 
Rate

Independent 
transition rate

0 to 999 
(frames)
Executing a Transition
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Transition control block (standard type)

To execute a transition on the M/E or PGM/PST bank by a 
button operation, use the following procedure in the 
transition control block.
To carry out an instantaneous cut transition: Press the 

[CUT] button.
To carry out a gradual transition: Press the [AUTO 

TRANS] button.
This executes the transition at the preset transition rate 
(see page 94).
While the transition is executing, the [AUTO TRANS] 
button lights amber. When it completes the button 
goes off.

To complete a partially executed transition 
instantaneously: Press the [CUT] button.
The [AUTO TRANS] button goes off.

Executing a Transition With the 
Fader Lever (Manual Transition)

Using the fader lever, you can manually control the 
progress of the transition. Moving the fader lever from one 
end of its travel to the other completes the transition.
To execute a manual transition with the transition control 
block fader lever, use the following procedure.
To carry out the transition completely: Move the lever 

over the full range of its travel.
To pause a partly executed transition: Stop moving the 

fader lever.
To resume a paused transition: Resume moving the 

fader lever.

Combinations of Auto and Manual 
Transitions

Using the [AUTO TRANS] button, the [CUT] button, and 
the fader lever, use the following procedures.

Moving the fader lever during an auto 
transition
During an auto transition started by pressing the [AUTO 
TRANS] button, operating the fader lever immediately 
enables the fader lever, and the [AUTO TRANS] button 
goes off. Thereafter, the fader lever controls the progress 
of the transition.

Executing an auto transition after partly 
moving the fader lever
• Press the [CUT] button to instantaneously complete the 

transition.
• Press the [AUTO TRANS] button to complete the rest of 

the transition at the preset transition rate.
If the transition rate is set to 100 frames, and the fader lever 
has moved through 1/4 of the transition, then the remaining 
3/4 of the transition is carried out in 100 frames.

Non-Sync State

If the fader lever is in an intermediate position when a 
transition is completed as an auto transition, then the lever 
position no longer agrees with the transition state. This is 
termed a non-sync state.
In a non-sync state, two lit LEDs indicate the position from 
which a normal transition can be carried out. This is either 
at one end position or both end positions of the fader lever 
travel.
Moving the fader lever toward the position of the lit LEDs 
does not carry out a transition, but when the fader lever 
reaches the end position the non-sync state is released, and 
it is now possible to carry out the next transition.

Fader lever

AUTO TRANS button

CUT button
99Executing a Transition
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• If the fader lever is moved in the direction away from the 
lit LEDs, this carries out the next transition, over the 
remaining part of the fader lever travel.

• Even in a non-sync state, you can carry out an auto 
transition by pressing the [AUTO TRANS] button. 
During the auto transition, the indicators show the 
transition progress in the usual way, but when the 
transition completes, they once again indicate the non-
sync state.

Fader Lever Operation in Bus Fixed 
Mode

Flip-flop mode and bus fixed mode
The following describes the difference between flip-flop 
mode and bus fixed mode, taking an M/E bank as an 
example; the functionality is the same, however, on the 
PGM/PST bank.

Normally, when a background transition is carried out on 
an M/E bank, the signals selected on the A and B rows of 
cross-point buttons are interchanged at the end of the 
transition. That is to say, except during a transition, the 
background output is always from the background A bus. 
This is called “flip-flop mode.”
The alternative is known as “bus fixed mode,” in which 
there is no bus interchange. In this mode, when the fader 
lever is at the top of its travel the output from the A bus is 
always 100%, and when the fader lever is at the bottom of 
its travel the output from the B bus is 100%.

Flip-flop mode and bus fixed mode

In the bus fixed mode there is a fixed relationship between 
the position of the fader lever and the signal output on each 
bus. Depending on the direction of the transition, the fader 
lever must therefore always be moved in a particular 
direction, as shown in the following table. This does not 
affect an auto transition, which is executed regardless of 
the fader lever direction.

Manual transition completed 
as auto transition when 
moving the fader lever upward: 
Top two LEDs light.

Manual transition completed 
as auto transition when 
moving the fader lever 
downward: Bottom two LEDs 
light.

Once the fader lever 
is moved to this 
position, the non-sync 
state ends, and the 
next transition 
(direction shown by 
the arrow) is possible.

Next transition Transition 
direction

Fader lever 
movement

Background A t B Downward

B t A Upward

Keys 1, 2, 3, 4, 
5, 6, 7, and 8

On t Off 
(deletion)

Downward

Off t On 
(insertion)

Upward

Buttons lit

Flip-flop mode

Bus fixed mode

Fader 
lever
Executing a Transition
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• When a transition applies to a combination of more than 
one of the background and keys 1, 2, 3, 4, 5, 6, 7, and 8, 
then the transition for all of these must be in the same 
direction complying with the above table.

• If as a result of an auto transition, for example, the fader 
lever position does not agree with the signal output, this 
is a non-sync state (see page 99) and LEDs light at both 
end positions of the fader lever travel. Moving the fader 
lever does not carry out a transition, but when the fader 
lever reaches the end position the non-sync state is 
released, and it is now possible to carry out the next 
transition. If the fader lever is moved in the direction 
away from the lit LEDs, this carries out the next 
transition, over the remaining part of the fader lever 
travel. 

Transition Preview

With the preview output of the M/E banks and PGM/PST 
bank, you can check the effect of a transition in advance. 
To carry out a transition preview, press the [TRANS 
PVW] button in the transition control block.

In multi-program mode, DSK mode or bus fixed mode 
(page 100), it is not possible to carry out a transition 
preview.

Carrying out a transition preview

1 In the M/E or PGM/PST bank transition control block, 
press the [TRANS PVW] button.

The [TRANS PVW] button lights green, and the 
switcher is now in the transition preview mode. At this 
point, the preview output is the same as the program 
output before the [TRANS PVW] button was pressed.

2 Operate the fader lever, or press the [AUTO TRANS] 
button or [CUT] button.

On the preview monitor, you can check the effect of 
the transition.

To terminate a transition preview
There are three modes for a transition preview. To 
terminate a transition preview, carry out the operation 
which depends on the mode, and press the [TRANS PVW] 
button, turning it off.
Lock: Toggling the [TRANS PVW] button on and off 

switches between the transition preview mode and the 
normal mode.

Hold: The preview mode obtains only while the [TRANS 
PVW] button is held down.

One Time: Each time a transition ends, it reverts to the 
normal mode.

Set the transition preview mode in the following 
combinations. 

For details, see “Setting the Button Operation Mode” in 
Chapter 19 and “Settings Relating to Video Switching 
(Transition Menu)” in Chapter 20 (Volume 2).

Notes

Transition 
Preview mode

Switcher setup
(Transition menu)
<Transition 
Preview> group

Panel setup
(Operation 
>Custom Button 
menu)
<Trans Pvw> group

Lock Normal Lock

Hold Normal Hold
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• During a transition, whether executed with the [AUTO 
TRANS] button or the fader lever, it is not possible to 
press the [TRANS PVW] button.

• In bus fixed mode (see page 100), transition previews 
are not available.

• When using the simple-type transition control block (see 
page 109), transition previews are not available.

Independent Key 
Transitions

What is an independent key transition?
In addition to common transitions, it is possible to carry 
out independent transitions on the keyers of the M/E banks 
and PGM/PST bank. These are called “independent key 
transitions.”
By carrying out an independent key transition in 
combination with a common transition, different transition 
types can be used for the background and keys. It is also 
possible to use different transition types for key insertion 
and key deletion by means of a Setup menu setting (see 
page 105).

Combining other transitions with 
independent key transitions
When you set a common transition and a key independent 
transition for the same key, you can apply two different 
effects such as a wipe and mix (dissolve) (see page 85)  to 
the key simultaneously.
When carrying out such a combination of transitions 
simultaneously on a key as auto transitions (see page 98), 
the result depends on the timing of pressing the respective 
[AUTO TRANS] buttons.

Simultaneous execution
If the [AUTO TRANS] buttons for the two transitions are 
pressed simultaneously, the following is the result.
Note that in both cases the common transition is a wipe and 
the independent key transition is a mix (dissolve).
Deleting a key with simultaneous transitions: With the 

key inserted, it is deleted simultaneously with the two 
transitions.
When the common transition completes, even if the 
independent key transition is still not completed, the 
two end simultaneously.

One Time One Time –

Notes

Transition 
Preview mode

Switcher setup
(Transition menu)
<Transition 
Preview> group

Panel setup
(Operation 
>Custom Button 
menu)
<Trans Pvw> group
Independent Key Transitions
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Deleting a key with simultaneous transitions

Inserting a key with simultaneous transitions: With the 
key not inserted, it is inserted simultaneously with the 
two transitions. If the common transition or 
independent key transition ends first, the other 
continues to completion.

Inserting a key with simultaneous transitions

Time offset execution
If the [AUTO TRANS] buttons for the two transitions are 
pressed with a time offset, the following is the result.
Note that in both cases the common transition is a wipe and 
the independent key transition is a mix (dissolve).
Time offset execution with the key inserted: With the 

key inserted, it is deleted with the two transitions 
acting with a time offset.
Whichever button is pressed first, when the common 
transition completes, even if the independent key 
transition is still not completed, the two end 
simultaneously.

Time offset execution with the key inserted

Time offset execution with the key not inserted: With 
the key not inserted, it is inserted with the transition 
whose [AUTO TRANS] button is pressed first.
Since the key is then in the inserted state, with the 
transition whose [AUTO TRANS] button is pressed 
later, the key is deleted. When the key is completely 
deleted, both transitions complete.

Wipe and mix 
(dissolve) are carried 
out simultaneously.

The key is deleted, 
even if the 
independent key 
transition has not 
completed.

Wipe and mix 
(dissolve) are 
carried out 
simultaneously.

The transitions 
continue until both 
are completed.

Common transition 
(wipe)

Independent key 
transition (mix)

The key is deleted, 
even if the 
independent key 
transition has not 
completed.

Example: When the independent key transition [AUTO TRANS] 
button is pressed later
103Independent Key Transitions
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Time offset execution with the key not inserted Time offset execution with the key not inserted

Common transition 
(wipe)

Independent key 
transition (mix)

Example 1: When the independent key transition [AUTO TRANS] 
button is pressed later

The transition 
completes with 
the key deleted.

Common transition 
(wipe)

Independent key 
transition (mix)

The transition 
completes with 
the key deleted.

Example 2: When the common transition [AUTO TRANS] button 
is pressed later
Independent Key Transitions
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Basic Independent Key Transition 
Operations

Independent key transition control block (standard type)

To set independent transitions for the keyers on the M/E or 
PGM/PST bank, use the independent key transition control 
block.

1 Select one or more of the delegation buttons [KEY1] 
to [KEY4] ([DSK1] to [DSK4] in the PGM/PST 
bank), turning them on.

You can press more than one button at the same time.

The buttons for [Key5] to [Key8] and [DSK5] to 
[DSK8] require previous assignment in the Setup 
menu (see page 381).

2 Select the transition type.

To fade a key in or out: Press the [MIX] button, 
turning it on.

To insert or delete a key using a dedicated wipe 
pattern: Press the [WIPE] button, turning it on.

To insert or delete a key using a dedicated DME 
wipe pattern: Press the [DME] button, turning it 
on.

To instantaneously insert or remove the key: press 
the [CUT] button, turning it on.

If, in the Setup menus, you set insertion and deletion 
as independent modes, make the settings for the next 
transition in the independent key transition control 
block.
Separate settings are required both when inserting a 
key and when deleting it. For example, with the key 
not inserted, if you select the transition type and carry 
out a transition, this will be the setting when inserting 
a key.
You can also use the Transition menu to select a 
desired independent key transition type for each key 
(see the next section).

For details of the wipe settings, see “Wipe Settings for 
Independent Key Transitions” (page 164). For details 
of DME wipe settings, see “DME Wipe Settings for 
Independent Key Transitions” (page 182).

3 Execute the transition.

To insert or delete the key gradually with a mix or 
wipe transition: Press the [AUTO TRANS] 
button.

For details of the transition rate, see “Setting the 
Independent Key Transition Rate” (page 106).
For details of operation together with a common 
transition, see “Combining other transitions with 
independent key transitions” (page 102).

To cut the key in or out instantaneously: Press the 
[KEY ON] button on the keyer.

• In an independent key transition, the pattern limit 
function is not available.

• When the following DME effects are set, the effects 
may be applied during wipe transitions. If the effects 
are not necessary, cancel the settings.
- Trail
- Motion Decay
- Wind
When the Keyframe Strobe effect is set, operating 
keyframes do the same effect. Cancel the 
unnecessary settings.

Notes 

Independent key transition type 
selection buttons

Independent key transition execution section

Key delegation buttons
Key source name display/key 
snapshot buttons

Notes 
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Independent key transition operations 
when using the CCP-6224/6324 Control 
Panel

Transition control block (compact type)

To carry out an independent key transition, press the 
corresponding button in the independent key transition 
execution section of the transition control block.
The color of the button shows the status as follows.
Lit green: transition in progress.
Lit amber: key inserted.
Lit red: key inserted into final program output.
Off: no key inserted.

For details of setting the transition rate, see “Setting the 
transition rate in the Flexi Pad control block” (page 95).

The buttons for [Key5] to [Key8] and [DSK5] to [DSK8] 
require previous assignment in the Setup menu (see page 
381). 

Setting the Independent Key 
Transition Type by a Menu Operation

You can also select the required independent key transition 
type by a menu operation.

1 In the M/E or PGM/PST menu, select first the desired 
one from VF1 ‘Key1’ to VF4 ‘Key4,’ then HF6 
‘Transition.’

The Transition menu for the selected appears.

2 Select the required transition type in the <Transition 
Type> group.

If, in the Setup menus, you set insertion/deletion as 
independent modes, make the settings for insertion in 
the <On Transition Type> group, and the settings for 
deletion in the <Off Transition Type> group.

Setting the Independent Key 
Transition Rate

There are two ways of setting the transition rate: using the 
Flexi Pad control block, Multifunction Flexi Pad control 
block or numeric keypad control block to enter a numeric 
value, or using the Key menu to access the Transition 
menu for the M/E or PGM/PST bank.
You can also display the transition rate, independent key 
transition rate, and fade-to-black transition rate for each of 
the M/E and PGM/PST banks, and change the settings (see 
page 223).
When the setup selection is for separate transition rates for 
inserting or deleting a key, you can set both rates 
independently. For example, with the system in the state 
with the key not inserted, the transition rate setting applies 
to key insertion.

Setting the independent key transition rate 
in the Flexi Pad control block

In the PGM/PST bank or when using a simple-type 
transition control block, you cannot use the Flexi Pad 
control block to set the transition rate.

1 In the Flexi Pad control block of the M/E bank, hold 
down the [TRANS RATE] button, and in the 
independent key transition control block, press the 
delegation button [KEY1] to [KEY8] for the key for 
which you want to set the transition rate.

The memory recall section display is now ready to 
accept the entered independent key transition rate.

2 Enter the desired transition rate with the numeric 
keypad.

• Enter a value of up to three digits.
• To cancel the entry, press any of the six buttons in 

the leftmost column ([WIPE], [DME], ...) or the 
[TRANS RATE] button.

For details of frame input mode and timecode input 
mode, see page 95.

3 Press the [ENTR] button.

Setting the independent key transition rate 
in the numeric keypad control block

You cannot use the numeric keypad control block to set the 
transition rate for a simple transition.

Notes 

Independent key transition execution section

Notes 

Notes 
Independent Key Transitions
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1 In the numeric keypad control block, hold down the 
[TRANS RATE] button, and in the independent key 
transition control block, press the delegation button 
[KEY1] to [KEY8] ([DSK1] to [DSK8] in the PGM/
PST bank) for the key for which you want to set the 
transition rate.

The numeric keypad control block changes to the 
mode for inputting the independent key transition rate, 
and its display now shows the corresponding region 
name and the current transition rate set for the region.

2 With the numeric keypad, enter the transition rate.

• Enter a value of up to three digits.
• To clear the entry value, press the [CLR] button.

For details of frame input mode and timecode input 
mode, see page 95.

3 Press the [ENTER] button.

This confirms the entry, and the selected region name 
and the set transition rate appear in the numeric keypad 
control block display.

To enter a difference from the current value
After pressing the [+/–] button, enter the difference and 
press the [TRIM] button.
To change the sign (+ or –), press the [+/–] button.

Setting the independent key transition rate 
in the Multifunction Flexi Pad control block
For example, to set the independent key transition rate for 
M/E-1 key1, carry out the following procedures.

1 In the Multifunction Flexi Pad control block, press the 
[TRANS RATE] button.

The Multifunction Flexi Pad control block switches to 
the transition rate setting mode.

2 In the region selection buttons, select the switcher 
bank.

3 Press the [TRANS SEL] button in the memory recall 
section.

You can select the type of transition for which to set 
the rate.

4 Press the [KEY1] button.

This enables setting of the independent key transition 
rate for M/E-1 key1.

5 Watching the alphanumeric display, enter the 
transition rate you want to set with the memory recall 
section button.

If required, press the [TC] button to switch the input 
mode (frame count input or timecode input).
• Enter a value of up to three digits.
• To cancel the input, press any of the mode selection 

buttons.

6 Press the [ENTR] button.

Setting the independent key transition rate 
by a menu operation

1 In the M/E or PGM/PST menu, select first the desired 
one from VF1 ‘Key1’ to VF4 ‘Key4,’ then HF6 
‘Transition.’

The Transition menu for the selected key appears.

2 Select any transition type in the <Transition Type> 
group.

If, in the Setup menus, you set insertion/deletion as 
independent modes, make the settings for insertion in 
the <On Transition Type> group, and the settings for 
deletion in the <Off Transition Type> group.

3 Turn the knob to set the transition rate.

Independent key transition rate display
To check the set independent key transition rate, press the 
key source name display/key snapshot button above the 
corresponding delegation button when the [K-SS] button is 
off.

Displaying the independent key transition 
rates in a menu and changing the settings
For each of the M/E and PGM/PST banks, you can also 
display the transition rate, independent key transition rate 
and fade-to-black transition rate, and change the settings 
(see page 223).

Knob Parameter Adjustment Setting values

1 Transition 
Rate

Transition rate 0 to 999 (frame 
count)
107Independent Key Transitions
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Fade to Black

The PGM/PST bank provides a fade-to-black function, 
controlled with the [FTB] button in the fade to black 
control block. 

In multi-program mode or DSK mode, it is possible to 
carry out a fade-to-black on a number of programs 
simultaneously.

You can also make a Setup menu setting such that a fade-
to-black does not apply to particular programs.

For details of the setting, see “Settings Relating to Video 
Switching (Transition Menu)” in Chapter 20 (Volume 2).

Fade to Black Operation

Fade to black control block

Carrying out a fade to black
Press the [FTB] button in the fade to black control block.
The fade to black is carried out with the transition rate set 
for the program output of the PGM/PST bank.
During the transition, the [FTB] button lights amber. When 
the transition completes (the video is completely black), 
the button lit color changes to red.

Setting the Fade to Black Transition 
Rate

Setting the fade to black transition rate

1 In the PGM/PST menu, select first VF7 ‘Misc,’ then 
HF1 ‘Transition.’

The Transition menu appears.

2 Select [FTB].

3 Turn the knob to set the fade to black transition rate.

Displaying the transition rates in a menu 
and changing the settings
You can also display the transition rate, independent key 
transition rate, and fade-to-black transition rate for each of 
the M/E and PGM/PST banks, and change the settings (see 
page 223).

Notes 

FTB button

Knob Parameter Adjustment Setting values

1 Transition 
Rate

Transition rate 0 to 999 (frame 
count)
Fade to Black
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Simple Transition

Basic Operations for Simple 
Transitions

A simple-type transition control block is used to carry out 
a transition.

Transition control block (simple right-hand type)

The simple transition control block cannot be installed in 
the CCP-6224/6324 Control Panel.

Carrying out a transition using a simple-
type transition control block

1 With the background A row of cross-point buttons in 
the cross-point control block, select the background 
video.

2 Using one of the following methods, select the way in 
which the transition will affect the image.

Use a combination of the transition type selection 
buttons ([MIX], [NAM], [WIPE] and [DME]) and the 
next transition selection buttons ([KEY1] and 
[KEY2]).

For an overview of the mix, NAM, wipe, and DME 
wipe transition types, see “Transition Types” (page 
85). 

To change the background only: Press one of the 
[MIX], [NAM], [WIPE], and [DME] buttons.
The [KEY1] and [KEY2]buttons go off, and the 
system changes to the background transition 
mode.

To insert or delete key 1: Hold down the [KEY1] 
button and press one of the [MIX], [NAM], 
[WIPE], and [DME] buttons.

To insert or delete key 2: Hold down the [KEY2] 
button and press one of the [MIX], [NAM], 
[WIPE], and [DME] buttons.

To insert or delete key 1 and key 2 simultaneously: 
Hold down the [KEY1] and [KEY2] buttons, and 
press one of the [MIX], [NAM], [WIPE], and 
[DME] buttons.

To use a super mix or preset color mix: Select 
[Super Mix] or [Preset Color Mix] in the Misc 
>Transition menu for the M/E or PGM/PST bank.

To set the key priority, use the Misc >Key Priority 
menu for the M/E or PGM/PST bank (see page 89).

The transition type selection buttons ([MIX], [NAM], 
[WIPE], and [DME]) can be assigned to other 
transition types in setup.

For details, see “Setting Transition Control Block 
Button Assignments” in Chapter 19 (Volume 2).

3 Select the new background for after the transition.

• Select the background video with the background B 
row of cross-point buttons.

• To insert a key, select the key signal, and make 
various settings as required.

For details of key settings, see Chapter 4 “Keys” (page 
112).

4 Depending on the transition type selected in step 2, 
make the required settings.

For details of the settings, see the following sections:

Super mix: “Super Mix Settings” (page 92)
Preset color mix: “Color Matte Settings” (page 92)
Wipe: “Basic Procedure for Wipe Settings” (page 

152)
DME Wipe: “Basic Procedure for DME Wipe 

Settings” (page 176)
Clip transition: “Clip Transition Operations” (page 

208)

5 Carry out the transition in the transition execution 
section.

For a gradual transition such as a mix or wipe: 
Press the [TAKE] button, or operate the fader 
lever.

Notes 

Key status display

Key transition selection buttons

Transition type selection buttons

Transition execution section

Notes 
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See “Setting the Transition Rate” (page 94) and 
“Pattern Limit” (page 97) as required.

Display of the Key Output Status and 
Key Priority

You can check the output status of keys 1 and 2 and the key 
priority setting, in the key status display in the transition 
control block.
The key status display includes two ON indicators 
corresponding to keys 1 and 2.

Display of the key output status
When the key is inserted in the output from the M/E or 
PGM/PST bank, the indication “ON” lights, and when it is 
not inserted, the indication goes off.

Key priority display
The key lying in front on the program monitor has an 
indication “OVER” lit.
To set the key priority, use the Misc >Key Priority menu 
for the M/E or PGM/PST bank (see page 89).

Split Fader

What does “split fader” mean?
The term “split fader” refers to the function of carrying out 
a transition with the fader lever split into left and right 
halves, so that the background A and background B buses 
can be manipulated separately.
To use the split fader, the following conditions must be 
met.
• The fader lever is in bus fixed mode.

For details, see “Selecting the Bank to Make the 
Settings” in Chapter 20 (Volume 2).

• The necessary settings have been made in a Setup menu 
to enable the split fader. 
For details, see “Selecting the Bank to Make the 
Settings” in Chapter 20 (Volume 2).

• A background is selected for the next transition.
• For the transition type, [MIX] or [NAM] is selected.

Split fader operation
The two halves of the split fader lever correspond to the 
buses as follows.
Right fader lever: Background A bus
Left fader lever: Background B bus
The relationship between the positions of the two fader 
levers and the image output in a mix is as follows.

• When the transition type is NAM, the outputs of the A 
bus and B bus in the above table are the outputs 
subjected to NAM.

• The transition indicators always show the progress of the 
background A bus.

• The operation of the left lever and that of the right lever 
can be swapped.
For details, see “Specifying Main Split Fader” in 
Chapter 19 (Volume 2).

Independent Key Transitions With a 
Simple Transition Module

You carry out independent key transition operations using 
the independent key transition control block (simple type). 
This controls only keys 3 and 4. However, each key button 
can be assigned to any key in setup.

For details , see “Assigning a Function to the Independent 
Key Transition Control Block (Simple Type)” in Chapter 
19 (Volume 2).

Independent key transition control block (simple type)

Left lever 
position

Right lever 
position

A bus 
output

B bus 
output

Top Top 100% 0%

Bottom Top 100% 100%

Top Bottom 0% 0%

Bottom Bottom 0% 100%

Center Center 50% 50%

Left lever 
position

Right lever 
position

A bus 
output

B bus 
output

Key 3 control block Key 4 control block

Independent key transition type 
selection buttons

Independent key transition 
execution section

The functions of the key 3 control block and key 4 control block 
are the same.
Simple Transition
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Carrying out a transition using a simple-
type independent key transition control 
block

1 Select the transition type for key 3 or key 4 using the 
independent key transition type selection buttons.

To fade a key in or out: Press the [MIX] button, 
turning it on.

To insert or delete a key using a dedicated wipe 
pattern: Press the [WIPE] button, turning it on.

To insert or delete a key using a dedicated DME 
wipe pattern: Press the [DME] button, turning it 
on.

For details of wipe settings, see “Wipe Settings for 
Independent Key Transitions” (page 164). For details 
of DME wipe settings, see “DME Wipe Settings for 
Independent Key Transitions” (page 182).

To cut the key instantaneously in or out: Press the 
[CUT] button, turning it on.

If, in the Setup menus, you set insertion and deletion 
as independent modes, make the settings for the next 
transition in the independent key transition control 
block.
Separate settings are required both when inserting a 
key and when deleting it. For example, with the key 
not inserted, if you select the transition type and carry 
out a transition, this will be the setting when inserting 
a key.

2 Carry out the transition in the independent key 
transition execution section.

To insert or delete the key gradually with a mix or 
wipe transition: Press the [TAKE] button.
To set the independent key transition rate using a 
simple-type transition control block, use the key 3 
and key 4 Transition menus (see page 106). 

To cut the key in or out instantaneously: Press the 
[KEY 3 ON] button or [KEY 4 ON] button.

In an independent key transition, the pattern limit 
function is not available.

Notes 
111Simple Transition



112

  C
hapter 4  K

eys

hapter4
CKeys
Overview

A key is an effect in which a part of the background image 
is replaced by an image or superimposed text. The signal 
determining how the background is cut out is termed “key 
source,” and the signal that replaces the cut-out part is 
termed “key fill.”
The system component responsible for processing a key is 
referred to as a keyer.
Each M/E bank and the PGM/PST bank has eight keyers, 
and all of these keyers provide the same functions.

When the signal format is 1080P, four keyers can be used 
(keys 1 to 4).

Key Types

The key type indicates the manner in which the key source 
signal is used to cut out the background. In each bank, you 
can use the following key types. You can select the key 
type using the key type selection buttons in the key control 
block or Multi function Flexi Pad control block, or by a 
setting in the Type menu for the keyer (see page 116). 

Luminance key
The background is cut out according to the luminance (Y) 
of the key source signal, and at the same time the key fill 
signal is cut out and then added to the background signal.

Linear key
This is a type of luminance key, but there is a reduced 
variability in gain, allowing more precise adjustment.

Color vector key
The key signal is created from a combination of the 
luminance and chrominance components of the key source 
signal. When perfect keying is not possible with a 
luminance key, this allows a key signal to be created even 
if the luminance level is low, provided that the colors have 
high saturation.

Clean mode
In a luminance key, linear key or color vector key, you can 
enable the clean mode. When the clean mode is on, the key 
source does not affect the key fill, which is added 
unchanged to the background. This improves the keyed 
image quality, but means that the part of the key fill signal 
which is not to be inserted must be completely black, or it 
will color the background. You set the clean mode with the 
Type menu of the respective keyer. 

For details, see “Setting the key type in a menu” (page 
116).

Note that in the following situations, the clean mode goes 
off, and cannot be turned on.
• When the key type is a pattern key
• When key inversion is on
• When the key fill is a matte
• When the key edge is an outline
• When the key edge is normal with soft edge being on
• When fine key is on
• When the key positioner is on

Notes 
Overview
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Chroma key
A key signal based on a particular color is used to cut out 
the background, and the key fill is then inserted. The 
inserted signal is also referred to as the foreground, and the 
composite image is called a chroma key image.

For details of chroma key, see (page 119) and (page 120) . 

Wipe pattern key
This uses the wipe pattern selected for a transition as the 
key source.

Key wipe pattern key
This uses the wipe pattern selected for an independent key 
transition as the key source.

Note on wipe pattern modifiers
In a wipe pattern key or key wipe pattern key, you can 
apply various modifications, depending on the pattern 
used, and the modifiers in common with a wipe.
However, modifiers which relate to the wipe direction and 
edge are not reflected.

Key Modifiers

Edge modifiers
You can apply borders and other effects to the edge of the 
key (see pages 123 and 133). 

Name Effect Image

Normal This is the state with 
no key edge modifiers 
applied.

Foreground Background

Chroma key image

Border This applies a uniform 
width border to the 
edge of the key. You 
can adjust the border 
width and density. You 
can also enable the 
separate edge 
function, and adjust 
the top, bottom, left, 
and right border 
widths separately.

Drop 
border 

This applies a border 
below and to the right 
for example, of the 
key. You can adjust the 
border width, position, 
and density.

Shadow This applies a shadow 
below and to the right 
for example, of the 
key. You can adjust the 
shadow width, 
position, and density.

Outline This uses the outline 
of the original key as 
the key. You can adjust 
the width and density 
of the outline. You can 
also enable the 
separate edge 
function, and adjust 
the top, bottom, left, 
and right outline 
widths separately.

Emboss This applies an 
embossing effect to 
the outline of the key. 
You can adjust the 
width and position of 
the embossing and the 
density. You can adjust 
the density separately 
for key fill and key 
edge. When 
embossing is on, the 
Fine Key and zabton 
functions go off.

–

Soft 
edge

This softens the edge 
of the key.

–

Zabton This inserts a 
translucent pattern 
behind a key. You can 
adjust the pattern size, 
softness, density and 
color.

–

Name Effect Image
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Edge type and key fill/key source position
The key edge modification function has two modes: a 
mode (“key drop ON mode”) in which the key fill/key 
source position moves downward, and a mode (“key drop 
OFF mode”) in which it does not move downward.
Key drop ON mode: The key fill/key source position 

moves downward by eight scan lines or four scan lines. 
When a drop border or shadow is selected, it is 
possible to apply a border to the top edge of the key.

Key drop OFF mode: The key fill/key source position 
does not move. When a drop border or shadow is 
selected, it is not possible to apply a border to the top 
edge of the key.

In the key drop ON mode, a menu setting selects between 
the mode (“4H mode”) in which the key fill/key source 
position is lowered by four scan lines, and the mode (“8H 
mode”) in which the key fill/key source position is lowered 
by eight scan lines.
When Fine Key is on, the edge width is forced to the range 
0.00 to 4.00.

Note that in the following situations, the key drop mode is 
forcibly turned on.
• When the edge type is border, outline, or emboss
• When the edge type is normal with soft edge being on
• When Fine Key is on

To fix key fill / key source in key drop off mode
Switch frame delay mode on.
Regardless of the fine key and edge type settings, key fill 
and key source are fixed in key drop off mode. In this mode 
key image has a one-frame delay. 

This function uses the resizer, and therefore the normal 
effect of the setting is not obtained while using DME wipe 
or other effect that uses the resizer. 

Edge fill
When a border, drop border, or shadow modifier is 
selected, you can select a signal to fill these edge effects.
The edge fill may be either the signal from the dedicated 
color matte generator, or the signal currently selected on 
the utility 1 bus.
In the case of an outline, there is no edge fill signal 
selection, because the key fill signal fills the outline, and 
the rest of the image remains as the background.
For the emboss effect, in place of the edge fill signal, the 
emboss fill matte 1 and emboss fill matte 2 signals are 
used.

Masks
A mask is used to inhibit the effect of a key over a part of 
the image. This allows parts of the background which 

would otherwise be keyed to be protected, or to correct the 
key if it is not of the desired shape.

For details of masking operations, see “Masks” (pages 
126 and 134).

Key mask and background mask
There are two types of mask: a key mask and a background 
mask.
Key mask: This masks out a part of the key, which will 

result in the background appearing.
Background mask: This masks out a part of the 

background, which will result in the key fill appearing.

Main mask and subsidiary (“sub”) mask
Each keyer allows two masks to be used simultaneously, 
and these are referred to as the main mask and the sub 
mask. The signal that determines the mask shape and size 
is termed the mask source, and different sources are used 
for the main mask and sub mask.
Main mask: This uses the signal from the dedicated box 

generator provided on each keyer, or the signal from 
the dedicated pattern generator as the mask source.
When the box generator is selected, a rectangular mask 
is formed. You can adjust the positions of the four 
sides of the box separately.
When the pattern generator is selected, you can select 
the pattern and apply modifiers.

Sub mask: This uses the wipe generator signal or the 
signal selected on the utility 1 bus, as the mask source.
When the wipe generator is selected, the patterns and 
the pattern modifiers are the same as in a wipe 
transition.

Key Memory

The key memory function allows the keyer settings on 
each cross-point button to be automatically stored, so that 

Notes 

Key mask

Masked  
area (box)

Background mask
Overview
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the next time the same cross-point button is selected these 
settings are recalled automatically.
There are two modes for key memory: simple mode and 
full mode. 
The parameters stored in each mode are as follows.
Simple mode: key type, clean mode (including the plane 

setting for chroma keying), key position, key 
inversion, and adjustment values for the particular key 
type (Clip, Gain, Density, Filter, etc. This includes 
color vector key, wipe pattern key, key wipe pattern 
key, and chroma key. However, in the case of a 
chroma key, it excludes color cancel, Y balance, 
foreground CCR, window, and shadow.)

Full mode: All settings except transition (the same 
parameters as simple mode, Fine Key, key modifiers, 
main and sub mask settings, chroma key detailed 
settings, and so on)

For the settings for these modes, see “Selecting the Bank 
to Make the Settings” in Chapter 20 (Volume 2).

Key Default

With a simple operation you can return the key adjustment 
values to their defaults.
The adjustment values which can be returned to their 
default values are as follows.
• Adjustment values for the particular key type (Clip, 

Gain, Density, Filter, etc.)
In the case of chroma keying, all adjustment values 
return to their default values.

• Key position
• Key inversion
• Clean mode

For details, see “Returning the key adjustment values to 
their defaults” (page 137).

For the menu operation to return the key adjustment 
values to their defaults, see “Returning to Default State in 
Function Groupings” (page 75).

Key Setting Operations 
Using Menus

There are two ways of making key settings: either using 
menus, or using the key control block or the Multifunction 
Flexi Pad control block.
This section describes basic procedures for making key 
settings using the menus, taking the M/E-1 >Key1 menu as 
an example.
Operations in the Key menus are the same for all banks 
(M/E-1 to M/E-3 and PGM/PST).

For details of the method of using the key control block, 
see “Key Setting Operations with the Key Control Block” 
(page 131).

Key Setting Menus

The key setting menus for each bank (M/E-1 to M/E-3 and 
PGM/PST) are as follows.

When the signal format is 1080P, only keys 1 to 4 can be 
used.

Accessing a key setting menu
For example, to access the M/E-1 >Key1 menu, carry out 
any of the following procedures.
• In the menu control block, select the top menu selection 

button [M/E 1], then press VF1 ‘Key1.’
If VF1 ‘Key5’ is shown, press the [KEY1-4] switching 
button at the top of the menu, turning it on, then press 
VF1 ‘Key1.’

Bank Keys set Menus

M/E-1 Keys 1 to 8 M/E-1 >Key1 to 8

M/E-2 Keys 1 to 8 M/E-2 >Key1 to 8

M/E-3 Keys 1 to 8 M/E-3 >Key1 to 8

M/E-4 Keys 1 to 8 M/E-4 >Key1 to 8

PGM/PST Downstream keys 
1 to 8

PGM/PST >DSK1 
to 8

Notes 

Switching button
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• In the M/E-1 bank transition control block, press the 
KEY1 next transition selection button twice in rapid 
succession.

• In the M/E-1 bank independent key transition control 
block, press the key delegation button [KEY1] twice in 
rapid succession.

• In the key control block, press the M/E delegation button 
[M/E1], then press the key delegation button [KEY1] 
twice in rapid succession.

Note that you can access the DSK menus by pressing the 
button for the corresponding key in the downstream key 
control block twice in rapid succession.

• To select [M/E 4] with the top menu selection buttons, it 
is first necessary to assign a button in the Setup menu 
(see page 380).

• To select [Key5] to [Key8], and [DSK5] to [DSK8] in 
the key control block, a previous assignment in the Setup 
menu is required (see page 381). 

Key Type Setting

Setting the key type in a menu

1 In the M/E-1 >Key1 menu, select HF1 ‘Type.’

The Type menu appears.

2 In the <Key Type> group, select the key type.

Luminance: luminance key
Linear: linear key
Chroma: chroma key
Color Vector: color vector key
Wipe Pattern: wipe pattern key
Key Wipe Pattern: key wipe pattern key

3 Carry out the following settings as required, 
depending on the key type selected in step 2.

To enable clean mode (see page 112) for a 
luminance key, linear key or color vector key: 
Select [Clean Mode] so that it is set on.
When clean mode is enabled, key fill is added to 
the background without cutting out with key 
source.

When chroma key is selected: Select [Chroma 
Adjust] to access the Chroma Adjust menu (see 
page 120), and make the required settings.

When a wipe pattern key is selected: In the M/E-1 
>Wipe menu (see page 152), select the pattern and 
set any modifiers, then return to the M/E-1 >Key1 
menu.

When a key wipe pattern key is selected: In the M/
E-1 >Key1 >
Transition >Wipe Adjust menu (see page 164), 
carry out pattern selection and modifier setting, 
then return to the M/E-1 >Key1 >Type menu.

For a wipe pattern selected for a wipe pattern key or 
key wipe pattern key, the [Edge] and [Direction] 
modifier settings are not available.

4 Set the parameters.

When a luminance key or linear key is selected

a) Setting this value to 1, produces the “through” state in which no filter 
is applied. The larger the value, the more strongly the filter applies.

When a chroma key is selected

When a color vector key is selected

Notes 

Notes 

Knob Parameter Adjustment Setting values

1 Clip Reference level 
for generating 
the key signal

+109.59 to –7.31

2 Gain Key sensitivity –100.00 to 
+100.00

3 Density Key density 0.00 to 100.00

4 Filter Filter coefficient 1 to 9 a)

Knob Parameter Adjustment Setting values

3 Density Key density 0.00 to 100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Y Clip Reference level 
for creating 
luminance signal

+109.59 to 
–7.31

2 Y Gain Luminance 
signal sensitivity

–100.00 to 
+100.00

3 C Clip Reference level 
for creating 
chrominance 
signal

100.00 to 0.00

4 C Gain Chrominance 
signal sensitivity

–100.00 to 
+100.00

5 Density Key density 0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Y Filter Luminance 
signal filter 
coefficient

1 to 9

2 C Filter Chrominance 
signal filter 
coefficient

1 to 9
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When a wipe pattern key or key wipe pattern key is 
selected

5 Make the following settings as required.

To invert the black and white sense of the key 
source: Press [Key Invert], turning it on.

To adjust the horizontal position or key source 
width for a luminance key, linear key, or 
chroma key: Press [Key Position], turning it on, 
and set the parameters.

To set the key priority: Press [Key Priority] or select 
VF7 ‘Misc’ and HF3 ‘Key Priority’ to access the 
Key Priority menu.

For details, see “Setting the Key Priority by a Menu 
Operation” (page 89).

Selecting Key Fill and Key Source

In the case of the MVS-8000X, only the premium inputs 
(inputs to the switcher PREMIUM INPUTS connectors 1 
to 20) can be selected as key signals on the M/E-4 bank.

Selecting key fill and key source
To select key fill and key source for key 1 on the M/E-1 
bank, use the following procedure.

1 In the M/E-1 >Key1 menu, select HF1 ‘Type.’

The Type menu appears.

2 In the <Key Fill> group, select either of the following 
for use as key fill.

Key Bus: signal selected on the key 1 fill bus
Matte: signal from the dedicated color matte 

generator

3 If you selected [Key Bus] in step 2, select the key fill 
signal on the key 1 row in the cross-point control 
block.

For the CCP-6224/6324 Control Panel, it is necessary 
to set the [AUX CTRL] button to Off in order to exit 
the AUX panel-less function (see page 82).

4 If you selected [Matte] in step 2, in the same Type 
menu, press the [Matte Adjust] button to display the 
Matte Adjust menu, then adjust the single-color or 
two-color combination color matte. Select whether to 
use a single-color matte or a two-color combination in 
the <Fill Matte> group.

Flat Color: Adjust color 1 with the following 
parameters.

Mix Color: Carry out a color mix. Adjust color 1 and 
color 2, and select a mix pattern (see the next 
section).

5 In the <Key Source> group, specify the key source 
selection mode.

Self: The key fill bus signal is automatically selected 
as the key source.
When the key type is selected as chroma key, 
select [Self].

Auto Select: The signal allocated, being paired with 
the key fill bus signal, to a cross-point button is 
automatically selected as the key source. The 
setting of key fill and key source pairs is carried 
out in the Setup menu. 

For details, see “Cross-Point Settings (Xpt Assign 
Menu)” in Chapter 19 (Volume 2).

Split: You can select a key source signal 
independently of the key source automatically 
selected in Auto Select mode.

6 When [Split] was selected in step 5, hold down the 
[SPLIT] button in the key control block or the 
Multifunction Flexi Pad Control block, then in the 
cross-point control block key 1 row, select the key 
source signal. Alternatively, hold down the key 
delegation button in the transition control block and 
press a cross-point button in the key 1 row to select the 
key source signal.

• In the above-stated key 1 row operation, you can 
only select a key signal assigned to a cross-point 

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of edge 
softness

0.00 to 100.00

3 Density Key density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Phase Key horizontal 
position

–4.00 to +4.00

2 Left Key left edge 
position

–4.00 to +4.00

3 Right Key right edge 
position

–4.00 to +4.00

Notes 

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Notes 
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button. For the method of selecting a video signal, 
see “To select a video signal assigned to a cross-
point button” below.

• When [Split] is selected, the key memory function 
(see page 114) is disabled.

To select a video signal assigned to a cross-point 
button
By selecting the key source bus with an auxiliary bus 
control block AUX delegation button, and pressing the 
cross-point button, it is possible to select the video signal 
assigned to the cross-point button.
(If you press the cross-point button with holding down 
[KEY], the key signal assigned to the cross-point button.)

In the above operation, the following settings must have 
been made.
• Assigning the key source bus to an AUX delegation 

button
For details, see “Auxiliary Bus Control Block Settings 
(Aux Assign Menu)” in Chapter 19 (Volume 2).

• Setting the [KEY] button operating mode
For details, see “Setting the Button Operation Mode” in 
Chapter 19 (Volume 2).

Selecting key source and key fill in the 
menu

Selecting key source
For example, to select the key source for M/E-1 key 1, use 
the following procedure.

1 In the <Key Fill> group of the M/E-1 >Key1 >Type 
menu, hold down [Key Bus].

2 Press [Signal Select].

The Signal Select menu appears.

3 In the <Target> group, press [Source].

4 In the <Key Source> group, select the key source 
selection mode (Self, Auto Select, or Split).

See step 5 in “Selecting Key Fill and Key Source” 
(page 117).

5 If you selected [Split], using any of the following 
methods, select the key source signal.

• Press directly on the list on the right.
• Press the arrow keys to scroll the reverse video 

cursor.
• Turn the knob.

6 In the <Assign> group, select the video signal or key 
signal from the V/K pair to assign to the key source.

7 Press [Set Xpt].

This selects the key source signal.

Selecting key fill
For example, to select the key fill for M/E-1 key 1, use the 
following procedure.

1 In the M/E-1 >Key1 >Type menu status area, press 
“Fill.”

The Signal Select menu appears.

2 In the <Target> group, press [Fill].

3 Select the fill signal from the list on the right.

4 Press [Set Xpt].

This selects the key fill signal.

Carrying out a color mix for key fill
When [Matte] is selected for key fill, you can combine 
color 1 and color 2. For the combination, you can use not 
only a key wipe generator pattern, but also the dedicated 
pattern for key edge color mix.

1 In the <Key Fill> group of the Type menu, select 
[Matte] and press [Matte Adjust].

The Matte Adjust menu appears.

2 Select [Mix Color] in the <Fill Matte> group.

3 Adjust the following parameters.

Notes 

Knob Parameter Setting Values

1 No Button number 1 to 300

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00
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4 Select the combining pattern in the <Mix Pattern> 
group.

Key Wipe: The wipe pattern selected for an 
independent key transition is used for 
combination. You can change this pattern by 
pressing [Pattern Select] to open the menu for key 
wipe pattern selection (Pattern Select menu), and 
make adjustments by pressing [Pattern Adjust] to 
open the menu for pattern adjustment (Wipe 
Adjust menu).

Key Edge Pattern: Combine using the dedicated 
pattern selected for the color mix in the key edge 
fill. You can change this pattern by pressing 
[Pattern Select] to open the menu for edge color 
mix dedicated wipe pattern selection (Mix Pattern 
Select menu), and make adjustments by pressing 
[Pattern Adjust] to open the menu for pattern 
adjustment (Matte Adjust menu).

For details, see “Carrying out a color mix for the 
key edge fill matte” (page 124).

5 In the Type menu, adjust color 1 and color 2.

To adjust color 1, select [Color1], and to adjust color 
2, select [Color2], then adjust the following 
parameters.

6 To interchange color 1 and color 2, press the [Color 
Invert] button, turning it on.

Chroma Key Composition and Basic 
Settings

In creating a chroma key image, either a normal mix or an 
additive mix can be used. To select which, use the Type 
>Chroma Adjust menu for the keyer.
Normal mix: The foreground is cut out with the key 

signal, and then combined with the background, which 
has also been cut out with the key signal.

Additive mix: The background, which has been cut out 
with the key signal, is combined with the unshaped 
foreground. This is effective for a natural-looking 
composite when the scene includes glass or other 
translucent objects.

Plane function
In an additive mix, the foreground is not shaped by the key 
signal, and variations in the (blue) background appear in 
the composite image. To prevent this, it is possible to set a 
particular luminance level for the background, and any 
parts below this level are cut forcibly.

Composing an image by chroma keying

1 In the M/E-1 >Key1 menu, select HF1 ‘Type.’

2 Select [Chroma] in the <Key Type> group.

It becomes possible to adjust the key density (see page 
116).

3 Select [Chroma Adjust].

The Chroma Adjust menu appears.

4 Carry out auto chroma key adjustments. 
Also carry out manual adjustments if necessary to 
obtain an optimum chroma key image.

5 In the <Mix Mode> group, select [Normal Mix] or 
[Additive Mix] depending on the desired type of 
chroma key composition.

When using an additive mix for chroma keying, the 
(typically blue) background parts of the foreground video 
must be converted to black. For this, use the color cancel 
function (see page 121).

Using the plane function
In an additive mix, since no key is applied to the 
foreground, any variations in the (typically blue) 
background may appear in the composite image. To avoid 
this, a particular luminance level can be set for the (blue) 
background, and regions of lower luminance forcibly cut.

1 In the Chroma Adjust menu, set [Plane] on.

2 Adjust the following parameter.

2 Soft Softness of the 
edge of the 
pattern

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Luminance Luminance level 0.00 to 100.00
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Key Adjustments (Menus)

This section describes key adjustments made by a menu 
operation.
You can adjust the following functions by a menu 
operation.
• Chroma Key Adjustment (page 120)
• Key Edge Modifications  (page 123)
• Masks  (page 126)
• Applying a DME effect to a key  (page 127)
• Specifying the Key Output Destination  (page 129)
• Key Modify Clear  (page 130)
• Blink Function (page 130)
• Video Processing  (page 130)

Chroma Key Adjustments

Methods of adjusting the composite obtained from chroma 
keying include automatic adjustment with the auto chroma 
key function, and manual adjustment carrying out the 
necessary processing separately. The optimum results will 
be obtained by first carrying out adjustments with the auto 
chroma key function, then making any fine adjustments as 
required.
The following manual adjustments are possible.

Key active
When this function is off, only the foreground is output 
and you can make adjustments of color cancel (see the next 
paragraph).

Color cancel
If the foreground image includes shades of the background 
color, turn this function on to remove the color from the 
foreground image.

Chroma key window
You can adjust the range over which the key signal is 
determined as matching the specified hue. When this 
adjustment is off the default ranges are used.

Chroma keying generates a key signal based on a 
particular color (reference color) in the foreground 
(typically a plain blue background), and the “window” 
refers to the range of colors which are regarded as 
matching this specified reference color to create the key 
signal.
As seen on a vectorscope (that is, in the hue-saturation 
color space), the range for this matching corresponds to a 
truncated sector. This range is specified by two 
parameters: the “Angle” parameter, which determines the 
range of the hue parameter, and the “Crop” parameter, 
which determines the degree of truncation (see the 
following figure).

Window adjustment

Y balance
In normal chroma keying, the key signal is based on the 
chrominance component only, and all elements of the 
foreground with the same hue are replaced by the 
background. Using the Y balance function, you can specify 
a luminance level range within which the key is active, and 
replace the specified part by the background.
You can use the Y balance function independently on the 
key signal for the composition and the key signal for the 
color cancel function. When applied to the key signal for 
the composition, this produces the foreground with the 
color cancel effect applied. This can therefore be used to 
provide an impression of smoke, for example.
When the Y balance function is applied to the color cancel 
key, the relevant part is output in its original color without 
canceling, and therefore it is possible to combine colors 
which are the same color as the background (i.e. typically 
blue) in the foreground.

Chroma key shadow
This function provides a more realistic treatment when the 
shadow of an object in the field of view falls on the blue 
background. Since parts of the blue background darker 
than a specified intensity are treated as shadows, there is 
no effect on cutting out of the foreground.

Video signal adjustment
You can vary the foreground signal gain, or change the 
hue. There are separate adjustments for the gain of the 
overall video signal, and Y and C components.

Making auto chroma key adjustments
Auto chroma key is an automatic adjustment function 
which allows you to specify a part of the foreground video 
(for example, the blue background color) and use it as a 
reference for creating the chroma key image.

Reference color 
specified by Hue 
setting

Range of colors creating the key 
signal (to be replaced by 
background signal)

Range of colors remaining 
as foreground

a) The Crop and Angle values do not change even if you use the 
auto chroma key function.

Angle a)

Crop a)
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1 In the M/E-1 >Key1 menu, select HF1 ‘Type,’ then 
select [Chroma] in the <Key Type> group.

2 Select [Chroma Adjust].

The Chroma Adjust menu appears.

3 Select [Sample Mark] in the <Auto> group.

The foreground video only appears on the monitor, 
with a white box-shaped sample selector.

4 Adjust the position and size of the sample selector, to 
specify the color to be used as the basis of chroma 
keying (typically a blue background).

a) The setting ranges depend on the signal format, screen aspect ratio, 
and size settings.

5 Select [Auto Start] in the <Auto> group.

This executes an auto chroma key based on the color 
specified by the sample selector, and displays the 
composite image on the monitor.

Making key active adjustments
When the key active function is on, the composite image is 
output to the monitor, and you can watch the monitor while 
manually adjusting the keying. 
When the key active function is off, only the foreground 
image appears. Set this off when manually adjusting color 
cancel (see the next section).

1 In the Chroma Adjust menu, set [Key Active] on.

2 Adjust the following parameters.

Making color cancel adjustments
If the background color is leaking into the foreground 
video, turning the color cancel function on allows you to 
eliminate this leakage.

1 In the Chroma Adjust menu, turn [Key Active] off.

Only the foreground image appears on the monitor.

2 In the <Color Cancel> group, set [Color Cancel] on.

3 Adjust the following parameters.

4 Set [Key Active] on.

The chroma key composite image now appears in the 
monitor.

Making key signal adjustments for color 
cancel
When the color cancel function is set on, you can adjust the 
key signal for color cancel.

1 In the <Color Cancel> group of the Chroma Adjust 
menu, set [Color Cancel] on.

2 In the <Color Cancel> group, set [Cancel Key] on.

The cancel key is now on, and you can now adjust the 
key signal for color cancel.

3 Make the following settings, as required, in the <Color 
Cancel> group.

When setting [Key Position] on and adjusting the 
color cancel key edge position

Knob Parameter Adjustment Setting values

1 Position H Horizontal 
position

–100.00 to 
+100.00 a)

2 Position V Vertical position –100.00 to 
+100.00 a)

3 Size Size 1.00 to 100.00

Knob Parameter Adjustment Setting values

1 Clip Chroma key 
reference level

0.00 to 100.00

2 Gain Key gain –100.00 to 
+100.00

3 Hue Hue 359.99 to 0.00

4 Density Density 0.00 to 100.00

5 Filter Filter coefficient 1 to 9

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

5 Filter Filter coefficient 1 to 9

Knob Parameter Adjustment Setting values

1 Clip Color cancel key 
reference level

0.00 to 100.00

2 Gain Color cancel key 
gain

–100.00 to 
+100.00

Knob Parameter Adjustment Setting values

1 H Phase Move left and 
right edges of 
the color cancel 
key 
simultaneously

Left edge 
position value 
shown
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When setting [Window] on and adjusting the 
detection range of the color cancel key

For details of the crop and angle parameters, see 
“Chroma key window” (page 120).

When setting [Y Balance] on and adjusting the 
ratio in which Y balance is added to the color cancel 
key

Adjusting the window
Setting the window (see page 120) function on allows you 
to adjust the detection range used to determine the key 
signal. When this function is off, the default range is used 
for the key.
After making sure that the values of Clip, Gain, and Hue 
are adjusted appropriately, use the following procedure to 
make the window adjustment.

1 In the Chroma Adjust menu, set [Window] on.

2 Adjust the following parameters.

Adjusting the Y balance
Setting the Y balance (see page 120) on allows you to 
specify that, even if the hue is the same, only portions of a 
particular luminance will be replaced by the background.

1 In the Chroma Adjust menu, set [Y Balance] on.

2 Adjust the following parameters.

Adjusting the chroma key shadow
This function allows a shadow falling on the (typically 
blue) background color to be rendered more realistically. 
Since portions of the (blue) background of less than a 
certain luminance are treated as shadows, there is no effect 
on cutting out of the foreground. 

1 In the Chroma Adjust menu, set [Shadow] on.

2 Adjust the following parameters.

When chroma key shadow is on, key edge is changed to 
normal, and soft edge is switched off.

Adjusting the video signal
You can change the gain of the foreground signal, or vary 
the Hue. There are separate adjustments for the gain of the 
whole video signal, or Y and C individually.

1 In the Chroma Adjust menu, set [FRGD CCR] on.

2 Adjust the following parameters.

2 Left Move left edge 
of the color 
cancel key

–3.00 to +3.00

3 Right Move right edge 
of the color 
cancel key

–3.00 to +3.00

Knob Parameter Adjustment Setting values

1 Crop Crop value 100.00 to 0.00

2 Angle Angle value 180.00 to 0.00

Knob Parameter Adjustment Setting values

1 Mixture Ratio of Y 
balance key

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Crop Crop value 100.00 to 0.00

2 Angle Angle value 180.00 to 0.00

Knob Parameter Adjustment Setting values

1 Clip Luminance 
range

0.00 to 100.00

Knob Parameter Adjustment Setting values

2 Gain Key gain –100.00 to 
+100.00

3 Luminance Luminance 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Reference 
luminance for 
shadows

0.00 to 100.00

2 Gain Shadow key 
gain

–100.00 to 
+100.00

3 Density Shadow opacity 0.00 to 100.00

4 Soft Shadow 
softness

0.00 to 100.00

Notes 

Knob Parameter Adjustment Setting values

1 Video 
Gain

Overall gain of 
video signal

–100.00 to 
+100.00

2 Y Gain Y signal gain –100.00 to 
+100.00

3 C Gain C signal gain –100.00 to 
+100.00

4 Hue Hue offset 
amount

–180.00 to 
+180.00

Knob Parameter Adjustment Setting values
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Key Edge Modifications

To modify the key edge of key 1 on the M/E-1 bank, use 
the following procedure.

1 In the M/E-1 >Key1 menu, select HF2 ‘Edge.’

The Edge menu appears.

2 Select the edge type (see page 113) in the <Edge> 
group.

Normal: unadorned edge
Border: edge with border applied
Drop Border: edge with drop border applied
Shadow: edge with shadow applied
Outline: edge used as outline
Emboss: embossing effect applied to edge

If you select [Normal], skip to step 7.

3 Set the border width and other parameters.

When border or outline is selected: The setting 
parameters depend on the key type and whether 
the separate edge function is enabled or not. To 
enable the separate edge function, press [Separate 
Edge], setting it on.

• Separate edge off

a) In the “4H mode” and when [Fine Key] (page 124) is on, the setting 
value range is 0.00 to 4.00.

b) When a wipe pattern key or key wipe pattern key is selected as the 
key type

• Separate edge on
The left, right, top, and bottom border or outline 
widths can be adjusted independently. The separate 
edge function is only valid when a luminance key, 
linear key, or chroma key is selected as the key type.

a) In the “4H mode” and when [Fine Key] (page 124) is on, the setting 
value range is 0.00 to 4.00.

When drop border or shadow is selected: The 
setting parameter values depend on the on/off 
setting of key drop and the selection of 4H mode/
8H mode (see page 114).

• “Key drop off” mode 

• “Key drop on” mode

a) In the “4H mode” and when [Fine Key] (page 124) is on, the setting 
value range is 0.00 to 4.00.

When emboss is selected:

a) The Density adjustment only affects the key edge. This can be 
adjusted separately from Key Density, and if Key Density is set to 
0.00, the embossed edge effect only can be applied.

To make edge fill adjustments, carry out the settings in 
step 6.

4 Select the edge fill signal in the <Edge Fill> group.

Utility 1 Bus: signal selected on the utility 1 bus
Matte: signal from dedicated color matte generator.

It becomes possible to adjust color 1.

When the edge type is outline, in place of the edge fill 
signal, the selected key fill signal fills the outline, and 
elsewhere remains as the background.

5 Carry out the following operation, depending on the 
selection in step 4.

When [Utility 1 Bus] is selected: Hold down the 
[UTIL] button in the cross-point control block, 
and select the signal in the background A bus row.
While the [UTIL] button is held down, the 
background A bus changes to the utility 1 bus.

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00 a)

(0.00 to 100.00) 
b)

3 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Top Top edge width 0.00 to 8.00 a)

2 Left Left edge width 0.00 to 8.00 a)

3 Right Right edge width 0.00 to 8.00 a)

4 Bottom Bottom edge 
width

0.00 to 8.00 a)

5 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00 a)

2 Position Position 359.99 to 
180.00

3 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 8.00 a)

2 Position Position 359.99 to 0.00

3 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Width 0.00 to 4.00

2 Position Position 359.99 to 0.00

3 Density a) Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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To enable the [UTIL] button, its operation mode 
must be set to [Hold] beforehand. 

For details, see “Setting the Button Operation 
Mode” in Chapter 19 (Volume 2).

When [Matte] is selected: Press [Matte Adjust] in the 
same EDGE menu, to display the Matte Adjust 
menu, and adjust a single color or two-color 
combination color matte.
You can select whether to use a single color matte 
or a two-color combination color matte in the 
<Edge Matte> group.

For the color mix operation, see “Carrying out a color 
mix for the key edge fill matte” (page 124).

6 When emboss is selected for the edge type, adjust the 
color in the <Emboss Fill> group.

To adjust matte 1 press [Matte1], and to adjust matte 2 
press [Matte2], then adjust the following parameters.

7 To make the edge soft, press [Soft Edge] to set it on, 
and adjust the softness.

For a normal edge, when [Soft Edge] is enabled, [Key 
Drop] is kept on.

8 To make separate fine adjustments to the positions of 
the left, right, top, and bottom of the source edge, press 
[Fine Key], to set it on, and adjust the following 
parameters.

In the emboss function it is not possible to set [Fine 
Key] on.
• When the edge type is normal, drop border or 

shadow, enabling the [Fine Key] function keeps 
[Key Drop] on.

• When applying a border to the key edge, enabling 
the [Fine Key] function halves the border width 
setting range.

To fix key fill and key source in key drop off mode

1 In the Edge menu, press [Key Delay Mode].

The Key Delay Mode menu appears.

2 Press [Frame Delay], setting it to On.

This function uses the resizer, and therefore the 
expected result of the setting may not be obtained if 
conditions do not allow the resizer to be used.

Carrying out a color mix for the key edge 
fill matte
When you select ‘Matte’ for the edge fill of a border, drop 
border, or shadow, you can create a combination of color 
1 and color 2 using a wipe pattern generated by the 
dedicated pattern generator.

1 In the <Edge Fill> group of the Edge menu, select 
[Matte], then press [Matte Adjust].

The edge fill Matte Adjust menu appears.

2 In the <Edge Matte> group, select [Mix Color], 
turning it on.

3 Adjust the following parameters.

Notes 

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Top Key top edge 
position

–2.00 to +2.00

2 Left Key left edge 
position

–2.00 to +2.00

3 Right Key right edge 
position

–2.00 to +2.00

4 Bottom Key bottom 
edge position

–2.00 to +2.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 H Phase Key horizontal 
position

Left edge 
position value 
shown

2 V Phase Key vertical 
position

Top edge 
position value 
shown

Notes 

Notes 

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Softness of 
pattern edge

0.00 to 100.00

3 Pattern Pattern number 1 to 24 a)
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a) The patterns are the same as standard wipes. (For details, see “Wipe 
Pattern List” in (page 344).)

To select the pattern, display the Mix Pattern Select 
menu by pressing [Mix Pattern] in the edge fill Matte 
Adjust menu. 
After selecting one of the patterns (standard wipe 
patterns 1 to 24) displayed in the Mix Pattern Select 
menu, you can adjust the following parameters.

4 Adjust color 1 and color 2.

To adjust color 1 press [Color 1], and to adjust color 2 
press [Color 2], turning it on respectively, and adjust 
the following parameters.

5 If required, set the pattern modifiers.

When turning [Position] on and setting the pattern 
position

a) See page 158.

When turning [Multi] on and replicating the 
pattern

a) See page 160.

When turning [Aspect] on and setting the aspect 
ratio of the pattern

a) See page 160.

When turning [Angle] on in the <Rotation> group 
and inclining the pattern

a) See page 159.

When turning [Speed] on in the <Rotation> group 
and rotating the pattern at a constant speed

a) See page 159.

6 To interchange color 1 and color 2, press [Color 
Invert], turning it on.

Applying the zabton effects

1 In the Edge menu, press [Zabton], turning it on.

2 Adjust the following parameters.

If in the pattern selection described below you select 
“Mask Pattern,” and “Box” for the main mask, the 
“Size” parameter here cannot be adjusted. Set “Size” 
in the Main Mask menu.

3 To adjust the pattern and color, press [Zabton Adjust].

The Zabton Adjust menu appears.

4 In the <Zabton Pattern> group, select the pattern.

Key Wipe: Use a key wipe.
You can change this pattern by pressing [Pattern 
Select] to open the menu for key wipe pattern selection 
(Pattern Select menu), and make adjustments by 

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Softness of 
pattern edge

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal 
position

–200.00 to 
+200.00 a)

2 Position V Vertical position –200.00 to 
+200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of 
repetitions of 
pattern 
horizontally

1 to 63

2 V Multi Number of 
repetitions of 
pattern vertically

1 to 63

3 Invert Type Replication 
layout

1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern 
rotation

–100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of 
pattern

–100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Pattern edge 
softness

0.00 to 100.00

3 Density Density 0.00 to 100.00

Notes 
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pressing [Pattern Adjust] to open the menu for pattern 
adjustment (Wipe Adjust menu).
Key Edge Pattern: Use a color mixing pattern for key 

edge.
You can change this pattern by pressing [Pattern 
Select] to open the menu for edge color mix 
dedicated wipe pattern selection (Mix Pattern 
Select menu), and make adjustments by pressing 
[Pattern Adjust] to open the menu for pattern 
adjustment (Matte Adjust menu).

Mask Pattern: Use the main mask Box or Pattern.

You can also press [Pattern Select], and in the 
corresponding pattern adjustment menu, change the 
pattern.

5 To adjust the color, press [Zabton Color] and adjust 
the following parameters.

Masks

There are two masks, which can be used to mask off 
unneeded parts of a key or background, or to remove 
defects, and these are known as the main mask and 
subsidiary mask. 
You can either use the main mask and subsidiary mask 
independently, or at the same time. 

Using the main mask
For example, to use the main mask for key 1 on the M/E-1 
bank, use the following procedure.

1 In the M/E-1 >Key1 menu, select HF3 ‘Main Mask.’

The Main Mask menu appears.

2 In the <Mask Type> group, select the mask type.

Key Mask: Masks a part of a key.
Bkgd Mask: Masks a part of a background.

3 In the <Mask Source> group, select the mask source.

Box: signal from the dedicated box generator
Pattern: signal from the dedicated pattern generator

4 Set the mask source parameters.

When a box is selected

When a pattern is selected

a) The pattern is the same as a standard wipe. (See “Wipe Pattern List” 
in Appendix (Volume 1) (page 344).)

To select the pattern, display the Mask Ptn Select 
menu by pressing the [Mask Ptn Select] button in the 
Main Mask menu. 
After selecting one of the patterns (standard wipe 
patterns 1 to 24) displayed in the Mask Ptn Select 
menu, you can adjust the following parameters.

5 To invert the black and white sense of the mask source, 
press the [Mask Invert] button, turning it on.

6 When a pattern is selected as the mask source, set the 
pattern modifiers as required.

When turning [Position] on and setting the pattern 
position

a) See page 158.

When turning [Multi] on and replicating the 
pattern

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

4 Density Density 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Top Top position –100.00 to 
+100.00

2 Left Left position –100.00 to 
+100.00

3 Right Right position –100.00 to 
+100.00

4 Bottom Bottom position –100.00 to 
+100.00

5 Soft Box softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

5 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal 
position

–200.00 to 
+200.00 a)

2 Position V Vertical position –200.00 to 
+200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of 
repetitions of 
pattern 
horizontally

1 to 63
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a) See page 160.

When turning [Aspect] on and setting the aspect 
ratio of the pattern

a) See page 160.

When turning [Angle] on in the <Rotation> group 
and setting the angle of the pattern rotation

a) See page 159.

When turning [Speed] on in the <Rotation> group 
and setting the rate of pattern rotation

a) See page 159.

Using the subsidiary mask
For example, to use the subsidiary mask for key 1 on the 
M/E-1 bank, use the following procedure.

1 In the M/E-1 >Key1 menu, select HF4 ‘Sub Mask.’

The Sub Mask menu appears.

2 In the <Mask Type> group, select the mask type.

Key Mask: Masks a part of a key.
Bkgd Mask: Masks a part of a background.

3 In the <Mask Source> group, select the mask source.

Wipe: wipe pattern selected for a transition
If you select [Wipe], select the pattern and make 
modifier settings in the M/E-1 >Wipe menu (see 
page 152), then return to this M/E-1 >Key1 menu.
In the case of a wipe pattern selected for a mask, 
the modifier [Edge] and [Direction] settings are 
not available.

Utility 1 Bus: signal selected on the utility 1 bus
When you selected [Utility 1 Bus], hold down the 
[UTIL] button in the M/E-1 bank cross-point 

control block, and select the signal with the 
background A bus buttons. While the [UTIL] 
button is pressed, the background A bus switches 
to the utility 1 bus.

To enable the [UTIL] button, its operation mode must 
be set to [Hold] beforehand. 

For details, see “Assigning a Bus to an AUX 
Delegation Button” in Chapter 19 (Volume 2).

4 Set the mask source parameters.

When wipe is selected

When utility 1 bus is selected

5 To invert the black and white sense of the mask source, 
press the [Mask Invert] button, turning it on.

Applying a DME Effect to a Key
 

• When the SDI interface is used to connect the DME, 
DME effects (including DME wipes) can be used in only 
one place for one M/E bank.

• When the dedicated interface is used to connect the 
DME, the number of keys to which DME effects 
(including DME wipes) can be applied simultaneously 
for one M/E bank varies as follows depending on the 
execution mode of the DME wipe pattern selected for the 
background.

2 V Multi Number of 
repetitions of 
pattern vertically

1 to 63

3 Invert Type Replication 
layout

1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Pattern angle –100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rate of pattern 
rotation

–100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

Notes 

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Clip Reference level 
for creating 
mask signal

+109.59 to 
–7.31

2 Gain Gain –100.00 to 
+100.00

Notes 
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- MVS-8000X

- MVS-7000X

a) 0 when the system signal format is 1080P.
b) 1 when the system signal format is 1080P and the DME input/output 

signal format is set to dual link mode.
c) 0 when the system signal format is 1080P and the DME input/output 

signal format is set to dual link mode.
• When combining DMEs connected via the dedicated 

interface and the SDI interface, you can increase the 
number of keys to which DME effects are applied 
simultaneously. (Requires a setting in setup.)
For details, see “Setting DME and Switcher Interfaces” 
in Chapter 20 (Volume 2).

Assigning a DME to a key

1 In the M/E-1 >Key1 menu, select HF5 ‘Processed 
Key.’

The Processed Key menu appears.

2 In the <DME Select> group, select the DME channel 
(DME1 to DME8) to be used.

The lit colors of [DME1] to [DME8] indicate the DME 
assignment.
Lit green: Shows the DME assigned to the currently 

selected key.
Lit amber: Shows the DME assigned to a key other 

than the currently selected key.
Off: DME is not assigned.

To select a DME being used by another keyer
Press [Override], turning it on, then select the DME 
channel.
The later selection is valid, and the button lights green.

Using two or three DME channels on one 
keyer
When using the DME dedicated interface, proceed as 
follows.

• On the MVS-8000X, when the signal format is 1080P, 
the combination of two consecutively numbered DME 
channels that can be selected is DME1 and DME2, 
DME3 and DME4, DME5 and DME6, or DME7 and 
DME8. It is not possible to combine three or more DME 
channels.

• On the MVS-7000X, when the signal format is 1080P, 
the above restriction also applies if using the MVE-
8000A. There is no such restriction for the MKS-7470X/
7471X.

1 Select the DME for the first channel (see the previous 
item, “Assigning a DME to a key”), then select the 
successive channel for the second channel. For the 
third channel select the channel after that.

2 To select the video signal for the second channel, hold 
down the [UTIL] button in the cross-point control 
block, and select the signal in the Key1 row (DME 
external video bus).

3 To select the video signal for the third channel, hold 
down the [UTIL] button in the cross-point control 
block, and carry out the following operation.

• If the selected DME is channel 3 or channel 4, turn 
off the [KEY4] button in the key 2 row, then select 
the signal in the key 2 row (DME utility 1 bus).

• If the selected DME is channel 7 or channel 8, turn 
on the [KEY4] button in the key 2 row, then select 
the signal in the key 4 row (DME utility 2 bus).

Applicable 
block

Key to 
which 
DME 
effects 
are 
applied

DME wipe 
pattern for 
background

Number of keys 
to which DME 
effects can be 
applied 
simultaneously

Other than 
M/E-4

Keys 1 
to 4

No DME 
wipe used

2

One-channel 
mode

1

Two- or 
three-
channel 
mode

0

Keys 5 
to 8

- 2 a)

M/E-4 Keys 1 
to 4

No DME 
wipe used

2 b)

One-channel 
mode

1 c)

Two- or 
three-
channel 
mode

0

Keys 5 
to 8

- 0

Key to 
which 
DME 
effects are 
applied

DME wipe pattern 
for background

Number of keys to 
which DME effects 
can be applied 
simultaneously

Keys 1 to 4 No DME wipe used 2

One-channel mode 1

Two- or three-
channel mode

0

Keys 5 to 8 - 2 a)

Notes 
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Using four DME channels on one keyer
When using the DME dedicated interface, proceed as 
follows.

• On the MVS-8000X, when the signal format is 1080P, 
this operation cannot be carried out.

• On the MVS-7000X, when the signal format is 1080P, 
the above restriction also applies if using the MVE-
8000A. There is no such restriction for the MKS-7470X/
7471X.

1 Select the DME channel 1 (or channel 5) for the first 
channel (see “Assigning a DME to a key” (page 128)). 
In the same way, select the DME channel 2 (channel 6) 
for the second channel, the DME channel 3 (channel 7) 
for the third channel, and the DME channel 4 (channel 
8) for the fourth channel.

2 To select the video signal for the second channel, hold 
down the [UTIL] button in the cross-point control 
block, and select the signal in the Key1 row (DME 
external video bus).

3 To select the video signal for the third channel, hold 
down the [UTIL] button in the cross-point control 
block, and carry out the following operation.

• If the selected DME is channel 3, turn off the 
[KEY4] button in the key 2 row, then select the 
signal in the key 2 row (DME utility 1 bus).

• If the selected DME is channel 7, turn on the [KEY4] 
button in the key 2 row, then select the signal in the 
key 4 row (DME utility 2 bus).

4 To select the video signal for the fourth channel, hold 
down the [UTIL] button in the cross-point control 
block, and carry out the following operation.

• If the selected DME is channel 4, turn on the [KEY4] 
button in the key 2 row, then select the signal in the 
key 4 row (DME utility 2 bus).

• If the selected DME is channel 8, turn off the 
[KEY4] button in the key 2 row, then select the 
signal in the key 2 row (DME utility 1 bus).

When using the SDI interface
The operations to select the video signals for the third and 
fourth channels differ from those in the previous 
procedure: select the video signals on the AUX bus 
allocated in a Setup menu (Engineering Setup >Switcher 
>Device Interface >DME Type Setting >DME SDI 
Interface menu).

 

In setup (Engineering Setup >Switcher >Device Interface 
menu), if “Dual DME units” is selected, the second 
channel video signal is also selected on the AUX bus.

For details, see “Setting the Interface Between the DME 
and the Switcher” in Chapter 19 (Volume 2).

You can check the DME operating status in the Status 
menu (see page 225).

Assigning a DME output signal as a 
monitor signal

1 In the Processed Key menu, press [Monitor].

The Monitor menu appears.

2 Press [Monitor Set], turning it on.

3 In the <DME Select> group, select the DME channel 
(DME1 to DME8) to be used.

This assigns the selected DME output to DME MON 
V and DME MON K.
The colors with which [DME1] to [DME8] are lit 
show the key assignment status.
Lit green: DME currently being monitored
Lit amber: DME that can be monitored
Off: Unassigned DME

Specifying the Key Output 
Destination

Using the key processed keyer signals 
(external processed key)
To select the key processed keyer key fill and key source 
signals on the AUX bus or edit preview bus, press [Ext 
Proc Key] turning it on, in the Processed Key menu.
This assigns the key fill and key source signals for M/E-1 
key 1 to reentry signals PROC V and PROC K.
When a DME is selected on the keyer, the key fill and key 
source signals to which a DME effect is applied are 
assigned.

You cannot select the PROC V and PROC K signals using 
the cross-point selection buttons of the M/E or PGM/PST 
bank.

Notes 

Notes 

Notes 
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Using the key processed keyer signals or 
signals to which a DME effect is applied in 
frame memory (frame memory feed)
To use the key processed keyer key fill and key source 
signals on the frame memory source buses, in the 
Processed Key menu, press [FM Feed]. [Ext Proc Key] 
turns on, and the key fill and key source signals processed 
on the currently selected keyer are automatically assigned 
to frame memory source buses 1 and 2. When a DME is 
selected on the keyer, the key fill and key source signals to 
which a DME effect is applied are assigned.

Key Modify Clear

A simple button operation or a menu operation returns the 
key settings to the initial status settings.
Press [Default Recall] at the lower left of the menu display, 
turning it on, then press the corresponding VF button (VF1 
to VF4) to return the key settings to their initial status.

For details of the initial status, see “Saving User-Defined 
Settings” in Chapter 18 (Volume 2).
For the menu operation to return the key state to that set in 
initial status, see “Returning to Default State in Function 
Groupings” (page 75).

Blink Function

With the blink function, you can obtain the following 
effects.
Key blink: The key is alternately inserted and deleted at 

regular intervals. You can set the period of blinking, 
and the proportion of each cycle for which the key is 
inserted.

Edge blink: The key fill and key edge fill signals are 
interchanged at regular intervals. You can set the 
period of blinking, and the proportion of each cycle for 
which the original state holds.

The blink settings are in the Transition menu for each key. 

Using the blink function
For example, to make the required settings for key 1 on the 
M/E-1 bank, use the following procedure.

1 In the M/E-1 >Key1 menu, select HF6 ‘Transition.’

The Transition menu appears.

2 In the <Blink> group, select [Key Blink] or [Edge 
Blink] to set it on.

3 Set the blink parameters.

When key blink is selected

When edge blink is selected

Video Processing

You can adjust the luminance and hue of the selected key 
fill signal.
For example, to apply video processing to the signal 
selected on the M/E-1 bank key 1 fill bus, use the 
following procedure.

1 In the M/E-1 >Key1 menu, select HF7 ‘Video 
Process.’

The Video Process menu appears.

2 Press [Video Process], turning it on.

3 Adjust the following parameters.

To return adjustment values to their defaults
Press [Unity].

Knob Parameter Adjustment Setting values

1 Blink Rate Length of blink 
cycle

1 to 100

2 Duty Proportion of 
cycle for which 
key inserted

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Blink Rate Length of blink 
cycle

1 to 100

2 Duty Proportion of 
cycle for which 
original state 
holds

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Video 
Gain

Video gain –200.00 to 
+200.00

2 Y Gain Luminance gain –200.00 to 
+200.00

3 C Gain Chrominance 
gain

–200.00 to 
+200.00

4 Hue Delay Hue delay –180.00 to 
+180.00

5 Black 
Level

Luminance black 
level

–7.31 to 
+109.59
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Key Setting Operations 
with the Key Control 
Block

This section describes the basic procedures for key settings 
using the key control block.

To select [M/E 4], [Key5] to [Key8], and [DSK5] to 
[DSK8] in the key control block, a previous assignment in 
the Setup menu is required (see page 381). 

Selecting the Bank and Keyer

To make key settings, first select the bank (from M/E-1 to 
M/E-3 and PGM/PST) and keyer, then assign them to the 
key control block.
For example, to set key 1 on M/E-1 with the key control 
block, use the following procedure.

1 Using the M/E delegation buttons in the key control 
block, press the [M/E1] button, setting it on.

2 Using the key delegation buttons in the key control 
block, press the [KEY1] button, setting it on.

This assigns the key control block to M/E-1 key 1.

Selecting the Key Type

To select the key type, press one of the key type (see page 
112) selection buttons in the key control block.
[LUM] button: luminance key
[LIN] button: linear key
[CRK] button: chroma key
[CVK] button: color vector key
[PTN] button: key wipe pattern key

When using a wipe pattern key as the key type, in the 
<Key Type> group of the Type menu for the keyer, 
select [Wipe Pattern] and make the settings.

The button you pressed lights green, and you can now 
adjust the parameters with the knobs. The display beside 
each knob shows the first letter of the parameter name and 
the three-digit setting value.

Parameter Adjustment with the 
Knobs

When the button for a function requiring parameter 
settings is pressed (that is, on), you can set the parameters 
with the four knobs. If there are more than four values to 
be assigned to the knobs, the [MORE] button lights amber. 
At this point, press the [MORE] button, which turns green, 
to assign the fifth and subsequent parameters to the knobs, 
so that the parameter settings can be made.

When the [LUM] or [LIN] button is lit green

When the [CRK] button is lit green

• When [Key Active] is off, only the parameters Hue and 
Density are displayed.

• When both [Key Active] and [Color Cancel] are off, 
only the parameter Density is displayed.

Notes 

M/E delegation buttons

Key type selection buttons

Key fill/key source selection buttons

KnobsKey delegation buttons

Displays

Edge type selection buttons

MORE button

Knob Parameter Adjustment Setting values

1 Clip Reference level for 
generating the key 
signal

+109 to –7

2 Gain Key sensitivity –100 (shown as 
–00) to +100

3 Density Key density 0 to 100

4 Filter Filter coefficient 1 to 9

Knob Parameter Adjustment Setting values

1 Clip Chroma key 
reference level

0 to 100

2 Gain Key sensitivity –100 (shown as 
–00) to +100

3 Hue Hue 0 to 359

4 Density Key density 0 to 100
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When the [CVK] button is lit green

When the [PTN] button is lit green

Selecting Key Fill

Select whether to use a color matte as key fill, or the signal 
on the key fill bus.
When using a color matte: Press the [MATTE FILL] 

button, setting it on. The button lights green, and you 
can now set the parameters with the knobs.

When [Mix Color] is selected in the key fill Matte 
Adjust menu, you can further adjust color 2.

When using the key fill bus signal: Press the [MATTE 
FILL] button, turning it off. 
To select the key fill signal, use the key 1 or key 2 bus 
buttons in the cross-point control block.
For the CCP-6224/6324 Control Panel, it is necessary 
to set the [AUX CTRL] button to Off in order to exit 
the AUX panel-less function (see page 82).

Selecting Key Source

• To use the key source paired with the key fill signal 
selected on the key fill bus, press the [AUTO SEL] 
button, turning it on. The pairing of the cross-point 
buttons for key fill and key source is carried out in the 
Setup menu.
For details, see “Cross-Point Settings (Xpt Assign 
Menu)” in Chapter 19 (Volume 2).

• To select key source independently of the key fill signal 
selected on the key fill bus and paired with key source, 
hold down the [SPLIT] button, turning it on, then press 
the desired Key 1 or Key 2 button in the cross-point 
control block.

• To use as key source the same signal as the key fill signal 
selected on the key fill bus, select the SELF mode by 
pressing the [AUTO SEL] button and [SPLIT] button 
simultaneously so that both are off. When chroma key is 
selected as the key type, select the SELF mode.

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Y Clip Reference level for Y 
signal

+109 to –7

2 Y Gain Y signal sensitivity –100 (shown as 
–00) to +100

3 C Clip Reference level for 
chrominance signal

100 to 0

4 C Gain Chrominance signal 
sensitivity

–100 (shown as 
–00) to +100

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Y Filter Y signal filter 
coefficient

1 to 9

2 C Filter Chrominance signal 
filter coefficient

1 to 9

4 Density Key density 0 to 100

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Edge softness 0 to 100

3 Density Key density 0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Color 1 
luminance

0 to 100

2 Saturation Color 1 
saturation

0 to 100

3 Hue Color 1 hue 359 to 0

When [Mix Color] is on, and 
the [MORE] button is lit amber

Knob Parameter Adjustment Setting values

1 Luminance Color 1 
luminance

0 to 100

2 Saturation Color 1 
saturation

0 to 100

3 Hue Color 1 hue 359 to 0

4 Size Pattern size 0 to 100

When [Mix Color] is on, and 
the [MORE] button is lit green

Knob Parameter Adjustment Setting values

1 Luminance Color 2 
luminance

0 to 100

2 Saturation Color 2 
saturation

0 to 100

3 Hue Color 2 hue 359 to 0

4 Soft Edge softness 0 to 100
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Key Adjustments (Key 
Control Block)

This section describes the various key adjustments 
provided by the control panel key control block.

Key Edge Modifications

To apply a modification to the key edge (see page 113), 
press one of the edge type selection buttons in the key 
control block.

[BDR] button: border
[DROP BDR] button: drop border
[SHDW] button: shadow
[OUTLINE] button: outline
[EMBOS] button: emboss

The pressed button lights green, and you can now adjust 
the parameters with the knobs. The display beside each 
knob shows the first letter of the parameter name and the 
three-digit setting value.

Setting the border parameters
When the [BDR] button is lit green, the parameter settings 
depend on the key type and whether the separate edge 
function is active. To activate the separate edge function, 
press [Separate Edge], setting it on, in the Edge menu for 
the key.

Separate edge off

a) In the “4H mode” and when [Fine Key] (page 124) is on, the setting value 
range is 0 to 4.

b) When a wipe pattern key or key wipe pattern key is selected as the key type

Separate edge on
The border width settings can be made independently for 
left, right, top, and bottom sides. The separate edge 
function is only available when luminance key, linear key, 
or chroma key is selected as the key type.

a) In the “4H mode” and when [Fine Key] (page 124) is on, the setting value 
range is 0 to 4.

To adjust the edge fill color
When [BDR] is selected, the [MORE] button lights amber. 
Pressing the [MORE] button to turn it green then allows 
you to adjust the edge fill color parameters with the knobs.

Setting the drop border or shadow 
parameters
When the [DROP BDR] or [SHDW] button is lit green, the 
parameter settings differ between the “key drop OFF” and 
“key drop ON” modes (see page 114) as shown below. 
Switching between these two modes is made by turning the 
[KEY DROP] button on or off.

“Key drop OFF” mode

a) In the “4H mode” and when [Fine Key] (page 124) is on, the setting value 
range is 0 to 4.

“Key drop ON” mode

a) In the “4H mode” and when [Fine Key] (page 124) is on, the setting value 
range is 0 to 4.

To adjust the edge fill color
When [DROP BDR] or [SHDW] is selected, the [MORE] 
button lights amber. Pressing the [MORE] button to turn it 
green then allows you to adjust the edge fill color 
parameters with the knobs.

Setting the outline parameters
When the [OUTLINE] button is lit green, the parameter 
settings depend on the key type and whether the separate 

Knob Parameter Adjustment Setting values

1 Width Border width 0 to 8 a)

(0 to 100) b)

4 Density Border density 0 to 100

Knob Parameter Adjustment Setting values

1 Top Top edge width 0 to 8 a)

2 Left Left edge width 0 to 8 a)

3 Right Right edge width 0 to 8 a)

4 Bottom Bottom edge width 0 to 8 a)

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100

2 Saturation Saturation 0 to 100

3 Hue Hue 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Width Width 0 to 8 a)

2 Position Position 359 to 180

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Width Width 0 to 8 a)

2 Position Position 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100

2 Saturation Saturation 0 to 100

3 Hue Hue 359 to 0

4 Density Density 0 to 100
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edge function is active. To activate the separate edge 
function, press [Separate Edge], setting it on, in the Edge 
menu for the key.

Separate edge off

a) In the “4H mode” and when [Fine Key] (page 124) is on, the setting value 
range is 0 to 4.

b) When a wipe pattern key or key wipe pattern key is selected as the key type

Separate edge on
The outline width settings can be made independently for 
left, right, top, and bottom sides. The separate edge 
function is only available when luminance key, linear key, 
or chroma key is selected as the key type.

a) In the “4H mode” and when [Fine Key] (page 124) is on, the setting value 
range is 0 to 4.

When [Outline] is selected with separate edge on, the 
[MORE] button lights amber. Pressing the [MORE] button 
to turn it green then allows you to adjust the key fill density 
parameter with a knob.

Setting the embossing parameters
When the [EMBOS] button is lit green, adjust the 
following parameters.

Selecting a normal edge
When all five edge type selection buttons are off, a normal 
edge is selected. If one of the buttons is lit, press it, turning 
it off. 

Softening the edge
Press the [SOFT EDGE] button, turning it on. The button 
lights green, and you can now adjust the softness with the 
knob.

• For a normal edge, when [SOFT EDGE] is enabled, 
“Key Drop” mode turns on.

• When a luminance key or linear key is selected as the 
key type, and clean mode is enabled, enabling [SOFT 
EDGE] ends the clean mode.

Applying the zabton effects
When the [ZABTN] button is lit green, adjust the 
following parameters.

Press the [MORE] button lit amber, changing it to green, 
then adjust the following parameters.

Masks

Using the main mask
In the key control block, press the [MAIN MASK] button, 
turning it on. 
The parameter settings depend on the mask source selected 
as [Box] or [Pattern] in the <Mask Source> group of the 
Main Mask menu for the key.

When box is selected

When box is selected and the [MORE] button is lit amber, 
there are more settings. Press the [MORE] button, so that 
it changes from amber to green to make the extra setting.

Knob Parameter Adjustment Setting values

1 Width Outline width 0 to 8 a)

(0 to 100) b)

4 Density Outline density 0 to 100

Knob Parameter Adjustment Setting values

1 Top Top edge width 0 to 8 a)

2 Left Left edge width 0 to 8 a)

3 Right Right edge width 0 to 8 a)

4 Bottom Bottom edge width 0 to 8 a)

Knob Parameter Adjustment Setting values

4 Density Outline density 0 to 100

Knob Parameter Setting values

1 Width 0 to 4

2 Position 359 to 0

4 Density 0 to 100

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0 to 100

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Pattern edge 
softness

0 to 100

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0 to 100

2 Saturation Saturation 0 to 100

3 Hue Hue 359 to 0

4 Density Density 0 to 100

Knob Parameter Adjustment Setting values

1 Top Top position –100 (shown as 
–00) to +100

2 Left Left position –100 (shown as 
–00) to +100

3 Right Right position –100 (shown as 
–00) to +100

4 Bottom Bottom position –100 (shown as 
–00) to +100

Knob Parameter Adjustment Setting values

1 Soft Box softness 0 to 100
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When pattern is selected

a) The pattern is the same as a standard wipe. (See “Wipe Pattern List” (page 
344).)

Using the subsidiary mask
In the key control block, press the [SUB MASK] button, 
turning it on. The parameter settings depend on the mask 
source selected as [Wipe] or [Utility 1 Bus] in the <Mask 
Source> group of the Sub Mask menu for the key.

When wipe is selected

When utility 1 bus is selected

Applying a DME Effect to a Key

• When the SDI interface is used to connect the DME, 
DME effects (including DME wipes) can be used in only 
one place for one M/E bank.

• When the dedicated interface is used to connect the 
DME, the number of keys to which DME effects 
(including DME wipes) can be applied simultaneously 
for one M/E bank varies as follows depending on the 
execution mode of the DME wipe pattern selected for the 
background.

- MVS-8000X

- MVS-7000X

a) 0 when the system signal format is 1080P.
b) 1 when the system signal format is 1080P and the DME input/output 

signal format is set to dual link mode.
c) 0 when the system signal format is 1080P and the DME input/output 

signal format is set to dual link mode.
• When combining DMEs connected via the dedicated 

interface and the SDI interface, you can increase the 
number of keys to which DME effects are applied 
simultaneously. (Requires a setting in setup.)
For details, see “Setting DME and Switcher Interfaces” 
in Chapter 20 (Volume 2).

Assigning a DME to a key

1 In the key control block, press the delegation buttons 
[M/E1] and [KEY1].

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Edge softness 0 to 100

3 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0 to 100

2 Soft Edge softness 0 to 100

Knob Parameter Adjustment Setting values

1 Clip Reference level for 
creating mask 
signal

+109 to –7

2 Gain Gain –100 (shown as 
–00) to +100

Notes 

Applicable 
block

Key to 
which 
DME 
effects 
are 
applied

DME wipe 
pattern for 
background

Number of keys 
to which DME 
effects can be 
applied 
simultaneously

Other than 
M/E-4

Keys 1 
to 4

No DME 
wipe used

2

One-channel 
mode

1

Two- or 
three-
channel 
mode

0

Keys 5 
to 8

- 2 a)

M/E-4 Keys 1 
to 4

No DME 
wipe used

2 b)

One-channel 
mode

1 c)

Two- or 
three-
channel 
mode

0

Keys 5 
to 8

- 0

Key to 
which 
DME 
effects are 
applied

DME wipe pattern 
for background

Number of keys to 
which DME effects 
can be applied 
simultaneously

Keys 1 to 4 No DME wipe used 2

One-channel mode 1

Two- or three-
channel mode

0

Keys 5 to 8 - 2 a)
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2 Using the DME channel selection buttons, select the 
DME channel (DME1 to DME8) for applying the 
effect.

The lit colors of the [DME1] to [DME8] buttons 
indicate the DME assignment.
Lit green: Shows the DME assigned to the currently 

selected key.
Lit amber: Shows the DME assigned to a key other 

than the currently selected key.
Off: DME is not assigned.

To select a DME being used by another keyer
Press [Override], turning it on, then select the DME 
channel.
The later selection is valid, and the button lights green.

Using two or three DME channels on one 
keyer
When using the DME dedicated interface, proceed as 
follows.

On the MVS-800X, when the signal format is 1080P, the 
combination of two consecutively numbered DME 
channels that can be selected is DME1 and DME2, DME3 
and DME4, DME5 and DME6, or DME7 and DME8. It is 
not possible to combine three or more DME channels.
On the MVS-7000X, when the signal format is 1080P, the 
above restriction also applies if using the MVE-8000A. 
There is no such restriction for the MKS-7470X.

1 Select the DME for the first channel (see the previous 
item, “Assigning a DME to a key”), then select the 
successive channel for the second channel. For the 
third channel select the channel after that.

2 To select the second channel video signal, hold down 
the [UTIL] button in the cross-point control block, and 
select the signal in the Key1 row (DME external video 
bus).

3 To select the third channel video signal, when the 
selected DME is Ch3 or Ch4, select the signal on the 
DME utility 1 bus. When the selected DME is Ch7 or 
Ch8, select the signal on the DME utility 2 bus.

For details of the method of signal selection, see “Bus 
Selection” (page 79).

Using four DME channels on one keyer
When using the DME dedicated interface, proceed as 
follows.

• When the signal format is 1080P, this operation cannot 
be carried out.

• On the MVS-7000X, when the signal format is 1080P, 
the above restriction also applies if using the MVE-
8000A. There is no such restriction for the MKS-7470X/
7471X.

1 Select the DME channel 1 (or channel 5) for the first 
channel (see “Assigning a DME to a key” (page 135)). 
In the same way, select the DME channel 2 (channel 6) 
for the second channel, the DME channel 3 (channel 7) 
for the third channel, and the DME channel 4 (channel 
8) for the fourth channel.

2 For the second channel video signal, select the signal 
on the DME external video bus.

3 To select the third channel video signal, when the 
selected DME is Ch3, select the signal on the DME 
utility 1 bus. When the selected DME is Ch7, select the 
signal on the DME utility 2 bus.

4 To select the fourth channel video signal, when the 
selected DME is Ch4, select the signal on the DME 
utility 2 bus. When the selected DME is Ch8, select the 
signal on the DME utility 1 bus.

For details of the method of signal selection, see “Bus 
Selection” (page 79).

When using the SDI interface
The operations to select the video signals for the third and 
fourth channels differ from those in the previous 
procedure: select the video signals on the AUX bus 
allocated in a Setup menu (Engineering Setup >Switcher 
>Device Interface >DME Setting >DME SDI Interface 
menu).

When using a second key in combination with a dedicated 
interface, select the signal to be used on the AUX bus.
You can check the DME operating status in the Status 
menu (see page 225).

Assigning the DME output signal to a 
monitor signal

1 Holding down the output destination specification 
button [MON] in the key control block, use the DME 
channel selection buttons to select the DME channel 
(DME1 to DME8) you want to use.

The selected DME output is assigned to DME MON V 
and DME MON K.

Notes 

Notes 

Notes 
Key Adjustments (Key Control Block)



  C
hapter 4  K

eys
2 To check the DME assignment status, hold down just 
the [MON] button.

While it is held down, the lit color of the [DME1] to 
[DME8] buttons shows the key assignment status.
Lit green: Shows the DME currently being 
monitored.
Lit amber: Shows a DME which can be monitored.
Off: DME is not assigned.

Other Key Setting Operations

Using an external processed key
You can select and use the key processed keyer key fill and 
key source signals on the AUX buses.

1 Select the keyer to be allocated.

2 In the key control block, press [PROC KEY], turning 
it on.

The button lights amber, and on the currently selected 
keyer, the key fill and key source are assigned to 
reentry signals PROC V and PROC K.

When a DME is selected on the currently selected 
keyer, the key fill and key source signals to which the 
DME effect is applied are assigned to PROC V and 
PROC K.

You cannot select the PROC V and PROC K signals using 
the cross-point selection buttons of the M/E or PGM/PST 
bank.

Using a frame memory feed
When you press the [FM FEED] button in the key control 
block, it lights momentarily amber, then the key fill and 
key source signals processed in the currently selected 
keyer are assigned to frame memory sources 1 and 2.
If a DME is selected on the currently selected keyer, then 
the key fill and key source signals to which a DME effect 
is applied are assigned to frame memory sources 1 and 2.
Carrying out a frame memory feed causes the [PROC 
KEY] button to light amber.

Using the show key function
While the [SHOW KEY] button is held down, the key-
processed key source signal appears on the specified 
output. (Show key mode)
Even when the [SHOW KEY] button is released, for a 
preset time the show key mode is maintained. You can 
specify the output to which the show key function is 

applied and set the time for which the show key mode is 
maintained after releasing the button in a Setup menu.

For details see “Settings for the Show Key Function” in 
Chapter 20 (Volume 2).

Using the auto delegation function
To couple the selection in the key delegation buttons of the 
independent key transition control block so that the key 
control block delegation selection is automatically 
switched, in the key control block press the [AUTO 
DELEG] button, turning it on.

Returning the key adjustment values to 
their defaults
Holding down a key type button ([LUM], [LIN], [CRK], 
[CVK], or [PTN]) recalls the key default values (page 
115).

Key modify clear
When an M/E delegation button is held down, holding 
down a key delegation button together returns the key 
settings to the initial status settings.

For details of the initial status, see “Saving User-Defined 
Settings” in Chapter 18 (Volume 2).

Notes 
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Key Adjustments 
(Multifunction Flexi Pad 
Control Block)

This section describes basic key adjustment operations 
when using the Multifunction Flexi Pad control block.

To select [M/E 4], a previous assignment in the Setup 
menu is required (see page 380). 

Selecting the switcher bank and keyer
Before carrying out key adjustment, first select the key 
adjust mode, then select the switcher bank and keyer.
For example, to adjust key 1 on M/E-1, proceed as follows.

1 In the Multifunction Flexi Pad control block mode 
selection buttons, press [KEYADJ].

2 Press the [M/E1] region selection button.

3 Press the [KEY SHIFT] button, turning it off.

4 In the memory recall section, press the [KEY1] button.

To select keys 5 to 8, in step 3 press [KEY SHIFT], 
turning it on, then press one of buttons [KEY5] to 
[KEY8] in the memory recall section to select the key.

The button displays in the memory recall section now 
appear as shown in the following illustration.

Pressing the [PAGE 1/4] > [PAGE 2/4] > [PAGE 3/4] 
buttons further changes the display as follows, then 
pressing [PAGE 4/4] returns to the original display 
shown in the illustration.

Notes 

Notes 

EDIT ENBL button

Mode selection buttons

Alphanumeric display

Adjustment knobs

Adjustment knob 
displaysMemory recall 

section

Region selection 
buttons

[PAGE 1/4]

[PAGE 2/4]

[PAGE 3/4]
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With these buttons in the memory recall section, you can 
carry out the following key adjustment.

Selecting the key type
[LUM] button: Selects a luminance key.
[LIN] button: Selects a linear key.
[CRK] button: Selects a chroma key.
[WIPE PTN] button: Selects a key wipe pattern key.

Adjust the parameters for each type with the adjustment 
knobs. For details of the parameters, see the following 
sections.
Luminance key: “When the [LUM] or [LIN] button is lit 

green” (page 131)
Linear key: “When the [LUM] or [LIN] button is lit 

green” (page 131)
Chroma key: “When the [CRK] button is lit green” (page 

131)
Key wipe pattern key: “When the [PTN] button is lit 

green” (page 132)

Selecting the key source
[AUTO SEL] button: The signal assigned as a pair with 

the key fill bus signal for the key row button in the 
cross-point control block is automatically selected.

[SPLT] button: Select a different signal manually. To 
make the selection, hold down this button, and press 
the button assigned to the signal you want as key 
source in the cross-point control block.

You can also use the same signal as the key fill selected on 
the key fill bus as key source (SELF). Press the [AUTO 
SEL] button and [SPLT] button simultaneously so that 
both are off, to select the SELF mode.

Setting auto chroma key
[SMPL MARK] button: Toggles the sample mark 

display on and off. When on, the monitor screen shows 
the foreground video and a white box sample mark.

[AUTO STRT] button: Automatically adjusts the chroma 
key. When the [SMPL MARK] button is off, pressing 
this does not carry out automatic chroma key 
adjustment.

You can adjust the display position and size of the sample 
mark with the adjustment knobs.

For details of these parameters, see “Making auto chroma 
key adjustments” (page 120).

Setting the show key function
[SHOW KEY] button: When this is pressed, the key 

source signal to which key processing has been 
applied is output from the specified output port (show 
key mode).

For details, see “Using the show key function” (page 137).

Setting the resizer function
[RE SIZR] button: Enables and disables the resizer 

function.

The parameters that can be adjusted with the adjustment 
knobs are on three pages; to access the second page or third 
page, press the [KNOB 1/3] or [KNOB 2/3] button. 

For details of the parameters, see “Menu operations for 
key shrinking, magnification, rotation and movement” 
(page 141).

If you press this button at the same time as any of the 
[KEY1] to [KEY4] buttons, you can switch the trackball 
and joystick to the resizer setting mode.
[ROT X] button: When this is set to On, you can rotate the 

key around on the x-axis.
[ROT Y] button: When this is set to On, you can rotate the 

key around on the y-axis.

For the parameters adjustable with the adjustment knobs, 
see step 4 in “Setting rotation of the resizer” (page 147).

Inverting the sense of the key source
[KEY INV] button: When this is set to On, the sense of 

the key source is inverted.

Selecting the key fill signal
[FILL MAT] button: When this is On, the signal 

generated by the dedicated color matte generator is 
selected, and when it is Off, the signal selected on the 
key 1 fill bus is selected.

For parameters that can be adjusted with the adjustment 
knobs, see “Selecting key fill and key source” (page 117).

[PAGE 4/4]
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Selecting the key edge signal
[EDGE MAT] button: When this is On, the signal 

generated by the dedicated color matte generator is 
selected, and when it is Off, the signal selected on the 
utility bus is selected.

For parameters that can be adjusted with the adjustment 
knobs, see step 4 in “Key Edge Modifications” (page 123).

Selecting the mask source
[MASK] button: Selects the mask source (box generated 

by dedicated generator or pattern) to be selected in the 
Main Mask menu for each M/E bank.

The parameters that can be adjusted with the adjustment 
knobs are different for a box or a pattern.
The box parameters are on two pages; to access the second 
page, press the [KNOB1/2] button.

For details, see step 4 in “Using the main mask” (page 
126).

Applying modifiers to the key edge
[BDR] button: Applies a border to the edge.
[DROP BDR] button: Applies a drop border to the edge.
[SHDW] button: Applies a shadow to the edge.

For parameters that can be adjusted with the adjustment 
knobs, see “Key Edge Modifications” (page 123).

Setting the degree of edge softening
[SOFT EDGE] button: Softens the key edge.

For parameters that can be adjusted with the adjustment 
knobs, see step 7 in “Key Edge Modifications” (page 124).

Enabling the set key to be used on the AUX 
bus
[PROC KEY] button: This enables the keyer key fill/key 

source signal to be subjected to key processing, then 
used as a reentry signal by selection on the AUX bus.

For details, see “Using an external processed key” (page 
137).

Sending a signal subjected to key 
processing to frame memory
[FM FEED] button: Press this to assign the key fill/key 

source signal processed on the currently selected keyer 
to frame memory source 1 or 2.

For details, see “Using a frame memory feed” (page 137).

Using a DME currently used on another 
keyer
[OVER RIDE] button: When one DME channel is in use, 

holding down this button and pressing a DME channel 
button ([DME1] to [DME8]) allows you to forcibly 
select this channel. The button for the selected DME 
channel lights green.

Recalling the keyer using the DME channel
[TRCE] button: Holding down this button, press the 

selection button for the DME channel already assigned 
to another keyer or transition, to switch the keyer or 
transition to which the DME channel is assigned to the 
currently selected state.

Monitoring DME output
[DME MON] button: Holding down this button and 

pressing the selection button for a DME channel 
([DME1] to [DME8]) allows you to monitor the signal 
for this channel as a reentry signal to DME MON V/K. 
However, it is first necessary to assign this channel on 
the DME to the delegation (keyer or transition) to be 
monitored.

Selecting the DME channel
[DME1] to [DME8] buttons: Press one of these to select 

the corresponding DME channel. The number of valid 
buttons depends on the number of DME channels in 
use.

[DME MORE] button: If there are more than four DME 
channels in use, use this to change the DME channel 
selection buttons displayed.

Returning the key adjustment values to 
their defaults
Holding down a key type button ([LUM], [LIN], [CRK], or 
[WIPE PTN])
recalls the key default values.

Key modify clear
When the [KEY ADJ] button is held down, holding down 
the region selection button for the selected region together 
returns all the key settings of the region to the initial status 
settings.
When the [KEY ADJ] button is held down, holding down 
the button for the selected key together returns the key 
settings to the initial status settings.

For details of the initial status, see “Saving User-Defined 
Settings” in Chapter 18 (Volume 2).
Key Adjustments (Multifunction Flexi Pad Control Block)
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Resizer

Resizer allows you to apply DME-like effects such as 
image shrinking, magnification and movement, rotation as 
well as change of the aspect ratio, to the processed key.
The following functions are available.
• Two-dimensional transformations of keys (page 141)
• Key rotation around on the x- or y-axis
• Resizer interpolation settings (page 143)
• Resizer crop/border settings (page 144)
• Resizer effect settings (page 145)

(wide key border, drop shadow, edge enhance, mosaic, 
defocus, mask)

• The image of the key manipulated by resizer has a one-
frame delay.

• Some effects of resizer are different from what you 
would expect of DME effects.

Restrictions on the use of effects
There are restrictions on combined use of resizer effects 
themselves and that with DME wipes.

For details, see “Impossibility of simultaneous use within 
the same keyer” (page 147).

Relation between resizer and other effects
You cannot apply DME effects to a key for which the 
resizer function is enabled. When one of the three 
functions – resizer, DME wipe and DME effects – is 
enabled, the other two are disabled.

Two-Dimensional Transformations 
and Rotation of Keys

When the screen aspect ratio is 4:3 in HD format, when the 
resizer is used to shrink a video image, this is applied to the 
16:9 screen including the added video on the left and right 
sides. Use the crop function as required to extract the 4:3 
image.

Menu operations for key shrinking, 
magnification, rotation and movement
For example, to shrink, magnify, rotate or move key 1 of 
the M/E-1 bank, use the following procedure.

1 In the M/E-1 >Key1 >Processed Key menu, press 
[Resizer], turning it on.

2 Adjust the following parameters with the knobs.

a) [X] is turned on in the <Rotation> group of the Rotation menu.
b) [Y] is turned on in the <Rotation> group of the Rotation menu.

Notes 

Notes 

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Location X Move key 
horizontally

HD –99.9999 to 
+99.9999

SD 
4:3

–33.3333 to 
+33.3333

SD 
16:9

–24.9999 to 
+24.9999

2 Location Y Move key 
vertically

HD –99.9999 to 
+99.9999

SD 
4:3

–33.3333 to 
+33.3333

SD 
16:9

–24.9999 to 
+24.9999

3 Size Magnify or 
shrink key

0.0000 to 99.9999

4 a) Rotation X Rotate key 
horizontally

–99.9999 to 
+99.9999

4 b) Rotation Y Rotate key 
vertically

–99.9999 + 
99.9999

5 Perspective Change 
perspective

0.0000 to 1.0000

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Aspect X Change 
aspect ratio 
horizontally 

0.0000 to 99.9999

2 Aspect Y Change 
aspect ratio 
vertically 

0.0000 to 99.9999

3 Aspect 
Ratio

Change 
aspect ratio 
horizontally 
and 
vertically at 
a time

0.0000 to 2.0000
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Key control block operations for key 
shrinking, magnification, rotation and 
movement

1 Use the delegation buttons to select the key to which 
you want to apply a resizer function.

2 Press the [RESIZER] button, turning it on.

3 Adjust the following parameters with the knobs.
(To switch between displaying parameter group 1/2 
and 2/2, press the [MORE] button.)

4 To specify the direction of rotation, press the [ROT X] 
or [ROT Y] button, turning it on.

To enable the [ROT X] and [ROT Y] buttons, it is 
necessary to assign functions in advance. 

For details, see Chapter 19 “Assigning Functions to 
Key Control Block Buttons” (Volume2).

5 Turn the knobs to adjust the following parameters.

• When [ROT X] is lit

• When [ROT Y] is lit
Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 X Move key 
horizontally

HD –99 to 
+99

SD 4:3 –33 to 
+33

SD 16:9 –24 to 
+24

2 Y Move key 
vertically

HD –99 to 
+99

SD 4:3 –33 to 
+33

SD 16:9 –24 to 
+24

3 S Magnify or 
shrink key

0.0 to 99

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 X Change 
aspect ratio 
horizontally 

0.0 to 99

Delegation buttons

RESIZER button

MORE button

Adjustment 
knobs

2 Y Change 
aspect ratio 
vertically 

0.0 to 99

3 R Change 
aspect ratio 
horizontally 
and 
vertically at 
a time

0.0 to 2.0

Notes

Knob Parameter Adjustment Setting values

1 Rotation X Rotate key 
horizontally

–99 to +99

4 Perspective Change 
perspective

0 to 99

Knob Parameter Adjustment Setting values

2 Rotation Y Rotate key 
vertically

–99 to +99

4 Perspective Change 
perspective

0 to 99

Parameter group [2/2]

Knob Parameter Adjustment Setting values
Resizer
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Device control block operations for key 
shrinking, magnification, rotation and 
movement

1 Press the [RSZR CTRL] button, turning it on.

2 Press the delegation button to select the key.

3 Press the [RSZR] button, turning it on.

4 • To change the aspect ratio, turn on the [LOC 
SIZE(ASP)].

• To shrink, magnify, or move the key, turn on the 
[LOC XYZ(LOC)].

• To rotate the key, turn on the [ASP PS (ROT)] 
button. To specify the direction of rotation, press [X] 
or [Y]. To adjust perspective, press [Z].

Hold these buttons down while carrying out the 
operation of step 5 to enable fine adjustment (fine 
mode).

5 Use the trackball and joystick for the operation.

For details of parameters, see steps 3 and 5 of “Key 
control block operations for key shrinking, 
magnification, rotation and movement” (page 142).

Entering parameters
This operation is the same as DME three-dimensional 
parameter input.

For details, see “Entering Three-Dimensional Parameter 
Values” (page 273).

Resetting parameters
This operation is the same as DME three-dimensional 
parameter resetting.

For details, see “Entering Three-Dimensional Parameter 
Values” (page 273).

Clearing resizer effects

To clear two-dimensional transform and rotation 
parameters only and set the initial state
In the device control block, press the [CLR WORK BUFR] 
button in the operation buttons.

To clear all resizer parameters, and set the initial 
state
In the device control block, press the [CLR WORK BUFR] 
button in the operation buttons, twice in rapid succession.

For the initial state, you can select either the factory default 
settings or user settings.

For details of how to make this selection, see “Selecting 
the State After Powering On (Start Up Menu)” in Chapter 
18 (Volume 2).

Resizer Interpolation Settings

For example, to make the interpolation settings for key 1 
of the M/E-1 bank, use the following procedure.

1 In the M/E-1 >Key1 >Processed Key menu, press 
[Resizer], turning it on.

2 Press [Resizer Process].

The Resizer Process menu appears.

3 In the <Video Field/Frame Mode> and other groups, 
make the interpolation settings.

This operation is the same as when making the DME 
interpolation settings for MVS-8000A.

For details, see Chapter 11 ““Interpolation Settings” 
(page 333).

However, the following points are different from the 
operation for MVE-8000A.
• [Interpolation Mode] can be set for any type of signal 

formats.
• The anti-moire filter cannot be set.

Delegation buttons

RSZR CTRL button

Trackball

ASP button

LOC button

RSZR button Z-ring
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Resizer Crop/Border Settings

Making a crop setting for a key for which 
resizer is on
For example, to make the crop settings for key 1 of the M/
E-1 bank, use the following procedure.

1 In the M/E-1 >Key1 >Processed Key menu, press 
[Resizer], turning it on.

2 Press [Border/Crop].

The Border/Crop menu appears.

3 Press [Crop], turning it on.

4 Set the parameters.

These settings are the same as those for crop of DME. 
For details, see “Crop Settings” (page 277).

If mosaic or defocus is enabled, and in the <Mosaic/
Defocus Mode> group you select Video/Key, then the crop 
is disabled.

Applying a border to a key for which 
resizer is on
For example, to add the border for key 1 of the M/E-1 
bank, use the following procedure.

1 In the M/E-1 >Key1 >Processed Key menu, press 
[Resizer], turning it on.

2 Press [Border/Crop].

The Border/Crop menu appears.

3 Press [Border], turning it on.

4 Set the parameters.

The valid ranges of the parameter values depend on the 
combination of signal format (SD/HD) and aspect 
ratio (4:3/16:9) selected in the system, as follows.

SD format

HD format

To apply color to a border

1 In the <Border Mode> group of the Border/Crop 
menu, press [Flat Color].

2 Adjust the following parameters.

To soften the inner edge of a border

1 In the Border/Crop menu, press [Border Soft].

2 Adjust the following parameters.

To apply a beveled light edge

1 In the <Border Mode> group of the Border/Crop 
menu, press [Beveled Light Edge].

2 Adjust the following parameters.

Notes 

Knob Parameter Adjustment Setting values

1 H Simultaneously 
adjust width of 
left and right 
borders

0.00 to 4.00

2 V Simultaneously 
adjust width of 
top and bottom 
borders

0.00 to 3.00 
(4:3) 
0.00 to 2.25 
(16:9)

3 All Simultaneously 
adjust width of 
all four borders

Value of H 
shown

5 Density Density of the 
borders

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Simultaneously 
adjust width of 
left and right 
borders

0.00 to 12.00 
(4:3) 
0.00 to 16.00 
(16:9)

2 V Simultaneously 
adjust width of 
top and bottom 
borders

0.00 to 9.00

3 All Simultaneously 
adjust width of 
all four borders

Value of H 
shown

5 Density Density of the 
borders

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Inner Soft Border inner 
softness

0.00 to 100.00

Knob Parameter Adjustment Setting values
Resizer
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3 Press [Border Soft].

4 Adjust the following parameters.

To apply a beveled color edge

1 In the <Border Mode> group of the Border/Crop 
menu, press [Beveled Color Edge].

2 In the <Color Adjust> group, select the edges for 
adjustment among the [Top], [Left], [Right], and 
[Bottom] edges. To select all the four edges, press 
[All].

3 Set the color parameters.

For details, see “To apply color to a border” (page 
144)

4 Press [Border Soft].

5 Adjust the following parameters.

Applying Resizer Effects

For example, to apply effects to key 1 of the M/E-1 bank, 
use the following procedure.

1 In the M/E-1 >Key1 >Processed Key menu, press 
[Resizer], turning it on.

2 Press [Enhanced Effect].

The Enhanced Effect menu appears.

Applying a wide key border

1 In the M/E-1 >Key1 >Processed Key >Enhanced 
Effect menu, press [Dual Rszr Effect], turning it on.

2 Press [Wide Key Border], turning it on.

3 Adjust the following parameters.

a) Shared with the drop shadow “Soft” value.

4 To add an outline, press [Outline], turning it on.

5 To adjust the border color, press [Border Color].

6 Set the color parameters.

For details, see “To apply color to a border” (page 
144).

Knob Parameter Adjustment Setting values

1 Top Top edge –100.00 to 
+100.00

2 Left Left edge –100.00 to 
+100.00

3 Right Right edge –100.00 to 
+100.00

4 Bottom Bottom edge –100.00 to 
+100.00

5 All Four edges Value of Left 
shown

Knob Parameter Adjustment Setting values

1 Inner Soft Border inner 
softness

0.00 to 100.00

2 Bound 
Soft

Border 
boundary 
softness

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Inner Soft Border inner 
softness

0.00 to 100.00

2 Bound 
Soft

Border 
boundary 
softness

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Simultaneously 
adjust border 
width of left and 
right edges

0.00 to 100.00

2 V Simultaneously 
adjust border 
width of upper 
and lower edges

0.00 to 100.00

3 All Simultaneously 
adjust border 
width of all four 
edges

Value of H 
shown

4 Soft a) Softness of 
border

0.00 to 100.00

5 Density Density of 
border 

0.00 to 100.00
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Applying a drop shadow

1 In the M/E-1 >Key1 >Processed Key >Enhanced 
Effect menu, press [Dual Rszr Effect], turning it on.

2 Press [Drop Shadow], turning it on.

3 Set the parameters.

The valid ranges of the parameter values depend on the 
combination of signal format (SD/HD) and aspect 
ratio (4:3/16:9) selected in the system, as follows.

SD format

a) Shared with the wide key border “Soft” value.

HD format

a) Shared with the wide key border “Soft” value.

Edge enhancement
Adjusting the gain sharpens the image.

1 In the M/E-1 >Key1 >Processed Key >Enhanced 
Effect menu, press [Edge Enhance], turning it on.

2 Adjust the following parameters.

Applying a mosaic

1 In the M/E-1 >Key1 >Processed Key >Enhanced 
Effect menu, press [Mosaic], turning it on.

2 Set the parameters.

 This operation is the same as the DME mosaic setting. 
For more details, see “Mosaic Settings” (page 294).

3 In the < Mosaic/Defocus Mode > group, select the 
signal to which to apply the mosaic effect.

Video/Key: Video signal and key signal
Video: Video signal only

If mosaic is enabled, and in the <Mosaic/Defocus 
Mode> group you select Video/Key, then the crop and 
mask are disabled.

4 Set the parameters.

To make the mosaic like a relief pattern

1 With [Mosaic] on, press [Relief], turning it on.

2 In addition to the mosaic parameters, set the following 
parameters.

Knob Parameter Adjustment Setting values

1 H Horizontal 
position of 
shadow

–8.00 to +8.00

2 V Vertical position 
of shadow

–6.00 to +6.00 
(4:3) 
–4.50 to +4.50 
(16:9)

3 Size Shadow size 0.00 to 2.00

4 Soft a) Softness of 
shadow

0.00 to 100.00

5 Density Density of 
shadow

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Horizontal 
position of 
shadow

–24.00 to 
+24.00 (4:3)
–32.00 to 
+32.00 (16:9)

2 V Vertical position 
of shadow

–18.00 to 
+18.00

3 Size Shadow size 0.00 to 2.00

4 Soft a) Softness of 
shadow

0.00 to 100.00

5 Density Density of 
shadow

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Horizontal gain 
adjustment

0.00 to 100.00

2 V Vertical gain 
adjustment

0.00 to 100.00

3 All Both horizontal 
and vertical 
adjustment

H value is 
displayed

Notes 

Knob Parameter Adjustment Setting values

1 H Horizontal 
defocusing

0.00 to 100.00

2 V Vertical 
defocusing

0.00 to 100.00

3 All Horizontal and 
vertical 
defocusing

H value shown

Knob Parameter Adjustment Setting values

3 Gain Relief depth of 
mosaic cells

0.00 to 100.00

4 Angle Light source 
direction

–8.00 to +8.00
Resizer
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Defocusing

1 In the M/E-1 >Key1 >Processed Key >Enhanced 
Effect menu, press [Defocus], turning it on.

2 Set the parameters.

This operation is the same as the defocusing setting 
when using the DME with the DME dedicated 
interface (see page 290). 

However, <Mosaic/Defocus Mode> appears in place 
of <Defocus Mode>. 

If defocus is enabled, and in the <Mosaic/Defocus Mode> 
group you select Video/Key, then the crop and mask are 
disabled.

Applying a mask to mosaic or defocus

1 In the M/E-1 >Key1 >Processed Key >Enhanced 
Effect menu, press [Dual Rszr Effect], turning it on.

2 Press [Mask], turning it on.

This enables the mask function.
To make the mask settings, continue with steps 3 and 
following.

3 Press [Mask Menu].

The Mask menu appears.

4 In the <Mask Source> group, select either of [Box] 
and [Circle].

Box: Use a box pattern as the mask signal.
Circle: Use a circle pattern as the mask signal.

5 Set the parameters.

The valid ranges of the parameter values depend on the 
combination of signal format (SD/HD) and aspect 
ratio (4:3/16:9) selected in the system, as follows.
The parameters are the same as for drop shadow. 

For more details, see “Applying a drop shadow” 
(page 146), except that knobs 3 and 5 are as follows.

The rotation and inversion operations are the same as 
for a DME mask setting. 

For more details, see “Mask Settings” (page 297).

• When a mask effect is applied to a border, the 
boundary becomes discontinuous, giving an 
unnatural effect. Avoid applying a mask to a border.

• If mosaic or defocus is enabled, and in the <Mosaic/
Defocus Mode> group you select Video/Key, then 
the mask is disabled.

Restrictions on resizer effects

Restrictions on the use of effects
Of the resizer effects, using mask, drop shadow, or wide 
key border requires two units of hardware for the resizer 
function.
These are called “dual resizer effects”.
In a dual resizer effect, predetermined combinations, key 1 
and key 2, key 3 and key 4, key 5 and key 6, key 7 and key 
8 are used.
For example, if either of key 1 and key 2 has resizer set to 
On, the other key cannot be used for a dual resizer effect.
The same restriction applies when using a resizer DME 
wipe in place of resizer.

Impossibility of simultaneous use within the 
same keyer
The following combinations of resizer effects cannot be 
simultaneously on.
• Mosaic and edge enhance
• Defocus and wide key border
• Mask and drop shadow
• Mask and wide key border

Setting rotation of the resizer

Either X or Y direction must be specified for rotation. You 
cannot make rotation by combining both directions.
When rotating key 1 of the M/E-1 bank, for example, use 
the following procedure.

1 Select M/E-1 >Key1 >Processed Key menu, press 
[Resizer], turning it on.

2 Press [Rotation], turning it on.

The Rotation menu appears.

3 Press [X] or [Y] in the <Rotation> group to select the 
direction of rotation.

4 Turn the knobs to adjust the following parameters.

Notes 

Knob Parameter Adjustment Setting values

3 Size Size 0.00 to 100.00

5 Aspect Aspect ratio –100.00 to 
+100.00

Notes 

Notes 
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• When [X] is on

• When [Y] is on

Canceling Virtual Images
If an extreme degree of perspective is set for an image, the 
part of the image which is beyond the imaginary view 
point of view is wrapped around to show the other side of 
the image on the monitor screen. You can press [Wrap 
Around], turning it on, to make a setting not to show the 
virtual images.

Key Snapshots

Key settings other than the key on/off status and the key 
priority can all be instantaneously saved in a dedicated 
register, for recall when required. A key snapshot 
comprises three values: a cross-point button number, key 
memory full mode, and independent key transition, and 
can be called in any combination.
There are four key snapshot registers for each keyer.

Key Snapshot Operations

Key snapshot operations are carried out in the independent 
key transition control block, downstream key control 
block or Multifunction Flexi Pad control block. Each keyer 
is provided with four dedicated key snapshot registers.

Independent key transition control block (standard type)

To select [Key5] to [Key8] or [DSK5] to [DSK8] in the 
independent key transition control block or downstream 
key control block, a previous assignment in the Setup 
menu is required (see page 381).

Saving a key snapshot
For example, the following procedure saves the state of the 
M/E-1 key 1 settings.

1 In the M/E-1 independent key transition control block, 
press the key delegation button [KEY1], turning it on.

2 Press the [K-SS] button, turning it on. 

Knob Parameter Adjustment Setting values

1 Rotation X Rotate key 
horizontally

–99.0000 to 
+99.0000

4 Perspective Change 
perspective

0.0000 to 
99.9999

Knob Parameter Adjustment Setting values

2 Rotation Y Rotate key 
vertically

–99.0000 to 
+99.0000

4 Perspective Change 
perspective

0.0000 to 
99.9999

Notes 

Key source name display/
key snapshot buttons

Key delegation buttons

Key snapshot setting 
buttons
Key Snapshots
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The system switches to key snapshot mode, and the 
key source name display/key snapshot buttons show 
the status of registers 1 to 4 for key 1.
Off: Nothing is saved in the register.
Lit orange: Settings are saved in the register.
For a register holding a snapshot, the register name is 
shown as up to eight characters.

3 Hold down the [K-SS STORE] button, and press the 
key source name display/key snapshot button 
corresponding to the register in which you want to 
save the snapshot.

The key source name display/key snapshot button 
which you pressed lights yellow.

If you save a key snapshot in a register for which the 
button is lit orange or yellow, the existing contents of 
the register are overwritten.

Recalling a key snapshot
For example, the following procedure recalls the state of 
the M/E-1 key 1 settings.

1 In the M/E-1 independent key transition control block, 
press the key delegation button [KEY1], turning it on.

2 Press the [K-SS] button, turning it on.

3 Set the following buttons on or off, depending on the 
information you want to recall.
(These buttons are not provided in the downstream key 
control block.)

[K-MOD ENBL] button: When this is on, the key 
settings and key modifiers are recalled. When this 
is off, they are not recalled.

[K-TR ENBL] button: When this is on, the 
independent key transition settings are recalled. 
When this is off, they are not recalled.

If both buttons are off, the key memory function is 
enabled and only the saved selection of key fill and key 
source signals is recalled.

4 Press the key source name display/key snapshot button 
corresponding to the register you want to recall.

The button you pressed lights yellow, and this recalls 
the key snapshot.
To cancel a recall carried out in the downstream key 
control block, press the [UNDO] button in the 
downstream key control block.

Key snapshot operation on the 
Multifunction Flexi Pad control block
By default, the [KEY SS] key snapshot mode selection 
button does not appear in the Multifunction Flexi Pad 
control block. To carry out key snapshot saving and recall 
in this control block, it is first necessary in the Engineering 
Setup >Panel >Config >Link/Program Button >Multi 
Function >Mode Sel Assign menu to assign the Key 
Snapshot mode to a mode selection button.

To save a key snapshot
For example, to save a key snapshot for key 1 of M/E-1, 
select M/E1 and key1, then use the following procedure.

1 Press the [K SS] button.

The button displays in the memory recall section 
change as shown in the following illustration.

2 In the memory recall section, hold down the [STOR] 
button, and press the button (any of [1] to [4]) for the 
register in which you want to save the key snapshot.

To recall a key snapshot
For example, to recall a key snapshot for M/E-1 key 1 
saved in register 1, with the M/E1 region and key 1 
selected, proceed as follows.

1 Press the [KEY SS] button.

2 According to the information you want to recall, set 
the following buttons On/Off.

[MOD ENBL] button: Recall the key adjustment 
values and key modifier settings.

[TRNS ENBL] button: Recall independent key 
transition settings.
If both are Off, then key memory is enabled, and 
just the saved key fill and key source signal 
selections are recalled.

3 Press button [1] for the register you want to recall.

Notes 
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The [1] button lights yellow, and the key snapshot is 
recalled.
To cancel the recall operation, press the [UNDO] 
button.

To delete a key snapshot
For example, to delete a key snapshot for M/E1 key 1 
saved in register 1, with the M/E1 and key 1 region 
selected, proceed as follows.

1 Press the [KEY SS] button.

2 Holding down the [DEL] button, press the button [1] 
for the register in which is saved the key snapshot you 
want to delete.

To carry out an auto transition execution during 
key snapshot operation
Press the [AUTO TRNS] button.

Instant key insertion/removal
Press the [KEY ON] button.
To remove the key, while the key is inserted press the 
[KEY ON] button.

Key Snapshot Operations Using a 
Simple Transition Module

When using a simple transition module, the key snapshots 
hold the settings for key 3 and key 4. However, each key 
control block can be assigned to any key in setup.

For details, see “Assigning a Function to the Independent 
Key Transition Control Block (Simple Type)” in Chapter 
19 (Volume 2).

You can carry out key snapshot operations in the 
independent key transition control block (simple type) and 
Flexi Pad control block (simple type).
There are four dedicated key snapshot registers for each of 
keys 3 and 4.

Independent key transition control block (simple type)

Saving a key snapshot
For example, to save the settings of M/E-1 key 3, use the 
following procedure.

1 In the M/E-1 independent key transition control block, 
press the [K-SS] button in the key 3 control block, 
turning it on.

This switches to key snapshot mode, and the key 
source name display/key snapshot button shows the 
state of registers 1 and 2 for key 3.
Pressing the [K-SS 3/4] button shows the state of 
registers 3 and 4 for key 3.
Off: Nothing is saved in the register.
Lit orange: Settings are saved in the register.
For a register holding a snapshot, the register name is 
shown as up to eight characters.

2 In the Flexi Pad control block, hold down the 
[SNAPSHOT] button and press the key source name 
display/key snapshot button corresponding to the 
register in which you want to save the snapshot.

The key source name display/key snapshot button 
which you pressed lights yellow.

The functions of the key 3 control block 
and key 4 control block are the same.

K-SS button

Key 3 control block Key 4 control block

Key source name display/key 
snapshot buttons

In setup, assign the function of 
the K-SS 3/4 button to any of 
these four buttons.
Key Snapshots
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If you save a key snapshot in a register for which the 
button is lit orange or yellow, the existing contents of 
the register are overwritten.

Recalling a key snapshot
For example, the following procedure recalls the state of 
the M/E-1 key 3 settings.

1 In the M/E-1 independent key transition control block, 
press the [K-SS] button in the key 3 control block, 
turning it on.

2 Press the key source name display/key snapshot button 
corresponding to the register you want to recall.

Press the [K-SS 3/4] button as required, to switch 
between displaying the key 3 registers 1 and 2 or 
registers 3 and 4.
The button you pressed lights yellow, and this recalls 
the key settings (excluding the key insertion state (on/
off) and key priority).

Notes 
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Overview

A wipe is a transition from the current video stream to a 
new video stream, using a wipe pattern. 
Changing the background by means of a wipe is referred to 
as a “background wipe,” and inserting or deleting a key 
with a wipe is termed a “key wipe.”
There are two types of wipe: those that can be selected in 
a common transition, and those that can be selected in an 
independent key transition (see page 164).

Types of Wipe Pattern

The patterns that can be used for a wipe are divided into a 
number of groups, as follows. Note that only the standard 
wipe patterns can be used for an independent key 
transition.

For wipe patterns, see “Wipe Pattern List” in Appendix 
(Volume 1) (page 344).

Standard wipe patterns
Patterns consisting of straight lines vertically, 
horizontally, or diagonally, and circular patterns.

Enhanced wipes
More complex shapes such as hearts, stars, and round 
corners.

Rotary wipes
These patterns involve rotation of the image about a point.

Mosaic wipe pattern
This divides the image into small tiles.

Random and diamond dust wipe patterns
These patterns consist of small random tiles, or fine 
particles.

Basic Procedure for Wipe 
Settings

You carry out wipe setting operations principally using the 
Wipe menu for each of the M/E-1 to M/E-3 and PGM/PST 
banks.
This section describes the basic procedures for wipe 
settings, taking the M/E-1 >Wipe menu as an example.

Wipe Settings Menu

Accessing the wipe settings menu
To access the M/E-1 >Wipe menu, use either of the 
following operations.
• In the menu control block, select the top menu selection 

button [M/E 1], and press VF5 ‘Wipe.’

To select [M/E-4], a previous assignment in the Setup 
menu is required.

• In the transition control block of the M/E-1 bank, press 
the transition type selection button [WIPE] twice in 
rapid succession.

Wipe Pattern Selection

Selecting a wipe pattern by a menu 
operation

1 In the M/E-1 >Wipe menu, select HF1 ‘Main Pattern.’

The Main Pattern menu appears.

Notes 
Overview / Basic Procedure for Wipe Settings
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2 Select the wipe pattern group with the pattern group 
selection button.

Standard: standard wipes
Enhanced: enhanced wipes
Rotary: rotary wipes
Mosaic1 to Mosaic3: mosaic wipes
Random/Dust: random/diamond dust wipes
The patterns from the selected pattern group appear on 
the screen.

For details of wipe patterns, see “Types of Wipe 
Pattern” (page 152) and “Wipe Pattern List” (page 
344).

3 Press the button to select the desired pattern.

4 3The parameters change according to the selected 
pattern, and you can adjust the pattern.

When a polygon wipe is selected (pattern number 
49)

a) A value of –100.00 completely removes the star “rays,” leaving a 
circle; at +100.00 the “rays” are at their sharpest.

When a mosaic wipe is selected (pattern numbers 
200 to 203, 206 to 213, 224 to 247, 250 to 257, 260 to 
269)

When a karaoke wipe is selected (pattern numbers 
220 to 223)

a) At –100.00 tiles appear from the top (or left edge) of the screen; at 
+100.00 from the bottom (or right edge) of the screen.

b) At –100.00 all rows appear simultaneously; at +100.00 until one row 
of tiles is completely displayed, the next row does not start to appear.

When a random wipe is selected (pattern number 
273)

When a diamond dust wipe is selected (pattern 
number 274)

When Flash Rate is set to 0.00, you cannot change the 
pattern. In this state, adjusting H Size or V Size has no 
effect on the pattern.

For details of a pattern mix, see the next section.

For details of applying pattern modifiers, see “Setting 
Wipe Modifiers” (page 155).

Pattern Mix

You can create a new pattern by combining two selected 
patterns (main and “sub”).

It is not possible to apply a pattern mix to an independent 
key transition.

Types of pattern mix
There are four ways in which patterns can be combined in 
a pattern mix, as follows.
Mix: The effect of the sub pattern is applied to the main 

pattern, modifying the outline or nature of the main 
pattern.

Positive NAM (+Nam): Creates a pattern with an outline 
which contains all points within the outlines of either 
of the main pattern and the sub pattern.

Negative NAM (–Nam): Creates a pattern with an outline 
which contains all points within the outlines of both of 
the main pattern and the sub pattern. 

Knob Parameter Adjustment Setting values

1 No Number of 
points

3 to 64

2 Star Rate Angularity of 
star

–100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

1 H Tile No Number of tiles 
horizontally

2 to 36

2 V Tile No Number of tiles 
vertically

2 to 18

Knob Parameter Adjustment Setting values

1 Start Position of start 
tile

–100.00 to 
+100.00 a)

2 Row No Number of rows 
of tiles

1 to 36

3 Phase Delay for next 
row

–100.00 to 
+100.00 b)

Knob Parameter Adjustment Setting values

1 H Size Tile width 0.00 to 100.00

2 V Size Tile height 0.00 to 100.00

3 Volatility Rate of tile 
generation

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Size Particle width 0.00 to 100.00

2 V Size Particle height 0.00 to 100.00

3 Flash Rate Rate of 
generation of 
particles

0.00 to 100.00

Notes 

Notes 
153Basic Procedure for Wipe Settings



154

  C
hapter 5  W

ipes
Morphing: As the transition progresses, the pattern 
morphs from the main pattern, through the “mix” 
combination, to the sub pattern.

• Parameter settings
Start: Point in the course of the transition at which the 

main pattern is at 100%
End: Point in the course of the transition at which the 

sub pattern is at 100%
• A value of 0.00 corresponds to the beginning of the 

transition, and a value of 100.00 to the end of the 
transition.

• A negative Start value signifies that the main and sub 
patterns are already combined when the transition starts.

• An End value of 100.00 or more signifies that the main 
and sub patterns are still combined when the transition 
complete.

• If the Start and End values are the same, the main and 
sub patterns are interchanged instantaneously at the 
corresponding point in the transition.

• If End is less than Start, as the transition proceeds, it 
changes from the sub pattern to the main pattern.

Dust mix
You can apply the effect of a diamond dust wipe to a 
selected pattern. You can also apply the diamond dust wipe 
effect to the pattern resulting from a pattern mix (see page 
155). 
When the pattern mix function is off, turning dust mix on 
results in the main pattern and the diamond dust pattern 
being mixed. This state is the same as a pattern mix when 
the diamond dust pattern is selected for the sub pattern.

Main and sub modifier link function
When carrying out a pattern mix, it is possible to link the 
modifier settings for the main pattern and sub pattern. 
There are two modes for this function.

FULL LINK (fully linked) mode
In this mode, all modifier settings are the same for the main 
pattern and sub pattern.
Changing the modifier settings for one pattern 
automatically changes the settings for the other.

SEMI LINK (semi-linked) mode
Only the parameter settings of the modifiers are linked. 
The modifier on/off settings are not linked. When the 
parameter values for the modifiers of the main pattern and 
sub pattern are different, then after this link mode is 
selected, changing the value of a parameter for one pattern 
changes the value of the parameter for the other pattern to 
maintain the same difference between the two.

 

When carrying out a wipe transition using a pattern mix, it 
is recommended that you set the modifier link function to 
FULL LINK mode.
If the link function is off, or SEMI LINK mode is selected, 
the desired effect may not be obtained at the start or end of 
the transition.

Combining two patterns
Select a main pattern in the Main Pattern menu, then use 
the following procedure.

1 In the M/E-1 >Wipe menu, select HF3 ‘Sub Pattern.’

The Sub Pattern menu appears.

Mix Positive NAM Negative NAM

1

Main pattern at 100%

1 Mix combination of main and sub patterns already begun
2 Mix ends during transition, which ends with sub pattern at 

100%
3 Begins with main pattern at 100%
4 Ends with sub pattern at 100%
5 Mix begins after transition starts
6 Transition ends with main and sub patterns still in mix 

combination

Transition 
(0.00 - 100.00)

Start value End value

Sub pattern at 100%

2

3 4

5 6

Notes 
Basic Procedure for Wipe Settings
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2 In the same way as for the main pattern, select the sub 
pattern.

The patterns that can be selected for the sub pattern 
depend on the pattern selected for the main pattern (see 
the following table).

3 Select HF2 ‘Pattern Mix.’

The Pattern Mix menu appears.

4 In the <Pattern Mix> group, select the type of pattern 
mix (see page 153).

Mix: mix
+Nam: positive Nam
–Nam: negative Nam
Morphing: morphing

5 Depending on the selection in step 4, set the following 
parameters.

When mix, positive Nam, or negative Nam is 
selected

When morphing (see page 154) is selected

6 In the <Main/Sub Link> group, make the main/sub 
modifier link function settings (see page 154). 

Full: fully linked mode
Semi: semi-linked mode

Applying the effect of a diamond dust wipe 
to the selected pattern (Dust mix)

1 In the Pattern Mix menu, press [Dust Mix], turning it 
on.

2 Set the following parameters as required.

You can also apply the dust mix function to the pattern 
generated by a pattern mix.

When a random/diamond dust wipe (pattern numbers 
270-274) is selected, the dust mix function is not 
available.

Setting Wipe Modifiers

You can apply various modifiers to the wipe pattern: 
setting the wipe direction, pattern position, and so on.
Note that the available modifiers may depend on the 
pattern you are using (see page 163). 

Main pattern and sub pattern modifiers
You can make independent settings of the modifiers for the 
main pattern and sub pattern.
• To set the modifiers for the main pattern, in the M/E-1 

>Wipe menu, select HF5 ‘Main Modify,’ and make the 
settings in the Main Modify menu.

• To set the modifiers for the sub pattern, select HF6 ‘Sub 
Modify,’ and make the settings in the Sub Modify menu.

Operations in the Main Modify menu and Sub Modify 
menu are the same.

Independently set modifiers for the main pattern 
and sub pattern
• Positioner
• Rotation
• Aspect ratio
• Pattern replication (MULTI)
• Pairing

Yes: Combination possible No: Combination not possible

Main 
pattern

Sub pattern

Standard Enhanced Rotary Mosaic Random/
diamond 
dust 

Standard Yes Yes No Yes Yes

Enhanced Yes Yes No Yes Yes

Rotary No No No No No

Mosaic Yes Yes No No Yes

Random/
diamond 
dust

Yes Yes No Yes No

Knob Parameter Adjustment Setting values

1 Mix Ratio Proportion of 
sub pattern to 
the main pattern

0.00 to 100.00

Knob Parameter Adjustment Setting values

2 Start Point in 
transition at 
which main 
pattern is at 
100%

–50.00 to 
+150.00

3 End Point in 
transition at 
which sub 
pattern is at 
100%

–50.00 to 
+150.00

Knob Parameter Adjustment Setting values

1 Mix Ratio Proportion of 
diamond dust 
pattern in mix

0.00 to 100.00

2 H Size Particle width 0.00 to 100.00

3 V Size Particle height 0.00 to 100.00

4 Flash Rate Rate of 
generation of 
particles

0.00 to 100.00

Notes 
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• Modulation
• Spring
• Spiral
The following sections show examples of modifying the 
main pattern.

Specifying the wipe direction (Direction)
You can specify the direction of the wipe: the regular 
direction is referred to as “normal,” and the other direction 
as “reverse.” You can also select alternating directions 
each time the transition is completed (normal/reverse 
mode).

To specify the wipe direction in a menu

1 In the M/E-1 >Wipe menu, select HF4 ‘Edge/
Direction.’

The Edge/Direction menu appears.

2 In the <Direction> group, specify the wipe direction.

Normal: regular direction
Normal/Reverse: alternate between regular and 

reverse for each transition
Reverse: reverse direction to normal

To specify the wipe direction with a button in the 
transition control block
In the transition control block of each of the M/E-1 to M/
E-3 and PGM/PST banks, press the following direction 
selection buttons.
NORM: Normal
NORM/REV: Normal/reverse
REV: Reverse

Splitting the wipe pattern (Split)
This splits the pattern, making the parts of the wipe move 
in opposite directions.

The parameter Split No specifies the number of splits.
The parameter Spacing specifies the spacing between 
adjacent patterns.

1 In the M/E-1 >Wipe menu, select HF4 ‘Edge/
Direction.’

The Edge/Direction menu appears.

2 Press [Split], turning it on.

3 Set the following parameters.

Modifying the wipe pattern edge (Edge)
You can apply a border to the pattern, soften the edges, or 
soften the applied border.

Border: You can adjust the border width.
Soft: You can adjust the edge softness.
Soft border: You can adjust the border width, and the 

softness of the inner and outer edges of the border.
When a border or soft border is selected, the signal filling 
the border is called edge fill. For the edge fill, you can use 
a matte generated by the dedicated color matte generator, 
or the signal selected on the utility 2 bus. A matte can 
include color 1 and color 2, and a combination of the two 
colors (a “color mix”).

1 In the M/E-1 >Wipe menu, select HF4 ‘Edge/
Direction.’

The Edge/Direction menu appears.

2 In the <Edge> group, select the edge type.

Normal Reverse

Split OnSplit Off

Knob Parameter Adjustment Setting values

1 Split No Number of splits 1 to 4 (integer)

2 Spacing Spacing 
between 
adjacent 
patterns

0.00 to 100.00

Border Soft

Soft border
Basic Procedure for Wipe Settings
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Border: border
Soft: soft edge
Soft Border: soft border

3 Set the parameters according to the selection in step 2.

When border is selected

When soft edge is selected

When soft border is selected

4 When you selected border or soft border, select the 
edge fill signal in the <Edge Fill> group.

Utility 2 Bus: signal selected on the utility 2 bus
Matte: signal from the dedicated color matte 

generator

5 Depending on the operation in step 4, carry out the 
following operation.

When ‘Utility 2 Bus’ is selected: Hold down the 
[UTIL] button in the cross-point control block, 
and select the signal on the background B bus.
While the [UTIL] button is held down, the 
background B bus changes to the utility 2 bus.

To enable the [UTIL] button, its operation mode 
must be set to [Hold] beforehand. 

For details, see “Setting the Button Operation 
Mode” in Chapter 19 (Volume 2).

When ‘Matte’ is selected: In the same Edge/
Direction menu, press [Matte Adjust] to display 
the Matte Adjust menu, then adjust the single-
color or two-color combination color matte. Select 
whether to use a single-color matte or a two-color 
combination in the <Edge Matte> group.

Flat Color: Adjust color 1 with the following 
parameters.

When you select [Mix Color] for a two-color 
combination, see the next paragraph.

Carrying out a color mix for the edge fill 
matte
When you selected [Matte] for the border or soft border 
edge fill, you can combine color 1 and color 2.
For the combination, you can use not only a normal wipe 
generator pattern, but also the dedicated color mix pattern.

1 In the <Edge Fill> group of the Edge/Direction menu, 
select [Matte], and press [Matte Adjust].

The Matte Adjust menu appears.

2 In the <Edge Matte> group, select [Mix Color], 
turning it on.

3 In the <Mix Pattern> group, make one of the following 
selections.

Wipe: Use the wipe pattern selected for the transition.
Pattern: Use the dedicated pattern.

4 Depending on the selection in step 3, set the following 
parameters.

When Wipe is selected

When Pattern is selected

a) The patterns are the same as for a standard wipe. See “Wipe Pattern 
List” (page 344).

If you selected Pattern, you can also carry out the 
pattern selection by pressing the [Mix Ptn Select] 
button in the Matte Adjust menu, to display the Mix 
Ptn Select menu. Select any pattern appearing in the 
Mix Ptn Select menu (wipe patterns 1 to 24) by 
pressing the appropriate button, and you can then 
adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

2 Inner Soft Border inner 
softness

0.00 to 100.00

3 Outer Soft Border outer 
softness

0.00 to 100.00

Notes 

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

3 Pattern Pattern number 1 to 24 a)

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

Knob Parameter Adjustment Setting values
157Basic Procedure for Wipe Settings
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5 If you selected Pattern in step 4, if required, the 
following modifiers can be added. After selecting a 
wipe mix, skip to step 6.

When turning [Position] on and setting the pattern 
position

a) See page 158.

When turning [Multi] on and using replications of 
the same pattern

a) See page 160.

When turning [Aspect] on and setting the aspect 
ratio of the pattern

a) See page 160.

When turning [Angle] on in the <Rotation> group 
and slanting the pattern

a) See page 159.

When turning [Speed] on in the <Rotation> group 
and rotating the pattern at a constant rate

a) See page 159.

6 To adjust color 1, set [Color 1] on, and to adjust color 
2 set [Color 2] on, then adjust the parameters.

7 To interchange color 1 and color 2, press the [Color 
Invert] button, turning it on.

Setting the wipe position (Positioner)
When you turn on this function, you can move the wipe 
pattern to any position.

• The parameter H Position controls the horizontal 
position of the pattern.
A negative value moves the pattern to the left, and a 
positive value moves the pattern to the right.

• The parameter V Position controls the vertical position 
of the pattern. 
A negative value moves the pattern down, and a positive 
value moves the pattern up.

You can set the position independently for the main pattern 
and sub pattern.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Position> group, press [Position], turning it on, 
and set the pattern position.

To return the pattern position to the center of the 
screen
In the <Position> group, press [Center].

To move the pattern from its current position to 
the center through the course of a transition
In the <Position> group, press [Auto Center], turning it on.

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal 
position

–200.00 to 
+200.00 a)

2 Position V Vertical position –200.00 to 
+200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of 
repetitions of 
pattern 
horizontally

1 to 63

2 V Multi Number of 
repetitions of 
pattern 
vertically

1 to 63

3 Invert Type Replication 
layout

1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern 
rotation

–100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of 
pattern

–100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal 
position

–200.00 to 
+200.00

2 Position V Vertical position –200.00 to 
+200.00

Positioner OnPositioner Off
Basic Procedure for Wipe Settings
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To set the wipe position using the trackball or 
joystick
You can also set the wipe position using the trackball or 
joystick in the device control block. 

1 In the device control block, press the [M/E1], [M/E2], 
[M/E3], [M/E4], or [P/P] button, turning it on.

The [M/E4] button requires a previous assignment in 
the Setup menu.
The buttons in the device control block are assigned to 
the wipe position setting as follows.

2 Press the [MAIN] button or [SUB] button, turning it 
on.

3 Press the [POS] button, turning Position on.

4 Move the trackball or joystick, to set the wipe position. 
By pressing the [X] button, turning it on, you can 
restrict movement to the horizontal direction, and by 
pressing the [Y] button, turning it on, you can restrict 
movement to the vertical direction. 

Rotating the wipe pattern (Rotation)
You can rotate the pattern. There are three rotation modes, 
as follows.

Angle
This carries out a wipe with the pattern in a fixed angle.

The parameter Angle determines the angle of pattern 
rotation. 
• A value of –100.00 of the parameter Angle corresponds 

to one whole turn counterclockwise.
• A value of +100.00 corresponds to one whole turn 

clockwise.
• With a value of 0.00 there is no rotation.

Speed
Through the course of the transition the wipe pattern 
rotates at a fixed specified speed.

The parameter Speed determines the speed of pattern 
rotation. 
• A value of –100.00 of the parameter Speed corresponds 

to one turn per second counterclockwise.
• A value of +100.00 corresponds to one turn per second 

clockwise. 
• With a value of 0.00 the pattern is stationary.

Magnitude
Through the course of the transition the wipe pattern 
rotates through the specified angle. 

The parameter Angle determines an angle of pattern 
inclination at the beginning of the transition.
• A value of –100.00 corresponds to the angle rotated one 

whole turn counterclockwise.
• A value of +100.00 corresponds to the angle rotated one 

whole turn clockwise.
• With a value of 0.00 the pattern is stationary.
The parameter Magnitude determines an angle of pattern 
rotation through the course of the transition.
• A value of –200.00 corresponds to a rotation of two turns 

counterclockwise.
• A value of +200.00 corresponds to a rotation of two turns 

clockwise.
• With a value of 0.00 the pattern is stationary.

You can apply rotation independently to the main pattern 
and sub pattern.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Rotation> group, select the rotation type.

Notes 

Table 1: Buttons and assigned settings

Button name Setting

MAIN Wipe position for common transition 
(main pattern)

SUB Wipe position for common transition 
(sub pattern)

Table 2: Buttons assigned to functions

Button name Function

POS Toggle Position on or off.

X, Y Fix the operating direction.

CTR Return the pattern position to the 
center of the screen.

Angle Off Angle On
159Basic Procedure for Wipe Settings
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Angle: Incline the pattern through a fixed angle.
Speed: Rotate at a fixed rate.
Magnitude: Rotate through a particular angle during 

the course of the transition.

3 According to the selection in step 2, set the following 
parameters.

When Angle is selected

When Speed is selected

When Magnitude is selected

Setting the wipe pattern aspect ratio 
(Aspect ratio)
You can freely change the aspect ratio of the pattern.

A negative value of the parameter Aspect stretches the 
pattern vertically; a positive value stretches the pattern 
horizontally.
You can set the aspect ratio independently for the main 
pattern and sub pattern.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press [Aspect], turning it on.

3 Set the following parameter.

Setting the wipe pattern replication (Multi)
The same pattern can be repeated horizontally and 
vertically or both, up to 63 times. You can also change the 
orientation of alternate copies, or change the position.

• The parameter H Multi determines the number of pattern 
replications horizontally, and the parameter V Multi 
determines the number of pattern replications vertically.

• The parameter Shift determines the manner of 
replication.
At a value of –100.00, the pattern of the adjacent odd-
numbered column on the left lines up with the central 
coordinate horizontally.
At a value of +100.00, the pattern of the adjacent odd-
numbered column on the right lines up with the central 
coordinate horizontally.

For an independent key transition wipe, you can use the 
“Invert Type” parameter to select from the following four 
types of replication pattern.

1: All replications in the same orientation
2: Even-numbered rows staggered
3: Even-numbered columns and rows inverted
4: Even-numbered columns and rows inverted, and even-

numbered rows staggered

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern 
rotation

–100.00 to 
+100.00

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of 
pattern

–100.00 to 
+100.00

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern 
rotation at start 
of transition

–100.00 to 
+100.00

2 Magnitude Angle of 
rotation through 
course of 
transition

–200.00 to 
+200.00

Aspect Off Aspect On

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to 
+100.00

Multi Off Multi On
Basic Procedure for Wipe Settings
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You can set pattern replication independently for the main 
pattern and sub pattern.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press the [Multi] button, turning it on.

3 Set the following parameters.

4 To make more adjustments, press the [Multi Adjust] 
button.

The Multi Adjust menu appears.

5 Make the following settings, as required.

H Invert: When this is on, alternate tiles are inverted 
left-to-right.

V Invert: When this is on, alternate tiles are inverted 
top-to-bottom.

Non-Mask: When this is on, even if the positioner 
function is used to move the pattern position, the 
pattern is always present on the screen.

Position: By adjusting the following parameters, 
move the pattern position within the divisions 
determined in step 3.

a) See page 158.

Making a wipe pattern like a Venetian blind 
(Pairing)
This slits the pattern into multiple strips in the horizontal 
or vertical direction, making it like a venetian blind.

• The parameter Width determines the width of the slits.
• The parameter H Offset determines the spacing in the 

horizontal direction.
If a negative value is set, the even-numbered pairs of 
strip and slit move to the left, and the odd-numbered 
pairs move to the right. (The value –100.00 represents 
the maximum movement.)
If a positive value is set, the even-numbered pairs of strip 
and slit move to the right, and the odd-numbered pairs 
move to the left. (The value +100.00 represents the 
maximum movement.)

• The parameter V Offset determines the spacing in the 
vertical direction.
If a negative value is set, the even-numbered pairs of 
strip and slit move upward, and the odd-numbered pairs 
move downward. (The value –100.00 represents the 
maximum movement.)
If a positive value is set, the even-numbered pairs of strip 
and slit move downward, and the odd-numbered pairs 
move upward. (The value +100.00 represents the 
maximum movement.)

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 In the <Pairing> group, select the slit direction.

H: Create slits in the horizontal direction.
V: Create slits in the vertical direction.

3 Set the following parameters.

Applying modulation to the wipe pattern 
(Modulation)
The pattern signal can be modulated, giving waves on the 
horizontal or vertical edges, or radially. 

Knob Parameter Adjustment Setting values

1 H Multi Number of 
repetitions of 
pattern 
horizontally

1 to 63

2 V Multi Number of 
repetitions of 
pattern 
vertically

1 to 63

3 Shift Replication 
layout

–100.00 to 
+100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal 
position of 
pattern

–200.00 to 
+200.00 a)

2 Position V Vertical position 
of pattern

–200.00 to 
+200.00 a)

Knob Parameter Adjustment Setting values

1 Width Width of the 
slits

1 to 128 
(integer)

2 H Offset Spacing in the 
horizontal 
direction

–100.00 to 
+100.00

3 V Offset Spacing in the 
vertical direction

–100.00 to 
+100.00

Pairing Off Pairing On
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The parameter Shape determines the form of the 
modulation.
1: sine wave, 2: triangular wave, 3: rectangular wave

When using 1080PsF mode in an HD system, the 
modulation function is not available.

Horizontal modulation
This modulates the pattern, applying waviness in the 
horizontal direction to edges.

The parameter Speed determines the speed of waves.
A value of –100.00 generates the maximum downward 
speed of waves, and a value of +100.00 the maximum 
upward speed.

Vertical modulation
This modulates the pattern, applying waviness in the 
vertical direction to edges.

The parameter Speed determines the speed of waves.
A value of –100.00 generates the maximum leftward speed 
of waves, and a value of +100.00 the maximum rightward 
speed.

Fringe
This modulates the pattern, applying waviness in the radial 
direction to edges.

The parameter Speed determines the speed of waves. 
A value of –100.00 generates the maximum 
counterclockwise speed of waves, and a value of +100.00 
the maximum clockwise speed.
You can apply modulation independently to the main 
pattern and sub pattern.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Depending on the desired effect, in the <Modulation> 
group select one of the following.

H (Horizontal modulation): Modulate the pattern, 
applying waviness in the horizontal direction to 
edges.

V (Vertical modulation): Modulate the pattern, 
applying waviness in the vertical direction to 
edges.

Fringe (Radial modulation): Modulate the pattern, 
applying waviness in the radial direction to edges.

3 Set the following parameters.

Applying barrel or pincushion distortion to 
the edge of the wipe pattern (Spring)
As the transition progresses, the edge of the pattern is 
subjected to barrel or pincushion distortion.

A negative parameter value produces pincushion 
distortion, and a positive value produces barrel distortion.
You can set the spring function independently for the main 
and sub patterns.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press [Spring], turning it on.

3 Set the following parameters.

Notes 

Knob Parameter Adjustment Setting values

1 Amplitude Amplitude of 
modulation

0.00 to 100.00

2 Frequency Frequency of 
modulation

0.00 to 100.00

3 Speed Speed of waves –100.00 to 
+100.00

4 Shape Form of the 
modulation

1 to 3

Knob Parameter Adjustment Setting values

1 Gain Degree of barrel 
distortion

–100.00 to 
+100.00

Spring Off Spring On
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Applying a spiral effect to the wipe pattern 
(Spiral)
This deforms the pattern spirally.

• The parameter Magnitude determines the size and 
direction of the spiral.
A value of –100.00 represents the maximum movement 
in the counterclockwise direction, and a value of 
+100.00 represents the maximum movement in the 
clockwise direction.

• The parameter Wave Speed determines the speed of the 
lateral waves.
A value of –100.00 represents the maximum speed to the 
left, and a value of +100.00 represents the maximum 
speed to the right.

You can set the spiral function independently for the main 
and sub patterns.

1 In the M/E-1 >Wipe menu, select HF5 ‘Main Modify.’

The Main Modify menu appears.

2 Press [Spiral], turning it on.

3 Set the following parameters.

Possible combinations of wipe patterns 
and modifiers

Yes: Can be used    No: Cannot be used

a) Not patterns 1 to 16, 19, and 20
b) Not patterns 300 to 303
c) Not patterns 100 to 103, 150, 151, 516, 518, 604, and 606
d) Not patterns 1 to 8, 17, and 18
e) Not patterns 220 to 223
f) Not patterns 19 and 20
g) But patterns 21, 23 and 24 are possible
h) But patterns 21 and 23 are possible

Wipe Modify Clear

Press [Default Recall] at the lower left of the menu display, 
turning it on, then press VF5 ‘Wipe’ to return the wipe 
settings to their initial status.

For details of the menu operation to return the wipe state 
to that set in initial status, see “Returning to Default State 
in Function Groupings” (page 75).

Knob Parameter Adjustment Setting values

1 Magnitude Size and 
direction of the 
spiral

–100.00 to 
+100.00

2 Wave 
Speed

Speed of the 
lateral waves

–100.00 to 
+100.00

Modifiers Type of wipe

Standard Enhanced Rotary Mosaic Random/
diamond 
dust

Direction Yes Yes Yes Yes Yes

Split Yes Yes No Yes No

Edge Yes Yes Yes Yes Yes

Positioner Yes a) Yes b) Yes c) No No

Rotation Yes Yes Yes c) No No

Spiral Off Spiral On

Aspect 
ratio

Yes d) Yes No No No

Pattern 
replication

Yes Yes Yes Yes e) No

Pairing Yes f) Yes No No No

Modulation
(H/V)

Yes Yes Yes No No

Modulation 
(Fringe)

No g) Yes No No No

Spring No g) Yes No No No

Spiral No h) Yes No No No

Modifiers Type of wipe

Standard Enhanced Rotary Mosaic Random/
diamond 
dust
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Wipe Settings for 
Independent Key 
Transitions

You carry out independent key transition wipe setting 
operations using the Wipe Adjust menu for each keyer.
This section describes the independent key transition wipe 
settings, taking the M/E-1 >Key1 >Transition >Wipe 
Adjust menu as an example.

For details, see “Independent Key Transitions” (page 
102).

Basic Procedure for Independent 
Key Transition Wipe Settings

Accessing the independent key transition 
wipe settings menu
As an example, to access the M/E-1 >Key1 >Transition 
>Wipe Adjust menu, carry out the following operations.
• In the menu control block, select the top menu selection 

button [M/E 1] and select VF1 ‘Key1’ and HF6 
‘Transition’ to display the Transition menu for key 1, 
then press [Wipe Adjust].

• If VF1 [Key5] is shown, press the switching button at the 
top of the menu, so that [Key1-4] appears, and press VF1 
[Key1].

To select [M/E-4], a previous assignment in the Setup 
menu is required.

• In the independent key transition control block of the M/
E-1 bank, press the key delegation button [KEY1], then 
press the independent key transition type selection 
button [WIPE] twice in rapid succession.

Carrying out the above operation displays the M/E-1 
>Key1 >Transition >Wipe Adjust menu (which will be 
referred to below as simply the Key1 Wipe Adjust menu).

Selecting the independent key transition 
wipe pattern
You select the independent key wipe pattern from the list 
of patterns displayed in the menu.

 

In an independent key transition, you can only use the 
standard wipe patterns (pattern numbers 1 to 24).
To select a wipe pattern for independent key1 on the M/E-
1 bank, use the following procedure.

1 In the Key1 Wipe Adjust menu, select [Pattern Select].

The Pattern Select menu appears.

2 Press the button for the desired pattern.

Setting Independent Key Transition 
Wipe Modifiers

Available modifiers
You can use the following modifiers with an independent 
key transition wipe.
Note that the available modifiers may depend on the 
pattern you are using.
• Direction
• Edge
• Positioner
• Rotation
• Aspect ratio
• Pattern replication

Setting the wipe direction (Direction)
In the <Direction> group of the Key1 Wipe Adjust menu, 
make any of the following selections.
Normal: regular direction
Normal/Reverse: alternate between regular and reverse 

for each transition
Reverse: reverse direction to normal

Softening the wipe pattern edge (Soft 
edge)

1 Press [Soft] in the Key1 Wipe Adjust menu, turning it 
on.

2 Set the following parameter.

Setting the wipe position (Positioner)
There are two methods of setting the wipe position: using 
the device control block, or in a menu.

Notes 

Notes 

Knob Parameter Adjustment Setting values

1 Soft Edge softness 0.00 to 100.00
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To set the wipe position using the trackball or 
joystick
You can also set the wipe position using the trackball or 
joystick in the device control block.

1 In the device control block, press the [M/E1], [M/E2], 
[M/E3], [M/E4], or [P/P] button, turning it on.

The [M/E4] button requires a previous assignment in 
the Setup menu.
The buttons in the device control block are assigned to 
the wipe position setting as follows.

2 Press one of the buttons in Table 1 above, to select the 
wipe position to which the operation applies. Multiple 
selection is possible.

By setting the operation mode in setup, you can also 
use [K1 CB1], [K2 CB2], [K3], and [K4] to select keys 
5 to 8. In this case, press [SHIFT], turning it on, then 
press [K1 CB1], [K2 CB2], [K3], or [K4] to select one 
of keys 5 to 8. However, it is not possible to select 
more than one key.

For details of assignment for keys 5 to 8, see 
“Assigning Buttons for Selection of Keys 5 to 8 in the 
Setup Menu” in the Appendix (page 381).

3 Press the [POS] button, turning Position on.

4 Move the trackball or joystick, to set the wipe position. 
By pressing the [X] button, turning it on, you can 
restrict movement to the horizontal direction, and by 
pressing the [Y] button, turning it on, you can restrict 
movement to the vertical direction. 

To set the wipe position by a menu operation

1 Press [Position] in the Key1 Wipe Adjust menu, 
turning it on.

2 Set the following parameters.

a) See page 158.

To move the pattern from its current position to 
the center through the course of a transition
Press [Auto Center] in the <Position> group, turning it on.

Rotating the wipe pattern (Rotation)

1 In the <Rotation> group of the Key1 Wipe Adjust 
menu, select the rotation type.

Angle: Incline the pattern through a fixed angle.
Speed: Rotate at a speed rate.
Magnitude: Rotate the pattern through a fixed angle 

during the course of the transition.

2 According to the selection in step 1, set the following 
parameters.

When Angle is selected

a) See page 159.

When Speed is selected

a) See page 159.

When Magnitude is selected

a)See page 159.

Notes 

Table 1: Buttons and assigned settings

Button name Setting

K1 CB1 Wipe position for independent key 1 
transition

K2 CB2 Wipe position for independent key 2 
transition

K3 Wipe position for independent key 3 
transition

K4 Wipe position for independent key 4 
transition

Table 2: Buttons assigned to functions

Button name Function

POS Toggle Position on or off.

X, Y Fix the operating direction.

CTR Return the pattern position to the 
center of the screen.

Notes 

Knob Parameter Adjustment Setting values

1 Position H Horizontal 
position

–200.00 to 
+200.00 a)

2 Position V Vertical position –200.00 to 
+200.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern 
rotation

–100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of 
pattern

–100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern 
rotation at start 
of transition

–100.00 to 
+100.00 a)

2 Magnitude Angle of 
rotation through 
course of 
transition

–200.00 to 
+200.00 a)
165Wipe Settings for Independent Key Transitions
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Setting the wipe pattern aspect ratio 
(Aspect ratio)

1 Press [Aspect] in the Key1 Wipe Adjust menu, turning 
it on.

2 Set the following parameter.

a)See page 160.

Replicating the wipe pattern (Multi)

1 Press [Multi] in the Key1 Wipe Adjust menu, turning 
it on.

2 Set the following parameters.

a)See page 160.

Wipe Snapshots

You can snapshot and save a wipe pattern together with the 
current settings of its modifiers and pattern limit in a 
dedicated register for recall when required.
There are 10 wipe snapshot registers on each M/E bank 
and the PGM/PST bank. 
Use the Flexi Pad control block, the Multifunction Flexi 
Pad block in each switcher bank or the Menu control block 
to save and recall wipe snapshots. 
For simple transitions (see page 109), there are eight wipe 
snapshot registers on each M/E bank and the PGM/PST 
bank.

Wipe Snapshot Operations With the 
Flexi Pad

Flexi Pad control block (standard type)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of 
repetitions of 
pattern 
horizontally

1 to 63

2 V Multi Number of 
repetitions of 
pattern 
vertically

1 to 63

3 Invert Type Replication 
layout

1 to 4 a)

WIPE button STORE STATS 
button

UNDO button

Numeric display

Memory recall buttons
Wipe Snapshots
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Flexi Pad control block (simple type)

Selecting a wipe pattern in the Flexi Pad 
control block
To select a pattern with a standard type Flexi Pad control 
block, use the following procedure. (It is not possible to 
select a wipe pattern with a simple type Flexi Pad control 
block.)

1 In the M/E-1 Flexi Pad control block, press the 
[WIPE] button.

This switches the Flexi Pad control block to wipe 
snapshot mode.

2 In the memory recall section, press the [PTN NO] 
button.

This switches the Flexi Pad control block to wipe 
pattern number recall mode.

3 Use the buttons in the memory recall section to enter 
the pattern number consisting of up to three digits, and 
press the [ENTR] button.

The entry is confirmed, and now the numeric display 
shows the pattern number (see page 344).

Saving a wipe snapshot

1 Make the wipe settings that you want to save.

Make any modifier settings required (see page 155).

2 In the Flexi Pad control block, hold down the [WIPE] 
button, and press the memory recall button 
corresponding to the register in which you want to 
save.

• If you press a button which is lit orange or yellow, 
the existing contents of the register are overwritten.

• If you carry out a pattern mix, and both the main 
pattern and sub pattern are selected, then the 
memory recall button shows the main pattern.

The pattern appears on the button you pressed, which 
lights yellow.
The numeric display shows the number of the 
corresponding pattern.
It is also possible to display the register name using a 
Setup menu.

For details, see “Operation Settings (Operation 
Menu)” in Chapter 19 (Volume 2).

Meaning of the state of buttons
Off: Nothing is saved in the register.
Lit orange: Settings are saved in the register.
Lit yellow: The most recently recalled register.

Canceling the saving of a wipe snapshot
To cancel the saving of a wipe snapshot immediately after 
performing it, hold down the [STORE STATS] button, and 
press the [UNDO] button. 
The [STORE STATS] button changes from amber to 
green.

On a simple type Flexi Pad control block, it is not possible 
to cancel the saving of a wipe snapshot.

Recalling a wipe snapshot

1 In the Flexi Pad control block, press the [WIPE] 
button.

This switches the Flexi Pad control block to the wipe 
snapshot mode.

2 Press the memory recall button for the register from 
which you want to recall the wipe snapshot.

The button lights, and the saved wipe snapshot is 
recalled. At this point, the numeric display shows the 
pattern number or register name.

Canceling the recall of a wipe snapshot
To cancel the recall of a wipe snapshot, press the [UNDO] 
button.

Deleting a wipe snapshot
When the [WIPE] button is lit in the Flexi Pad control 
block, hold down the [STORE STATS] button and press 
the memory recall button for the register in which you 
want to delete the wipe snapshot.

Notes 

WIPE button

Numeric 
display

UNDO button

Memory 
recall buttons

Notes 
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The indication of the memory recall button reverts from 
the wipe pattern or register name to the register number.

In a simple type Flexi Pad control block, it is not possible 
to delete a wipe snapshot.

Wipe Snapshot Operations With the 
Menus

Menus used
As an example, when operating on M/E-1, select M/E-1 
>Wipe >Wipe Snapshot.
The Wipe Snapshot menu appears.

Button displays
In setup you can select whether the memory recall buttons 
show the pattern number or register name.

For details, see “Operation Settings (Operation Menu)” 
in Chapter 19 (Volume 2).

Saving a wipe snapshot from the menu

1 Set up the wipe you want to save.

2 In the Wipe Snapshot menu, press [Store], lighting it 
amber.

3 Press the memory recall button for the register in 
which you want to save.

• If you press a button which is already lit, this overwrites 
the contents of the register.

• When both the main pattern and sub pattern are selected 
for a pattern mix, the button in the memory recall section 
shows only the main pattern.

Recalling a wipe snapshot from the menu
In the Wipe Snapshot menu, press the memory recall 
button for the wipe snapshot you want to recall.
This recalls the wipe snapshot, and the button you pressed 
lights amber.
In the upper left is shown the currently recalled register 
name or number.

The Flexi Pad and menu settings are linked.
A setting in setup determines whether register names or 
pattern numbers appear.

Deleting a wipe snapshot from the menu

1 In the Wipe Snapshot menu, press [Delete].

2 Press the memory recall button for the wipe snapshot 
you want to delete.

Notes 

Notes 

Memory recall buttons

Notes 
Wipe Snapshots
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Wipe Pattern Operations 
in the Multifunction Flexi 
Pad Control Block

Recalling a Wipe Snapshot

You can recall a wipe snapshot in the Multifunction Flexi 
Pad control block.
To recall a wipe snapshot, use the operations shown in the 
following illustration.

1 In the Multifunction Flexi Pad control block, press the 
[WIPE] button.

This sets the Multifunction Flexi Pad control block to 
wipe snapshot mode, and the button indications appear 
as follows.

You can change the indications for buttons [0] to [9] in 
the memory recall section to pattern images, using the 
Engineering Setup >Panel >Operation >Flexi Pad 
Mode menu.

2 Select the region for the wipe snapshot to be recalled 
with the region selection buttons.

3 Press the numeric button (lit orange) in the memory 
recall section corresponding to the register in which 
the desired wipe snapshot is stored.

The button you pressed lights yellow, and this recalls 
the saved wipe snapshot.
At this point the numeric display shows the register 
name or pattern number for the pattern.

Selecting the Wipe Pattern

1 Press the [WIPE] button, and select the region with the 
region selection buttons.

The [M/E4] button requires a previous assignment in 
the Setup menu (see page 380).

2 Press the [PTN NO.] button in the memory recall 
section.

The [PTN No.] button lights green.

3 With the buttons in the memory recall section, enter 
the pattern number of up to three digits, and press the 
[ENTR] button.

This confirms the input, and the pattern number (see 
page 344) appears in the alphanumeric display.
The [PTN NO.] button lights orange, and the system 
returns to wipe snapshot mode.

Editing the Wipe Pattern

By pressing the [EDIT ENBL] button to switch the 
memory recall section to editing mode as shown in the 
following illustration, you can edit the selected wipe 
pattern with the following buttons.
To exit from the editing mode, press the [EDIT ENBL] 
button once more, or press the [EXIT] button.

Wipe pattern edge setting buttons
BDR (border): Applies a border to the wipe pattern.
SOFT BDR (soft border): Softens the applied border.
SOFT (soft edge): Softens the edge.
EDGE MAT (edge matte): Selects whether to fill the 

edge with a color matte, or insert an image from the 
utility bus. By default a color matte is selected.

You can adjust the parameters selected with these buttons 
using the control knobs, when the button is lit green.

WIPE button Alphanumeric display

Adjustment knobs

Region selection 
buttons

Memory recall section

Notes 
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When border is selected

When soft border is selected

When soft edge is selected

When edge matte is selected

Buttons for positioning the wipe pattern
POS (position): Adjusts the position of the wipe pattern.
CNTR (center): Returns the wipe pattern position to the 

center.
When you press the [POS] button, the alphanumeric 
display first shows the name of the parameter, “H” or “V,” 
and then the value of the parameter.
When the [POS] button is lit green, you can adjust the 
position of the wipe pattern with the control knobs.

Buttons for setting the wipe direction
NORM (normal): Sets wipe to normal (forward) 

direction.
NORM/REV (normal/reverse): Sets the wipe direction 

to alternate between normal and reverse for each 
transition.

REV (reverse): Sets wipe to reverse direction to normal.

Buttons for setting the wipe pattern limit
PTN LIMT (pattern limit): Enables the following 

settings for the pattern limit using the control knobs.
LIMT SET (limit set): If you change the pattern size with 

the fader lever then press this button, this sets the 
current size as the pattern limit.

a) At 0%, executing the transition has no effect at all.
b) At 100%, the transition can be executed with the same effect as with no 

pattern limit set, but when the transition completes, background buses A 
and B are not interchanged.

Other buttons
EXIT: Exits the editing mode, and returns the memory 

recall section to wipe snapshot mode.
KNOB 1/2: When the control knob adjustments are on two 

pages, this switches between parameter group [1/2] 
and parameter group [2/2].

Wipe modify clear
When the [WIPE] button is held down, holding down the 
region selection button for the selected region together 
returns all the wipe settings of the region to the initial 
status settings.

For details of the initial status, see “Saving User-Defined 
Settings” in Chapter 18 (Volume 2).

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 W Border width 0 to 100

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 L Luminance 0 to 100

2 S Saturation 0 to 100

3 H Hue 359 to 0

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 W Border width 0 to 100

2 I Degree of 
softening of 
inside of border

0 to 100

3 O Degree of 
softening of 
outside of 
border

0 to100

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 L Luminance 0 to 100

2 S Saturation 0 to 100

3 H Hue 359 to 0

Knob Parameter Adjustment Setting values

1 S Degree of 
softening of 
edge

0 to 100

Knob Parameter Adjustment Setting values

1 L Luminance 0 to 100

2 S Saturation 0 to 100

3 H Hue 359 to 0

Knob Parameter Adjustment Setting values

1 H Horizontal 
position

–200 to +200

2 V Vertical position –200 to +200

Knob Parameter Adjustment Setting values

1 P Pattern limit 
range

0 a) to +100 b) (%)
Wipe Pattern Operations in the Multifunction Flexi Pad Control Block
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Saving, Canceling, and Deleting 
Edited Wipe Patterns

Saving the edited wipe pattern as a 
snapshot
Holding down the [WIPE] button, press the button in the 
memory recall section for the register in which you want to 
save.
The button you pressed lights yellow.
Buttons for registers in which wipe snapshots are already 
saved light orange.

Canceling a saved wipe snapshot
Immediately after saving, hold down the [STOR STAT] 
button and press the [UNDO] button.
At other times, hold down the [STOR STAT] button, and 
press the button for the register in which the wipe snapshot 
you want to cancel is saved.
Buttons for registers in which wipe snapshots are already 
saved light orange.

Canceling recall of a wipe snapshot
To cancel the operation of recalling a wipe snapshot, press 
the [UNDO] button.

Deleting the data of a saved wipe snapshot
Holding down the [DEL] button, press the button for the 
register in which the wipe snapshot you want to delete is 
saved.
The register button you pressed goes off.
171Wipe Pattern Operations in the Multifunction Flexi Pad Control Block
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CDME Wipes
verview

 DME wipe is a wipe transition that uses a DME effect to 
ange from one video image to the next.

here are two types of DME wipe: those which can be 
lected for a normal transition, and those which can be 
lected for an independent key transition (see page 188).

It is also possible to carry out a DME wipe on a key using 
the resizer (see page 184).

ypes of DME Wipe Pattern

he patterns used for a DME wipe fall into two broad 
asses.
reset patterns: predetermined fixed patterns
ser programmable DME patterns: patterns which you 

can create using keyframe effects

ME wipe execution mode and pattern 
umbers that can be used
here are three DME wipe execution modes, depending on 
e number of DME channels available: one-channel 
ode, two-channel mode and three-channel mode. The 

attern numbers that can be used in these modes are as 
llows.

On the MVS-8000X, when the signal format is 1080P, 
the three-channel mode is not available.
On the MVS-7000X, when the signal format is 1080P, 
the above restriction also applies if using the MVE-

8000A. There is no such restriction for the MKS-7470X/
7471X.

DME wipe pattern groups
The patterns used in DME wipes fall into the following 
groups.

For each group (excluding user programmable DMEs), 
for schematic patterns and numbers, see “DME Wipe 
Pattern List” in Appendix (page 348).

Notes 

xecution mode Preset 
pattern 
numbers that 
can be used

User programmable 
DME pattern 
numbers that can 
be used

ne-channel mode 1000 series 1901 to 1999

wo-channel mode 2000 series 2901 to 2999

hree-channel mode 3000 series 3901 to 3999

otes 
Overview
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Effects Pattern numbers

One-channel 
mode

Two-channel 
mode

Three-channel 
mode

Slide The new video slides in over the old video. 1001 to 1008 2601 to 2608 —

Squeeze The new video appears squeezed over the old video, and 
progressively expands to cover it.

1021 to 1031 2621 to 2628 —

Split The old video splits, and the new video appears in the gap. 1011 to 1013 — —

Door The new video moves like a door closing, and progressively 
covers the old video.

10411048 — —

Flip tumble The old video rotates about an axis and is replaced by the 
new video. During the transition, the signal from the utility 2 
bus of the M/E bank appears as the background.

1101 to 1104, 
1109, 1110, 
1121, 1122, 
1124, 1131 to 
1133, 1135

— —

Mirror The new video appears over the old video as a mirror effect 
slides in all four directions.

1355 to 1358 — —

Sphere The new video appears wrapped around a sphere over the 
old video, then returns to the original video while 
unwrapping.

1365 — —

Character trail The new video appears with a trail over the old video. Next 
this gradually returns to the original from the periphery.

1371, 1372 — —

Wave The new video appears with a wave-like effect over the old 
video. Next this returns to the original video as the effect 
reduces.

1378, 1379 — —

Ripple The new video appears over the old video like outwardly 
moving ripples.

1381 — —

Page turn The old video moves like a page turning, and the new video 
appears behind it.

1301 to 1313, 
1315 to 1318, 
1341 to 1345

2701 to 2713, 
2715 to 2718, 
2741 to 2745

—

Page roll The new video unrolls like a scroll over the old video. This is 
a type of page turn.

1321 to 1333, 
1335 to 1338, 
1346 to 1350

2721 to 2733, 
2735 to 2738, 
2746 to 2750

—

Frame in-out Completed in two transitions. In the first transition, the new 
video appears, then on the second transition the new video 
goes out and the old video returns.

1201 to 1208, 
1221 to 1224

2851 to 2854, 
2861 to 2864

—

Picture-in-
picture

• In one-channel mode, this completes in two transitions.
- In the first transition, the old video shrinks, and the new 

video appears behind it.
- In the second transition, the old video expands again 

until it is its original size.
• In two-channel mode, in the first half of the transition, the 

old video shrinks, and the new video appears.
- In the second half of the transition, the new video 

expands, and the old video disappears. 
- You can move the pattern from the current position by a 

relative amount.
- During the transition, the signal from the utility 2 bus of 

the M/E bank appears as the background.

1251 2651 to 2652 —

2D trans The new video appears over the old video, while 
undergoing expansion, two-dimensional rotation and 
translation.

1051 to 1058, 
1061 to 1064, 
1068

— —

3D trans • In one-channel mode, the new video appears over the old 
video, while undergoing expansion, three-dimensional 
rotation and translation.

• In two-channel mode, the old video changes to the new 
video while both undergo expansion, three-dimensional 
rotation and translation.

1071, 1072, 
1074, 1076, 
1077, 1088, 
1091 to 1094

2631 to 2634, 
2642, 2644

—
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In an independent key transition, the following patterns 
can be used.

DME Wipe Pattern Variation and 
Modifiers

You can modify the selected DME wipe pattern in the 
same way as an ordinary wipe pattern, as follows.

For the setting operations, see “Setting DME Wipe 
Modifiers” (page 178).

Direction: You can set the DME wipe direction to normal, 
reverse, or alternating normal/reverse (see page 178), 
except for a key transition, which is always in normal/
reverse mode. However, a key transition can only be 
specified when the following patterns are selected, and 

when other patterns are selected, this is fixed, as 
normal/reverse.
Patterns: 1204, 1207, 1221 to 1224

Edge: You can apply a border or soft border (see page 
178). 
In the case of those user programmable DME patterns 
for keys in which an edge has already been applied to 
the effect, the behavior is as follows.
• When the DME wipe edge setting is on, only part of 

the edge applied in the effect is enabled, and that 
portion can be adjusted (see page 178).

• When the DME wipe edge setting is off, the edge 
applied in the effect is enabled as is.

Positioner: You can move the DME wipe pattern or center 
of the effect to an arbitrary position. Using the position 
select function, you can also instantaneously move the 
pattern.
• 1031

When this pattern number is selected, with the 
progress of the transition the pattern center 
automatically moves initially from the set position 
toward the center of the screen (see page 178). In 
other words, the effect obtained is the same as in a 
normal wipe with the positioner set to “AUTO 
CENTER”.

• 1201 to 1208, 1221 to 1224, 1251
When these pattern numbers are selected, you can 

Sparkle The new video appears over the old video with a nonlinear 
effect applied, such as broken glass, explosion, or melt. 
Next this returns to the original video as the effect gradually 
reduces.

1391, 1393, 
1394, 1396, 
1398, 1399

— —

Split slide The new video appears in strip form while sliding 
interleaved in the opposite direction over the old video.

1384 to 1389 — —

Mosaic In the first half of the transition, a mosaic is gradually 
applied to the old video, then at the 50% point the inner 
image changes to the new video. In the second half, the 
mosaic effect on the new video is gradually reduced, 
returning to the original image at 100%.

1701 — —

Defocus In the first half of the transition, the old video is gradually 
defocused, then at the 50% point the inner image changes 
to the new video. In the second half, the defocusing effect 
on the new video is gradually reduced, returning to the 
original image at 100%.

1702 — —

Brick • In two-channel mode, a brick such that the side surface is 
visible slides in over the old video, then rotates so that the 
new video can be seen.

• In three-channel mode, a brick appears over the old video 
as the image is expanding and rotating, and switches to 
the new video.

— 2801 to 2804, 
2811 to 2814

3601

User 
programmable 
DME

Using a DME keyframe effect created with a keyframe 
operation, this executes a DME wipe.

For details of creating keyframe effects, see “Creating User 
Programmable DME Patterns” (page 186).

1901 to 1999 2901 to 2999 3901 to 3999

Pattern 
groups

Effects Pattern numbers

One-channel 
mode

Two-channel 
mode

Three-channel 
mode

Notes 

Execution mode DME wipe patterns that can be used

One-channel mode Slide, split, squeeze, door, 2D trans, 3D 
trans, frame in-out, page turn, page roll, 
mirror, sphere, character trail, wave, 
ripple, split slide, sparkle, user 
programmable DME

Two-channel mode Page turn, page roll
Overview
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set the pattern position when the first transition 
completes.

• 1381, 1391, 1393, 1394, 1396
When these pattern numbers are selected, you can 
set the center of the transition effect.

• 2651, 2652
When these pattern numbers are selected, you can 
move the pattern for each channel, or with values 
relative to the current position the two channels 
simultaneously.

• 2801 to 2804, 2811 to 2814
When the these pattern numbers are selected, you 
can set the vertical position as the brick slides in.

• 2851 to 2854, 2861 to 2864
When these pattern numbers are selected, you can 
set the pattern position for each channel setting when 
the first transition completes.

Pattern limit: You can restrict the range of the transition 
as desired. However, this is not available for a DME 
wipe in the independent key transition control block. 

For more details, see “Pattern Limit” (page 97).

Size: This can only be used when one of the following 
pattern numbers is selected.
• 1201 to 1208, 1221 to 1224, 1251
• 2651, 2652, 2851 to 2854, 2861 to 2864
You can set the size of the image.

Crop: You can crop the image. It is also possible in 16:9 
mode to crop both sides, to convert the image to a 4:3 
aspect ratio. For the execution of a DME wipe crop 
transition, you can select from the following three 
possibilities.
• Cut
• Last 5%
• Linear
When [Last 5%] is selected, you can set the [Release 
Transition] as follows. 
• Last 30%
• Last 5%
• Off

When pattern numbers 1701 and 1702 are selected, 
crop cannot be used.

Relation Between DME Wipes and 
Other Effects

The relations between DME wipes and other effects are as 
follows.

Relation to ordinary wipes
• DME wipes do not use the wipe generator built into the 

switcher. Therefore, during the execution of a DME 

wipe, you can still use a pattern produced by the wipe 
generator as the source for a pattern key or mask.

• A DME wipe pattern cannot be used as the source for a 
pattern key or mask.

Relation to processed keys
When using the DME for a processed key, if you select a 
DME wipe, an available DME is automatically allocated to 
the DME wipe. If all of the DME channels are in use, then 
it is not possible to select a DME wipe.
If in a Setup menu a setting has been made for DME 
allocation, that Setup menu setting takes precedence. 

For details, see “Setting the assignments of DME channels 
to use on the individual M/E banks” in Chapter 20 
(Volume 2).

Relation to resizer
When resizer is enabled, it is not possible to select a DME 
wipe.
For the key 1 and key 2, key 3 and key 4, key 5 and key 6, 
or key 7 and key 8 combinations, if one is used for a dual 
resizer effect, the other key cannot be used for a DME 
wipe.

Number of DME wipes that can be used 
simultaneously on a single M/E bank
DME wipes can be used in nine places, including the eight 
independent key transitions.

• When the signal format is 1080P, DME wipes can be 
used in five places, including the four independent key 
transitions.

• In the case of the MVS-8000X, DME effects cannot be 
applied on keys 5 to 8 of the M/E-4 bank. There is no 
such restriction for the MVS-7000X.

• When the SDI interface is used to connect the DME, 
DME effects (including DME wipes) can be used in only 
one place for one M/E bank.

• When the dedicated interface is used to connect the 
DME, the number of keys to which DME effects 
(including DME wipes) can be applied simultaneously 
for one M/E bank varies as follows depending on the 
execution mode of the DME wipe pattern selected for the 
background.

Notes 

Notes 
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- MVS-8000X

- MVS-7000X

a) 0 when the system signal format is 1080P.
b) 1 when the system signal format is 1080P and the DME input/output 

signal format is set to dual link mode.
c) 0 when the system signal format is 1080P and the DME input/output 

signal format is set to dual link mode.

Basic Procedure for DME 
Wipe Settings

You carry out DME wipe setting operations principally 
using the DME Wipe menu for each bank.
This section describes the basic procedures for DME wipe 
settings, taking the M/E-1 >DME Wipe menu as an 
example.

For details of independent key transition DME wipe 
settings, see “DME Wipe Settings for Independent Key 
Transitions” (page 182).

For details of resizer DME wipe, see “Resizer DME Wipe 
Setting” (page 184).

DME Wipe Settings Menu

Accessing the DME Wipe menu
To access the M/E-1 >DME Wipe menu, use either of the 
following operations.
• In the menu control block, select the top menu selection 

button [M/E 1], and press VF6 ‘DME Wipe.’

To select [M/E-4], a previous assignment in the Setup 
menu is required.

• In the transition control block of the M/E-1 bank, press 
the transition type selection button [DME] twice in rapid 
succession.

DME Wipe Pattern Selection

Selecting a DME wipe pattern by a menu 
operation

1 In the M/E-1 >DME Wipe menu, select HF1 ‘1ch’ for 
one-channel mode, HF2 ‘2ch’ for two-channel mode 
or HF3 ‘3ch’ for three-channel mode.

2 Select the desired DME wipe pattern group with one of 
the following buttons.

• Slide/Squeeze: slide and squeeze
• Split/Door: split and door
• Flip Tumble: flip tumble
• Mirror/Sphere: mirror and sphere
• Character Trail: character trail

Applicable 
block

Key to 
which 
DME 
effects 
are 
applied

DME wipe 
pattern for 
background

Number of keys 
to which DME 
effects can be 
applied 
simultaneously

Other than 
M/E-4

Keys 1 
to 4

No DME 
wipe used

2

One-channel 
mode

1

Two- or 
three-
channel 
mode

0

Keys 5 
to 8

- 2 a)

M/E-4 Keys 1 
to 4

No DME 
wipe used

2 b)

One-channel 
mode

1 c)

Two- or 
three-
channel 
mode

0

Keys 5 
to 8

- 0

Key to 
which 
DME 
effects are 
applied

DME wipe pattern 
for background

Number of keys to 
which DME effects 
can be applied 
simultaneously

Keys 1 to 4 No DME wipe used 2

One-channel mode 1

Two- or three-
channel mode

0

Keys 5 to 8 - 2 a)

Notes 
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• Wave/Ripple: wave and ripple
• Page Turn/Roll: page turn and page roll
• Frame I/O/P in P: frame in/out and picture-in-

picture
• 2D Trans/3D Trans: 2D trans and 3D trans
• Sparkle/Split Slide: sparkle and split slide
• Mosaic/Defocus: mosaic and defocus
• Brick: brick
• User Program: user programmable DME

Selectable DME wipe pattern groups in one-
channel mode: All of the above groups except for 
Brick.

Selectable DME wipe pattern groups in two-
channel mode: Slide/Squeeze, Page Turn/Roll, 
Frame I/O, PinP, 3D Trans, Brick and User 
Program.

Selectable DME wipe pattern groups in three-
channel mode: User Program and Brick.

For details of DME wipe patterns, see “Types of DME 
Wipe Pattern” (page 172) and “DME Wipe Pattern 
List” (page 348).

The patterns from the selected pattern group appear on 
the screen.

3 Press the button to select the desired pattern.

For a key transition, the page turn, page roll and 
picture-in-picture cannot be used.

Adjusting DME wipe pattern parameters
Of the DME wipe patterns, the following have parameters 
that can be adjusted.

When Brick (for two channels) is selected 
(pattern numbers 2801 to 2804, 2811 to 2814)

a) The horizontal center position of the video pasted on Side V. At –100.00 
the center is at the left edge of the screen, and at +100.00 the center is at 
the right edge of the screen.

b) The vertical center position of the video pasted on Side V. At –100.00 the 
center is at the bottom edge of the screen, and at +100.00 the center is at 
the top edge of the screen.

When Frame in-out (for two channels) is selected
• Pattern numbers 2851 to 2854

• Pattern numbers 2861 to 2864

When Brick (for three channels) is selected 
(pattern number 3601)

a) Shared with knob 3 for parameter group 2
b) The horizontal center position of the video pasted on Side V. At –100.00 

the center is at the left edge of the screen, and at +100.00 the center is at 
the right edge of the screen.

c) The vertical center position of the video pasted on Side V. At –100.00 the 
center is at the bottom edge of the screen, and at +100.00 the center is at 
the top edge of the screen.

Notes 

Knob Parameter Adjustment Setting values

1 Side V Size X Horizontal 
magnification

0.01 to 8.00

2 Side V Size Y Vertical 
magnification

0.01 to 8.00

3 Height Height of brick 0.01 to 100.00

4 Center X Horizontal 
center position

–100.00 to 
+100.00 a)

5 Center Y Vertical center 
position

–100.00 to 
+100.00 b)

Knob Parameter Adjustment Setting values

5 Delay Timing for 
video selected 
on a utility bus 
to appear on 
the screen

–100.00 to 
+100.00

Knob Parameter Adjustment Setting values

1 Rot X Rotation about 
the Y axis 
(horizontal 
direction)

–100.00 to 
+100.00

2 Rot Y Rotation about 
the X axis 
(vertical 
direction)

–100.00 to 
+100.00

3 Rot Z Rotation about 
the Z axis

–100.00 to 
+100.00

5 Delay Timing for 
video selected 
on a utility bus 
to appear on 
the screen

–100.00 to 
+100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Side V Size X Side V 
horizontal 
magnification

0.01 to 8.00

2 Side V Size Y Side V vertical 
magnification

0.01 to 8.00

3 Height Height of brick 0.01 to 
100.00 a)

4 Side V Center 
X

Side V 
horizontal 
center position

–100.00 to 
+100.00 b)

5 Side V Center 
Y

Side V vertical 
center position

–100.00 to 
+100.00 c)

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Side H Size X Side H 
horizontal 
magnification

0.01 to 8.00

2 Side H Size Y Side H vertical 
magnification

0.01 to 8.00
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a) Shared with knob 3 for parameter group 1
b) The horizontal center position of the video pasted on Side H. At –100.00 

the center is at the left edge of the screen, and at +100.00 the center is at 
the right edge of the screen.

c) The vertical center position of the video pasted on Side H. At –100.00 the 
center is at the bottom edge of the screen, and at +100.00 the center is at 
the top edge of the screen.

Setting DME Wipe Modifiers

You can apply various modifiers to the DME wipe pattern: 
setting the DME wipe direction, pattern position, and so 
on.

For an overview of the DME wipe modifiers, see “DME 
Wipe Pattern Variation and Modifiers” (page 174).

Specifying the DME wipe direction 
(Direction)
You can specify the DME wipe direction (normal/reverse).

To specify the DME wipe direction in a menu

1 In the M/E-1 >DME Wipe menu, select HF4 ‘Edge/
Direction.’

The Edge/Direction menu appears.

2 In the <Direction> group, specify the DME wipe 
direction.

Normal: regular direction
Normal/Reverse: alternate between regular and 

reverse for each transition
Reverse: reverse direction to normal

To specify the DME wipe direction with a button 
in the transition control block
In the transition control block of each of the M/E-1 to M/
E-3 and PGM/PST banks, press the following direction 
selection buttons.
NORM: Normal
NORM/REV: Normal/Reverse
REV: Reverse

Modifying the DME wipe pattern edge

1 In the M/E-1 >DME Wipe menu, select HF4 ‘Edge/
Direction.’

The Edge/Direction menu appears.

2 Depending on whether the selected pattern is in one-
channel mode or two-channel mode, proceed as 
follows.

For a pattern in one-channel mode: press [1st Ch], 
turning it on.

For a pattern in two-channel mode: from the <Ch 
Select> group, select the corresponding channel. 
You can select more than one channel at the same 
time.

3 In the <Edge> group, select the edge type.

Border: border
Soft Border: soft border

4 Set the parameters according to the selection in step 3.

When border is selected

When soft border is selected

Display indications when multiple channels are 
selected at the same time
The indications on the knobs show the settings of the 
lowest-numbered channel. When you turn the knobs to 
adjust the settings, this changes the settings on the 
other channels by the same amount.

Setting the DME wipe position (Positioner)

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

3 Height Height of brick 0.01 to 100.00 
a)

4 Side H Center 
X

Side H 
horizontal 
center position

–100.00 to 
+100.00 b)

5 Side H Center 
Y

Side H vertical 
center position

–100.00 to 
+100.00 c)

Parameter group [2/2]

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

3 Luminance Luminance 0.00 to 100.00

4 Saturation Saturation 0.00 to 100.00

5 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

2 Inner Soft Border inner 
softness

0.00 to 100.00

3 Luminance Luminance 0.00 to 100.00

4 Saturation Saturation 0.00 to 100.00

5 Hue Hue 359.99 to 0.00
Basic Procedure for DME Wipe Settings
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2 Depending on whether the DME wipe pattern is in 
one-channel mode or two-channel mode, proceed as 
follows.

For a pattern in one-channel mode: press [1st Ch], 
turning it on.

For a pattern in two-channel mode: from the <Ch 
Select> group, select the corresponding channel. 
You can select more than one channel at the same 
time.

3 In the <Position> group, press [Position], turning it on.

4 Set the following parameters.

Display indications when multiple channels are 
selected at the same time
The indications on the knobs show the settings of the 
lowest-numbered channel. When you turn the knobs to 
adjust the settings, this changes the settings on the 
other channels by the same amount.

To return the DME wipe pattern position to the 
center of the screen
In the <Position> group, press [Center].

Displaying and moving the position of the 
DME wipe pattern (position select)

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.
In the <Position Select> group, the one of the [Top 
Left], [Top Right], [Bottom Left], and [Bottom Right] 
buttons that is on indicates the current display position 
of the DME wipe pattern.

2 In the <Position> group, press [Position], turning it on.

3 Depending on whether the DME wipe pattern is in 
one-channel mode or two-channel mode, proceed as 
follows.

In one-channel mode: press [1st Ch], turning it on.
In two-channel mode: from the <Ch Select> group, 

select the corresponding channel. You can select 
more than one channel at the same time.

4 To move the position of the DME wipe pattern, press 
the button where you want to move to, turning it on.

The DME wipe pattern displayed on the screen moves 
to the position of the specified button.

Setting relative positions to move the DME 
wipe pattern
In two-channel mode, use the following procedure. 

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 In the <Ch Select> group, select the target channels.

3 Press [Position] in the <Position> group, turning it on.

4 Set the following parameters.

For details of the method of DME wipe pattern 
selection, see “DME Wipe Pattern Selection” (page 
176)).

Setting the DME wipe pattern size (Size)

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the selected pattern is in one-
channel mode or two-channel mode, proceed as 
follows.

For a pattern in one-channel mode: press [1st Ch], 
turning it on.

For a pattern in two-channel mode: from the <Ch 
Select> group, select the corresponding channel. 
You can select more than one channel at the same 
time.

3 Press [Size], turning it on.

4 Set the following parameters.

a) The effect size when [Size] is off is taken as 100.00%.

Knob Parameter Adjustment Setting values

1 H Horizontal 
position

–200.00 to 
+200.00

2 V Vertical 
position

–200.00 to 
+200.00

Knob Parameter Adjustment Setting values

4 Relative H Relative 
movement in 
the horizontal 
direction

–400.00 to 
+400.00

5 Relative V Relative 
movement in 
the vertical 
direction

–400.00 to 
+400.00

Knob Parameter Adjustment Setting values

1 Size Set size of 
effect

0.00 to 200.00 a)
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Display indications when multiple channels are 
selected at the same time
The indications on the knobs show the settings of the 
lowest-numbered channel. When you turn the knobs to 
adjust the settings, this changes the settings on the 
other channels by the same amount.

Adjusting the DME wipe pattern cropping

When pattern numbers 1701 and 1702 are selected, crop 
cannot be used.

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the selected pattern is in one-
channel mode or two-channel mode, proceed as 
follows.

For a pattern in one-channel mode: press [1st Ch], 
turning it on.

For a pattern in two-channel mode: from the <Ch 
Select> group, select the corresponding channel. 
You can select more than one channel at the same 
time. Some patterns need no selection which is 
fixed in the <Ch Select> group.

3 In the <Crop Mode> group, press [Crop], turning it on.

4 Set the following parameters.

Display indications when multiple channels are 
selected at the same time
The indications on the knobs show the settings of the 
lowest-numbered channel. When you turn the knobs to 
adjust the settings, this changes the settings on the 
other channels by the same amount.

In 16:9 mode, to crop to 4:3 aspect ratio
In the <Crop Mode> group, press [4:3 Crop], turning it on.

To set the action when a DME wipe crop 
transition is executed

1 In the M/E-1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 Depending on whether the selected pattern is in one-
channel mode or two-channel mode, proceed as 
follows.

For a pattern in one-channel mode: in the <Ch 
Select> group, press [1st Ch], turning it on.

For a pattern in two-channel mode: from the <Ch 
Select> group, select the corresponding channels. 
You can select more than one channel at the same 
time.

3 In the <Crop Mode> group, press [Crop] or [4:3 Crop] 
(to crop from 16:9 to 4:3 aspect ratio), turning it on.

4 In the <Crop Mode> group, press [Remove From 
Begin].

The Remove From Begin menu appears.

5 In the <Crop Transition> group, select the execution 
mode for the DME wipe crop transition.

Cut: Cut mode. The cropping does not change during 
the transition, but at the end point of the transition 
the cropping is removed (enlarges).

Last 5%: The cropping is maintained for the first 95% 
of the transition, and is progressively removed 
during the last 5% of the transition (enlarges).

Linear: The cropping is removed linearly through the 
whole course of the transition (enlarges).

Notes 

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Crop the left 
and right of the 
image

Left value shown

2 V Crop the top 
and bottom of 
the image

Top value shown

3 All Crop the top, 
bottom, left, 
and right of the 
image

Left value shown

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Crop the top of 
the image

–100.00 to 
+100.00

2 Left Crop the left of 
the image

–100.00 to 
+100.00

3 Right Crop the right 
of the image

–100.00 to 
+100.00

4 Bottom Crop the 
bottom of the 
image

–100.00 to 
+100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values
Basic Procedure for DME Wipe Settings
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Setting the timing of transition completion
When the execution mode for a DME wipe crop transition 
is set to [Last 5%], you can select the timing of transition 
completion from 70% ([Last 30%]), 95% ([Last 5%]), and 
100% ([Off]).

1 In the M/E 1 >DME Wipe menu, select HF5 ‘Modify.’

The Modify menu appears.

2 In the <Crop Mode> group select [Remove From 
Begin].

The Remove From Begin menu appears.

3 In the <Release Transition> group, select the timing of 
transition completion.

Last 30%: The transition completes at the end of 70% 
of the transition execution time. The transition has 
a dead zone from 70% to 95% of the transition 
time.

Last 5%: The transition completes at the end of 95% 
of the transition execution time. When the 
transition completes, the cropping is removed 
during the last 5% (enlarges).

Off: The transition completes at the end of the 
transition execution time. During the last 5% of 
the transition, the transition and cropping removal 
proceed together.

DME Wipe Modify Clear

Press [Default Recall] at the lower left of the menu display, 
turning it on, then press VF6 ‘DME Wipe’ to return the 
DME wipe settings to their initial status.

For details of the menu operation to return the DME wipe 
state to that set in initial status, see “Returning to Default 
State in Function Groupings” (page 75).

Transition

t: transition execution time
y: change in transition and 

cropping amount

Cropping

“Dead Zone”

Transition

t: transition execution time
y: change in transition and 

cropping amount

Cropping
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DME Wipe Settings for 
Independent Key 
Transitions

You carry out independent key transition DME wipe 
setting operations using the DME Wipe Adjust menu for 
each keyer.

For an overview of independent key transitions, see page 
102.

This section describes the independent key transition DME 
wipe settings, taking the M/E-1 >Key1 >Transition >DME 
Wipe Adjust menu as an example.

Basic Procedure for Independent 
Key Transition DME Wipe Settings

Accessing the independent key transition 
DME wipe settings menu
As an example, to access the M/E-1 >Key1 >Transition 
>DME Wipe Adjust menu, carry out the following 
operation.
• In the menu control block, select the top menu selection 

button [M/E 1], and select VF1 ‘Key1’ and HF6 
‘Transition’ to display the Transition menu for key 1. 
Next, press [DME Wipe Adjust].
If VF1 [Key5] is shown, press the switching button at the 
top of the menu, so that [Key1-4] appears, and press VF1 
[Key1].

To select [M/E-4], a previous assignment in the Setup 
menu is required.

• Press the key delegation button [Key1] in the 
independent key transition control block of the M/E-1 
bank, then press the independent key transition type 
[DME] twice in quick succession.

Carrying out the above operation displays the M/E-1 
>Key1 >Transition >DME Wipe Adjust menu (which will 
be referred to below as simply the Key1 DME Wipe Adjust 
menu).

Selecting the independent key transition 
DME wipe pattern
You select the independent key DME wipe pattern from 
the list of patterns displayed in the menu. 

To select a DME wipe pattern for independent key1 on the 
M/E-1 bank, use the following procedure.

1 In the <Pattern Select> group of the Key1 DME Wipe 
Adjust menu, press [1ch] for one-channel mode or 
[2ch] for two-channel mode.

The Pattern Select menu appears.

2 Select the desired DME wipe pattern group with one of 
the following buttons.

(In two-channel mode, only Page Turn and Page Roll 
are selectable.)
• Slide/Squeeze: slide and squeeze
• Split/Door: split and door
• Mirror/Sphere: mirror and sphere
• Character Trail: character trail
• Wave/Ripple: wave and ripple
• Page Turn/Roll: page turn and page roll
• Frame I/O: frame in/out
• 2D Trans/3D Trans: 2D Trans and 3D Trans
• Sparkle/Split Slide: sparkle and split slide
• User Program: user programmable DME

For details of DME wipe patterns, see “Types of DME 
Wipe Pattern” (page 172) and “DME Wipe Pattern 
List” (page 348).

3 Press the button to select the desired pattern.

Setting Independent Key Transition 
DME Wipe Modifiers

You can add modifiers such as pattern position and size for 
an independent key transition DME wipe.

For introductory information, see “Setting the DME wipe 
position (Positioner)” (page 178) and “Setting the DME 
wipe pattern size (Size)” (page 179).

Setting the DME wipe position (Positioner)

For applicable pattern numbers, see page 174.

1 In the <Position> group of the Key1 DME Wipe 
Adjust menu, press [Position], turning it on.

2 Set the following parameters.

Notes 

Knob Parameter Adjustment Setting values

1 H Horizontal 
position

–200.00 to 
+200.00

2 V Vertical 
position

–200.00 to 
+200.00
DME Wipe Settings for Independent Key Transitions
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To return the DME wipe pattern position to the 
center of the screen
In the <Position> group, press [Center].

Setting the DME wipe pattern size (Size)

For applicable pattern numbers, see page 175.

1 In the Key 1 DME Wipe Adjust menu, press [Size], 
turning it on.

2 Set the following parameter.

a) The effect size when [Size] is off is taken as 100.00%.

Cropping a key DME wipe

1 In the <Crop Mode> group of the Key1 DME Wipe 
Adjust menu, press [Crop], turning it on.

2 Set the following parameters.

To crop to 4:3 in 16:9 mode
In the <Crop Mode> group, press [4:3 Crop], turning it on.

To set the operation for DME wipe crop transition 
execution

1 In the <Crop Mode> group of the Key1 DME Wipe 
Adjust menu, press [Crop], turning it on.

2 In the <Crop Mode> group, press [Crop] or [4:3 Crop] 
(to crop to 4:3 in 16:9 mode), turning it on.

3 In the <Crop Mode> group, press [Remove From 
Begin].

The Remove From Begin menu appears.

For subsequent operations, see step 5 of “To set the 
action when a DME wipe crop transition is executed” 
(page 180).

To set the timing of transition completion

1 In the <Crop Mode> group of the Key1 DME Wipe 
Adjust menu, press [Crop], turning it on.

2 In the <Crop Mode> group, press [Remove From 
Begin].

For subsequent operations, see “Setting the timing of 
transition completion” (page 181).

Applying a border to a key DME wipe
In the <Edge> group of the Key1 DME Wipe Adjust menu, 
press [Border], turning it on.

For subsequent operations, use the same process as in step 
4 of “Modifying the DME wipe pattern edge” (page 178).

Knob Parameter Adjustment Setting values

1 Size Set size of 
effect

0.00 to 200.00 a)

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Crop the left 
and right of the 
image

Left value shown

2 V Crop the top 
and bottom of 
the image

Top value shown

3 All Crop the top, 
bottom, left, 
and right of the 
image

Left value shown

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Cropping of the 
top of the 
image

–100.00 to 
+100.00

2 Left Cropping of the 
left of the 
image

–100.00 to 
+100.00

3 Right Cropping of the 
right of the 
image

–100.00 to 
+100.00

4 Bottom Cropping of the 
bottom of the 
image

–100.00 to 
+100.00
183DME Wipe Settings for Independent Key Transitions
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Resizer DME Wipe Setting 

You can carry out a DME wipe on a key using the resizer.

When the screen aspect ratio is 4:3 in HD format, when the 
resizer DME wipe is used to shrink a video image, this is 
applied to the 16:9 screen including the added video on the 
left and right sides. Use the crop function as required to 
extract the 4:3 image.

DME wipe patterns available for resizer DME wipe
You can use the following patterns of the DME wipe 
pattern one-channel mode that can be used in a resizer 
DME wipe. (7000-series numbers)
• Slide (pattern numbers: 7001 to 7008)
• Squeeze (pattern numbers: 7021 to 7031)
• Frame in-out (pattern numbers: 7201 to 7208, 7221 to 

7224)

Relation between resizer DME wipes and 
other effects
The following relations hold between a resizer DME wipe 
and other effects.

Relation to processed keys
It is not possible to select a resizer DME wipe for a key 
with processed key enabled.

Relation to resizer
It is not possible to use a resizer DME wipe for a key with 
resizer enabled.
It is not possible to use a resizer DME wipe for a key 
forming a pair with a key with the dual resizer effect 
enabled. The key combinations forming pairs are keys 1 
and 2, keys 3 and 4, key 5 and key 6, and key 7 and key 8. 
For example, when a dual resizer effect is enabled for key 
1, it is not possible to use a resizer DME wipe on key 2.

Making resizer DME wipe settings

1 In the <Pattern Select> group of the Key1 DME Wipe 
Adjust menu, press [1ch].

The 1ch Pattern Select menu appears.

2 Select [Resizer Slide/Squeeze] or [Resizer Frame I/O].

The patterns of the selected group appear.
The wipe patterns that can be used for a resizer DME 
wipe are as follows.
• Slide (pattern numbers: 7001 to 7008)
• Squeeze (pattern numbers: 7021 to 7031)

• Frame in-out (pattern numbers: 7201 to 7208, 7221 
to 7224)

3 Press the desired pattern to select it.

For more about resizer DME wipe modifiers, see 
“Setting Independent Key Transition DME Wipe 
Modifiers” (page 182).Notes 
Resizer DME Wipe Setting



  C
hapter 6  D

M
E

 W
ipes
DME Wipe Snapshots

You can snapshot and save a DME wipe pattern together 
with the current settings of its modifiers and pattern limit 
in a dedicated register for recall when required.
There are 10 DME wipe snapshot registers for each of the 
M/E and P/P banks. 
To save and recall these registers, use the Flexi Pad control 
block, the Multifunction Flexi Pad block in each switcher 
bank or the Menu control block.
In the case of a simple transition system, there are eight 
DME wipe snapshot registers for each switcher bank.

DME Wipe Snapshot Operations 
With the Flexi Pad

You can save, recall and delete DME wipe snapshots using 
the procedures similar to the procedures for wipe snapshot 
operations. In DME wipe snapshot operations, use the 
[DME] button instead of the [WIPE] button used in wipe 
snapshot operations. 

Selecting a DME wipe pattern in the Flexi 
Pad control block
In the standard type Flexi Pad control block, enter a four-
digit pattern number, using the [DME] button (see page 
167).

• You cannot select a DME wipe pattern in the simple type 
Flexi Pad control block.

• A button in the memory recall section in which a DME 
wipe snapshot is saved shows the pattern, and lights 
yellow.
For a user-programmable DME, the register number (see 
page 186) appears.
Depending on the setting of the Setup menu, you can 
also display a register name.
For details, see “Operation Settings (Operation Menu)” 
in Chapter 19 (Volume 2).

• In a simple type Flexi Pad control block, it is not possible 
to delete a DME wipe snapshot.
For details of the operating procedures, see “Wipe 
Snapshots” (page 166).

DME Snapshot Operations With the 
Menus

In the same way as for wipe snapshots, you can save, 
recall, and delete DME snapshots.

For details of the operating procedures, see “Wipe 
Snapshot Operations With the Menus” (page 168).

Notes 
185DME Wipe Snapshots
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Creating User 
Programmable DME 
Patterns

With a user programmable DME, you can use DME effects 
created through the use of keyframes for a transition on the 
switcher system.
Note the following points when creating a keyframe effect 
for use as a user programmable DME pattern.

Register numbers and pattern numbers
When saving a keyframe effect as a user programmable 
DME pattern, specify the register number that corresponds 
to the pattern number as shown in the following table.

For details of registers and keyframe effects, see Chapter 
13 “Keyframe Effects” (Volume 2), respectively.

When the signal format is 1080P, three-channel mode 
cannot be used.

Keyframe effects in the global channel
When the effect with the same number as the reference 
channel is present on the DME global (GLBL) channel, 
executing the user programmable DME will also execute 
the effect on the global channel simultaneously.
When executing a user programmable DME, take note of 
whether the effect is present on the global channel.

User Programmable DME Transition 
Mode

To create a user programmable DME, it is necessary to set 
the transition mode (the way in which the effect moves). 
To set the transition mode, use the Key Frame >DME User 
PGM menu.

For details of the operating procedures, see “Transition 
Mode Settings for User Programmable DME” in Chapter 
13 (Volume 2).

The following transition modes are available.

a) Transition according to DME wipe patterns 1202, 1203, or 1204
b) Transition according to DME wipe pattern 1201
c) Transition according to DME wipe pattern 1251

For details, see “Overview” (page 172).

For the following group of effects available in two-channel 
mode, no user programmable DME wipe patterns can be 
created.

Page turn, Page roll, Frame in-out, Brick

Notes on creating keyframe effects
When creating a keyframe effect to be used as a user 
programmable DME pattern, note the following, 
depending on the transition mode used.

Notes on single transition mode (one-channel 
mode)
• Either create the first keyframe image outside the screen 

area, or set the image size to zero so that it cannot be seen 
within the screen.

• Create the last keyframe to be a full-size image.
• In the <Transition Mode> group of the Key Frame 

>DME User PGM menu, select [Single].

Notes on flip tumble (one-channel mode)
• Create the first keyframe image at full size. In the 

<Back> group of the DME >Input/Output >Video/Key 
menu, depending on the direction of the rotation you 
want during the transition, press [H Invert] or [V Invert], 
turning it on.

Execution mode Register number Pattern number

One-channel 
mode

101 to 199 1901 to 1999

Two-channel mode 201 to 299 2901 to 2999

Three-channel 
mode

301 to 399 3901 to 3999

Notes 

Channels Transition mode Effect group

One-channel 
mode

Single transition 
mode

Slide, Split, Door, 
Page turn, Page 
roll, Squeeze, 
Mirror, Sphere, 
Character Trail, 
Wave, Ripple, 2D 
Trans, 3D Trans, 
Sparkle, Split 
Slide

Flip Tumble Flip Tumble, 
Mosaic, Defocus

Frame in-out Frame in-out

Frame in-out H a) Frame in-out

Frame in-out V Frame in-out

Picture-in-picture b) Picture-in-picture

Compress c) Picture-in-picture

Two-channel mode Dual transition 
mode

Slide, Squeeze, 
3D Trans

Two-channel 
picture-in-picture

Picture-in-picture

Notes 
Creating User Programmable DME Patterns
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• Create the last keyframe with the image inverted so the 
back side is visible, and with the size at full size.

• In the <Transition Mode> group of the Key Frame 
>DME User PGM menu, select [Flip Tumble].

Notes on frame in-out (one-channel mode)
Create a minimum of three keyframes.
• Either create the first keyframe image outside the screen 

area, or set the image size to zero so that it cannot be seen 
within the screen.

• Create the first transition to end such that the image can 
be seen within the screen. At this point, press the 
[PAUSE] button in the keyframe control block, turning 
it on, to set a pause for the keyframe.

• Either create the last keyframe image outside the screen 
area, or set the image size to zero so that it cannot be seen 
within the screen.

• In the <Transition Mode> group of the Key Frame 
>DME User PGM menu, select [FRAME I/O].

Notes on Frame in-out H (one-channel mode)
Create a minimum of three keyframe points.
• Either create the first keyframe image outside the screen 

area, or set the image size to zero so that it cannot be seen 
within the screen.

• As the state after completion of the first transition, move 
the image horizontally to make it visible within the 
screen. At this time, press the [PAUSE] button in the 
keyframe control block, turning it on, to set a pause for 
the keyframe.

• For the last keyframe move the image horizontally to 
place it outside the screen area or set the image size to 
zero, so that the image is not visible within the screen.

• In the <Transition Mode> group of the Key Frame 
>DME User PGM menu, select [FRAME I/O H].

Notes on frame in-out V (one-channel mode)
Create a minimum of three keyframe points.
• Either create the first keyframe image outside the screen 

area, or set the image size to zero so that it cannot be seen 
within the screen.

• As the state after completion of the first transition, move 
the image vertically to make it visible within the screen. 
At this time, press the [PAUSE] button in the keyframe 
control block, turning it on, to set a pause for the 
keyframe.

• For the last keyframe move the image vertically to place 
it outside the screen area or set the image size to zero, so 
that the image is not visible within the screen.

• In the <Transition Mode> group of the Key Frame 
>DME User PGM menu, select [FRAME I/O V].

Notes on picture-in-picture (one-channel mode)
Create a minimum of three keyframes.
• Either create the first keyframe image outside the screen 

area, or set the image size to zero so that it cannot be seen 
within the screen.

• Create the first transition to end such that the image can 
be seen within the screen. At this point, press the 

[PAUSE] button in the keyframe control block, turning 
it on, to set a pause for the keyframe.

• Either create the last keyframe image outside the screen 
area, or set the image size to zero so that it cannot be seen 
within the screen.

• In the <Transition Mode> group of the Key Frame 
>DME User PGM menu, select [P In P].

Notes on compress (one-channel mode)
Create a minimum of three keyframe points.
• Create the first keyframe with the image at full size.
• In the state at completion of the first transition, create the 

image to be visible within the screen. At this time, press 
the [PAUSE] button in the keyframe control block, 
turning it on, to set a pause for the keyframe.

• For the last keyframe, once again set the image size to 
full size.

• In the <Transition Mode> group of the Key Frame 
>DME User PGM menu, select [Compress].

Notes on dual transition mode (two-channel 
mode)
• Create the first keyframe for each channel as follows.

- Channel 1: create the image full-size.
- Channel 2: either create the image outside the screen 

area, or set the image size to zero so that it cannot be 
seen within the screen.

• Create the last keyframe for each channel as follows.
- Channel 1: either create the image outside the screen 

area, or set the image size to zero so that it cannot be 
seen within the screen.

- Channel 2: create the image full-size.
• In the <Transition Mode> group of the Key Frame 

>DME User PGM menu, select [Dual].

Notes on picture-in-picture (two-channel mode)
Create a minimum of three keyframes.
• Create the first keyframe for each channel as follows.

- Channel 1: create the image full-size.
- Channel 2: since the priority is low, it will not be 

visible on the screen, so no particular restrictions 
apply.

In the Global Effect >Ch1 to Ch4 >Combiner menu, 
when setting the priority of channel 1 and channel 2, set 
the channel 1 priority higher.

• In the intermediate part of the transition, create the two 
images so that both are visible within the screen. In the 
Global Effect >Ch1 to Ch4 >Combiner menu, when 
setting the priority of channel 1 and channel 2, set the 
channel 2 priority higher.
It is recommended to make the priority settings at a 
keyframe point at which the two images are not 
overlapping.

• During the course of a transition, there is a “dead zone” 
corresponding to the intermediate point of the whole 
effect (see following figure), during which the image 
does not change. Therefore, it is necessary to create the 
effect so that the image in the intermediate part of the 
187Creating User Programmable DME Patterns
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transition is the keyframe for the mid-point of the whole 
effect. The range of this “dead zone” corresponds to the 
central one-third of the range of the transition indicator. 
This also applies to an auto transition. 

• Create the last keyframe for each channel as follows.
- Channel 1: since the priority is low, it will not be 

visible on the screen, so no particular restrictions 
apply.

- Channel 2: create the image full-size.
• In the <Transition Mode> group of the Key Frame 

>DME User PGM menu, select [P In P].

DME Wipe Pattern 
Operations in the 
Multifunction Flexi Pad 
Control Block

Recalling a DME Wipe Snapshot

The operation of recalling a DME wipe snapshot in the 
Multifunction Flexi Pad control block is the same as the 
operation of recalling a wipe snapshot, except for pressing 
the [DME WIPE] button to select DME wipe snapshot 
mode (see page 169).

You can change the indications for buttons [0] to [9] in the 
memory recall section to pattern images, using the 
Engineering Setup >Panel >Operation >Flexi Pad Mode 
menu.

Selecting the DME Wipe Pattern

The operation of selecting the DME wipe pattern in the 
Multifunction Flexi Pad control block is the same as the 
operation of selecting a wipe pattern, except for pressing 
the [DME WIPE] button to select DME wipe snapshot 
mode (see page 169).

Note, however, that the pattern numbers for DME wipe 
patterns have four digits (see page 348).

Editing the DME Wipe Pattern

By pressing the [EDIT ENBL] button to switch the 
memory recall section to editing mode as shown in the 
following illustration, you can edit the selected DME wipe 
pattern with the following buttons.
To exit from the editing mode, press the [EDIT ENBL] 
button once more, or press the [EXIT] button.

Keyframe effect

First keyframe Last keyframe 
Mid-point of effect

Change in image through transition

Image at point C 
appears

Image at point A 
appears

Transition indicator

Fader lever

Image at point B 
appears 
(dead zone)
DME Wipe Pattern Operations in the Multifunction Flexi Pad Control Block
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Note that the operation of the following buttons is the same 
as when editing a wipe pattern.
• [EXIT] button
• [PTN LIMT], [LIMT SET] buttons
• [NORM], [NORM/REV], [REV] buttons
• [KNOB 1/2] button

For the method of operation of these buttons, see “Editing 
the Wipe Pattern” (page 169).

Channel selection buttons
1ST CH (channel 1): Selects channel 1.
2ND CH (channel 2): Selects channel 2.
You can also select two channels by pressing the buttons 
simultaneously.

DME wipe pattern edge setting buttons
BDR (border): Applies a border to the DME wipe pattern.
SOFT BDR (soft border): Softens the applied border.
You can adjust the parameters selected with these buttons 
using the control knobs, when the button is lit green.

• When border is selected

• When soft border is selected

Buttons for positioning the DME wipe 
pattern
POS (position): Adjusts the position of the DME wipe 

pattern.
CNTR (center): Returns the DME wipe pattern position 

to the center.
When you press the [POS] button, the alphanumeric 
display first shows the name of the parameter, “H” or “V,” 
and then the value of the parameter.
When the [POS] button is lit green, you can adjust the 
position of the pattern with the control knobs.

Buttons for setting DME wipe pattern 
cropping
CROP: Adjusts the DME wipe pattern cropping.
4:3 CROP: Crops a 16:9 image to 4:3.
When the [CROP] button is lit green, you can set the 
cropping ratio of the DME wipe pattern, with the control 
knobs.

Knob Parameter Adjustment Setting values

1 W Border width 0 to 100

2 L Luminance 0 to 100

3 S Saturation 0 to 100

4 H Hue 0 to 359

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 W Border width 0 to 100

2 I Degree of 
softening of 
inside of 
border

0 to 100

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 L Luminance 0 to 100

2 S Saturation 0 to 100

3 H Hue 0 to 359

Knob Parameter Adjustment Setting values

1 H Horizontal 
position

–200 to +200

2 V Vertical 
position

–200 to +200

3 H (R) Relative 
horizontal 
movement

–400 to +400

4 V (R) Relative 
vertical 
movement

–400 to +400

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Cropping ratio 
of the image 
from left and 
right sides

–100 to +100

2 V Cropping ratio 
of the image 
from top and 
bottom sides

–100 to +100

3 A Cropping ratio 
of the image 
from all four 
sides

–100 to +100
189DME Wipe Pattern Operations in the Multifunction Flexi Pad Control Block
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Button for specifying effect size
SIZE: Specifies the effect size. When the [SIZE] button is 

lit green, you can specify the effect size, with the 
control knobs.

a) The effect size when [Size] is off is taken as 100.00.

DME wipe modify clear
With the [DME WIPE] button held down, pressing and 
holding down the region selection button for the selected 
region returns the DME wipe settings to their initial status.

For details of the initial status, see “Saving User-Defined 
Settings” in Chapter 18 (Volume 2).

Saving, Canceling, and Deleting 
DME Wipe Snapshots

The operations of saving, canceling, and deleting a DME 
wipe pattern snapshot you have created are the same as the 
operations of saving, canceling, and deleting a wipe 
snapshot (see page 171).

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 T Cropping ratio 
of the image 
from the top

–100 to +100

2 L Cropping ratio 
of the image 
from the left

–100 to +100

3 R Cropping ratio 
of the image 
from the right

–100 to +100

4 B Cropping ratio 
of the image 
from the 
bottom

–100 to +100

Knob Parameter Adjustment Setting values

1 S Effect sizes 0 to 200 a)
DME Wipe Pattern Operations in the Multifunction Flexi Pad Control Block
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Overview

Frame memory is a function whereby a frame of input 
video can be frozen and written to memory, for further use 
as material for editing. 
You can also play recorded frame memory clips (movies).

Frame capacity
The frame memory board has two blocks of memory, and 
the following table shows the maximum number of images 
that can be written to each block. (Of the two, one is 
reserved for storing frame memory clips.)

HD system: 
(Without ancillary data)

(With ancillary data)

SD system: 
(Without ancillary data)

(With ancillary data)

For details of operating procedures, see “Still Image 
Operations” (page 193).

Types of image and terminology used
The following types of image are handled in frame 
memory.
Freeze image: An input image that has been frozen, but 

not saved to memory.
Still image: A freeze frame that has been saved to memory 

as a file. Each file (still file) holds just one still image.
Frame memory clip: A clip consists of a sequence of still 

images, which appears as a movie on playback. In this 
manual this is also referred to simply as a “clip.” The 
files (still files) constituting clips are referred to as a 
“clip file.”

When the above distinctions are not being made, an image 
is simply referred to as an “image.”

About extended clips
Of the two memory blocks for saving a clip, the clip saved 
in the one which is not combined with a still image is 
called an “extended clip.”

Video format Memory capacity

1080i/50 Approx. 1000 frames

1080i/59.94

1080PsF/23.976

1080PsF/24

1080PsF/25

1080PsF/29.97

1080PsF/50 Approx. 2300 frames

1080P/30

720P/50 Approx. 2300 frames

720P/59.94

Video format Memory capacity

1080i/50 Approx. 700 frames

1080i/59.94 Approx. 800 frames

1080i/60

1080PsF/23.976 Approx. 600 frames

1080PsF/24

1080PsF/25 Approx. 700 frames

1080PsF/29.97 Approx. 800 frames

1080PsF/30

720P/50 Approx. 1400 frames

720P/59.94 Approx. 1700 frames

Video format Memory capacity

480i/59.94 Approx. 5600 frames

576i/50 Approx. 4800 frames

Video format Memory capacity

480i/59.94 Approx. 4700 frames

576i/50 Approx. 3900 frames

Video format Memory capacity
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However, when the signal format is 1080P, since both a 
still image and a clip are saved in both memory blocks, 
there is no extended clip.

Use of frame memory
There are eight frame memory channels, FM1 to FM8, and 
each channel independently allows a freeze image to be 
saved or recalled.
By allocating FM1 to FM8 to cross-point buttons you can 
use the still image output or clip output from each channel 
as input material.

However, when the signal format is 1080P, only the four 
options of FM1 to FM4 can be used.

Correspondence between input and output
There are two buses for capturing frame memory material: 
the frame memory source bus 1 and the frame memory 
source bus 2.
These input buses are used by allocation to one of the pairs 
of output, FM1&2, FM3&4, FM5&6, and FM7&8. You 
can freeze a frame in each channel separately, or freeze in 
the two channels simultaneously.
The source buses allocated to FM1 to FM8 are as follows.

Pair mode
By enabling the pair mode, you can link FM1 and FM2, 
FM3 and FM4, FM5 and FM6, and FM7 and FM8. For 
example, when a freeze or image processing is carried out 
on FM1, the same operation is carried out on FM2. The 
same applies to the other pairs. When a pair of images are 
captured in pair mode, the image frozen in FM1 (3, 5, or 7) 
is referred to as the main file and the other frozen in FM2 
(4, 6, or 8) is referred to as the sub file. 

Pair files and single files
A file that can be recalled in pair mode is termed a “pair 
file.” A pair file can be created by setting pair mode and 
capturing an image, or by using the coupling function (see 
page 210) to combine two single files.
A file other than a pair file is termed a “single file.” A 
single file can be created by switching off pair mode and 
capturing an image, or by using the separation function 
(see page 210) to split a pair file.

Operation modes
The frame memory has the following operation mode. 
V/K mode: When the pair mode is active, the key signal is 

automatically selected on frame memory source bus 2. 
This is convenient for handling the video and key 
signals together in frame memory. For example, when 
you select a video signal on frame memory source bus 
1, the key signal assigned to it is automatically 
selected on frame memory source bus 2. You can also 
use the signal automatically selected on frame memory 
source bus 2 as a key signal when processing keyframe 
memory 1.

To change the pair mode or operation mode, use the Frame 
Memory menu.

Frame memory folders
Still images and clips can be managed in a maximum of 
twelve groups.
Such a group is called a “frame memory folder.” Folders 
can be added or deleted, and can be given a name of up to 
8 characters.

• When the system is powered off, the folder names are 
deleted. The folder names need to be saved on media.

• The following names cannot be used for folders. 
Flash1, Flash2
CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, 
COM2, COM3, COM4, COM5, COM6, COM7, COM8, 
COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, 
LPT8, LPT9
A folder named “Default” is provided, and this folder 
cannot be renamed or deleted.

• Still images and clips in different frame memory folders 
cannot have the same name.

Notes 

Input Frame memory 
source bus 1

Frame memory source 
bus 2

Output FM1 FM2

FM3 FM4

FM5 FM6

FM7 FM8

Notes 
Overview
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Still Image Operations

The frame memory functions provides the following still 
image file functions.
• Capturing and Saving an Input Image (page 196)
• Recalling Still Images (page 198)
• Image Output (page 199)
• Continuously Capturing Still Images (Record) (page 

200)
• Recalling a Continuous Sequence of Still Images 

(Animation) (page 200)

During playback of a frame memory clip of the pair 
assigned to either of the target FM selection buttons (see 
page 204), frame memory operations may not be 
performed properly. Carry out frame memory operations 
after stopping clip playback.

Preparations

Allocating the frame memory outputs (FM1 
to FM8) to cross-point buttons
To output a frame memory image to a monitor, for 
example, the output signal from the frame memory (FM1 
to FM8) must be allocated to a cross-point button. Carry 
out this allocation in the Setup menu.

When the signal format is 1080P, only the four options of 
FM1 to FM4 can be used.

Accessing the Frame Memory menu
Most frame memory operations are carried out using the 
Frame Memory menu.
To access the Frame Memory menu, use either of the 
following procedures.
• In the menu control block, select the top menu selection 

button [FRAME MEM].
• Press the cross-point button to which the frame memory 

output is allocated twice in rapid succession.

Interpreting the Frame Memory Menu

The menu screen consists of the following principal parts.
The frame memory selection area display is the same for 
all except the Pattern Adjust/Pattern Select/Field Invert/
File (excluding Pair Recombination menu)/Folder/
External Device menus.

Notes 

Notes 
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Frame Memory menu

a Auto store status display
Depending on the setup settings, this appears when the 
auto store function is enabled.

b Display of available image capacity
This shows the remaining number of frames. When no 
more frames can be stored, in pair mode “1” or “0” appears 
in red, and in single mode “0” appears in red.
The lower figure shows the remaining number of frames 
that can be used as extended clips.

When the signal format is 1080P, each time a still image is 
saved the remaining space is reduced by two frames.

c Target FM selection buttons

2Display of available image capacity

4Pair selection button

6 File selection area

3 Target FM selection buttons

5Pair button

1Auto store status display

Frame memory 
selection area

7 Frame memory 
folder selection 
area

9 Find button

8Direct Recall 
button

Notes 

Status display

Still/duration display

Reposition/Lock status display

The border color shows the status as follows:
Blue: selected as the reference channel
Amber: selected, but not the reference channel
Black: not selected

Extended clip display

Display of ancillary data
Still Image Operations
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Press one of these to select which of the selected outputs 
(FM1 and FM2 in the example shown) the operation 
applies to.
The following information appears on the button.

Status display
File name (e.g. image001) and thumbnail: when a file is 

output
Black: when a black signal is output
Through: when the input image is output
Freeze: when a freeze is output
Record: when continuously capturing images (record)

Still/duration display
When a still image is selected, “Still” is shown. When a 
clip is selected, a duration indication such as “00:00:10” is 
shown.

Reposition/Lock status display
This shows “R” when the reposition function (see page 
199) is on, and shows “L” when the lock function (see 
page 199) is on.

Extended clip display
For an extended clip, an “E” appears.

Ancillary data-attached clip display
For an ancillary data attached clip, an “A” appears.

d Pair selection button
Select the pair to be displayed in the target FM selection 
buttons.
(in the following figure, the pair of FM1 and FM2 is 
selected.)

The following information appears on the button.

Status display
For a pair, shows the status for the reference.
Thumbnail: when a file is output
Black: when a black signal is output
Through: when the input image is output
Freeze: when a freeze is output
Record: when continuously capturing images (record) 

e Pair button
Press this button, turning it on, to enable pair mode.

f File selection area 
You can select from the displayed still image files or clip 
files.

Thumbnail indications
Still image files and clip files: Still image files are 

displayed as gray buttons and clip files are displayed 
as yellow buttons.

Single files and pair files: Single files are displayed with 
shadow and pair files are displayed with no shadow.

Selected file: Pale blue border. When more than one file is 
selected, only the first is pale blue, and the remainders 
are amber. If the pair file was selected, each press 
switches the front and the back.

File information detail display
For the selected file, this shows the file name, “P” if a pair 
file, “E” if an extended clip, “A” if an ancillary data 
attached clip, and the duration.

g Frame memory folder selection area
Select the frame memory folder to be displayed.

h Direct Recall button
Toggle on and off the direct recall mode in which pressing 
a thumbnail immediately recalls the file.

i Find button
Pressing this button displays a popup window, in which 
you can enter a file name to carry out a search.

Selecting an Input Image

For the input image to frame memory, you can use either 
the signal selected on one of the two frame memory source 
buses or a dedicated color matte signal.
When using the signal on frame memory source bus 1 or 2 
for the input image, select the signal as described below.

The border color shows the status as follows:
Blue: selected as the reference channel
Amber: selected, but not the reference channel
Black: not selected

Status display

Selected file
When a pair file is selected each press switches the front and 
the back.

File information detail display
195Still Image Operations
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Selecting the signal on a frame memory 
source bus
As an example, to select a signal on frame memory source 
bus 1, use the following procedure.

1 In the auxiliary bus control block, press the AUX 
delegation button to which frame memory source bus 
1 is allocated, turning it on.

For allocation of buses to the AUX delegation buttons, 
see “Assigning a Bus to an AUX Delegation Button” 
in Chapter 19 (Volume 2).

On a CCP-6224/6324 control panel, you switch the 
cross-point control block for use as an AUX bus 
control block.

2 In the auxiliary bus control block cross-point buttons, 
select the signal to be used for the input image.

To select a signal with a key or DME effect applied 
on the frame memory source bus
In the key control block, press the [FM FEED] button, 
turning it on.
This automatically assigns the key fill and key source 
signals being keyed by the currently selected keyer to 
frame memory source buses 1 and 2.
When DME is selected on the keyer, the key fill and key 
source signals to which a DME effect is applied are 
assigned.

Selecting Outputs and Target Frame 
Memory

Selecting outputs (FM) and target frame 
memory
The following description applies to the case of settings for 
FM1&2, but the procedures are similar for the other cases.

1 In the Frame Memory menu, press one of VF1 to VF4, 
and select the required HF menu.

The current status of frame memory appears. (See 
page 193.)

2 From the pair selection buttons, press the buttons 
corresponding to FM1 and FM2.

This assigns the signals to FM1 and FM2.
To the right of the target FM selection buttons, the 
FM1 and FM2 output status appears (see page 194).

3 If required, press [Pair], to select the FM operation 
mode (pair mode).

On: Operate on FM1 (3, 5, 7) and FM2 (4, 6, 8) as a 
pair.

Off: Operate on FM1 (3, 5, 7) and FM2 (4, 6, 8) 
individually.

For more details, see “Pair mode” (page 192).

In the Pair Recombination menu, the [Pair] operation 
is not possible.

4 Press the target FM selection button [FM1] or [FM2] 
(see page 194) to select the FM operations apply to.

When [Pair] is On: Whichever of FM1 and FM2 you 
press, the pair is selected.

When [Pair] is Off: One of the targets must be 
selected. However, in the Clip >Play menu you 
can also select both FM1 and FM2.

Selecting a frame memory folder
Press a button in the frame memory folder selection area 
(see page 195).
By pressing [More] to switch the display, you can select 
from a maximum of 12 folders.
Thumbnails of the files within the selected folder appear.

Capturing and Saving an Input 
Image

As the input material for the frame memory, you can use 
the signal selected on the frame memory source bus. For 
this signal you can use video processing (video levels or 
hue value adjustment) or masking.
Allocating a frame memory source bus signal to one of 
FM1 to FM8, then carrying out a freeze captures a still 
image in the corresponding frame memory output image, 
and saves it in temporary memory.
For a freeze, an image can be captured either as video 
frame (a “frame freeze”) or a video field (“field freeze”).

When the system is powered off, any freeze images written 
to temporary memory are lost.

Freezing an image and writing it to 
memory
To freeze the signal selected as input material, and write it 
to memory, use the following procedure.

1 In the Frame Memory menu, select VF1 ‘Still’ and 
HF2 ‘Freeze/Store.’

The Freeze/Store menu appears.

Notes 

Notes 
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2 Select the target frame memory.

For the procedure, see “Selecting outputs (FM) and 
target frame memory” (page 196).

3 To enable V/K mode, press [V/K Mode] turning it on.

4 Press a button in the frame memory folder selection 
area, to select the folder to hold the freeze image (see 
page 196).

The folder selected here is the destination folder for 
writing the freeze image.
It is not possible to change the selection of this folder 
after the following step 5.
An orange bar appears on the selection button for the 
destination folder.

5 Press [Freeze Enable], turning it on.

The signals of frame memory source buses 1 and 2 are 
assigned to the pair of FMs selected in step 2, a freeze 
is now possible.

6 If necessary, make the video process settings (see page 
197) or mask settings (see page 198) for application to 
the selected signal.

7 In the state in which you want to freeze, press one of 
the following in the <Freeze> group, to write the 
freeze image to temporary memory.

Frame: Freeze one frame.
Field: Freeze one field.
Off: Release the freeze, and delete the recorded freeze 

image.
After carrying out the freeze, to return to the state 
immediately before the freeze, press [Undo] in the 
<Freeze> group.

• All freeze images written to temporary memory are 
lost when the system is powered off.

• If you change the frame memory to use as in step 2 
before saving the freeze images written to temporary 
memory, all the freeze images in temporary memory 
are lost, unless the auto store function has been 
enabled in setup. With the auto store function 
enabled, the freeze images written to temporary 
memory are saved automatically when the frame 
memory selection is changed.

• For the following signal formats, a field freeze is not 
possible.

1080P/50, 1080P/59.94, 1080PsF/23.976, 
1080PsF/24, 1080PsF/25, 1080PsF/29.97, 720P/
50, 720P/59.94

Saving a freeze image (Store)
You can save an image in temporary memory which has 
been placed with the freeze function as a file in memory. 
You can save a single image in a single file and apply a 
name of up to eight characters to the file.

• When the system is powered off, all the files saved in 
memory are lost.

• When the signal format is 1080P, the file name is limited 
to seven characters.
Each time a still image is saved, the remaining space is 
reduced by two frames.

To save a captured still image in a file, use the following 
procedure in the Still >Freeze/Store menu.

1 Press [Store].

The keyboard window (see page 72) appears.

2 In the keyboard window, enter the file name.

The following names cannot be used:
CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, 
COM2, COM3, COM4, COM5, COM6, COM7, 
COM8, COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, 
LPT8, LPT9

3 In the keyboard window, press the [Enter] button.

This saves the still image file in memory.
The destination folder is the folder selected in step 4 of 
“Freezing an image and writing it to memory.”
If the entered folder name already exists, a message to 
confirm overwriting appears.
When the system is powered off, the file saved in 
memory is erased.

To carry out a freeze and store simultaneously 
(Freeze and Store)
Press [Freeze & Store], turning it on.
In this state, if you press [Frame] or [Field], this carries 
out a freeze, and simultaneously stores in a still image 
file.

Setting video processing
To set video processing for the signal selected on a frame 
memory source bus, use the following procedure in the 
Still >Freeze/Store menu.

1 In the <Video Process> group, press [Video Process], 
turning it on.

Notes 

Notes 

Notes 

Notes 
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2 Use the knobs to adjust the following parameters.

To return the settings to the default values, press 
[Unity] in the <Video Process> group.

When a pair setting is active, it is coupled to the video 
process on/off setting, but the above parameter 
settings are only valid for frame memory source bus 1. 
The pair setting cannot be used to set the frame 
memory source bus 2. If you want to set video process 
for frame memory source bus 1 only with the pair 
setting when old settings for frame memory source bus 
2 remain, return the frame memory source bus 2 
settings to their default values. When setting video 
process for the frame memory source bus 2, disable the 
pair setting.

Setting a mask
Masks can be set separately for frame memory source 
buses 1 and 2. To apply a mask to the signal selected on 
frame memory source bus 1, for example, use the 
following procedure in the Still >Freeze/Store menu.

1 Press [Box Mask], turning it on.

2 Use the knobs to adjust the following parameters.

3 To link the masks on frame memory source buses 1 
and 2, press [Mask Link], turning it on.

Recalling Still Images

You can recall an image file saved in memory, and allocate 
to any of the FM1 to FM8 outputs.

Recalling a still image
To recall a still image file saved in memory using the 
thumbnails, and assign it to an FM output, use the 
following procedure.

1 In the Frame Memory menu, select VF1 ‘Still’ and 
HF1 ‘Recall.’

The Recall menu appears.
• When [Pair] is on, only pair files (pairs of main file 

and sub file) are displayed.
• When [Pair] is off, both single files and pair files 

appear (see following figure).

2 In the frame memory selection area, select the FM to 
be assigned. (See page 196).

3 If [Direct Recall] is on, press and turn it off.

4 Select the desired folder in the folder selection area.
By pressing [More] to switch the display, you can 
select from a maximum of 12 folders.

Thumbnails of the files within the selected folder 
appear.

5 Using the arrow keys or turning the knob, scroll the 
file thumbnail display.

6 Press the thumbnail of the still image you want to 
recall.

7 Press [Recall].

Knob Parameter Adjustment Setting values

1 Video Gain Overall gain 
of the video 
signal

–200.00 to +200.00

2 Y Gain Y signal gain –200.00 to +200.00

3 C Gain Chrominanc
e signal gain

–200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black 
Level

Y signal 
black level

–7.31 to +109.59

Notes 

Knob Parameter Adjustment Setting values

1 Top Top position –100.00 to +100.00

2 Left Left position –100.00 to +100.00

3 Right Right 
position

–100.00 to +100.00

4 Bottom Bottom 
position

–100.00 to +100.00 Knob Parameter Adjustment Setting values

1 Scroll Thumbnail 
display 
scrolling

1 and upwards

Main file

Sub file
Still Image Operations
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This recalls the still image file, which is assigned to the 
FM you selected in step 2.

To recall in direct recall mode
Direct recall means that pressing a thumbnail immediately 
recalls the file.
In this mode, only the front thumbnail file is recalled.

1 In step 7 above, instead of pressing [Recall], press 
[Direct Recall].

2 Press the thumbnail for the file you want to recall.

To display the subsidiary file in front
With the direct recall mode on, press [Sub Display], 
turning it on.

To search by file name

1 Press the [Find] button.

The Find window appears.

2 Press [Find].

A keyboard window appears.

3 Enter the string you want to search for, and press 
[Enter].

This starts the search, and the indicator lights.
When the search ends, the files found are selected.

4 To move through the selected files, press the [< Prev] 
or [Next >] button.

5 Press outside the Find window on the menu screen.

Image Output

There are two functions related to image output: the 
reposition function for moving the output image, and the 
lock function for fixing the output image.

Moving the output image (reposition 
function)
For up to two channels of FM1 to FM8 (one from FM1, 
FM3, FM5 and FM7 and the other from FM2, FM4, FM6 
and FM8), you can move the output image with respect to 
the screen. The area of the screen around the image that has 

been moved is filled with black. There are two ways of 
carrying out this repositioning.
Normal mode: Movement in the horizontal direction is in 

two-pixel increments.
Black and white mode: Movement in the horizontal 

direction is in one-pixel increments, and for each pixel 
moved the color is inverted.

It is not possible to save an image moved with the 
reposition function directly to frame memory.

1 In the Frame Memory menu, select VF3 ‘Reposition/
Lock’ and HF1 ‘Reposition.’

The Reposition menu appears. In this menu, you can 
also enable the V/K mode (see page 197).

2 In the frame memory selection area, select the FM 
output (see page 196).

3 In the <Reposition> group, select the movement 
mode.

Normal: Move in normal mode.
Black&White: Move in black & white mode.

4 With the knobs, adjust the parameters to move the 
image.

a) See page 158.

The surroundings of the moved image on the screen 
are filled with black.

5 To return the image moved by the reposition function 
to the center position, in the <Reposition> group press 
[Center].

Fixing the output image selection (lock 
function)
For the output of each of FM1 to FM8, this fixes the image 
at the current output. When this lock is enabled, even if the 
output is recalled in a snapshot or keyframe, the images 
output to FM1 to FM8 are preserved.

Notes 

Knob Parameter Adjustment Setting values

1 Position H Move in 
horizontal 
direction

–200.00 to +200.00 a)

2 Position V Move in 
vertical 
direction

–200.00 to +200.00 a)
199Still Image Operations



200

  C
hapter 7  Fram

e M
em

ory
When the signal format is 1080P, this function cannot be 
used.

1 In the Frame Memory menu, select VF3 ‘Reposition/
Lock’ and HF2 ‘Lock.’

The Lock menu appears.

2 In the frame memory selection area, select the FM 
output. (See page 196.)

3 Press [Lock], turning it on.

This fixes the currently selected frame memory output 
image.
To release the lock, set [Lock] to off.

Continuously Capturing Still Images 
(Record)

You can continuously capture (freeze) a sequence of input 
video frames and store the sequence of the still images 
over a specified time interval.
The name of each image recorded in this way consists of a 
first character string followed by a second string.
First character string: A common part of name assigned 

to all the still images captured in one record operation. 
This string includes a maximum of four characters, 
which can be specified using a menu before carrying 
out the capture. The first string is automatically used 
as the clip name when the images are treated as a frame 
memory clip. 

Second character string: A four-digit number (0000 or 
greater), which is incremented each time a still image 
is captured.

 

When using the record function to continuously capture 
frames, it is not possible to use the mask function.

Continuously freezing input images and 
writing to memory

1 In the Frame Memory menu, select VF1 ‘Still’ and 
HF4 ‘Animation Record.’

The Animation Record menu appears.

2 Select the desired frame memory (see page 196).

3 To use V/K mode, press [V/K Mode], turning it on.

4 Press a button in the frame memory folder selection 
area, to select the folder to hold the freeze image (see 
page 196).

The folder selected here is the destination folder for 
writing the freeze image.
It is not possible to change the selection of this folder 
after the following step 5.
An orange bar appears on the selection button for the 
destination folder.

5 Press [Record Enable], turning it on.

The signals of frame memory source buses 1 and 2 are 
assigned to the pair of FMs selected in step 2, the 
recording function is now possible.

6 Input the file name if required.

Pressing [File Name] displays the keyboard window 
and you can enter the first character string (up to four 
characters) of the file name.

7 Set the recording time if required.

Pressing [Duration] displays the numeric keypad 
window, in which you can enter the recording time in 
the form of timecode.
If you set the recording time to zero, this uses all frame 
memory in which storing is possible for recording.

8 If required, set video processing for the selected signal 
(see page 197).

9 Press [Record], to start recording.

When the recording time is set, recording stops once 
the time has elapsed.

10Press [Stop] to stop recording.

Even if the recording time is set, you can still stop 
recording before the set time has elapsed.

Recalling a Continuous Sequence of 
Still Images (Animation)

You can use a continuous sequence of images captured 
with the record function as keyframes to create an effect. 
By executing this effect you can recall the continuous 
sequence (animation).

 

• For example, to create an effect using FM1, FM1 must 
be assigned to a user region. 

Notes 

Notes 

Notes 

Notes 
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• To execute the effect, you must assign the user region to 
which FM1 is assigned to a region selection button in the 
numeric keypad control block and the Multifunction 
Flexi Pad control block. 
For details of assigning to region selection buttons, see 
Chapter 19 “Control Panel Setup (Panel)” (Volume 2).

In the Frame Memory menu, effect creation follows the 
image file names. Of the eight characters in the file names, 
if files have the same characters except for the last three 
characters they are treated as an image file group, and the 
effect is created with the last three (numeric) characters in 
sequence.

 

When creating the effect in pair mode (see page 192), the 
files used must be main files and sub files with the same 
last three (numeric) characters in the file name.

To recall a continuous sequence of still images, create an 
effect in the user region with the still image files as a 
keyframe, and run the created effect.

With the 720P format or 1080P format, you can 
continuously recall images using the frame memory in 
units of two frames only.

Creating an effect with still image files as a 
keyframe

1 In the Frame Memory menu, select VF1 ‘Still’ and 
HF5 ‘Create Key Frame.’

The Create Key Frame menu appears.
• A thumbnail appears for each group of files having 

the same characters, except for the last three 
characters, in the file name.

• When [Pair] is on, only pair files (each pair 
comprising a main file and a sub file) appear.

• When [Pair] is off, both single files and pair files all 
appear.

2 In the frame memory selection area, select the frame 
memory to be assigned (see page 196).

3 Select the desired folder in the folder selection area.
By pressing [More] to switch the display, you can 
select from a maximum of 12 folders.

Thumbnails of the files within the selected folder 
appear.

4 Turn the knob to select the register number in the user 
region.

To search for an empty register in the user region, use 
the numeric keypad control block or the Multifunction 
Flexi Pad control block. 

For details, see step 3 of “Recalling a Register” in 
Chapter 13 (Volume 2).

5 Use the arrow keys or turn the knobs to scroll the 
thumbnail display of the files.

6 Select the thumbnail of the files to be used for the 
keyframe.

7 If necessary, turn the knob to check the animation 
effect in the thumbnail display.

8 Using the region selection buttons in the numeric 
keypad control block or the Multifunction Flexi Pad 
control block, select one of the regions (User1 to 
User8) to which the frame memory output signals have 
been assigned.

9 Carry out either of the following.

• To clear the effect register selected in step 4, and 
create a new effect: press [Create Key Frame].

• To add to the end of the effect register selected in 
step 4, press [Append Key Frame].

A confirmation message for creating the effect 
appears.
If there is an inappropriate condition for creating the 
effect, an error message appears.

For details of error messages, see “Error Messages” 
in the Appendix (Volume 2).

10Press [OK].

This creates the effect in the selected user region 
register.

Notes 
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Knob Parameter Adjustment Setting values

5 Register Effect 
register 
number

1 to 99

Notes 

Knob Parameter Adjustment Setting values

1 Scroll Thumbnail 
display 
scrolling

1 and upwards

Knob Parameter Adjustment Setting values

3 Viewer Animate 
thumbnail 
display of 
files

00:00:00 and 
upwards
201Still Image Operations



202

  C
hapter 7  Fram

e M
em

ory
To cancel creating the effect
Press [Cancel].

• The effect is built with the selected files, in 
increasing order of the last three characters of the 
file name. If you do not want to include some of 
these files in the effect, first delete or rename them.

• A maximum of 99 keyframes can be included in a 
single effect.

Recalling a sequence of still images
Run the effect created by the foregoing procedure.
The procedure for doing this is the same as for any other 
effect.

For details, see “Executing Effects” in Chapter 13 
(Volume 2).

Frame Memory Clip 
Function

What is a “frame memory clip”?
Movies can be read into frame memory, and recalled and 
played back. A movie held in frame memory is called a 
“frame memory clip.”
A frame memory clip can be named using up to four 
characters (see page 200).

Ancillary data
In a frame memory clip, in addition to the video image, 
you can also record and play back ancillary data which can 
be used as embedded audio.
To record the ancillary data, in the Setup menu the frame 
memory saving mode must be set to “save with ancillary 
data”.

For details, see “Saving a Frame Memory Clip With 
Ancillary Data” in Chapter 18 (Volume 2). 

• With this setting, the saving mode for still images also 
changes to “save with ancillary data,” but when playing 
back a still image the ancillary data is never played. 

• When you change the saving mode, the frame memory is 
initialized, and any existing recorded frame memory 
data is lost.

• When the signal format is 1080P, ancillary data is not 
supported.

Note on transferring ancillary data
Ancillary data is recorded when the frame memory saving 
mode is set to “save with ancillary data,” and can be saved 
to an external storage device such as a hard disk or 
memory card, and recalled. However, the ancillary data 
can only be saved or recalled; 
• When the frame memory saving mode is set to “save 

with ancillary data. 
• When ancillary data is present in the saved or recalled 

frame memory file.
• When the system signal format is the same as the signal 

format in the file.
When the frame memory saving mode is set to “save with 
ancillary data,” the following ancillary data status 
information is added to a frame memory clip. 
• Disable(d):

In this state the ancillary data is not played. This is the 
status when the [Ancillary Enable] button in the Frame 
Memory >Clip menu is set to Off. 

• Enable(d):
In this state, ancillary data is present, and can be played 

Notes 

Notes 
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back. This is the status when the [Ancillary Enable] 
button in the Frame Memory >Clip menu is set to On. 
This is the status after a clip recording operation. 

This status information is saved in a file, and is followed 
when the file is recalled. 

Frame memory clip settings
For frame memory clips, you can make the following 
settings using a menu or device control block (trackball/
search dial/joystick).
• Start point 
• Stop point 
• Loop On/Off
The above settings can be saved in a snapshot register as 
snapshot attributes, and recalled.

Frame Memory Clip 
Operations

During playback of a frame memory clip of the pair 
assigned to either of the target FM selection buttons (see 
page 204), frame memory operations may not be 
performed properly. 
Carry out frame memory operations after stopping clip 
playback.

Preparations for Operation

The preparations for using a frame memory clip (hereafter, 
a “clip”) are the same as for a still image operation.

For details, see “Preparations” (page 193) and 
“Selecting Outputs and Target Frame Memory” (page 
196).

Recalling Clips

Recalling a clip
You can recall a clip from each of frame memories 1 to 8.

1 In the Frame Memory menu, select VF2 ‘Clip’ and 
HF1 ‘Recall.’

The Recall menu appears. (See following figure)
• When [Pair] is set to On, only pair files (sets of main 

file and sub file) are shown.
• When [Pair] is set to Off, both of single files and pair 

files are shown.

Notes 
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2 In the frame memory selection area, select an assigned 
target FM. (See page 196).

3 If [Direct Recall] is on, press the button, turning it off.

4 In the frame memory folder selection area, select the 
desired folder.
By pressing [More] to switch the displays, you can 
select from a maximum of 12 folders.

5 Using the arrow keys or turning the knob, scroll the 
file thumbnail display.

6 Press the thumbnail of the clip you want to recall.

7 Press [Recall].

This recalls the clip file, which is assigned to the FM 
you selected in step 2.
In pair mode, if a clip is selected, the main file is output 
to FM1, and the sub file to FM2. In single mode, when 
only one of FM1 and FM2 is selected, the front file on 
the thumbnail is output.

To recall in direct recall mode
Direct recall means that pressing a thumbnail immediately 
recalls the file.
In this mode, only the front thumbnail file is recalled.

1 In step 7 above, instead of pressing [Recall], press 
[Direct Recall].

2 Press the thumbnail for the file you want to recall.

To display the subsidiary file in front
With the direct recall mode on, press [Sub Display], 
turning it on.

To search the clip file by file name
Press the [Find] button (see page 199).

Clip Playback

You can play a recalled clip by a menu operation or by 
using the device control block.

With a pair file recalled, it is possible to set [Pair] to Off 
and carry out a single file operation, but if you then set 
[Pair] to On again, the output of frame memory may be 
black. In such cases it is necessary to recall the pair file 
once more.

Playing a clip using the menu

1 In the Frame Memory menu, select VF2 ‘Clip’ and 
HF2 ‘Play.’

The Play menu appears. The status of the clip shown 
in the current target FM selection buttons appears here.

2 When [Pair] is Off, press a target FM selection button 
to select the target.

Knob Parameter Adjustment Setting values

1 Scroll Thumbnail 
display 
scrolling

1 and upwards

Target selection buttons

Pair selection buttons

Clip file selection area

Frame memory 
selection area

Frame memory 
folder selection area

Direct Recall button

Find button

Notes 

Playback start point 
(pale blue bar)

Current position 
(red bar)

Status buttons
These show the timecode 
values for the start point, 
current position, and end 
point.

Playback end point 
(yellow bar)
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3 To set loop playback, press [Loop], turning it on.

4 To start playback, press [Play]. During playback, to 
stop, press [Stop].

To cue up
Press [Cue].

To play the image at the beginning of the clip 
(Clip Begin)
Press [Rewind].

To play the image at the end of the clip (Clip End)
Press [FF].

To specify the playback start point
To set the current position as the playback start point, in 
the <Start TC> group, press [Set]. To set a different 
position, press the [Start] status button, and enter a 
timecode value from the numeric keypad window.

To specify the playback stop point
Start playback, and at the desired position press the 
[STOP] button to stop playback, then in the <Stop TC> 
group, press [Set]. To set to any position, press the [Stop] 
status button, and enter a timecode value from the numeric 
keypad window.

To change the current position
To change the current position, press the [Current] status 
button, and enter a timecode value from the numeric 
keypad window.

To delete the parts of a clip file other than the 
playback part (trimming)

1 Set the playback start point and stop point.

2 Press [Trim].

A confirmation message appears.

3 Press [Yes].

Using the device control block (search 
dial) to play back clips

A frame memory clip must first be recalled with a menu 
operation.

1 With the device selection buttons, select the frame 
memory clip to be played (FM1 CLIP to FM8 CLIP).

If the pair mode is on, both main and subsidiary FMs 
light.

2 Press the [PLAY] button, turning it on.

To stop playback, press [STOP] or any of the [SHTL], 
[JOG], [CUE], [REW], [FF], and [ALL STOP] 
buttons.

For details of the buttons in the device control block 
(search dial), see “Device Control Block (Search 
Dial)” (page 39).

To specify the playback start point
To make the current position the playback start point, press 
the [START TC] button. To set a different position, press 
the [SET START TC] button, then enter the timecode from 
the numeric keypad control block.

To specify the duration
Press the [SET DUR] button, and enter a timecode from 
the numeric keypad control block. If the playback start 
point is already set, this automatically sets the playback 
stop point. If the playback stop point is already set, this 
automatically sets the playback start point. (The duration 
setting is not displayed in the device control block.)

To specify the playback stop point
Start playback, and at the desired position press the 
[STOP] button to stop playback, then press the [STOP TC] 
button. To set to any position, press the [SET STOP TC] 
button, and enter a timecode from the numeric keypad 
control block.

To carry out the variable speed playback
Use the search dial.

For details on using the search dial, see “Controlling the 
Tape/Disk Transport” in Chapter 12 (Volume 2).

To apply a loop to a frame memory clip
Press the [LOOP] button.

Using the device control block (trackball) 
or device control block (joystick) to play 
back clips

A frame memory clip must first be recalled with a menu 
operation.

1 Press the [DEV] button in the region selection buttons, 
and select the frame memory clip for playback (FM1 
CLIP to FM8 CLIP).

If the pair mode is on, both main and subsidiary FMs 
light.

2 Press the [PLAY] button, turning it on.

To stop playback, press [STOP] or any of the [SHTL], 
[JOG], [CUE], [REW], [FF], and [ALL STOP] 
buttons.

Notes 
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For details of the buttons in the device control block 
(trackball) or device control block (joystick), see “Device 
Control Block (Trackball)” (page 35).

For details of the playback start point, stop point, and 
duration settings, see the previous item, “Using the device 
control block (search dial) to play back clips” (page 205).

To carry out the variable speed playback
Press any of the [SHTL], [JOG], and [VAR] buttons, then 
turn the Z-ring or move the joystick. The image changes in 
the forward direction when you turn the Z-ring clockwise, 
and in the reverse direction when you turn it 
counterclockwise. Move the joystick to the right for the 
forward direction and to the left for the reverse direction.
When you pressed the [JOG] button: Playback is at a 

speed corresponding to the turning speed of the Z-ring 
or the movement speed of the joystick.

When you pressed the [SHTL] button: Playback is at a 
speed corresponding to the rotation angle of the Z-ring 
or amount of movement of the joystick.

When you pressed the [VAR] button: Playback is at a 
speed corresponding to the rotation angle of the Z-ring 
or amount of movement of the joystick, in the range 
–1 to +3 times normal speed.

Clip Creation

You save a movie as a clip.

If the number of frame memory clips exceed 100 single 
files (50 pair files), an error appears.

Using the menu to record clips

1 In the Frame Memory menu, select VF2 ‘Clip’ and 
HF3 ‘Record.’

The Record menu appears.

2 With [Pair] off, press the operation target selection 
button, to select the operation target.

3 In the folder selection area, select the folder containing 
the clip to be recorded.

4 In the <Record Enable> group, select the clip type.

• To record a normal clip, press [Clip].
• To record an extended clip, press [Ext Clip].

5 To set the clip name, press [Name].

A keyboard window appears.

6 Enter the clip name, and press Enter.

7 To start recording, press [Record Start].

8 To end recording, press [Record Stop].

To set the clip duration

1 Press [Clip Duration].

A numeric keypad window appears.

2 Enter a timecode value or number of frames, and press 
Enter.

Creating and Handling Frame 
Memory Folders

You can create, rename, and delete frame memory folders.

Creating a new folder

1 In the Frame Memory menu, select VF5 ‘Folder.’

Notes 

Frame memory 
selection area

Operation target 
selection buttons

Pair selection 
buttons

Folder selection 
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The Folder menu appears. The status area shows a list 
of the current folder settings.

2 Select [New].

A keyboard window appears.

3 Enter the folder name, and press Enter.

Changing the folder name

1 In the Frame Memory >Folder menu, select the folder 
with the arrow keys or by turning the knobs.

2 Press [Rename].

A keyboard window appears.

3 Enter the new folder name, and press Enter.

The following names cannot be used for folders:
Default, Flash1, Flash2

CON, PRN, AUX, CLOCK$, NUL, COM0, 
COM1, COM2, COM3, COM4, COM5, COM6, 
COM7, COM8, COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, 
LPT7, LPT8, LPT9

This changes the folder name.

Deleting a folder

1 In the Frame Memory >Folder menu, select the folder 
with the arrow keys or by turning the knobs.

To select all folders, select [All].

2 Press [Delete].

A confirmation message appears.

3 To carry out the deletion select [Yes], and to cancel the 
deletion select [No].

It is not possible to delete the default folder (named 
“Default”).

Clip Output

As for still image operation, you can use the reposition and 
lock functions.

For details of the operation, see “Image Output” (page 
199).

Recording and Playback of Ancillary 
Data

Preparations
To record ancillary data, it is first necessary in the Setup 
menu to select “save with ancillary data” as the frame 
memory saving mode.

For details, see “Saving a Frame Memory Clip With 
Ancillary Data” in Chapter 18 (Volume 2).

Recording ancillary data
To record ancillary data in a frame memory clip, use the 
Frame Memory >Clip >Record menu. 

For details of the operating sequence, see “Clip Creation” 
(page 206).

To check ancillary data during recording
If the ancillary data to be recorded is embedded audio, by 
first setting the signal output to through mode, you can 
listen while recording.

For the method of setting the signal output to through 
mode, see “Signal Output Settings (Output Menu)” in 
Chapter 20 (Volume 2).

 

For [Freeze Enable] or [Record Enable], in the <Record 
Enable> group, pressing [Clip] or [Ext Clip] to turn them 
on or off may result in noise. Also, with these buttons in 
the On state, selecting the signal on the frame memory 
source bus may result in noise.

Knob Parameter Adjustment Setting values

1 No. Folder selection 1 to 12

2 Num Number of files to 
select 
consecutively 
from selected file

1 to 12

Notes 

Knob Parameter Adjustment Setting values

1 No. Folder selection 1 to 12

2 Num Number of files to 
select 
consecutively 
from selected file

1 to 12

Notes 
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Playing back ancillary data
You can play ancillary data recorded in a frame memory 
clip by normal playback or an auto transition of the clip 
transition.
To play the ancillary data, you must use the following 
procedure to enable playback of the ancillary data. 

For the subsequent playback operation, see “Clip 
Playback” (page 204).

• After recording a frame memory clip, the ancillary data 
state is enabled for playback.

• To play back the clip, set the signal output to through 
mode.
For the method of setting through mode, see “Signal 
Output Settings (Output Menu)” in Chapter 20 
(Volume 2).

• When the reposition function is on, ancillary data cannot 
be played back.

• Switching reposition function between on and off may 
cause noise.

• Only the AUX bus and edit preview bus can output 
ancillary data.

• For loop playback of clips in the following video 
formats, the loop playback range must be at least 5 
frames, and set to a multiple of 5 frames.
- 480i/59.94
- 720P/59.94
- 1080i/59.94
- 1080PsF/29.97

• Recalling operations of still images or clips can cause 
noise.

• Carrying out file operations on a frame memory clip may 
result in the ancillary data being discontinuous, or in 
noise occurring. However, if the first or last frame of the 
clip is deleted, noise will not occur.

• The audio sampling frequency is always 48 kHz.
• In the case of 480i or 59.94, noise may occur at the 

beginning of playing back a clip. This can be avoided by 
making the first nine or more frames of the clip 
soundless.

• When you play back the recorded embedded audio, 
depending on the device to be used, noises are produced 
at the playback start point and end point. For details of 
devices that are used for playback, contact your Sony 
service or sales representative.

1 In the Frame Memory menu, select VF2 “Clip”, HF5 
“Ancillary Enable.”

2 Select the frame memory folder and file to be played 
back.

3 Set the [Ancillary Enable] button to On.

Clip Transition 
Operations

A frame memory clip (movie) is played back, linked to a 
transition using a mix (dissolve) or wipe.
The following restrictions apply to the use of a clip 
transition.
• Key frame capture is not possible.
• It is not possible to apply a pattern limit.
• Transitions executed in two strokes, such as a preset 

color mix with the stroke mode set to Normal, or a DME 
wipe with a picture-in-picture pattern, will not execute 
correctly.

• It is not possible to vary the transition rate of a clip 
transition.

• Transition preview cannot be used.
• No instantaneous state of a clip transition can be saved 

as a snapshot.
• When recalling a snapshot including a clip transition 

during executing another clip transition, the follow-on 
transition does not operate properly. Be sure to complete 
the transition before recalling a snapshot.

When a clip transition is selected as the transition type, if 
one of the wipe direction selection buttons in the transition 
control block is lit, it indicates the direction of clip 
playback.

Setting a clip transition
The following example describes the case of a clip 
transition using FM 1&2 Clip on the M/E-1 bank.

To use a clip transition effectively, the image from the 
frame memory clip being played back during the clip 
transition should be seen in the M/E-1 program output. For 
example, inserting a key using frame memory output 1 and 
frame memory output 2.

1 Display the M/E-1 >Misc >Transition menu, and in the 
<Transition Type> group select “FM1&2 Clip.”

2 Press [Clip Transition].

The Clip Transition menu appears.

Notes 
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3 Press the [Clip] button.

The status area shows a list of clips.

4 Select the clip to use in the clip transition.

5 Return to the Clip Transition menu, and in the <BKGD 
Transition Type> group, select the background 
transition type.

For details of the background transition selected here, 
see the various adjustments in the M/E-1 >Misc 
>Transition menu.

6 In the <Select> group, press [BKGD Transition].

7 Use either of the following methods to set the 
background transition start point independently of the 
clip playback timing.

• Move the fader lever to the desired position, and in 
the <BKGD Transition Set Timing> group press 
[Start].

• Turn knob 1 to set the number of frames. (The left 
end of the reference axis (see following figure) is the 
position of frame 0.)

8 Using either of the following methods, set the end 
point of the background transition.

• Move the fader lever to the desired position, and in 
the <BKGD Transition Set Timing> group press 
[Stop].

• Turn knob 2 to set the number of frames.

9 If Wipe or DME Wipe is selected in the <BKGD 
Transition Type> group, in the <BKGD Transition 
Direction> group, select the background transition 
direction.

10In the <Select> group, press [FM1&2 Clip].

11Using either of the following methods, set the start 
point of the clip.

• Move the fader lever to the desired start point, and in 
the <Clip Transition Set Timing> group press 
[Start].

• Turn knob 1 to set the number of frames. (The left 
end of the reference axis (see previous figure) is the 
position of frame 0.)

It is not possible to set the end point.

12In the <Clip Transition Direction> group, select the 
playback direction of the clip.

To reset the start point and end point
Press [Timing Reset].
The background transition start point and end point, and 
the clip start point are all reset.

Notes 

Clip display area

Background transition display area

Clip transition display area

Notes 
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Image Data Management

You can carry out the following operations on the files in 
which images are saved.
• Pair File Processing (page 210)
• Moving Files (page 210)
• Deleting Files (page 211)
• Renaming Files (page 211)

During playback of a frame memory clip of the pair 
assigned to either of the target FM selection buttons (see 
page 204), frame memory operations may not be 
performed properly. Carry out frame memory operations 
after stopping clip playback.

Pair File Processing

You can create a pair file from two single files. In the 
reverse direction, you can split a pair file into two single 
files.
Couple: You can create a pair file from two single still 

image files or clip files.
Separate: You can also separate a pair file into two single 

still image files or clip files.

Creating a pair file from two single files

Carrying out the following operation automatically 
switches [Pair] to On.

The following description applies to the case of FM1&2, 
but the procedures are similar for the other cases.

1 In the Frame Memory >Still >Recall menu or Frame 
Memory >Clip >Recall menu, recall the two single 
files you want to convert to a pair file, to FM1 and 
FM2.

2 In the Frame Memory menu, select VF4 ‘File’ and 
HF1 ‘Pair Recombination.’

The Pair Recombination menu appears.

3 Press [Couple].

Splitting a pair file into two single files

Carrying out the following operation automatically 
switches [Pair] to Off.

The following description applies to the case of FM1and 
FM2, but the procedures are similar for the other cases.

1 In the Frame Memory >Still >Recall menu or Frame 
Memory >Clip >Recall menu, recall the pair file.

2 Select the folder in which the file to be moved is 
stored.

3 In the Frame Memory menu, select VF4 ‘File’ and 
HF1 ‘Pair Recombination.’

The Pair Recombination menu appears.

4 Press [Separate].

Moving Files

1 In the Frame Memory menu, select VF4 ‘File’ and 
HF4 ‘Move.’

The Move menu appears. The status area shows files 
to be moved in the upper area, and destination files in 
the lower area.

2 Select the folder which contains the file to be moved.

3 Using any of the following methods, select the file to 
be moved.

• Press the arrow keys to scroll the display.
• Press directly on the thumbnail in the status area.
• Turn the knobs.

4 Select the destination folder and file.

5 Press [Move].

6 To confirm the move press [Yes], and to cancel press 
[No].

Notes 
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Deleting Files

1 In the Frame Memory menu, select VF4 ‘File’ and 
HF5 ‘Delete.’

The Delete menu appears. In the status area, whether 
pair mode is on or off, all of the saved files appear as 
thumbnails.

2 Select the folder which contains the file to be deleted.

3 Using either of the following methods, select the file to 
be deleted. If necessary, press the arrow keys to scroll 
the display.

• Press directly on the thumbnail in the status area.
• Turn the knobs.

• To delete all files, press [Select All], turning it on.
• When a clip thumbnail is selected, the still image 

files making up the clip are also selected for 
deletion.

4 If necessary, turn the knob to check the contents of the 
frame memory clip through the thumbnail display.

5 Press [Delete].

A message for confirming the deletion appears.

6 To confirm the deletion press [Yes], and to cancel 
press [No].

Renaming Files

1 In the Frame Memory menu, select VF4 ‘File’ and 
HF6 ‘Rename’

The Rename menu appears. In the status area, whether 
pair mode is on or off, all of the saved files appear as 
thumbnails.

2 Using either of the following methods, select the file to 
be renamed. If necessary, press the arrow keys to scroll 
the display.

• Press directly on the thumbnail in the status area.
• Turn the knobs.

3 If necessary, turn the knob check the contents of the 
frame memory clip through the thumbnail display.

4 Press [Rename].

A keyboard window appears.

5 Enter the new name, then press [Enter] in the keyboard 
window.

The following names cannot be used:
CON, PRN, AUX, CLOCK$, NUL, COM0, 
COM1, COM2, COM3, COM4, COM5, COM6, 
COM7, COM8, COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, 
LPT7, LPT8, LPT9

Knob Parameter Adjustment Setting values

1 No File selection 1 and upwards

2 Num Selection of 
number of 
files in 
sequence

1 and upwards

Knob Parameter Adjustment Setting values

3 Viewer For a movie, 
the current 
frame 
position. For 
a still image, 
no effect.

00:00:00 and 
upwards

Knob Parameter Adjustment Setting values

1 No File selection 1 and upwards

Knob Parameter Adjustment Setting values

3 Viewer For a movie, 
the current 
frame 
position. For 
a still image, 
no effect.

00:00:00 and 
upwards
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External Hard Disk Drive 
Access

You can connect a hard disk drive to the USB port of the 
switcher processor, to carry out the following operations.
Format: Format the hard disk.
Backup: Batch saving of files from frame memory to the 

hard disk.
Restore: Restoring frame memory from files saved on the 

hard disk.
Since image data saved in memory is lost when the system 
is powered off, using an external hard disk drive allows 
required data to be preserved.

• Only one hard disk drive can be connected to a single 
switcher processor.

• While the hard disk is being accessed, frame memory 
operations are not possible. This applies to all operations 
for frame memory including frame memory recall by a 
snapshot operation.

• During playback of a frame memory clip of the pair 
assigned to either of the target FM selection buttons (see 
page 204), frame memory operations may not be 
performed properly. Carry out frame memory operations 
after stopping clip playback.

• When the signal format is 1080P, this function cannot be 
used.

Consult your Sony service representative or sales 
representative about the hard disk drives that can be 
connected.

Hard Disk Formatting

When you connect a hard disk drive for the first time, it is 
necessary to format the hard disk. This partitions the disk, 
creating 15 logical areas (FMHDD1 to FMHDD15).

1 In the Frame Memory menu, select VF6 ‘External 
Device’ and HF1 ‘Ext HDD Format.’

The Ext HDD Format menu appears.

To get the hard disk drive information
In the button area press [Refresh Status].
The Device item shows the product information for the 
hard disk drive.

2 Press [Format].

A popup window for confirming formatting appears.

Carrying out formatting erases any existing data on the 
hard disk.

3 Press [Yes].

This starts the hard disk formatting. A progress bar and 
numerical indication appear to show the progress of 
the operation.
When the operation is completed, a popup window 
reading “Success!!” appears.

4 Press [OK].

Saving Files

You can save all of the files from frame memory to the 
external hard disk drive.

Before carrying out this operation for the first time, it is 
necessary to format the hard disk (see previous item, 
“Hard Disk Formatting”).

1 In the Frame Memory menu, select VF6 ‘External 
Device’ and HF2 ‘Ext HDD Backup/Restore.’

The Ext HDD Backup/Restore menu appears.
For each partition, a list of the directory names and 
number of files appears.

To get the hard disk drive information
Press [Refresh Status].
The Device item shows the product information for the 
hard disk drive, and the names of directories.

2 Using any of the following methods, select a logical 
drive (FMHDD1 to FMHDD15).

• Press directly on the list to select.
• Turn the knob.

3 In the <Backup> group, do either of the following.

• To replace the existing data, press [Replace].
• To save in addition to the existing data, press 

[Append].

A popup window for confirming file saving appears.

Notes 

Notes 

Notes 

Knob Parameter Adjustment Setting values

1 Partition Partition 
selection

1 to 15
External Hard Disk Drive Access



  C
hapter 7  Fram

e M
em

ory
When you execute [Replace], all of the saved files in 
the logical drive is erased immediately before the 
saving operations.

4 Press [Yes].

This starts the file saving operation. If there is no 
directory, a directory is automatically created, and the 
files are saved within it. A progress bar and numerical 
indication appear to show the progress of the 
operation.
When the operation is completed, a popup window 
reading “Completed.” appears.

5 Press [OK].

To rename a directory
Select a directory in the list, and in the button area press 
[Rename].
In the keyboard window that appears, enter the new 
directory name, and press [Enter]. The name of a directory 
is limited to eight characters.

The following names cannot be used:
CON, PRN, AUX, CLOCK$, NUL, COM0, COM1, 
COM2, COM3, COM4, COM5, COM6, COM7, 
COM8, COM9
LPT0, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, 
LPT8, LPT9

Recalling Files

You can recall all of the saved files on the hard disk drive 
into frame memory.

1 Carry out steps 1 and 2 of the procedure “Saving 
Files” (page 212).

It is not possible to select a partition (FMHDD1 to 
FMHDD15) of a hard disk in which no file is saved.

2 In the <Restore> group, do either of the following.

• To replace the existing data with the recalled data, 
press [Replace].

• To add the recalled data to the existing data, press 
[Append].

A popup window for confirming file recall appears.

When you execute [Replace], any existing data in 
frame memory is lost immediately before the recalling 
operations.

3 Press [Yes].

This starts the file recall operation. A progress bar and 
numerical indication appear to show the progress of 
the operation.
When the operation is completed, a popup window 
reading “Completed.” appears.

4 Press [OK].

Notes 

Notes 

Notes 

Notes 
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Managing Images Using a 
DDR/VTR

Using a DDR/VTR for High-speed 
Backup and Restoring

You can save all files currently held in frame memory as a 
backup data set, by high-speed recording on video tape or 
other medium. 
To restore the folder structure, it is necessary to save the 
automatically generated file list (of file name, length of 
clip, and so on) in memory.

At the beginning of this backup data a red or blue image is 
automatically inserted when the data is created. Do not 
delete this image, as it is required for restoring the data.

High-speed recording of backup data to 
DDR or VTR

Before starting the backup, it is necessary to select the FM 
output to record on an AUX bus, for example, and input 
the AUX output to the DDR/VTR.

1 In the Frame Memory menu, select VF6 ‘External 
Device,’ and HF4 ‘Backup to DDR/VTR.’

The Backup to DDR/VTR menu appears.

2 To save with ancillary data, output the frame memory 
output signal to the AUX bus.

3 In the <Backup Enable> group, select either of the 
following.

Clip/Still: Data from the first board (still images and 
clips)

Ext Clip: Data from the second board (extended clips)

4 Press [Backup Start].

The message “Preparing now...” is displayed in a 
popup window, and it changes to a confirmation 
message when the preparation is complete.

5 Start recording at the external device, and immediately 
after that press [Yes].

This starts the backup, and when completed a message 
appears.

6 Stop the recording at the external device, and press the 
[OK] button.

7 To save the file list in memory, press [File >File Name 
Data].

The File >File Name Data menu appears.
The name of the file that is saved is fixed (FM_Bkup).

For details, see “Overview of File Operations” in 
Chapter 17 (Volume 2).

Restoring backup data from DDR or VTR

Before starting the restore operation, it is necessary to 
select the DDR/VTR output on the FM input bus.

1 In the Frame Memory menu, select VF6 ‘External 
Device’ and HF5 ‘Restore from DDR/VTR.’

The Restore from DDR/VTR menu appears.

2 Press [File >File Name Data], to read the file list from 
the File Name Data menu.

For details, see “Overview of File Operations” in 
Chapter 17 (Volume 2).

3 To restore the ancillary data, select any of FM1, FM3, 
and FM5.

4 In the <Restore Enable> group, select either of the 
following.

Clip/Still: Data from the first board (still images and 
clips)

Ext Clip: Data from the second board (extended clips)

5 In the <Restore Type> group, press either of the 
following.

Replace: Replace the existing frame memory data 
with the recalled data.

Append: Add to the existing frame memory data.

If you selected “Ext Clip” in step 4, “Append” is 
selected automatically.

6 Press [Restore Start].

A confirmation popup window appears.

7 Start playback at the external device, and immediately 
after that press [Yes].

Notes 

Notes 

Notes 

Notes 
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Make sure to include that the red or blue image 
inserted at the beginning when the backup was made. 
If this image is not found, the clip or still image will 
not be played back correctly.

This starts the restore operation, and when completed 
a message appears.

8 Stop the playback at the external device, and press the 
[OK] button.

Extracting Images from Video Tape

By recording a clip or still image stored on a video tape as 
a single clip (single file) under certain rules, you can 
automatically extract an image from the clip, and save as a 
separate frame memory file.

When the signal format is 1080P, this function cannot be 
used.

Relation between recorded state of video 
tape and files after extraction
The extraction is carried out according to the following 
rules.

Example 1: When only video signal clips and a 
still image are recorded (single files)

Result of extraction:
Each section surrounded by red marker frames is extracted 
as a clip (main file). If the red markers surround a single 
frame, then it is extracted as a still image. In the case above 
two clip files (main files) are extracted, and one still image 
file.

Example 2: When a video signal clip is followed 
by a key signal clip with the same number of 
frames (pair file)

Result of extraction:
The section surrounded by red marker frames is extracted 
as the main file, and the section surrounded by blue marker 
frames is extracted as the sub file.
In the case above, one clip file (pair file) is extracted.

a) A red marker frame is a monochrome frame with the RGB signal levels 
respectively 100%, 0%, 0%.

b) A blue marker frame is a monochrome frame with the RGB signal levels 
respectively 0%, 0%, 100%.

• For extraction as a pair file, the main file and sub file 
must have the same number of frames.

• For image extraction as an extended clip, [Ext Clip] must 
be selected in the Record menu <Record Enable> group 
when the video tape content is recorded as a clip.

• For image extraction as still images, [Clip] must be 
selected in the Record menu <Record Enable> group 
when the video tape content is recorded as a clip.

1 In the Frame Memory >Clip >Record menu, record the 
tape image as a clip (see page 206).

2 In the Frame Memory menu, select VF4 ‘File’ and 
HF2 ‘Auto Extraction.’

The Auto Extraction menu appears.

3 Select a clip (single file) recorded from the tape.

4 Press [Extraction Start].

A confirmation popup window appears.

5 Press [Yes].

This starts the extraction, analyzes the currently 
selected single clip, and automatically extracts a 
movie (Clip) or still image (Still). When there is key 
data, a pair file is created.

To check the details of the images (still image/
clip)
Use the following knob operations.

Notes 

Notes 

V: video    
Red: red marker frame a)

Video tape

Notes 

V: video    
K: key    
Red: red marker frame a)    
Blue: blue marker frame b)

Video tape
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Knob Parameter Adjustment Setting values

1 No. File number 1 to maximum

3 Viewer Timecode for 
selected image

00:00:00 to 
maximum
Managing Images Using a DDR/VTR
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Color Background

The dedicated generators generate color signals, and these 
can be used as color backgrounds in video effects.

Color background selection
There are two color backgrounds, color background 1 and 
color background 2, which you use by assigning to cross-
point buttons.

Color combinations (“color mix”)
The color generators can output the result of combining 
two colors, which are color 1 and color 2.
Using a pattern from a dedicated pattern generator, color 1 
and color 2 can be combined in the boundary region, 
forming a color gradation. This is referred to in the menu 
system as “color mix.”
You can also apply modifiers to the selected pattern.
When the “color mix” function is not used, the result is a 
flat color, and color 1 is always output.
You carry out color background settings in the Color Bkgd 
menu. This section describes the settings menu for color 
background 1 as an example.

Color Background Settings Menu

Accessing the Color Bkgd1 menu
Use either of the following operations.
• In the menu control block, select the top menu selection 

button [COLOR BKGD], and press VF1 ‘Color Bkgd1.’
• Press a cross-point button assigned to color background 

1 twice in rapid succession.

Basic Color Background Setting 
Operations

Making a single-color matte (Flat Color)
If you are not using the “color mix” function to combine 
two colors, use the following procedure.

1 In the <Matte> group of the Color Bkgd 1 menu, press 
[Flat Color], turning it on.

2 Set the following parameters.

Making a color combination (color mix)
To combine color 1 and color 2, use the following 
procedure.

1 In the <Matte> group of the Color Bkgd1 menu, press 
[Mix Color], turning it on.

2 Set the following parameters as required.

a) The patterns are the same as for a standard wipe. See “Wipe Pattern 
List” (page 344).

You can also carry out the pattern selection by 
pressing the [Mix Ptn Select] button, to display the 
Mix Ptn Select menu. Select any pattern appearing in 

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of 
softening of 
edge

0.00 to 100.00

5 Pattern Pattern number 1 to 24 a)
217Color Background
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the Mix Ptn Select menu (standard wipe patterns 1 to 
24), and you can then adjust the following parameters.

3 To adjust color 1, set [Color 1] on, and to adjust color 
2 set [Color 2] on, then adjust the parameters.

4 If required, set the pattern modifiers.

When turning [Position] on and setting the pattern 
position

a) See page 158.

When turning [Multi] on and using replications of 
the same pattern 

a) See page 160.

When turning [Aspect] on and setting the aspect 
ratio of the pattern

a) See page 160.

When turning [Pairing] on and making a wipe 
pattern like a Venetian blind

When turning [Angle] on in the <Rotation> group 
and slanting the pattern

a) See page 159.

When turning [Speed] on in the <Rotation> group 
and rotating the pattern at a constant rate

a) See page 159.

When selecting H (horizontal) or V (vertical) in the 
<Modulation> group and applying waviness to the 
pattern
(The modulation is always a sine wave.)

When using 1080PsF mode in an HD system, the 
modulation function is not available.

a) See “Applying modulation to the wipe pattern (Modulation)” (page 
161).

5 To interchange color 1 and color 2, press the [Color 
Invert] button, turning it on.

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Edge softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal 
position

–200.00 to 
+200.00 a)

2 Position V Vertical position –200.00 to 
+200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of 
repetitions of 
pattern 
horizontally

1 to 63

2 V Multi Number of 
repetitions of 
pattern vertically

1 to 63

3 Invert Type Replication 
layout

1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

1 Width Width of the slits 1 to 128 
(integer)

Knob Parameter Adjustment Setting values

1 Angle Angle of pattern 
rotation

–100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate of 
pattern

–100.00 to 
+100.00 a)

Notes 

Knob Parameter Adjustment Setting values

1 Amplitude Amplitude of 
modulation

0.00 to 100.00

2 Frequency Frequency of 
modulation

0.00 to 100.00

3 Speed Speed of waves –100.00 to 
+100.00 a)
Color Background
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Copy and Swap

Overview of Copy and Swap

You can copy or swap the settings among the switcher 
banks or between keyers.
The following settings can be copied or swapped.
• Overall settings for the M/E-1 to M/E-4, and PGM/PST 

banks
• Keyer settings
• Wipe settings in a transition control block
• Wipe settings in an independent key transition control 

block
• DME wipe settings in a transition control block
• DME wipe settings in an independent key transition 

control block
• Matte data (color 1, color 2, and how to compose them)
• Color settings
• DME channel settings
• Format converter input settings (copy only)
• Format converter output settings (copy only)
You can carry out copy operations with a simple button 
operation. Swap operations, and copy operations on DME 
data can only be done with a menu operation.

M/E copy and M/E swap
You can copy and swap the overall bank settings among 
the M/E-1 to M/E-4, and PGM/PST banks.

If a DME is being used on the source M/E bank, then if for 
example there are insufficient DME channels, it may not 
be possible to select the DME.
There are no such restrictions on a swap.

Keyer copy and keyer swap
You can carry out copy and swap operations among the 
keyers listed in the following table.

If a DME is being used on the source keyer for a copy or 
either keyer for a swap, then if for example there are 
insufficient DME channels, or the limit on using DME 
channels within an M/E bank is exceeded, it may not be 
possible to select the DME.

Wipe copy and wipe swap
You can copy and swap the wipe settings among the banks 
listed in the following table.

Wipe copy and wipe swap in the 
independent key transition control block
You can copy and swap the wipe settings among the keyers 
listed in the following table.

DME wipe copy and DME wipe swap
You can copy and swap the DME wipe settings among the 
banks listed in the following table.

Target 
bank

Target data

M/E-1
M/E-2
M/E-3
M/E-4
PGM/
PST

Bank settings excluding the following data items:
• Setup data
• Flexi Pad settings
• Snapshots
• Keyframe effects
• Key snapshots
• Key memory

Notes 

Target 
bank

Target keyer Target data

M/E-1
M/E-2
M/E-3
M/E-4

Keys 1 to 8 Key settings excluding 
the following data items:
• Setup data
• Key snapshots
• Key memoryPGM/

PST
Downstream keys 1 to 8

Notes 

Target 
bank

Target data

M/E-1
M/E-2
M/E-3
M/E-4
PGM/
PST

Wipe settings.
It is not, however, possible to carry out copy or 
swap involving independent key transition wipe 
settings.

Target 
bank

Target keyer Target data

M/E-1
M/E-2
M/E-3
M/E-4

Keys 1 to 8 Wipe settings in the 
independent key 
transition control block.

PGM/
PST

Downstream keys 1 to 8

Target 
bank

Target data

M/E-1
M/E-2
M/E-3
M/E-4
PGM/
PST

DME wipe settings.
It is not, however, possible to carry out copy or 
swap involving independent key transition DME 
wipe settings.
219Copy and Swap
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DME wipe copy and DME wipe swap in the 
independent key transition control block
You can copy and swap the DME wipe settings among the 
keyers listed in the following table.

Matte data copy and swap
You can copy or swap the matte data among the color 
generators listed in the following table.

Color data copy and swap
You can copy or swap the color data among the color 
generators listed in the following table.

DME channel copy and swap
You can copy and swap the channel data among DME 
channels 1 to 4 or DME channels 5 to 8.
It is not possible to copy or swap the channel data between 
DME channels 1 to 4 and DME channels 5 to 8.

On the MVS-8000X, when the signal format is 1080P, the 
combinations for a copy or swap are restricted as follows.
• Channels 1 and 2
• Channels 3 and 4
• Channels 5 and 6
• Channels 7 and 8

On the MVS-7000X, when the signal format is 1080P, the 
above restriction also applies if using the MVE-8000A. 
There is no such restriction for the MKS-7470X/7471X.

Copying format converter data
You can copy data from one format converter input to 
another or from one output to another.

The copy source and destination data must be in the same 
signal format.

Copy and Swap Operations

Copy and Swap Menu Operations
In the menu operation section top menu selection buttons, 
press the [Copy/Swap] button, then press VF1 ‘Copy/
Swap.’ The Copy/Swap menu appears.
Here a copy/swap operation on wipe data is described by 
way of example, using the Copy/Swap >Wipe menu, but 
the same general procedure applies to all of the following 
menus.
• M/E: Copying and swapping M/E data
• Key: Copying and swapping key data
• Wipe: Copying and swapping wipe data
• DME Wipe: Copying and swapping DME wipe data
• Matte: Copying and swapping matte data
• Color: Copying and swapping color data
• DME: Copying and swapping data by DME channels
• Format Converter: Copying format converter data

For an overview of the concepts involved, see “Copy and 
Swap” (page 219). For details of color corrector copy 
and swap, see “Copy and Swap Operations” (page 229).

Target 
bank

Target keyer Target data

M/E-1
M/E-2
M/E-3
M/E-4

Keys 1 to 8
But excluding keys 5 to 8 
on M/E-4 In the MVS-
8000X

DME wipe settings in the 
independent key 
transition control block.

PGM/
PST

Downstream keys 1 to 8

Target 
bank

Target keyer and data

M/E-1
M/E-2
M/E-3
M/E-4
PGM/PST

• Keys 1 to 8
• Downstream keys 

1 to 8

• Matte data for key fill
• Matte data for key 

edge fill

Matte data for wipe border edge

Color 
background

• Matte data for color background 1
• Matte data for color background 2

Target 
bank

Target keyer and data

M/E-1
M/E-2
M/E-3
M/E-4
PGM/PST

• Keys 1 to 8
• Downstream keys 

1 to 8

• Colors 1 and 2 for 
key fill

• Colors 1 and 2 for 
key edge fill

• “Zabton” color data

Colors 1 and 2 for wipe border

Color data for preset color mix

Color 
background

• Colors 1 and 2 for color background 1
• Colors 1 and 2 for color background 2

Frame 
memory

• FM1 color
• FM2 color

DME ch1 to 
ch8

• Background
• Border
• Sepia
• Light
• Shade
• Drop shadow (other than DME ch4 and 

DME ch8)
• Trail

Notes 

Notes 
Copy and Swap
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Examples of Copy and Swap Operations 
by a Menu Operation
As an example, to copy or swap wipe data, use the 
following procedure.

1 In the Copy/Swap menu, select HF3 ‘Wipe.’

The Copy/Swap >Wipe menu appears.
The status area shows lists for the copy/swap source on 
the left, and the copy/swap destination on the right.

2 In the <Data Select> group, select either of the 
following.

Wipe: The operation applies to wipes in the transition 
control block.

Key Wipe: The operation applies to wipes in the 
independent key transition control block.

3 Using any of the following methods, select the data to 
be copied or swapped.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video 

cursor.
• Turn the knobs to make the setting.

a) Transition control block wipe data
b) Independent key transition control block wipe data

For details of the data affected, see “Copy and Swap” 
(page 219).

4 To copy, press [Copy], and to swap, press [Swap].

To undo a copy or swap 
Press [Undo], to return to the state before the copy or swap 
was carried out.

Copy by Button Operation
You can carry out the following copy operations by a 
simple button operation.
• M/E copy
• Keyer copy
• Wipe copy
• DME wipe copy

On the CCP-6224/6324, it is not possible to carry out a 
copy by button operation.

Basic button operation
The basic button operation is to hold down the copy source 
button, then press the destination button.
You can undo the last operation using [Undo] in the menu 
(see page 221).

M/E copy button operation
In the Flexi Pad control block of each M/E bank, use the 
[SNAPSHOT] button.

To copy from M/E-1 to M/E-2
In the M/E-1 Flexi Pad control block, hold down the 
[SNAPSHOT] button, then press the [SNAPSHOT] button 
in the M/E-2 Flexi Pad control block.

Keyer copy button operation
To specify the copy source, use the key delegation buttons 
in the key control block, and to specify the copy 
destination, use the key delegation buttons in the 
independent key transition control block.

To copy from M/E-1 key 1 to M/E-2 key 2
In the key control block M/E delegation buttons, press [M/
E1], turning it on, then hold down the [KEY1] button, and 
in the M/E-2 independent key transition control block, 
press the [KEY2] button.

Wipe copy button operation
Use the [WIPE] button in the Flexi Pad control block of 
each M/E bank.

To copy the M/E-1 wipe to the M/E-2 wipe
In the M/E-1 Flexi Pad control block, hold down the 
[WIPE] button, then press the [WIPE] button in the M/E-2 
Flexi Pad control block.

DME wipe copy button operation
Use the [DME] button in the Flexi Pad control block of 
each M/E bank.

To copy the M/E-1 DME wipe to the M/E-2 DME 
wipe
In the M/E-1 Flexi Pad control block, hold down the 
[DME] button, then press the [DME] button in the M/E-2 
Flexi Pad control block.

Knob Parameter Adjustment Setting values

1 Left No Select data for 
copy/swap 
source

1 to 5 a)

1 to 40 b)

2 Right No Select data for 
copy/swap 
destination

1 to 5 a)

1 to 40 b)

Notes 
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Misc Menu Operations

In the Misc menu, you can carry out the following 
operations.
• Enabling and disabling operation from an external 

device, System Manager, or an editing keyboard.
• Enabling and disabling side flags on the background bus 

of each of the M/E-1 to M/E-4 and PGM/PST banks.
For the side flag function, see “Side Flags” (page 238).

• Switching the safe title function on or off for each 
switcher output.

• Displaying the transition rate, independent key transition 
rate, and fade-to-black transition rate for each of the M/
E and PGM/PST banks, and changing the settings.

Port Settings for Control From an 
External Device

Enabling or disabling control from an 
external device

1 In the menu control block, press the top menu 
selection button [MISC], then select VF1 ‘Enable’ and 
HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears with 
the status area showing the settings of the following 
ports.
• Switcher Remote1 to Remote4 ports (RS-422A, D-

sub 9-pin)
• Switcher GPI port (parallel, 25-pin) 
• DME1/DME2 Editor ports (RS-422A, D-sub 9-pin)
• DME1/DME2 GPI ports (parallel, 25-pin)
When the signal format is 1080P, you can also make 
settings for DME3/DME4.

2 In the <Switcher> or <DME> group, press on the 
name of the port for which you want to disable control 
from an external device, turning it off. 
To re-enable control for the port, press on its name 
once more.

For the AUX bus operation from the Remote 1 to 
Remote 4 ports of the switcher, the setting (Enable/
Disable/Manual) in the Setup menu takes precedence. 
Only when the setting is “Manual,” the settings made 
in the Port Enable menu apply.

For details, see “Interfacing With External Devices 
(Device Interface Menu)” in Chapter 19 (Volume 2).

DME override

1 In the menu control block, press the top menu 
selection button [MISC], then select VF1 ‘Enable’ and 
HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears.

2 In the <DME Override> group, select the DME 
override mode.

DME Override: When a switcher snapshot or effect 
using a DME is recalled, forcibly select the DME 
that was used when saving.

On Air Protect: The operation is the same as the 
DME override function, except that a DME being 
used by an M/E bank or P/P bank that is on air will 
not be forcibly selected.

If effects using the same DME channel are selected 
simultaneously in two or more regions, the DME is 
selected with the order of precedence P/P >M/E1 >M/
E2 >M/E3 >M/E4.

Enabling or disabling control from System 
Manager
By installing the BZPS-8000 System Management 
Software (System Manager), you can use a computer 
connected on a network for management of some switcher 
data and control operations.
To enable or disable this function, use the following 
procedure.

1 In the menu control block, press the top menu 
selection button [MISC], then select VF1 ‘Enable’ and 
HF1 ‘Port Enable.’

The Misc >Enable >Port Enable menu appears.

2 Press [System Manager].

Each time you press the button toggles between enable 
and disable.

Editing Keyboard Settings
 

The following operations are only possible when a license 
for the BZS-8050 Editing Control Software is activated.

For details of license registration, see “Installation and 
Device Setup (Install/Unit Config Menu)” in Chapter 18 
(Volume 2).

Notes 

Notes 

Notes 
Misc Menu Operations
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Enabling or disabling control from the 
editing keyboard

1 In the menu control block, press the top menu 
selection button [MISC], then select VF1 ‘Enable’ and 
HF2 ‘Plug-In Editor.’

The Misc >Enable >Plug-In Editor menu appears.

2 In the <Control From Plug-In Editor> group, press 
[Editor Enable].

Each time you press the button toggles between enable 
and disable.

To enable control of the preview bus only
When control from the editing keyboard is disabled (when 
[Editor Enable] is set to Disable), to enable control of the 
preview bus only, press [PVW Bus Enable] in the 
<Control From Plug-In Editor> group.

Safe Title Settings

Switching the safe title function on or off

1 In the menu control block, press the top menu 
selection button [MISC] and select VF2 ‘Safe Title.’

The Misc >Safe Title menu appears.

2 Using any of the following methods, select the signal 
to which the settings apply.

• Directly press the list in the status area.
• Press the arrow keys to scroll the reverse video 

cursor.
• Turn the knob to make the setting.

• It is not possible to change the setting for the output 
for which the safe title is set off in a Setup menu.

• The safe title function cannot be used for output 
signals for which through mode is set to Enable in a 
Setup menu.

For more information about the Setup menu settings 
referred to above, see “Signal Input Settings (Input 
Menu)” and “Signal Output Settings (Output Menu)” 
in Chapter 20 (Volume 2).

3 Press [Safe Title] to set it on or off.

Displaying a List of Transition Rates 
and Changing the Settings

In the Transition menu, for each bank you can display a list 
of the M/E (or PGM/PST) transition rates and independent 
key (or DSK) transition rates, and change the settings.
These settings are linked to the other transition rate setting 
operations.
You can also display and set the fade-to-black transition 
rate.

Displaying the Transition menu
In the menu control block, press the top menu selection 
button [MISC], then select VF3 ‘Transition.’
The Misc >Transition menu appears.

About the Transition menu display
The display of the independent key transition rate in the 
Misc >Transition menu depends on the selection in the 
<Key Transition> group of the Engineering Setup 
>Switcher >Transition menu for each of the M/E and 
PGM/PST banks.
When [Same] (On direction and Off direction settings 

the same) is selected in the <Key Transition> 
group: Only “Key” (or “DSK” in the PGM/PST bank) 
appears.

When [Independ] (On direction and Off direction 
settings independent) is selected in the <Key 
Transition> group: “Key(On)” and “Key(Off)” each 
appear. In the case of the PGM/PST bank, “DSK(On)” 
and “DSK(Off)” appear.

For details, see “Settings Relating to Video Switching 
(Transition Menu)” in Chapter 20 (Volume 2).

Setting the transition rate in the Transition 
menu

To set the M/E transition rate
For example, to make the settings for the M/E-1 bank, use 
the following procedure.

1 Press in the list in the status area of the Misc 
>Transition menu, to select M/E-1.

2 In the <Transition Rate> group, press [Transition].

3 Turn the knob to set the number of frames.

Knob Parameter Adjustment Setting values

1 Output Signal to which 
the settings 
apply

1 to 48

Notes 

Knob Parameter Adjustment Setting values

1 Transition 
Rate

Transition rate 0 to 999 
(frames)
223Misc Menu Operations
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When a clip transition is selected as the transition type, it 
is not possible to change the transition rate in this menu.

To set the independent key transition rate
By way of example, the following is the procedure for 
settings of keys 1 to 4 in the M/E-1 block.

1 Press in the list in the status area of the Misc 
>Transition menu, to select M/E-1.

2 In the <Transition Rate> group, press [Key K1-K4].

To insert (on) or remove (off) keys individually, press 
[Key(On) K1-K4] or [Key(Off) K1-K4].

3 Turn the knobs to set the number of frames.

To set the fade-to-black transition rate in 
the Transition menu

1 In the Misc >Transition menu, press [FTB].

2 Turn the knob to set the number of frames.

AUX Menu Operations

AUX Bus Settings

Making video process settings for an AUX 
bus

1 In the Aux >Aux Bus menu, using any of the following 
methods, select the AUX bus to which the settings 
apply.

• Directly press the list in the status area.
• Press the arrow keys to scroll the reverse video 

cursor.
• Turn the knob to make the setting.

2 Press [Video Process], turning it on.

3 Adjust the following parameters.

To return adjustment values to their defaults, press 
[Unity].

Notes 

Knob Parameter Adjustment Setting values

1 Key1 Trans 
Rate

Key 1 transition 
rate

0 to 999 
(frames)

2 Key2 Trans 
Rate

Key 2 transition 
rate

0 to 999 
(frames)

3 Key3 Trans 
Rate

Key 3 transition 
rate

0 to 999 
(frames)

4 Key4 Trans 
Rate

Key 4 transition 
rate

0 to 999 
(frames)

Knob Parameter Adjustment Setting values

1 Transition 
Rate

Transition rate 0 to 999 
(frames)

Knob Parameter Adjustment Setting values

1 AUX Bus AUX bus 
selection

1 to 48

Knob Parameter Adjustment Setting values

1 Video 
Gain

Video signal 
gain

–200.00 to 
+200.00

2 Y Gain Luminance 
signal gain

–200.00 to 
+200.00

3 C Gain Chrominance 
signal gain

–200.00 to 
+200.00

4 Hue Delay Hue delay –180.00 to 
+180.00

5 Black 
Level

Black level –7.31 to 
+109.59
AUX Menu Operations
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Status Menu

The Status menu shows the following information.
• Operating status of the DME

Viewing the DME operating status
To view the DME operating status, press the top menu 
selection button [STATS] in the menu control block.
This selects VF1 ‘DME Status’ and the Status menu 
appears.

For each DME channel, you can see how the DME is being 
used in the corresponding operation block.
The display background color also indicates the following 
differences in the way in which a DME is being used.
Blue: The DME is currently being used in other than the 

final program output.
Red: The DME is currently being used in the final 

program output.

Router Control Menu 
Operations

Using the Router >Router Control >Router Control menu, 
you can carry out router switching operations.

Checking the List of Inputs for Each 
Destination

You can check the list of signals currently input for each 
destination.
In the menu control block, press the top menu selection 
button [RTR], then select VF1 ‘Router Control’ and HF1 
‘Router Control.’
The following menu appears, and the left side of the status 
area shows a list for destination assignments.

If in the Assign >RTR Mode Setting menu, [Inhibit] is set 
to On for a destination, the corresponding line appears in 
gray. Also, if [PROT] (protect) is set to ON for a source, 
using a BKSR3xxx or R1xxx series Router remote control, 
a padlock icon appears.
The right side of the status area shows the level assignment 
status to the Level 1 to Level 4 buttons.

Selecting the level
In the <Level Button No> group at the lower right in the 
above illustration, press the selected level for switching.

Switching the Source for Each 
Destination

You can switch the source for each destination with a 
menu operation.
For the assignment of destinations and sources to buttons, 
use the Setup >Panel >Aux Assign >RTR Mode Setting 
menu.

DME status display
225Status Menu / Router Control Menu Operations
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For details, see “Using the Auxiliary Bus Control Block 
for Router Control” in Chapter 19 (Volume 2).

1 Press [Change Xpt].

The Router >Router Control >Router Control 
>Change Xpt menu appears.
Destination Select buttons appear in groups of 16.
Source Select buttons appear by group (maximum 24 
buttons).

2 Press one of the Destination Select buttons, to select 
the destination for which you want to switch the 
source.

To change the group
Press one of the [1-16], [17-32], [33-48], and [49-64] 
buttons.

3 Press one of the Source Select buttons, to select the 
source you want to switch.

To change the group
Press one of the [1-24], [25-48], ... [97-120], and [121-
128] buttons.

Video Process

The term “video process” is applied to adjustments to the 
luminance and hue of the input video signal.
There are two types of adjustment, depending on the 
application:
• Adjustment of an individual input signal
• Image effects on a particular bus

These types of adjustment may be carried out 
independently. However, since they are implemented by 
the same hardware, if the same signal is subjected to 
processing twice, there may be limitations on the range of 
effects obtained in the final result.

Video Process Adjustments for Each 
Input Signal

For each signal input to the switcher, you can set video 
process on or off and set the parameters (Video Gain, Y 
Gain, C Gain, Hue Delay, and Black Level) in the Setup 
menu.

For details of the settings, see “Signal Input Settings” in 
Chapter 20 (Volume 2).

Video Process Adjustments on a 
Particular Bus

Buses to which the adjustments apply
For each of the following buses, you can switch video 
process adjustments on or off, and adjust the parameters.
• Following buses in the M/E-1 to M/E-4, and PGM/PST 

banks
- Key fill buses for keys 1 to 8
- Background A and background B buses
- Utility 1 and utility 2 buses

• Frame memory source 1 and frame memory source 2 
buses

• Aux 1 to 48 buses
These settings also apply to keyframes and snapshots.

Making the adjustments
Adjust VIDEO GAIN, Y GAIN, BLACK LEVEL, C 
GAIN, and HUE DELAY in the following menus.

Notes 
Video Process
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Video Process Memory

When using video process adjustments for an image effect 
on a bus, this function saves the final values for each pair 
number for the signals. The video process on/off setting is 
not saved.
When you change the adjustments the values are 
automatically saved, and these last values are recalled 
when the pair number is selected.
In other words, by switching video process memory on, 
regardless of the video process information for each bus, 
you can carry out video process adjustments for each input 
signal.
The parameters saved are as follows.

VIDEO GAIN, Y GAIN, BLACK LEVEL, C GAIN, 
HUE DELAY

Switch the video process memory on or off in the Setup 
menu.

For details of setting operations, see “Settings Relating to 
Keys, Wipes, Frame Memory and Color Correction (Key/
Wipe/FM/CCR Menu)” in Chapter 20 (Volume 2).

Video Process Settings

This section describes operations on the M/E-1 to M/E-4, 
and PGM/PST background A and B buses, and utility 
buses 1 and 2.
For these operations, use the Misc >Video Process menu in 
the respective operating bank.

For video process settings on other buses, see the 
following.

• Settings for a particular input signal: “Signal input 
settings” in Chapter 20 (Volume 2)

• Key fill bus settings: “Video Processing” (page 130)
• Settings for frame memory source buses 1 and 2: 

“Setting video processing” (page 197)
• Settings for Aux 1 to 48 buses: “Making video process 

settings for an AUX bus” (page 224)
• Overview of video process: “Video Process” (page 226)

This section describes an example on the background A 
bus of the M/E-1 bank. 
For the background B bus or utility bus 1 or 2, make the 
adjustment with a similar procedure.

Making video process settings for each 
bus

1 In the menu control block, press the top menu 
selection button [M/E1] and select VF7 ‘Misc’ and 
HF2 ‘Video Process.’

2 In the <Bkgd-A> group, press [Video Process], 
turning it on.

3 Adjust the following parameters.

To return the parameter settings to the defaults, press 
[Unity] in the <Bkgd-A> group.

Applicable bus Menu used for 
operation

See 
page

M/E-1 to M/E-
4 banks

Key fill buses 
for keys 1 to 8

M/E-1 to M/E-4 
menus

page 
130

Background A 
and B buses

Video Process 
menu

page 
227

Utility 1 and 2 
buses

PGM/PST 
bank

Key fill buses 
for DSK1 to 
DSK8

PGM/PST menu page 
130

Background A 
and B buses

Video Process 
menu

page 
227

Utility 1 and 2 
buses

Frame memory source 1 and 2 
buses

Frame Memory 
menu

page 
197

Aux 1 to 48 buses AUX menu page 
224

Knob Parameter Adjustment Setting values

1 Video 
Gain

Video signal 
gain

–200.00 to 
+200.00

2 Y Gain Luminance 
signal gain

–200.00 to 
+200.00

3 C Gain Chrominance 
signal gain

–200.00 to 
+200.00

4 Hue Delay Hue delay –180.00 to 
+180.00

5 Black 
Level

Black level –7.31 to 
+109.59
227Video Process
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Preparations

The color corrector enables video signal color correction 
(black balance/white balance adjustment, gamma 
correction, knee correction, etc.).

To use the color corrector, the BZS-8420X (for MVS-
8000X) or the BZS-7420X (for the MVS-7000X) Color 
Corrector Software. To use the software, you are required 
to input an install key.

For the method of inputting an install key, see 
“Installation and Device Setup (Install/Unit Config 
Menu)” in Chapter 18 (Volume 2).

Restrictions on color corrector and M/E 
combination

Example of restriction 2: When M/E-1 is selected on the 
M/E-2 background A bus (or background B bus, key 
bus, or utility 1 or 2 bus), then M/E-2 cannot be 
selected on the M/E-3 key bus or the utility 1 bus.

Assigning the color corrector input buses 
to AUX delegation buttons
There are two inputs for capturing material to the color 
corrector: the CCR1 bus and the CCR2 bus.

For details of the input assignment operation, see 
“Auxiliary Bus Control Block Settings (Aux Assign 
Menu)” in Chapter 19 (Volume 2).

Notes 

Signal 
format

When the color corrector 
output is selected

When the 
color corrector 
output is not 
selected

3M/E system 4M/E system/
5M/E system

4M/E system/
5M/E system

Other 
than 
720P

– Re-entry signal 
selection on a 
key bus or the 
utility 1 bus 
cannot be 
performed over 
a cascade of 
two or more M/
E blocks. 
(Restriction 2)

–

720P Re-entry signal 
selection on a 
key bus or the 
utility 1 bus 
cannot be 
performed over 
a cascade of 
two or more M/
E blocks. 
(Restriction 2)

Re-entry signal 
selection on a 
key bus or the 
utility 1 bus 
cannot be 
performed. 
(Restriction 1)

Re-entry signal 
selection on a 
key bus or the 
utility 1 bus 
cannot be 
performed over 
a cascade of 
three or more 
M/E blocks. 
(Restriction 2)
Preparations
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Selecting the color correction input signal
After assigning CCR1 and CCR2 to AUX buses, use the 
following procedure.

1 Press the AUX delegation buttons assigned to CCR1 
(or CCR2).

2 In the cross-point button row, select the signal to 
which you want to apply color correction.

The signals that can be selected on the CCR1 and 
CCR2 buses are primary inputs, premium inputs, 
format converter inputs and frame memory outputs 
(FM1 to FM8) only.
However you can make all the internal signals of the 
switcher selectable by a setting in the Setup menu. 

For details, see “Selecting the Bank to Make the 
Settings” in Chapter 20 (Volume 2).

Selecting the color corrector output signal
By assigning the signal output from the color corrector to 
a cross-point button, you can make that signal available on 
that button.

For details of the assignment process, see “Cross-Point 
Settings (Xpt Assign Menu)” in Chapter 19 (Volume 2).

Accessing the CCR menu
For color correction operations, use the CCR menu.
To access the CCR menu, in the menu control block, press 
the top menu selection button [CCR].
The following description uses CCR1 as an example. To 
apply color correction to CCR2, replace VF1 ‘CCR1’ by 
VF2 ‘CCR2,’ and follow the same procedure.

Overall Color Corrector 
Operations

Enabling Color Corrector

To enable the functions of color corrector 1, for example, 
use the following procedure.

1 In the CCR menu, press VF1 ‘CCR1’ and any HF.

2 In the <CCR> group, press [CCR], turning it on.

Returning all color corrector settings to 
their defaults

1 In the <CCR> group, press [Unity].

A confirmation message appears.

2 Press [Yes].

This returns all color corrector settings to their 
defaults, whether [CCR] is on or off.

Copy and Swap Operations

Copying color corrector data

1 In the CCR menu, press VF5 ‘Copy/Swap.’

The Copy/Swap menu appears.
The status area shows a copy source list on the left and 
a copy destination list on the right.

2 Using any of the following methods, select the copy 
source data and copy destination data.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video 

cursor.
• Turn the knobs.

3 Press [Copy].

This carries out the copy.

Notes 

Knob Parameter Adjustment Setting values

1 Left No Select copy 
source data

1 or 2

2 Right No Select copy 
destination 
data

1 or 2
229Overall Color Corrector Operations
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Swapping color corrector data
Refer to the procedure described in the previous item 
“Copying color corrector data.” In step 3, press [Swap] 
instead of [Copy].

To undo copy or swap 
In the Copy/Swap menu, press [Undo].
The state before carrying out the copy or swap is restored.

Color Corrector 
Functions

This section describes the color corrector functions.
For each of the following operations, it is possible to copy 
or swap data between two color correctors (CCR1 and 
CCR2).

Input Video Processing Operations

Carry out the following corrections to a YUV signal before 
conversion to an RGB signal.
• Overall gain adjustment of the video signal
• Gain adjustment of the Y signal
• Gain adjustment of the C signal
• Hue delay
• Black level adjustment
To apply input video processing effects, use the following 
procedure.

1 In the CCR menu, press VF1 ‘CCR1’ and HF1 ‘Input 
Process.’

The Input Process menu appears.

2 In the <Input Process> group, press [Input Process], 
turning it on.

3 Adjust the following parameters.

To return the parameters to their default settings
Press [Unity] in the <Input Process> group.

Primary Color Correction 
Operations

Carry out the following corrections to each of the R, G, and 
B signals.

Knob Parameter Adjustment Setting values

1 Video Gain Video signal 
gain

–200.00 to 
+200.00

2 Y Gain Y signal gain –200.00 to 
+200.00

3 C Gain Chrominance 
signal gain

–200.00 to 
+200.00

4 Hue Delay Hue delay –180.00 to 
+180.00

5 Black 
Level

Black level –116.90 to 
+116.90
Color Corrector Functions
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Black balance adjustment: setting the output level for a 
0% level input signal.

White balance adjustment: setting the output level for a 
100% level input signal.

Gamma correction: adjusting the curvature of the gamma 
curve.

Knee correction: adjusting the position of the maximum 
point of the gamma curve.

It is also possible to mask part of the region to be corrected.

Applying primary color correction

1 In the CCR menu, press VF1 ‘CCR1’ and HF2 
‘Primary CCR.’

The Primary CCR menu appears.

2 In the <Primary CCR> group, press [Primary CCR], 
turning it on.

3 In the <Primary CCR Adjust> group, select the setting 
item.

Black: black balance adjustment
White: white balance adjustment
Gamma: gamma correction
Knee: knee correction

4 Depending on the selection in step 3, adjust the 
following parameters.

When Black or Gamma is selected

When White is selected

When Knee is selected

To return the parameters to their default settings
In the <Primary CCR> group, press [Unity].

Masking a part of the primary color 
correction
Here the procedure for mask 1 operation is described by 
way of example. You can carry out mask 2 operation in a 
similar way.

1 In the Primary CCR menu, press [Mask1].

2 In the < Primary/Secondary Mask > group, press 
[Mask1], turning it on.

Output level

Black balance 
adjustment

White balance 
adjustment

Input level

Unadjusted signal

Input level

Output level

Knee correction

Gamma 
correction

Adjusted signal

Knob Parameter Adjustment Setting values

1 Red Red signal 
adjustment

–100.00 to +100.00

2 Green Green signal 
adjustment

–100.00 to +100.00

3 Blue Blue signal 
adjustment

–100.00 to +100.00

4 All Simultaneous 
RGB 
adjustment

Red value is shown

Knob Parameter Adjustment Setting values

1 Red Red signal 
adjustment

0.00 to 200.00

2 Green Green signal 
adjustment

0.00 to 200.00

3 Blue Blue signal 
adjustment

0.00 to 200.00

4 All Simultaneous 
RGB 
adjustment

Red value is shown

Knob Parameter Adjustment Setting values

1 Red Red signal 
adjustment

20.00 to 75.00

2 Green Green signal 
gain

20.00 to 75.00

3 Blue Blue signal 
gain

20.00 to 75.00

4 All Simultaneous 
RGB 
adjustment

Red value is shown
231Color Corrector Functions
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When [Mask 2] is selected in the Secondary CCR 
menu, linked to this setting it automatically changes 
from [Mask 2] to [Mask 1].

3 Press [Mask1 Adjust].

The Mask1 Adjust menu appears.

4 In the <Mask Source> group, select the mask source.

Box: signal from dedicated box generator
Pattern: signal from dedicated pattern generator

5 Depending on the selection in step 3, adjust the 
following parameters.

When Box is selected

When Pattern is selected

For the pattern selection, you can also press [Mask Ptn 
Select] in the Mask1 Adjust menu, then use the Mask 
Ptn Select menu.
Press any of the displayed patterns (standard wipe 
patterns 1 to 24) to select it, then you can adjust the 
following parameters.

6 When selecting the pattern as a mask source, set the 
pattern modifiers as required.

When turning [Position] on and setting the pattern 
position

a) See “Setting the wipe position (Positioner)” (page 158).

When turning [Multi] on and replicating the same 
pattern

a) See “Setting the wipe pattern replication (Multi)” (page 160).

When turning [Aspect] on and setting the aspect 
ratio of the pattern

a) See “Setting the wipe pattern aspect ratio (Aspect ratio)” (page 160).

When turning the [Angle] on in the <Rotation> 
group and slanting the pattern

a) See “Angle” (page 159).

When turning [Speed] on in the <Rotation> group 
and rotating the pattern at a fixed rate

a) See “Speed” (page 159).

7 To invert the mask source, return to the Primary CCR 
menu and press [Pri/Sec Mask Invrt], turning it on.

Notes 

Knob Parameter Adjustment Setting values

1 Top Top position –100.00 to +100.00

2 Left Left position –100.00 to +100.00

3 Right Right 
position

–100.00 to +100.00

4 Bottom Bottom 
position

–100.00 to +100.00

5 Soft Degree of 
softness of 
box

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of 
softness of 
pattern edge

0.00 to 100.00

5 Pattern Pattern 
number

1 to 24

Knob Parameter Adjustment Setting values

1 Size Pattern size 0.00 to 100.00

2 Soft Degree of 
softness of 
pattern edge

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Position H Horizontal 
position

–200.00 to +200.00 a)

2 Position V Vertical 
position

–200.00 to +200.00 a)

Knob Parameter Adjustment Setting values

1 H Multi Number of 
repetitions of 
pattern 
horizontally

1 to 63

2 V Multi Number of 
repetitions of 
pattern 
vertically

1 to 63

3 Invert Type Replication 
layout

1 to 4 a)

Knob Parameter Adjustment Setting values

1 Aspect aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Angle of 
pattern 
rotation

–100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation 
rate of 
pattern

–100.00 to +100.00 a)
Color Corrector Functions
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The mask function is common to the primary color 
correction, secondary color correction, and spot color 
adjustment functions. 

Secondary Color Correction 
Operations

For the six colors R (red), G (green), B (blue), Y (yellow), 
C (cyan), and M (magenta), adjust the luminance and 
saturation, and also the hue within a range of ±30 degrees 
of the center value for each color.
You can mask a part of the region to be corrected.

Applying secondary color correction

1 In the CCR menu, press VF1 ‘CCR1’ and HF3 
‘Secondary CCR.’

The Secondary CCR menu appears.

2 In the <Secondary CCR> group, press [Secondary 
CCR], turning it on.

3 In the <Secondary CCR Adjust> group, select the 
color for which you want to make the setting.

4 Adjust the following parameters.

To return the parameter settings to their default 
values
In the <Secondary CCR> group press [Unity].

Masking a part of the secondary color 
correction
Set [Mask] to On in the Secondary CCR menu, then carry 
out the same operation as described under “Masking a part 
of the primary color correction” (page 231).

Luminance Processing Operations

After converting a signal to which RGB color correction 
has been applied to a YUV signal, divide the luminance 
levels into three regions, referred to as Dark, Middle, and 
Bright, and apply video signal adjustments to these 
regions.

There are three modes for luminance processing, as 
follows.
Tint mode: adding a specified color to the original video 

signal.
Color Modify mode: adjusting the original video signal.
Y Modify mode: adjusting the output levels of the input 

luminance signal.
• White balance adjustment: setting the output level 

for an input luminance signal at the 100% level.
• Black balance adjustment: setting the output level 

for an input luminance signal at the 0% level.
• Y lift correction: adjusting the curvature of the 

curve.
• Y dark correction: adjusting the position of the 

maximum point of the curve.

It is also possible to mask part of the region to be corrected.

Notes 

Knob Parameter Adjustment Setting values

1 Luminance Luminance –100.00 to +100.00

2 Saturation Saturation 0.00 to 200.00

3 Hue Delay Hue delay –180.00 to +180.00

Under Dark point

Middle/Dark point

Bright/Middle point

Over Bright point

Dark Middle Bright

Input signal luminance level

Output signal luminance level

Black balance adjustment

White balance 
adjustment

Input signal 
luminance level

Unadjusted signal

Input signal 
luminance level

Output signal luminance level

Y Dark

Adjusted signal

Y Lift
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Applying luminance processing

1 In the CCR menu, press VF1 ‘CCR1’ and HF5 
‘Luminance Process.’

The Luminance Process menu appears.

2 In the <Luminance Process> group, press [Luminance 
Process], turning it on.

3 In the <Mode> group, specify the adjustment mode.

Tint: add a specified color to the original video signal.
Color Modify: adjust the original video signal.
Y Modify: adjust the output levels of the input 

luminance signal.
When tint mode or color modify mode is selected, skip 
to step 4.
When Y modify mode is selected, adjust the following 
parameters.

4 In the <Bound> group, make the settings for the three 
regions (Dark, Middle, and Bright).

[Level] parameters: set the boundaries of the three 
regions.

[Soft] parameters: set the degree of boundary 
softness of the three regions.

5 In the <Luminance Process Adjust> group, press 
[Dark], [Mid], or [Bright], and adjust the following 
parameters for the three regions.

In tint mode

In color modify mode

To return the parameters to their default settings
In the <Luminance Process> group, press [Unity].

Spot Color Adjustment

You can change the color of a specified color region to a 
different color, without affecting other regions. You can 
also mask part of such a region.
Then for the region other than the region whose color you 
have changed, you can make the following corrections.
• Video signal overall gain adjustment
• Y signal gain adjustment
• Y signal offset adjustment
• C signal gain adjustment
• C signal hue adjustment

Knob Parameter Adjustment Setting values

1 White White 
balance 
adjustment

0.00 to 200.00

2 Black Black 
balance 
adjustment

–100.00 to +100.00

3 Y Lift Curvature of 
curve

–100.00 to +100.00

4 Y Dark Position of 
maximum 
point of 
curve

–7.31 to +109.59

Knob Parameter Adjustment Setting values

1 Over B 
Level

Luminance 
level of the 
Over Bright 
point

50.00 to 150.00

2 Mid B 
Level

Luminance 
level of the 
Bright/Middle 
point

10.00 to 120.00

3 Dark Mid 
Level

Luminance 
level of the 
Middle/Dark 
point

–20.00 to +90.00

4 Under D 
Level

Luminance 
level of the 
Under Dark 
point

–50.00 to +50.00

Knob Parameter Adjustment Setting values

1 Over B 
Soft

Degree of 
softness at 
Over Bright 
point

15.00 to 70.00

2 Mid B Soft Degree of 
softness at 
Bright/Middle 
point

15.00 to 42.50

3 Dark Mid 
Soft

Degree of 
softness at 
Middle/Dark 
point

15.00 to 42.50

4 Under D 
Soft

Degree of 
softness at 
Under Dark 
point

15.00 to 70.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance –100.00 to +100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance –100.00 to +100.00

2 C Gain Chrominanc
e signal gain

0.00 to 200.00

3 Hue Delay Hue delay –180.00 to +180.00
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Adjusting the color of the specified region 
(key)

1 In the CCR menu, press VF1 ‘CCR1’ and HF6 ‘Spot 
CCR/Output.’

The Spot CCR/Output menu appears.

2 In the <Spot CCR> group, press [Spot CCR], turning 
it on.

3 In the <Auto> group, press [Sample Mark], turning it 
on.

When [Sample Mark] is on, the effects of color 
adjustment outside the region of spot color adjustment 
(see page 235) and output video processing (see page 
236) are temporarily disabled.
Turning [Sample Mark] off restores the former state.

4 Adjust the parameters so that the color you want to 
change is included within the sample mark.

5 In the <Auto> group, press [Auto Start], to adjust the 
key automatically.

This automatic adjustment does not carry out key gain 
adjustment. If required, adjust the key gain as shown 
in step 6.

6 Press [Key Adjust], and adjust the following 
parameters.

7 Press [Window], turning it on, to adjust the key 
detection range for spot color adjustment.

8 In the <Spot CCR> group, press [Spot CCR] to display 
the parameters, and adjust the replacement color.

To return the parameters to their default settings
In the <Spot CCR> group, press [Unity].

Masking a part of the spot color 
adjustment
Set [Mask] to On in the Spot CCR/Output menu, then carry 
out the same procedure as in “Masking a part of the 
primary color correction” (page 231).

Adjusting the color outside the spot color 
adjustment region

1 In the Spot CCR/Output menu, press [Outer Out Proc] 
in the <Outer Out Proc> group, turning it on.

2 Adjust the following parameters.

To return the parameters to their default settings
In the <Outer Out Proc> group, press [Unity].

Output Video Processing Operations

Carry out the following corrections are available on the 
YUV signal.
• Video signal overall gain adjustment
• Y signal gain adjustment
• Y signal offset adjustment
• C signal gain adjustment
• C signal hue adjustment

Notes 

Knob Parameter Adjustment Setting values

1 Position H Horizontal 
position

–100.00 to +100.00

2 Position V Vertical 
position

–100.00 to +100.00

3 Size Size 1.00 to 100.00

Notes 

Knob Parameter Adjustment Setting values

1 Luminance Luminance –7.31 to +109.59

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

4 Gain Key gain –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Video Gain Video signal 
gain

–200.00 to +200.00

2 Y Gain Y signal gain –200.00 to +200.00

3 C Gain Chrominance 
signal gain

–200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black 
Level

Black level –116.90 to +116.90

Knob Parameter Adjustment Setting values
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Applying output video processing effects

1 In the CCR menu, press VF1 ‘CCR1’ and HF6 ‘Spot 
CCR/Output.’

The Spot CCR/Output menu appears.

2 In the <Output Process> group, press [Output 
Process], turning it on.

3 Adjust the following parameters.

To return the parameters to their default settings
In the <Output Process> group, press [Unity].

YUV Clip Operations

For each of the luminance and color difference signals, the 
following processing is available.
White clip: setting the maximum level of the luminance 

signal.
Dark clip: setting the minimum level of the luminance 

signal.
Positive clip: setting the maximum amplitude in the 

positive direction of the color difference signal.
Negative clip: setting the maximum amplitude in the 

negative direction of the color difference signal.

Applying YUV clip processing

1 In the CCR menu, press VF1 ‘CCR1’ and HF7 ‘YUV 
Clip/RGB Clip.’

The YUV Clip/RGB Clip menu appears.

2 In the <YUV Clip> group, press [YUV Clip], turning 
it on.

3 In the <YUV Clip Adjust> group, select the target for 
adjustment.

Luminance: settings for the luminance signal.
Chroma: settings for the color difference signal.

4 Depending on the selection in step 3, adjust the 
following parameters.

When Luminance is selected

When Chroma is selected

To return the parameters to their default settings
In the <YUV Clip> group, press [Unity].

RGB Clip Operations

For each of the R, G, and B signals, you can make dark clip 
and white clip adjustments.

Making RGB clip adjustments

1 In the CCR menu, press VF1 ‘CCR1’ and HF7 ‘YUV 
Clip/RGB Clip.’

The YUV Clip/RGB Clip menu appears.

2 In the <RGB Clip> group, press [RGB Clip], turning it 
on.

3 In the <RGB Clip Adjust> group, select the item you 
want to adjust.

Dark: dark clip adjustment
White: white clip adjustment

4 Adjust the following parameters.

Knob Parameter Adjustment Setting values

1 Video Gain Video signal 
gain

–200.00 to +200.00

2 Y Gain Y signal gain –200.00 to +200.00

3 C Gain Chrominance 
signal gain

–200.00 to +200.00

4 Hue Delay Hue delay –180.00 to +180.00

5 Black 
Level

Black level –116.90 to +116.90

Knob Parameter Adjustment Setting values

1 White Clip White clip 
adjustment

–6.85 to +109.13

2 Dark Clip Dark clip 
adjustment

–6.85 to +109.13

Knob Parameter Adjustment Setting values

1 U Posi Clip Positive clip 
adjustment 
for U signal

–113.39 to +113.39

2 U Nega 
Clip

Negative clip 
adjustment 
for U signal

–113.39 to +113.39

3 V Posi Clip Positive clip 
adjustment 
for V signal

–113.39 to +113.39

4 V Nega 
Clip

Negative clip 
adjustment 
for V signal

–113.39 to +113.39

Knob Parameter Adjustment Setting values

1 Red Red signal 
adjustment

–50.00 to +149.99 a)

–49.99 to +150.00 b)

2 Green Green signal 
adjustment

–50.00 to +149.99 a)

–49.99 to +150.00 b)

3 Blue Blue signal 
adjustment

–50.00 to +149.99 a)

–49.99 to +150.00 b)
Color Corrector Functions



  C
hapter 9  C

olor C
orrector
a) When Dark is selected
b) When White is selected

To return the parameters to their default settings
In the <RGB Clip> group, press [Unity].

4 All Simultaneous 
RGB 
adjustment

Red value is shown

Knob Parameter Adjustment Setting values
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Side Flags

Overview

The term “side flags” refers to the areas to left and right of 
an image with aspect ratio 4:3 embedded within a 16:9 
frame, when these areas are filled with a separate image 
selected from the utility 1 bus. 
You can adjust the width of the side flag area.

Side Flag Settings

Input source aspect ratio, auto side flags, 
and auto crop settings

Aspect ratio 4:3 setting
Set the input signal to aspect ratio 4:3. If set to 16:9, the 
side flags are disabled.

Auto side flag setting
This function automatically applies side flags when a 4:3 
signal is selected in the cross-point control block.

Auto crop setting
When carrying out a DME wipe, this function 
automatically crops the image during transition to 4:3.

Adjusting the width of the side flag area
You can set the left and right sides separately.

For the operation for the above setting, see “Settings for 
Switcher Configuration (Config Menu)” in Chapter 20 
(Volume 2).

Enabling and disabling side flags with a 
menu operation
You can enable or disable side flags for the backgrounds 
(A and B) of each of the M/E and PGM/PST banks. 

As an example, to enable side flags for background B row 
on the M/E-1 bank, use the following procedure.

1 In the menu control block, press the top menu 
selection button [MISC], then select VF1 ‘Enable’ and 
HF3 ‘Side Flags.’

The Misc >Enable >Side Flags menu appears.
The status area shows the buttons for Bkgd A and 
Bkgd B for each of the M/E-1 to M/E-4, and PGM/
PST (P/P) banks.

2 In the <M/E-1 Side Flags> group, press [Bkgd B].

Each time you press the button toggles between 
Enable and Disable.

To display a menu for the aspect ratio 4:3, auto 
side flags, and auto crop settings
In the Misc >Enable >Side Flags menu, press [Setup 
>SWER >Side Flags].

To display a menu for assigning the side flags on/
off function to a cross-point button
In the Misc >Enable >Side Flags menu, press [Side Flags 
Button Assign].

Enabling and disabling side flags with a 
button operation
For example, to enable side flags for the background B row 
of the M/E-1 bank, use the following procedure.

1 First, in the Setup menu assign the rightmost cross-
point button to the [SIDE FLAG] button.

For details of the assignment operation, see 
“Assigning a Cross-Point Button to Enable/Disable 
Side Flags” in Chapter 19 (Volume 2).

2 Press the [SIDE FLAG] button at the right end of the 
background B row of the M/E-1 bank.

The button you pressed lights amber, and this enables 
the side flags.
Side Flags
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• The operations of enabling or disabling the side flags 
by menu operation and by control panel button 
operation are linked.

• When the auto side flags are on, selecting a 4:3 video 
material automatically lights the [SIDE FLAG] 
button, but if you press this button, turning it off, the 
side flags are temporarily disabled.
However, when you select a different 4:3 video 
material, the [SIDE FLAG] button automatically 
lights once again, enabling the side flags.

Creating an image with side flags
For example, to create an image with side flags in the 
background B row of the M/E-1 bank, use the following 
procedure.

1 In the M/E-1 bank cross-point control block, hold 
down the [UTIL] button, and in the background A row 
select the signal (utility bus 1 signal) you want to insert 
in the side flag areas.

2 In the background B row, press the cross-point button 
corresponding to the 4:3 video material.

At this point, if auto side flags are on, this 
automatically adds side flags to the 4:3 video material.

For details, see “Settings for Switcher Configuration 
(Config Menu)” in Chapter 20 (Volume 2).

3 Use either of the following methods to turn the side 
flags on.

• Use the Misc >Enable >Side Flags menu. (See page 
238).

• Use a cross-point button operation. (See previous 
item.)

This adds side flags to the 4:3 video material.

Wipe Action on Images with Side 
Flags

When a wipe is carried out on an image with side flags, all 
wipe patterns can be used.
The following illustration shows the action in a wipe.

Wipe from a 4:3 image to a 16:9 image

Wipe from a 4:3 image to another 4:3 
image (when side flags are on for both 
images)

DME Wipe Action for an Image with 
Side Flags

When a DME wipe is carried out on an image with side 
flags, all wipe patterns can be used.
Depending on the setting (On/Off) of [Auto Crop] in the 
Engineering Setup >Switcher >Config menu, the 
appearance of the 4:3 image changes.

Notes 

Side flag areas

4:3 image
(Side flags on)

16:9 image

Side flag areas

4:3 image
(Side flags on)

The circles indicate the 
position of the wipe pattern 
edge when the transition is 
half finished.

Side flag areas
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• When using the DME through SDI interface with [Auto 
Crop] being off, side flags are not added to the new 
image during DME wipe.

• For signals with the following DME wipe pattern 
selected on the DME external video bus (gray part 
shown in the pattern illustration), side flags are not 
applied when auto side flags are set to Off.
- Two-channel page turn
- Two-channel page roll
- Two-channel frame in-out
- Two-channel brick
- Three-channel brick

The following illustration shows the action in a DME 
wipe.

DME wipe from a 4:3 image to a 16:9 image

Wipe action using slide (No. 1001)

DME wipe from a 4:3 image to another 4:3 
image (when side flags are on for both 
images)

Wipe action using squeeze (No. 1031)

a) When using the DME through SDI interface, side flags are not added 
during a DME wipe.

Notes 

Auto crop on

4:3 image
(Side flags on)

Auto crop off

Side flag area

16:9 image

Side flag areas

Auto crop on

4:3 image
(Side flags on)

Side flag areas
Autocrop off

Side flag areas a)

4:3 image
(Side flags on)

Side flag areas

Side flag areas
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Multi Program 2

Overview

What is Multi Program 2?
By operating the switcher in Multi Program 2 mode, a 
single switcher mix/effects bank can be used to create two 
separate video outputs, referred to as “main” and “sub.” 
You can set backgrounds, keys, and transitions for each of 
main and sub. Keys 2 to 8, however, are common to main 
and sub.

To enable this function requires the BZS-8200X (for the 
MVS-8000X) or BZS-7200X (for the MVS-7000X) Multi 
Program 2 software. 

Using the software
To use the Multi Program 2 software, you are required to 
enter an install key which validates the software. (If the 
software has been factory installed, the install key is not 
required.)
For the method of obtaining an install key, contact your 
Sony representative.
To obtain a key, you may be required to submit the unique 
device ID of the switcher you are using. You can check the 
unique device ID in the Install menu of the switcher.

For details of the operation, see “Installation and Device 
Setup (Install/Unit Config Menu)” in Chapter 18 
(Volume 2).

Assigning main and/or sub to switcher 
banks
For Multi Program 2 operations, a single switcher bank 
may be shared, and switched between main and sub, or two 
separate switcher banks may be used, each dedicated to 
main or sub.
Example 1: Assigning M/E-1 main and sub to a single 

switcher bank, and switching between them

Example 2: Assigning separate switcher banks as “M/E-1 
main dedicated” and “M/E-1 sub dedicated”

Video creation operations in Multi Program 
2 mode
For each of main and sub, there are differences from the 
operations in standard mode.

For details, see “Differences between Multi Program 2 
Mode and Standard Mode” (page 246).

Sequence of Operations in Multi 
Program 2

Basic operation sequence
Enter the BZS-8200X or BZS-7200X install key (first time 
only)
↓
Set Multi Program 2 operating mode for each switcher 
bank
↓
Assign output signals, and set the background 
configuration, key configuration, and key preview 
configuration
↓
For each switcher bank, make a main/sub assignment (one 
of main dedicated, sub dedicated, and main and sub 
shared)
↓
For a switcher bank assigned to main and sub shared, 
assign the [MAIN] and [SUB] delegation buttons
↓
Create the main and sub images
↓
Execute the transition

Optional operations
• Making cross-point settings
• Enabling DME wipe operations for sub
• Inhibiting utility 2 bus signal selection
• Including Multi Program 2 data in keyframes and 

snapshots
• Changing the key assignment for each output

Notes 

Used switched between M/E-1 main and sub

Used for M/E-1 main operations

Used for M/E-1 sub operations
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• Assigning sub preview output to preview selection 
buttons in the fade-to-black control block

• Changing the matrix size to Standard
• Making settings for keyframe timeline operation

Basic Operations (Required)

Entering the install key of the software 
(first time only)
After installing the BZS-8200X or the BZS-7200X Multi 
Program 2 software in the switcher, carry out the following 
procedure.

1 In the status area of the Engineering Setup >System 
>Install/Unit Config menu, select the switcher 
(SWRx), and press [License].

The License menu appears.

2 In the License menu, enter the install key.

For details of the operation, see “Installation and 
Device Setup (Install/Unit Config Menu)” in 
Chapter 18 (Volume 2).

3 Shut down the menus (see page 70).

4 Power the switcher and SCU off and on again.

Setting the operating mode for each 
switcher bank
To set a desired switcher bank to Multi Program 2 mode, 
use the following procedure.

1 Display the Engineering Setup >Switcher >Config 
menu.

2 Select the switcher bank from M/E-1 to M/E-4, and P/
P.

3 In the <M/E Config> group, select [Multi Program2].

4 Repeat steps 2 and 3 as required, to set the operating 
mode for all desired switcher banks.

Assigning output signals for Multi 
Program 2 mode

To assign signals to outputs
Use the Engineering Setup >Switcher >Config >M/E 
Output Assign menu.
The difference from standard mode is that OUT1 is fixed, 
set to PGM1 (main program), and OUT6 is fixed, set to 
PGM2 (sub program), and that for the OUT2 to OUT5 

signals you can assign any signal selected from the 
following.

PGM1, PGM2, PGM3, PGM4, PVW1, PVW2, K-
PVW1, K-PVW2, CLEAN, SUB CLEAN

Each of main and sub can use a maximum of four of the six 
outputs (OUT1 to OUT6). The outputs can be used within 
the following limits.
• OUT1, OUT2: main only
• OUT3, OUT4: can be used for either main or sub
• OUT5, OUT6: sub only

For details, see “Selecting the System Operation Mode” in 
Chapter 18 (Volume 2).

To set the background and key configuration
Use the Engineering Setup >Switcher >Config >PGM 
Config menu.
The following are the differences from standard mode.
Background configuration: Consists of the following 

combinations.
• For main: Clean, Bkgd A, Bkgd B
• For sub: Sub Clean, Utility 2, Utility 3

Key configuration: Key1 can be set to “Enable” only 
when the background is Clean, Bkgd A, or Bkgd B.

For details, see “Setting the Operation Mode” in 
Chapter 20 (Volume 2).

To set the key preview configuration
Use the Engineering Setup >Switcher >Config >K-PVW 
Config menu.
The following are the differences from standard mode.
Background configuration: Clean or Sub Clean
Key configuration: Key1 can be set to “On” or “Link” 

only when the background is Clean.

For details, see “Setting the Operation Mode” in 
Chapter 20 (Volume 2).

To assign sub outputs to output ports
Use the Engineering Setup >Switcher >Output >Output 
Assign menu.
You can assign a sub output signal to a switcher output 
port number.

For details, see “Assigning Output Signals” in Chapter 20 
(Volume 2).

Assigning main and/or sub to switcher 
banks
For each switcher bank for which Multi Program 2 mode 
is selected, set whether this is main dedicated, sub 
dedicated, or main and sub shared.

Notes 
Multi Program 2
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To assign main and sub to a single switcher bank

1 In the Engineering Setup >Panel >Config >MP2 Main/
Sub Assign menu, select the switcher bank.

2 In the <Main/Sub Assign> group, select [Main&Sub].

Main: use for main operations.
Sub: use for sub operations.
Main&Sub: use for both main and sub operations.
When “Main&Sub” is selected, it is necessary to 
assign [MAIN] and [SUB] delegation buttons to the 
control panel buttons.

To assign main and sub to two consecutive 
switcher banks
For example, to assign the first row (first switcher bank) to 
M/E-1 main, and the second row (second switcher bank) to 
M/E-1 sub, use the following procedure.

1 In the status area of the Engineering Setup >Panel 
>Config >MP2 Main/Sub Assign menu, select 1st 
Row (M/E-1), then press [Main] in the <Main/Sub 
Assign> group.

2 Press [Dual M/E Assign] to assign M/E to two banks.

In this state, both 1st Row and 2nd Row are set to 
main.

3 Set 2nd Row to [Sub].

This cancels the shift/non-shift assignment for dual M/
E in standard mode.

It is not possible to assign the combinations of Main with 
Main&Sub, or Sub with Main&Sub.

Assigning the [MAIN] and [SUB] 
delegation buttons to buttons on the 
control panel

To assign the Main/Sub switching function to 
buttons in the transition control block
This applies to the standard type and compact type 
transition control block, and the CCP-6224/6324 control 
panel.

For details of the CCP-6224 2M/E control panel, see page 
125, and for the details of the CCP-6324 3M/E control 
panel, see page 61.

For details of the transition control block, .

1 In the Engineering Setup >Panel >Config menu, press 
[Program Button].

The Program Button menu appears.

2 Press [Transition Module1].

The Transition Module1 menu appears.

3 Select the switcher bank in the <Bank Select> group.

The buttons in the transition control block on the left 
appear in the currently assigned state.

4 Press the button whose assignment you wish to 
change.

The button you press appears in reverse video.

5 From the list on the right, select [MAIN], and press 
[Set].

The indication on the button changes according to the 
selection.

6 Repeat Step 4 and 5 to assign [SUB].

To assign to macro buttons in the cross-point 
control block

For details of the cross-point control block, see page 22.

1 In the Engineering Setup >Panel >Config menu, press 
[Program Button].

The Program Button menu appears.

2 Press [Xpt Module].

The Xpt Module menu appears.

3 Select the switcher bank, then in the <PRE MCRO/
POST MCRO> group, press [Main Sub].

You can now use the [PRE MCRO] button as [MAIN], 
and the [POST MCRO] button as [SUB].

To assign macro operations to different buttons
If in the above operation you assigned a Multi Program 2 
function to the macro buttons, you can assign the PRE 
MCRO and POST MCRO functions to different buttons.

For details, see “Assigning Functions to User Preference 
Buttons” or “Assigning a Function to a Memory Recall 
Button in the Utility/Shotbox Control Block” in 
Chapter 19 (Volume 2).

Notes 
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Examples of Operations in the Multi 
Program 2 Mode (When Sharing a 
Switcher Bank)

To create video on the M/E or PGM/PST bank assigned to 
both main and sub operations, use the following procedure.

1 Press the [MAIN] button, turning it on, and turning off 
the [SUB] button.

2 With the normal operations, create the main video.

3 Press the [SUB] button, turning it on, and turning off 
the [MAIN] button.

Now you can create the sub video.

4 Create the sub video.

The basic method of operation is the same as for the 
main video, except that the utility 2 bus signal is 
assigned to background A, and the utility 3 bus signal 
is assigned to background B.
For sub, only keys 2 to 8 can be used, and for wipes, 
standard wipe patterns only. There are also other 
differences in operation from standard mode.

For details, see “Differences between Multi Program 
2 Mode and Standard Mode” (page 246) and 
“Restrictions on Using Multi Program 2 Mode” (page 
247).

5 Press the [MAIN] and [SUB] buttons simultaneously, 
turning them on.

If both buttons are lit, the control panel shows the 
status of main.

6 Carry out the transition.

Both main and sub video images are switched.

Optional Operations

Making cross-point settings
Cross-point assign tables can be set not only for main 
output but also for sub output.
You can set cross-point assign tables for the following 
banks.

M/E-1 SUB to M/E-4 SUB
P/P SUB

The table actually used is that for which the control panel 
delegation button is lit.

For details, see “Cross-Point Settings (Xpt Assign Menu)” 
in Chapter 19 (Volume 2).

Enabling DME wipe operations for sub
By factory default, DME wipe operations are inhibited for 
sub background. To enable them, in the Engineering Setup 
>Switcher >Config menu, set [DME Wipe Sub Enable] to 
On.
This setting applies to the whole control panel (all M/E 
banks and PGM/PST bank).

If a DME wipe for sub is recalled in a snapshot or 
keyframe, the image will not be handled correctly.

Inhibiting utility 2 bus signal selection
In Multi Program 2 mode, you can inhibit other uses of the 
utility 2 bus signal in order to use the signal as the 
background for sub.
This setting applies to the whole control panel (all M/E 
banks and PGM/PST bank).
In the Engineering Setup >Panel >Config >MP2 Main/Sub 
Assign menu, set [Util2 Inhibit] to On.
This inhibits operations of selecting from the background 
B row while holding down the [UTIL] button in the cross-
point control block.

Inhibiting key operations for main or sub 
keyer
In the Engineering Setup >Panel >Config >Operation 
Inhibit >M/E Operation Inhibit menu, you can make 
settings to inhibit key operations on each of the main and 
sub keyers independently.

For details, see “Inhibiting Utility 2 Bus and Key 
Operations” in Chapter 19 (Volume 2).

Including Multi Program 2 data in recall 
operations of keyframes and snapshots
In the Engineering Setup >Switcher >Config menu, set 
[Recall M/E Config] to On.
When a keyframe or snapshot is stored or recalled, the 
following data is included.

M/E Config, PGM Config, M/E Output Assign, and 
Key PVW Config

For details of the above data, see “Setting the operating 
mode for each switcher bank” (page 242) and “Assigning 
output signals for Multi Program 2 mode” (page 242).

This setting applies to the whole control panel (all M/E 
banks and PGM/PST bank).

M/E Config data is saved, even when this setting is Off.

Notes 

Notes 
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Changing the key assignment for each 
output (Misc menu)
In Multi Program 2 mode you can change the key 
assignments independently.
The following describes an example using M/E-1, but the 
operation is the same for other banks.

• This setting is linked to the setting in the Engineering 
Setup >Switcher > Config >PGM Config menu.

• It is not possible to make this setting while the above 
PGM Config menu is locked, or [Recall M/E Config] 
(see previous item) is set to Off.

1 In the M/E-1 menu, select first VF7 ‘Misc,’ then HF5 
‘Key Assign.’

The Key Assign menu appears, and the current key 
assignment is shown in the status area.

2 Change the setting in “Key Enable” as required.

Keys recalled in a snapshot recall
If a snapshot is recalled independently on main or sub, this 
only retrieves the settings for the key assigned to the 
recalled side. For example, if key 1 and key 2 are assigned 
on main, and key 3 and key 4 are assigned on sub, then if 
you recall a snapshot on main, this only retrieves the 
settings for key 1 and key 2, and the state of key 3 and key 
4 assigned on sub is not affected.

Assigning sub preview output to preview 
selection buttons
You can assign the sub preview output to a preview 
selection button in the fade-to-black control block or 
downstream key/fade-to-black control block.

For details, see “Overall Control Panel Settings (Config 
Menu)” in Chapter 19 (Volume 2).

When the Multi Program 2 license is valid, by assigning 
the “Shift” function to a button, you can assign two 
preview outputs, “Shift” and “Unshift” to a single button. 
To use the shift output, always assign “Shift” to some 
button.

Changing the matrix size to Standard
When using a router, if the matrix size is set to [128×128], 
it is not possible to control the utility 3 bus on the S-Bus. 
When using Multi Program 2, in the <Matrix Size> group 
of the Engineering Setup >Router/Tally >Router menu, 
select other than [128 × 128].

For details, see “Assigning Switcher Inputs and Outputs to 
S-Bus Space” in Chapter 23 (Volume 2).

As for the bus number of the utility 3 bus, a DME Key bus 
number is used as follows.

Making settings for timeline-related 
keyframe operations

To assign sub regions to the region selection 
buttons in the numeric keypad control block
In the Engineering Setup >Panel >Config >10 Key Region 
Assign menu, assign regions to the region selection 
buttons in the numeric keypad control block.

For details, see “Overall Control Panel Settings (Config 
Menu)” in Chapter 19 (Volume 2).

To make region and reference region selections 
using a menu
During snapshot or keyframe operations, you can select a 
region (including sub) in the Key Frame >Region Select 
menu. This is convenient for selecting some of the regions 
assigned to the numeric keypad control block or changing 
the reference region.

For details, see “Specifying the Region and Edit Points” 
in Chapter 13 (Volume 2).

To assign regions shown in the Timeline menu
You can select how regions assigned to region selection 
buttons appear in the Key Frame >Timeline menu.

For details, see “Settings in the Timeline Menu” in 
Chapter 13 (Volume 2).

Enabling re-entry between the main and 
sub sides of the same M/E bank
In the Engineering Setup >Switcher >Config menu, set 
[MP2 Free Re-Entry] to On.

• Re-entry adds a 1H delay to the video. Nested re-entry 
may lead to problems in the video. 

• A maximum of ten re-entry stages are possible, with the 
final output having a delay of 5H.

• The selection order of re-entry signals affects the 
number of lines by which the output signal is lowered. 

• If a delay occurs in the image, even when the through 
mode is set, the ancillary data does not pass through. 

• For example, it is possible to select the re-entry of M/E-
1 main on M/E-1 main. 

Notes 

No. Bus (Standard) Bus (MP2)

70 M/E-1 DME Key M/E-1 Utility3

85 M/E-2 DME Key M/E-2 Utility3

100 M/E-3 DME Key M/E-3 Utility3

115 P/P DME Key P/P Utility3

Notes 
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Restrictions on mutual re-entry when using Multi 
Program 2
The snapshot function is affected by this re-entry function.
When the [MP2 Free Re-Entry] button is On, and any of 
the switcher banks are in Multi Program 2 mode, then the 
following restrictions apply.
If you save and recall snapshots simultaneously with more 
than one region specified, the recorded state is played back 
in the order of precedence of regions (M/E-1 >M/E-2 >M/
E-3 >P/P). Therefore, if you save and recall snapshots with 
more than one region specified, the cross-point settings 
may not be recalled correctly.
To recall the snapshots correctly, press the cross-point 
button before recalling the snapshots, to select a signal 
other than the re-entry signal, then recall the snapshots.

Functions Added in Multi Program 2 
Mode

• You can set video processing for the utility 3 bus signal.
• In the control panel and DCU GPI input settings and 

switcher GPI link settings, the actions that can be 
selected now also include “Sub Cut” and “Sub Auto 
Trans.”

• A switcher GPI link can now be set also for the utility 3 
bus.

• To the macro event configuration parameters and macro 
attachment settings, “Main & Sub” and “Sub” have been 
added.

• For cross-point button link settings, M/E-1 to M/E-4, 
and P/P “Sub Program,” “Sub Preset,” and “Sub Trans 
PGM” have been added to the link source bus.

• Snapshot attributes can now be set independently for 
main and sub.

• There are additional menus for sub which can be recalled 
by pressing a button twice.

• You can set [MP2 Auto Correct] to On or Off in the 
Effect menu or Snapshot menu. When this is set to On, 
for example, copy destination and source data is 
automatically recognized as main or sub, and the data 
interchanged.

• When the key adjustment mode is selected on the 
Multifunction Flexi Pad (or when the KEY ADJ button 
is lit), if you select the region selection button to which 
[M/E-x Sub] is assigned, the [TRNS] button operates as 
a button for the sub region.

• You can assign [SUB TRANS] to the key control block. 
This button functions as a [TRNS] button for the sub 
region.

Differences between Multi Program 2 Mode and Standard Mode

The differences from operation in standard mode are as 
follows.

Item Main Sub

Keys a) Keys 1 to 8 can be used Keys 2 to 8 only can be used

Wipes
(background)

Patterns Same as standard mode • Only standard patterns can be used
• Pattern mix is not possible

Modifiers Same as standard mode • Pairing, modulation, spring, spiral, 
and split cannot be used

• Edge fill mattes are single-color 
only

• Replication can be selected from 
four patterns

Wipes (key) Same as wipes (background) for sub

DME wipes Use Can be used Cannot be used (Can be used, with a 
setting change)

Patterns for 1 channel For a dedicated interface, each of main and sub can be used.
For the SDI interface, only one of main and sub can be used.

Patterns for 2 channels Only one of main and sub can be used
(For each M/E, the number of DMEs that can be used is the same as in 
standard mode.)Patterns for 3 channels

Backgrounds Wipe edge fill matte (including color 
mix and other settings in the Matte 
Adjust menu)

Wipe edge fill matte (single-color 
only)

Modifiers Same as standard mode Wipe border colors are single-color 
only
Multi Program 2
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a) Keys 2 to 8 are common to main and sub.

• Allow a transition to complete before carrying out main 
and sub delegation switching.

• The sub background A bus (utility 2 bus) is shared with 
wipe edge border fill. Making a change to one affects the 
other.

• Even if the wipe border width is set to the same numeric 
value for main and sub, the same image is not obtained.

Restrictions on Using Multi Program 
2 Mode

• The following functions are not available for sub:
- Data copy and swap
- Default recall (except for parametric recall)
- [AUTO] button function (see page 58)

• Re-entry is limited to five levels. Re-entry is not possible 
for main and sub of the same M/E.
However, this restriction can be removed.
For details, see “Enabling re-entry between the main 
and sub sides of the same M/E bank” (page 245).

• In the following cases, a transition using the fader lever 
may not be performed correctly:
- When the main and sub bus toggle modes are set 

differently
- For a pattern mix, preset color mix, and so on

• For an Internal bus link, GPI link, or External bus link, 
the “Utility 2” bus cannot be selected.

• Screen aspect, show key, and [MCRO ATTCH ENBL] 
button settings are common to main and sub.

• If a snapshot is recalled simultaneously for main and 
sub, or a keyframe is executed simultaneously for main 
and sub, then for the following common to main and sub 
the main settings are reflected.
- Key
- M/E Config
- DME external video bus and utility 1 bus

• When a macro attachment is set on the DME utility 1 bus 
or DME utility 2 bus, it is not possible to make separate 
main and sub settings.

• When snapshots with different M/E Config settings are 
recalled:
- If M/E Config data is not to be included in the snapshot 

data, the current system settings are used for snapshot 
reproduction.

- If M/E Config data is to be included in the snapshot 
data first M/E Config data is set, and then other 
snapshot data is recalled. 

• The bus override function is only available on the 
following buses:
- M/E-1 to M/E-4 Main BKGD A/B buses
- M/E-1 to M/E-4 Sub BKGD A/B buses (UTIL-2, 

UTIL-3 buses)
- P/P Main PGM/PST bus
- P/P Sub PGM/PST buses (UTIL-2, UTIL-3 buses)

• When a master snapshot or master timeline is executed 
with a key being assigned to both main and sub, it is 
uncertain which data will be reflected.

• When recalling a master snapshot with different register 
numbers for main and sub, the recall timing may differ 
by one field or more between main and sub.

• The link state is maintained even when M/E Config is 
changed. Set the link setting again, as required.

• Since keys 2 to 4 are shared between main and sub, when 
the main and sub fader lever positions are different, if 
you move the fader lever, the video changes 
instantaneously to the value of the most recently moved 
fader lever.

• When the transition type for main or sub is set to preset 
color mix, it is not possible to carry out independent key 
transition operation (common to main and sub).

• When the signal format is 1080P, snapshots, wipe 
snapshots, and effects created using a wipe for sub, do 
not function correctly with a signal format other than 
1080P. Similarly, those created with other than the 1080 
signal format, do not function correctly with a signal 
format of 1080P.

Transitions Key priority Cannot be used

Transition preview Cannot be used

Preset color mix Color matte or video signal selected 
on the utility 2 bus

Color matte only

Snapshots Cross-point hold Utility 2 cannot be set Utility 3 is added. BKGD A/B and 
Key1 cannot be set.

Control from an editor Same as standard mode Cannot be used

Operation setting for switcher GPI inputs and 
outputs

Same as standard mode Cannot be used

Item Main Sub

Notes 
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3D Support

Overview

Installing the following software enables video creation in 
3D mode.
• BZS-8560X (for MVS-8000X) or BZS-7560X (for 

MVS-7000X) as the switcher upgrade software
• BZDM-8560 (for MVE-8000A/MVE-9000) or BZS-

7561X (for MKS-7470X/7471X) as the DME upgrade 
software

• On the MVS-8000X, the M/E-4 bank is not used for 3D 
mode.

• On the MVS-7000X, the M/E configuration in 3D mode 
will be the same as that in 2M/E mode (see page 254).

• The following signal formats support 3D.
1080i/50, 1080i/59.94, 720P/50, 720P/59.94

• For details of the board configurations required for 3D 
mode, consult your Sony representative.

Using the software
To use the switcher upgrade software and DME upgrade 
software, you need to enter an install key to enable the 
software. (It is not necessary to enter an install key if the 
software was factory-installed.)

Ask your Sony representative about entering the install 
key.

At this time, the unique device ID may be required.
You can check the unique device ID in the Install menu of 
the switcher and DME.

For details of this operation, see “Installation and Device 
Setup (Install/Unit Config menu)” in Chapter 18 
(Volume 2).

How the 3D display works
In 3D mode, two different images, for the left eye and the 
right eye, are displayed simultaneously, to be combined by 
the brain into a stereoscopic image.
Therefore, switcher and DME hardware is duplicated, with 
input signals for the left eye and right eye. (See the 
following figure.)

Preparations

Switching the system to 3D mode

It is only possible to switch to 3D mode when the system 
signal format is set to one of the following.
1080i/50, 1080i/59.94, 720P/50, 720P/59.94

1 Display the Engineering Setup >System >Format 
menu.

2 Press [3D Mode], turning it on.

A popup window appears, with a message.

3 Check the message, and select [Yes].

Input primary numbers for left and right 
signals
For the signals used in 3D mode for the left eye view and 
right eye view (referred to simply as left and right signals), 
select a combination of primary input numbers from two 
types (signals in the same slot and signals in different 
slots).

Notes 

Notes 

Combined by brain into 
stereoscopic image

Image showing view 
from right eye

Image showing view 
from left eye

X-axis

Left eye Right eye

Parallax (spacing between eyes)
Increasing the parallax value increases the 
apparent stereoscopic effect.

Z-axis
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For some signals, such as titles, the same signal is used for 
both left and right.

Specify whether to use a combination of left and 
right signals in the same slot or different slots

1 Display the Engineering Setup >System > Install/Unit 
Config > Unit Config menu.

2 In <3D Connector Pair> group, select either of the 
following.

1-2 Mode: Specify a pair of left and right signals in the 
same slot.

1-21Mode: Specify a pair of left and right signals in 
different slots.

3 Press [Execute].

Combinations of left and right signals 
(Input terminals)
The following combinations of left and right signals are 
available depending on whether to use the signals in the 
same slot or different slots. 

If [1-2 Mode] is selected on MVS-8000X
If [1-21 Mode] is selected on MVS-8000X

Right signals Left signals

Slot 5

PRIMARY INPUTS 1 PRIMARY INPUTS 2

PRIMARY INPUTS 3 PRIMARY INPUTS 4

: :

PRIMARY INPUTS 19 PRIMARY INPUTS 20

Slot 6

PRIMARY INPUTS 21 PRIMARY INPUTS 22

PRIMARY INPUTS 23 PRIMARY INPUTS 24

: :

PRIMARY INPUTS 39 PRIMARY INPUTS 40

Slot 7

PRIMARY INPUTS 41 PRIMARY INPUTS 42

PRIMARY INPUTS 43 PRIMARY INPUTS 44

: :

PRIMARY INPUTS 59 PRIMARY INPUTS 60

Slot 8

PRIMARY INPUTS 61 PRIMARY INPUTS 62

PRIMARY INPUTS 63 PRIMARY INPUTS 64

: :

PRIMARY INPUTS 79 PRIMARY INPUTS 80

Slot 9

PRIMARY INPUTS 81 PRIMARY INPUTS 82

PRIMARY INPUTS 83 PRIMARY INPUTS 84

: :

PRIMARY INPUTS 99 PRIMARY INPUTS 100

Slot 10

PRIMARY INPUTS 101 PRIMARY INPUTS 102

PRIMARY INPUTS 103 PRIMARY INPUTS 104

: :

PRIMARY INPUTS 119 PRIMARY INPUTS 120

Slot 11

PRIMARY INPUTS 121 PRIMARY INPUTS 122

PRIMARY INPUTS 123 PRIMARY INPUTS 124

: :

PRIMARY INPUTS 139 PRIMARY INPUTS 140

Slot 12

PRIMARY INPUTS 141 PRIMARY INPUTS 142

PRIMARY INPUTS 143 PRIMARY INPUTS 144

Slot 13

PREMIUM INPUTS 1 PREMIUM INPUTS 2

PREMIUM INPUTS 3 PREMIUM INPUTS 4

: :

PREMIUM INPUTS 19 PREMIUM INPUTS 20

Right signals Left signals

Slot 5 Slot 6

PRIMARY INPUTS 1 PRIMARY INPUTS 21

PRIMARY INPUTS 2 PRIMARY INPUTS 22

: :

PRIMARY INPUTS 20 PRIMARY INPUTS 40

Slot 7 Slot 8

PRIMARY INPUTS 41 PRIMARY INPUTS 61

PRIMARY INPUTS 42 PRIMARY INPUTS 62

: :

PRIMARY INPUTS 60 PRIMARY INPUTS 80

Slot 9 Slot 10

PRIMARY INPUTS 81 PRIMARY INPUTS 101

PRIMARY INPUTS 82 PRIMARY INPUTS 102

: :

PRIMARY INPUTS 100 PRIMARY INPUTS 120

Slot 11

PRIMARY INPUTS 121 PRIMARY INPUTS 122

PRIMARY INPUTS 123 PRIMARY INPUTS 124

: :

PRIMARY INPUTS 139 PRIMARY INPUTS 140

Slot 12

PRIMARY INPUTS 141 PRIMARY INPUTS 142

PRIMARY INPUTS 143 PRIMARY INPUTS 144

Right signals Left signals
2493D Support
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If [1-2 Mode] is selected on MVS-7000X

If [1-21 Mode] is selected on MVS-7000X

Setting input signals for 3D mode
For each primary input, to select whether separate left and 
right signals are used, or the same signal is shared between 
left and right, use the following procedure.

1 Display the Engineering Setup >Switcher > Config 
>3D Config menu.

2 Press [Input Link].

The Input Link menu appears.

3 Using any of the following methods, select the link 
number to operate on.

• Press directly on the list.
• Press the arrow keys to scroll the reverse video 

cursor.
• Turn the knobs.

4 Press [3D Input Link], and set the link to either of the 
following.

• To use separate left and right signals, set to On.
• To use the same signal shared between left and right, 

set to Off (no indication).

When this is set to “Off,” one signal of the 
predetermined pair cannot be used.
For example, for IN1 and IN21, IN21 cannot be used, 
and is grayed out in the list.

5 Repeat steps 3 and 4, to set all of the primary inputs in 
3D mode.

Slot 13

PREMIUM INPUTS 1 PREMIUM INPUTS 2

PREMIUM INPUTS 3 PREMIUM INPUTS 4

: :

PREMIUM INPUTS 19 PREMIUM INPUTS 20

Right signals Left signals

Slot 5

PRIMARY INPUTS 1 PRIMARY INPUTS 2

PRIMARY INPUTS 3 PRIMARY INPUTS 4

: :

PRIMARY INPUTS 19 PRIMARY INPUTS 20

Slot 6

PRIMARY INPUTS 21 PRIMARY INPUTS 22

PRIMARY INPUTS 23 PRIMARY INPUTS 24

: :

PRIMARY INPUTS 39 PRIMARY INPUTS 40

Slot 7

PRIMARY INPUTS 41 PRIMARY INPUTS 42

PRIMARY INPUTS 43 PRIMARY INPUTS 44

: :

PRIMARY INPUTS 59 PRIMARY INPUTS 60

Slot 8

PRIMARY INPUTS 61 PRIMARY INPUTS 62

PRIMARY INPUTS 63 PRIMARY INPUTS 64

: :

PRIMARY INPUTS 79 PRIMARY INPUTS 80

Right signals Left signals

Slot 5 Slot 6

PRIMARY INPUTS 1 PRIMARY INPUTS 21

PRIMARY INPUTS 2 PRIMARY INPUTS 22

: :

PRIMARY INPUTS 20 PRIMARY INPUTS 40

Slot 7 Slot 8

PRIMARY INPUTS 41 PRIMARY INPUTS 61

PRIMARY INPUTS 42 PRIMARY INPUTS 62

: :

PRIMARY INPUTS 60 PRIMARY INPUTS 80

Right signals Left signals

Knob Parameter Adjustment Setting values

1 Link No Link number 1 to upwards

3 Num Select the 
number of 
consecutive 
numbers from 
the selected link 
number

1 to upwards

Notes 

When On, different signals are 
used for left and right.
When there is no indication 
(Off), the same signal is 
shared between left and right.

When On, left and 
right are reversed.

Link number
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Using pairs of primary input numbers reversed 
right-to-left
Press [L/R Input Exchange], setting it to On, to swap the 
left and right signals, and reverse the indications in the list.
For example, when the left signal is IN1, and the right 
signal is IN21, this assigns IN21 to the left signal and IN1 
to the right signal.

When [3D Input Link] is off and [L/R Input Exchange] is 
set to On, then the other input of the pair can be used.
For example, when using IN1 shared between left and 
right, you can also use IN21 shared between left and right, 
and IN21 also appears in the list.

To assign inputs with the primary input numbers 
reversed left-to-right to cross-points

1 In the Input Link menu, set [L/R Input Exchange] to 
On, then display the Engineering Setup >Panel >Xpt 
Assign >Main, V/K Pair Assign menu.

In the Source field, “3D Exchange=xx” appears (“xx” 
is the input number linked to the input number at the 
position of the cursor).
In the example of the following figure, for IN11 “3D 
Exchange=31” appears.

2 Press [Set].

This sets IN31 in place of IN11.

Combinations of left and right signals 
(output connectors)
The left and right signals are combined for the slots as 
follows.

If [1-2 Mode] is selected on MVS-8000X

If [1-21 Mode] is selected on MVS-8000X

If [1-2 Mode] is selected on MVS-7000X

Notes 

Right signals Left signals

Slot 13

OUTPUTS 1 OUTPUTS 2

OUTPUTS 3 OUTPUTS 4

: :

OUTPUTS 19 OUTPUTS 20

Left-right reversed 
number is assigned

“xx” is the input number 
linked to the input number at 
the position of the cursor

Slot 14

OUTPUTS 25 OUTPUTS 26

OUTPUTS 27 OUTPUTS 28

: :

OUTPUTS 43 OUTPUTS 44

Slot 15

MSD1 MSD2

OUTPUTS 21 OUTPUTS 22

OUTPUTS 23 OUTPUTS 24

OUTPUTS 45 OUTPUTS 46

OUTPUTS 47 OUTPUTS 48

Right signals Left signals

Slot 13 Slot 14

OUTPUTS 1 OUTPUTS 25

OUTPUTS 2 OUTPUTS 26

: :

OUTPUTS 20 OUTPUTS 44

Slot 15

MSD1 MSD2

OUTPUTS 21 OUTPUTS 22

OUTPUTS 23 OUTPUTS 24

OUTPUTS 45 OUTPUTS 46

OUTPUTS 47 OUTPUTS 48

Right signals Left signals

Slot 9

OUTPUTS 1 OUTPUTS 2

OUTPUTS 3 OUTPUTS 4

: :

OUTPUTS 19 OUTPUTS 20

Slot 10

OUTPUTS 25 OUTPUTS 26

OUTPUTS 27 OUTPUTS 28

: :

OUTPUTS 43 OUTPUTS 44

Slot 11

MSD1 MSD2

OUTPUTS 21 OUTPUTS 22

OUTPUTS 23 OUTPUTS 24

OUTPUTS 45 OUTPUTS 46

OUTPUTS 47 OUTPUTS 48

Right signals Left signals
2513D Support
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If [1-21 Mode] is selected on MVS-7000X

Setting frame memory outputs for 3D 
mode
Select whether to use frame memory outputs 1 to 8 in 
combinations of left and right signals for 3D mode. The 
left and right combinations are fixed, as 1 and 5, 2 and 6, 3 
and 7, and 4 and 8.

1 Display the Engineering Setup >Switcher >Config 
>3D Config menu.

2 Press [FM Output Link].

The FM Output Link menu appears.

3 Using any of the following methods, select the link 
number.

• Press directly on the list.
• Press the arrow keys to scroll the reverse video 

cursor.
• Turn the knobs.

4 Press [FM Link], and set the link to either of the 
following.

• To use the frame memory outputs in left and right 
combinations, set to On.

• To use the same frame memory output for left and 
right, set to Off (no indication).

When [FM Link] is On, frame memory output does not 
include ancillary data for the right image.

5 Repeat steps 3 and 4, to set all of the frame memory 
outputs for 3D mode.

Functions for which left and right frame memory 
outputs are coupled when [FM Link] is On
Pair mode On/Off, clip playback, clip transition 1), clip 
transition snapshot
Carry out operations other than the above separately for 
left and right.
1) When [FM Link] is On, a clip for the right frame memory to be used in the 

clip transition cannot be selected in the following menus.
• M/E-1 >Misc >Transition >Clip Transition >Clip menu
• M/E-2 >Misc >Transition >Clip Transition >Clip menu
• P/P >Misc >Transition > Clip Transition > Clip menu
• The selection must be made in the Frame Memory >Clip >Recall menu

Switching the type of DME output signal 
(video/key) assigned to a monitor signal
The function for switching the signal type of the monitor 
output (one channel) to video or key is assigned to one of 
the Prefs buttons of the Menu control block or one of the 
buttons of the Utility/Shotbox control block (DME MON 
KEY command).

For details of the assignment, see “Settings Button 
Assignment (Prefs/Utility Menu)” in Chapter 19 (Volume 
2). 

To switch the signal type of DME output (video/
key) assigned to a monitor signal
Press the DME MON KEY command assigned button and 
turn it on to assign DME key output to a monitor signal. 
Then press the button and turn it off to assign DME video 
output to a monitor signal. For selection of the DME 
channels to be assigned to a monitor signal. 

For details, see “Assigning a DME output signal as a 
monitor signal” (page 129).

Right signals Left signals

Slot 9 Slot 10

OUTPUTS 1 OUTPUTS 25

OUTPUTS 2 OUTPUTS 26

: :

OUTPUTS 20 OUTPUTS 44

Slot 11

MSD1 MSD2

OUTPUTS 21 OUTPUTS 22

OUTPUTS 23 OUTPUTS 24

OUTPUTS 45 OUTPUTS 46

OUTPUTS 47 OUTPUTS 48

Knob Parameter Adjustment Setting values

1 Link No Link number 1 to 8

Link number

Using two signals in left-right 
combination
Using one signal shared 
between left and right

3 Num Select the 
number of 
consecutive 
numbers from 
the selected 
link number

1 to 8

Notes 

Knob Parameter Adjustment Setting values
3D Support
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Selecting the signal output from a DME 
monitor output connector

1 Display the Engineering Setup >DME >Output 
>Monitor Output menu.

2 Press [DME1] or [DME2] to select the DME to 
operate on.

3 On the left, select MONI OUT#1 or MONI OUT#2.

4 On the right, select the signal.

You can select any of Ch1 Video, Ch1 Key, Ch2 
Video, and Ch2 Key.

5 Press [Set].

This assigns the signal.

Restrictions in 3D Mode

In 3D mode, the following restrictions apply, because the 
switcher and DME hardware is operating in tandem (link 
A and link B).

a) In MVS-8000X
b) In MVS-7000X

Video Creation in 3D Mode

Adjusting the parallax using the DME
By adjusting the parallax (see page 248), you can control 
the degree of depth perception.

1 Display the Global Effect >Ch1 to Ch4 >3D Mode 
menu.

2 To adjust the parallax, press [Parallax].

3 Turn the knobs to adjust the following parameters.

If the position of an image in three-dimensional space 
is in the plane of the monitor screen, adjusting the 
parallax does not change the 3D effect. In this case, 
adjust the parameters in the local coordinate space so 
that the image is either in front of or behind the plane 
of the screen before adjusting the parallax.

4 To adjust the perspective without changing a size or 
shape, press [Disparity].

5 Turn the knobs to adjust the following parameters.

Restrictions Details

Functions that 
cannot be used 
in the switcher

• 73 or more signal inputs (MVS-8000X) 
or 41 or more signal inputs (MVS-
7000X)

• 11 or more premium input signals 
(MVS-8000X only)

• 25 or more signal outputs
• Monitor buses 2/4/6/8
• M/E-2 bank a)

• M/E-3 bank
• Key 5 to Key 8 b)

• DME utility buses 1, 2
• Color corrector 2
• Format converter
• Functions of the “Logical M/E Assign” in 

the Engineering Setup >Switcher 
>Config menu.

Functions that 
cannot be used 
on the DME

• DME channels 3, 4, 7, 8
• DME monitor output numbers 3 and 4
• Editor ports 3 and 4 when the editor 

port operation mode is set to 
“Independent”

Other 
restrictions

• Auto chroma keying is carried out on 
the left image.

• Tallies are generated based on the left 
signal in the PGM/PST bank.

Knob Parameter Adjustment Setting values

1 1ch 
Parallax

Adjust the 
parallax for 
channel 1

0.00 to 8.00

2 2ch 
Parallax

Adjust the 
parallax for 
channel 2

0.00 to 8.00

Notes 

Knob Parameter Adjustment Setting values

1 1ch 
Disparity

Adjust the 
degree of depth 
perception for 
channel 1

–8.00 to 8.00

2 2ch 
Disparity

Adjust the 
degree of depth 
perception for 
channel 2

–8.00 to 8.00
2533D Support
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M/E Configuration 
Switching

On the MVS-7000X, a single mix/effect board MKS-
7210X can be shared among a number of M/E banks.
Using this function, you can select the M/E configuration 
of the whole switcher from the following.

In this manual, using a single MKS-7210X board is 
referred to as 1M/E mode, 2M/E mode, 3M/E mode, or 
4M/E mode depending on the maximum number of M/Es 
on which the board is used.

• A maximum of five M/Es can be used on a single 
switcher.

• When the signal format is 1080P, each MKS-7210X 
board can only be used on a single 1M/E and the number 
of available keys is 4.

• In 2M/E mode, DME selection on a single M/E is as 
follows.
- Two places when the dedicated interface is used.
- One place when the SDI interface is used.

Setting the number of M/Es for each board
Use the following procedure.

1 Display the Engineering Setup >System > Install/Unit 
Config >M/E Split menu.

2 In <M/E Split (1st Board)> group, select any of 
[1ME], [2ME], [3ME], and [4ME].

3 In each of the <M/E Split (2nd Board)> to <M/E Split 
(3rd Board)> groups, select [1ME] or [2ME].

4 Press [Execute].

Assigning Keys for 3M/E Mode or 4M/E 
Mode
You can assign keys for 3M/E mode or 4M/E mode 
selected in the M/E Split menu.

1 Display the Engineering Setup >Switcher > Config 
>Key Config menu.

2 Assign keys to M/E-1 and M/E-2.

Select any of the following in the <Key Assign (M/E-
1, M/E-2)> group.
0Key (ME1) 4Key(ME2): Assign no key to M/E-1 

and four keys to M/E-2.
1Key(ME1) 3Key(ME2): Assign one key to M/E-1 

and three keys to M/E-2.
2Key(ME1) 2Key(ME2): Assign two keys each to M/

E-1 and M/E-2.
3Key(ME1) 1Key(ME2): Assign three keys to M/E-1 

and one key to M/E-2.
4Key(ME1) 0Key(ME2): Assign four keys to M/E-1 

and no key to M/E-2.

3 Assign keys to M/E-3 and P/P.

Select the key assignment method in the <Key Assign 
(M/E-3, P/P)> group in the same way as step 2 above.

Board Number of 
assigned M/Es

Number of keys available on 
a single M/E

Board 1 1 8

2 4

3 M/E-1, M/E-2 Select from 
0 to 4

PGM/PST 4

4 Select from 0 to 4

Board 2 1 8

2 4

Board 3 1 8

2 4

Notes
M/E Configuration Switching
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Restrictions in 3M/E Mode and 4M/E Mode
In 3M/E mode and 4M/E mode, the following restrictions 
apply.

a) No restriction is applied to P/P. Thus, both utility buses 1 and 2 can be used 
for P/P.

Classification 3M/E mode 4M/E mode

Operation mode All M/Es and 
P/P

DSK mode and multi-program 2 
mode cannot be set.

All M/Es and 
P/P

• DSK mode and multi-program 2 
mode cannot be set.

• [Utility 2] cannot be selected for 
the background in multi-program 
mode.

M/E-1, M/E-2 [Utility 2] cannot be selected for the 
background in multi-program mode.

M/E assignment All M/Es and 
P/P

Logical M/E Assign cannot be used. All M/Es and 
P/P

Logical M/E Assign cannot be used.

Wipes All M/Es and 
P/P

• Pattern mix cannot be used.
• Pattern number 162 wipes cannot 

be used.

All M/Es and 
P/P

• Pattern mix cannot be used.
• Pattern number 162 wipes cannot 

be used.

M/E-2 • Random/diamond dust wipes can 
be used.

• Dust mix cannot be used.

M/E-2, M/E-3 • Random/diamond dust wipes can 
be used.

• Dust mix cannot be used.

Wipe border M/E-2 Wipe border colors are single-color 
only.

M/E-2, M/E-3 Wipe border colors are single-color 
only.

M/E outputs M/E-1, M/E-2 Out5 and Out6 cannot be used. All M/Es and 
P/P

Out5 and Out6 cannot be used.

Signal selection M/E-1, M/E-2 PROC V and PROC K signals 
cannot be selected with any cross-
point button.

All M/Es and 
P/P

PROC V and PROC K signals 
cannot be selected with any cross-
point button.

Utility bus M/E-1 Since only one utility bus is available, 
utility 1 bus is used instead of utility 2 
bus in the following functions. a)

• Wipe border
• Preset color mix
• Backgrounds of DME wipes

M/E-1, P/P Since only one utility bus is available, 
utility 1 bus is used instead of utility 2 
bus in the following functions.
• Wipe border
• Preset color mix
• Backgrounds of DME wipes

M/E-2 Since only one utility bus is available, 
you cannot select the following 
functions.
• Key border
• Sub mask
• Preset color mix
• Wipe border

M/E-2, M/E-3 Since only one utility bus is available, 
you cannot select the following 
functions.
• Key border
• Sub mask
• Preset color mix
• Wipe border

M/E-2 If you select a DME wipe which uses 
a utility bus for a background image, 
a color matte signal is used instead 
of a utility bus signal.

M/E-2, M/E-3 If you select a DME wipe which uses 
a utility bus for a background image, 
a color matte signal is used instead 
of a utility bus signal.

Side flags M/E-2 Side flags cannot be used. M/E-2, M/E-3 Side flags cannot be used.

DME All M/Es and 
P/P

For PGM/PST, the same restrictions 
as those for 2M/E apply. For M/E1 
and M/E-2, the same restrictions as 
those for 4M/E mode apply.

All M/Es and 
P/P

• For the dedicated interface, DME 
can be used in only one place for 
each M/E.

• For the SDI interface, DME wipes 
and processed keys cannot be 
used.

• Only one-channel mode patterns 
can be selected for DME wipes.
255M/E Configuration Switching
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CDME Operations
DME

DME (Digital Multi Effects) allows you to add three-
dimensional effects such as image movement, rotation, 
magnification and shrinking, as well as a wide variety of 
special effects. DME is the general name for all of these 
effects.
You can use up to eight channels as dedicated DME 
channels. 
Each channel can be used on its own or in combination 
with other channels, which allows you to create advanced 
effects with more complexity.
Functions that can be used differ with the models of DME.

For details, see“Functional Differences With Models of 
DME” (page 394).

Three-Dimensional Transformations

Transformation is the process of placing a video image in 
a three-dimensional DME coordinate space and subjecting 
it to manipulations such as movement, rotation, 
magnification or shrinking.

Three-dimensional coordinate space

Source coordinate space and target coordinate 
space
Images are placed in one of two types of coordinate space: 
source coordinate space and target coordinate space.
• The source coordinate space is a three-dimensional 

coordinate space with reference to the image itself. The 
x- and y-axes are defined parallel to the plane of the 
image, and the z-axis is defined perpendicular to the 
plane of the image. When you move the image, the 
coordinate axes also move.

• The target coordinate space is a three-dimensional 
coordinate space with reference to the output monitor 
screen. The x- and y-axes are defined parallel to the 

plane of the monitor screen, and the z-axis is defined 
perpendicular to the plane of the monitor screen. The 
coordinates do not move even if the image moves.

Source coordinate space and target coordinate space

For example, as shown in the following figure, the image 
moves in a different direction when you move it along the 
x-axis of the source coordinate space and along the x-axis 
of the target coordinate space. 

Movement along the x-axes of the source 
coordinate space and target coordinate space

Local coordinate space and global coordinate 
space
The coordinates of an individual DME channel are called 
its local coordinate space. The coordinates common to all 
channels are called the global coordinate
space.
By switching from local to global coordinate space, you 
can add new movement to the movement of images in 
individual channels, and also apply transformation effects 
to multiple channels that have been combined by Global 
effects (see page 336).

Source coordinate space Target coordinate space

Source coordinate space Target coordinate space
DME / DME
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Local coordinate space and global coordinate space

Three-dimensional parameters
Three-dimensional parameters are x, y, and z values which 
define the position of an image, its axis of rotation, the 
position of an imaginary point of view on the image, and 
so on. 
The standard values of parameters are as follows, 
depending on the aspect ratio of your monitor (4:3 or 
16:9).

Values for 4:3 mode
• Origin at center of image (source coordinate space) 

or center of monitor (target coordinate space)
x = 0.00, y = 0.00, z = 0.00

• Upper right corner of image or monitor
When using SD format signals: x = 4.00, y = 3.00, z = 
0.00
When using HD format signals: x = 12.00, y = 9.00, z = 
0.00

• Lower left corner of image or monitor
When using SD format signals: x = –4.00, y = –3.00, z = 
0.00
When using HD format signals: x = –12.00, y = –9.00, z 
= 0.00

Values for x-, y-, and z-axes (4:3 mode)

Values for 16:9 mode
• Origin at center of image (source coordinate space) 

or center of monitor (target coordinate space)
x = 0.00, y = 0.00, z = 0.00

• Upper right corner of image or monitor
When using SD format signals: x = 4.00, y = 2.25, z = 
0.00
When using HD format signals: x = 16.00, y = 9.00, z = 
0.00

• Lower left corner of image or monitor
When using SD format signals: x = −4.00, y = −2.25, z = 
0.00
When using HD format signals: x = −16.00, y = −9.00, z 
= 0.00

Values for x-, y- and z-axes (16:9 mode)

Limits of three-dimensional parameters
The following table shows the limits of three-dimensional 
transformation parameters.
The three-dimensional parameters of an image change 
when you use the trackball or Z-ring to execute a 
transformation. You can also execute a transformation by 
entering parameter values from the numeric keypad 
control block.

Rotation around y-axis in local coordinate space

Rotation around y-axis in global coordinate space

x-axis

z-axis – y-axis

y-axis
z-axis +

The plus direction on the 
z-axis is depth into the 
image or monitor screen.

a) The value in parentheses is for HD 
format.

x-axis

x-axis

z-axis –

y-axis

y-axis

z-axis +

The plus direction on the 
z-axis is depth into the 
image or monitor screen.

a) The value in parentheses is for 
HD format.
257DME
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Detents
The system defines points called detents at regular 
intervals on the three-dimensional space. Pressing the 
[CTR] button (see page 271) in the device control block 
sets the current three-dimensional parameter values to the 
closest detent points.
The following table shows the interval between successive 
detents for each transformation operation mode (see page 
258).

a) When a value is smaller than 1, 1/Aspect or 1/Perspective (z) is adjusted 
to an integral value.

Three-dimensional parameter default 
values
Each of the transformation operation modes has default 
values for three-dimensional parameters. If required, you 
can return the current value to the defaults by pressing the 
[CTR] (see page 271) button in the device control block 
twice in rapid succession. 
The following table shows the default parameter values for 
each transformation operation mode.

Resetting of parameter values set in the 
source coordinate space
In some transformation operation modes, if you switch to 
the target coordinate space after setting up a three-
dimensional transformation in the source coordinate space, 
the setting values in the source coordinate space (three-
dimensional parameter values) are converted to values in 
the target coordinate space (source/target conversion).
Once a conversion has taken place, the original source 
coordinate space parameters do not return to their original 
values when you switch back to the source coordinate 
space. They are reset to zeros.
Source/target conversion occurs in the following operation 
modes: 
• Location XYZ
• Rotation

Transformation Operation Modes

The following operation modes are available for three-
dimensional DME transformations. These operations are 
carried out in the device control block (trackball or 
joystick). (For details, see “Three-Dimensional 
Transformation Operations” (page 270).)

Location XYZ
Moves the image on the x-axis, y-axis, or z-axis. The 
direction of movement differs depending on whether you 
are manipulating the image in the source coordinate space 
or the target coordinate space.

Operation mode Limits of three-dimensional 
transformation parameters

Location XYZ HD format: –999.9999 to +999.9999 

SD 
format:

4:3 –333.3333 to +333.3333

16:9 –250.0000 to +250.0000

Rotation, Spin –999.9999 to +999.9999

Axis Location HD format: –999.9999 to +999.9999 

SD 
format:

4:3 –333.3333 to +333.3333

16:9 –250.0000 to +250.0000

Location Size 0.0000 to +999.9999

Aspect 0.0000 to +2.0000

Perspective (x, y) HD format: –999.9999 to +999.9999 

SD 
format:

4:3 –333.3333 to +333.3333

16:9 –250.0000 to +250.0000

Perspective (z) 0.0000 to 999.9999

Skew –9.9999 to +9.9999

Operation mode Detent interval

Location XYZ 1.0000

Rotation, Spin 0.2500

Axis Location 1.0000

Location Size 0.2500

Aspect 1.0000 a)

Perspective (x, y)
Perspective (z)

1.0000
1.0000 a)

Skew 0.1000

Operation mode Default value

Location XYZ 0.0000

Rotation, Spin 0.0000

Axis Location 0.0000

Location Size 1.0000

Aspect 1.0000

Perspective (x, y)
Perspective (z)

0.0000
1.0000

Skew 0.0000
DME



  C
hapter 11  D

M
E

 O
perations
Image movement in the source coordinate space

Image movement in the target coordinate space

Rotation
Rotates the image on the x-axis, y-axis, or z-axis. The type 
of rotation differs depending on whether you are 
manipulating the image in the source coordinate space or 
the target coordinate space.

Image rotation in the source coordinate space

Image rotation in the target coordinate space

Spin
When rotating the image in Rotation mode, it may not 
always be possible to achieve the kind of rotation around 
an axis that you want. Combining Rotation mode with Spin 
mode creates an effect that rotates the image around a 
specified axis. The type of rotation differs depending on 
whether you are manipulating the image in the source 
coordinate space or the target coordinate space. (The way 
the image rotates around an axis is the same as in Rotation 
mode.)

Axis Location
Moves an axis of rotation in the source coordinate space.

Axis movement

Location Size
Changes the size of the whole image. 
• Because shrinking and magnification of the image in the 

source coordinate space is done in three-dimensional 
space, magnifying the image emphasizes the sense of 
perspective.

Movement on the x-axis Movement on the y-axis

Movement on the z-axis

Movement on the x-axis Movement on the y-axis

Movement on the z-axis

Rotation around the y-axisRotation around the x-axis

Rotation around the z-axis

Rotation around the y-axisRotation around the x-axis

Rotation around the z-axis

Movement on the x-axis Movement on the y-axis

Movement on the z-axis
259DME
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• Because shrinking and magnification of the image in the 
target coordinate space is a conversion of the two-
dimensional image displayed on the monitor, shrinking 
and magnification does not change the shape of the 
image.

Magnification and shrinking in the source 
coordinate space

Magnification and shrinking in the target 
coordinate space

Aspect
In the source coordinate space, changes the aspect ratio in 
the x-axis direction and y-axis direction, either 
independently or simultaneously.

Perspective
In the target coordinate space, changes the perspective on 
the image by changing an imaginary view point, without 
changing the position of the image.

The x-axis and y-axis values define the position of the 
view point. The z-axis value defines its distance from the 
image.

Skew
In the source coordinate space, change the skew of the 
image on the x-axis or y-axis.

Graphics Display

Graphics display is a function that allows you to display 
wire frames, coordinate axes and a grid over the current 
DME image, to make it easier to create effects in three-
dimensional coordinate space.
Graphics displayed by this function can also be output to 
the monitor output connector.
To make graphics display settings, use the DME menu. 
(For details, see “Graphics Display Operation” (page 
274).)
You can display the following kinds of graphics.

Wire frames
A wire frame displays an image enclosed in a frames, so 
that you can check the position and size of the image. If 
there is a shadow (see page 342), a frame is shown for the 
shadow as well.

Change of aspect ratio 
in x-axis direction

Change of aspect ratio 
in y-axis direction

Simultaneous change 
aspect ratio in x-axis 
direction and y-axis 
direction

Change of view point on 
x-axis

Change of view point on 
y-axis

Change of distance from 
view point to image

Change of skew on x-axis

Change of skew on y-axis
DME
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Coordinate axes
This is a three-dimensional display of coordinates in local 
or global coordinate space. You can check the origin of the 
axes and the directions of the x-, y-, and z-axes.

Channel ID
This displays the channel number so that you can check 
which channel you are using, a useful feature when you are 
working with multiple channels.
Channel IDs are displayed differently in local and global 
coordinate space.
• In local coordinate space, the channel number is 

displayed along with “F” or “B” to indicate whether you 
are looking at the front (F) or back (B) of the current wire 
frame. For example, “1F” means the front of the wire 
frame on channel 1 in local coordinate space.

• In global coordinate space, the channel number is 
displayed along with “G” to indicate global. For 
example, “G2” means channel 2 in global coordinate 
space.

Wire frame, local coordinate space axes, and channel ID

Grid
This is a grid pattern representing the whole of the monitor 
screen. The grid makes it easy to set the position of an 
image in two-dimensional coordinates.

Grid (16:9 mode)

Shrinking the graphics display
You can shrink the graphics display so that you can see 
beyond the range displayed on the normal monitor screen. 
This makes it possible to visually set the location of images 
in a larger space. The range displayed on a normal monitor 
screen is indicated by a frame.

To automatically erase the graphic display
Turn Auto Erase on. The graphic display is erased 
automatically whenever a keyframe is executed. It is 
displayed again after the keyframe ends, after the time set 
in Recovery Time.

Flex Shadow center axis
When using the Flex Shadow function (see page 283), turn 
Flex Shadow Axis on to display the Flex Shadow center 
axis. This is an effective aid in making settings for this 
function.

The Flex Shadow center axis function is not supported on 
the MVE-8000A.

Three-Dimensional Parameter 
Display

You can display a three-dimensional parameter list for the 
currently controlled image. When more than one DME 
channel is selected, the status of the reference channel is 
displayed.

For the method of displaying a parameter list and an 
example display, see “Viewing the three-dimensional 
parameter details” (page 273).

Special Effects

You can use DME to add a variety of special effects.
The special effects shown below can be applied.

Wire frame

Local coordinate space axes

Channel ID

Notes 

Range displayed on normal monitor screen

Wire frame
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Functions that can be used differ with the models of DME. 
For details, see “Functional Differences With Models of 
DME” (page 394).

Edge effects

Name Effect/Image

Border
(See page 276.)

Adds a border to the image frame. You 
can adjust the width (or thickness) of the 
border, its color, and the softness of the 
border edges.

Crop
(See page 277.)

Crops away the edges of the image. You 
can crop the top, bottom, left, and right 
sides individually or all together. You can 
also soften the cropped edges.

Beveled Edge
(See page 278.)

Gives an image a beveled edge. You can 
set the edge width and color. The inner 
edge softness and edge boundary 
softness can also be set.

Color

Lights

Key Border
(See page 279.)

Adds borders to keys or gives a key 
consisting of an outline only.

Art Edge
(See page 279.)

Adds edges to the inner and outer side of 
the input image.
The following items can be set.
• Art edge width and position
• Separate softening of the art edge inner 

and outer sides
• Color of art edges 

Examples of Art Edge source

Name Effect/Image

Gradation Matte 

Rainbow Matte

Radial Gradation
DME
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Effects for entire image

Art Edge
(See page 279.)

Flex Shadow
(See page 283.)

Allows a shadow to be added to the image 
using only one DME channel.
The following settings can be made for the 
shadow.
• The signal to use for the shadow

- External: Generate shadow using 
input key signal.

- Internal: Generate shadow using an 
internally generated, full-size DME 
key signal.

• Shadow shrinking and magnification
• Shadow position
• Shadow color and density
• Center axis of deformation
• Shadow slant and perspective

Name Effect/Image

Radial Rainbow

Examples of Art Edge source 
[Rainbow Matte]

Flex Shadow Source = External

Flex Shadow Source = Internal

Wipe Crop
(See page 287.)

Crops the video image to be visible inside 
or outside a wipe pattern.

Name Effect/Image

Defocus
(See page 290.)

Defocuses the whole image. The degree 
of defocusing can be set simultaneously 
or separately for video and key signals. 
(However, when the DME dedicated 
interface is used, the degree of 
defocusing can be set for video signals 
only.) You can also cancel the black level 
leaking that occurs at the edge of the 
screen when the Defocus effect is used.

Blur
(See page 291.)

Applies a rounded blurring to the whole 
image.

Name Effect/Image

Background

Video image

When Invert is On
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264

  C
hapter 11  D

M
E

 O
perations
Effects for video image

Multi Move
(See page 292.)

Shrinks the image and lines up a number 
of copies vertically and horizontally. You 
can specify the center point of the 
shrinking, the shrinking ratio, and the 
aspect ratio of the image screen.

Name Effect/Image

Sepia
(See page 293.)

Overlays a specified color onto the image. 
You can adjust the sepia color that is 
overlaid, and specify the degree of mixing 
between the original image and the sepia 
image.

Mono
(See page 293.)

Converts the image into a monochrome 
image.

Posterization
(See page 293.)

Coarsens the luminance gradations of the 
image, for a paintinglike effect. 

Solarization
(See page 293.)

Coarsens the chroma gradations of the 
image, for a paintinglike effect.

Nega
(See page 294.)

Reverses the luminance or chroma of the 
image.

Contrast
(See page 294.)

Changes the contrast of the luminance 
and chroma of the image.

Name Effect/Image

Mosaic
(See page 294.)

Divides the image into small tiles so that it 
looks like a mosaic. You can specify the 
size and aspect ratio of the tiles.

Mask
(See page 297.)

Masks part of the picture, so that special 
effects are applied only inside a selected 
pattern.

Name Effect/Image

Mask (normal)

Mask (invert)

Video 
image

Effect video 
image (Mosaic)

Video image
Effect video image 
(Mosaic)
DME
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Freeze effects
Freezes the input video. The video can also be frozen at a 
specified interval (see page 299). 

Nonlinear effects
Sketch
(See page 294.)

Provides a sketch-like effect based on the 
outlines of the image, using different 
touches such as sketch, edge color, 
drawing, relief, and sharp.
 

Metal
(See page 296.)

Provides a metallic gloss like that from 
gold, silver, or a rainbow colored surface. 
A metallic gloss can also be given to a 
freely selected color.

Dim and Fade
(See page 296.)

The Dim effect makes the image darker 
as it recedes into the distance. The Fade 
effect makes the image fade into the 
background as it recedes into the 
distance.

Glow
(See page 297.)

Softens the edges of highlights, giving an 
effect like being struck by a soft light.

Name Effect/Image

Sketch

Fade

Name Effect/Image

Wave
(See page 300.)

Produces a 
wave-like 
effect in the 
image.

Mosaic Glass
(See page 302.)

Makes the 
image 
rougher and 
finer at a 
specified 
interval.

Flag
(See page 302.)

Applies an 
effect like a 
flag waving 
in the wind.

Twist
(See page 302.)

Twists the 
image.

Ripple
(See page 303.)

Applies an 
effect like 
ripples 
moving 
across the 
image.

Rings
(See page 306.)

Partitions 
the image 
into rings 
that rotate 
while 
moving in 
the same 
direction.
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Broken Glass
(See page 306.)

Partitions 
the image 
like broken 
glass, with 
shards flying 
outward.

Flying Bar
(See page 307.)

Divides the 
image into 
bars which 
peel off in 
two blocks 
as they 
move.

Blind
(See page 307.)

Divides the 
image into 
bars or 
wedges, 
with blocks 
rotating like 
the slats of 
venetian 
blinds.

Split
(See page 308.)

Splits the 
image upper 
and lower, 
left and 
right.

Split Slide
(See page 308.)

Divides the 
image into 
bars which 
slide 
alternately in 
reverse 
directions.

Mirror
(See page 309.)

Partitions 
the image 
vertically 
and 
horizontally, 
creating an 
image like a 
reflection in 
a mirror.

Multi Mirror
(See page 309.)

Divides the 
image into 
originals and 
reflections, 
lining them 
up vertically 
and 
horizontally.

Name Effect/Image

Kaleidoscope
(See page 310.)

Creates an 
image like a 
view into a 
kaleido-
scope.

Lens
(See page 310.)

Creates an 
image like a 
view through 
a lens.

Circle
(See page 311.)

Makes a 
circle with 
the image.

Panorama
(See page 311.)

Curves the 
upper and 
lower edges 
of the image 
to 
emphasize 
the sense of 
perspective.

Page Turn
(See page 311.)

Turns the 
image like a 
turning 
page.

Roll
(See page 312.)

Rolls the 
image up.

Cylinder
(See page 312.)

Winds the 
whole image 
onto a 
cylinder.

Name Effect/Image
DME
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Corner Pinning effect
Sphere
(See page 313.)

Winds the 
whole image 
onto a 
sphere.

Explosion
(See page 313.)

Divides the 
image into 
fragments 
which 
expand as 
they fly out.

Swirl
(See page 313.)

Swirls the 
image.

Melt
(See page 314.)

Melts the 
image away 
from a 
specified 
part.

Character Trail
(See page 315.)

Extends the 
edge of the 
image like a 
trail.

Name Effect/Image

Name Effect/Image

Corner Pinning 
(See page 334.)

Provides the effect of inserting the 
foreground in the background, allowing 
the four corners to be positioned freely, so 
that the image fills the quadrilateral 
outlined by the corners.

Background

Foreground (in cropped state)

Corner Pinning (when Crop Link is on)
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Lighting effects

Recursive effects

Background color
Adds a color or inputs an external signal to the background 
of the image (see page 331). 

Separate sides (effects for front and back 
sides)
Applies separate video signals and key signals to the front 
and back of the image (see page 331). 

Front and back sides

Signal inversion (Invert effect)
Inverts the input video signal and/or key signal 
horizontally or vertically. You can make separate settings 
for the front and back (see page 332).

Name Effect/Image

Lighting
(See page 316.)

Provides the effect of light striking the 
image.  

Spotlighting
(See page 323.)

Creates the effect of a spotlight striking 
the surface of the image.

Name Effect/Image

Trail
(See page 318.)

Recursively 
freezes the 
input video 
at regular 
intervals so 
that a trail of 
afterimages 
is created. 
You can 
make the 
afterimages 
stardust 
trails.

Normal

Mat

Specular

Motion Decay
(See page 320.)

Blurs the 
motion of a 
moving 
video by 
creating 
afterimages 
of the 
moving 
video. You 
can make 
the 
afterimages 
stardust 
trails.

Keyframe 
Strobe
(See page 321.)

Freezes the video each time the effect 
passes a keyframe. You can make the 
afterimages stardust trails.

Wind
(See page 322.)

Strobes the 
image at 
regular 
intervals, 
and moves 
the frozen 
image in a 
fixed 
direction, 
leaving an 
afterimage.

Name Effect/Image

Front Back
DME
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Inversion of input signal

Key density adjustment
Adjusts the key density for the key signal input to the DME 
(see page 333). 

Key source selection
Selects either the key signals received from the switcher or 
the key signals generated in the DME for application to the 
front and back of the image (see page 268 or page 333).

Color mix setting
This is a combination of two colors with a pattern 
generator. This color mix signal can be used to fill parts 
such as a background or border (see page 289). 

Global Effects

Global effects are special effects created by combining the 
images of successive channels. The following types of 
global effects are available.
• Combiner
• Brick
• Shadow

Devices for DME Support

The following boards and processors provide DME 
support.

The available functions depend on the type of DME being 
used. For details, see “Functional Differences With 
Models of DME” in Appendix (page 394).

MKS-7470X/7471X DME board set (MVS-
7000X only)
Installing this in the MVS-7000X allows DME to be 
operated as though part of the switcher.
Each board supports two channels, and a maximum of two 
boards (four channels) can be used.
There are two types of interfaces available for connecting 
DMEs to the switcher: the dedicated interface and the SDI 
interface.

For details, see “Setting the Interface Between the DME 
and the Switcher” in Chapter 20 (Volume 2).

The use of the SDI interface requires an MKS-8110X 20-
input board and an MKS-7171X DME output connector 
board. When using the SDI interface, the following 
operations are different from using the dedicated interface.
• Setting the input signals from the switcher to the MKS-

7470X/7471X (AUX bus outputs), and signals returned 
to the switcher (reentry inputs).
For details, see “Setting the AUX Bus Output and 
Reentry Input” in Chapter 20 (Volume 2).

• Selecting the combiner channels not in the key control 
block, but in the Global Effect menu.
For details, see “Procedure for combine operation when 
using an SDI interface” (page 338)

MVE-8000A Multi Format DME Processor
The MVE-8000A is a “Digital Multi Effects” with multi-
format support.
For the MVE-8000A, an optional MKE-8021A Input/
Output Board is available as a dedicated interface for 
integrated use with the switcher.
There are two types of interfaces available for connecting 
DMEs to the switcher: the dedicated interface and the SDI 
interface.

 

When using the SDI interface, the following operations are 
different from using the dedicated interface.

For details, see “Setting the Interface Between the DME 
and the Switcher” in Chapter 20 (Volume 2).

• Setting the input signals from the switcher to the MVE-
8000A (AUX bus outputs), and signals returned to the 
switcher (reentry inputs). However, “Ext In” cannot be 
set for the DME channel.
For details, see “Setting the AUX Bus Output and 
Reentry Input” in Chapter 20 (Volume 2).

• Selecting the combiner channels not in the key control 
block, but in the Global Effect menu (see page 337).

Horizontal 
inversion

Input signal Vertical 
inversion

Color 2

Color 1

Notes 
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MVE-9000 Multi Format DME Processor
The MVE-9000 is a “Digital Multi Effects” with multi-
format support.
For the MVE-9000, an optional MKE-9021A Input/Output 
Board is available as a dedicated interface for integrated 
use with the switcher.
There are two types of interfaces available for connecting 
DMEs to the switcher: the dedicated interface and the SDI 
interface.

For details, see “Setting the Interface Between the DME 
and the Switcher” in Chapter 20 (Volume 2).

When using the SDI interface, the following operations are 
different from when using the dedicated interface.
• Setting the input signals from the switcher to the MVE-

9000 (AUX bus outputs), and signals returned to the 
switcher (reentry inputs).
For details, see “Setting the AUX Bus Output and 
Reentry Input” in Chapter 20 (Volume 2).

• Selecting the combiner channels not in the key control 
block, but in the Global Effect menu (see page 337).

Three-Dimensional 
Transformation 
Operations

Use the device control block to carry out three-
dimensional DME transformations.

For details of three-dimensional DME coordinate space, 
see “Three-Dimensional Transformations” (page 256).

Basic Operations 

This section explains how to use the device control block 
(trackball) to carry out three-dimensional transformations.

Device control block (trackball)

Buttons used when the three-dimensional 
transform operation mode is enabled
LOCAL: Enable operations in the DME local coordinate 

space. 
GLB (global): Enable operations in the DME global 

coordinate space.
The [LOCAL] and [GLB] buttons can be selected at 
the same time.

SRC (source): Enable operations in the DME source 
coordinate space.

TRGT (target): Enable operations in the DME target 
coordinate space.
The [SRC] and [TRGT] buttons cannot be selected at 
the same time. When these buttons are held down, 
trackball and Z-ring operation is switched to a finer 
control. (fine mode)

Notes 

Function assignment buttons

Operating buttons Z-ring

Region selection buttons (DME1 to 8)

Trackball
Three-Dimensional Transformation Operations
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AXIS LOC (location): When this button is lit, the 
trackball moves the rotational axis of the image in the 
x-axis and y-axis directions, and the Z-ring moves the 
axis in the z-axis direction.

ASP PERS (aspect/perspective): When the [SRC] button 
is lit, pressing this button enables the trackball to 
control the x-axis and y-axis directions independently, 
and the Z-ring controls the x-axis and y-axis directions 
together, to vary the aspect ratio. When the [SHIFT] 
button is held down and this button is pressed, the 
trackball controls the skew of the image in the x-axis 
and y-axis directions.
When the [TRGT] button is lit, pressing this button 
enables the trackball to control the perspective of the 
image in the x-axis and y-axis directions.
The Z-ring controls the distance to the viewpoint.

LOC (location) SIZE: When this button is lit, the Z-ring 
controls the image size.
The trackball moves the image in the x-axis and y-axis 
directions.

LOC (location) XYZ: When this button is lit, the trackball 
moves the image in the x-axis and y-axis directions, 
and the Z-ring moves the image in the z-axis direction.

SHIFT: While holding down this button, pressing the 
[ASP PERS] button or [ROT] button switches to the 
shifted version of the corresponding function.

CLR WORK BUFR (clear work buffer): Press this 
button once to clear only the three-dimensional 
transform parameters of the information held in the 
work buffer. Press twice in rapid succession to clear all 
of the parameters, and return to the default state.

ROT (rotation): When this button is lit, the trackball 
rotates the image about the x- and y-axes, and the Z-
ring rotates the image about the z-axis.
Pressing this while holding down the [SHIFT] button 
enables rotation of the image in the “Spin” mode. The 
trackball and Z-ring operate in the same manner.

X, Y, Z: These restrict which axes the trackball and Z-ring 
can control. You can select more than one.
When one of these buttons is selected, you can enter 
the parameter value for the corresponding axis using 
the numeric keypad control block.

CTR (center): Pressing this button changes the values of 
the three-dimensional parameters currently controlled 
by the trackball and Z-ring to the closest detent values.
Pressing twice in rapid succession returns the 
parameter values to their defaults.

Transforming an image in three-
dimensional coordinate space

1 With the region selection buttons, select the target 
channel of the operation.

You can press several of the buttons simultaneously to 
select several channels. In this case, the button that you 

pressed first lights in green, while buttons pressed 
subsequently light in amber.

2 With the function assignment buttons, select the three-
dimensional coordinate space in which to perform the 
transformation.

LOCAL button: Selects local coordinate space.
GLB button: Selects global coordinate space. You 

can select this button and the [LOCAL] button 
simultaneously.

SRC button: Selects the source coordinate space.
TRGT button: Selects the target coordinate space.
([SRC] and [TRGT] cannot be selected at the same 
time.)

3 Press the button for the operation you want to do, 
turning it on, to select the transformation mode.

The trackball and Z-ring are assigned to the selected 
three-dimensional coordinate space transformation 
mode.
To move the image: Press the [LOC XYZ] button, 

turning it on.
You can move the image on the x- and y-axes with 
the trackball and move it on the z-axis with the Z-
ring. Pressing the [LOC SIZE] button instead of 
the [LOC XYZ] button, turning it on, makes it 
possible to move the image on the x- and y-axes.

To rotate the image: Press the [ROT] button, turning 
it on.
You can rotate the image on the x- and y-axes with 
the trackball and rotate it on the z-axis with the Z-
ring. 
To rotate the image in Spin mode, press the [ROT] 
button, turning it on, while holding down the 
[SHIFT] button. You can operate in the same way 
with the trackball and Z-ring.

To move an axis of rotation: With the [SRC] button 
selected in step 2, press the [AXIS LOC] button, 
turning it on.
You can move the axis of rotation of the image on 
the x- and y-axes of the image with the trackball, 
and on the z-axis with the Z-ring. 

To magnify or shrink the image: Press the [LOC 
SIZE] button, turning it on.
You can magnify and shrink the image with the Z-
ring. Rotate counterclockwise to shrink, and 
clockwise to magnify.

To change the aspect ratio of the image: With the 
[SRC] button selected in step 2, press the [ASP 
PERS] button, turning it on.
You can change the aspect ratio independently on 
the x- and y-axes with the trackball, and change it 
simultaneously on both the x- and y-axes with the 
Z-ring.

To change the perspective on the image: With the 
[TRGT] button selected in step 2, press the [ASP 
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PERS] button, turning it on.
You can change the perspective of the image on 
the x- and y-axes with the trackball, and change 
the distance to the view point with the Z-ring.

To change the skew of the image: With the [SRC] 
button selected in step 2, press the [ASP PERS] 
button, turning it on, while holding down the 
[SHIFT] button.
You can change the skew of the image along the x- 
and y-axes with the trackball.

4 Depending on the axis of the change, operate the 
trackball and Z-ring as follows.

• To change on the x-axis, rotate the trackball 
horizontally.
Parameter values increase as you rotate to the right, 
and decrease as you rotate to the left.

• To change on the y-axis, rotate the trackball 
vertically.
Parameter values increase as you rotate upward, and 
decrease as you rotate downward.

• To change on the z-axis, rotate the Z-ring.
Parameter values increase as you rotate clockwise, 
and decrease as you rotate counterclockwise.
However, when you have pressed the [LOC XYZ] 
button to move the image, z-axis parameters 
increase as you rotate counterclockwise, and 
decrease as you rotate clockwise.

To reduce the rate of change of the parameters 
(fine mode)
Carry out the trackball or Z-ring operations while 
holding down the [SRC] or [TRGT] button.

5 To restrict the change in the transformation to a 
specific axis, press the [X], [Y], or [Z] button, tuning 
it on. 

This enables the trackball and Z-ring operations on the 
selected axis only.

Three-Dimensional Parameter 
Display

You can check the values of the three-dimensional 
parameters in the DME menu.

Functions assignable to trackball and Z-ring operations

Button Usable 
coordinate 
space

Trackball 
x-
direction

Trackball 
y-
direction

Z-ring

LOC 
XYZ

Source, 
target

Move 
image on 
x-axis

Move 
image on 
y-axis

Move 
image on 
z-axis

ROT Source, 
target

Rotate 
image on 
y-axis

Rotate 
image on 
x-axis

Rotate 
image on 
z-axis

SHIFT+ 
ROT

Source, 
target

Rotate 
image on 
y-axis 
(Spin 
mode)

Rotate 
image on 
x-axis 
(Spin 
mode)

Rotate 
image on 
z-axis 
(Spin 
mode)

AXIS 
LOC

Source Move x-
axis of 
rotation

Move y-
axis of 
rotation

Move z-
axis of 
rotation

LOC 
SIZE

Source, 
target

Move 
image on 
x-axis

Move 
image on 
y-axis

Magnify 
and shrink 
image 

ASP 
PERS

Source Change 
aspect 
ratio on x-
axis

Change 
aspect 
ratio on y-
axis

Change 
aspect 
ratio on x- 
and y-
axes 
simultane-
ously

Target Shift view 
point on x-
axis

Shift view 
point on y-
axis

Change 
distance 
from view 
point to 
image

SHIFT+ 
ASP 
PERS

Source Change 
skew on x-
axis

Change 
skew on y-
axis

Change 
aspect 
ratio on x- 
and y-
axes 
simultane-
ously
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Displaying the three-dimensional 
parameters in the DME menu
In the menu control block, select the top menu selection 
button [DME].
The DME menu appears. The status area shows the three-
dimensional parameters currently controlled by the device 
control block.
• When multiple DME channels are selected, this shows 

the parameters for the reference channel.
• When both Global and Local are selected, the three-

dimensional parameters are shown for the channel (the 
reference channel) for which the button is lit green.

Example three-dimensional parameter display (DME menu)

Viewing the three-dimensional parameter 
details
In the DME menu, press the menu title button (the [DME] 
in the upper left part of the screen).
The Status menu appears. This menu shows the three-
dimensional parameters for the DME reference channel 
currently selected in the device control block.

Example three-dimensional parameter details

Entering Three-Dimensional 
Parameter Values 

In addition to setting three-dimensional parameter values 
with the trackball and Z-ring, you can enter them directly 
from the numeric keypad control block.

Entering three-dimensional parameter 
values

1 In the device control block, press the [X], [Y], or [Z] 
button, turning it on.

The numeric keypad control block enters a mode in 
which you can enter parameters for the selected axis.

2 Enter a parameter value with the numeric keypad.

The number of significant digits after a decimal point 
is 4. 

3 Press the [ENTER] button.

The parameter value is changed, and the image 
changes.

To enter difference values
You can enter difference values by pressing the [+/–] 
button, entering the difference from the current value, and 
pressing the [TRIM] button to confirm. The [+/–] button 
toggles between “+” (plus) and “–” (minus) each time it is 
pressed.

Resetting three-dimensional parameter 
values
Pressing the [CTR] button in the device control block sets 
the current three-dimensional parameter values to the 
closest detent points (page 258).
To reset three-dimensional parameter values to the 
defaults (page 258) for the current transformation 
operation mode, press the [CTR] button twice in rapid 
succession. 

Clearing the working buffer
The working buffer is memory that holds the instantaneous 
state of an effect. To clear (initialize) only the three-
dimensional transform parameters in the working buffer, 
press the [CLR WORK BUFR] button in the device 
control block.
To clear all of the parameters in the working buffer and 
initialize the DME system, press the [CLR WORK BUFR] 
button twice in rapid succession. It is necessary to do this 
for both the local coordinate space and global coordinate 
space.

Type of three-
dimensional space a)

Operation mode for 
three-dimensional 
transforms b)

Value of X

Value of Y

Value of Z

a) This shows one of Local Target, Local Source, Global Target, 
and Global Source.

b) This shows one of Loc XYZ, Loc Size, Rot, Spin, Axis Loc, 
Skew, Asp, and Pers.
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As the initial DME state, you can specify whether to use 
the factory default settings or user settings in the Setup 
menu.

For details see “Selecting the State After Powering On 
(Start Up Menu)” in Chapter 18 (Volume 2).

Graphics Display Operation

Use the DME menu to make graphics display settings. You 
can make separate settings for separate channels. To select 
a target DME channel, use the device control block.

For the types of graphics displayed, see “Graphics 
Display” (page 260).

Displaying graphics

1 In the menu control block, select the top menu 
selection button [DME]. 

The DME menu appears. 

2 Select VF6 ‘Input/Output’ and HF4 ‘Graphic.’ 

The Graphic menu appears. 

3 Turn [Graphic] on.

The system enters graphics display mode, enabling 
graphics to be displayed in the monitor screen.

4 Turn on the buttons of the graphics you want to show.

To show axes: Turn [Axis] on.
To show axis names: Turn [Axis Name] on. 
To show the channel ID: Turn [Ch ID] on. 
To show a wire frame: Turn [Wire Frame] on.
To show the grid: Turn [Grid] on. 
To show the flex shadow axis: Turn [Flex Shadow 

Axis] on.
The selected graphics appear in the monitor screen.

The flex shadow axis function is not supported on the 
MVE-8000A.

5 If you want to shrink the graphics display to show the 
range not displayed on a normal monitor, turn [Scale] 
on and set the following parameters.

As the value of the setting grows, the monitor shrinks 
further toward the center point.

6 To automatically erase the graphic display while the 
keyframes are executing, press [Auto Erase], turning it 
on, and then set the following parameter.

Outputting graphics to the monitor output 
connector
In the Graphic menu, press [Monitor Out] to turn it on.
Graphics are displayed on the device connected to the 
monitor output connector.

Canceling Virtual Images

When a transformation is executed with an extreme degree 
of perspective, the part of the image which is beyond the 
imaginary view point can wrap around and show on the 
other side. The wrapped-around portion is referred to as a 
virtual image.
Using the DME menu, you can make a setting not to show 
the virtual images.

Canceling virtual images

1 In the DME menu, select VF6 ‘Input/Output’ and HF2 
‘Video/Key.’

The Video/Key menu appears.

2 Press [Wrap Around], turning it on.

Notes 

Knob Parameter Adjustment Setting values

1 Scale Degree to 
which the 
graphics 
display is 
shrunk

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Recover 
Time

Time until 
graphic 
display 
appears 
again after 
keyframe 
execution

0 to 300 (frames)
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Applying Special Effects 
(Operations Common to 
Special Effects)

In this section, explanations of the operating procedures 
for individual special effects begin with selections from 
the DME menu. The following are common operations 
that you must do prior to selecting from the DME menu.

1 In the device control block, select the target DME 
channel.

2 In the menu control block, select the top menu 
selection button [DME].

The DME menu appears.

[Wrap Around] on

Virtual image
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Applying Special Effects 
(Edge Effects)

Border Settings

Adding a border

1 In the DME menu, select VF1 ‘Edge’ and HF1 
‘Border/Crop.’

The Border/Crop menu appears.

2 Press [Border], turning it on.

3 Set the parameters.

The valid ranges of the parameter values depend on the 
combination of signal format (SD/HD) and aspect 
ratio (4:3/16:9) selected in the system, as follows.

4:3 mode

16:9 mode

Setting the border color
The operation differs depending on the DME used (MVE-
8000A, MVE-9000 or MKS-7470X/7471X).

When the MVE-8000A is used
Press [Border Color], turning it on, and set the following 
parameters.

When the MVE-9000 or MKS-7470X/7471X is used
Use the buttons in the <Border Fill> group to select the 
signal to insert in the border.
Flat Color: single color
Mix Color: mix color signal set in the Color Mix menu 

(see page 289)
Ext Video: an external video signal input to the Ext IN 

connector
If Flat Color is selected, adjust the following parameters.

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Border width 
on left and 
right sides

Left value shown

2 V Border width 
on top and 
bottom sides

Top value shown

3 All Border width 
on all sides

Left value shown

5 Density Border 
density

0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Border width 
on top side

–6.00 to +6.00 (SD)
–18.00 to +18.00 
(HD)

2 Left Border width 
on left side

–8.00 to +8.00 (SD)
–24.00 to +24.00 
(HD)

3 Right Border width 
on right side

–8.00 to +8.00 (SD)
–24.00 to +24.00 
(HD)

4 Bottom Border width 
on bottom 
side

–6.00 to +6.00 (SD)
–18.00 to +18.00 
(HD)

5 Density Border 
density

0.00 to 100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Border width 
on left and 
right sides

Left value shown

2 V Border width 
on top and 
bottom sides

Top value shown

3 All Border width 
on all sides

Left value shown

5 Density Border 
density

0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Border width 
on top side

–4.50 to +4.50 (SD)
–18.00 to +18.00 
(HD)

2 Left Border width 
on left side

–8.00 to +8.00 (SD)
–32.00 to +32.00 
(HD)

3 Right Border width 
on right side

–8.00 to +8.00 (SD)
–32.00 to +32.00 
(HD)

4 Bottom Border width 
on bottom 
side

–4.50 to +4.50 (SD)
–18.00 to +18.00 
(HD)

5 Density Border 
density

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00
Applying Special Effects (Edge Effects)
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If Mix Color or Ext Video selected, the border color 
changes according to the mix color signal or external video 
signal.

Softening the border edges
Press [Border Soft], turning it on, and set the following 
parameters.

Crop Settings

Cropping the image

1 In the DME menu, select VF1 ‘Edge’ and HF1 
‘Border/Crop.’

The Border/Crop menu appears.

2 Press [Crop], turning it on.

3 Set the parameters.

The valid ranges of the parameter values depend on the 
combination of signal format (SD/HD) and aspect 
ratio (4:3/16:9) selected in the system, as follows.

4:3 mode

16:9 mode

Signs of numeric settings
For H, V, and All settings, the sign (+/–) of the setting 
need not be considered. For example, in the case of an 
H setting, the value for Left is automatically regarded 
as a negative value, and the value for Right as a 
positive value, to display the image.
The following is an example of these settings.

4 To soften the edges of the image, press [Edge Soft], 
turning it on, and set the following parameter.

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Soft Softness of inner 
side of border

0.00 to 100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Crop 
positions on 
left and right 
sides

Left value shown

2 V Crop 
positions on 
top and 
bottom sides

Top value shown

3 All Crop 
positions on 
all sides

Left value shown

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Crop position 
on top side

–3.00 to +3.00 (SD)
–9.00 to +9.00 (HD)

Knob Parameter Adjustment Setting values

2 Left Crop position 
on left side

–4.00 to +4.00 (SD)
–12.00 to +12.00 
(HD)

3 Right Crop position 
on right side

–4.00 to +4.00 (SD)
–12.00 to +12.00 
(HD)

4 Bottom Crop position 
on bottom 
side

–3.00 to +3.00 (SD)
–9.00 to +9.00 (HD)

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Crop 
positions on 
left and right 
sides

Left value shown

2 V Crop 
positions on 
top and 
bottom sides

Top value shown

3 All Crop 
positions on 
all sides

Left value shown

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Crop position 
on top side

–2.25 to +2.25 (SD)
–9.00 to +9.00 (HD)

2 Left Crop position 
on left side

–4.00 to +4.00 (SD)
–16.00 to +16.00 
(HD)

3 Right Crop position 
on right side

–4.00 to +4.00 (SD)
–16.00 to +16.00 
(HD)

4 Bottom Crop position 
on bottom 
side

–2.25 to +2.25 (SD)
–9.00 to +9.00 (HD)

Parameter Entered value Setting

H 1.5 Left=–1.50

Right=1.50

–1.5 Left=–1.50

Right=1.50

Parameter group [2/2]

Knob Parameter Adjustment Setting values
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Edges cannot be softened when the Crop effect is 
disabled.

To specify whether to invert the crop area when 
inverting the video image
In the <Invert/Crop Process> group, select either of the 
following.
Crop –> Invert: Set an axis of symmetry at the center of 

the input video, and invert both the desired area of 
video and the crop area horizontally and vertically 
around that axis of symmetry. The order of effect 
application is Crop > Invert.

Invert –> Crop: Set an axis of symmetry at the center of 
the input video, and invert only the desired area of 
video horizontally and vertically around that axis of 
symmetry. The order of effect application is Invert > 
Crop.

Beveled Edge Settings

Applying a beveled edge

1 In the DME menu, select VF1 ‘Edge’ and HF2 
‘Beveled Edge.’

The Beveled Edge menu appears.

2 Press [Beveled Edge], turning it on.

3 Set the parameters.

The valid ranges of the parameter values depend on the 
combination of signal format (SD/HD) and aspect 
ratio (4:3/16:9) selected in the system, as follows.

4:3 mode

16:9 mode

4 In the <Edge Mode> group, select the type of edge.

Light: effect of light striking the edge

Color: colored edges. When this is selected, set the 
following parameters in the <Color Adjust> 
group.

• To set the density

• To set the colors for each edge (Top, Left, Right, 
Bottom, All)

Knob Parameter  Adjustment Setting values

1 Soft Softness of 
edges

0.00 to 100.00

Notes 

Knob Parameter Adjustment Setting values

1 H Simultaneou
sly adjust 
width of left 
and right 
edges

0.00 to 4.00 (SD)
0.00 to 12.00 (HD)

2 V Simultaneou
sly adjust 
width of top 
and bottom 
edges

0.00 to 3.00 (SD)
0.00 to 9.00 (HD)

3 All Simultane-
ously adjust 
width of all 
four edges

Value of H shown

Knob Parameter Adjustment Setting values

1 H Simultane-
ously adjust 
width of left 
and right 
edges

0.00 to 4.00 (SD)
0.00 to 16.00 (HD)

2 V Simultane-
ously adjust 
width of top 
and bottom 
edges

0.00 to 2.25 (SD)
0.00 to 9.00 (HD)

3 All Simultane-
ously adjust 
width of all 
four edges

Value of H shown

Knob Parameter Adjustment Setting values

1 Top Adjust 
luminance of 
top edge

–100.00 to +100.00

2 Left Adjust 
luminance of 
left edge

–100.00 to +100.00

3 Right Adjust 
luminance of 
right edge

–100.00 to +100.00

4 Bottom Adjust 
luminance of 
bottom edge

–100.00 to +100.00

5 All Simultaneou
sly adjust 
luminance of 
all four 
edges

Value of Left shown

Knob Parameter Adjustment Setting values

1 Density Adjust the 
color density

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00 a)

Knob Parameter Adjustment Setting values
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a) For the All adjustment, the value for Left is shown.

5 To soften the inside of the edges and the boundaries 
between adjacent edges, turn on [Edge Soft], and 
adjust the following parameters.

Key Border Settings

The Key Border function is not supported on the MVE-
8000A.

Applying key borders

1 In the DME menu, select VF1 ‘Edge’ and HF3 ‘Key 
Border.’

The Key Border menu appears.

2 Press [Key Border], turning it on.

The key border function and Glow function (see page 
297) cannot be turned on at the same time. Only the 
one most recently turned on is effective.

3 Set the following parameters.

4 To set the key border color, press [Flat Color] and 
adjust the following parameters.

To select an outline only key
Press [Outline], turning it on.

Art Edge Settings

The Art Edge function is not supported on the MVE-
8000A.

Applying art edges

1 In the DME menu, select VF1 ‘Edge’ and HF4 ‘Art 
Edge.’

The Art Edge menu appears.

2 Press [Art Edge], turning it on.

The Defocus, Blur, Key Border, and Glow effects 
cannot be applied to the Art Edge sections.

3 Set the parameters.

2 Saturation Saturation 0.00 to 100.00 a)

3 Hue Hue 359.99 to 0.00 a)

Knob Parameter Adjustment Setting values

1 Inner Soft Softness of 
the inside of 
edges

0.00 to 100.00

2 Bound Soft Softness of 
the edge 
boundaries

0.00 to 100.00

Notes 

Notes 

Knob Parameter Adjustment Setting values

Bound 
Soft

Inner Soft

Knob Parameter Adjustment Setting values

1 H Simultane-
ously adjust 
width of left 
and right key 
borders

0.00 to 100.00

2 V Simultane-
ously adjust 
width of top 
and bottom 
key borders

0.00 to 100.00

3 All Simultane-
ously adjust 
width of all 
four key 
borders

Value of H shown

4 Soft Softness of 
the key 
borders

0.00 to 100.00

5 Density Density of 
the key 
borders

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Notes 

Notes 
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The valid ranges of the parameter values depend on the 
combination of signal format (SD/HD) and aspect 
ratio (4:3/16:9) selected in the system, as follows.

4:3 mode

16:9 mode

Adjusting the position of art edges

1 In the Art Edge menu, press [Edge Position], turning it 
on.

2 Adjust the following parameters.

The valid ranges of the parameter values depend on the 
combination of signal format (SD/HD) and aspect 
ratio (4:3/16:9) selected in the system, as follows.

4:3 mode

16:9 mode

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Simultane-
ously adjust 
width of left 
and right 
edges

Value of Left shown

2 V Simultane-
ously adjust 
width of top 
and bottom 
edges

Value of Top shown

3 All Simultane-
ously adjust 
width of all 
four edges

Value of Left shown

5 Density Density of 
edges

0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Width of top 
edge

0.00 to 6.00 (SD)
0.00 to 18.00 (HD)

2 Left Width of left 
edge

0.00 to 8.00 (SD)
0.00 to 24.00 (HD)

3 Right Width of right 
edge

0.00 to 8.00 (SD)
0.00 to 24.00 (HD)

4 Bottom Width of 
bottom edge

0.00 to 6.00 (SD)
0.00 to 18.00 (HD)

5 Density Density of 
edges

0.00 to 100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 H Simultane-
ously adjust 
width of left 
and right 
edges

Value of Left shown

2 V Simultane-
ously adjust 
width of top 
and bottom 
edges

Value of Top shown

3 All Simultane-
ously adjust 
width of all 
four edges

Value of Left shown

5 Density Density of 
edges

0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Width of top 
edge

0.00 to 4.50 (SD)
0.00 to 18.00 (HD)

2 Left Width of left 
edge

0.00 to 8.00 (SD)
0.00 to 32.00 (HD)

3 Right Width of right 
edge

0.00 to 8.00 (SD)
0.00 to 32.00 (HD)

4 Bottom Width of 
bottom edge

0.00 to 6.00 (SD)
0.00 to 18.00 (HD)

5 Density Density of 
edges

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Top Position of 
top edge

–3.00 to +3.00 (SD)
–9.00 to +9.00 (HD)

2 Left Position of 
left edge

–4.00 to +4.00 (SD)
–12.00 to +12.00 
(HD)

3 Right Position of 
right edge

–4.00 to +4.00 (SD)
–12.00 to +12.00 
(HD)

4 Bottom Position of 
bottom edge

–3.00 to +3.00 (SD)
–9.00 to +9.00 (HD)

5 All Adjust the 
position of all 
four edges

Value of H shown

Knob Parameter Adjustment Setting values

1 Top Position of 
top edge

–2.25 to +2.25 (SD)
–9.00 to +9.00 (HD)

2 Left Position of 
left edge

–4.00 to +4.00 (SD)
–16.00 to +16.00 
(HD)

3 Right Position of 
right edge

–4.00 to +4.00 (SD)
–16.00 to +16.00 
(HD)

4 Bottom Position of 
bottom edge

–2.25 to +2.25 (SD)
–9.00 to +9.00 (HD)

5 All Adjust the 
position of all 
four edges

Value of H shown
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Softening the inner and outer sides of art 
edges

1 In the Art Edge menu, press [Soft], turning it on.

2 Adjust the following parameters.

Setting the way in which art edge colors 
change

1 In the <Art Edge Source> group of the Art Edge menu, 
select the color pattern to apply to the art edges.

Flat Color: Uses Color 1 (see page 283) as a flat color.
Gradation Matte: Color 1 changes to Color 2 (see 

page 283) at the border lines (see step 2 (page 
281)).

Rainbow Matte: The color set as Color 1 changes hue 
into color on the border lines.

Radial Gradation: Color 1 on the inner side is mixed 
into Color 2 on the outer side, according to the 
shape of the art edge.

Radial Rainbow: The hue of Color 1 on the inner side 
changes into Color 2 on the outer side, according 
to the shape of the art edge.

Rainbow Gradation: Color 3 (see “Color 3 settings” 
(page 283)) overwrites Radial Rainbow, giving a 
gradation effect.

2 When you select other than [Flat Color], set the 
gradation border lines for the selected pattern.

Border line parameters for Gradation Matte and 
Rainbow Matte
The valid ranges of the parameter values depend on the 
combination of signal format (SD/HD) and aspect 
ratio (4:3/16:9) selected in the system, as follows.

Knob Parameter Adjustment Setting values

1 Inner H Simultane-
ously adjust 
softness of 
left and right 
inner edges

0.00 to 100.00

2 Inner V Simultane-
ously adjust 
softness of 
top and 
bottom inner 
edges

0.00 to 100.00

3 Outer H Simultane-
ously adjust 
softness of 
left and right 
outer edges

0.00 to 100.00

4 Outer V Simultane-
ously adjust 
softness of 
top and 
bottom outer 
edges

0.00 to 100.00

Example: Moving the right edge position in the “minus” 
direction.

Art edge portion

Position before 
moving

Position after 
moving

Moving in the 
minus direction

5 All Simultane-
ously adjust 
softness of 
all inner and 
outer edges.

Value of Outer H 
shown

Knob Parameter Adjustment Setting values

Flat Color Gradation Matte

Radial GradationRainbow Matte

Radial Rainbow Rainbow Gradation
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4:3 mode

16:9 mode

Radial Gradation and Radial Rainbow parameters 

Rainbow Gradation parameters
The valid ranges of the parameter values depend on the 
combination of signal format (SD/HD) and aspect 
ratio (4:3/16:9) selected in the system, as follows.

• 4:3 mode

• 16:9 mode

3 When Gradation Matte or Rainbow Matte is selected, 
set modifiers as required.

When turning [Angle] on in the <Rotation> group 
and slanting the pattern

a) –1.00 is one rotation in counterclockwise direction. +1.00 is one 
rotation in clockwise direction. 0.00 is no rotation.

When turning [Speed] on in the <Rotation> group 
and rotating the pattern at a specified speed

a) –100.00 is four rotations per second in counterclockwise direction. 
+100.00 is four rotations per second in clockwise direction. 0.00 is 
no rotation.

Knob Parameter Adjustment Setting values

1 H  Position of 
gradation 
border in 
horizontal 
direction

–8.00 to +8.00 (SD)
–24.00 to +24.00 
(HD)

2 V Position of 
gradation 
border in 
vertical 
direction

–6.00 to +6.00 (SD)
–18.00 to +18.00 
(HD)

3 Soft Softness of 
gradation 
border 
region

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H  Position of 
gradation 
border in 
horizontal 
direction

–8.00 to +8.00 (SD)
–32.00 to +32.00 
(HD)

2 V Position of 
gradation 
border in 
vertical 
direction

–4.50 to +4.50 (SD)
–18.00 to +18.00 
(HD)

3 Soft Softness of 
gradation 
border 
region

0.00 to 100.00

Knob Parameter Adjustment Setting values

3 Soft Softness of 
gradation 
border 
region

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H  Position of 
gradation 
border in 
horizontal 
direction

–8.00 to +8.00 (SD)
–24.00 to +24.00 
(HD)

2 V Position of 
gradation 
border in 
vertical 
direction

–6.00 to +6.00 (SD)
–18.00 to +18.00 
(HD)

3 RBW Soft Softness of 
rainbow 
border 
region

0.00 to 100.00

4 GRD Soft Softness of 
gradation 
border 
region

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H  Position of 
gradation 
border in 
horizontal 
direction

–8.00 to +8.00 (SD)
–32.00 to +32.00 
(HD)

2 V Position of 
gradation 
border in 
vertical 
direction

–4.50 to +4.50 (SD)
–18.00 to +18.00 
(HD)

3 RBW Soft Softness of 
rainbow 
border 
region

0.00 to 100.00

4 GRD Soft Softness of 
gradation 
border 
region

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Angle Rotation 
angle of 
pattern

–8.00 to +8.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation 
speed of 
pattern

–100.00 to +100.00 
a)

Knob Parameter Adjustment Setting values
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Setting art edge colors

1 In the Art Edge menu, turn on the button (Color 1 to 
Color 3) for the color for which you want to make 
settings in the <Color Adjust> group.

2 Adjust the following parameters.

Color 1 settings 

Color 2 settings

Color 2 cannot be set when [Flat Color] is selected in 
the <Art Edge Source> group.

Color 3 settings

Color 3 can be set only when [Rainbow Gradation] is 
selected in the <Art Edge Source> group.

Relationship between Hue and Hue Offset
For example, when the Hue value of Color 1 is 180.00, 
and the Hue Offset value of Color 2 is –540.00, the 
relationship is as shown below, with the hue changing 
within the Hue Offset range of Color 1 and Color 2. 

Rounding art edge corners
Press [Round Corner], turning it on.
The art edge corners on the inner and outer sides are 
rounded.

This function is available only when [Soft] is on.

Flex Shadow Settings

• The Flex Shadow function is not supported on the MVE-
8000A.

• On the MKS-7470X/7471X, the Flex Shadow function 
can be used except for the following.
- [External] in the Flex Shadow Source group
- [Ext Video] in the Flex Shadow Fill group

• “Mix Color” or “Ext Video” can only be applied to one 
of the background (see page 331), flex shadow, trail (see 
page 318), and wind (see page 322) effects.
If you select “Mix Color” or “Ext Video” in one of these 
settings, a selection of “Mix Color” or “Ext Video” in 
any of the other effects is disabled, and “Flat Color” is 
selected in its place.

• When executing combining four channels of DME 
images, “Mix Color” and “Ext Video” in the flex shadow 
and background effects cannot be selected.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Notes 

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Offset Hue range –540.0 to +540.0

Notes 

Position determined 
by H and V values 
(When Angle (see 
step 3) is 0.)

Determined by the value of 
Angle (see step 3). 

Border

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Offset Hue range –540.0 to +540.0

Notes 

Notes 

Hue 
setting 
rangeHue 

Offset 
setting 
range
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Applying a flex shadow

1 In the DME menu, select VF1 ‘Edge’ and HF5 ‘Flex 
Shadow.’

The Flex Shadow menu appears.

2 Press [Flex Shadow], turning it on.

The Flex shadow function cannot be enabled when the 
following functions are enabled.
• Any nonlinear effect
• Brick
• Shadow

3 Adjust the following parameters.

The valid ranges of the parameter values depend on the 
combination of signal format (SD/HD) and aspect 
ratio (4:3/16:9) selected in the system, as follows.

4:3 mode

a) The Soft parameter is valid only when [Internal] is selected in the 
<Flex Shadow Source> group.

16:9 mode

a) The Soft parameter is valid only when [Internal] is selected in the 
<Flex Shadow Source> group.

4 In the <Flex Shadow Source> group, select the signal 
to use for the flex shadow.

External: Generate the shadow using an input signal.
Internal: Generate the shadow using a full-size key 

signal.

5 In the <Flex Shadow Fill> group, select the signal to 
insert in the flex shadow.

Flat Color: single color
Mix Color: mix color signal set in the Color Mix 

menu (see page 289)
Ext Video: an external video signal input to the Ext IN 

connector

6 Only if Flat Color is selected in step 5, adjust the 
following parameters.

Adjusting the size of the flex shadow

1 In the Flex Shadow menu, press [Size], turning it on.

2 Set the following parameters.

a) The Soft parameter is valid only when [Internal] is selected in the 
<Flex Shadow Source> group.

Setting the center point of the flex shadow

1 In the Flex Shadow menu, press [Axis Loc], turning it 
on.

Notes 

Knob Parameter Adjustment Setting values

1 H Move 
shadow 
horizontally

–8.00 to +8.00 (SD)
–24.00 to +24.00 
(HD)

2 V Move 
shadow 
vertically

–6.00 to +6.00 (SD)
–18.00 to +18.00 
(HD)

3 Size All Enlarge or 
shrink 
horizontally 
and vertically

Value of Size H (see 
page 284) shown

4 Soft a) Softness of 
shadow

0.00 to 100.00

5 Density Density of 
shadow

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Move 
shadow 
horizontally

–8.00 to +8.00 (SD)
–32.00 to +32.00 
(HD)

2 V Move 
shadow 
vertically

–4.50 to +4.50 (SD)
–18.00 to +18.00 
(HD)

3 Size All Enlarge or 
shrink 
horizontally 
and vertically

Value of Size H (see 
page 284) shown

4 Soft a) Softness of 
shadow

0.00 to 100.00

5 Density Density of 
shadow

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Size H Enlarge or 
shrink 
horizontally 

0.00 to 2.00

2 Size V Enlarge or 
shrink 
vertically 

0.00 to 2.00

3 Size All Enlarge or 
shrink 
horizontally 
and vertically 

Value of Size H 
shown

4 Soft a) Softness of 
shadow

0.00 to 100.00

5 Density Density of 
shadow

0.00 to 100.00
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2 Adjust the following parameters.

The valid ranges of the parameter values depend on the 
combination of signal format (SD/HD) and aspect 
ratio (4:3/16:9) selected in the system, as follows.

4:3 mode

16:9 mode

The flex shadow central axis appears when the [Flex 
Shadow Axis] function is enabled in the Graphic menu. 

For details, see “Graphics Display Operation” (page 
274).

Skewing the flex shadow

1 In the Flex Shadow menu, press [Skew], turning it on.

2 Adjust the following parameters.

Adding perspective to the flex shadow

1 In the Flex Shadow menu, press [Perspective], turning 
it on.

2 Adjust the following parameters.

Inverting the flex shadow
In the <Invert> group of the Flex Shadow menu, select the 
direction to invert the shadow.
H: Invert the shadow in the horizontal direction. The 

inversion is applied around the axis of the knob 2 
parameter Axis Loc V set with [Axis Loc].

V: Invert the shadow in the vertical direction. The 
inversion is applied around the axis of the knob 1 
parameter Axis Loc H set with [Axis Loc].

Knob Parameter Adjustment Setting values

1 Axis Loc H Move the 
shadow 
center axis 
horizontally 

–8.00 to +8.00 (SD)
–24.00 to +24.00 
(HD)

2 Axis Loc V Move the 
shadow 
center axis 
vertically

–6.00 to +6.00 (SD)
–18.00 to +18.00 
(HD)

Knob Parameter Adjustment Setting values

1 Axis Loc H Move the 
shadow 
center axis 
horizontally 

–8.00 to +8.00 (SD)
–32.00 to +32.00 
(HD)

2 Axis Loc V Move the 
shadow 
center axis 
vertically

–4.50 to +4.50 (SD)
–18.00 to +18.00 
(HD)

When the default Axis 
Loc setting is used

Shadow skewed 
with Axis Loc set at 
the lower left corner 
of the picture

Shadow size and 
perspective adjusted 
with default Axis Loc 
setting

Shadow skewed with 
Axis Loc set at the 
midpoint on the left 
edge of the picture

Axis Loc H

Axis Loc V

Picture

Flex shadow

Axis Loc position

Knob Parameter Adjustment Setting values

1 Skew H Skew 
horizontally 

–100.00 to +100.00

2 Skew V Skew 
vertically

–100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Perspective 
H

Add 
horizontal 
perspective

–100.00 to +100.00

2 Perspective 
V

Add vertical 
perspective

–100.00 to +100.00

Perspective 
H = –100

Perspective 
H = +100

Perspective 
V = –100

Perspective 
V = +100
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Setting a combine shadow
When there are several images, adds a flex shadow in the 
depth of an image or overlays multiple flex shadows.

1 In the Flex Shadow menu, press [Combine Shadow], 
turning it on.

2 Adjust the following parameter.

• The Combine Shadow effect is applied to all 
shadows, not only the sections where shadows 
overlap.

• Combine Shadow is enabled when the Flex Shadow 
effect and the global effect Combiner are enabled. In 
this state, Combine Shadow remains enabled even if 
the global effect is disabled.

• In Combine Shadow, the settings for the channel 
with the lowest number among the channels being 
combined are enabled.

Flex shadow creation example
The flow of flex pattern creation will be explained using 
the following pattern as an example.

Picture

When H is enabled When V is enabled

Flex shadow

Before 
inversion

Before 
inversion

After 
inversion

After 
inversion

Video Video

Example 1: When Flex Shadow is enabled on both of two channels.

Combine shadow is enabled.
Density is set to 100.00.

Combine shadow is enabled.
Density is set to 0.00. 

Shadow Shadow

No combine shadow is set. Knob Parameter Adjustment Setting values

1 Density Density of 
combine 
shadow

0.00 to 100.00

Notes 

Video Video

Example 2: Flex Shadow is enabled on one channel only.

Combine shadow is enabled.
Density is set to 100.00.

Combine shadow is enabled.
Density is set to 0.00. 

Shadow

No combine shadow is set.
Applying Special Effects (Edge Effects)
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1 Press [Flex Shadow], turning it on.

2 In the <Flex Shadow> group, select [External].

3 Turn [Axis Loc] on and use knob 2 to set the Axis Loc 
V parameter so that the center of the flex shadow 
deformation is at the bottom of the picture.
(For HD format and 16:9 mode: Axis Loc V = –9.00)

The following steps will be easier if you display the 
flex shadow axis graphic by pressing [Flex Shadow 
Axis] in the Graphic menu.

4 Press [V] in the <Invert> group, turning it on, to invert 
the flex shadow vertically.

5 Turn [Size] on and use knob 2 to set the Size V 
parameter so that the shadow extends vertically.
(For HD format and 16:9 mode: Size V = 1.50)

6 Press [Skew], turning it on, and use knob 1 to set the 
Skew H parameter so that the parallel lines appear to 
emerge from the depth at the right.
(For HD format and 16:9 mode: Skew H = –50.00)

Wipe Crop Settings

• The wipe crop function is not supported on the MVE-
8000A.

• When wipe crop is on, any mask that was on is turned 
off.

• When brick is on, wipe crop cannot be turned on. To turn 
wipe crop on, it is first necessary to turn brick off.

• In the <Shaped Video> group of the Video/Key menu, 
when [Output] is off, unless you set [Bkgd] in the HF1 
‘Bkgd’ menu to on, the wipe crop effect will not 
function.

Applying the wipe crop effect

To select the pattern

1 In the DME menu, select VF1 ‘Edge’ and HF6 ‘Wipe 
Crop.’

The Wipe Crop menu appears.

2 Press [Wipe Crop], turning it on.

3 Press [Pattern Select].

The Pattern Select menu appears.

4 From the displayed patterns (standard wipe patterns 1 
to 24 and 304), press any pattern to select it.

In this state, you can use the knobs to adjust the size of 
the pattern. (For details of parameters, see the next 
item.)

To set the pattern size and position

1 In the Wipe Crop menu, press [Position/Size].

2 Set the following parameters.

The setting range for the parameters depends on the 
signal format (SD/HD) and aspect ratio (4:3/16:9) 
selected in the system, as follows.

For SD format

a) For 4:3 mode
b) For 16:9 mode

When pattern number 304 is selected, the effect of 
settings in the <Edge> group varies with the Size 
setting.

For HD format

a) For 4:3 mode
b) For 16:9 mode

Notes 

Knob Parameter Adjustment Setting values

1 H Horizontal 
position

–8.00 to +8.00

2 V Vertical 
position

–6.00 to +6.00 a)

–4.50 to +4.50 b)

3 Size Pattern size 0.00 to 100.00

5 Pattern Pattern 
number

1 to 24, 304

Notes 

Knob Parameter Adjustment Setting values

1 H Horizontal 
position

–24.00 to +24.00 a)

–32.00 to +32.00 b)

2 V Vertical 
position

–18.00 to +18.00

3 Size Pattern size 0.00 to 100.00

5 Pattern Pattern 
number

1 to 24, 304
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When pattern number 304 is selected, the effect of 
settings in the <Edge> group varies with the Size 
setting.

To invert the regions of the cropping
In the Wipe Crop menu, press [Invert], turning it on.

Setting the aspect ratio of the wipe crop 
pattern (Aspect)

1 In the Wipe Crop menu, press [Aspect], turning it on.

2 Set the following parameter.

a) When set to a negative value, the image is stretched vertically, to 
become taller. 
When set to a positive value, the image is stretched horizontally, to 
become wider.

Rotating the wipe crop pattern (Rotation)

1 In the <Rotation> group of the Wipe Crop menu, 
select one of the following.

Angle: Incline the pattern through a fixed angle.
Speed: Rotate the pattern at a fixed speed.

2 Depending on the selection in step 1, set the following 
parameter.

When Angle is selected

a)  –1.00 represents a whole turn counterclockwise, and +1.00 
represents a whole turn clockwise. 0.00 is the original state.

When Speed is selected

a) –100.00 represents a speed of four whole turns counterclockwise per 
second, and +100.00 represents a speed of four whole turns 
clockwise per second. 0.00 is the stationary state.

Applying modulation to the wipe crop 
pattern (Modulation)

1 In the <Modulation> group of the Wipe Crop menu, 
select one of the following.

H (horizontal modulation): Modulate the pattern to 
apply waving in the horizontal direction.

V (vertical modulation): Modulate the pattern to 
apply waving in the vertical direction.

2 Set the following parameters.

Replicating the wipe crop pattern 
(Multiplication)

1 In the Wipe Crop menu, press [Multi], turning it on.

2 Set the following parameters.

a) See the replication patterns (page 160).

Modifying the wipe crop pattern edge
You can apply a border to the wipe crop pattern, or soften 
the boundary.

1 In the <Edge> group of the Wipe Crop menu, select 
one of the following.

Border: border
Soft: soft edge 
Soft Border: soft border

2 Depending on the selection in step 1, set the following 
parameters.

When Border is selected

Notes 

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 
a)

Knob Parameter Adjustment Setting values

1 Angle Angle of 
pattern 
rotation

–8.00 to +8.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation rate 
of pattern

–100.00 to +100.00 
a)

Knob Parameter Adjustment Setting values

1 Amplitude Amplitude of 
modulation

0.00 to 100.00

2 Frequency Frequency of 
modulation

0.00 to 100.00

3 Speed Speed of 
waves

–100.00 to +100.00

Knob Parameter Adjustment Setting values

1 H Multi Number of 
repetitions of 
pattern 
horizontally

1 to 63

2 V Multi Number of 
repetitions of 
pattern 
vertically

1 to 63

3 Invert Type Replication 
layout

1 to 4 a)

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00
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When Soft is selected

When Soft Border is selected

Selecting the signal or color to be inserted 
in the wipe crop border
When you are applying a border or soft border to the wipe 
crop, you can select the signal or color to be inserted in the 
border.

1 In the <Border Fill> group of the Wipe Crop menu, 
select one of the following.

Flat Color: flat color
Mix Color: a mix color signal combining color 1 and 

color 2 (see the next section, “Color Mix 
Settings”)

Ext Video: an external video signal input to the Ext IN 
connector

2 When Flat Color is selected in step 1 only, adjust the 
following parameters.

Color Mix Settings
 

The color mix function is not supported on the MVE-
8000A.

Creating a color combination pattern

To select the pattern

1 In the DME menu, select VF1 ‘Edge’ and HF7 ‘Color 
Mix.’

The Color Mix menu appears.

2 Press [Mix Pattern Select].

The Mix Pattern Select menu appears.

3 Press any of the displayed patterns (standard wipe 
patterns 1 to 24) to select it.

In this state, you can adjust the pattern size and border 
softness with the knobs.

(For details of the parameters, see the next item.)

To set the pattern size and position

1 In the Color Mix menu, press [Position/Size].

2 Set the following parameters.

The setting range for the parameters depends on the 
system selected signal format (SD/HD) and aspect 
ratio (4:3/16:9), as follows.

For SD format

a) For 4:3 mode
b) For 16:9 mode

For HD format

a) For 4:3 mode
b) For 16:9 mode

To invert the regions of the two colors
In the Color Mix menu, press [Color Invert], turning it on.

Adjusting the color 1 and color 2

1 In the Color Mix menu, to adjust color 1 press 
[Color1], and to adjust color 2 press [Color2].

Knob Parameter Adjustment Setting values

1 Soft Edge 
softness

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Width Border width 0.00 to 100.00

2 Inner Soft Border inner 
softness

0.00 to 100.00

3 Outer Soft Border outer 
softness

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Notes 

Knob Parameter Adjustment Setting values

1 H Horizontal 
position

–8.00 to +8.00

2 V Vertical 
position

–6.00 to +6.00 a)

–4.50 to +4.50 b)

3 Size Pattern size 0.00 to 100.00

4 Soft Softness of 
the pattern

0.00 to 100.00

5 Pattern Pattern 
number

1 to 24

Knob Parameter Adjustment Setting values

1 H Horizontal 
position

–24.00 to +24.00 a)

–32.00 to +32.00 b)

2 V Vertical 
position

–18.00 to +18.00

3 Size Pattern size 0.00 to 100.00

4 Soft Softness of 
the pattern

0.00 to 100.00

5 Pattern Pattern 
number

1 to 24
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2 Set the following parameters.

Modifying the color combination pattern
See the following pages.
• “Setting the aspect ratio of the wipe crop pattern 

(Aspect)” (page 288)
• “Replicating the wipe crop pattern (Multiplication)” 

(page 288)
• “Rotating the wipe crop pattern (Rotation)” (page 288)
• “Applying modulation to the wipe crop pattern 

(Modulation)” (page 288)

Applying Special Effects 
(Effects on the Overall 
Video Signal)

Defocus Settings

Applying the Defocus effect 

1 In the DME menu, select VF2 ‘Video Modify’ and 
HF1 ‘Defocus/Blur.’

The Defocus/Blur menu appears.

2 Press [Defocus], turning it on.

 

On the MVE-8000A, the Defocus and Glow effects 
cannot be enabled at the same time. The effect which 
was turned on most recently is enabled.

3 In the <Defocus Mode> group, select the signal to 
which to apply the defocus effect.

Video/Key: Video signal and key signal
Video: Video signal only 
Key: Key signal only

  

“Key” can be selected only when the DME is 
connected through an SDI interface.

4 Set the parameters.

When Video/Key is selected (with DME dedicated 
interface)

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Notes 

Notes 

Knob Parameter Adjustment Setting values

1 H Horizontal 
defocusing of 
video and 
key signals

0.00 to 100.00

2 V Vertical 
defocusing of 
video and 
key signals

0.00 to 100.00

3 All Horizontal 
and vertical 
defocusing of 
video and 
key signals

H value shown
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When Video/Key is selected (with SDI-interfaced 
DME)

When Video is selected

When Key is selected (with SDI-interfaced DME)

5 To cancel black level leaking that can occur at the edge 
of the screen when the Defocus effect is enabled, press 
[Clean Defocus], turning it on.

Masking the Defocus effect with a selected 
pattern
Press [Mask] to display the Mask menu, and set the pattern 
type and modifiers (see page 297).

Blur Settings

Applying the Blur effect 

1 In the DME menu, select VF2 ‘Video Modify’ and 
HF1 ‘Defocus/Blur.’

The Defocus/Blur menu appears.

2 Press [Blur], turning it on.

On the MVE-8000A, the Glow and Blur effects cannot 
be enabled at the same time. The effect which was 
turned on most recently is enabled.

3 When the DME is connected through an SDI interface, 
in the <Blur Mode> group, select the signal to which 
you want apply the Blur effect.

Video/Key: Video signal and key signal
Video: Video signal only
Key: Key signal only

4 Set the parameters.

When the DME dedicated interface is used

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 V/K H Horizontal 
defocusing of 
video and 
key signals

Video H value 
shown

2 V/K V Vertical 
defocusing of 
video and 
key signals

Video V value 
shown

3 V/K All Horizontal 
and vertical 
defocusing of 
video and 
key signals

Video H value 
shown

4 Video All Horizontal 
and vertical 
defocusing of 
video signal

Video H value 
shown

5 Key All Horizontal 
and vertical 
defocusing of 
key signal

Key H value shown

Parameter group [2/2]

Knob Parameter Adjustment Settings values

1 Video H Horizontal 
defocusing of 
video signal

0.00 to 100.00

2 Video V Vertical 
defocusing of 
video signal

0.00 to 100.00

3 Key H Horizontal 
defocusing of 
key signal

0.00 to 100.00

4 Key V Vertical 
defocusing of 
key signal

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Horizontal 
defocusing of 
video signal

0.00 to 100.00

2 V Vertical 
defocusing of 
video signal

0.00 to 100.00

3 All Horizontal 
and vertical 
defocusing of 
video signal

H value shown

Knob Parameter Adjustment Settings values

1 H Horizontal 
defocusing of 
key signal

0.00 to 100.00

2 V Vertical 
defocusing of 
key signal

0.00 to 100.00

3 All Horizontal 
and vertical 
defocusing of 
key signal

H value shown

Notes 

Knob Parameter Adjustment Setting values

1 H Horizontal 
defocusing of 
video and 
key signals

0.00 to 100.00
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When Video/Key is selected (with SDI-interfaced 
DME)

When video is selected (with SDI-interfaced DME)

When Key is selected (with SDI-interfaced DME)

Masking the Blur effect with a selected 
pattern
Press [Mask] to display the Mask menu, and set the pattern 
type and modifiers (see page 297).

Multi Move Settings

Applying the Multi Move effect

1 In the DME menu, select VF2 ‘Video Modify’ and 
HF2 ‘Multi Move.’

The Multi Move menu appears.

2 Press [Multi Move], turning it on.

3 Set the parameters.

The valid ranges of the parameter values depend on the 
combination of signal format (SD/HD) and aspect 
ratio (4:3/16:9) selected in the system, as follows.

4:3 mode

2 V Vertical 
defocusing of 
video and 
key signals

0.00 to 100.00

3 All Horizontal 
and vertical 
defocusing of 
video and 
key signals

H value shown

Parameter group [1/2]

Knob Parameter Adjustment Settings values

1 V/K H Horizontal 
defocusing of 
video and 
key signals

Video H value 
shown

2 V/K V Vertical 
defocusing of 
video and 
key signals

Video V value 
shown

3 V/K All Horizontal 
and vertical 
defocusing of 
video and 
key signals

Video H value 
shown

4 Video All Horizontal 
and vertical 
defocusing of 
video signal

Video H value 
shown

5 Key All Horizontal 
and vertical 
defocusing of 
key signal

Key H value shown

Parameter group [2/2]

Knob Parameter Adjustment Settings values

1 Video H Horizontal 
defocusing of 
video signal

0.00 to 100.00

2 Video V Vertical 
defocusing of 
video signal

0.00 to 100.00

3 Key H Horizontal 
defocusing of 
key signal

0.00 to 100.00

4 Key V Vertical 
defocusing of 
key signal

0.00 to 100.00

Knob Parameter Adjustment Settings values

1 H Horizontal 
defocusing of 
video signal

0.00 to 100.00

Knob Parameter Adjustment Setting values

2 V Vertical 
defocusing of 
video signal

0.00 to 100.00

3 All Horizontal 
and vertical 
defocusing of 
video signal

H value shown

Knob Parameter Adjustment Setting values

1 H Horizontal 
defocusing of 
key signal

0.00 to 100.00

2 V Vertical 
defocusing of 
key signal

0.00 to 100.00

3 All Horizontal 
and vertical 
defocusing of 
key signal

H value shown

Knob Parameter Adjustment Setting values

1 Center X x-value of 
shrinking 
center point

–4.00 to +4.00 (SD)
–12.00 to +12.00 
(HD)

2 Center Y y-value of 
shrinking 
center point

–3.00 to +3.00 (SD)
–9.00 to +9.00 (HD)

3 Size Shrinking 
ratio

0.00 to 100.00

Knob Parameter Adjustment Settings values
Applying Special Effects (Effects on the Overall Video Signal)
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a) Specify minus values to stretch the image in the vertical direction, 
and plus values to stretch the image in the horizontal direction.

16:9 mode

a) Specify minus values to stretch the image in the vertical direction, 
and plus values to stretch the image in the horizontal direction.

Sepia Settings

Applying the Sepia effect

1 In the DME menu, select VF2 ‘Video Modify’ and 
HF3 ‘Color Modify.’

The Color Modify menu appears.

2 Press [Sepia], turning it on.

3 Set the following parameters.

4 To set the color of the sepia image, press [Sepia 
Color], turning it on, and adjust the parameters. 

Masking the Sepia effect with a selected 
pattern
Press [Mask] to display the Mask menu, and set the pattern 
type and modifiers (see page 297).

Mono Settings

Applying the Mono effect

1 In the DME menu, select VF2 ‘Video Modify’ and 
HF3 ‘Color Modify.’

The Color Modify menu appears.

2 Press [Mono], turning it on.

Masking the Mono effect with a selected 
pattern
Press [Mask] to display the Mask menu, and set the pattern 
type and modifiers (see page 297).

Posterization and Solarization 
Settings

You can specify the degree of luminance coarsening.
You can specify the degree of chroma coarsening.

Applying the Posterization or Solarization 
effect

1 In the DME menu, select VF2 ‘Video Modify’ and 
HF3 ‘Color Modify.’

The Color Modify menu appears.

2 Press [Poster/Solar], turning it on.

3 Set the parameters.

4 Aspect Aspect ratio 
of shrunken 
images

–100.00 to +100.00 
a)

Knob Parameter Adjustment Setting values

1 Center X x-value of 
shrinking 
center point

–4.00 to +4.00 (SD)
–16.00 to +16.00 
(HD)

2 Center Y y-value of 
shrinking 
center point

–2.25 to +2.25(SD)
–9.00 to +9.00 (HD)

3 Size Shrinking 
ratio

0.00 to 100.00

4 Aspect Aspect ratio 
of shrunken 
images

–100.00 to +100.00 
a)

Knob Parameter Adjustment Setting values

1 Mix Y Y signal mix 
amount

0.00 to 100.00

2 Mix C Chroma 
signal mix 
amount

0.00 to 100.00

3 Mix All Y signal and 
chroma 
signal mix 
amount

Mix Y value shown

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Poster Coarseness 
of luminance 
gradations 
(Posterization 
parameter)

0.00 to 100.00

2 Solar Coarseness 
of chroma 
gradations 
(Solarization 
parameter)

0.00 to 100.00
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Masking the Posterization or Solarization 
effect with a selected pattern
Press [Mask] to display the Mask menu, and set the pattern 
type and modifiers (see page 297).

Nega Settings

Applying the Nega effect

1 In the DME menu, select VF2 ‘Video Modify’ and 
HF3 ‘Color Modify.’

The Color Modify menu appears.

2 Press [Nega Y] or [Nega C], turning it on, or press both 
buttons, turning them on.

Nega Y: Reverse the luminance.
Nega C: Reverse the chroma.

Masking the Nega effect with a selected 
pattern
Press [Mask] to display the Mask menu, and set the pattern 
type and modifiers (see page 297).

Contrast Settings

Applying the Contrast effect

1 In the DME menu, select VF2 ‘Video Modify’ and 
HF3 ‘Color Modify.’

The Color Modify menu appears.

2 Press [Contrast], turning it on.

3 Set the parameters.

Clip, Gain, Offset

Masking the Contrast effect with a 
selected pattern
Press [Mask] to display the Mask menu, and set the pattern 
type and modifiers (see page 297).

Mosaic Settings

Applying the Mosaic effect

1 In the DME menu, select VF2 ‘Video Modify’ and 
HF4 ‘Mosaic.’

The Mosaic menu appears.

2 Press [Mosaic], turning it on.

3 Set the following parameters.

a) Specify minus values to stretch the tiles in the vertical direction, and 
plus values to stretch the tiles in the horizontal direction.

Masking the Mosaic effect with a selected 
pattern
Press [Mask] to display the Mask menu, and set the pattern 
type and modifiers (see page 297).

Sketch Settings

Applying the Sketch effect

1 In the DME menu, select VF7 ‘Enhanced Video 
Modify’ and HF1 ‘Sketch.’

The Sketch menu appears. 

2 Press [Sketch], turning it on.

Knob Parameter Adjustment Setting values

1 Y Clip Luminance 
clip level

+109.59 to –7.31

2 Y Gain Luminance 
contrast 
gradient

–100.00 to +100.00

3 Y Offset Luminance 
offset level 
increment

–100.00 to +100.00

4 C Gain Chroma 
contrast 
gradient

–100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Size Size of tiles 0.00 to 100.00

2 Aspect Aspect ratio 
of tiles

–100.00 to 
+100.00 a)

Video output level

Video input level

Video output level

Video input level
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3 Select the method for applying outlines in the <Sketch 
Mode> group.

Sketch: Apply an effect like a sketch.
Edge Color: Enhance the outlines.
Draw: Apply an effect like a line drawing.
Relief: Apply a bas-relief effect.
Sharp: Increase the apparent sharpness. 

4 Set the following parameters, according to the method 
selected in step 3.

When Sketch is selected

a) 100.00 gives an image completely transformed by the Sketch effect. 
0.00 is the original input image. 

b) The larger the Clip value, the narrower the outline width. 

When Edge Color is selected 

a) 100.00 gives an image completely transformed by the Sketch effect. 
0.00 is the original input image. 

b) The larger the Clip value, the narrower the outline width. 

When Draw is selected 

a) 100.00 gives an image completely transformed by the Sketch effect. 
0.00 is the original input image. 

b) The larger the Clip value, the narrower the outline width. 

When Relief is selected

a) 100.00 gives an image completely transformed by the Sketch effect. 
0.00 is the original input image. 

When Sharp is selected 

5 If you selected other than Sharp in step 3, depending 
on the necessity, proceed as follows.

To adjust the outline color for Edge Color or Draw
Turn [Edge Matte] on and set the following parameters 
to set the outline color. 

Knob Parameter Adjustment Setting values

1 Mix Mix amount 
for Sketch 
video and 
input video

0.00 to 100.00 a)

2 Clip Reference 
level for 
outline 
extraction

–100.00 to 
+100.00 b)

3 Gain Image gain 
for outline 
extraction

–100.00 to +100.00

4 C Gain Chroma gain 
of input video

–100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Mix Mix amount 
for Edge 
Color video 
and input 
video

0.00 to 100.00 a)

2 Clip Reference 
level for 
outline 
extraction

–100.00 to 
+100.00 b)

Knob Parameter Adjustment Setting values

1 Mix Mix amount 
for Draw 
video and 
input video

0.00 to 100.00 a)

2 Clip Reference 
level for 
outline 
extraction

–100.00 to 
+100.00 b)

3 Gain Image gain 
for outline 
extraction

–100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Mix Mix amount 
for Relief 
video and 
input video

0.00 to 100.00 a)

2 Offset Relief 
luminance 
level

–100.00 to +100.00 

3 Gain Image gain 
for outline 
extraction

–100.00 to +100.00

4 Angle Direction of 
relief image 
light source 

–8.00 to +8.00

Knob Parameter Adjustment Setting values

1 H Simultane-
ously adjust 
the left and 
right resolu-
tion

0.00 to 100.00

2 V Simultane-
ously adjust 
the top and 
bottom 
resolution

0.00 to 100.00

3 All Simultane-
ously adjust 
the resolu-
tion of all four 
sides

0.00 to 100.00

5 Coring Minimum 
value of 
edge to 
emphasize

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
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To set the color of the sections other than the 
outlines for Draw
Press [Matte], turning it on, and adjust the following 
parameters to set the color of the sections other than 
the outlines.

To select the signal to mix with the relief pattern for 
Relief
In the <Chroma Type> group, select the signal to mix 
with the relief pattern. 
Matte: Select a single color. The following 

parameters can be adjusted. 

Video: Select the input video signal. 

6 To invert white and black in the extracted video, or to 
invert the outlines and the sections other than the 
outlines, press [Nega], turning it on.

Masking the Sketch effect with a selected 
pattern
Press [Mask] to display the Mask menu and set the type of 
pattern and modifiers (see page 297). 

Metal Settings

Applying the Metal effect

1 In the DME menu, select VF7 ‘Enhanced Video 
Modify’ and HF2 ‘Metal.’

The Metal menu appears. 

2 Press [Metal], turning it on.

3 Set the parameters.

4 In the <Metal Mode> group, select the type of metallic 
gloss. 

Gold: Give a gold gloss to the input video. 
Silver: Give a silver gloss to the input video.
Rainbow: Give a rainbow color gloss to the input 

video.
Variable: Give a metallic gloss to the input video in 

any color by adjusting the following parameters. 

Masking the Metal effect with a selected 
pattern
Press [Mask] to display the Mask menu and set the type of 
pattern and modifiers (see page 297). 

Dim and Fade Settings

The Dim and Fade functions are not supported on the 
MVE-8000A. 

Applying the Dim effect

1 In the DME menu, select VF7 ‘Enhanced Video 
Modify’ and HF3 ‘Dim & Fade.’

The Dim & Fade menu appears. 

2 Press [Dim], turning it on.

3 Set the following parameters.

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Mix Ratio Mix amount 
for Metal 
video and 
input video

0.00 to 100.00

2 Y Clip Clip level of 
input signal 
Y level

0.00 to 100.00

3 Y Gain Amount of 
gain for clip 
adjusted 
input signal 
Y level

–100.00 to +100.00

4 Y Offset Offset added 
to clip and 
gain 
adjusted 
input Y 
signal

0.00 to 100.00

Knob Parameter Adjustment Setting values

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Notes 

Knob Parameter Adjustment Setting values

1 Start Point where 
dimming 
starts (dim 
start point)

–100.00 to +100.00

Knob Parameter Adjustment Setting values
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4 Press [Flat Color] and set the parameters for the color 
of the depths of the picture.

Applying the Fade effect

1 In the DME menu, select VF7 ‘Enhanced Video 
Modify’ and HF3 ‘Dim & Fade.’

The Dim & Fade menu appears. 

2 Press [Fade], turning it on.

3 Set the parameters.

Glow Settings

Applying the Glow effect

1 In the DME menu, select VF7 ‘Enhanced Video 
Modify’ and HF4 ‘Glow.’

The Glow menu appears. 

2 Press [Glow], turning it on.

 

• On the MVE-9000 and MVS-7470X/7471X, the key 
border function and Glow function cannot be turned 
on at the same time. The function most recently 
turned on is effective.

• On the MVE-8000A, the Defocus and Glow effects 
or the Blur and Glow effects cannot be turned on at 
the same time. The effect most recently turned on is 
effective.

3 Set the parameters.

4 Press [Matte] and set the glow color. 

Inverting the highlight areas
Press [Glow Invert], turning it on.
The highlight and non-highlight areas are inverted. 

Masking the Glow effect with a selected 
pattern
Press [Mask] to display the Mask menu and set the type of 
pattern and modifiers (see page 297). 

When the signal format is 1080P (3G) on the MKS-7470X/
7471X, masking will cause the edges to get blurred.

Mask Settings

Applying masks

1 In the DME menu, select VF2 ‘Video Modify’ and 
HF7 ‘Mask.’

The Mask menu appears.

2 In the <Mask> group, press the button for the group of 
the effect to which you want to apply the mask, turning 
it on.

Effect Gp 1: Posterization, Solarization, Nega, Sepia, 
Mono, Contrast, Mosaic, Sketch, Metal

Effect Gp 2: Defocus, Blur, Glow

 

On the MVE-8000A, Effect Gp 1 and Effect Gp 2 
cannot be turned on at the same time.

2 Gain Degree of 
dimming

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Start Point where 
fading starts 
(fade start 
point)

–100.00 to +100.00

2 Gain Degree of 
fading

0.00 to 100.00

Notes 

Knob Parameter Adjustment Setting values
Knob Parameter Adjustment Setting values

1 Clip Reference 
level for 
highlight 
detection

0.00 to 100.00

2 Gain Amount of 
gain for 
highlights

–100.00 to +100.00

3 Soft Softness 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Notes

Notes 
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3 Press [Position/Size].

4 Set the mask source parameters.

The valid ranges of the parameter values depend on the 
combination of signal format (SD/HD) and aspect 
ratio (4:3/16:9) selected in the system, as follows.

4:3 mode

a) This setting value is not supported on the MVE-8000A.

16:9 mode

a) This setting value is not supported on the MVE-8000A.

5 To invert the mask source, press [Invert], turning it on.

6 As required, set the modifiers for the mask pattern.

When turning [Aspect] on and adjusting the 
pattern aspect ratio

a) When a minus value is specified, the picture is extended in the 
vertical direction. When a plus value is specified, the picture is 
extended in the horizontal direction. 

When turning [Angle] on in the <Rotation> group 
and slanting the pattern

a) –1.00 is one rotation in counterclockwise direction. +1.00 is one 
rotation in clockwise direction. 0.00 is no rotation.

When turning [Speed] on in the <Rotation> group 
and rotating the pattern at a specified speed

a) –100.00 is four rotations per second in counterclockwise direction. 
+100.00 is four rotations per second in clockwise direction. 0.00 is 
no rotation.

Notes on applying a mask effect with a DME (only 
when using the MKS-7470X/7471X or MVE-9000)
In the <Mask> group of the DME >Video Modify >Mask 
menu, if [Effect Gp1] and [Effect Gp2] are simultaneously 
set to On, then the border or beveled edge is also masked.
The following explains this with the example of using a 
circular mask pattern.

m

m
In the state corresponding to image 2, if you switch [Effect 
Gp2] to On, then the mask should be applied to portion 2 
only, but in fact the border or beveled edge is also masked.

Knob Parameter Adjustment Setting values

1 H Horizontal 
position

–8.00 to +8.00 (SD)
–24.00 to +24.00 
(HD)

2 V Vertical 
position

–6.00 to +6.00 (SD)
–18.00 to +18.00 
(HD)

3 Size Size of mask 0.00 to 100.00

4 Soft Softness of 
mask

0.00 to 100.00

5 Pattern Pattern 
number

21, 24, 304 a)

Knob Parameter Adjustment Setting values

1 H Horizontal 
position

–8.00 to +8.00 (SD)
–32.00 to +32.00 
(HD)

2 V Vertical 
position

–4.50 to +4.50 (SD)
–18.00 to +18.00 
(HD)

3 Size Size of mask 0.00 to 100.00

4 Soft Softness of 
mask

0.00 to 100.00

5 Pattern Pattern 
number

21, 24, 304 a)

Knob Parameter Adjustment Setting values

1 Aspect Aspect ratio –100.00 to +100.00 a)

Knob Parameter Adjustment Setting values

1 Angle Rotation 
angle of 
pattern

–8.00 to +8.00 a)

Knob Parameter Adjustment Setting values

1 Speed Rotation 
speed of 
pattern

–100.00 to +100.00 a)

Image 1: Image before applying mask

Border or 
beveled 
edge

Image with 
‘Mono(chrome)’ 
or ‘Defocus’ 
applied

Image 2: State with [Effect Gp1] only set to On

Portion 2 has 
‘Mono’ masked, 
and ‘Defocus’ 
only applied.

Portion 1 has 
both ‘Mono’ and 
‘Defocus’ 
applied.
Applying Special Effects (Effects on the Overall Video Signal)
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Freeze Settings

Freezes the input video. The following types are available:
Hard Freeze: Freezes the input video at an arbitrary 

timing.
Time Strobe: Freezes the input video at specified intervals 

for a specified length.
Film: Slows the apparent frame rate, for an effect like film. 

You can specify the ratio of advancement.
For Hard Freeze and Time Strobe, you can select the first 
field or the frame as the freeze timing.

 

When 720P or 1080P signal format is used, the Film mode 
cannot be selected.

To apply a Freeze effect, start by displaying the Freeze 
menu. In the DME menu, select VF3 ‘Freeze’ and HF1 
‘Freeze.’

Applying the Hard Freeze effect

1 In the <Freeze Timing> group, select the signal freeze 
timing.

Frame: Freeze one frame of signal.
Field 1: Freeze the first field of signal.

2 In the <Freeze> group, press [Hard Freeze], turning it 
on.

Applying the Time Strobe effect

1 In the <Freeze Timing> group, select the signal freeze 
timing.

Frame: Freeze one frame of signal.
Field 1: Freeze the first field of signal.

The freeze timing setting is not required when the 
following signal formats are being used. 

1080P/50, 1080P/59.94, 1080PsF/23.976, 
1080PsF/24, 1080PsF/25, 1080PsF/29.97, 720P/
50, 720P/59.94

2 In the <Freeze> group, press [Time Strobe], turning it 
on.

3 Set the parameters.

Applying the Film effect
 

When 720P or 1080P signal format is used, the Film mode 
cannot be selected.

1 In the <Freeze> group, press [Film], turning it on.

2 Set the parameter.
Notes 

Notes 

Image 3: State with [Effect Gp1] and [Effect Gp2] set to On

The border or 
beveled edge 
effect is also 
masked.

Knob Parameter Adjustment Setting values

1 Duration Freeze 
interval

1 to 255 (frames)

2 Live Ratio of live 
video 
inserted 
between 
freeze 
images

0.00 to 100.00

Notes 

Knob Parameter Adjustment Setting values

1 Film Ratio of 
frame 
advance

0.00 to 100.00
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Applying Special Effects 
(Nonlinear Effect 
Settings)

You can add a variety of effects, including effects that 
change the shape of the image as a whole.

1 In the DME menu, select VF4 ‘Non Linear/Corner 
Pin’ and HF1 ‘Non Linear.’

A menu for selecting the various effects appears.

2 Display the menu for the effect that you want to apply 
by pressing its button.

3 Make the settings for the selected effect.

• It is not possible to apply two or more nonlinear 
effects at the same time. Turning any nonlinear 
effect on automatically turns all other nonlinear 
effects off.

• The Flex Shadow function cannot be enabled when 
any of the nonlinear effects Page Turn, Roll, 
Cylinder, and Sphere is enabled. 

• However, the Flex Shadow function is not supported 
on the MVE-8000A.

To turn an effect off
In the setting menu, press the button for the effect name, 
turning it off, or in the Type menu press [OFF] in the lower 
right part of the window.

Wave Settings

There are two modes: H&V and Size. You can set the size 
and frequency of the waves, the wave form, the amount of 
wave movement, and the range. In H&V mode, you can 
also set the wave angle.

To apply the Wave effect
With the Wave menu displayed, use the following 
procedure.

1 In the <Mode> group, select the wave modulation 
mode.

H&V: Modulate vertically and horizontally without 
changing the size of the image. This mode allows 
waves to be created in both the vertical and 
horizontal directions at the same time.

Size: Create waves by reducing and expanding the 
image. This mode allows waves to be created in 
one direction only.

2 Set the following parameters, according to the selected 
mode.

When H&V is selected
Notes 

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Amp H Amplitude of 
waves in 
horizontal 
direction

0.00 to 100.00

2 Freq H Frequency of 
waves in 
horizontal 
direction

0.00 to 100.00

3 Offset H a) Horizontal 
direction in 
which to 
offset wave 
phase and 
amount of 
movement

–16.00 to +16.00 c)

–64.00 to +64.00 d)

4 Speed H b) Horizontal 
direction and 
speed of 
waves

–100.00 to +100.00

5 Slant Slant of 
waves

–8.000 to +8.000

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Amp V Amplitude of 
waves in 
vertical 
direction

0.00 to 100.00

2 Freq V Frequency of 
waves in 
vertical 
direction

0.00 to 100.00

Before modulation

Size not modulated.
1 and 2 are same size.

Create waves by 
reducing 1 and 
expanding 2 the image.
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a) Set when Lock is on.
b) Set when Lock is off.
c) Setting for SD 4:3, SD 16:9
d) Setting for HD 4:3, HD 16:9

When Size is selected

a) Set when Lock is on.
b) Set when Lock is off.
c) Setting for SD 4:3, SD 16:9
d) Setting for HD 4:3, HD 16:9

To stop the waves
Press [Lock], turning it on.
With each press, the waves alternately stop and start 
moving again.

To select the waveform
Press [Form] and set the following parameters.

When H&V mode is selected

When Size mode is selected

a) 1 (SINE): Sine wave
2 (PARABOLA): Parabola wave
3 (TRIANGLE): Triangular wave
4 (RECTANGLE): Rectangular wave
5 (CIRCLE): Circular wave
6 (CUBIC): Cubic wave

To randomize the modulated waveform

1 Press [Random], turning it on.

2 Set the following parameters.

When H&V mode is selected

When Size mode is selected

To limit the wave range

1 Press [Range], turning it on.

2 Set the following parameters.

3 Offset V a) Vertical 
direction in 
which to 
offset wave 
phase and 
amount of 
movement

–16.00 to +16.00 c)

–64.00 to +64.00 d)

4 Speed V b) Vertical 
direction and 
speed of 
waves

–100.00 to +100.00

5 Slant Slant of 
waves

–8.000 to +8.000

Knob Parameter Adjustment Setting values

1 Amp H Amplitude of 
waves

0.00 to 100.00

2 Freq H Frequency of 
waves

0.00 to 100.00

3 Offset H a) Direction in 
which to 
offset wave 
phase and 
amount of 
movement

–16.00 to +16.00 c)

–64.00 to +64.00 d)

4 Speed H b) Direction and 
speed of 
waves

–100.00 to +100.00

5 Slant Slant of 
waves

–8.000 to +8.000

Parameter group [2/2]

Knob Parameter Adjustment Setting values

Offset

Amp

Knob Parameter Adjustment Setting values

1 Form H Waveform in 
horizontal 
direction

1 to 6 a)

2 Form V Waveform in 
vertical direction

1 to 6 a)

Knob Parameter Adjustment Setting values

1 Form H Waveform 1 to 6 a)

Knob Parameter Adjustment Setting values

1 Random H Degree of 
randomness 
in horizontal 
waveform 
modulation

0.00 to 100.00

2 Random V Degree of 
randomness 
in vertical 
waveform 
modulation

0.00 to 100.00

3 Random 
All

Degree of 
randomness 
in both 
vertical and 
horizontal 
directions

Random H value 
shown

Knob Parameter Adjustment Setting values

1 Random H Degree of 
randomness 
in waveform 
modulation

0.00 to 100.00
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When H&V mode is selected

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

When Size mode is selected

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

To smooth the range envelope when the wave 
range is limited

1 Press [Range Envelope], turning it on.

2 Set the following parameters.

When H&V mode is selected
 

When Size mode is selected

To reverse the wave range
To reverse the horizontal wave range set with [Range]: 

Press [Range Rev H], turning it on.
To reverse the vertical wave range set with [Range]: 

Press [Range Rev V], turning it on.

Mosaic Glass Settings

There are two modes: H&V and Size. You can set the size 
and frequency of waves in the image, the wave form, the 
amount of wave movement, and the range. In H&V mode, 
you can also set the wave angle.

To apply the Mosaic Glass effect
Display the Mosaic Glass menu.
The items displayed in the Mosaic Glass menu and the 
functions of the knobs are the same as for the Wave menu 
(see page 300).

Flag Settings

There are two modes: H&V and Size. You can set the size 
and frequency of waves in the image, the wave form, the 
amount of wave movement, and the range. In H&V mode, 
you can also set the wave angle.

To apply the Flag effect
Display the Flag menu.
The items displayed in the Flag menu and the functions of 
the knobs are the same as for the Wave menu (see page 
300).

Twist Settings

You can twist the image in the horizontal or vertical 
direction.
You can set the size and frequency of waves in the image, 
the wave form, the amount of wave movement, and other 
parameters.

Knob Parameter Adjustment Setting values

1 Size H Amount of 
horizontal 
wave 
modulation

0.00 to 100.00

2 Offset H Center point 
of horizontal 
modulation 
range

–8.000 to +8.000 a)

–32.000 to 
+32.000 b)

3 Size V Amount of 
vertical wave 
modulation

0.00 to 100.00

4 Offset V Center point 
of vertical 
modulation 
range

–8.000 to +8.000 a)

–32.000 to 
+32.000 b)

Knob Parameter Adjustment Setting values

1 Size H Amount of 
wave 
modulation

0.00 to 100.00

2 Offset H Center point 
of 
modulation 
range

–8.000 to +8.000 a)

–32.000 to 
+32.000 b)

Knob Parameter Adjustment Setting values

1 Envelope 
H

Smoothness 
of envelope 
in horizontal 
direction

0.00 to 100.00

Envelope

Size

Offset

2 Envelope 
V

Smoothness 
of envelope 
in vertical 
direction

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Envelope 
H

Smoothness 
of envelope

0.00 to 100.00

Knob Parameter Adjustment Setting values
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To apply the Twist effect
With the Twist menu displayed, set the following 
parameters.

a) Set when Lock is on.
b) Set when Lock is off.
c) Setting for SD 4:3, SD 16:9
d) Setting for HD 4:3, HD 16:9

To stop the waves
Press [Lock], turning it on.
With each press, the waves alternately stop and start 
moving again.

To select the waveform
Press [Form] and set the following parameters.

 

a) 1 (SINE): Sine wave
2 (PARABOLA): Parabola wave

3 (TRIANGLE): Triangular wave
4 (RECTANGLE): Rectangular wave
5 (CIRCLE): Circular wave
6 (CUBIC): Cubic wave

Ripple Settings

There are four modes: Radial, Angular, Both, and Shape. 
The direction of modulation differs depending on the 
mode. You can set the size and frequency of the ripples, 
their direction and speed, their center point, and other 
parameters. In Shape mode, you can select ripple shapes 
other than circles (stars, etc.). 

To apply the Ripple effect
With the Ripple menu displayed, use the following 
procedure.

1 In the <Mode> group, select the ripple modulation 
mode.

Radial: Points on radii of the same length from the 
center of the ripples behave in the same way.

Angular: Points at the same angle from the center of 
the ripples behave in the same way.

Both: Both Radial and Angular ripples are applied.
Shape: The ripples can have shapes such as stars or 

hearts in addition to circles.

Modulation modes and directions

2 Set the following parameters, depending on the 
selected modulation mode.

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Amp V Amplitude of 
twist in vertical 
direction

0.00 to 100.00

2 Freq V Frequency of 
twist in vertical 
direction

0.00 to 100.00

3 Offset V a) Amount of 
movement in 
twist phase in 
the vertical 
direction

–16.00 to 
+16.00 c)

–64.00 to 
+64.00 d)

4 Speed V b) Speed and 
direction of 
twist movement 
in vertical 
direction

–100.00 to 
+100.00

5 Slant Slant of twist –8.000 to 
+8.000

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Amp H Amplitude of 
twist in 
horizontal 
direction 

0.00 to 100.00

3 Offset H a) Amount of 
movement in 
twist phase in 
the horizontal 
direction

–100.00 to 
+100.00

5 Slant Slant of twist –8.000 to 
+8.000

Knob Parameter Adjustment Setting values

1 Form H Waveform in 
horizontal 
direction

1 to 6 a)

2 Form V Waveform in 
vertical 
direction

1 to 6 a)

Modulation along radii (Radial mode)

Modulation along periphery (Angular mode)
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When Radial mode is selected

a) Set when Lock is on.
b) Set when Lock is off.
c) Setting for SD 4:3, SD 16:9
d) Setting for HD 4:3, HD 16:9

When Angular mode is selected

a) Set when Lock is on.
b) Set when Lock is off.

When Both mode is selected

a) Set when Lock is on.
b) Set when Lock is off.
c) Setting for SD 4:3, SD 16:9
d) Setting for HD 4:3, HD 16:9

When Shape mode is selected

Knob Parameter Adjustment Setting values

1 Amp R Ripple 
amplitude 
along radius

0.00 to 100.00

2 Freq R Ripple 
frequency 
along radius

0.00 to 100.00

3 Offset R a) Direction 
along radius 
in which to 
offset ripple 
phase and 
amount of 
movement

–8.000 to +8.000 c)

–32.000 to 
+32.000 d)

4 Speed R b) Ripple 
direction 
along radius 
and speed

–100.00 to +100.00

5 Amp A Ripple 
amplitude 
along 
periphery

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Amp A Ripple 
amplitude 
along 
periphery

0.00 to 100.00

2 Freq A Ripple 
frequency 
along 
periphery

0.00 to 100.00

3 Offset A a) Direction 
along 
periphery in 
which to 
offset ripple 
phase and 
amount of 
movement

–8.000 to +8.000

4 Speed A b) Ripple 
direction 
along 
periphery 
and speed

–100.00 to +100.00

5 Amp R Ripple 
amplitude 
along radius

0.00 to 100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Amp R Ripple 
amplitude 
along radius 

0.00 to 100.00

2 Freq R Ripple 
frequency 
along radius

0.00 to 100.00

3 Offset R a) Direction 
along radius 
in which to 
offset ripple 
phase and 
amount of 
movement

–8.000 to +8.000 c)

–32.000 to 
+32.000 d)

4 Speed R b) Ripple 
direction 
along radius 
and speed

–100.00 to +100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Amp A Ripple 
amplitude 
along 
periphery

0.00 to 100.00

2 Freq A Ripple 
frequency 
along 
periphery

0.00 to 100.00

3 Offset A a) Direction 
along 
periphery in 
which to 
offset ripple 
phase and 
amount of 
movement

–8.000 to +8.000 

4 Speed A b) Ripple 
direction 
along 
periphery 
and speed

–100.00 to +100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Amp R Ripple 
amplitude 

0.00 to 100.00

2 Freq R Ripple 
frequency 

0.00 to 100.00
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a) Set when Lock is on.
b) Set when Lock is off.
c) Setting for SD 4:3, SD 16:9
d) Setting for HD 4:3, HD 16:9
e) 1 (Circle): Circle

2 (Rectangle): Rectangle
3 (Star): Star
4 (Heart): Heart

To limit the direction in which modulation is 
applied
By pressing [Plus Only], turning it on, you can limit the 
direction in which modulation is applied (the direction in 
which the image expands) to the plus direction only.

To set the ripple center point

1 Press [Position], turning it on.

2 Set the following parameters, depending on the 
selected modulation mode.

When Shape is selected

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

When other than Shape is selected

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

To limit the ripple range

1 Press [Range], turning it on.

2 Set the following parameters.

When Radial or Shape mode is selected

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

When Angular mode is selected

When Both mode is selected

3 Offset R a) Direction in 
which to 
offset ripple 
phase and 
amount of 
movement

–8.000 to +8.000 c)

–32.000 to 
+32.000 d)

4 Speed R b) Ripple 
direction and 
speed

–100.00 to +100.00

5 Shape Ripple shape 1 to 4 e)

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Aspect Ripple 
aspect ratio

–100.00 to +100.00

2 Angle Ripple angle –8.000 to +8.000

Knob Parameter Adjustment Setting values

1 H Ripple center 
point in 
horizontal 
direction

–5.000 to +5.000 a)

–20.000 to 
+20.000 b)

2 V Ripple center 
point in 
vertical 
direction

–3.000 to +3.000 a)

–12.000 to 
+12.000 b)

Parameter group [1/2]

Knob Parameter Adjustment Setting values Knob Parameter Adjustment Setting values

1 H Ripple center 
point in 
horizontal 
direction

–8.000 to +8.000 a)

–32.000 to 
+32.000 b)

2 V Ripple center 
point in 
vertical 
direction

–6.000 to +6.000 a)

–18.000 to 
+18.000 b)

Knob Parameter Adjustment Setting values

1 Size R Amount of 
ripple 
modulation 
along radius

0.00 to 100.00

2 Offset R Center of 
modulation 
range along 
radius

–8.000 to +8.000 a)

–32.000 to 
+32.000 b)

Knob Parameter Adjustment Setting values

1 Size A Amount of 
ripple 
modulation 
along 
periphery 

0.00 to 100.00

2 Offset A Center of 
modulation 
range along 
periphery

–8.000 to +8.000

Knob Parameter Adjustment Setting values

1 Size R Amount of 
ripple 
modulation 
along radius

0.00 to 100.00

2 Offset R Center of 
modulation 
range along 
radius

–8.000 to 
+8.000 a)

–32.000 to 
+32.000 b)
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b) Setting for HD 4:3, HD 16:9

To reverse the ripple range
When modulation mode is Radial, Both, or Shape: 

Press [Range Rev R], turning it on.
When modulation mode is Both or Angular: Press 

[Range Rev A], turning it on.

Other settings
You can turn [Lock], [Form], [Random], and [Range 
Envelope] on to do the following.
• Stop the waves
• Select the wave shape
• Randomize the waveform
• Smooth the range envelope when the wave range is 

limited

For Lock, Form, Random, and Range Envelope functions, 
see “Wave Settings” (page 300).

Rings Settings

You can set the degree of transition, the degree of 
randomness in the distance moved by each block, the 
amount of movement, the width of the partitions, the 
degree of randomness in partition width, the center point, 
the starting angle, and other parameters.

To apply the Rings effect
With the Rings menu displayed, use the following 
procedure.

1 To make transition settings, press [Transition] and set 
the following parameters.

2 To set the partition method, press [Partition] and set 
the following parameters.

3 To set the ring center position, press [Position] and set 
the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

4 To partition into pixels, press [Pixel], turning it on, and 
set the following parameters.

Broken Glass Settings

You can set the degree of transition, the degree of 
randomness in the distance moved by each block, the 
amount of movement, the width of the partitions, the 
degree of randomness in partition width, the center point, 
the starting angle, and other parameters.
You can also fix the direction in which shards scatter.

3 Size A Amount of 
ripple 
modulation 
along 
periphery 

0.00 to 100.00

4 Offset A Center of 
modulation 
range along 
periphery

–8.000 to +8.000

Knob Parameter Adjustment Setting values

1 Transition Degree of 
transition 

0.000 to 100.000

2 Random Degree of 
randomness in 
distance 
moved by 
each block

0.000 to 100.000

Knob Parameter Adjustment Setting values

3 Spiral Amount of 
movement 
toward 
periphery 
accompanying 
transition 

–1.000 to +1.000

Knob Parameter Adjustment Setting values

1 Width Width of 
partition

0.000 to 100.000

2 Random Degree of 
randomness in 
partition width

0.000 to 100.000

3 Angle Starting angle 
of effect 

–8.000 to +8.000

Knob Parameter Adjustment Setting values

1 H Horizontal 
center position

–5.000 to 
+5.000 a)

–20.000 to 
+20.000 b)

2 V Vertical center 
position

–4.000 to 
+4.000 a)

–16.000 to 
+16.000 b)

Knob Parameter Adjustment Setting values

1 Density Degree to 
which image 
disappears 
around 
periphery

0.00 to 100.00

2 Random Degree of 
jaggies at 
block edges

0.00 to 100.00

Knob Parameter Adjustment Setting values
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To apply the Broken Glass effect
Display the Broken Glass menu.
The functions of the knobs in the Broken Glass menu are 
the same as those of the Rings menu (see page 306), with 
the exception of [Direction].

To fix the direction in which shards scatter
Press [Direction], turning it on.

Flying Bar Settings

You can set the degree of transition, the degree of 
randomness in the distance moved by each block, the 
direction of movement, the width of the partitions, the 
degree of randomness in partition width, the partition 
angle, and other parameters.

To apply the Flying Bar effect
With the Flying Bars menu displayed, use the following 
procedure.

1 To make transition settings, press [Transition] and set 
the following parameters.

2 To set the partition method, press [Partition] and set 
the following parameters.

Blind Settings

There are two modes: Bar and Wedge. You can set the 
number of rotations by blocks, the perspective, the width 
and position of blocks, the direction, the center position, 
and other parameters. 

To apply the Blind effect
With the Blind menu displayed, use the following 
procedure.

1 In the <Mode> group, select [Bar] or [Wedge].

2 To make transition settings, press [Transition] and set 
the following parameters.

3 To set the partition method, press [Partition] and set 
the following parameters.

When Bar was selected in step 1

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

When Wedge was selected in step 1

To set the wedge center position 
When Wedge is selected in the <Mode> group, you can set 
the wedge center position.

1 Press [Position].

2 Set the following parameters.

Knob Parameter Adjustment Setting values

1 Transition Degree of 
transition 

0.000 to 100.000

2 Random Degree of 
randomness in 
distance 
moved by 
each block

–100.000 to 
+100.000

3 Angle Direction of 
movement

–8.000 to +8.000

Knob Parameter Adjustment Setting values

1 Width Width of 
partition

0.000 to 100.000

2 Random Degree of 
randomness in 
partition width

0.000 to 100.000

3 Angle Partition angle –8.000 to +8.000

Knob Parameter Adjustment Setting values

1 Rotation Number of 
rotations of 
the blocks

–8.000 to +8.000

2 Perspective Degree of 
randomness in 
distance 
moved by 
each block 

0.000 to 100.000

Knob Parameter Adjustment Setting values

1 Width Width of 
partition

0.000 to 100.000

2 Offset Degree of 
randomness in 
partition width

–5.000 to 
+5.000 a)

–20.000 to 
20.000 b)

3 Angle Starting angle 
of effect 

–8.000 to +8.000

Knob Parameter Adjustment Setting values

4 No Width of 
blocks

0.000 to 100.000

5 Phase Partition 
position

–8.000 to +8.000

Knob Parameter Adjustment Setting values

1 H Horizontal 
center 
position

–8.000 to +8.000 a)

–32.000 to 
+32.000 b)

2 V Vertical 
center 
position

–6.000 to +6.000 a)

–18.000 to 
+18.000 b)
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b) Setting for HD 4:3, HD 16:9

Split Settings

You can set the degree to which the image is split, the split 
positions, and other parameters.

To apply the Split effect
With the Split menu displayed, use the following 
procedure.

1 In the <Mode> group, select the split method.

Single: Leave gaps between splits.
Double: Fill gaps between splits with the same image.

2 Set the following parameters.

To set the split position

1 Press [Position].

2 Set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Split Slide Settings

You can set the degree of transition, the degree of 
randomness in the distance moved by each block, the 
degree of sliding, block width, block angle, and other 
parameters.

To apply the Split Slide effect
With the Split Slide menu displayed, set the following 
parameters.

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Transition 
H

Degree of 
left and right 
separation 

–100.00 to 
+100.000

2 Transition 
V

Degree of 
top and 
bottom 
separation

–100.00 to 
+100.000

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Top Amount of 
movement of 
top

–100.00 to 
+100.000

2 Left Amount of 
movement of 
left

–100.00 to 
+100.000

3 Right Amount of 
movement of 
right

–100.00 to 
+100.000

4 Bottom Amount of 
movement of 
bottom

–100.00 to 
+100.000

Knob Parameter Adjustment Setting values

1 H Degree of 
left and right 
separation 

–4.000 to +4.000 a)

–16.000 to 
+16.000 b)

2 V Degree of 
top and 
bottom 
separation

–3.000 to +3.000 a)

–12.000 to 
+12.000 b)

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Transition H Degree of 
transition in 
horizontal 
direction

–100.00 to 
+100.000

2 Random H Degree of 
randomness in 
distance 
moved by 
blocks in 
horizontal 
direction 

0.00 to 100.00

3 Skew H Degree of skew 
in horizontal 
direction

0.00 to 100.00

4 Width H Horizontal 
width of 
partition

0.00 to 100.00

5 Angle Angle of 
partition line

–8.000 to 
+8.000

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Transition V Degree of 
transition in 
vertical 
direction

–100.00 to 
+100.000

2 Random V Degree of 
randomness in 
distance 
moved by 
blocks in 
vertical 
direction 

0.00 to 100.00

3 Skew V Degree of skew 
in vertical 
direction

0.00 to 100.00

Knob Parameter Adjustment Setting values
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To set the partition position 

1 Press [Position], turning it on.

2 Set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Mirror Settings

You can choose to reflect in the directions left to right, 
right to left, bottom to top, top to bottom, or any 
combination of directions. You can also set the position of 
the border between original and reflections.

To apply the Mirror effect
With the Mirror menu displayed, press [Left to Right], 
[Right to Left], [Top to Bottom], or [Bottom to Top] to set 
the reflection method (multiple selections possible).
Left to Right: Reflect left side on right.
Right to Left: Reflect right side on left.
Top to Bottom: Reflect top side on bottom.
Bottom to Top: Reflect bottom side on top.

To set the position of the border between original 
and reflection

1 Press [Position].

2 Set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Multi Mirror Settings

You can set the width of the original, the center position of 
the original, the offset of the image with fixed mirrors, the 
direction of the mirrors, and other parameters.

To apply the Multi Mirror effect
With the Multi Mirror menu displayed, set the following 
parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

To set the center position of original image

1 Press [Position], turning it on.

2 Set the following parameters.

4 Width V Vertical width 
of partition

0.00 to 100.00

5 Angle Angle of 
partition line

–8.000 to 
+8.000

Knob Parameter Adjustment Setting values

1 H Horizontal 
partition 
position 

–5.000 to +5.000 a)

–20.000 to 
+20.000 b)

2 V Vertical 
partition 
position

–5.000 to +5.000 a)

–20.000 to 
+20.000 b)

Parameter group [2/2]

Knob Parameter Adjustment Setting values

Left to Right Top to Bottom

Knob Parameter Adjustment Setting values

1 H Horizontal 
border 
position

–8.000 to +8.000 a)

–32.000 to 
+32.000 b)

2 V Vertical 
border 
position 

–6.000 to +6.000 a)

–24.000 to 
+24.000 b)

Knob Parameter Adjustment Setting values

1 Interval H Horizontal 
distance 
between 
mirrors 
(original width) 

0.000 to 10.000 a)

0.000 to 40.000 b)

2 Offset H Amount of 
horizontal 
offset of image 
with mirrors 
fixed

–4.000 to +4.000 a)

–16.000 to 
+16.000 b)

3 Interval V Vertical 
distance 
between 
mirrors 
(original width) 

0.000 to 10.000 a)

0.000 to 40.000 b)

4 Offset V Amount of 
vertical offset 
of image with 
mirrors fixed

–4.000 to +4.000 a)

–16.000 to 
+16.000 b)

5 Angle Mirror angle –8.000 to +8.000

Knob Parameter Adjustment Setting values

1 H Horizontal 
original 
image 
center 
position 

–4.000 to +4.000 a)

–16.000 to +16.000 b)
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a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Kaleidoscope Settings

You can set the number of blocks, the partition reference 
point and angle, horizontal and vertical offsets, a reflection 
position, and other parameters. 

To apply the Kaleidoscope effect
With the Kaleidoscope menu displayed, set the following 
parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

To reflect the kaleidoscope image as if in a mirror

1 To reflect in the horizontal direction, press [Mirror H], 
turning it on.

2 To reflect in the vertical direction, press [Mirror V], 
turning it on.

To set the reflection position 

1 Press [Position], turning it on.

2 Set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

To cyclically repeat part of the original and its 
reflection
Press [Cyclic], turning it on.

Lens Settings

You can set the shape and aspect ratio of the lens, the 
angle, the magnification ratio, the curve ratio, the size, the 
center position, and other parameters. 
You can also choose to display only the portion of the 
image that is seen through the lens.

To apply the Lens effect
With the Lens menu displayed, use the following 
procedure.

1 In the <Mode> group, select the lens shape.

• Circle
• Rectangle
• Star
• Heart
• Bar
• Cross

2 Depending on the selected lens shape, set the 
following parameters.

When Circle, Rectangle, Star, or Heart is selected

When Bar is selected

When Cross is selected

2 V Vertical 
original 
image 
center 
position

–4.000 to +4.000 a)

–16.000 to 
+16.000 b)

Knob Parameter Adjustment Setting values

1 Number Number of 
blocks 

0.00 to 100.00

2 Phase Angle of 
partition 
reference point

–8.000 to +8.000

3 Offset H Amount of 
horizontal 
offset

–4.000 to +4.000 a)

–16.000 to +16.000 b)

4 Offset V Amount of 
vertical offset

–3.000 to +3.000 a)

–12.000 to +12.000 b)

Knob Parameter Adjustment Setting values

1 H Horizontal 
reflection 
position 

0.000 to 4.000 a)

0.000 to 16.000 b)

2 V Vertical 
reflection 
position 

0.000 to 3.000 a)

0.000 to 12.000 b)

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Magnify H Magnification 
ratio

–100.00 to +100.00

2 Curve H Curve ratio –100.00 to +100.00

3 Size H Size 0.00 to 100.00

4 Angle Slant angle –8.000 to +8.000

5 Aspect Aspect ratio –100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Magnify H Magnification 
ratio

–100.00 to +100.00

2 Curve H Curve ratio –100.00 to +100.00

3 Size H Size 0.00 to 100.00

4 Angle Slant angle –8.000 to +8.000

Parameter group [1/2]

Knob Parameter Adjustment Setting values

1 Magnify H Horizontal 
magnification 
ratio

–100.00 to +100.00

2 Curve H Horizontal 
curve ratio

–100.00 to +100.00
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To make only the lens part visible
Press [Lens Only], turning it on.
The parts of the image outside the lens are removed.

To set the lens center position 

1 Press [Position], turning it on.

2 Set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Circle Settings

You can set the size of the circle, and make the axis of 
modulation vertical.

To apply the Circle effect
With the Circle menu displayed, set the following 
parameters.

To make the axis of modulation vertical
Press [Mod V], turning it on.
The axis of modulation when converting to the circle 
becomes vertical.

Panorama Settings

You can set the horizontal and vertical curve ratio, and the 
curve center position.

To apply the Panorama effect
With the Panorama menu displayed, set the following 
parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Page Turn Settings

There are four modes: H&V, H, V, and Off. You can select 
the turn position, the radius of the turned portion, the 
amount and angle of turning, and the input video for the 
front and back pages. 

To apply the Page Turn effect
With the Page Turn menu displayed, use the following 
procedure.

1 In the <Split Mode> group, select the split mode.

H&V: The image turns as it is split from the center 
into 4 parts: left, right, upper, lower.

H: The image turns as it is split from the center into 2 
parts: left, right.

V: The image turns as it is split from the center into 2 
parts: upper, lower.

When nothing is selected (Off): There are no splits 
and the image turns from the edge.

2 Press [Page Turn], then set the following parameters.

3 Size H Horizontal 
size

0.00 to 100.00

Parameter group [2/2]

Knob Parameter Adjustment Setting values

1 Magnify V Vertical 
magnification 
ratio

–100.00 to +100.00

2 Curve V Vertical 
curve ratio

–100.00 to +100.00

3 Size V Vertical size 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Horizontal 
lens center 
position 

–5.000 to +5.000 a)

–20.000 to +20.000 b)

2 V Vertical lens 
center 
position 

–4.000 to +4.000 a)

–16.000 to +16.000 b)

Knob Parameter Adjustment Setting values

1 Radius Size of circle 0.00 to 100.00

Parameter group [1/2]

Knob Parameter Adjustment Setting values

Knob Parameter Adjustment Setting values

1 Curve H Horizontal curve 
ratio

–100.00 to +100.00

2 Curve V Vertical curve 
ratio

–100.00 to +100.00

3 Position H Horizontal curve 
center position

–4.000 to +4.000 a)

–16.000 to 
+16.000 b)

4 Position V Vertical curve 
center position

–3.000 to +3.000 a)

–12.000 to 
+12.000 b)

Knob Parameter Adjustment Setting values

1 Radius Radius of 
turn part

0.00 to 100.00

2 Offset Amount of 
turn

–100.00 to +100.00
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a) When split mode is H&V
b) When split mode is H
c) When split mode is V
d) When split mode is off

To set the input signal of the back page

1 In the <Back Video> group, select the signal input into 
the back page.

Self: Use the same signal as the front page.
Flat: Use a flat color.
Hue Rotation: Gradually vary the hue.
2nd Ch: Use the 2nd channel video signal.

To select “2nd Ch,” it is first necessary to select 
the second DME on the keyer using DME. 

2 Adjust the following parameters, according to the 
selected input signal.

When Flat is selected

When Hue Rotation is selected

When using a page turn effect with one channel, the 
following restrictions apply.
• In an MVE-8000A HD system, when the input is for 

example a title, parts of the back page other than the title 
appear as black.

• For the MKS-7470X/7471X, the same restrictions as 
above apply to all signal formats.

Roll Settings

There are four modes: H&V, H, V, and Off. You can select 
the turn position, the radius of the turned portion, the 
amount and angle of turning, and the input video for the 
front and back pages. 

To apply the Roll effect
Display the Roll menu.
The knobs in the Roll menu have the same functions as 
those in the Page Turn menu (see page 311).

When using a roll effect with one channel, the following 
restrictions apply.
• In an MVE-8000A HD system, when the input is for 

example a title, parts of the back page other than the title 
appear as black.

• For the MKS-7470X/7471X, the same restrictions as 
above apply to all signal formats.

Cylinder Settings

You can set the degree of winding onto the cylinder, the 
radius, the horizontal position of the wound image, and 
front and back side output for the image.

To apply the Cylinder effect
With the Cylinder menu displayed, set the following 
parameters.

The procedure for selecting the input signal in the <Back 
Video> group is the same as for the Page Turn menu (see 
page 311).

When using a cylinder effect with one channel, the 
following restrictions apply.
• In an MVE-8000A HD system, when the input is for 

example a title, parts of the inner surface other than the 
title appear as black.

• For the MKS-7470X/7471X, the same restrictions as 
above apply to all signal formats.

3 Angle Angle of turn –0.250 to +0.000 a)

–0.250 to +0.250 b)

–0.500 to +0.000 c)

–8.000 to +8.000 d)

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Speed Speed at 
which hue 
changes

–12.00 to +12.00

Notes 

Knob Parameter Adjustment Setting values

Notes 

Knob Parameter Adjustment Setting values

1 Radius Degree to 
which image is 
wound onto the 
cylinder 

0.00 to 100.00

2 Min R Radius of the 
cylinder 

0.00 to 100.00

3 Offset Horizontal 
position of the 
image wound 
onto cylinder

–100.00 to 
+100.00

Notes 
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Sphere Settings

You can set the degree of winding onto the sphere, the 
radius, the horizontal position of the wound image, and 
front and back side output for the image.

You cannot monitor the part of a rotating sphere that 
corresponds to its axis on the monitor screen.

To apply the Sphere effect
Display the Sphere menu.
The knobs in the Sphere menu have the same functions as 
those in the Cylinder menu “Cylinder Settings” (page 
312).

When using a sphere effect with one channel, the 
following restrictions apply.
• In an MVE-8000A HD system, when the input is for 

example a title, parts of the inner surface other than the 
title appear as black.

• For the MKS-7470X/7471X, the same restrictions as 
above apply to all signal formats.

Explosion Settings

You can set the pattern shape and aspect ratio, the center 
position, the amount of movement by fragments, the 
curvature of the transition path, and other parameters.

To apply the Explosion effect
With the Explosion menu displayed, use the following 
procedure.

1 In the <Mode> group, select the explosion pattern.

• Circle
• Rectangle
• Star
• Heart
• Ellipse

2 Set the following parameters.

When Circle was selected in step 1

When Rectangle, Star, Heart, or Ellipse was 
selected in step 1

To make the fragments stardust

1 Press [Pixel], turning it on.

2 Set the following parameters.

To set the explosion center point

1 Press [Position], turning it on.

2 Set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Swirl Settings

You can set the amount of swirl, the swirl region, the 
amount of rotation, and the swirl center position.

Notes 

Notes 

Knob Parameter Adjustment Setting values

1 Transition Degree of 
transition

0.00 to 100.00

2 Curve Degree to 
which image 
periphery 
expands

0.00 to 100.00

3 Spiral Degree of 
curvature of 
transition 
path

–100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Transition Degree of 
transition

0.00 to 100.00

2 Curve Degree to 
which image 
periphery 
expands

0.00 to 100.00

3 Aspect Aspect ratio 
of waveform

–100.00 to +100.00

4 Angle Slant of 
waveform

–8.000 to +8.000

Knob Parameter Adjustment Setting values

1 Density Degree to 
which image 
disappears

0.00 to 100.00

2 Random Degree of 
randomness 
in flying out 
fragment 
positions

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Center point 
in horizontal 
direction

–5.000 to +5.000 a)

–20.000 to +20.000 b)

2 V Center point 
in vertical 
direction

–4.000 to +4.000 a)

–16.000 to +16.000 b)

Knob Parameter Adjustment Setting values
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To apply the Swirl effect
With the Swirl menu displayed, set the following 
parameters.

To make the tip of the swirl stardust

1 Press [Pixel], turning it on.

2 Set the following parameters.

To set the center position of the swirl

1 Press [Position], turning it on.

2 Set the following parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

Melt Settings

You can set the degree of transition, the degree of 
extension in the image, the jaggedness of the melting 
sections, and the amplitude, frequency, amount of 
movement, and speed of the melting sections. You can also 
set the slant of the borders, the shape of the sections that 
begin to melt, and other parameters.

To apply the Melt effect
With the Melt menu displayed, use the following 
procedure.

1 In the <Direction> group, select the direction in which 
the image melts away.

Up: Melting occurs upward.
Down: Melting occurs downward.

2 To make transition settings, press [Transition] and set 
the following parameters.

3 To make wave settings for melting part, press [Border] 
and set the following parameters.

a) Set when Lock is on.
b) Set when Lock is off.
c) Setting for SD 4:3, SD 16:9
d) Setting for HD 4:3, HD 16:9

To stop the waves in the melting part
Press [Lock], turning it on.
With each press, the waves alternately stop and start 
moving again.

To select the shape of the part beginning to melt
Press [Form] and set the following parameter.

a) 1 (SINE): Sine wave
2 (PARABOLA): Parabola wave
3 (TRIANGLE): Triangular wave
4 (RECTANGLE): Rectangular wave

Knob Parameter Adjustment Setting values

1 Transition Swirl amount 0.00 to 100.00

2 Center Amount of 
rotation in 
center of swirl

–8.000 to 
+8.000

3 Outer Amount of 
rotation outside 
of Area

–8.000 to 
+8.000

4 Area Region of swirl 0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Density Degree to 
which image 
disappears

0.00 to 100.00

2 Random Trail type and 
amount of 
stardust

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 H Horizontal 
center 
position of 
swirl

–8.000 to +8.000 a)

–32.000 to +32.000 b)

2 V Vertical 
center 
position of 
swirl

–6.000 to +6.000 a)

–18.000 to +18.000 b)

Knob Parameter Adjustment Setting values

1 Transition Degree of 
transition

0.00 to 100.00

2 Curve Degree to 
which image 
stretches

0.00 to 100.00

3 Random Degree of 
jaggies at 
melted part

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Amp Amplitude of 
waves

0.00 to 100.00

2 Freq Frequency 
of waves

0.00 to 100.00

3 Offset a) Amount of 
wave phase 
offset

–16.000 to +16.000 c)

–64.000 to +64.000 d)

4 Speed b) Direction 
and speed 
of waves

–100.00 to +100.00

5 Slant Slant of 
border

–100.00 to +100.00

Knob Parameter Adjustment Setting values

1 Form Waveform 1 to 8 a)
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5 (CIRCLE): Circular wave
6 (CUBIC): Cubic wave
7 (MELT1): Melting wave 1
8 (MELT2): Melting wave 2

To make the melting part stardust

1 Press [Pixel], turning it on.

2 Set the following parameters.

Character Trail Settings

You can set the effect starting position, the degree of 
expansion, the slant angle of the effect region, and trail 
direction, the degree to which the image disappears, the 
trail type and amount of stardust, and other parameters.

To apply the Character Trail effect
With the Character Trail menu displayed, set the following 
parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

To make the tip of the swirl stardust

1 Press [Pixel], turning it on.

2 Set the following parameters.

Knob Parameter Adjustment Setting values

1 Density Degree to 
which image 
disappears

0.00 to 100.00

2 Random Degree to 
which pixel 
positions 
become 
more 
randomized 
further from 
the center

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Transition Position where 
effect starts

–8.000 to 
+8.000 a)

–32.000 to 
+32.000 b)

2 Expand Degree of 
expansion

0.00 to 100.00

3 Trans Angle Angle of 
slanting in 
effect region

–8.000 to 
+8.000

4 Trail Angle Direction of trail –100.00 to 
+100.00

Knob Parameter Adjustment Setting values

1 Density Degree to 
which image 
disappears

0.00 to 100.00

2 Random Trail type and 
amount of 
stardust

0.00 to 100.00
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Applying Special Effects 
(Lighting and Recursive 
Effects)

Lighting Settings

You can specify the intensity and color of the light and the 
lighting pattern. The following lighting patterns are 
available:
Plane: Illumination of the entire screen.
Bar: Bar illumination. You can specify the width and 

angle of the bar, and its softness.
Preset: Lighting pattern suitable for nonlinear effects.
When Bar is selected, the following modes can be selected.
Normal: Emphasizes the bar highlight area.
Specular: An effect like light striking a surface with 

metallic reflections.
Mat: An effect like light striking paper, cloth, or another 

diffusively reflective surface.

The function for setting the bar mode of the lighting area 
is not supported on the MVE-8000A.

Applying the Lighting effect

1 In the DME menu, select VF5 ‘Light/Trail’ and HF1 
‘Lighting.’

The Lighting menu appears.

2 Press [Lighting], turning it on.

3 In the <Light Pattern> group, select the lighting 
pattern Plane, Bar or Preset.

4 Set the parameters.

The parameters differ as follows, depending on the 
selected lighting pattern.

When Plane is selected

a) You can make the Lighting effect more effective by adjusting [Total 
Ambient] to lower the brightness of the entire image. This setting is 
used both by this effect and by the Spotlighting effect.

The Total Ambient parameter is not supported on the 
MVE-8000A. 

When Bar is selected

a) You can make the Lighting effect more effective by adjusting [Total 
Ambient] to lower the brightness of the entire image. This setting is 
used both by this effect and by the Spotlighting effect.

The Total Ambient parameter is not supported on the 
MVE-8000A. 

When Preset is selected

a) Setting is available when nonlinear effect page turn, roll, cylinder, or 
sphere is selected. 

b) You can make the Lighting effect more effective by adjusting [Total 
Ambient] to lower the brightness of the entire image. This setting is 
used both by this effect and by the Spotlighting effect.

The Total Ambient parameter is not supported on the 
MVE-8000A. 

Notes 

Knob Parameter Adjustment Setting values

1 Light Intensity of 
light in 
highlight 
area

0.00 to 100.00

5 Total 
Ambient

Brightness of 
whole image

0.00 to 100.00 a)

Notes 

Knob Parameter Adjustment Setting values

1 Light Intensity of 
light in 
highlight 
area

0.00 to 100.00

2 Ambient Intensity of 
light in 
ambient area

0.00 to 100.00

5 Total 
Ambient

Brightness of 
whole image

0.00 to 100.00 a)

Notes 

Knob Parameter Adjustment Setting values

1 Light Intensity of 
light in 
highlight 
area

0.00 to 100.00

2 Ambient Intensity of 
light in 
ambient area

0.00 to 100.00

3 Shade Intensity of 
light in shade 
area

0.00 to 100.00 a)

5 Total 
Ambient

Brightness of 
whole image

0.00 to 100.00 b)

Notes 
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The three regions for which the light intensity can be set

Setting the bar shape of the highlight area
When you select [Bar] or [Preset] in step 3 of “Applying 
the Lighting effect” (page 316), use the following 
procedure to set the shape of the bar.

1 Turn [Light Modify] on.

2 Adjust the following parameters.

a) For SD 4:3
b) For SD 16:9
c) For HD 4:3
d) For HD 16:9
e) There are some nonlinear effects for which Angle cannot be used.

Bar shape parameters

Setting the color of the light in the 
highlight area

1 Turn [Light Color] on.

2 Adjust the following parameters.

Setting the bar shape of the shade area
When you select [Preset] in step 3 of “Applying the 
Lighting effect” (see page 316), use the following 
procedure to set the bar shape of the shade area.

1 Turn [Shade Modify] on.

2 Adjust the following parameters.

a) For SD 4:3 and SD 16:9
b) For HD 4:3
c) For HD 16:9

Setting the color of the shade in the shade 
area

1 Turn [Shade Color] on.

2 Adjust the following parameters.

Setting the bar mode of the highlight area
When you select [Bar] in step 3 of “Applying the Lighting 
effect” (page 316), use the following procedure to set the 
bar mode of the highlight area. 

The bar mode of the highlight area is not supported on the 
MVE-8000A. 

1 Select the mode in the <Bar Light Mode> group. 

Normal: Emphasizes the bar highlight area. 
Specular: An effect like light striking a surface with 

metallic reflections.

Knob Parameter Adjustment Setting values

1 X X-value of 
bar center 
point

–8.00 to +8.00 a) b)

–24.00 to +24.00 c)

–32.00 to +32.00 d)

2 Y Y-value of 
bar center 
point

–6.00 to +6.00 a)

–4.50 to +4.50 b)

–18.00 to 
+18.00 c) d)

3 Angle e) Angle of bar –8.00 to +8.00

4 Width Width of bar 0.00 to 100.00

5 Soft Softness of 
edges

0.00 to 100.00

Highlight 
area

Ambient 
area

Shade 
area

Center point 
of bar

Bar width

Bar angle

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 X X-value of 
bar center 
point

–8.00 to +8.00 a)

–24.00 to +24.00 b)

–32.00 to +32.00 c)

4 Width Width of bar 0.00 to 100.00

5 Soft Softness of 
edges

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Notes 
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Mat: An effect like light striking paper, cloth, or 
another diffusively reflective surface. 

2 Set the following parameters.

a) For SD 4:3 and SD 16:9
b) For HD 4:3
c) For HD 16:9

3 When you select Normal or Mat in step 1, press [Bar 
Diffuse Color], turning it on, and adjust the following 
parameters to set the color of the diffuse light area. 

Trail Settings

• Of the three effects of trail, motion decay and keyframe 
strobe, only one can be on at a time. When one of them 
is on, turning another of them on automatically turns off 
the one that has been on.

• Turning Trail on when Motion Decay (see page 320), 
Keyframe Strobe (see page 321) or Wind (see page 322) 
is on turns it off automatically.

Applying the Trail effect

1 In the DME menu, select VF5 ‘Light/Trail’ and HF2 
‘Trail.’

The Trail menu appears.

2 Press [Trail], turning it on.

3 Set the parameters.

a) 0.00 is no trail. At 100.00, the trail does not disappear.

4 To erase the trail, press [Trail Eraser], turning it on.

Switching the priority between the current 
image and trail superimposed
In the <Priority> group, select the method of 
superimposition.
Over: Current image is on top.
Under: Trail is on top.

Selecting the source to create a trail
In the <Trail Source> group, select the source to create a 
trail.

Knob Parameter Adjustment Setting values

1 Intensity Intensity of 
diffuse light 
area

0.00 to 100.00

2 Offset Offset of 
center of 
diffuse light 
area

–4.00 to +4.00 a)

–12.00 to +12.00 b)

–16.00 to +16.00 c)

3 Width Width of 
diffuse light 
area

0.00 to 100.00

4 Soft Softness of 
diffuse light 
area

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

With no selection 
made in the <Bar 
Light Mode> group

Width

Bar Light

With a selection made in 
the <Bar Light Mode> 
group

Diffuse Light

Diffuse Light

Bar Light

Offset = 0

Notes 

Knob Parameter Adjustment Setting values

1 Decay Degree to 
which the 
trail is left

0.00 to 100.00 a)

2 Interval Freeze 
interval

1 to 255 (frames)

3 Live Proportion of 
the interval 
between two 
successive 
freeze 
images for 
which the 
video is run

0.00 to 100.00
Applying Special Effects (Lighting and Recursive Effects)
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• “Rainbow,” “Mix Color,” and “Ext Video” are not 
supported on the MVE-8000A.

• “Mix Color” or “Ext Video” can only be applied to one 
of the background (see page 331), flex shadow (see page 
283), trail, and wind (see page 322) effects.
If you select “Mix Color” or “Ext Video” in one of these 
settings, a selection of “Mix Color” or “Ext Video” in 
any of the other effects is disabled, and “Flat Color” is 
selected in its place.

• When executing combining four channels of DME 
images, “Mix Color” and “Ext Video” in the flex shadow 
and background effects cannot be selected.

Freeze Video: Use freeze images of the input video as 
source of the trail.

Flat Color: Use a flat color matte as source of the trail. 
You can set the following parameters with the knobs.

Hue Rotate: Use a color matte whose hue varies slightly 
with each frame for the trail of the afterimages. You 
can set the following parameters with the knobs.

Mix Color: Insert a mix color signal set in the Color Mix 
menu (see page 289) in the afterimage portion.

Ext Video: Insert the external video signal input to the Ext 
IN connector in the afterimage portion.

Rainbow: Use a freeze image with the hue changing every 
frame in the afterimage portion. The difference from 
“Hue Rotate” is that many colors appear 
simultaneously.

For details of the Rainbow parameters, see the “Hue 
Rotate” item above.

Erasing the afterimages that remain in 
memory whenever a keyframe is passed
Press [Trail Eraser], turning it on. 
When the effect passes a keyframe, the afterimage is 
erased before writing a new afterimage.

Selecting the freeze timing
In the <Trail Freeze Timing> group, select the timing for 
freezing a trail.
Frame: freeze in frame units.
Field: freeze in field units.

The freeze timing setting is not required when the 
following signal formats are being used. 

Signal formats: 1080P/50, 1080P/59.94, 1080PsF/
23.976,1080PsF/24, 1080PsF/25, 1080PsF/29.97, 
720P/50, 720P/59.94

Defocusing the afterimage portion 
(Defocus)
 

The function to defocus the trail afterimage portion is not 
supported on the MVE-8000A.

1 Press [Defocus], turning it on.

2 Set the following parameters.

Applying stardust to the afterimage 
portion
The afterimage portion becomes stardust, and gradually 
disappears.

1 Press the [DUST] button, turning it on.

2 Set the following parameters.

Notes 

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue 
Speed

Speed at 
which the 
hue changes

–12.00 to +12.00

Notes 

Notes 

Knob Parameter Adjustment Setting values

1 Defocus V Defocusing 
of the video 
signal

0.00 to 100.00

2 Defocus K Defocusing 
of the key 
signal

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Trail Dust Amount of 
the 
afterimage 
disappearing 
as stardust a)

0.00 to 100.00

2 Dust Soft Timing with 
which 
stardust 
disappears

0.00 to 100.00

3 Dust Size Size of 
stardust

0.00 to 100.00
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a) The way in which the afterimage disappears is affected by both 
Decay and Trail Dust parameter adjustments.

Setting a combine process
Select whether to add the Trail effect before or after the 
combine. 

• The combine process function is not supported on the 
MVE-8000A.

• When you change the selection in the <Combine 
Process> group, the afterimages which had been added 
up to then disappear.

• When you do not combine images, the Trail effect only 
is applied, regardless of the selection in the <Combine 
Process> group. 

Select one of the following in the <Combine Process> 
group. 
Combine –> Trail: Add the Trail effect after the combine. 

As the trail parameters, the data for the channel with 
the lowest number among the channels being 
combined is enabled.

Trail –> Combine: Add the Trail effect before the 
combine. Trails parameters can be set independently 
for each channel. 

Motion Decay Settings

When you turn on motion decay, if the Trail, Keyframe 
Strobe or Wind effect is on, it automatically goes off.

Blurring image motion

1 In the DME menu, select VF5 ‘Light/Trail’ and HF3 
‘Motion Decay.’

The Motion Decay menu appears.

2 Press [Motion Decay], turning it on.

3 Set the following parameter.

a) At the setting 0.00, there is no afterimage. At a setting of 100.00, the 
afterimage does not decay.

4 In the <Decay Mix Mode> group, select the way in 
which the video signal is blurred.

Soft: mix the live image and the afterimage.
Hard: show the lighter of the live image and 

afterimage.

5 To erase the afterimage, press [Decay Eraser], turning 
it on.

Erasing the afterimages that remain in 
memory whenever a keyframe is passed
Press [Decay Eraser], turning it on.
When the effect passes a keyframe, the afterimage is 
erased before writing a new afterimage.

Selecting the freeze timing
In the <Decay Freeze Timing> group, select the timing for 
motion decay freezing.
Frame: freeze in frame units.
Field: freeze in field units.

The freeze timing setting is not required when the 
following signal formats are being used. 

1080P/50, 1080P/59.94, 1080PsF/23.976, 
1080PsF/24, 1080PsF/25, 1080PsF/29.97, 720P/
50, 720P/59.94

Applying stardust to the afterimage 
portion
The afterimage portion becomes stardust, and gradually 
disappears.

1 Press the [DUST] button, turning it on.

2 Set the following parameters.

4 Dust 
Aspect

Aspect ratio 
of stardust

–100.00 to +100.00

Notes 

Notes 

Knob Parameter Adjustment Setting values

Combine –> Trail Trail –> Combine

Knob Parameter Adjustment Setting values

1 Video 
Decay

Degree of 
blurring of the 
video signal

0.00 to 100.00 a)

Notes 

Knob Parameter Adjustment Setting values

1 Decay 
Dust

Amount of the 
afterimage 
disappearing as 
stardust a)

0.00 to 100.00
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a) The way in which the afterimage disappears is affected by both the 
Video Decay and Decay Dust parameter adjustments for the motion 
decay.

Keyframe Strobe Settings

When you turn on keyframe strobe, if the Trail, Motion 
Decay or Wind effect is on, it automatically goes off.

For details, see “Note” in the section “Trail.”

Leaving a trail of afterimages of the image

1 In the DME menu, select VF5 ‘Light/Trail’ and HF4 
‘KF Strobe.’

The KF Strobe menu appears.

2 Press [KF Strobe], turning it on.

3 Set the following parameter.

a) At the setting 0.00, there is no afterimage. At a setting of 100.00, the 
afterimage does not decay.

4 To erase the afterimage, press [KF Strobe Eraser], 
turning it on.

Selecting the overlay priority for movie and 
still images (video freeze image)
In the <Priority> group, select the way in which the images 
are overlaid.
Over: the movie is on top, and the still image is 

underneath.
Under: the movie is underneath, and the still image is on 

top.
Mix: the movie and still images are mixed; adjust the 

following parameter with the knob.

a) The 0.00 setting is the same as Over, and the 100.00 is the same as 
Under.

Selecting the freeze timing
In the <KF Freeze Timing> group, select the timing for 
freezing the keyframe strobe.
Frame: freeze in frame units.
Field: freeze in field units.

The freeze timing setting is not required when the 
following signal formats are being used. 

1080P/50, 1080P/59.94, 1080PsF/23.976, 
1080PsF/24, 1080PsF/25, 1080PsF/29.97, 720P/
50, 720P/59.94

Erasing the afterimages that remain in 
memory whenever a keyframe is passed
Press [KF Strobe Eraser], turning it on.
When the effect passes a keyframe, the afterimage is 
erased before writing a new afterimage.

Applying stardust to the afterimage 
portion
The afterimage portion becomes stardust, and gradually 
disappears.

1 Press the [DUST] button, turning it on.

2 Set the following parameters.

a) The way in which the afterimage disappears is affected by both the 
Decay and KF Strobe Dust parameter adjustments for the keyframe 
strobe.

2 Dust Soft Timing with 
which stardust 
disappears

0.00 to 100.00

3 Dust Size Size of stardust 0.00 to 100.00

4 Dust 
Aspect

Aspect ratio of 
stardust 

–100.00 to 
+100.00

Notes 

Knob Parameter Adjustment Setting values

1 Decay Degree of 
blurring of the 
video signal

0.00 to 100.00 a)

Knob Parameter Adjustment Setting values
Knob Parameter Adjustment Setting values

1 Mix Mix amount of 
the still image 
with respect to 
the movie

0.00 to 100.00 a)

Notes 

Knob Parameter Adjustment Setting values

1 KF Strobe 
Dust

Amount of the 
afterimage 
disappearing as 
stardust a)

0.00 to 100.00

2 Dust Soft Timing with 
which stardust 
disappears 

0.00 to 100.00

3 Dust Size Size of stardust 0.00 to 100.00

4 Dust 
Aspect

Aspect ratio of 
stardust 

–100.00 to 
+100.00
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Disabling the keyframe strobe afterimage
Press [KF Strobe Disable], turning it on.
If you turn this function on when creating a keyframe, even 
as the effect passes a keyframe, no afterimage remains.

Setting a combine process
Select whether to add the Keyframe Strobe effect before or 
after the combine. 

• The combine process function is not supported on the 
MVE-8000A.

• When you change the selection in the <Combine 
Process> group, the afterimages which had been added 
up to then disappear.

• When you do not combine images, the Keyframe Strobe 
effect only is applied, regardless of the selection in the 
<Combine Process> group.

Select one of the following in the <Combine Process> 
group. 
Combine –> KF STRB: Add the Keyframe Strobe effect 

after the combine. 
As parameters, the data for the channel with the lowest 
number among the channels being combined is 
enabled.

KF STRB –> Combine: Add the Keyframe Strobe effect 
before the combine. 
Parameters can be set independently for each channel. 

Wind Settings

• The wind function is not supported on the MVE-8000A.
• When wind is turned on, any of the following effects that 

are on are turned off.
- Trail
- Motion decay
- Keyframe strobe

Applying the wind effect

1 In the DME menu, select VF5 ‘Light/Trail’ and HF5 
‘Wind.’

The Wind menu appears.

2 Press [Wind], turning it on.

3 Set the following parameters.

a) 0.00 represents no afterimage, and 100.00 represents no decay in the 
afterimage.

4 To erase the afterimages, press [Wind Eraser], turning 
it on.

Selecting the signal for the afterimage 
portion
In the <Wind Source> group, select the image to fill the 
afterimage portion.

• “Mix Color” or “Ext Video” can only be applied to one 
of the background (see page 331), flex shadow (see page 
283), trail (see page 318), and wind effects.
If you select “Mix Color” or “Ext Video” in the wind 
settings, a selection of “Mix Color” or “Ext Video” in 
any of the other effects is disabled, and “Flat Color” is 
selected in its place.

• When executing combining four channels of DME 
images, “Mix Color” and “Ext Video” cannot be 
selected.

Freeze Video: Freeze the input image to use as the 
afterimage.

Flat Color: Use a single color matte for the afterimage; 
you can set the following parameters with the knobs.

Hue Rotate: Use a single color matte with the hue 
changing for each frame as the afterimage; you can set 
the following parameters with the knobs.

Mix Color: Insert a mix color signal (see page 289) in the 
afterimage portion.

Notes 

Notes 

Knob Parameter Adjustment Setting values

1 Decay Amount of 
afterimage 
displayed

0.00 to 100.00 a)

2 Shift H Extension in the 
horizontal 
direction

–100.00 to 
+100.00

3 Shift V Extension in the 
vertical 
direction

–100.00 to 
+100.00

Notes 

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue 
Speed

Rate at which 
hue changes

–12.00 to +12.00
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Ext Video: Insert the external video signal input to the Ext 
IN connector in the afterimage portion.

Rainbow: Use a freeze image with the hue changing every 
frame in the afterimage portion. The difference from 
“Hue Rotate” is that many colors appear 
simultaneously.

For details of the Rainbow parameters, see the “Hue 
Rotate” item above.

Applying modulation to the afterimage 
portion (Modulation)

1 In the Wind menu, press [Modulation], turning it on.

2 Set the following parameters.

For details of Priority, Wind Freeze Timing, Wind 
Eraser, Defocus, Dust, and Combine Process in the 
Wind menu, see “Trail Settings” (page 318).

Spotlighting Settings

You can set up to three light sources (lights 1 to 3).

• The Spotlighting effect is not supported on the MVE-
8000A.

• The BZDM-9050 Texture Lighting Software (for MVE-
9000) is required to set lights 2 and 3.

• When the global effect Combiner is enabled, the settings 
of the smallest-numbered channel selected for the 
Combiner are used.

Adjustments to the image surface
The following adjustments can be made to the image 
surface struck by the light.
• Adjusting the brightness of the whole image
• Selecting the image surface effect
• Test sphere function
• Adjusting the bumpiness of the image surface

• Coordinate axis on surface of image
• Texture deformations

Selecting the image surface effect
Flat: The image surface is unchanged, causing the selected 

light source to appear as the effect.
Texture: A texture appears on the surface of the image. 

Textures can be selected from among 30 patterns (see 
page 393).

Non Linear: Spotlighting effect is applied to an area to 
which a DME nonlinear effect is applied. 

The BZDM-9050 is required to enable Texture and Non 
Linear settings on the MVE-9000.

Test sphere function
A test sphere is a translucent sphere virtually embedded in 
the center of the input picture to provide an intuitive way 
for you to check the position and direction of the spotlight. 
When you change the position or direction of a light 
source, the side of the sphere closest to the light source 
grows brighter. You can easily check the position and 
direction of the light source by viewing the test sphere (see 
page 325).

Coordinate axis on surface of image 
Specify where to apply the texture or test sphere on the 
image surface.
Move: The texture moves together with the DME image.

Fix: The texture does not move, even if the DME image 
moves.

Texture deformations
You can change the texture pattern, position, and size, and 
use the repetition function.
The following figure shows examples of a texture pattern 
repeated in the X and Y directions.

Knob Parameter Adjustment Setting values

1 Amp H Horizontal 
amplitude of the 
wave

0.00 to 100.00

2 Freq H Horizontal 
frequency of 
the wave

–100.00 to 
+100.00

3 Amp V Vertical 
amplitude of the 
wave

0.00 to 100.00

4 Freq V Vertical 
frequency of 
the wave

–100.00 to 
+100.00

Notes 

Notes 

Image before movement Coordinate axis = Move
Texture moves together 
with DME image.

Image before movement Coordinate axis = Fix
Texture does not move, even 
if DME image moves.
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Setting lights

Light source types
The following type of light sources are available (see 
figure). 
Parallel: Parallel light source
Point: Point light source. As the light source is placed 

further away, the illuminated range becomes wider 
and the light become weaker.

Line: Line light source
Whole: Non-directional light source which illuminates the 

whole image.

Linking and unlinking image and spotlight
The spotlight can move together with a DME image, or be 
fixed in place.
Source: Place the light source in source coordinate space. 

The spotlight is linked and moves when the image 
moves.

Target: Place the light source in target coordinate space. 
The spotlight does not move, even when the image 
moves.

Selecting the lighted area
You can select the area lit by the spotlight.
FRGD: The light strikes the image foreground.
BKGD: The light strikes the image background.
Both: The light strikes both foreground and background.

Surface Flat
For the currently selected light source only, you can 
forcibly make the image surface effect flat. 
This is effective when you have selected texture as image 
surface effect and want a flat effect for one light source 
only.

Light shape
Creates the light shape.
• Select the shape pattern

For shape patterns, see “Shape Patterns” (page 393).
• Set the size, degree of deformation, softness, and 

rotation.

Original image Repetition in X 
direction

Repetition in Y 
direction

Repetition in X and 
Y directions

Light source Light source

Light source

Parallel Point

Line Whole

Spotlight

Image before movement

Coordinate axis = Source
Spotlight moves together 
with DME image.

Coordinate axis = Target
Spotlight does not move, 
even if DME image moves.

No effect

Background

Foreground Spotlight

FRGD selected

BKGD selected Both selected
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Ring settings
Shines the light with a hole in the middle, like a doughnut. 
Adjust the following parameters.
Offset: Distance to move the center of the ring from the 

initial position (the position set when selecting the 
light source in the <Spot Mode> group).

Radius: Inner side radius of the ring.
Angle: When an Offset is set, the rotation angle of the ring 

around the initial center position. 

Fill blending modes
Specifies the way in which the light is blended with the 
image.
Mix: Light as if reflected from a mirror. The light can be 

given a color.
Multiply: Light as if reflected from a dull surface (diffuse 

reflection).

Relation between test spheres and parallel 
rays
The following figure shows an example of the effect of 
parallel rays on a test sphere.

The direction of a ray is defined by longitude and latitude.
• Longitude: A direction (angle), expressed as a plus value 

for clockwise rotation in the plus direction with respect 
to the X axis of the input picture.

• Latitude: Latitude
The following figure shows the relationships between the 
longitude and latitude of parallel rays, input picture, and 
test sphere.

The unit of these direction parameters is the number of 
rotations, with 360° (1 rotation) expressed as 1.00, in the 
same way as 3D rotation parameters.
The following relationships apply in the example shown in 
the figure.

The fractional part of the setting after the decimal point 
corresponds to an angle 0 to 360°. If the fractional parts of 
two setting values are the same, the effect is the same even 
if the integral parts are different.
The integral part of a setting value is used when moving a 
light source with keyframes.
For example, when the longitude of a light source rotates 
in the clockwise direction from 0.88 (315°) to 0.12 (45°), 
it rotates in the counterclockwise direction (the angle 
grows smaller) if the above values are used. In this case, 
the value of the second keyframe can be set to 1.12 (360° 
+ 45°).

Keyframe trajectory

RadiusAngle

Offset

Angle: Rotation angleInitial center position

Test sphere

Ray

Parameter Setting Angle

Longitude 0.12 45°

Latitude 0.12 45°

Parallel rays

Input picture

Z-axis
Latitude=+0.25

Latitude=−0.25

X-axis

Y-axis
Longitude

Test sphere

Latitude

KF2 = 1.12

KF2 = 0.12

KF1 = 0.88

Test sphere
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Setting the surface where light strikes the 
image

1 In the DME menu, select VF5 ‘Light/Trail’ and HF6 
‘Spot Lighting.’

The Spot Lighting menu appears.

2 Press [Spot Lighting], turning it on.

3 Set the following parameter. 

• Lowering the brightness of the image makes 
Spotlighting more effective.

• The Total Ambient setting is shared with the 
Lighting function.

4 In the <Surface Select> group, select the state of the 
surface struck by the light.

Flat: The image surface is unchanged, causing the 
selected light source to appear as the effect.

Texture: A texture appears on the surface of the 
image.

Non Linear: The Spotlighting effect is applied to an 
area to which a DME nonlinear effect is applied.

• The BZDM-9050 Texture Lighting Software (for 
MVE-9000) is required to enable Texture or Non 
Linear.
An install key must be entered to use the software.
For details, see “Installation and Device Setup 
(Install/Unit Config Menu)” in Chapter 18 
(Volume 2).

• The Spotlighting Non Linear setting is effective for 
the following nonlinear effects. For any other 
nonlinear effect, the result of selecting the Non 
Linear setting is the same as selecting Flat.

Wave, Mosaic Glass, Flag, Ripple, Lens, 
Panorama, Page Turn, Roll.

5 If you selected Texture or Non Linear in step 4, set the 
following parameters.

Parameters when you selected Texture
• SD format

a) Minus moves left, plus moves right.
b) Minus moves down, plus moves up.
c) Plus emphasizes bumps in texture, minus emphasizes depressions. 

0.00 is a flat surface.

• HD format

a) Minus moves left, plus moves right.
b) Minus moves down, plus moves up.
c) Plus emphasizes bumps in texture, minus emphasizes depressions. 

0.00 is a flat surface.

Parameters when you selected Non Linear

a) Light appears from Z direction. At –100.00 the light goes deepest, at 
+100.00 the whole image is lit like a flat effect.

6 If you selected Texture in step 4, select the pattern as 
explained in the next section “To select a texture 
pattern.”

7 If you selected Texture in step 4, select the way it is 
applied in the <Surface Axis> group.

Move: The texture moves together with the DME 
image.

Fix: The texture does not move, even if the DME 
image moves.

For the difference between these application methods, 
see “Coordinate axis on surface of image” (page 323).

If Non Linear is selected in the <Surface Select> 
group, Fix is disabled. Behavior is the same as Move.

Knob Parameter Adjustment Setting values

1 Total 
Ambient

Brightness of 
whole image 

0.00 to 100.00

Notes 

Knob Parameter Adjustment Setting values

1 X Movement in 
X-axis direction

–8.00 to +8.00 a)

2 Y Movement in 
Y-axis direction

–6.00 to +6.00 b)

3 Size X Image size in 
X-axis direction

0.50 to 16.00

4 Size Y Image size in 
Y-axis direction

0.50 to 16.00

5 Amp Emphasize 
bumps and 
depressions 

–100.00 to 
+100.00 c)

Knob Parameter Adjustment Setting values

1 X Movement in 
X-axis direction

–32.00 to 
+32.00 a)

2 Y Movement in 
Y-axis direction

–24.00 to 
+24.00 b)

3 Size X Image size in 
X-axis direction

0.50 to 16.00

4 Size Y Image size in 
Y-axis direction

0.50 to 16.00

5 Amp Emphasize 
bumps and 
depressions

–100.00 to 
+100.00 c)

Knob Parameter Adjustment Setting values

5 Amp Distance of light –100.00 to 
+100.00 a)

Notes 

Knob Parameter Adjustment Setting values
Applying Special Effects (Lighting and Recursive Effects)
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To select a texture pattern

1 In the Spot Lighting menu, press [Texture Ptn Select].

The Texture Ptn Select menu appears.
Two lists appear in the status area. The list on the left 
displays the number and name of the currently selected 
texture. The list on the right is for selecting a texture.

2 In the <Texture Pattern> group, press [User] or 
[Factory] to select the texture pattern list.

[User]: List of texture patterns created by the user.
See “Adding User Texture Patterns” in 
Chapter 18 (Volume 2).

[Factory]: List of texture patterns stored in the system 
when shipped from the factory.

3 Do one of the following to select a texture.

• Press directly on the list on the right of the status 
area.

• Press the arrow keys to scroll the reverse video 
cursor.

• Turn the knob.

a) When Factory is selected
b) When User is selected. The setting value range depends on the 

number of texture patterns installed.

4 Press [Set].

The texture selected in step 2 appears in the list on the 
left of the status area.

To set a test sphere

1 In the Spot Lighting menu, press [Test Sphere], 
turning it on.

A test sphere effect appears on the image surface.

2 Adjust the following parameter. 

a) Light appears from Z direction. At –100.00 the light goes deepest, at 
+100.00 the whole image is lit like a flat effect.

For details of the relationship of test spheres and light 
sources, see “Relation between test spheres and 
parallel rays” (page 325).

Setting light sources
Up to three light sources (Light 1 to Light 3) for 
Spotlighting can be set by menus.

Light source menu
The following three light source menus are available.

The BZDM-9050 Texture Lighting Software (for MVE-
9000) is required to enable Light 2 and Light 3.
An install key must be entered to use the software.

For details, see “Installation and Device Setup (Install/
Unit Config Menu)” in Chapter 18 (Volume 2).

To set light source data
The following example shows how to set light source data 
with the Light 1 menu.
If you use multiple light sources, use the same procedure 
for all light sources.

1 In the <Spot Lighting Adjust> group of the Spot 
Lighting menu, press [Light 1].

The Light 1 menu appears.

2 Press [Light 1], turning it on.

3 Set the following parameters.

• Lowering the brightness of the image makes 
Spotlighting more effective.

• The Total Ambient setting is shared with the 
Lighting function.

4 In the <Spot Mode> group, select the type of light 
source (see page 324).

Parallel: Parallel light source. The direction can be 
set.

Knob Parameter Adjustment Setting values

1 Texture No Texture 1 to 30 a)

101 and upwards b)

Knob Parameter Adjustment Setting values

5 Amp Distance of light –100.00 to 
+100.00 a)

Light source Menu

Light 1 DME >Light/Trail >Spot Lighting 
>Light 1

Light 2 DME >Light/Trail >Spot Lighting 
>Light 2

Light 3 DME >Light/Trail >Spot Lighting 
>Light 3

Notes 

Knob Parameter Adjustment Setting values

1 Total 
Ambient

Brightness of 
whole image

0.00 to 100.00

2 Intensity Intensity 
(brightness) of 
the light source

0.00 to 100.00

3 Soft Softness of the 
lighted area 

0.00 to 100.00
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Point: Point light source. The position can be set.
Line: Line light source. The position and angle can be 

set.
Whole: Non-directional light source which 

illuminates the whole image (no settings).

5 According to the selected light source type, set the 
following parameters.

When you selected Parallel

a) Minus moves counterclockwise, plus moves clockwise.

When you selected Point
• SD format

a) Minus moves left, plus moves right.
b) Minus moves down, plus moves up.
c) Minus moves forward, plus moves deeper.

• HD format

a) Minus moves left, plus moves right.
b) Minus moves down, plus moves up.
c) Minus moves forward, plus moves deeper.

When you selected Line

• SD format

a) Minus moves left, plus moves right.
b) Minus moves down, plus moves up.
c) Minus moves forward, plus moves deeper.

d) Minus moves counterclockwise, plus moves clockwise.

• HD format

a) Minus moves left, plus moves right.
b) Minus moves down, plus moves up.
c) Minus moves forward, plus moves deeper.
d) Minus moves counterclockwise, plus moves clockwise.

6 In the <Axis Select> group, select the coordinate space 
in which to place the light source.

Source: Place the light source in the source coordinate 
space. The spotlight moves when the image 
moves.

Target: Place the light source in the target coordinate 
space. The spotlight does not move, even when the 
image moves.

For details of the coordinate space in which to place 
the light source, see “Linking and unlinking image and 
spotlight” (page 324). 

To set a test sphere

1 In the Light 1 menu, press [Test Sphere], turning it on.

A test sphere effect appears on the surface of the 
image.

2 Adjust the following parameter. 

a) Light appears from Z direction. At –100.00 the light goes deepest, at 
+100.00 the whole image is lit like a flat effect.

To select the lighted area
In the <Area Select> group, select one of the following.
FRGD: The light strikes the image foreground.
BKGD: The light strikes the image background.
Both: The light strikes both foreground and background.

For more information about the lighted area, see 
“Selecting the lighted area” (page 324).

• If you select [Multiply] in the <Fill Blending Mode> 
group of the Light Color Adjust menu (see page 330), 

Knob Parameter Adjustment Setting values

1 Longitude Longitude –8.00 to +8.00 a)

2 Latitude Latitude –8.00 to +8.00

Knob Parameter Adjustment Setting values

1 X Movement in 
X-axis direction

–6.00 to +6.00 a)

2 Y Movement in 
Y-axis direction

–6.00 to +6.00 b)

3 Z Movement in 
Z-axis direction

–6.00 to +6.00 c)

Knob Parameter Adjustment Setting values

1 X Movement in 
X-axis direction

–24.00 to 
+24.00 a)

2 Y Movement in 
Y-axis direction

–24.00 to 
+24.00 b)

3 Z Movement in 
Z-axis direction

–24.00 to 
+24.00 c)

Knob Parameter Adjustment Setting values

1 X Movement in 
X-axis direction

–6.00 to +6.00 a)

2 Y Movement in 
Y-axis direction

–6.00 to +6.00 b)

3 Z Movement in 
Z-axis direction

–6.00 to +6.00 c)

4 Longitude Longitude –8.00 to +8.00 d)

Knob Parameter Adjustment Setting values

1 X Movement in 
X-axis direction

–24.00 to 
+24.00 a)

2 Y Movement in 
Y-axis direction

–24.00 to 
+24.00 b)

3 Z Movement in 
Z-axis direction

–24.00 to 
+24.00 c)

4 Longitude Longitude –8.00 to +8.00 d)

Knob Parameter Adjustment Setting values

5 Amp Distance of 
light

–100.00 to +100.00 a)

Notes 
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the light effect is not applied to the background, even if 
you select BKGD or Both.

• If the setting of [Brilliancy] in the <Fill Source> group 
of the Light Color Adjust menu (see page 330) is 100.00, 
the light effect is not applied to the background, even if 
you select BKGD or Both.

• When the global effect Combiner is set to Mix or Depth, 
the light effect is not applied to the background, even if 
you select BKGD or Both.

To select Surface Flat
Press [Surface Flat], turning it on.
If you have selected anything other than Flat in the 
<Surface Select> group of the Spot Lighting menu, the 
part corresponding only to the surface being struck by the 
currently set light from the light source is shown in the 
same way as if Flat had been selected.

To set the shape of the light

1 Press [Shape], turning it on.

2 Set the following parameters.

SD format

a) For more information about the shape patterns, see “Shape Patterns” 
(page 393) in the Appendix.

b) 0 is a round shape, and 100 is the shape itself. Smaller values make 
the pattern more rounded.

c) –1.00 is one rotation in the counterclockwise direction. +1.00 is one 
rotation in the clockwise direction.

HD format

a) For more information about the shape patterns, see “Shape Patterns” 
(page 393) in the Appendix.

b) 0 is a round shape, and 100 is the shape itself. Smaller values make 
the pattern more rounded.

c) –1.00 is one rotation in the counterclockwise direction. +1.00 is one 
rotation in the clockwise direction.

To rotate the shape pattern

1 Press [Shape Speed], turning it on.

The display on knob 5 that was visible when [Shape] 
was selected changes.

2 Set the following parameter.

a) –100.00 is four rotations per second in the counterclockwise 
direction, and +100.00 is four rotations per second in the clockwise 
direction. 0.00 stops the rotation.

To change the light to a ring shape

If you select Parallel or Whole (see page 327) in the <Spot 
Mode> group and shaping is disabled, the Ring parameter 
cannot be set.

1 Press [Ring], turning it on.

2 Set the following parameter.

SD format

a) –1.00 is one rotation in the counterclockwise direction and +1.00 is 
one rotation in the clockwise direction.

There is no Radius setting when Line is selected in the 
<Spot Mode> group.

HD format

Knob Parameter Adjustment Setting values

1 Shape Ptn Shape pattern 1 to 2 a)

2 Size Shape size 0.00 to 6.00 

3 Deform Amount of 
shape 
deformation

0.00 to 100.00 b)

4 Soft Softness of 
shape pattern

0.00 to 100.00 

5 Angle Angle of shape 
pattern rotation

–8.00 to +8.00 c)

Knob Parameter Adjustment Setting values

1 Shape Ptn Shape pattern 1 to 2 a)

2 Size Shape size 0.00 to 24.00 

3 Deform Amount of 
shape 
deformation

0.00 to 100.00 b)

4 Soft Softness of 
shape pattern

0.00 to 100.00 

5 Angle Angle of shape 
pattern rotation

–8.00 to +8.00 c)

Knob Parameter Adjustment Setting values

5 Speed Rotation 
direction and 
speed

–100.00 to 
+100.00 a)

Notes 

Knob Parameter Adjustment Setting values

1 Offset Offset from 
center 
position 
(radius)

–6.00 to +6.00 

2 Radius Radius of 
ring 

0.00 to 6.00  

3 Angle Rotation 
angle of ring

–8.00 to +8.00 a)

Notes 

Knob Parameter Adjustment Setting values

1 Offset Offset from 
center position 
(radius)

–24.00 to 
+24.00 

2 Radius Radius of ring 0.00 to 6.00  

3 Angle Rotation angle 
of ring

–8.00 to +8.00 a)
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a) –1.00 is one rotation in the counterclockwise direction and +1.00 is 
one rotation in the clockwise direction.

There is no Radius setting when Line is selected in the 
<Spot Mode> group.

To rotate the ring

1 Press [Ring Speed], turning it on.

The display on knob 3 that was visible when [Ring] 
was selected changes.

2 Set the following parameter.

a) –100.00 is four rotations per second in the counterclockwise 
direction, and +100.00 is four rotations per second in the clockwise 
direction. 0.00 stops the rotation.

To invert the lighted area
Press [Light Invert], turning it on.

To add color to the light source

1 In the Light 1 menu, press [Light Color Adjust].

The Light Color Adjust menu appears.

2 In the <Fill Blending Mode> group, select how the 
light and image should be blended.

Mix: Light as if reflected from a mirror.
Multiply: Light as if reflected from a dull surface 

(diffuse reflection).

3 If you selected Mix, select the fill color in the <Fill 
Source> group.

Flat Color: A monochrome matte.
Hue Rotation: Color matte with a color that gradually 

varies.

4 According to the selection, set the following 
parameters.

When you selected Flat Color

a) 100.00: The image beneath the light shines through.

When you selected Hue Rotation

a) –12.00 is a 360-degree rotation every second in the counterclockwise 
direction. +12.00 is a 360-degree rotation every second in the 
clockwise direction.

b) 100.00: The image beneath the light shines through.

Copying or swapping light source settings
You can copy or swap the setting from one light source 
(Light 1 to Light 3) to another light source. 

1 In the Spot Lighting menu, press [Copy/Swap].

The Copy/Swap menu appears.
Two lists appear in the status area. The list on the left 
shows the copy or swap sources, and the list on the 
right shows the copy or swap destinations.

2 Do one of the following to select the target data.

• Press directly on the list in the status area.
• Press the arrow keys to scroll the reverse video 

cursor.
• Turn the knobs.

3 Press [Copy] to copy, or [Swap] to swap.

To undo a copy or swap
Press [Undo]. Settings are returned to their values before 
the copy or swap.

Notes 

Knob Parameter Adjustment Setting values

3 Speed Rotation speed 
and direction

–100.00 to 
+100.00 a)

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00 

3 Hue Hue 359.99 to 0.00

4 Brilliancy Brilliance of 
surface struck 
by light

0.00 to 100.00 a)

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00 

3 Speed Speed at which 
hue changes

–12.00 to 
+12.00 a)

4 Brilliancy Brilliance of 
surface struck 
by light

0.00 to 100.00 b)

Knob Parameter Adjustment Setting values

1 Left No Copy or swap 
source data

1 to 3

2 Right No Copy or swap 
destination data

1 to 3
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Applying Special Effects 
(Other Effects)

Background Settings

Adds a color or inputs an external signal to the background 
of the image.

 

Signal selection for this purpose is not supported on the 
MVE-8000A.

Applying the Background effect

1 In the DME menu, select VF6 ‘Input/Output’ and HF1 
‘Bkgd.’

The Bkgd menu appears.

2 Press [Bkgd], turning it on.

The Background effect is enabled. Only if Flat Color 
is selected in the <Bkgd Fill> group, you can adjust the 
parameters with the knobs.

3 Set the following parameters.

Selecting the signal to insert in the 
background
When using the MVE-9000, you can select the signal to 
insert in the background.
With [Bkgd] set on, use the following procedure.

1 In the <Bkgd Fill> group, select one of the following.

Flat Color: single color
Mix Color: mix color signal set in the Color Mix 

menu (see page 289)
Ext Video: an external video signal input to the Ext IN 

connector

• “Mix Color” or “Ext Video” can only be applied to 
one of the background, flex shadow (see page 283), 
trail (see page 318), and wind (see page 322) effects.
If you select “Mix Color” or “Ext Video” in one of 

these settings, a selection of “Mix Color” or “Ext 
Video” in any of the other effects is disabled, and 
“Flat Color” is selected in its place.

• When executing combining four channels of DME 
images, “Mix Color” and “Ext Video” cannot be 
selected.

2 Only if Flat Color is selected in step 1, adjust the 
following parameters.

Separate Sides Settings

Applies separate video signals and key signals to the front 
and back of the image.

Applying the Separate Sides effect

1 In the DME menu, select VF6 ‘Input/Output’ and HF2 
‘Video/Key.’

The Video/Key menu appears.

2 Press [Separate Side], turning it on.

The Separate Sides effect is enabled. If the video and 
key signals currently being output to the monitor are 
the front side, you can select the front signals. If they 
are the back side, you can select the back signals. 
Video and key signals are selected with the cross-point 
control blocks of each M/E bank or the PGM/PST 
bank.

Shaped Video Settings

For each of the front and back sides of the image, specifies 
whether to handle input video from the switcher as shaped 
video (key processed signals).
You can also make these settings for the output video.

 

• When using an SDI interface, with the [PROC KEY] not 
selected in the output destination buttons, then the 
shaped video function is enabled.

• When using the dedicated interface or SDI interface, 
with [PROC KEY] selected in the output destination 
buttons, since the input video signal to the first channel 
is always set to the key processed signal on the switcher, 
the shaped video setting is always on. For the second and 

Notes 

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Notes 

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00

Notes 
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third channel signals, this will be turned off. For the 
output video, this is always on.

Switching shaped video on or off

1 In the DME menu, select VF6 ‘Input/Output’ and HF2 
‘Video/Key.’

The Video/Key menu appears.

2 In the <Shaped Video> group, press each of the 
following buttons to switch it on or off.

Front Input: When this is on, the front image of the 
input video signal is treated as shaped video.

Back Input: When this is on, the back image of the 
input video signal is treated as shaped video.

Output: When this is on, the output video signal is 
treated as shaped video.

About on and off for shaped video input (Front 
Input/Back Input)
Switch shaped video on and off according to the input 
video signals. 
For example, switch the shaped video input on when the 
input signal is a key processed image such as computer 
graphics.
Switch the shaped video input off when the input signal is 
not key processed, for example when a video signal taken 
with a camera is cut out with a title or other key signal.

About on and off for shaped video output
Switch the shaped video output on and off to match the on 
and off state of the switcher clean video mode.
Also, when the shaped video output is on, it is 
recommended that the switcher key type be set to linear 
key.

About the relationship between shaped 
video output and effects
When the shaped video output is off, the video signal 
before key processing is output. According to the selected 
effect, the following states may result.
(a) The output video signal is affected by the key signal. 
(b) When key processing is done, a different image may 

appear in the parts which are removed. 
(c) There is no change in the output video signal for 

effects which are applied to key signals only. 
When multiple effects are applied, the order of priority is 
(a) > (b) > (c). 
The following explains the relationship between effects 
and states (a), (b), and (c).

(a) The output video signal is affected by the key 
signal 
The output video signal is affected by the key signal when 
the following effects are selected. To prevent the signal 

from being affected, set the DME key source to Int Key, or 
choose an appropriate input key signal. 

Page Turn, Roll, Cylinder, Sphere, Spotlighting, 
global effects (Combiner, Brick, Shadow) 

(b) When key processing is done, a different 
image may appear in the parts which are removed
The following states result, depending on the selected 
effect. 
Removal with the key can be checked by turning the 
background on. 
Border, Beveled Edge: Added also to the outer side of the 

cropped video signal. 
Trail, Keyframe Strobe: The key signal level of the 

afterimage portion varies with adjustments of the knob 
(Decay), but the afterimage portion of the video signal 
does not disappear until Trail Eraser (KF Strobe 
Eraser) is turned on or the effect is turned off. 

Lighting: The Lighting effect is applied to the whole 
picture.

Spotlighting: If BKGD or Both is selected in the <Area 
Select> group, light strikes the entire background.

(c) No change in the output video signal for 
effects which are applied to key signals only 
The following states result, depending on the selected 
effect. 
Removal with the key can be checked by turning the 
background on. 
Crop: The Copy effect is applied to the key signal only. 

The video signal does not change.
Edge Soft: The Edge Soft effect is applied to the key 

signal only. The video signal does not change. 
Shadow, Flex Shadow, Combine Shadow: The key 

signal density changes. The video signal does not 
change. 

Fade: The key signal density changes according to depth 
data. The video signal does not change. 

Key Density: The key signal density changes. The video 
signal does not change.

Invert Settings

Inverts the input video signal and/or key signal 
horizontally or vertically. You can make separate settings 
for the front and back.

Applying the Invert effect

1 In the DME menu, select VF6 ‘Input/Output’ and HF2 
‘Video/Key.’

The Video/Key menu appears.

2 In the <Front> group (to invert front signals) or the 
<Back> (to invert back signals), press the following 
buttons, turning them on.
Applying Special Effects (Other Effects)
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H Invert: Invert video and key signals horizontally.
V Invert: Invert video and key signals vertically.

Key Density Settings

You can adjust the key density for the key signal input to 
the DME.

Setting the key density

1 In the DME menu, select VF6 ‘Input/Output’ and HF2 
‘Video/Key.’

The Video/Key menu appears.

2 Press [Key Density], turning it on.

3 Set the following parameter.

Key Source Selection

You can select either the key signals received from the 
switcher or the key signals generated in the DME for 
application to the front and back of the image.

Selecting the key source signals

When the shaped video setting (see page 331) is on, it is 
not possible to select the key source. It is fixed as “Ext 
Key” as listed in the following.

1 In the DME menu, select VF6 ‘Input/Output’ and HF2 
‘Video/Key.’

The Video/Key menu appears.

2 In the <Front Key> group or <Back Key> group 
respectively, press one of the following, turning it on.

Ext Key: Use the key signal sent from the switcher as 
the key source.

Int Key: Use the full-size DME internal key signal as 
the key source.

Lum Key: Use the input video luminance signal as the 
key source. 

3 When Ext Key or Lum Key is selected in step 2, set the 
following parameters.

• The Ext Key and Lum Key in the <Front Key> group 
share clip and gain settings. Similarly, Ext Key and 
Lum Key in the <Back Key> group also share clip 
and gain settings.

• The Ext Key parameter setting is only enabled when 
the shaped video setting is off.

Interpolation Settings

Specifies the methods used for interpolation processing of 
input video signals and input key signals.
For input video signals, you can select from the following 
four methods.
• Detect changes in the luminance and chrominance 

signals separately, and switch automatically between 
fields and frames. You can select the degree of change 
detection.

• Detect changes in the luminance signal separately, and 
switch automatically between fields and frames. You 
can select the degree of change detection.

• Do interpolation in field units.
• Do interpolation in frame units.

For input key signals, you can select from the following 
three methods.
• Detect changes in the luminance signal separately, and 

switch automatically between fields and frames. You 
can select the degree of change detection.

• Do interpolation in field units.
• Do interpolation in frame units.
You can also select the number of pixels used in 
interpolation processing, and select the method used to 
show the picture reduced or expanded.
Further, you can apply an anti-moire filter to reduce the 
moire patterns created by interpolation.

• Interpolation processing is possible for the following 
signal formats and DME systems.
- MVE-8000A: 480i/59.94, 576i/50
- MVE-9000 and MKS-7470X/7471X: 480i/59.94, 

576i/50, 1080i/59.94, 1080i/50
• The anti-moire filter is only effective when the MVE-

8000A is used in an HD system.

Knob Parameter Adjustment Setting values

1 Key 
Density

Key density 0.00 to 100.00

Notes 

Knob Parameter Adjustment Setting values

1 Clip Reference level 
for key signal 
generation

–7.31 to 
+109.59

2 Gain Key sensitivity –100.00 to 
+100.00

Notes 

Notes 
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Selecting an interpolation method for input 
video signals

1 In the DME menu, select VF6 ‘Input/Output’ and HF3 
‘Process.’ 

2 In the <Video Field/Frame Mode> group, select the 
interpolation method for the video signal.

Adaptive Y/C: Detect changes in the luminance and 
chrominance components of the video signal 
separately, and switch automatically between 
fields and frames. 

Adaptive Y: Detect changes in the luminance 
component of the video signal separately, and 
switch automatically between fields and frames.

Field: Do interpolation in field units. This gives 
natural movement, suitable for moving video. 

Frame: Do interpolation in frame units. This gives 
higher image precision, suitable for still pictures. 

3 When you select Adaptive Y/C or Adaptive Y in step 
2, set the following parameter. 

4 In the <Key Field/Frame Mode> group, select the 
interpolation method for the key signal.

Adaptive: Detect changes in the luminance 
component of the key signal separately, and 
switch automatically between fields and frames.

Field: Do interpolation in field units. This gives 
natural movement, suitable for moving video. 

Frame: Do interpolation in frame units. This gives 
higher image precision, suitable for still pictures. 

5 When you select Adaptive in step 4, set the following 
parameter. 

6 In the <Interpolation Mode> group, set the number of 
pixels to use in interpolation. 

Multi: Use multi-point interpolation.  This gives 
higher picture quality. 

Linear: Use two-point interpolation.

7 In the <Filter Mode> group, select the method used to 
show the picture reduced or expanded.

Mode1 (standard): Even when the picture is reduced, 
add compensation so that it can be seen clearly. 

Mode2 (soft): Suppress aliasing when expanding or 
reducing the picture. 

Mode3 (sharp): Do not suppress aliasing when 
expanding or reducing the picture.

Applying the anti-moire filter
You can reduce the moire patterns created by interpolation 
when an image is enlarged, compressed, or rotated.

 

This function is effective only when the HD signal format 
is used on the MVE-8000A.

1 In the DME menu, select VF6 ‘Input/Output’ and HF3 
‘Process.’

The Process menu appears.

2 Press [Anti Moire Filter], turning it on.

3 Set the following parameter.

Corner Pinning Settings

When the Brick effect is enabled, the Corner Pinning 
function cannot be used.

Setting the Foreground Corner Pinning 
positions

1 In the DME menu, select VF4 ‘Non Linear/Corner 
Pin’, HF2 ‘Corner Pinning.’

The Corner Pinning menu appears.

2 Set [Corner Pinning] to On.

3 Set [Corner Marker] to On.

A marker appears for each corner. The marker for the 
selected corner is distinguished from the other 
markers.

Knob Parameter Adjustment Setting values

1 Mode Degree of 
motion detection

1 to 4

Knob Parameter Adjustment Setting values

1 Mode Degree of 
motion detection

1 to 4

Notes 

Knob Parameter Adjustment Setting values

1 Anti Moire 
Filter

Amount of moire 
reduction

1 to 8

Notes 
Applying Special Effects (Other Effects)
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4 In the <Corner Select> group, select the corner to 
operate on.

Top Left: Top left
Top Right: Top right
Bottom Left: Bottom left
Bottom Right: Bottom right
All: All four corners

5 Turn the knobs to adjust the position of the corner 
selected in step 4.

The parameter setting ranges depend on the system’s 
selected signal format (SD/HD) and aspect ratio (4:3/
16:9) combination, as follows.

4:3 mode

a) When the selection for operation is “All,” the Top Left value appears, 
and the knobs move all four corners correspondingly.

16:9 mode

a) When the selection for operation is “All,” the Top Left value appears, 
and the knobs move all four corners correspondingly.

Resetting the corner positions
In the Corner Pinning menu, press [Reset Corner].

Selecting the area used for pinning
When the foreground is cropped, press [Crop Link] to 
select either of the following.
On: Use the area of the cropped image for positioning

Off: Use the area of the entire image, including the part 
hidden by cropping (shaded in the diagram below) for 
positioning

Adjusting the density of the foreground
You can adjust the density of the foreground image to be 
translucent so that the background shows through, making 
it easier to position the corners.

This setting is not saved in a key frame or snapshot.

1 In the Corner Pinning menu, set [Video Through] to 
On.

2 Turn the knob to adjust the following parameter.

Adjusting the zoom
You can enlarge the image around the corner being 
adjusted, to allow fine positioning of the corner.

• This setting is not saved in a key frame or snapshot.
• This function is only enabled when combine is set.
• When all four corners are being positioned, this function 

cannot be used.

1 In the Corner Pinning menu, press [Zoom Enable], 
turning it On.

2 Turn the knob to adjust the following parameter.

Knob Parameter Adjustment Setting values

1 Pos X Movement in 
x-axis direction

–8.00 to +8.00 
(SD) a)

–24.00 to +24.00 
(HD) a)

2 Pos Y Movement in 
y-axis direction

–6.00 to +6.00 
(SD) a)

–18.00 to +18.00 
(HD) a)

Knob Parameter Adjustment Setting values

1 Pos X Movement in 
x-axis direction

–8.00 to +8.00 
(SD) a)

–32.00 to 
+32.00 (HD) a)

2 Pos Y Movement in 
y-axis direction

–4.50 to +4.50 
(SD) a)

–18.00 to 
+18.00 (HD) a)

Marker for selected corner

Other markers

Marker for selected corner

Notes 

Knob Parameter Adjustment Setting values

4 Density Image density 0.00 to 100.00

Notes 

Area positioned by pinning when Crop Link is On

Area positioned by pinning when Crop Link is Off

(The bold frame shows the area used for positioning.)
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Global Effect Operations

Overview

Global effects are special effects created by combining the 
images of successive channels. The Global Effect menu is 
used to add these effects. The following types of global 
effects are available.

 

On the MVE-8000A, when the signal format is 1080P, of 
the following effects, three or more channel combiner and 
brick effects cannot be used.

Operations Common to All Global 
Effects

In this section, explanations of the operating procedures 
for individual global effects begin with selections from 
VF1 ‘Ch1 - Ch4’ in the Global Effect menu. The following 
are common operations that you must do prior to selecting 
from this menu.

1 In the device control block, select the target DME 
channel.

2 In the menu control block, press the top menu 
selection button [GLB EFF], then select VF1 ‘Ch1 - 
Ch4.’

Knob Parameter Adjustment Setting values

5 Zoom Degree of 
zooming in on 
the corners

1.00 to 16.00

Zoom Off

Zoom On

Notes 

Name Effect/Image

Combiner Automatically combines the selected images 
when multiple channels are selected on one 
keyer or for one transition.

Brick Creates a rectangular parallelepiped from 3 
successive channels.

Shadow Gives the image a shadow.
Global Effect Operations
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The Global Effect >Ch1 - Ch4 menu appears.

Combiner Settings

When multiple channels are selected on one keyer or for 
one transition, the Combiner automatically combines the 
selected images. Up to four channels can be combined.
You can also control the way in which the combination is 
carried out, as a mix or an overlap with priority set 
automatically. For a mix, you can control the relative 
amounts of each channel.
Images can also be crossed in three dimensions. 

 

Three-dimensional image crossing is not supported on the 
MVE-8000A.

Combination of channel 1 (Ch1) and channel 2 
(Ch2)

Combination of Ch1, Ch2, and Ch3

Combination of Ch1 and Ch2 / combination of 
Ch3 and Ch4

Combination of Ch1, Ch2, Ch3, and Ch4

Mixing Ch1 and Ch2

If the Mix1 setting is 70, the proportion of the channels in 
the mixed portion in the previous illustration is as shown 
in the following table.

Mixing Ch1, Ch2, and Ch3

If the Mix1 setting is 70 and the Mix2 setting is 40, the 
proportions of the channels in the mixed portions in the 
previous illustration are as shown in the following table.

Notes 

Combiner

Combiner
Combination Indication in 

figure
Ch1 Ch2

Ch1 and Ch2 30% 70%

Combination Indication in 
figure

Ch1 Ch2 Ch3

Ch1 and Ch2 30% 70% –

Ch2 and Ch3 – 60% 40%

Ch1 and Ch3 30% – 70%

Combiner

Combiner

Combiner
337Global Effect Operations
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Pairwise mixing of Ch1 and Ch2, and Ch3 and 
Ch4

If the Mix1 setting is 70 and the Mix2 setting is 40, the 
proportions of the channels in the mixed portions in the 
previous illustration are as shown in the following table.

Ch1 crossed with Ch2

Setting the combiners
The setting menu differs according to the combiner usage 
status.
This section shows the cases of “Ch1+Ch2+Ch3” and 
“Ch1+Ch2, Ch3+Ch4” as examples.

For details of operating procedures when using an SDI 
interface, see “Procedure for combine operation when 
using an SDI interface” (page 338).

1 In the Global Effect >Ch1- Ch4 menu, select HF1 
‘Combiner Priority.’ 

The Combiner Priority menu appears. 

2 If [Mix], [Auto] or [Depth] is on, turn it off.

3 Set the overlap priority for “Ch1+Ch2+Ch3” or 
“Ch1+Ch2, Ch3+Ch4” as follows.

For case “Ch1+Ch2+Ch3”
Under <Priority1> to <Priority3>, press [Ch1], [Ch2], 
and [Ch3], respectively, to set the overlap priority.
Priority1: Select the channel with the highest priority. 

Priority2: Select the channel with the second highest 
priority. 

Priority3: Select the channel with the lowest priority.

For case “Ch1+Ch2, Ch3+Ch4”
Under <Combiner 1 Priority 1> and <Combiner 1 
Priority 2>, press [Ch1] and [Ch2] respectively, and 
under <Combiner 2 Priority 1> and <Combiner 2 
Priority 2>, press [Ch4] and [Ch3] respectively, to set 
the respective priorities for overlaying the images.

Procedure for combine operation when 
using an SDI interface
Use the following procedure only when the DME with an 
SDI interface.

It is not possible to select  channels with buttons in the key 
control block.
In the following, the example given is that channels 2 and 
3 are combined, then channels 1+2 and channels 3+4 are 
combined, but other combinations are also possible.

1 In the Global Effect menu, select VF1 ‘Ch1-Ch4’ and 
HF7 ‘Combine Gp Select.’

The Combine Gp Select menu appears.

2 In the <Combine Gp Select> group, select the channel 
combination.

Ch1, Ch2, 
and Ch3

30% 42% 28%

Combination Indication in 
figure

Ch1 Ch2 Ch3 Ch4

Ch1 and Ch2 30% 70% – –

Ch3 and Ch4 – – 60% 40%

Combination Indication in 
figure

Ch1 Ch2 Ch3

Notes 

Priority1: Ch1
Priority2: Ch2
Priority3: Ch3

Combiner1 Priority1: Ch1
Combiner1 Priority2: Ch2
Combiner2 Priority1: Ch4
Combiner2 Priority2: Ch3
Global Effect Operations
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• To combine channels 2 and 3, press [Ch2+Ch3], 
turning it on.

• To combine the previously combined combinations 
of channels 1 and 2, and channels 3 and 4, press 
[Ch1+Ch2] and [Ch3+Ch4], turning them on.

The only two buttons that can be selected 
simultaneously are the combination of [Ch1+Ch2] and 
[Ch3+Ch4].

The selected channels are combined.

To cancel a combine
When for example [Ch2+Ch3] is on, pressing [Ch2+Ch3] 
once more turns it off. Alternatively, pressing a different 
combination button to select it cancels the combine 
selection for the current combination.

Mixing the images of up to four 
consecutive channels

1 In the Combiner Priority menu, press [Mix], turning it 
on.

2 Adjust the following parameters.

For case “Ch1+Ch2”

a) See “Mixing Ch1 and Ch2” (page 337).

For case “Ch1+Ch2+Ch3”

a) See “Mixing Ch1, Ch2, and Ch3” (page 337).

For case “Ch1+Ch2+Ch3+Ch4”
Knobs 1 and 2 set the same parameters as “For case 
‘Ch1+Ch2+Ch3’,” respectively. Knob 3 is 
additionally effective, which sets the parameter Mix3 
(in the same setting value range as with knobs 1 and 2).

Mixing pairwise the images of channels 1 
and 2, and channels 3 and 4

1 In the Combiner Priority menu, press [Combiner1 
Mix], turning it on.

2 Adjust the following parameter.

a) See “Pairwise mixing of Ch1 and Ch2, and Ch3 and Ch4” (page 
338).

3 Press [Combiner2 Mix], turning it on.

4 Adjust the following parameter.

a) See “Pairwise mixing of Ch1 and Ch2, and Ch3 and Ch4” (page 
338).

Automatically setting the priority of 
overlapping images
To set the system so that the priority of overlapping images 
is automatically determined by their position on the z-axis, 
in the Combiner Priority menu, press [Auto], turning it on.

It is not possible to cross images. If an image is rotated, the 
priority is determined by the position on the z-axis of the 
center of the image.

Crossing images from up to four 
consecutive channels in three dimensions

The three-dimensional crossing function is not supported 
on the MVE-8000A.

1 In the Combiner Priority menu, press [Depth], turning 
it on.

2 Set the following parameters.

For case “Ch1+Ch2” 

Notes 

Knob Parameter Adjustment Setting values

1 Mix Mix degree 0.00 to 100.00 a)

Knob Parameter Adjustment Setting values

1 Mix1 Mix degree for 
mix of channel 1 
with result of 
Mix2

0.00 to 100.00 a)

2 Mix2 Mix degree for 
channels 2 and 
3

0.00 to 100.00 a)

Knob Parameter Adjustment Setting values

1 Mix1 Mix degree for 
channels 1 and 
2

0.00 to 100.00 a)

Knob Parameter Adjustment Setting values

1 Mix2 Mix degree for 
channels 2 and 
3

0.00 to 100.00 a)

Notes 

Notes 

Knob Parameter Adjustment Setting values

1 Soft Softness of 
edges of 
crossed section

0.00 to 100.00
339Global Effect Operations



340

  C
hapter 11  D

M
E

 O
perations
For case “Ch1+Ch2+Ch3”

For case “Ch1+Ch2+Ch3+Ch4”
Knobs 1 and 2 set the same parameters as “For case 
‘Ch1+Ch2+Ch3’,” respectively. Knob 3 is 
additionally effective, which sets the parameter Soft3 
(in the same setting value range as with knobs 1 and 2).

Crossing images from channels 1 and 2, 
and channels 3 and 4 in three dimensions

The three-dimensional crossing function is not supported 
on the MVE-8000A.

1 In the Combiner Priority menu, press [Combiner1 
Depth], turning it on.

2 Set the following parameter.

3 Press [Combiner2 Depth], turning it on.

4 Set the following parameter.

Brick Settings

Brick allows you to create a rectangular parallelepiped by 
using images of three consecutive channels. 
The Brick effect can combine Ch1, Ch2, and Ch3, or 
combine Ch2, Ch3, and Ch4. The three images are 
displayed as shown in the following figure.

Combinations of Ch1, Ch2, and Ch3
Upper side: Ch1 image
Side V: Ch2 image
Side H: Ch3 image

Combinations of Ch2, Ch3, and Ch4
Upper side: Ch2 image
Side V: Ch3 image
Side H: Ch4 image
You can adjust the height of the brick, the overlap between 
the three images and the way to insert the side images.

Applying the Brick effect

1 In the Global Effect >Ch1 - Ch4 menu, select HF2 
‘Brick.’

The Brick menu appears.

2 Press [Brick], turning it on.

The Brick effect is enabled, and a rectangular 
parallelepiped (brick) showing the images of three 
channels appears. You can use the knobs to adjust 
parameters for the height of the brick and the overlap 
between the three images.

• When the Brick effect is enabled, the z-axis position 
of the front image in the source coordinate frame is 
shifted by the amount of half the height. Therefore, 
the image is somewhat magnified.

• The flex shadow function cannot be enabled when 
Brick is enabled. 

However, the flex shadow function is not supported on 
the MVE-8000A. 

3 Set the parameters.

Knob Parameter Adjustment Setting values

1 Soft1 Softness of 
edges of 
channel 1 and 
channel 2 
crossed section

0.00 to 100.00

2 Soft2 Softness of 
edges of 
channel 2 and 
channel 3 
crossed section

0.00 to 100.00

Notes 

Knob Parameter Adjustment Setting values

1 Soft1 Softness of 
edges of 
channel 1 and 
channel 2 
crossed section

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Soft2 Softness of 
edges of 
channel 3 and 
channel 4 
crossed section

0.00 to 100.00

Notes 

Knob Parameter Adjustment Setting values

1 Height Height of 
brick

0.00 to 8.00 a)

0.00 to 32.00 b)

2 Front 
Overlap

Front overlap –100.00 to +100.00

3 Side H 
Overlap

Side H 
overlap

–100.00 to +100.00

4 Side V 
Overlap

Side V 
overlap

–100.00 to +100.00
Global Effect Operations
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a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

4 Specify the way to insert the side images when the 
height is changed by pressing one of the following 
buttons in the <Side V> group or the <Side H> group.

Crop: Crop the parts that do not fit into the side 
without shrinking the picture. You can set the 
following parameters. 
The valid ranges of the parameter values depend 
on the combination of signal format (SD/HD) and 
aspect ratio (4:3/16:9) selected in the system, as 
follows.

• 4:3 mode

• 16:9 mode

The set position becomes the upper left corner of Side 
V or Side H. The right and bottom sides of the inserted 
image are set automatically.
Compress: Images are inserted after being 

compressed. You can set the following 
parameters.
The valid ranges of the parameter values depend 
on the combination of signal format (SD/HD) and 
aspect ratio (4:3/16:9) selected in the system, as 
follows.

• 4:3 mode

• 16:9 mode

The part of the image defined by Top, Left, Right, and 
Bottom is magnified or shrunk to fit into Side V or 
Side H.

To invert the image in a side face
For example, to invert the image on the front of Side H in 
the <Side H Front> group, press the following buttons, 
turning them on.
Invert H: To invert horizontally.
Invert V: To invert vertically.
For the images on the other faces, use a similar operation 
in the following
groups:
• Back image of Side H: <Side H Back> group
• Front image of Side V: <Side V Front> group
• Back image of Side V: <Side V Back> group

Knob Parameter Adjustment Setting values

1 H Position of 
left crop 

–4.00 to +4.00 (SD)
–12.00 to +12.00 
(HD)

2 V Position of 
top crop 

–3.00 to +3.00 (SD)
–9.00 to +9.00 (HD)

3 Rotation Angle of 
rotation, 
when rotated 
around the 
Z-axis of the 
source 
space

0/90/180/270°

Knob Parameter Adjustment Setting values

1 H Position of 
left crop 

–4.00 to +4.00 (SD)
–16.00 to +16.00 
(HD)

2 V Position of 
top crop 

–2.25 to +2.25(SD)
–9.00 to +9.00 (HD)

3 Rotation Angle of 
rotation, 
when rotated 
around the 
Z-axis of the 
source 
space

0/90/180/270°

Knob Parameter Adjustment Setting values

1 Top Position of 
top crop 

–2.83 to +3.00 (SD)
–8.50 to +9.00 (HD)

2 Left Position of 
left crop 

–4.00 to +3.83 (SD)
–12.00 to +11.50 
(HD)

3 Right Position of 
right crop 

–3.83 to +4.00 (SD)
–11.50 to +12.00 
(HD)

4 Bottom Position of 
bottom crop 

–3.00 to +2.83 (SD)
–9.00 to +8.50 (HD)

5 Rotation Angle of 
rotation, 
when rotated 
around the 
Z-axis of the 
source 
space

0/90/180/270°

Knob Parameter Adjustment Setting values

1 Top Position of 
top crop 

–2.12 to +2.25 (SD)
–8.50 to +9.00 (HD)

2 Left Position of 
left crop 

–4.00 to +3.87 (SD)
–16.00 to +15.50 
(HD)

3 Right Position of 
right crop 

–3.87 to +4.00 (SD)
–15.50 to +16.00 
(HD)

4 Bottom Position of 
bottom crop 

–2.25 to +2.12 (SD)
–9.00 to +8.50 (HD)

5 Rotation Angle of 
rotation, 
when rotated 
around the 
Z-axis of the 
source 
space

0/90/180/270°
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Shadow Settings

The effect uses two successive channels. You can adjust 
the position and density of the shadow with respect to the 
image, and the color of the shadow. The channel with the 
largest number (for example, Ch2 in the case of Ch1 and 
Ch2) becomes the shadow.

 

When the Combiner function is off, the shadow effect 
cannot be used.

Applying the Drop Shadow effect
The Shadow menu allows you to apply the Drop Shadow 
effect. To access the Shadow menu, in the Global Effect 
>Ch1 - Ch4 menu select HF3 ‘Shadow.’
Depending on the selected combiner channels, the valid 
buttons differ as follows.

Taking Ch1 Shadow as an example, the following explains 
the procedure for applying the Drop Shadow effect.

1 Press [Ch1 Shadow], turning it on.

The Drop Shadow effect is enabled, and channel 2 
becomes the channel for the shadow to the image. You 
can adjust the position and density of the shadow with 
the knobs.

The flex shadow function cannot be enabled when 
Drop Shadow is enabled. 
However, the flex shadow function is not supported on 
the MVE-8000A. 

2 Set the parameters.

a) Setting for SD 4:3, SD 16:9
b) Setting for HD 4:3, HD 16:9

3 In the <Ch1 Shadow Source> group, select the shadow 
source signal. 

Video: Select Ch2 video input as the shadow. 
Flat Color: Select a matte color as the shadow. 

4 When you select Flat Color in step 3, adjust the 
parameters.

To combine the video images after applying a 
shadow
Use the Combiner function to select channel 1 + channel 2 
and channel 3 + channel 4, then turn [Ch 1 Shadow] and 
[Ch 3 Shadow] on.

Notes 

Combiner 
channel 
selection

Button

Ch1 
Shadow

Ch2 
Shadow

Ch3 
Shadow

Ch1+
Ch2 
Shadow

Ch2+
Ch3 
Shadow

Ch1+Ch2 Valid

Ch2+Ch3 Valid

Ch3+Ch4 Valid

Ch1+Ch2
+Ch3

Valid Valid Valid

Ch2+Ch3
+Ch4

Valid Valid Valid

Ch1+Ch2
+Ch3+Ch
4

Valid Valid Valid Valid

Top side

Side V

Actual size, upper 
left corner

Set automatically

Cropped region

Crop

Compress

Magnified or 
shrunk to fit

Side H

Notes 

Knob Parameter Adjustment Setting values

1 Position H Horizontal 
shadow 
position

–8.00 to +8.000 a)

–32.00 to 
+32.000 b)

2 Position V Vertical 
shadow 
position

–8.00 to +8.000 a)

–32.00 to 
+32.000 b)

3 Density Density of 
shadow

0.00 to 100.00

Knob Parameter Adjustment Setting values

1 Luminance Luminance 0.00 to 100.00

2 Saturation Saturation 0.00 to 100.00

3 Hue Hue 359.99 to 0.00
Global Effect Operations
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To apply a shadow after combining the video 
images
Use the Combiner function to select channel 1 + channel 2 
+ channel 3 + channel 4, then turn [Ch 1 + Ch 2 Shadow] 
on.
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Appendix (Volume 1)
Wipe Pattern List

Interpreting the illustrations for patterns
The black part of the pattern represents the old video, and 
the white part the new video, with the wipe taking place in 
the direction of the arrow.

Standard Wipes
Wipe Pattern List
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Enhanced Wipes

Rotary Wipes
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Mosaic Wipes
Wipe Pattern List
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Random/Diamond Dust Wipes
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DME Wipe Pattern List

When 3M/E mode or 4M/E mode is selected on the MVS-
7000X, there are cases in which utility bus 1 (U1) appears 

instead of utility bus 2 (U2) and utility bus 2 (U2) does not 
appear.

DME Wipe Patterns Available in One-Channel Mode

Slide

Split

Squeeze

Notes
DME Wipe Pattern List
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Door

2D trans

3D trans
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Flip tumble

Frame in-out

Picture-in-picture
DME Wipe Pattern List
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Page turn

Page roll
351DME Wipe Pattern List
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Mirror

Sphere

Character trail

Wave

Ripple

Split slide
DME Wipe Pattern List
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Sparkle

Mosaic

Defocus

User programmable DME
The illustrations for patterns 1901 to 1999 show an effect 
register number or register name.

DME Wipe Patterns Available in Two-Channel Mode

Slide
353DME Wipe Pattern List
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Squeeze

3D trans

Picture-in-picture
DME Wipe Pattern List
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Page turn

Page roll
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Brick

Frame in-out

User programmable DME
The illustrations for patterns 2901 to 2999 show an effect 
register number or register name.

DME Wipe Patterns Available in Three-Channel Mode

Brick

User programmable DME
The illustrations for patterns 3901 to 3999 show an effect 
register number or register name.
DME Wipe Pattern List
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Resizer DME Wipe Pattern List

Slide

Squeeze

Frame in-out
Resizer DME Wipe Pattern List
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Menu Tree

Recalling Menus

This section details the menu structure, and shows the top 
menu selection buttons in the menu control block which 
are used to access the menus.

Menu control block

Some menus can also be accessed by pressing other 
buttons twice in rapid succession.

For more details, see “Overview” (page 65).

Some menus may not appear, depending on the model.

M/E-1 to M/E-4 Menus

The functions in the M/E-1, M/E-2, M/E-3, and M/E-4 
menus are the same, but the menu page numbers are 
distinguished as follows.

M/E-1 menus: 11xx, M/E-2 menus: 12xx, 
M/E-3 menus: 13xx, M/E-4 menus: 81xx

In this section, the numbers for the M/E-1 menus are given 
as examples.

Top menu selection buttons Notes 
359Menu Tree
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[M/E 1], [M/E 2], [M/E 3], and [M/E 4] buttons

The functions in the Key2 to Key8 menus are the 
same as those in the Key 1 menu, with the following 
menu page numbers.
Key2 menu: 112x, Key 3 menu: 113x, Key4 menu: 114x, 
Key5 menu: 151x, Key 6 menu: 152x, Key7 menu; 153x, 
Key8 menu: 154x

to next page

a) For VF1 to VF4, either of the groups Key1 to Key4 and Key5 to Key8 appears.
Menu Tree
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[M/E 1], [M/E 2], [M/E 3], and [M/E 4] buttons

a) In Multi Program 2 mode, the menus for sub are displayed with 400 higher numbers than the above for main.

to previous page
361Menu Tree
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PGM/PST Menu

[P/P] button

The functions in the DSK2 to DSK8 menus are the 
same as those in the DSK1 menu, with the following 
menu page numbers.
DSK2 menu: 142x, DSK3 menu: 143x, DSK4 menu: 144x, 
DSK5 menu: 181x, DSK6 menu: 182x, DSK7 menu: 183x, DSK8 menu: 184x

to next page

a) For VF1 to VF4, either of the groups Key1 to Key4 and Key5 to Key8 appears.
Menu Tree



  A
ppendix (V

olum
e 1)
[P/P] button

a) In Multi Program 2 mode, the menus for sub are displayed with 400 higher numbers than the aboves for main.

to previous page
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Frame Memory Menu

Color Bkgd Menu

[FRAME MEM] button

[COLOR BKGD] button
Menu Tree
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AUX Menu

CCR Menu

[AUX] button

[CCR] button
365Menu Tree
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Copy/Swap Menu

Misc Menu

Status Menu

[COPY SWAP] button

[MISC] button

[STATS] button
Menu Tree
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DME Menu

[DME] button
367Menu Tree
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Global Effect Menu

Device Menu

[GLB EFF] button

[DEV] button
Menu Tree
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Macro Menu

Key Frame Menu

[MCRO] button

[KEY FRAME] button
369Menu Tree
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Effect Menu

[EFF] button
Menu Tree
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Snapshot Menu

[SNAPSHOT] button
371Menu Tree
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Shotbox Menu

[SHOTBOX] button
Menu Tree
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File Menu

[FILE] button
373Menu Tree
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Engineering Setup Menu

[ENG SETUP] button

to following pages

a) MVS-7000X only
Menu Tree
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to pages after 
377

to previous pages

to next page
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to following 
pages

to previous pages

to previous pages
Menu Tree
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to previous pages

[ENG SETUP] button

to next page

a) MVS-7000X only
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to previous pages

[ENG SETUP] button
Menu Tree
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User Setup Menu

Diagnostic Menu

[USER SETUP] button

[DIAG] button
379Menu Tree
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Using the M/E-4 Bank

Assigning a Button for M/E-4 Selection in the Setup Menu

• In the factory defaults for this system, M/E-4 is not 
assigned to buttons on the control panel.

• To select M/E-4, assign buttons in the Setup menu 
according to the following table.

Control block Button Menu number Reference in User Guide
“Control Panel Setup (Panel)” and “Cross-Point Settings (Xpt 
Assign Menu)” in Chapter 19 (Volume 2)

Cross-point control 
block

Reentry buttons 7322.1
7322.5

“Creating Cross-Point Assign Tables”
Engineering Setup >Panel >Xpt Assign >Table Button Assign 
menu
Engineering Setup >Panel >Xpt Assign >Main,V/K Pair Assign 
menu

Entire switcher bank - 7321 “Interchanging the Bank Order or Disabling Operation”
Engineering Setup >Panel >Config menu

Key control block Delegation buttons 7321.29 “Assigning Functions to Key Control Block Buttons”
Engineering Setup >Panel >Config >Link/Program Button >Key 
Control Module >Button Assign menu

Device control block Region selection 
buttons

7321.17 “Assigning Functions to the Device Control Block”
Engineering Setup >Panel >Config >Link/Program Button 
>Joystick/Trackball Module menu

Numeric keypad 
control block

Region selection 
buttons

7321.7 “Assigning a Region to the Region Selection Buttons in the 
Numeric Keypad Control Block or Multifunction Flexi Pad 
Control Block”
Engineering Setup >Panel >Config >10 Key Region Assign 
menu

Fade to black 
control block

Preview selection 
buttons

7321.13 “Assigning Preview Output to Preview Selection Buttons”
Engineering Setup >Panel >Config >Link/Program Button 
>Fade To Black Module menu

Menu control block Top menu selection 
buttons

7321.19 “Assigning Functions to the Menu Control Block Top Menu and 
User Preference Buttons”
Engineering Setup >Panel >Config >Link/Program Button 
>Menu Panel menu

Multifunction Flexi 
Pad control block

Region selection 
buttons

7321.7 “Assigning a Region to the Region Selection Buttons in the 
Numeric Keypad Control Block or Multifunction Flexi Pad 
Control Block”
Engineering Setup >Panel >Config >10 Key Region Assign 
menu
Using the M/E-4 Bank
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Using Keys 5 to 8

Keys 5 to 8 cannot be used when the signal format is 
1080P.

Assigning Buttons for Selection of Keys 5 to 8 in the Setup Menu

In the factory defaults for this system, keys 5 to 8 are not 
assigned to buttons on the control panel.

To select keys 5 to 8, assign buttons in the Setup menu 
according to the following table.

Notes 

Control block Button Menu number Reference in User Guide
“Control Panel Setup (Panel)” and “Cross-Point Settings (Xpt 
Assign Menu)” in Chapter 19 (Volume 2)

Transition control 
block

Next transition 
selection buttons

7321.9 “Setting Transition Control Block Button Assignments”
Engineering Setup >Panel >Config >Link/Program Button 
>Transition Module1 menu

Cross-point control 
block

SHIFT button 7322.1 “Creating Cross-Point Assign Tables” “Setting the action of the 
[SHIFT] button in the cross-point control block”
Engineering Setup >Panel >Xpt Assign >Table Button Assign 
menu

Key Control Block Delegation button 7321.29 “Assigning Functions to Key Control Block Buttons”
Engineering Setup >Panel >Config >Link/Program Button >Key 
Control Module >Button Assign menu

Transition control 
block (standard 
type)

Key delegation 
buttons

7321.33 “Setting Transition Control Block Button Assignments”
Engineering Setup >Panel >Config >Link/Program Button 
>Transition Module2 menu

Independent key 
transition execution 
section

7321.34 “Setting Transition Control Block Button Assignments”
Engineering Setup >Panel >Config >Link/Program Button 
>Transition Module3 menu

Independent key 
transition control 
block

Entire block 7321.15 “Assigning Keys to the Independent Key Transition Control 
Block (Simple Type)”
Engineering Setup >Panel >Config >Compact Key Module 
Assign menu

Downstream key 
control block

Key delegation 
buttons

7321.1 “Assigning the Key Delegation in the Downstream Key Control 
Block”
Engineering Setup >Panel >Config >DSK Fader Assign menu

Downstream key/
fade-to-black control 
block

Key delegation 
buttons

7321.14 “Assigning Keys to the DSK1 and DSK2 Buttons in the 
Downstream Key/Fade-to-Black Control Block”
Engineering Setup >Panel >Config >Link/Program Button 
>DSK/FTB Module menu

Device control block 
(joystick)

Operating buttons 7321.31 “Selecting the Module to be the Reference for Device Control 
Block”
Menu Engineering Setup >Panel >Config >JS/TB User Setting 
menuDevice control block 

(trackball)

Cross-point control 
block

Key 1 row 7326.13 “Assigning the key/AUX bus delegation function to the key 1 
row”
Engineering Setup >Panel >Operation >Key Row Operation 
>Key Deleg/AUX Assign menu
381Using Keys 5 to 8
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Selecting Keys 5 to 8 for Next 
Transition

To select keys 5 to 8 for the next transition, in addition to 
assigning [KEY5] to [KEY8] for the operation, it is also 
possible to make the selection with [KEY1/5], [KEY2/6], 
[KEY3/7], [KEY4/8], [SHIFT], and [ADD].
The following describes this method of operation.
First in the Setup menu, assign the following to any 
buttons:

[KEY1/5], [KEY2/6], [KEY3/7], [KEY4/8], [SHIFT], 
and [ADD]

By way of example, this is the procedure for [KEY1/5].

To select key 5
Press [SHIFT], turning it on, then press the [KEY1/5] 
button.

To select keys 1 and 5 simultaneously

1 Press the [KEY1/5] button alone.

This selects key 1.

2 Press [SHIFT], turning it on.

3 Holding down [ADD], press the [KEY1/5] button.

This selects keys 1 and 5 simultaneously.

Selecting Input Signals for Keys 5 to 
8 in the Cross-Point Control Block

Buttons used for selection of keys 5 to 8

For the positions of the following buttons in the cross-
point control block, see page 23.

a) Button previously assigned in the Setup menu to selection of keys 5 to 8

To select the key 5 fill signal

1 Turn on the dedicated SHIFT button.

2 Turn off the [KEY3] button.

3 Select the signal in the key 1 row.

When a key delegation function is 
assigned to the key 1 row

1 In the key 1 row, press the button assigned to the 
desired key 5.

2 In the key 2 row, select the signal.

For details, see “Cross-Point Control Block in Key/AUX 
Bus Delegation Mode” (page 26).

Buttons to which keys can be assigned

Key Key row Dedicated SHIFT 
button a)

[KEY3]/[KEY4] 
button

5 Key 1 
row

Lit [KEY3] button off

6 Key 2 
row

[KEY4] button off

7 Key 1 
row

[KEY3] button lit

8 Key 2 
row

[KEY4] button lit
Using Keys 5 to 8
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Menus accessed by pressing a button twice

For relevant buttons other than the top menu selection 
buttons, pressing twice in rapid succession directly recalls 

a related menu page. The following table lists these buttons 
of each control block, together with the menus they recall. 
(XX represents the HF menu recalled last in the VF menu.)

Cross-point control block

Buttons Menus See

FM1 to 8 signals assigned buttons Frame Memory >Still >Recall page 198

Color Bkgd1 signal assigned button Color Bkgd >Color Bkgd1 page 217

Color Bkgd2 signal assigned button Color Bkgd >Color Bkgd2

CCR1 signal assigned button CCR >CCR1 >XX Chapter 19
(Volume 2)CCR2 signal assigned button CCR >CCR2 >XX

FMS1 Frame Memory >Still >Recall

FMS2 Frame Memory >Still >Recall

Transition control block (standard type, compact type)

Buttons Menus See

KEY1 (DSK1) a) • M/E-1, 2, 3, 4 >Key1 >XX 
• PGM/PST >DSK1 >XX

page 115

KEY2 (DSK2) a) • M/E-1, 2, 3, 4 >Key2 >XX 
• PGM/PST >DSK2 >XX

KEY3 (DSK3) a) • M/E-1, 2, 3, 4 >Key3 >XX 
• PGM/PST >DSK3 >XX

KEY4 (DSK4) a) • M/E-1, 2, 3, 4 >Key4 >XX 
• PGM/PST >DSK4 >XX

KEY5 (DSK5) a) • M/E-1, 2, 3, 4 >Key5 >XX
• PGM/PST >DSK5 >XX

KEY6 (DSK6) a) • M/E-1, 2, 3, 4 >Key6 >XX
• PGM/PST >DSK6 >XX

KEY7 (DSK7) a) • M/E-1, 2, 3, 4 >Key7 >XX
• PGM/PST >DSK7 >XX

KEY8 (DSK8) a) • M/E-1, 2, 3, 4 >Key8 >XX
• PGM/PST >DSK8 >XX

WIPE M/E-1, 2, 3, 4, PGM/PST >Wipe >Main Pattern page 152

DME M/E-1, 2, 3, 4, PGM/PST >DME Wipe >XX page 176

SUPER MIX M/E-1, 2, 3, 4, PGM/PST >Misc >Transition page 92

PST COLOR MIX M/E-1, 2, 3, 4, PGM/PST >Misc >Transition page 92

FM1&2 CLIP, FM3&4 CLIP, FM5&6 CLIP, 
FM7&8 CLIP

M/E-1, 2, 3, 4, PGM/PST >Misc >Clip Transition page 208

PRIOR SET M/E-1, 2, 3, 4, PGM/PST >Misc >Key Priority page 89

KEY PRIOR M/E-1, 2, 3, 4, PGM/PST >Misc >Next Key Priority page 90

WIPE (Independent key transition type selection 
button (standard type))

• M/E-1, 2, 3, 4 >Key1, 2, 3, 4, 5, 6, 7, 8 >Transition 
>Wipe Adjust >Pattern Select

• PGM/PST >DSK1, 2, 3, 4, 5, 6, 7, 8 >Transition 
>Wipe Adjust >Pattern Select

page 164

DME (Independent key transition type selection 
button (standard type))

• M/E-1, 2, 3, 4 >Key1, 2, 3, 4, 5, 6, 7, 8 >Transition 
>DME Wipe Adjust >1ch Pattern Select

• PGM/PST >DSK1, 2, 3, 4, 5, 6, 7, 8 >Transition 
>DME Wipe Adjust >1ch Pattern Select

page 182
383Menus accessed by pressing a button twice
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a) Including the key delegation buttons of the transition control block 
(standard type).

a) The menu to be recalled depends on the setup of the key assignment.

K-SS STORE Snapshot >Key Snapshot >XX Chapter 14 
(Volume 2)

Transition control block (standard type, compact type)

Buttons Menus See

Independent key transition control block (simple type) a)

Buttons Menus See

WIPE • M/E-1, 2, 3, 4 >Key1, 2, 3, 4, 5, 6, 7, 8 >Transition 
>Wipe Adjust >Pattern Select

• PGM/PST >DSK1, 2, 3, 4, 5, 6, 7, 8 >Transition 
>Wipe Adjust >Pattern Select

page 164

DME • M/E-1, 2, 3, 4 >Key1, 2, 3, 4, 5, 6, 7, 8 >Transition 
>DME Wipe Adjust >1ch Pattern Select

• PGM/PST >DSK1, 2, 3, 4, 5, 6, 7, 8 >Transition 
>DME Wipe Adjust >1ch Pattern Select

page 182

SHIFT • M/E-1, 2, 3, 4 >Key1, 2, 3, 4, 5, 6, 7, 8 >XX
• PGM/PST >DSK1, 2, 3, 4, 5, 6, 7, 8 >XX

page 115

Flexi Pad control block (standard type)

Buttons Menus See

WIPE M/E-1, 2, 3, 4, PGM/PST >Wipe >Main Pattern page 152

DME M/E-1, 2, 3, 4, PGM/PST >DME Wipe >XX page 176

SNAPSHOT Snapshot >Snapshot >XX Chapter 14 
(Volume 2)

EFF Effect >Effect 1-99 >XX Chapter 13 
(Volume 2)

SHOTBOX Shotbox >Register >Store/Recall Chapter 15 
(Volume 2)

MCRO Macro >Register >XX Chapter 16 
(Volume 2)

Key control block a)

Buttons Menus See

KEY1 • M/E-1, 2, 3, 4 >Key1 >XX
• PGM/PST >DSK1 >XX

page 115

KEY2 • M/E-1, 2, 3, 4 >Key2 >XX
• PGM/PST >DSK2 >XX

KEY3 • M/E-1, 2, 3, 4 >Key3 >XX
• PGM/PST >DSK3 >XX

KEY4 • M/E-1, 2, 3, 4 >Key4 >XX
• PGM/PST >DSK4 >XX

KEY5 • M/E-1, 2, 3, 4 >Key5 >XX
• PGM/PST >DSK5 >XX

KEY6 • M/E-1, 2, 3, 4 >Key6 >XX
• PGM/PST >DSK6 >XX

KEY7 • M/E-1, 2, 3, 4 >Key7 >XX
• PGM/PST >DSK7 >XX

KEY8 • M/E-1, 2, 3, 4 >Key8 >XX
• PGM/PST >DSK8 >XX
Menus accessed by pressing a button twice
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a) The menu recalled depends on which of the M/E delegation buttons and 
key delegation buttons are selected in the key control block.

a) The menu recalled depends on which of the M/E-1 to M/E-4 banks and 
PGM/PST bank the numeric control block is delegated to.

b) When other than [MASTR] is selected with the region selection buttons.

c) When [MASTR] is selected with the region selection buttons.
d) When the [SNAPSHOT] button or [EFF] button is set to On, or lit green.

a) The menu recalled depends on which of keyers 1 to 8 the downstream key 
control block is delegated to.

b) Recalling is possible only when the [K-SS] button is On.

LUM • M/E-1, 2, 3, 4 >Key1, 2, 3, 4, 5, 6, 7, 8 >Type
• PGM/PST >DSK1, 2, 3, 4, 5, 6, 7, 8 >Type

page 116

LIN

CVK

PTN

CRK • M/E-1, 2, 3, 4 >Key1, 2, 3, 4, 5, 6, 7, 8 >Type 
>Chroma Adjust

• PGM/PST >DSK1, 2, 3, 4, 5, 6, 7, 8 >Type 
>Chroma Adjust

page 120

Key control block a)

Buttons Menus See

Numeric keypad control block

Buttons Menus See

EFF • Effect >Effect 1-99 >XX b) 

• Effect >Master Timeline >Store c)
Chapter 13 
(Volume 2)

SNAPSHOT • Snapshot >Snapshot >XX b) 

• Snapshot >Master Snapshot >Store c)
Chapter 14 
(Volume 2)

SHOTBOX Shotbox >Register >Store/Recall Chapter 15 
(Volume 2)

MCRO Macro >Register >XX Chapter 16 
(Volume 2)

TRANS RATE a) Misc >Transition page 97

STORE RCALL Key Frame >Region Select d) Chapter 13 
(Volume 2)

Downstream key control block a)

Buttons Menus See

DSK1 • M/E-1, 2, 3, 4 >Key1 >XX
• PGM/PST >DSK1 >XX

page 115

DSK2 • M/E-1, 2, 3, 4 >Key2 >XX
• PGM/PST >DSK2 >XX

DSK3 • M/E-1, 2, 3, 4 >Key3 >XX
• PGM/PST >DSK3 >XX

DSK4 • M/E-1, 2, 3, 4 >Key4 >XX
• PGM/PST >DSK4 >XX

WIPE • M/E-1, 2, 3, 4 >Key1, 2, 3, 4, 5, 6, 7, 8 >Transition 
>Wipe Adjust >Pattern Select

• PGM/PST >DSK1, 2, 3, 4, 5, 6, 7, 8 >Transition 
>Wipe Adjust >Pattern Select

page 164

DME • M/E-1, 2, 3, 4 >Key1, 2, 3, 4, 5, 6, 7, 8 >Transition 
>Wipe Adjust >Pattern Select

• PGM/PST >DSK1, 2, 3, 4, 5, 6, 7, 8 >Transition 
>DME Wipe Adjust >Pattern Select

page 182

K-SS STORE b) Snapshot >Key Snapshot >XX Chapter 14 
(Volume 2)
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a) When the three-dimensional transformation operation mode is enabled.
b) When the [MENU] button is Off.

c) When the [MENU] button is On.
d) When the resizer control mode is enabled.

a) When the [TIMELINE] button is Off. b) When the [TIMELINE] button is On.

a) When a key other than DSK1 or DSK2 is assigned, the menu for the 
corresponding key appears.

Auxiliary bus control block

Buttons Menus See

FMS1, FMS2 Frame Memory >Still >Freeze/Store page 196

FM1 to 8 signals assigned buttons Frame Memory >Still >Recall page 198

Color Bkgd1 signal assigned button Color Bkgd >Color Bkgd1 page 217

Color Bkgd2 signal assigned button Color Bkgd >Color Bkgd2

CCR1 signal assigned button CCR >CCR1 >XX page 229

CCR2 signal assigned button CCR >CCR2 >XX

Device control block (trackball or joystick)

Buttons Menus See

DME1 to DME8 a) DME >XX page 275

DEV1 to DEV12 assigned buttons • Device >DDR/VTR >Cueup & Play b) 
• Device >DDR/VTR >Timeline c)

Chapter 12 
(Volume 2)

FM1CLIP to FM8CLIP assigned buttons Frame Memory >Clip >Recall page 203

K1RSZ to K8RSZ d) • M/E-1, 2, 3, 4 >Key1, 2, 3, 4, 5, 6, 7, 8 >Processed 
Key

• PGM/PST >DSK1, 2, 3, 4, 5, 6, 7, 8 >Processed 
Key

page 141

Device control block (search dial)

Buttons Menus See

DEV1 to DEV12 • Device >DDR/VTR >Cueup & Play a) 
• Device >DDR/VTR >Timeline b)

Chapter 12 
(Volume 2)

FM1CLIP to FM8CLIP assigned buttons Frame Memory >Clip >Recall –

Downstream key/fade-to-black control block

Buttons Menus See

DSK1, DSK2 PGM/PST >DSK1, 2 >XX a) page 115

Transition control block and Flexi Pad control block (simple type)

Buttons Menus See

KEY1 (DSK1) • M/E-1, 2, 3, 4 >Key1 >XX
• PGM/PST >DSK1 >XX

page 115

KEY2 (DSK2) • M/E-1, 2, 3, 4 >Key2 >XX
• PGM/PST >DSK2 >XX

WIPE • M/E-1, 2, 3, 4 >Wipe >Main Pattern
• PGM/PST >Wipe >Main Pattern

page 152

DME • M/E-1, 2, 3, 4 >DME Wipe >XX
• PGM/PST >DME Wipe >XX

page 176

FM1CLIP to FM8CLIP assigned buttons • M/E1, 2, 3, 4 >Misc >Clip Transition
• PGM/PST >Misc >Clip Transition

–

SNAPSHOT Snapshot >Snapshot >XX Chapter 14 
(Volume 2)
Menus accessed by pressing a button twice
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a) When the button is assigned to macro function in the Setup menu.

MCRO a) Macro >Register >XX Chapter 16 
(Volume 2)

Transition control block and Flexi Pad control block (simple type)

Buttons Menus See

Multifunction Flexi Pad control block

Buttons Menus See

WIPE M/E-1, 2, 3, 4, PGM/PST >Wipe >Main Pattern page 152

DME WIPE M/E-1, 2, 3, 4, PGM/PST >DME Wipe >xxx a) page 176

SNAPSHOT When the [MSTR] button is On.
Snapshot >Master Snapshot >Store

Chapter 14
(Volume 2)

When the [MSTR] button is Off 
Snapshot >Snapshot >xxx a)

EFF When the [MSTR] button is On
Effect >Master Timeline >Store

Chapter 13
(Volume 2)

When the [MSTR] button is Off
Effect >Effect 1-99 >xxx a)

SHOTBOX Shotbox >Register >Store/Recall Chapter 15
(Volume 2)

MCRO Macro >Register >xxx a) Chapter 16
(Volume 2)

TRANS RATE Misc >Transition page 223

KEY SS Snapshot >Key Snapshot >xxx a) Chapter 14
(Volume 2)

KEY ADJ >  KEY1 • M/E1, 2, 3, 4 >Key1 >xxx a)

• PGM/PST >DSK1 >xxx a)
page 115

KEY2 • M/E1, 2, 3, 4 >Key2 >xxx a)

• PGM/PST >DSK2 >xxx a)

KEY3 • M/E1, 2, 3, 4 >Key3 >xxx a)

• PGM/PST >DSK3 >xxx a)

KEY4 • M/E1, 2, 3, 4 >Key4 >xxx a)

• PGM/PST >DSK4 >xxx a)

KEY5 • M/E1, 2, 3, 4 >Key5 >xxx a)

• PGM/PST >DSK5 >xxx a)

KEY6 • M/E1, 2, 3, 4 >Key6 >xxx a)

• PGM/PST >DSK6 >xxx a)

KEY7 • M/E1, 2, 3, 4 >Key7 >xxx a)

• PGM/PST >DSK7 >xxx a)

KEY8 • M/E1, 2, 3, 4 >Key8 >xxx a)

• PGM/PST >DSK8 >xxx a)

LUM
LIN
WIPE PTN

M/E-1 >Key1, 2, 3, 4, 5, 6, 7, 8 >Type page 116

M/E-2 >Key1, 2, 3, 4, 5, 6, 7, 8 >Type

M/E-3 >Key1, 2, 3, 4, 5, 6, 7, 8 >Type

M/E-4 >Key1, 2, 3, 4, 5, 6, 7, 8 >Type

PGM/PST >DSK1, 2, 3, 4, 5, 6, 7, 8 >Type

CRK M/E-1 >Key1, 2, 3, 4, 5, 6, 7, 8 >Type >Chroma Adjust page 119

M/E-2 >Key1, 2, 3, 4, 5, 6, 7, 8 >Type >Chroma Adjust

M/E-3 >Key1, 2, 3, 4, 5, 6, 7, 8 >Type >Chroma Adjust

M/E-4 >Key1, 2, 3, 4, 5, 6, 7, 8 >Type >Chroma Adjust

PGM/PST >DSK1, 2, 3, 4, 5, 6, 7, 8 >Type >Chroma Adjust
387Menus accessed by pressing a button twice
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a) “xxx” represents the last accessed page of the relevant menu.

KEY SS  KEY1 • M/E1, 2, 3, 4 >Key1 >xxx a)

• PGM/PST >DSK1 >xxx a)
page 115

KEY2 • M/E1, 2, 3, 4 >Key2 >xxx a)

• PGM/PST >DSK2 >xxx a)

KEY3 • M/E1, 2, 3, 4 >Key3 >xxx a)

• PGM/PST >DSK3 >xxx a)

KEY4 • M/E1, 2, 3, 4 >Key4 >xxx a)

• PGM/PST >DSK4 >xxx a)

KEY5 • M/E1, 2, 3, 4 >Key5 >xxx a)

• PGM/PST >DSK5 >xxx a)

KEY6 • M/E1, 2, 3, 4 >Key6 >xxx a)

• PGM/PST >DSK6 >xxx a)

KEY7 • M/E1, 2, 3, 4 >Key7 >xxx a)

• PGM/PST >DSK7 >xxx a)

KEY8 • M/E1, 2, 3, 4 >Key8 >xxx a)

• PGM/PST >DSK8 >xxx a)

Multifunction Flexi Pad control block

Buttons Menus See
Menus accessed by pressing a button twice
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Menus allowing a return to default settings

Top menu selection button 
name

VF number 
(HF number)

Menu number Menu name

M/E1 VF1 a) 1110-series/1510-series Key1/Key5 b)

VF2 a) 1120-series/1520-series Key2/Key6 b)

VF3 a) 1130-series/1530-series Key3/Key7 b)

VF4 a) 1140-series/1540-series Key4/Key8 b)

VF5 1150-series Wipe b)

VF6 1160-series DME Wipe b)

VF7 1170-series Misc b)

M/E2 VF1 a) 1210-series/1610-series Key1/Key5 b)

VF2 a) 1220-series/1620-series Key2/Key6 b)

VF3 a) 1230-series/1630-series Key3/Key7 b)

VF4 a) 1240-series/1640-series Key4/Key8 b)

VF5 1250-series Wipe b)

VF6 1260-series DME Wipe b)

VF7 1270-series Misc b)

M/E3 VF1 a) 1310-series/1710-series Key1/Key5 b)

VF2 a) 1320-series/1720-series Key2/Key6 b)

VF3 a) 1330-series/1730-series Key3/Key7 b)

VF4 a) 1340-series/1740-series Key4/Key8 b)

VF5 1350-series Wipe b)

VF6 1360-series DME Wipe b)

VF7 1370-series Misc b)

M/E4 VF1 a) 8110-series/8510-series Key1/Key5 b)

VF2 a) 8120-series/8520-series Key2/Key6 b)

VF3 a) 8130-series/8530-series Key3/Key7 b)

VF4 a) 8140-series/8540-series Key4/Key8 b)

VF5 8150-series Wipe b)

VF6 8160-series DME Wipe b)

VF7 8170-series Misc b)

P/P VF1 a) 1410-series/1810-series DSK1/DSK5 b)

VF2 a) 1420-series/1820-series DSK2/DSK6 b)

VF3 a) 1430-series/1830-series DSK3/DSK7 b)

VF4 a) 1440-series/1840-series DSK4/DSK8 b)

VF5 1450-series Wipe b)

VF6 1460-series DME Wipe b)

VF7 1470-series Misc b)

COLOR BKGD VF1 2210 Color Bkgd 1 b)

VF2 2220 Color Bkgd 2 b)

CCR VF1 2410-series CCR1 b)

VF2 2420-series CCR2 b)
389Menus allowing a return to default settings
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a) VF1 to VF4 are shared between Key1 (DSK1) to Key4 (DSK4) and Key5 
(DSK5) to Key8 (DSK8).

b) Menu to return to the default settings for particular functions or for 
particular knob parameters (for the relevant knob parameters, see page 
390)

c) Menu to return to the default settings for particular knob parameters (for 
the relevant knob parameters, see page 390)

FRAME MEM VF1 2510-series Still c)

VF2 2520-series Clip c)

VF3 2530-series Reposition/Lock c)

VF4 2540-series File c)

VF5 2550-series Folder c)

AUX VF1 2311 Aux Bus c)

DME VF1 4110-series Edge c)

VF2 4120-series Video Modify c)

VF3 4131 Freeze c)

VF4 4141 Non-Linear c)

VF5 4150-series Light/Trail c)

VF6 4160-series Input/Output c)

VF7 4170-series Enhanced Video Modify b)

GLB EFF VF1 4210-series Ch1–Ch4 c)

VF2 4220-series Ch5–Ch8 c)

KEY FRAME (HF3) 6113 Path c)

Top menu selection button 
name

VF number 
(HF number)

Menu number Menu name

Knob parameters to which default recall does not apply

Menu number a) Menu name Button name Knob Parameter

1111 Type [Luminance] and [Linear] in 
<Key Type> group

4 Filter

[Color Vector] in <Key Type> 
group

1
2
(Parameter group [2/2])

Y Filter, 
C Filter

1111.1 Type >CRK Adjust [Key Active] 5 Filter

[Color Cancel] in <Color 
Cancel> group

5 Filter

1112.1 Edge >Matte [Mix Color] in <Edge Matte> 
group

5 Pattern

[Multi] 3 Invert Type

1113 Main Mask [Pattern] 5 Pattern

[Multi] 3 Invert Type

1116 Transition [Wipe] in <ON Transition Type> 
group

1

5 

Transition Rate
Pattern

[Wipe] in <OFF Transition 
Type> group

1

5 

Transition Rate
Pattern

[Key Blink] and [Edge Blink] in 
<Blink> group

1 Blink Rate

[Mix] in <Transition Type> group 1 Transition Type

[Wipe] in <Transition Type> 
group

1

5 

Transition Rate
Pattern
Menus allowing a return to default settings
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a) The menu numbers shown by way of example are those for M/E-1: the 
same applies for M/E-2, M/E-3, M/E-4, and P/P. Also, content applying to 
Key1 applies equally to Key2 to Key8.

1116.1 Transition >
Wipe Adjust

[Multi] 3 Invert Type

[H] and [V] in <Pairing> group 1 Width

[H], [V], and [Fringe] in 
<Modulation> group

4 Shape

1154 Edge/Direction [Split] in <Edge> group 1 Split No

1154.1 Edge/Direction >
Matte Adjust

[Mix Color] in <Edge Matte> 
group

3 Pattern

[Multi] 3 Invert Type

1155 Main Modify [H] and [V] in <Pairing> group 1 Width

[H], [V], and [Fringe] in 
<Modulation> group

4 Shape

1164 Edge/Direction [Independent Trans Rate] in 
<Pattern Limit Release> group

1 Transition Rate

1171 Transition [Mix], [Nam], [Super Mix], 
[Preset Color Mix], [Wipe], 
[DME Wipe], and [FTB] in 
<Transition Type> group

1 Transition Rate

Knob parameters to which default recall does not apply

Menu number a) Menu name Button name Knob Parameter

Knob parameters subject to restriction on default recall

Menu number Menu name Button name Knob Parameter

1111.1 a) Type >CRK Adjust [Sample Mark] in the <Auto> group 1
2

Position H
Position V1112.1 a) Edge >Matte Adjust [Position]

1113 a) Main Mask [Position]

1116.1 a) Transition >Wipe 
Adjust

[Position]

1116.3 a) Transition >DME Wipe 
Adjust

[Position] 1
2

H
V

1154.1 a) Edge Direction >Matte 
Adjust

[Position] 1
2

Position H
Position V

1155 a) Main Modify [Position] in the <Position> group

1155.1 a) Main Modify >Multi 
Adjust

[Position]

1156 a) Sub Modify [Position] in the <Position> group

1156.1 a) Sub Modify >Multi 
Adjust

[Position]

2122.2 Composite >Pattern 
Adjust

[Position] 1
2

Position H
Position V

2131 Reposition [Normal]

[Black&White]

2210 Color Bkgd1 b) [Position]

2412.1 c) Primary CCR >Mask1 
Adjust d)

[Position]

4116 DME >Edge >Wipe 
Crop

[Position/Size] 5 Pattern

4127 DME >Video Modify 
>Mask

[Position/Size]
391Menus allowing a return to default settings



392

  A
ppendix (V

olum
e 1)
a) The menu numbers shown by way of example are those for M/E-1: the 
same applies to M/E-2, M/E-3, M/E-4, and P/P. Equally, content applying 
to Key1 applies equally to Key2 to Key8.

b) The same applies to Color Bkgd2.
c) The menu numbers shown by way of example are those for CCR1: the 

same applies to CCR2.
d) The sample applies to Mask2 Adjust.
Menus allowing a return to default settings
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SpotLighting

Texture Patterns

Material provided by Digital Archive Japan, INC.

Shape Patterns
393SpotLighting
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Functional Differences With Models of DME

Function Menu number MVE-8000A MVE-9000 MKS-7470X/7471X See

Selection of signal to 
insert in the border

4111 Flat Color only Flat Color
Ext Video
Mix Color

Flat Color
Ext Video
Mix Color

page 276

Key Border 4113 No Cannot be turned on 
when Glow is on.

Cannot be turned on 
when Glow is on.

page 279

Art Edge 4114 No Yes Yes page 279

Flex Shadow 4115 No Yes Yes a) page 283

Wipe Crop 4116 No Yes Yes page 287

Color Mix 4117 No Yes Yes page 289

Defocus/Blur 4121 Cannot be turned 
on when Glow is 
on.

Yes Yes page 290

Mask 4127 Yes b) Yes Yes page 297

Adjustment of entire 
image brightness in 
Lighting/Spotlighting 
(parameter [Total 
Ambient])

4151
4156

No Yes Yes page 316
page 326

Setting the bar mode of 
the highlight area

4151 No Yes Yes page 317

Adjustment of color of the 
diffuse light area 
(parameter [Bar Diffuse 
Color])

4151 No Yes Yes page 318

Selection of signal to 
insert in the trail 
afterimage portion

4152 Freeze Video 
Flat Color 
Hue Rotate

Without limitation Without limitation page 318

Combine process for Trail 4152 No Yes Yes page 320

Defocus function for Trail 4152 No Yes Yes page 319

Combine process for 
Keyframe Strobe

4154 No Yes Yes page 322

Wind 4155 No Yes Yes page 322

Spotlighting 4156 No Yes Yes page 323

Selection of signal to 
insert in the background

4161 Flat Color only Flat Color
Ext Video
Mix Color

Flat Color
Ext Video
Mix Color

page 331

Interpolation settings 4163 Yes (SD only) Yes (both SD/HD) Yes (both SD/HD) page 333

Anti-moire filter 4163 Yes (HD only) No No page 334

Flex shadow axis settings 4164 No Yes Yes page 274

Dim and Fade 4173 No Yes Yes page 296

Glow 4174 Cannot be turned 
on when Defocus/
Blur is on.

Cannot be turned on 
when Key Border is 
on.

Cannot be turned on 
when Key Border is 
on.

page 297

Combiner depth settings 
(three-dimensional 
crossing function) 
(parameter [Depth])

4211 No Yes Yes page 339
Functional Differences With Models of DME
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a) [External] cannot be selected in the <Flex Shadow Source> group or [Ext 
Video] cannot be selected in the <Flex Shadow Fill> group.

b) Effect groups 1 and 2 cannot be selected at the same time. Pattern 304 
(Round Corner) is not supported.

Adding user texture 
patterns (for Spotlighting)

7316.9 No Yes No “Adding User 
Texture 
Patterns” in 
Chapter 18 
(Volume 2)

Setting AUX bus output/
reentry input

7337.7 It is not possible to 
make settings for 
DME 1 to 8 Ext In.

It is not possible to 
make settings for 
DME 1 to 8 Ext In.

It is not possible to 
make settings for 
DME 1 to 8 Ext In.

“Setting the 
AUX Bus 
Output and 
Reentry Input” 
in Chapter 20 
(Volume 2)

TBC window center 
position (Video/Key)

7341.1 Yes only when SDI 
interface is used.

Yes only when SDI 
interface is used.

No “Setting the 
TBC Window 
Center Position” 
in Chapter 21 
(Volume 2)

TBC window center 
position (Ext.In)

No Yes Yes “Setting the 
TBC Window 
Center Position” 
in Chapter 21 
(Volume 2)

Adjustment of monitor 
output video clip level

7343 Yes only when SDI 
interface is used.

Yes only when SDI 
interface is used.

No “Adjusting the 
Monitor Output” 
in Chapter 21 
(Volume 2)

Settings relating to usage 
of editor port

7344 Yes Yes No “Interfacing 
With External 
Devices 
(Device 
Interface 
Menu)” in 
Chapter 19 
(Volume 2)

1080P supported 7313.1 Yes No Yes “Setting the 
Signal Format 
(Format Menu)” 
in Chapter 18 
(Volume 2)

Function Menu number MVE-8000A MVE-9000 MKS-7470X/7471X See
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  Index
Index

Numerics
3D   18, 248
3M/E Mode   254
4M/E Mode   254

A
Additive mix   119
Ancillary data   202, 207
Angle   159
Anti-moire filter   334
Art edge settings   279
Aspect ratio   160, 166
Audio mixer   84
Auto

chroma key adjustments   120
transition   98

AUTO button   46
AUTO DELEG button   35
AUTO INS button   44
Auto/manual transition combination   

99
AUX

bus settings   224
delegation buttons   47
menu operations   224

AUX menu   365
AUX Panel-less Function   82
Auxiliary bus control block

for AUX buses   46
for router control   48

Axis location   259

B
Background

changing   13
mask   114
settings   331

Bank selection buttons   51
Basic menu operations   65
Beveled edge settings   278
Blind settings   307
Blink

function   130
Blur settings   291
Border   113

parameters   133
settings   276

Brick settings   340
Broken glass settings   306
BS button   72
Bus fixed mode

fader operation   100
wipe direction   101

Bus selection   79
Button

numbers   82, 83

C
Caps Lock button   72
CCP-6224

AUX Panel-less Function   82
CCP-6224 2M/E Control Panel   61
CCP-6324

AUX Panel-less Function   82
CCP-6324 3M/E Control Panel   61
CCR menu   365
Channel ID   261
Character Trail settings   315
Chroma key   113

adjustments   120
shadow   120
shadow adjustment   122
window   120

Circle settings   311
Clean mode   112
Clear button   71, 72
Clip function   202
Clip transition   85

operations   208
Close button   71, 72
Color

combination   217
matte settings   92
vector key   112

Color background
selection   217
setting operations   217
settings menu   217

Color Bkgd menu   364
Color cancel   120

adjustments   121
Color corrector   228
Color data

copy   220
swap   220

Color mix   217
for edge fill matte   157
for key fill   118

Color Mix settings   289
Combiner settings   337
Contrast settings   294
Control panel   21

configuration 1   21
configuration 2   21
configuration 3   22

Coordinate axes   261
Copy   219, 220
Copy/Swap menu   366

Corner Pinnig   334
Crop settings   277
Cross-point

button numbers   24
buttons   23
control block   22

Cut   86
Cylinder settings   312

D
Dead zone   187
Default recall button   69
Defocus settings   290
Del button   72
Delegation buttons   32
DEST button   47
Detents   258
Device

menu   368
DEVICE connectors   50
Device control block

joystick   38
search dial   39
trackball   35

Diagnostic menu   379
Digital multi effects   18, 256
Dim and fade settings   296
Direction   156, 164, 178
Display   34, 45
DME   18

applying to a key   127, 135
channel selection buttons   34
menu   367
special effects   261

DME channel
copy   220
swap   220

DME override   222
DME patterns

user programmable   186
DME wipe pattern   172

edge modification   178
groups   172
selection   176

DME wipe pattern list
for one-channel mode   348
for two-channel mode   353

DME wipe settings   176
for independent key transitions   

182
DME wipes   16, 172

copy   219, 220
direction   178
modifiers   178
modify clear   181
position   178, 182
resizer   184
Index



  Index
snapshot   185
swap   219, 220

Door   349
Downstream key control block   56
Drop border   113

parameters   133
dual resizer effects   147
Duration

setting buttons   43
Dust mix   154, 155

E
Edge

fill   114
modifiers   113

EDIT ENBL button   42
Edit point specification buttons   42
Editing buttons   42
EFF LOOP button   44
Effect

menu   370
resizer   145

Effect execution direction selection 
buttons   43

Emboss   113
Engineering Setup menu   374
Enhanced wipes   345
Enter button   71, 72
Explosion settings   313
External

processed key   129, 137
External devices   19
External hard disk drive   212

F
Fade to black   108

control block   46
transition rate   108

File menu   373
Files   20

deleting   211
renaming   211

Film effect   299
Fine mode   272
Flag settings   302
Flex shadow settings   283
Flexi Pad control block

simple type   52
standard type   30

Flip tumble   350
Flying bar settings   307
Frame

in-out   350, 358
Memory menu   364

Frame input mode   95
Frame memory

clip function   202
continuously capturing still 

images (record)   200
extracting images   215
feed   130, 137
pair file processing   210
recalling a continuous sequence of 

still images (animation)   
200

Frame memory operations   193
capturing an input image   196
clip   203
input image selection   195
menu display   193
preparations   193
selecting frame memory   196
selecting outputs   196

Freeze settings   299
Fringe   162
FTB button   46
FULL LINK   154
Function

button area   69
selection buttons   45

Functions assignable to trackball/Z-
ring   272

G
Global

coordinate space   256
Effect menu   368
effect operations   336

Glow settings   297
Graphics

outputting to the monitor   274
Graphics display   260, 274
Grid   261

H
Hard disk   212

partition   212
Hard freeze effect   299
HDD   212
HF buttons   69

I
Image

data management   210
extracting   215

Image file
deletion   211
renaming   211

Independent key transition   14, 102
DME wipe settings   182
simple transitions   110
type   106

type selection buttons   30, 55, 56
wipe modifiers   164
wipe settings   164

Independent key transition control 
block

simple type   54
standard type   105

Independent key transition execution 
section   30, 55, 56, 61

Independent key transition rate   106
display   107
setting by a menu operation   107
setting in the Flexi Pad control 

block   106
setting in the numeric keypad 

control block   106
Input

string   72
value   71

Interpolation settings   333
Invert settings   332
Item display   71, 72

J
Joystick   38

K
Kaleidoscope settings   310
Key   15

1/2 row   24
border settings   279
bus selection buttons   24
control block   32
default   115
delegation buttons   30, 56
deleting   13
density settings   333
edge modifications   123, 133
Frame menu   369
inserting   13
mask   114
memory   114
modifier buttons   33
modifiers   113
modify clear   130
output destination   129
output status display   90, 110
signal adjustments   121
source selection   333
status display   29, 54, 60
using keys 5 to 8   381

Key active   120
adjustment   121

KEY button   47
Key fill

selection   117
397Index
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  Index
selection buttons   33
Key priority   88

display   90, 110
for keys 1 to 8   90
setting by a menu operation   89
setting in the transition control 

block   88
Key setting

using menus   115
Key snapshot   148

buttons   30, 57
recalling   149, 151
saving   148, 150
setting buttons   30, 57
using simple transition module   

150
Key source

name display   30, 57
selection   117
selection buttons   33

Key transition
selection buttons   53

Key type
selection buttons   33
setting   116

Key/AUX bus delegation mode   26
Keyer

copy   219
swap   219

Keyframe   19
control block   41
status   69
strobe settings   321

KF button   29
Knob   34, 49

parameter buttons   69
K-SS button   55

L
Left button   72
Lens settings   310
Level selection buttons   48
Lighting settings   316
Line feed button   72
Linear key   112
Local coordinate space   256
Location

size   259
XYZ   258

Lock function   199
Luminance key   112

M
M/E

bank display   25
copy   219

swap   219
M/E configuration switching   254
M/E-1 to M/E-4 menus   359
Macro   19

attachment   20
menu   369
timeline   20

Magnitude   159
MAIN and SUB delegation button   243
Main mask   114

using   126, 134
Main menu site   74
Main/sub modifier link   154
Manual transition   99
Mask settings   297
Masks   114, 126, 134
Matte data

copy   220
swap   220

Max./min. value indication   71
Melt settings   314
Memory

card slot   50
recall buttons   51

Memory card/USB adaptor block   50
“Memory Stick”/USB connections 

block   50
“Memory Sticks”   50
Menu

accessing   66, 67
control block   49
display   49
organization   65
page number button   68
screen   67
shortcut menu   76
shutting down   70
switching between the main menu 

sites   74
title button   68
top menu list   65

MENU button   38
Menu tree   359
Metal settings   296
Minus button   71
Mirror settings   309
Misc menu operations   222
Mix   85, 153
Mixing images   339
Mode selection buttons   31, 44, 54
Modulation   161
Monitor output

graphics   274
Mono settings   293
MORE button   34
Morphing   154
Mosaic

glass settings   302

settings   294
wipes   346

Motion decay settings   320
Multi   160, 166

mirror settings   309
move settings   292

Multi Program 2   17
basic operation   242
restriction   247

Multifunction Flexi Pad Control Block
DME Wipe Pattern Operations   

188
Wipe Pattern Operations   169

MVE-8000A   269
MVE-9000   270
MVS-8000X Multi Format Switcher 

System   12

N
NAM   85
Nega settings   294
Negative NAM   153
Next transition   85

selecting   85
selection buttons   27, 59

Non-additive mix   85
Nonlinear effects settings   300
Non-Sync state   99
Normal

edge   134
mix   119

Numeric display   32, 54
Numeric keypad   45

control block   44

O
ON AIR indicators   34
One-stroke mode   92
One-time mode   92
Operation

buttons   36
modes   192

Outline   113
parameters   133

Output
destination specification buttons   

34
OVERRIDE button   35

P
Page Roll   351
Page turn   351

settings   311
Pair file processing   210
Pair mode   192
Pairing   161
Index
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Panorama settings   311
Parameter group button   69
Pattern limit   97

buttons   29, 53
setting by a menu operation   97
setting with the fader lever   97
transition   98

Pattern mix   153
types   153

Perspective   260
PGM/PST

menu   362
Picture-in-picture   350, 354
Plane function   119
Positioner   158, 164, 178, 182
Positive NAM   153
Posterization   293
Preset color mix   85
Preview   101

selection buttons   46
Previous page button   69
PRIOR SET button   29, 60

R
Random/diamond dust wipes   347
Recording

to DDR   214
to VTR   214

Reentry buttons   79
Regions

selection buttons   44
Related manuals   11
Replication   166
Resizer DME wipe   184
Resizer DME wipe patterns   358
Right button   72
Ripple settings   303
Rotary wipes   345
Rotation   159, 165, 259
Rotation of key   143
RTR button   48

S
Search dial   39
Second (2ND) button   47
Selected

bus display   47
source name displays   47

SEMI LINK   154
Separate sides settings   331
Sepia settings   293
Setup   20
Shadow   113

parameters   133
Shadow settings   342
Shaped video settings   331

SHIFT button   25
Shift button   72
Shortcut   76
Shotbox   19
Shotbox menu   372
SHOW KEY button   34
Show key function   137
Side flags

DME wipe action   239
MISC menu   238
wipe action   239

Signal
assignment to buttons   82
name display   84
selection   79

Simple
transition   109

Sketch settings   294
Skew   260
Slide   348, 353, 358
Snapshot   19

menu   371
Soft edge   113, 164
Softening

edge   134
wipe pattern edge   164

Solarization   293
Source

coordinate space   256
name displays   47

Space button   72
Speed   159
Sphere settings   313
Spin   259
Spiral   163
Split   156, 348

fader   110
settings   308
slide settings   308

Spotlighting settings   323
Spring   162
Squeeze   348, 354, 358
Standard wipe patterns   152
Standard wipes   344
Status area   69
Status menu   225, 366
STOP NEXT KF button   44
Sub (subsidiary) mask   114

using   127, 135
Subsidiary menu site   74
Super mix   85

settings   92
Swap   219, 220
Swirl settings   313

T
Target coordinate space   256

TC button   71
Three-dimensional

coordinate space   256
parameter display   261
parameters   257
transformations   256

Three-dimensional parameters
display   272
entering   273
values   273

Three-dimensional transformation   
256

Time
strobe effect   299

Time offset execution   103
Timecode input mode   95
Top menu list   65
Top menu selection buttons   49
TRACE button   35
Trail settings   318
TRANS PVW button   29, 60
Transformation operation modes   258
Transition

execution   94
next   85
preview   101

Transition control block
simple type   52
standard type   27

Transition execution
section   28, 53, 60
with the fader lever   99

Transition indicator
function   94

Transition rate   94
setting by a menu operation   97
setting in the Flexi Pad control 

block   95
setting in the MISC menu   223
setting in the numeric keypad 

control block   96
Transition type   85

selecting by a menu operation   91
selection buttons   28, 52, 59

Trim button   71
Twist settings   302

U
UNDO button   31, 54
User preference button   49
User programmable DME   353, 356

Notes on keyframe creation   186
patterns   186
transition mode   186

UTIL button   24
Utility   19
Utility/shotbox control block   51
399Index
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  Index
V
V/K mode   192
VF buttons   69
Video

processing   78, 130
signal adjustment   120

Video process   226
memory   227
settings   227

Virtual image cancellation   274

W
Wave settings   300
Wind settings   322
Window adjustment   120, 122
Wipe   15, 85

copy   219
enhanced   152
modify clear   163
mosaic   152
pattern list   344
random/diamond dust   152
rotary   152
standard   152
swap   219

Wipe Crop settings   287
Wipe direction   156, 164

selection buttons   29, 53, 60
Wipe modifiers   155
Wipe pattern

aspect ratio   160, 166
edge modification   156
key   113
modulation   161
replication   160, 166
rotation   159
selection   152
types   152

Wipe pattern/modifier combinations   
163

Wipe position   158, 164
Wipe settings   152

for independent key transitions   
164

Wipe snapshot   166
deleting   167
recalling   167
saving   167

Wire frames   260
Working buffer clearing   273
Wrap Around   275

X
XPT HOLD

buttons   24, 47
status display   54

Y
Y balance   120

adjustment   122

Z
Zabton   113, 125, 134
Z-ring   37
Index
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